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Welcome to the Microsoft® Windows NTTM operating system, the powerful 
platform for client-server computing. It is the high-end member of the family of 
Windows™ operating systems-the advanced operating system designed to make 
the most of today's powerful machines. 

Windows NT is a powerful, reliable, and open operating system, ready for the 
demands of client-server computing and the advancing power of personal 
computers in the 1990s and beyond. 

Incorporating the benefits of the family of Windows operating systems-ease 
of use, application integration, and choice of leading applications-the Windows 
NT operating system extends these benefits in a powerful platform for client­
server computing. 

You can run powerful new 32-bit applications created for Windows NT, which. 
is also compatible with existing environments. So you can run applications 
created for other versions of Microsoft Windows, MS-DOS®, and character-based 
MS® OS/2® l.x as well as POSIX-compliant applications. 

The Windows NT System Guide is for new and experienced users of Windows NT. 
This manual describes the features in Windows NT and presents step-by-step 
procedures for using the applications and tools provided in your product package. 

This introduction provides: 

• A description of Windows NT, including its benefits and a comparison to 
Microsoft Windows for MS-DOS. 

• The Windows NT system requirements. 

• A summary of the resources available for learning and using Windows NT. 

• A list of the conventions used in the Windows NT document set. 

• Accessibility information for people with disabilities. 
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What Is Windows NT? 
Complex business applications place high demands on computing technology. 
Windows NT is designed to support these applications with: 

• Power on the desktop Windows NT is a full 32-bit, preemptive multitasking 
operating system with a huge capacity to enable power users to fully exploit 
line-of-business and personal productivity applications as well as the latest 
generations of microprocessors including Intel® and RISC systems and 
symmetric multiprocessing systems. 

• Reliability Windows NT provides the reliability required by MIS 
professionals and other power users to run line-of-businessapplications. The 
advanced microkernel design of Windows NT, along with integrated security 
and manageability, provide a more reliable platform than other operating 
systems. 

• Open operating system Windows NT gives you better access to information 
throughout the enterprise and flexibility in choosing computing solutions. It 
has integrated networking and support for industry standard protocols, for easy 
access to resources in a heterogeneous computing environment. 

Windows NT will run existing applications for the MS-DOS and Windows 
operating systems as well as new 32-bit applications being developed by 
corporations and independent software vendors. It makes it easy for users 
to integrate information between applications. Windows NT also gives you 
flexibility in choosing hardware for your computing needs. It scales to run 
on single and multiprocessor-based systems and is portable to a variety of 
hardware platforms based on both Intel and RISe technology. 

Windows NT provides networking and workgroup support, with built-in file­
sharing and print-sharing capabilities for workgroup computing, and an open 
network system interface that includes built-in support for NetBEUI, TCP/lP, 
and other transports. Windows NT is compatible with existing networks such 
as Banyan® VINES® and Novell® NetWare®. 

With Windows NT, you can run a host of applications on bothx86 and RISC 
machines, including the following: 

• New, powerful Win32TM-based applications (32-bit Windows) 

• Programs created for the MS-DOS and Microsoft Windows for MS-DOS 
operating systems 

• MS OS/2 version 1.x character-based programs 

• PO SIX-compliant programs 
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Windows NT Compared with Windows for MS·DOS 
If you are familiar with versions of the Microsoft Windows operating system 
that run with MS-DOS, you will quickly understand how to use Windows NT. 
Windows NT shares these same features: 

• Mouse and keyboard techniques for working with windows,' menus, and icons 

• Desktop tools such as Program Manager, File Manager, and Print Manager 

• Accessories, games, and other components, with an extended set in 
Windows NT 

• The complete object linking and embedding (OLE) capabilities supported 
by applications created for versions of Windows for MS-DOS 

Windows NT, however, is a complete operating system with powerful additions 
to support file and system security, networking capabilities, and high-end, 32-bit 
computing. Windows NT is designed to take full advantage of the advanced 
computing capabilities of x86 and RISC processors to provide a platform for 
advanced line-of-business computing solutions and for applications requiring 
sophisticated system software. 

You will find these additional features in Windows NT: 

• Advanced built-in network support, including complete security features. 

• Applications in the new Administrative Tools group for managing user 
accounts, controlling network services, auditing system events, managing 
and backing up disks, and more. 

• Tools in File Manager, Control Panel, and Print Manager for security, 
hardware configuration, and network management. 

• A new file system-the Windows NT file system (NTFS)-that provides 
security and automatic error-correction capabilities. NTFS allows file and 
directory names of up to 256 characters. 

• A command prompt where you can start programs and batch files, or issue 
all Windows NT commands and most commands for MS-DOS, MS OS/2, 
and POSIX. 
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System Requirements 
The following table describes the system requirements for Windows NT. 

Category 

Hardware 

Memory 

Optional 
components 

Requirement 

32-bit x86-b<!sed microprocessor (such as Intel 80386/25 or 
higher), or supported RISC-based microprocessor such as the 
MIPS® R4000™ and DEC® Alpha 

VGA, or higher resolution, video display adapter 

One or more hard disks, with 75 MB minimum free hard disk 
space on the partition that will contain the Windows NT system 
files (92 MB minimum for RISC systems) 

For x86-based computers, a high-density floppy disk drive 

For RISC-based computers, a SCSI® CD-ROM drive 

12 MB RAM recommended minimum for x86 systems; 
16 MB minimum for RISC systems 

Mouse or other pointing device 

One or more SCSI CD-ROM drives (required for RISC-based 
computers) 

One or more network adapter cards, if you want to use 
Windows NT with a network 

The Windows NT package supports computers with up to two microprocessors. 
Support for additional microprocessors is available from original equipment 
manufacturers. 



Welcome xxi 

Finding Information About Windows NT 
The Windows NT System Guide presents information for both new and 
experienced users who are installing and using Windows NT. Read this book for a 
description of the applications and tools provided in your Windows NT package. 
This manual presents procedures for completing common tasks such as organizing 
the desktop, managing files and directories, printing, using applications, 
administering the network, and more. 

Your product package also includes README text files that are copied to the 
\WINNT directory when you install Windows NT. These files contain up-to­
date information about specific hardware, printers, and networks. To see this 
information, choose the Read Me icon in the Main program group. 

The following section describes other sources of information for learning and 
using Windows NT. 

Additional Information 
Three other key sources of information included in the Windows NT package 
will help you plan for and use Windows NT: 

Online demonstration 
Covers the basics of Windows NT. View it at the conclusion of Windows NT 
Setup, or at any time by choosing the Introducing Windows NT icon in the 
Main program group. 

Online Help 
Always available when you press Fl while working in Windows NT. Or at the 
command prompt, type help or net help and then press ENTER. 

Windows NT messages database 
This database is provided on the Setup CD-ROM disk. It contains explanations 
of error and system information messages. For instructions on using the 
database, choose the Read Me icon in the Main program group. 

Microsoft Support Services 
Microsoft offers a variety of support options to help you get the most from your 
Microsoft product. For information on these options, refer to the Guide to Service 
and Support included in your Microsoft Windows NT package. 
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Conventions 
The following conventional terms, text formats, and symbols are used throughout 
the printed documentation for Microsoft Windows NT. 

Convention 

Bold 

Italic 

ALL UPPERCASE 

Monospace 

• 
• 
\WINNT 

Meaning 

Indicates the actual commands, words, or characters that 
you type in a dialog box or at the command prompt. 

Indicates a placeholder for information or parameters that you 
must provide. For example, if the procedure asks you to 
type filename, you must type the actual name of a file. Italic 
also indicates new terms and the titles of other books. 

Indicates a directory, filename, or acronym. You can use 
lowercase letters when you type directory or filenames in 
a dialog box or at the command prompt, unless otherwise 
indicated for a specific application or utility. 

Represents examples of screen text or entries that you might 
type at the command line or in initialization files. 

Indicates a procedure with sequential steps. 

Indicates a procedure with only one step . 

Indicates a list of related information, not procedural steps . 

Refers to the Windows NT system tree. All references to files 
in the Windows NT operating system assume that you installed 
Windows NT in this directory. 

Indicates the group membership required for the account 
used to log on to Windows NT in order to complete the task 
described. 

Indicates a speCial note for RISC-based computers. 

Guidelines for mouse and keyboard actions are described in Chapter 2, 
"Windows NT Basics." 
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Accessibility for People with Disabilities 
Microsoft is committed to making its products and services easier for everyone to 
use. This section provides information about the following products and services: 

• Microsoft support services for people who are deaf or hard-of-hearing 

• Keyboard layouts designed for people who type with only one hand or a wand 

• Microsoft software documentation on audio cassette and floppy disk 

• Hints for customizing Microsoft Windows NT 

• Products and services from other organizations 

Note The information in this section applies only to Windows NT users in the 
United States. If you are outside the United States, your Windows NT package 
contains an information card listing product support telephone numbers and 
addresses of Microsoft subsidiaries. You can contact your subsidiary to find out 
whether the type of products and services described in this appendix are available 
in your area. 

Microsoft Support Services 
for People Who Are Deaf or Hard-of-hearing 

Through a TDDrrT (text telephone) service, Microsoft provides people who 
are deaf or hard-of-hearing with complete access to Microsoft Product Support 
Services. 

You can contact Microsoft Product Support Services using a text telephone by 
dialing 206-635-4948 between 6:00 A.M. and 6:00 P.M. Pacific time. Microsoft 
support services are subject to Microsoft prices, terms, and conditions in place 
at the time the service is used. 

Keyboard Layouts for Single-Handed Users 
Microsoft supports Dvorak keyboard layouts that make the most frequently typed 
characters on a keyboard more accessible to people who have difficulty using the 
standard QWERTY layout. There are three Dvorak layouts: one for two-handed 
users, one for people who type only with their left hand, and one for people who 
type only with their right hand. The left- or right-hand keyboard layouts can also 
be used by people who type with a single finger or a wand. You do not need to 
purchase any special equipment in order to use these features. 
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Microsoft Windows NT already supports the Dvorak keyboard layout, which 
can be useful for coping with or avoiding types of repetitive-motion injuries 
associated with typing. You can select this layout through the International 
option in Control Panel. 

The two layouts for people who type with only one hand are distributed as 
Microsoft Application Note GA0650. The Application Note is also contained in 
the file GA0650.ZIP on most network services or GA0650.EXE on the Microsoft 
Download Service. If you have a modem, you can download Microsoft 
Application Notes from network services, including the following: 

• CompuServe® 

• GEnie™ 

• Microsoft OnLine 

• Microsoft Download Service (MSDL), which you can reach by calling 
206-936-MSDL (936-6735) any time except between 1:00 A.M. and 2:30 A.M. 

Pacific time. Use the following communications settings: 

For this setting Specify 

Baud rate 

Parity 

Data bits 

Stop bits 

1200,2400, or 9600 

None 

8 

1 

• Various user-group bulletin boards (such as the bulletin-board services on 
the Association of PC User Groups network) 

People within the United States who do not have a modem can order disks by 
calling Microsoft Product Support Services at 206-637-7098 or 206-635-4948 
(text telephone). 

Documentation on Audio Cassette and Floppy Disk 
People who cannot use printed documentation can obtain most of Microsoft's 
publications from Recording for the Blind, Inc. Recording for the Blind 
distributes these documents to registered members of their distribution service, 
either on audio cassette or on floppy disk. Recording for the Blind's collection 
contains more than 80,000 titles, including Microsoft product documentation 
and books from Microsoft Press. You can contact Recording for the Blind at 
the following address. 



Recording for the Blind, Inc. 
20 Roszel Road 
Princeton, NJ 08540 

Phone within the United States: 1-800-221-4792 
Phone outside the United States: 609-452-0606 
Fax: 609-987-8116 

Customizing Windows NT 
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You can adjust the appearance and behavior of Windows NT to suit your eyesight 
and motor skills. These adjustments do not require any additional software or 
hardware. 

You can use the following methods to adjust the appearance of Windows NT: 

• If you have trouble differentiating the system colors, or if they cause eyestrain, 
adjust them using the Colors option in Control Panel. 

• If the desktop pattern or wallpaper causes eyestrain, adjust them using the 
Desktop option in Control Panel. 

• If you have trouble locating the text selection cursor (also known as the caret 
or insertion bar), adjust the rate at which it flashes using the Desktop option in 
Control Panel. 

You can use the following methods to a<.ijustthe behavior of the mOllse: 

• If you have trouble positioning the mouse on a window frame in order to 
adjust the size of a window, increase the window border width using the 
Desktop option in Control Panel. 

• If you have trouble using the keyboard because of the speed at which it repeats 
or the delay time before it begins repeating, adjust these using the Keyboard 
option in Control Panel. 

You can use the following method to decrease the amount of typing you have 
to do: 

• Assign application shortcut keys to each application you run so that you can 
launch the application or switch to it with a single key combination. Assign an 
application shortcut key in a program information file using the PIF Editor, 
which is located in your Main program group. 
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Getting More Information 
For more information on Microsoft products and services for people with. 
disabilities, contact Microsoft Customer Sales and Service at 1-800-426-9400 
(voice) or 206-635-4948 (text telephone). 

The Trace R&D Center at the University of Wisconsin produces a book and 
a compact disc that describe products that help people with disabilities use 
computers. The book, titled Trace ResourceBook, provides descriptions and 
photographs of about 2,000 products. The compact disc, titled CO-NET CD, 
provides a database of more than 17,000 products and other information for 
people with disabilities. It is issued twice a year and is available in many 
public libraries. 

You can contact the Trace R&D Center at the following address: 

Trace R&D Center 
S-151 Waisman Center 
1500 Highland Avenue 
Madison, WI 53705-2280 

Voice telephone: 608-263-2309 
Text telephone: 608-263-5408 
Fax: 608-262-8848 

For general information and recommendations about how computers can help 
specific individuals, consult a trained evaluator who can best match individual 
needs with the available solutions. An assistive technology program in your area 
will be able to provide referrals to programs and services. Within the United 
States, you can locate the nearest assistive technology program by contacting: 

National Information System (NIS) 
Center for Developmental Disabilities 
University of South Carolina, Benson Bldg. 
Columbia, SC 29208 

Voice/text telephone outside South Carolina: 1-800-922-9234 ext. 301 
Voice/text telephone in South Carolina: 1-800-922-1107 
Voice/text telephone outside the United States: 803-777-7826 
Fax: 803-777-6058 
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Introducing Windows NT 

After you install Windows NT, you can begin working right away. Windows NT 
takes care of most configuration tasks automatically, including preserving 
settings for other operating systems such as MS-DOS, if you maintain dual-boot 
capabilities. You can run your applications and manage files immediately, without 
editing special configuration or initialization files. 

This chapter presents the basic information you need to get started with 
Windows NT and explains what you can do with the Windows NT operating 
system. 

If you are new to using a graphical user interface such as Microsoft Windows or 
if you want a quick review, see Chapter 2, "Windows NT Basics," for a summary 
of the basic procedures you need to know .. 
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Starting and Quitting Windows NT 
This section describes how to start Windows NT and log on to your computer, 
and also describes how to use online Help and the Windows NT introductory 
demonstration. 

Starting Windows NT 
Because Windows NT is a secure system, you must identify yourself, or "log on," 
and enter a password each time you start Windows NT. 

t.. To start Windows NT 

1. Turn on your computer. 

2. If your computer is configured to start more than one operating system, 
press an arrow key at the startup screen to choose Windows NT, and then 
press ENTER. 

3. When the logon message appears, press CTRL+ALT+DEL to log on. 

~ Press Clrl+AIt+Del to log on 

Important The CTRL+ALT +DEL sequence ensures the security of your system. 
Even if you see a message already displayed that asks you to enter your 
password, always press CTRL+ALT +DEL before you type your password. 

4. In the Welcome dialog box, type your username and password, and also select 
either your local computer name or the name of a Windows NT Advanced 
Server domain, and then choose the OK button. 

!!sername: 

[rom: 

~assword: 

In this box, choose either your 
computername or a Windows NT 
Advanced Server domain name. 
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Your username and password are unique identifiers defined while running Setup. 
If you do not know the correct entries for logging on a computer, ask your 
network administrator. 

• The entry in the Username box is the name you entered while running Setup 
to identify your local user account, or it is the domain username assigned by 
the network administrator. Each time you log on, Windows NT proposes the 
username for whoever last logged on at this computer. 

• The entry in the From box is either a local computer name or the name of a 
Windows NT Advanced Server domain. For example, if you are logging on 
using an account stored locally at the workstation, select the workstation name 
in the From box. If your username corresponds to a domain account, select the 
domain name in the From box. Note that you can only log on to a domain at 
a computer that belongs to a domain. 

• The entry in the Password box is the one you defined while running Setup or 
that the network administrator defined for you. Leave this box blank if there 
is no password defined for your user account. 

As soon as you log on, you can run applications, share files with other users on 
the network, connect to a printer, and control who has access to your computer 
and its files, as summarized in "What to Do After Setup," later in this chapter. 

Logging On to a Domain from a Remote Access Service 
Workstation 

You can log on to a domain from a remote workstation domain accounts exist 
for your computer and username. (For information on joining a domain, see 
"Configuring the Network" in Chapter 5, "Control Panel.") After logging on to 
a domain from a remote computer, you can improve system response time by 
turning off domain browsing. This keeps File Manager from browsing the 
domain whenever you try to connect to a network drive. 

I> To log on to a domain from a remote workstation 

1. Log on to your computer. 

2. Start the Remote Access Service. 

3. Connect to the network. 

4. From the File menu in Program Manager, choose Logoff. 

5. Choose the OK button. 

6. Press CTRL+ALT +DEL to log on. 
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7. In the Welcome dialog box, type your domain username and password, 
and also select the domain name in the From box. 

8. Type your password and then choose the OK button. 

J> To turn off domain browsing 

1. From the Main group, start File Manager. 

2. From the Disk menu, choose Connect Network Drive. 

3. From the Connect Network Drive dialog box, clear the Expand By Default 
box. 

4. Choose the OK button. 

Using Windows NT Help 
Online Help in Windows NT is a convenient, quick way to look up information 
about a task you are performing or a feature or dialog box you would like to know 
more about. 

Windows NT Help includes the following: 

• Full-text search capability that enables you to find Help information quickly 
and an explanation of how to use full text search 

• A description of each command available from the command prompt 

• /\ glossary of Windows NT terms 

• Information about Microsoft Product Support Services 

• Information about accessibility for users with disabilities 

Starting and Quitting the Online Demonstration 
The online demonstration installed with Windows NT introduces the built-in 
networking security and workgroup features of Windows NT. The topics include 
the following: 

• Logging on to Windows NT 

• Connecting to other computers and sharing files on a network 

• Creating user accounts and setting file permissions 

• Connecting to a printer 

• Using ClipBook to share information over the network 

• Communicating with other users 

Although it should not be a problem in Windows NT, the demonstration 
requires 450K of memory when running in MS-DOS or Windows 3.1. 
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I> To run the "Introducing Windows NT" online demonstration 

1. Choose the Introducing Windows NT icon in the Main group. 

2. To quit, press the ESC key once if you are viewing the main menu, or press ESC 
twice if you are viewing a topic. 

Quitting Windows NT 
When you are working in Windows NT, you can press CTRL+ALT+DEL to change 
your password, to lock or secure the computer, or to log off so that you can restart 
your computer or log on using another user account. 

I> To log off the current session 

• From the File menu in Program Manager, choose Logoff. Or press ALT+F4. 

-Or-

• Press CTRL+ALT+DEL, and then choose the Logoff button in the Windows NT 
Security dialog box. 

logon Information----------------, 

Anniep is logged on as BEAGlE\anniep. 

logDn Date: 3/17/199314:16 

Use the T ask. list to close an application that is not responding. 

Ir ~H ,iogcm:::"u" I H tn;,'Shutdo"ri: :::r.:: I 
r :'"'TaskUst::'." I W't;ari~ei':n:1 

t> To turn off your computer 

• From the File menu in Program Manager, choose Shutdown. 

-Or-

• Press CTRL+ALT+DEL, and then choose the Shutdown button in the 
Windows NT Security dialog box. 

Caution Never use the computer's power switch to quit Windows NT, or you 
may lose data. Always use Shutdown to quit, so Windows NT can save changes 
in all working files and properly close applications and services. 
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What to Do After Setup 
The Windows NT operating system affects every aspect of your work on the 
computer. Although Windows NT takes care of most configuration tasks 
automatically, you might want to modify your working environment or add 
clements to your system. This section suggests activities for using and modifying 
your system after installing Windows NT. 

Using Windows NT Applications 
Program Manager is the application that runs each time you start Windows NT . 

. You can use Program Manager to organize and start applications and tools. 
The first time you start Windows NT, Program Manager shows the Main group 
window open on the desktop, plus icons for several built-in program groups. 
For more information, see Chapter 3, "Program Manager." The following tables 
list the applications provided with Windows NT. 

Main Group 

Application 

~ File Manager 

• Control Panel 

g Print Manager 

~ Mail 

trm Schedule+ 

Command 
Prompt 

ClipBook 
Viewer 

~ PIF Editor 

• Windows NT 
Setup 

~l~! Introducing 
Windows NT 

~ Windows NT 
Help 

Used to 

Manage files and directories, share files on the network, and 
connect to shared directories on other computers. See Chapter 4 . 

Customize the fonts, color, and desktop, and configure hardware 
devices and the network. See Chapter 5. 

Connect to, configure, and share printers, and control printing 
of documents. See Chapter 6. 

Send and receive electronic mail. See Chapter 7. 

Maintain a personal calendar and schedule meetings 
automatically. See Chapter8. 

Start programs or run batch files for MS-DOS, 
MS OS/2 version 1.x, and POSIX. See Chapter 9. 

Store clippings from data files and share that information over 
the network. See Chapter 10. 

Create or change program information files for running 
MS-DOS-based applications. See Chapter 11. 

Install device drivers and Windows NT components. 
See Chapter 12. 

View an online demonstration of the networking, security, 
and workgroup features of Windows NT. 

Look up information about a task, feature, or dialog box. 



Administrative Tools Group 

Application 

~ User Manager 

~ Backup 

@] Event Viewer 

~ Disk Administrator 

~~ Performance Monitor 
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Used to 

Create user accounts and groups, and define policies for 
users and groups. See Chapter 13. 

Back up and restore files on a tape drive for NTFS, 
FAT, or HPFS file systems. See Chapter 14. 

View and manage event logs for system, security, and 
application events. See Chapter 15. 

View and manage hard disk partitions and other disk 
resources. See Chapter 16. 

Measure CPU use and other data on system 
performance. See Chapter 17. 

Setting Up Startup Applications 
You can specify which applications will start automatically whenever you log on. 
These changes will only be saved for your user account. If another user logs on to 
your computer, or if you log on to another user account, the startup applications 
defined for that user account will appear. 

J> To define startup applications 

• In Program Manager, open the Startup group and add a program item for 
each application that you want to start cach timc you log on, following the 
procedures in "Creating Program Items" in Chapter 3, "Program Manager." 

Setting Up Your Personal Working Environment 
You will probably want to configure the appearance and content of your basic 
workspace, the desktop. 

Note If your computer is a member of a Windows NT Advanced Server 
domain, the network administrator might have created a user profile for you. Ask 
your network administrator if a user profile controls your personal working 
environment. Changes you make to your workspace may not be retained the next 
time you log on if a user profile controls your workspace. 
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~ To configure how your workspace looks and sounds 

1. In Control Panel, double-click the Color, Desktop, and Sound icons to define 
how your desktop looks and sounds, following the procedures in Chapter 5, 
"Control Panel." 

2. In the command prompt window, choose commands from the Control menu 
to configure fonts, screen size, position, and color, following the procedures 
in Chapter 9, "Command Prompt." 

t> To set up custom program groups for running applications 

• In Program Manager, create program groups and add program-item icons, 
following the procedures in "What Are Groups and Program Items?" in 
Chapter 3, "Program Manager." 

t> To change your password 

1. Log on to Windows NT in the usual way, and then press CTRL+ALT+DEL. 

2. In the Windows NT Security dialog box, choose the Change Password button. 

3. In the Change Password dialog box, type your old password, a new password, 
and a confirmation in the appropriate boxes, and then choose the OK button. 

Configuring the Network 
Windows NT provides network services so that users can connect computers 
to share files, printers, and other resources. The following tools in Windows NT 
help you configure and monitor the network. 

To install, configure, or remove any network component and to join a workgroup 
or domain, you must be logged on as a member of the Administrators group. 

Use To 

Network in Control Panel Install and configure software to support the network, 
and to join workgroups or domains. 

Event Viewer View the system, security, and application events on a 
computer to monitor how the computer is being used. 

File Manager Share files and directories on the network, and connect 
to shared directories. 

Print Manager Share printers on the network, and connect to shared printers. 

Server in Control Panel View connected users, shared resources, and open resources; 
manage directory replication and designate recipients of 
administrative alerts. 

Services in Control Panel Start and stop network services. 

User Manager Manage user accounts, group members, and security policies. 
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Joining a Workgroup or Domain 

Note You do not need to complete this procedure if your computer joined the 
correct workgroup or domain when you ran Setup. 

In Windows NT, a workgroup is a collection of computers that appear under 
the same workgroup name on the network. This grouping makes it easy to find 
directories or printers shared by people you work with. Besides providing the 
same network browsing capabilities as a workgroup, a Windows NT Advanced 
Server domain is a collection of computers that can recognize the same user 
accounts. Membership in a domain is assigned by the domain administrator in a 
Windows NT Advanced Server network. 

t> Tojoin a workgroup or a Windows NT Advanced Server domain 

1. At the computer which will join the workgroup or domain, log on as a member 
of the Administrators group. For example, you might be able to log on under 
the username "Administrator" and use this account to make changes. 

2. In the Network option of Control Panel, choose the Change button beside the 
Workgroup or Domain name at the top of the dialog box, and then follow the 
procedure as described in "Configuring the Network" in Chapter 5, "Control 
Panel." 

Browsing Other Computers and Resources on the Network 
In Microsoft Windows-based networking you can browse domains, workgroups, 
and computers to look for shared directories and printers. 

t> To browse for shared directories on the network 

1. In File Manager, choose Connect Network Drive from the Disk menu, or 
choose the Connect Drive button on the toolbar. 

2. The networks, domains and workgroups, computers, and shared directories are 
organized in a tree structure. From the Shared Directories box, choose an item 
to expand the list. Choose a network name to display available domains and 
workgroups, a domain or workgroup name to display available computers, or 
a computer name to display its shared directories. 
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~ To browse for shared printers on the network 

1. In Print Manager, choose Connect to Printer from the Printer menu, 
or choose the Connect to Printer button on the toolbar. 

2. From the Select Printer box, choose an item to expand the list. Choose a 
network name to display available domains and workgroups, a domain or 
workgroup name to display available computers, or a computer name to 
display its shared printers. 

3. To connect to a printer, double-click a printer name. 

Managing Files and Disks 
A key function of any operating system is to provide a file system for storing 
and managing your application and data files. The tools for file management 
in Windows NT include the following. 

Use 

File Manager 

Server in Control Panel 

Convert utility 

Managing Files 

To 

Create and delete directories, manage files stored in 
directories, and define file attributes. 

View and remotely manage other computers. 

Change a FAT or HPFS file system to NTFS for a disk 
partition after Setup. Run CONVERT.EXE from the 

. command prompt. 

When you format a hard disk, you prepare it to store files using a particular file 
system. Most operating systems require a specific file system to store files on a 
hard disk. Windows NT automatically supports the following three file systems: 

• The Windows NT file system (NTFS) is a new advanced file system that 
supports file recovery, extremely large storage media, and long filenames. 
NTFS is required if you want maximum data security for your installation, 
and is recommended if Windows NT is the only operating system on your 
computer. 

• The file allocation table (FAT) is the file system used by the MS-DOS 
operating system, limited to eight-character filenames with three-character 
extensions. FAT does not provide security. FAT is required for the system 
partition if you also use MS-DOS on your computer. 

• The high-performance file system (HPFS) is the file system used with the 
OS/2 operating system version 1.2 or later, which supports long filenames. 
HPFS does not provide security. 
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If you choose to install Windows NT on a disk partition formatted for FAT or 
HPFS, Windows NT automatically observes all the file-naming conventions 
of those file systems. For more information, see "Working with Files and 
Directories" in Chapter 4, "File Manager"; see also the online Command 
Reference and your documentation for Microsoft MS-DOS or Microsoft OS/2. 

If you choose to use NTFS with Windows NT, these new file-naming conventions 
apply: . 

• File and directory names can each be up to 256 characters, including 
extensions, and a name can have multiple extensions separated by periods. 

• Names can contain any uppercase or lowercase characters except the 
following: 

?\ * < > 1/: 
• If you mix uppercase and lowercase characters in a filename, Windows NT 

preserves the case when it displays the name. However, Windows NT does not 
regard case when distinguishing filenames you enter in dialog boxes or at the 
command prompt. 

• You can search for filenames or perform other multiple-file operations in 
Windows NT using wildcards, where an asterisk (*) stands for a whole word 
or group of characters, and a question mark ('1) represents a single character. 

When you create a file with a long name under NTFS, Windows NT also 
automatically creates a filename that is compatible with MS-DOS, so that 
computers running MS-DOS or applications that don't support long filenames 
can still identify the file. 

Setting Up to Print 
Windows NT provides several advantages in printing: 

• If you use Windows NT printers on the network, separate printer drivers do not 
have to be installed on each workstation, because the printer driver is stored on 
a single computer. 

• You can browse for available printers on the network. 

• You do not have to redirect a port for the printer-you just connect to a 
printer using Print Manager. 

• You can manage your print job from your local computer. 

You can choose Print Manager in the Main program group of Program Manager 
to install and configure printers. 
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t> To connect to,. install, or configure a network printer 

• If the network printer is on a Windows NT network, follow the procedures 
in "Connecting to a Network Printer" in Chapter 6, "Print Manager." 

Or, if the printer is on another kind of network, follow the procedures in 
"Installing a Printer" in Chapter 6. 

Configuring Your System 
What happens when you start your computer depends on various elements: 

• The defaults you define for the boot loader and any user environment variables 
you define for applications 

• The services you configure to start automatically 

• The applications you specify in the Startup group in Program Manager 

• The contents of your logon script 

• Any user profile that might be assigned by the administrator for a Windows 
NT Advanced Server domain 

Th is section describes how to get started defining each of these elements. 

You can change some system settings only if you are logged on as a member of 
the Administrators group or if you belong to another group that can configure the 
computer. If you cannot change system settings, ask your network administrator 
for assistance. For more information, see "Managing the Security Policies" in 
Chapter 13, "User Manager." 

In Windows NT, you define all elements of your system configuration using 
graphical tools such as Control Panel and Windows NT Setup. Windows NT 
automatically stores values that define the working environment for Windows NT, 
plus the information for running applications or for using alternate operating 
systems. 

Control Panel is probably the main tool you will use to change your system 
configuration. For example, you can choose the Fonts option to install or remove 
screen fonts, including TrueType® fonts. Also, some configuration values change 
automatically when you install new software or when you define your workspace 
in an application such as Microsoft Excel. 
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The following key tools can be used to configure system hardware and software. 

Use 

Windows NT Setup 

Control Panel 

PIF Editor 

Print Manager 

System in Control Panel 

To 

Install drivers for the video display, mouse, and keyboard 
for the computer. Install or remove supporting components 
for Windows NT. 

Define desktop appearance and configure hardware and 
software for the computer and for the network. 

Change the memory settings required for running 
MS-DOS-based applications. 

Install and configure printers to be used with your computer. 

Define environment variables and preferences for alternate 
operating systems. 

Defining the Boot Loader 
and Other Operating System Variables 
You can specify the default operating system that your system proposes at startup, 
define user environment variables, and add or configure virtual-memory paging 
files to optimize performance in Windows NT. 

t> To configure boot loader, user environment variables, or virtual memory 

• In the System option of Control Panel, specify the settings you want, following 
the procedures in "Defining Options for the Operating System" in Chapter 5, 
"Control Panel." 

The boot loader defines the information needed for system startup, such as the 
location for the operating system's files. Windows NT automatically creates the 
correct configuration and checks this information whenever you start your system. 
How this configuration information is stored depends on your system's 
microprocessor: 

• For an x86-based computer, Windows NT saves your startup preferences in the 
BOOT.INI file in the root directory on your main hard drive. Configuration 
files such as AUTOEXEC.BAT and CONFIG.SYS arc used only to specify 
memory and other parameters for MS-DOS-based applications that you might 
run under Windows NT. 

• For a RISC-based computer, your startup preferences and all other system 
configuration information are stored in nonvolatile RAM. 

You don't have to keep another operating system such as MS-DOS on your 
computer to run applications created for that operating system. For information 
about running applications created for other operating systems, see Chapter 11, 
"Other Application Environments." 
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Setting Up Startup Network Services 
Windows NT starts several network services automatically, so that the capabilities 
of the Windows NT network are automatically available as soon as you want to 
work with the system. For example, the Computer Browser, Event Log, 
Workstation, and Net Logon services start each time you log on. You might also 
want to start other services automatically at system startup, depending on your 
system needs. For example, to share local files and printers on the network, you 
need to start the Server service by using the Services option in Control Panel. 

r> To start network services automatically when you log on 

• In the Services option of Control Panel, set up services that you want to start 
automatically, following the procedures in "Managing Services" in Chapter 5, 
"Control Panel." 

Setting Up User Accounts and Groups 
If your computer is not a member of a Windows NT Advanced Server domain, 
you must create local user accounts and specify user groups. You might want 
to create user accounts and groups for everyone who will use your computer. 

A lIser account consists of all the information that Windows NT uses to allow 
someone to use a computer, including the username, a description, a password, 
and the groups to which that user belongs. 

A group is an account that contains other accounts, which are called members. 
Groups provide an easy way to grant common capabilities to several users, 
because all rights and permissions assigned to a group are provided to its 
members. 

J> To set up user accounts and groups for a single computer 

1. In the Administrative Tools group in Program Manager, double-click the 
User Manager icon. 

2. Create the user accounts you want, following the procedures in "Managing 
User Accounts" in Chapter 13, "User Manager." 

3. Create the groups you want, following the procedures in "Managing Groups" 
in Chapter 13, "User Manager." 

Task Configuration application 

Set up user accounts 

Set up local groups 

Set up shared resources 

User Manager 

User Manager 

File Manager, Print Manager 
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Managing Security 
The security provided through Windows NT when you use N&FS, combined with 
regular use of the Backup utility, can eliminate almost all pos~bility of data loss. 
Security in Windows NT consists of two basic elements: preventing data loss 

\ 

resulting from unauthorized access or preventing data loss resulting from file 
~~. \ 

For most actions related to security, you must log on as a member of the 
Administrators group. 

Controlling Unauthorized Access 
To control unauthorized access, Windows NT includes tools for limiting initial 
access to the system itself, to specific files and directories, and to resources such 
as printers. Windows NT also includes tools for monitoring security events. 

The tools for controlling access to the system include the following. 

Use To 

CfRL+ALT+DEL Change your password. 

File Manager Share resources and estahlish permissions to protect 
specific files and directories. 

Network in Control Panel Define limits for sharing a computer's resources with 
other users on the network. 

User Manager Create user accounts for identification and authentication 
when the user logs on, and authorize the specific actions 
a user can perform on the system. 

You can also change your password by pressing CTRL+ALT +DEL and then 
choosing the Change Password button in the Windows NT Security dialog box. 

The tools for auditing security transactions in Windows NT include the following. 

Use 

Event Viewer 

File Manager 

Print Manager 

User Manager 

To 

Define the size and management of the security event log. 

Define the files, directories, and users to be audited. 

Define printers to be audited. 

Define the kinds of events to be audited. 
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Preventing File Damage and Data Loss 
When you use NTFS, Windows NT logs all file transactions, replaces bad sectors 
automatically, and stores copies of all vital information. Therefore, Windows NT 
can preserve disk integrity and ensure complete, rapid recovery after power 
failure or other system failures. 

No matter which file system you use, Windows NT also automatically preserves 
a previous working configuration to ensure that you can always start Windows 
NT, in spite of any changes to the system configuration that may occur during a 
work session. Windows NT also requires that you create an Emergency Repair 
disk while running Setup so that your system can be repaired if system files are 
corrupted at startup. For information on repairing your system, see "Repairing 
Your System" in Chapter 12, "System Maintenance with Windows NT Setup." 

S.etting Up Security Policies 
You can define three basic security policies for your computer: 

• The Account policy controls how passwords are used by user accounts. 

• The Audit policy controls what types of events are recorded in the security 
log (which you can view in Event Viewer). 

• The User Rights policy controls the rights assigned to groups and user 
accounts for your computer. We do not recommend that you change these 
default settings. 

I> To manage security policies for your computer 

• From the Policy menu in User Manager, choose Account or Auditing, and 
then follow the procedures in "Managing the Security Policies" in Chapter 13, 
"User Manager." 
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CHAPTER 2 

Windows NT Basics 

This chapter reviews the basics for working in Windows NT. These features and 
the related procedures in the graphical user interface of Windows NT are identical 
to those in versions of Windows for MS-DOS. If you are familiar with Windows, 
you can skip this chapter. You can practice any of the basic procedures described 
here without fear of harming your system. 

This chapter emphasizes using the mouse to complete tasks. For information 
about using the keyboard to work with windows and dialog boxes, see "Using the 
Keyboard," later in this chapter. The following topics are included in the chapter: 

• Selecting items for action 

• Managing windows 

II Choosing commands 

• Using the Control menu and Task List 

• Using Help 

• Using dialog boxes and responding to system messages 

• Copying and pasting information between applications 

• Using keyboard shortcuts 
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Selecting Items for Action 
In Windows NT, you can use a mouse or other pointing device such as a pen to 
select items and carry out actions. For example, you select an icon, window, or 
other element by pointing to it with the mouse and clicking. 

The following terms are used to describe mouse actions. 

Mouse term 

Point 

Click 

Double-click 

Drag 

Meaning 

Move the mouse until the tip of the mouse pointer rests on what 
you want to choose on the screen. 

Press and release the mouse button without moving the mouse. 
Clicking an item selects it. For many actions, you can select 
multiple items by holding down SHIff while clicking. 

Click the mouse button twice in rapid succession. 

Hold down the mouse button while you move the mouse. 
For some actions, you can extend a selection by pressing SHIff 

while dragging. For other actions, you can move a copy of a 
selection to another location by pressing CfRL while dragging. 

Guidelines for Selecting Items and Using the Mouse 
To use Windows NT efficiently, use the mouse to select items and initiate 
commands. The following list presents basic guidelines for using the mouse: 

• When you select an icon, dialog box option, or other item, the selection is 
highlighted. For example, selected text or the label on a selected icon appears 
in reverse color. 

• To cancel a selection, click another item. 

• Double-clicking usually initiates the same action as selecting the item and 
then choosing a command. For example, double-clicking an icon in Program 
Manager is the same as selecting the icon and then choosing the Open 
command from the File menu. 

• When you move the mouse, the mouse pointer shows your location on the 
screen and often changes shape when the pointer crosses different areas on 
the screen. The following table shows some examples. 
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Appears 

Where you can click to select items. 

Where you can drag the window border to size a window. 

Where you can draw or paint. 

Where you can enter text in a window or dialog box. 

When you start an application and can continue working 
while Windows NT completes a background task. 

All Windows NT operations take place on the desktop, the area of the screen 
where elements such as windows, icons, and dialog boxes appear. When you 
first start Windows NT, the Program Manager application window appears on 
the desktop, showing the Main group window and group icons for the other 
applications installed with Windows NT. 

You can move windows and icons around on the desktop. When you click a 
window to begin working, the title bar changes color to show that it's the active 
window, and the window automatically becomes the active window. 

You can switch to other windows on the desktop by clicking the window you 
want, or by pressing ALT+TAB to cycle through the running applications. You can 
also use the Task List to switch windows, as described in "Using the Control 
Menu and Task List," later in this chapter. 

Starting Applications in Program Manager 
Program Manager is a Windows NT application that you use to start applications 
and also to organize applications and working files in logical groups. Applications 
and files are represented in Program Manager as program-item icons, and 
organized in groups that appear as windows or icons within the Program Manager 
window. You start an application by choosing its icon. For more information, 
see Chapter 3, "Program Manager." 
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Moving and Sizing Windows 
You can move or size most windows in Windows NT, or scroll the contents of 
the window with the basic mouse actions shown in the following illustration. 

Drag the title bar to move a window. 

Drag a border or corner 
of a window to size it. 

Drag the scroll box to 
scroll continuously. 

Click a scroll arrow to 
scroll incrementally. 

The following list shows how to use the buttons in the window frame to manage 
the size and position of the window. 

Choose 

... 

.",. 

To 

Display the Control menu (this is the same as pressing 
ALT+SPACEBAR). 

Reduce the application to an icon (this is the same as choosing 
Minimize from the Control menu). 

Enlarge the application window to full screen (this is the 
same as choosing Maximize from the Control menu). 

Return the application window to its previous size (this is the 
same as choosing Restore from the Control menu). 
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Using Document Windows 
Some Windows-based applications also present document windows so that you 
can view more than one document simultaneously. You can size, scroll, and 
arrange document windows, but you cannot move them outside the application 
window . 

.Eile .Edit ~iew Insert Forma! TQols .!ielp 

... } Active 
window 

~====================================~~~~ 

Control menu Maximize button 

Choosing Commands in Windows NT 
When you work with applications in Windows NT, you choose commands to 
complete actions. The applications and tools included with Windows NT provide 
several ways to choose commands. You can: 

• Use the mouse or keyboard to choose commands from the menu bar. 

• Choose buttons on toolbars (where available). 

• Use the drag-and-drop features in Program Manager or File Manager 
to move, copy, and print files, or to start applications. 

This section describes how to choose commands from the menu bar in all 
Windows-based applications. For information about using drag-and-drop in 
Windows NT, see "Working with Files and Directories" in Chapter 4, "File 
Manager." For information about using a toolbar, see the documentation for 
your application. 
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In all Windows-based applications, commands are grouped on menus, with the 
menu names displayed in the menu bar across the top of the application window. 
Each application has different menus, but most applications include at least a 
File menu, Edit menu, and Help menu. 

I> To choose a menu command 

1. To display the menu, point to the menu name in the menu bar and hold the 
mouse button down. 

2. Drag to select the command you want, and then release the mouse button. 

You can also press the ALI key and the underlined 
letter in a menu name to display the menu ... 

~~~illITiBE~~~iF~~ ... then press the underlined 

Move ... 
J;.opy ... 
Qelete 

F7 
HI 
Del 

letter in the command name 
to choose it. 

Eroperties ... AIt+Enter 

Bun ... 

10goff... AIHF4 
.shutdown ... 

Some commands have a shortcut 
key for choosing the command 
without displaying the menu. 

Guidelines for Working with Menus in Windows NT 
The following list presents some basic guidelines for menus: 

• When the menu is displayed, you can also press an arrow key to highlight 
a command name and then press ENTER to choose the command. 

• When you choose a command that ends in an ellipsis (oo.), the application 
displays a dialog box that asks you to supply more information. 

• If a command turns a feature on and off, a check mark (.f) appears by the 
command name when the feature is on. 

• When you choose a command that ends with an arrow (~ ), the menu cascades 
to display more command names. 

• If a command name is dimmed, it indicates that the command does not apply 
to the current situation or that you need to make a selection or complete 
another action before choosing the command. 
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Using the Control Menu and Task List 
All windows have a Control menu. You can use it to switch to another running 
application; close the window or quit the application; change the size and position 
of a window; or minimize or maximize it. 

Most dialog boxes and messages also have a Control menu, usually with 
commands for moving or closing the dialog box. 

cr k th C t I b on any 
I menu. 

I Ie e on ro -menu ox 
window to display its Contro 

=1 1;'!,l{;nFfl: /hjcj,ih:J!! 

Move 
liize 
Minimize 
Ma~imize • 

!;.Iose AIt+F4 

S~itch To ... CtrltEsc 

+1 f 

~J ... 
:Ip 
1-,.-

~ 
I-

1)- I--

f---, 

+ 
l+ 

I--

These commands are the same 
as dragging borders or using 
buttons to change the window. 

Choose Switch To if you 
want to use Task List. 

~ To use a window's Control menu 

1. Click the Control-menu box in a window, or click an application icon on 
the desktop. Or press ALT+SPACEBAR to display the Control menu for an 
application window or for a dialog box. Press ALT+HYPHEN (-) to display 
the Control menu for a document window. 

2. Choose a command for the action you want. 

The commands available on the Control menu vary for different applications, 
but most Control menus include at least the Move and Close commands. 

The Control menu for each application window includes the Switch To command, 
which displays Task List. You can use Task List to switch to other currently 
running applications, or to manage windows and icons on the desktop. 

Although it is usually easiest to switch to another window by clicking that 
window, your current application may fill the screen, or some of the windows 
may not be visible. With Task List, you can switch windows quickly without 
having to search for the window you want. 



24 System Guide 

~ To use Task List 

1. From the Control menu, choose Switch To; or press CTRL+ESC. 

2. In the task list, select the name of the application you want to work with. 

To switch to a task not on the list, in the New Task box, type the executable 
name for the task you want. Choose the Run button. 

New Task: ,-,-I p_br_us_h _____ ----'II Run I 
I 

3. Choose one of the following buttons for the action you want. 

Choose 

Switch To 

End Task 

Cancel 

Cascade 

Tile 

Arrange Icons 

To 

Switch to the application selected in the list. 

Quit the selected application. 

Close Task List. You can also press ESC or double-click the 
Control-menu box to quit. 

Display windows in layers, showing the title of each 
window. 

Resize all windows and arrange them side by side. 

Rearrange application icons on the desktop. 

~ To switch applications without using Task List 

• Press ALT+TAB. 

Continue pressing ALT + TAB until the window you want is displayed. 

If you do not want to use ALT + TAB for switching between windows, you can 
turn off this capability by choosing the Desktop icon in Control Panel and then 
selecting the Fast ALT + TAB Switching check box in the Desktop dialog box. 
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Windows NT provides Help so that you can get useful information quickly while 
you are working. Help contains a description of each command and dialog box, 
and explains procedures for most tasks. 

t> To get Help 

• Press Fl wherever you are working. 

The following illustration shows the Help Contents window for Program 
Manager. The Help Contents lists the major topics for the current application. 
From this window you can move to more specific information, in this example, 
to a full text search. 

o Start Find: .!iearch .. : , I Changing Properties 10 OOrg I Cilnccl 
OOuit' Look At: 

o Topic .lilies Only @ All Text Hints ... I 

Comm 
[g] Backup ~ 

OFile [g] ClipBook Viewer r-' 

OOpti [g] Control Panel 

OWin [g] E vent Viewer ,....., 
+ 
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I> To run a full text search for a Help topic 

1. In the Help window, choose the Find button. 

2. In the Find dialog box, type the word or phrase you're looking for. To find 
an exact match for a phrase, place quotes around it. 

Without quotes, the search will locate instances of words within the phrase 
as well as the phrase itself. 

3. Select All Text under Look At. 

4. Choose the Search button to perform the search. 

The following table summarizes the actions you can take while using Help. 

To 

Get help in a Windows-based 
application 

Get help in a dialog box or 
message box 

Get help on using Help 

See a list of Help topics 

Get help on a specific topic 

Go back to a previous topic 

Jump to another Help topic 

Display a definition 

Continue working with Help 
displayed 

Minimize Help to an icon 

View another Help file 

Exit Help 

Do this 

Press Fl for context-sensitive Help, or choose a command 
from the Help menu. 

Press Fl, or choose the Help button in the dialog box. 

From the Help menu, choose How To Use Help. 

Choose the Contents button. 

Choose the Search button and select a topic to view, 
or choose the Find button and enter text to search for. 

Choose the Back button, or choose the History button 
and double-click any listed topic. 

Click the underlined jump term, or choose a "hot" button 
in the Contents topics. 

Click the term with the dotted underline, and then click 
anywhere on the screen to close the definition. 

From the Help menu in the Help window, choose 
Always On Top. 

Choose the Minimize button in the Help window. 

From the File menu in Help, choose Open and select 
another .HLP filename. 

Double-click the Control-menu box. 

You can also set bookmarks for frequently used Help topics, and annotate 
any Help topic. These and other Help features are explained in Help. 
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Help is also available at the command prompt for all Windows NT commands. 
The following table shows the syntax for Help at the command prompt. 

Syntax 

help 

command!? 

help command 

net help 

net command I? 

net command /help 

net help command 

net help command /options 

Information provided 

Available native system commands. 

Description, syntax, parameters, and switches for native 
system commands, plus help for MS-DOS subsystem 
commands not listed when you type help. 

Description, syntax, parameters, and switches for native 
system commands. 

Available network commands. 

Syntax only for network commands. 

Syntax and description for network commands. 

Syntax and description for network commands. 

Parameters and switches for network commands. 

You can also use the online Command Reference, which displays additional 
details, examples, and conceptual information for the system or network 
command you typed. To start the Command Reference, double-click the Help 
icon in the Main program group. 

Using Dialog Boxes 
Windows NT displays a dialog box to ask for information and to provide 
information you need to proceed. When you choose a command that displays a 
dialog box, that dialog box may include areas where you type numbers or text. 
You may also see various options to change or view settings related to the 
command. 
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[8J Check box A 

Ilrop-down List: I(None) 

list Box: 

Iteml 
ltem2 
ltem3 
Itemil 
Item5 

Items =~~~ffi~i==111 
lext box: IUT n,m'Miij 
Spin button: ~ units 

Slow Fast 
S~ale: liB: 1 ~I' '1+1 

List box 

Command buttons 

Miscellaneous controls: text box, 
spin button, and scrolling scale. 

~ To use a dialog box 

I. Select options or type text to specify the information you want in a dialog box. 

Click an option to select it, or press ALT plus the underlined letter in the option 
name. If any item in a dialog box is dimmed, it is unavailable because it 
requires a selection or some previous action. 

To see a description of the options, press FI or choose the Help button in the 
dialog box. 

2. To move the dialog box in the window, drag its title bar. 

3. When you finish with the dialog box, choose the appropriate command button 
to carry out the command. 

Usually, clicking the OK button carries out the command. Sometimes the 
button that carries out the command has a label such as Open or Find Next. 

~ To close a dialog box without completing the command 

• In the dialog box, choose the Cancel button, or double-click the Control-menu 
box. 
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Guidelines for Buttons and Miscellaneous Items 
The following list presents some basic guidelines for using buttons and other 
items in dialog boxes. 

Option buttons and check boxes: 

• Click a round option button to select it and to turn off any other option in the 
group. You can select only one option button in a group. 

• Click a check box to turn that option on or off. You can select as many check 
boxes as you want. 

• When an option button or check box is selected, it's filled-a selected option 
button contains a dot and a selected check box contains an X. 

Command buttons: 

• If you choose a button with an ellipsis ( ... ), another dialog box appears. 

• If you choose a button with double arrows (»), the dialog box expands. 

List boxes: 

• Click an item in any kind of list to select it, or scroll to see more items. 

• In a drop-down list box, click the arrow to display a list of options to select. 

• In some lists, you can select multiple items. In such a list, click a selection a 
second time to turn it off. 

Miscellaneous items: 

• Type, edit, and paste text in any text box. If a text box contains text when you 
move to it, all the text is selected and any text you type replaces it. Press DEL 

or BACKSPACE to edit the text. 

• Scroll a spin button or type in the box to select a number. 

• Drag a scroll box to select a range in a scale. 
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Responding to Messages 
Windows NT displays messages or warnings if you should know about possible 
consequences of a command action, or if Windows NT requires more information 
or cannot complete a command for any reason. Most messages explain the 
problem and what you should do to continue working. 

~ To dismiss a message 

• Choose the OK button. 

If the message contains two or more command buttons, choose the OK button 
to proceed, or choose the Cancel button to cancel the action and dismiss the 
message. 

Cutting and Copying Information 
When you cut or copy information from an application, it is placed onto the 
Clipboard, which is a temporary storage area in your computer's memory. 
You can then paste that information from the Clipboard into other documents 
or applications. You can also use the Clipboard to transfer information between 
Windows-based applications and some MS-DOS-based applications. 

In some Windows-based applications, you can also paste information from the 
Clipboard to create a linked or embedded object. For more information, see 
Chapter 10, "Object Linking and Embedding." 

You can use the ClipBook Viewer to view and save the contents of the Clipboard. 
For more information, choose the ClipBook Viewer icon in Program Manager, 
and then press FI to get help. 

Transferring Information Between Windows-Based Applications 
You can use the Cut, Copy, and Paste commands in most Windows-based 
applications to copy or move information within a document, between documents, 
or between Windows-based applications. 
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t> To copy or move information with the Clipboard 

1. In your document, select the information you want to copy or move. 

2. To copy the information, choose Copy from the Edit menu. To move 
the information, choose Cut from the Edit menu. 

t> To paste information from the Clipboard 

1. If necessary, switch to the document or application that will receive 
the information from the Clipboard. 

2. Place the insertion point where you want the information to appear. 

3. From the Edit menu, choose Paste. 

Transferring Information Between MS-OOS-Based Applications 
When you are running an MS-DOS-based application under Windows NT, you 
can copy selected information or the entire screen onto the Clipboard. You can 
paste only text into an MS-DOS-based application, not a graphic or screen 
capture. 

t> To copy information from an MS-DOS-bascd application 

1. To open the application's Control menu, click the Control-menu box 
or press ALT +SPACEBAR. 

2. From the Control menu, choose Edit. 

3. From the cascading Edit menu, choose Mark. 

4. In the document, select the information you want to copy. 

5. From the application's Control menu, choose Edit, and then from the 
cascading Edit menu, choose Copy. 

In the command prompt window, the text is copied automatically. 

t> To paste text into an MS-DOS-based application 

1. Copy the information onto the Clipboard. 

2. Switch to the application into which you want to paste the information. 

3. Place the insertion point where you want the information to appear. 

4. From the application's Control menu, choose Edit, and then from the 
cascading Edit menu, choose Paste. 
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Copying Screen Images 
For both Windows-based applications and MS-DOS-based applications, you can 
copy an entire screen onto the Clipboard. For Windows-ba'sed applications, you 
can copy an image of the active window onto the Clipboard. You can place this 
image in any file that can save or display bitmap images. 

l> To copy the entire screen onto the Clipboard as text 

• Press PRINT SCREEN. 

To copy a screen image for a non-Windows-based application, the application 
must be running in text mode, not graphics mode. 

l> To copy an image of the active window onto the Clipboard 

• Press ALT + PRINT SCREEN. 

Using,the Keyboard 
Microsoft Windows NT and Windows-based applications provide a set of 
common keyboard shortcuts that you can use to carry out commands and select 
options in dialog boxes. You can use these shortcut keys to bypass the menus. 

The key names in the Windows NT documentation appear in small capital letters. 
For example, the Shift key appears as SHIFT, and the Control key appears as CTRL. 

The following conventions are used to describe keyboard actions in Windows NT. 

Convention 

KEYl+KEY2 

KEYl, KEY2 

Keypad 

Arrow keys 

Meaning 

A plus sign ( +) between key names means that you must press 
the keys at the same time. For example, "Press ALT+F4" means 
you press and hold down ALT while you press F4. 

A comma (,) between key names means that the keys must be 
pressed sequentially. For example, "Press ALT, HYPHEN (-)" 

means you press and release ALT, and then press the hyphen. 

The numeric keys to the right of the standard alphanumeric 
keys. Press NUM LOCK to toggle between numbers or arrow 
keys. 

The keys labeled uP, DOWN, LEFT, RIGHT, HOME, END, PAGE UP, 

and PAGE DOWN on the extended keyboard or on the keypad; 
used to move or scroll in a document, window, or list. 
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Each shortcut key may also work with the SHIFf, CTRL, and ALT keys for different 
actions. The following list shows the general uses for shortcut keys, either 
individually or in combination with other keys. 

Key 

ENTER 

ESC 

Fl, F2, F3, .•. 

INS, DEL, BACKSPACE 

TAB or arrow keys 

ALT+key 

SHIFT+key 

CTRL+key 

Used to 

Confirm or carry out an action. 

Cancel an action. 

Provide shortcuts for commands. If your keyboard has 
only 10 function keys, press ALT+FI for Fll, ALT+F2 for F12, 

and so on. 

Edit-insert, delete, or clear an item. 

Move the cursor, select an item, or scroll in a window or list. 

Choose commands or dialog box options, or perform other 
actions related to application windows. 

Extend the selection. 

Choose a command, apply an action in a dialog box, or 
perform an alternate action on a selected object. 

Using the Keyboard for Common Actions 
You can use standard keyboard procedures for many of the common tasks 
throughout Windows NT. The following procedures summarize how to start 
an application in Program Manager and open a file in an application. 

I> To start an application in Program Manager 

1. Press CTRL+ TAB to select the group you want to open, and then press ENTER 

to open that group window. 

2. Press an arrow key to select the program-item icon for the application you 
want, and then press ENTER to start the application. 

Or press SHIFf+ENTER to start the application as an icon. 
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~ To open a file in an application 

1. Press ALT to select the menu bar. 

2. To choose Open from the File menu, press F,O (the direct-access keys, which 
are indicated by the underlined letters in the menu bar and in the menus). 

Or press the RIGHT ARROW and DOWN ARROW keys to select and open the 
menu. Press the DOWN ARROW key to select Open, and then press ENTER 

to choose it. 

3. In the Open dialog box, press TAB to move between the list of files, 
directories, and drives, and then press an arrow key to select the filename 
or directory you want. 

4. To choose the OK button, press ENTER. 

To cancel your selection and close the dialog box, press ESC. 

This same series of keyboard actions works everywhere in Windows NT for 
choosing menu items and for selecting options in dialog boxes. 

Keyboard Shortcut Reference 
The following tables summarize common keyboard shortcuts in Windows NT. 
Keys that must be pressed sequentially are separated by a comma; keys that must 
be pressed at the same time are separated by a plus sign. 

Basic Windows NT Keyboard Shortcuts 

To 

Help: 

Open or switch to the Help window 

Move to and view the next jump term or definition 

Using Program Manager and File Manager: 

Open the selected icon 

Move a selected group or item 

Copy a selected item 

Clear a selected group or item 
I 

Edit properties of a selected group or item l 

Cascade the windows on the desktop 

Tile the windows on the desktop 

Press 

Fl 

TAB, ENTER 

ENTER 

F7 

F8 

DEL 

ALT+ENTER 

SHIFT+F5 

SHIFT+F4 

1 This shortcut also toggles between full-screen and window display for the command prompt and 
non -Windows-based applications. 
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Basic Windows NT Keyboard Shortcuts (continued) 

To 

Using File Manager: 

Expand the directory tree one level in File Manager 

Expand a directory branch in File Manager 

Expand all branches in File Manager 

Collapse a directory branch in File Manager 

Refresh the display 

Scrolling in a window or a dialog box: 

Scroll up or down one line, or left or right one item 

Scroll up one window 

Scroll down one window 

Scroll left one window 

Scroll right one window 

Moving and selecting in a window or a dialog box: 

Move to an item in a dialog box and select it 

Move left, right, up, or down in a window or 
dialog box 

Move to the beginning of a line 

Move to the end of a line 

Move up or down one window 

Move left one window 

Move right one window 

Extend the selection left, right, up, or down 

Extend the selection to the beginning of the line 

Extend the selection to the end of the line 

Extend the selection up one window 

Extend the selection down one window 

Extend the selection left one window 

Extend the selection right one window 

Press 

+ (keypad) 

* (keypad) 

CTRL+* (keypad) 

- (keypad) 

F5 

Arrow keys 

PAGE UP 

PAGE DOWN 

CTRL+ PAGE UP 

CTRL+PAGE DOWN 

TAB or arrow keys 

Arrow keys 

HOME 

END 

PAGE UP or PAGE DOWN 

CTRL+PAGE UP 

CTRL+PAGE DOWN 

SHIFT +arrow keys 

SHlFT+HOME 

SHlFT+END 

SHlFT+PAGE UP 

SHlFT+PAGE DOWN 

CTRL+SHIFT+PAGE UP 

CTRL+SHlFT+PAGE DOWN 
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Basic Windows NT Keyboard Shortcuts (continued) 

To 

Editing in dialog 'boxes or applications: 

Undo the last action 

Delete the selection 

Clear the selection 

Copy the selection 

Paste the selection 

Clear the preceding character 

Working with a window: 

Select the menu bar 

Carry out a command or action 

Cancel a command or action 

Toggling full-screen and window display 
for non-Windows-based applications2 

Select an application's Control menu 

Select the Control menu in a document window 

Display the Task List 

Move to the next application 

Quit the current application 

Working with multiple document windows: 

Move a document window 

Size a document window 

Maximize a document window 

Minimize a document window 

Restore a document window 

Close a document window 

Move to the next document window 

Switch to the previous document window 

Move to the next pane 

Move to the previous pane 

Press 

CfRL+Z or ALT+BACKSPACE 

SHIFr+DEL 

DEL 

CTRL+INS 

SHIFr+INS 

BACKSPACE 

ALTorFlO 

ENTER 

ESC 

ALT+ENTER 

ALT+SPACEBAR 

ALT, HYPHEN (-) 

CTRL+ESC 

ALT+TAB 

ALT+F4 

CTRL+F7, arrow keys 

CfRL+ F8, arrow keys 

CfRL+FlO 

CTRL+F9 

CTRL+F5 

CTRL+F4 

CTRL+F6 

CTRL+SHIFr + F6 

F6 

SHIFr+F6 

2 This shortcut also allows you to edit properties of a selected group or item in Program Manager and 
File Manager. 



CHAPTER 3 

Program Manager 

Use Program Manager to organize your applications and files in groups and 
to easily start applications. 

This chapter explains how to use Program Manager, including the following 
topics: 

• Quitting Windows NT 

• Working with group windows and icons 

• Creating and deleting groups 

• Creating, copying, moving, and deleting program items 

• Changing program item icons 

• Starting applications from Program Manager 

• Starting applications automatically when you log on to Windows NT 

37 
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Overview 
Use Program Manager to start applications and to organize applications and 
files on the Windows NT desktop. Program Manager starts when you log on to 
Windows NT. The name of the computer or domain that you specified when you 
logged on and your username appear in the title bar of the Program Manager 
window. When you want to leave Windows NT, use Program Manager to log 
off or shut down your computer. . 

The first time you log on to Windows NT, Program Manager opens on your 
desktop with the Main group window open inside the Program Manager window. 

Program-item icons 

Mail Print Manager 

I~ 111 ~ ~ ille!! 
:1~JN: ~ 

Command Windows NT PIF Editor Windows NT Introducing Read Me 
Prompt Setup Help Windows NT 

Accessories Administrative Games Startup Applications 
Tools 

Group icons 

Program Manager lets you organize your applications so that you can easily 
find and run them. To get working quickly, you can have an application open a 
document automatically when it starts. Or you can start applications automatically 
when you log on to Windows NT. Use groups and program items to organize your 
applications. Groups can be displayed as windows or icons. 

Program-item icons appear inside a group window and represent the 
applications, accessories, and documents you can start from Program Manager. 
Double-clicking a program-item icon starts the application that the icon 
represents. Program-item icons can be moved between groups but not outside 
of them. 
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A group window is a separate window inside the Program Manager window 
that contains program-item icons. Each group window has its own Control menu 
in the upper left corner, but no menu bar. You can control group windows using 
commands from the Program Manager menu bar. Group windows cannot be 
moved outside the Program Manager window. 

A group icon is a minimized group window. Group icons appear along the lower 
edge of the Program Manager window. Each is labeled to indicate what sort of 
program items are in the group. Like group windows, group icons cannot be 
moved outside the Program Manager window. 

Quitting Windows NT USing Program Manager 
Program Manager runs as long as you are running Windows NT. To end your 
Windows NT session when you want to leave your computer running, return to 
Program Manager and log off. When you want to turn off your computer, return 
to Program Manager and use the Shutdown option. 

t> To log off from Windows NT 

1. From the File menu, choose Logoff. Or double-click the Control-menu box. 

2. Choose the OK button to confirm that you want to log off. 

The system closes any running applications and displays the Welcome 
dialog box. Before closing an application, the system prompts you to save 
any unsaved work. Running services are not stopped. 

t> To shut down your computer 

1. From the File menu, choose Shutdown. 

2. Choose the OK button to confirm that you want to shut down your computer. 

The system closes running applications and services, and informs you when 
you can safely switch off your computer. 

If you want to restart your computer immediately rather than switch it off, 
select the Restart When Shutdown Is Complete check box. Windows NT 
automatically restarts after closing applications and services. 

Caution Never use the computer's power switch to quit Windows NT. Always 
choose the Shutdown command to quit, so Windows NT can save changes in all 
working files and properly close applications and services. 
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What Are Groups and Program Items? 
A group contains program items. You can display a group as either an icon 
or a window. When a group window is open, you can work with its program 
items-icons that represent applications. When you choose a program item, 
the application it represents starts. If you have specified a document in the 
program item, the application opens the document for you when it starts. 

Groups provide a convenient way to organize your applications, and program 
items provide an easy way to start your applications. Because you can associate 
a file with an application when you create a program item, you can create groups 
that organize files belonging to a project and let you easily switch from one part 
of the project to the next. 

Windows NT provides personal groups and common groups. Personal groups are 
stored as part of each user's logon information. Each time a particular user logs 
on, that user's personal groups appear. Common groups appear for all users who 
log on to the computer. Personal and common groups have different icons: 

Personal 
Applications 

Common 
Applications 

When you installed Windows NT, the system created groups and program items 
for applications. 

Group 

Main 

Applications 

Administrative Tools 

Accessories 

Games 

Startup 

Description 

Contains the Windows NT system applications including File 
Manager, Control Panel, and Print Manager. The Read Me item 
contains information you should know before you start working 
with Windows NT. 

Contains applications found on your hard disk. 

Contains applications for system management including 
User Manager, Disk Administrator, and Backup. 

Includes applications for word processing, drawing, and 
communications, plus several other applications such as a 
clock and a calculator. 

Offers games you can use to practice Windows skills. 

Contains applications that start when you log on to Windows 
NT. You can add any applications you want to this group; it is 
empty until you add applications to it. 
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Opening Group Windows and Reducing Them to Icons 
To start an application from a group, first open the group window that contains 
the program-item icon for that application. Once you have started the application, 
you can reduce the group window to an icon to free room on your desktop. For 
more information on starting applications, see "Starting an Application from a 
Group," later in this chapter. 

t> To open a group window 

• Double-click the group icon. Or select the group's name from the list at the 
bottom of the Window menu. Or press CTRL+F6 or CTRL+ TAB until the group 
icon you want is selected, and then press ENTER. 

t> To reduce a group window to an icon 

• Click the Minimize button, or double-click the Control-menu box for the 
group. 

Arranging Group Windows 
When several group windows are open, some windows will hide others. 
Use the Cascade and Tile commands from the Window menu to arrange all 
the open windows so that some part of each window is visible. 

The Cascade command resizes and layers the open group windows within 
the Program Manager workspace so that each title bar is visible. 
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The Tile command divides the Program Manager workspace into smaller 
windows of similar sizes for each group window you have open. 
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If you open another group window after you use the Cascade or Tile command, 
it covers the arranged windows. To arrange it with the other windows, choose 
the Cascade or Tile command again. 

l> To arrange all the open group windows 

• From the Window menu, choose Cascade or Tile. 

Arranging Group and Program-Item Icons 
You can arrange icons one at a time, or have Program Manager organize them 
all at once. When Program Manager arranges group icons, it aligns them along 
the lower edge of the Program Manager window. When arranging program-item 
icons, Program Manager distributes them within their group window. 

l> To arrange icons one at a time 

• Drag each icon to a new location. 

l> To arrange group icons 

1. Select any group icon. 

2. From the Window menu, choose Arrange Icons to align the group icons 
along the lower edge of the Program Manager window. 
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I> To arrange program-item icons 

1. Open the group window that contains the program-item icons you want to 
rearrange. 

2. From the Window menu, choose Arrange Icons to distribute the program-item 
icons evenly within the selected group window. 

Windows NT can automatically arrange program-item icons whenever you 
change the window size, or add, delete, or move program items. You can adjust 
the spacing between icons by choosing the Desktop icon from Control Panel, 
and then typing a number in the Icon Spacing box. 

I> To automatically arrange icons 

• From the Options menu, choose Auto Arrange. 

A check mark beside the command means it is in effect. 

Saving Program Manager Settings 
Once you have set the appearance of your group windows and icons, you can save 
it. Then each time you log on to Windows NT, they will appear as you set them 
up. As an alternative, you can choose to save the appearance of group windows 
and icons as they are when you log off of Windows NT. When you next log on to 
Windows NT, they will appear as they were when you logged off. 

t> To save the current settings 

• From the Options menu, choose Save Settings Now. 

So that different settings are not saved when you log off from Windows NT, 
make sure that the Save Settings On Exit command is not checked. 

t> To save settings when you log off from Windows NT 

• From the Options menu, choose Save Settings On Exit. 

A check mark appears next to the command. You can turn this feature off 
by choosing the command again. 
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Creating Groups 
You can create personal and common program groups using Program Manager. 
Generally, you will only need to create personal groups. When you log on, the 
groups you have created are ready for you. When another user logs on to the 
computer, that user does not see your program groups. You can add any number 
of groups to Program Manager to organize your applications and documents in a 
way that makes sense to you. After creating a group, you can add program items 
to it. For more information, see "Creating Program Items," later in this chapter. 

Create a common program group only when you want all users of the computer to 
have access to the program items in the group. If, for example, you have installed 
an application that you want to make available to all users of the computer, you 
can place it in a common program group. 

To create a common group, you must be logged on as a member of the 
Administrators or Power Users group. Users who are not members of one of these 
groups can copy program items from a common group to their personal groups; 
however, they cannot delete or move program items from common groups. 

~ To create a new group 

1. From the File menu, choose New. 

New------------~ 

o Program Item 

@ le.·~.~.i.~·~.~f.·.~.~.~·g.~.~·~.·.·.§.·~·~.~·p.j 
o I;ommon Program Group 

2. In the New Program Object dialog box, select Personal Program Group or 
Common Program Group, and then choose the OK button. 

3. In the Description box, type a description for the group you want to create 
and choose the OK button. 

This description will appear in the title bar of the group window and below 
the group icon. 
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Creating Program Items 
To create a program item, define the properties for the item. You can create a 
program item using Program Manager, File Manager, or Windows NT Setup. If 
you use File Manager or Windows NT Setup to create a program item, Windows 
NT will define the item's properties for you. Each method of creating program 
items has advantages: 

• Use Program Manager when you want to specify the program item's properties 
such as the application's working directory or which document the application 
will open when it starts. Also use Program Manager when you want to change 
a program item's properties. 

• When you are using a mouse, File Manager provides the most direct way to 
create a program item and place it in the group you choose. 

• Windows NT Setup is fastest when you need to create many program items 
at one time. For more information on this method, see Chapter 12, "System 
Maintenance with Windows NT Setup." 

Creating or Changing a Program Item 
Using Program Manager 
You can use Program Manager to create a program item for an application or for 
an application and a document. The following steps guide you through the basics 
of creating a program item. If you want, you can also specify a working directory, 
a shortcut key, and that the program start running minimized. 

To create or change a program item in a common program group, you must be 
logged on as a member of the Administrators or Power Users group. 

t> To create a program item using Program Manager 

1. Open the group to which you want to add the item. 

2. From the File menu, choose New to display the New Program Object dialog 
box. Then select the Program Item option and choose the OK button. Or press 
and hold down ALT while double-clicking in a blank area of the group 
window. 

I! escription: 

~ommand line: 

~ork.ing Directory: 

lihortcut Key: L-IN_on_e _______ ---' 

o Run Minimized 

Cancel 

Help 
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3. In the Description box, type a description that identifies the application. 

This optional description becomes the label that appears under the icon in the 
group window. If you leave this box blank, Program Manager labels the icon 
for you. However, a description of your own can be very useful, especially if 
you set up multiple program items for the same application. 

4. In the Command Line box, type the name of the program file, including its 
path and extension. 

For example, to add Microsoft Excel, located in a directory named C:\EXCEL, 
you would type: 

c: \excel\excel.exe 

If you don't know the name of the program file, choose the Browse button to 
display a list of files and directories. Select the appropriate filename from the 
list. You can use the directory listing to change to a different directory, if 
necessary. Choosing the OK button places the selected filename in the 
Command Line box. 

If you want the application to open a document when it starts, after the 
program name type a space and then the document's filename. Include the 
path required to locate the document. Be sure to separate the program name 
from the document name with a space. 

For example, to specify a spreadsheet named 92BUDGET.XLS, located in 
the C:\ADMIN\FY92 directory, as the document to be opened when you start 
Microsoft Excel, you would type: 

c: \excel\excel.exe c: \admin \fy92\92budget.xls 

If the document is in the same directory as the application, you can omit the 
path. For example, to specify a spreadsheet named EXPENSE.XLS, located 
in the C:\EXCEL directory, you would type: 

c:\excel\excel.exe expense.xls. 

5. Choose the OK button. 

The dialog box closes and the new program item appears in the group; 

You can also specify a working directory, a shortcut key, and whether the 
application starts as an icon in the Program Item Properties dialog box. 

J> To specify a working directory 

• In the Working Directory box, type the name of the directory. 

When you start the application, the directory you specify as the working 
directory will become the current directory. It will be the default directory 
in the application's Open and Save As dialog boxes when you open and 
save files. 
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~ To specify an application shortcut key 

• Type the key combination in the Shortcut Key box. 

A shortcut key allows you to switch quickly to the application when it is running. 
Valid shortcut-key sequences are CTRL+ALT+character, CTRL+SHIFT+character, 
SHIFT+ALT+character, and CTRL+SHIFT+ALT+character. Character can be any 
letter, number, or special character. When you type a character in the Shortcut 
Key box, Program Manager adds CTRL+ALT in front of it. To specify a different 
control-key sequence, you must type the sequence. 

You can reserve shortcut keys for an MS-DOS application by using Program 
Manager or PIF Editor. Shortcut-key settings made in Program Manager override 
settings made in PIF Editor. 

~ To run an application as an icon when it starts 

• Select the Ru'n Minimized check box. 

When this box is selected, the application is reduced to an icon when it starts. 
When you want applications you have added to the Startup group to run 
minimized when you start Windows NT, use this option. 

Once you have created a program item, you can change its properties. 

r> To change a program item 

1. Select the program item and choose Properties from the rile menu. 

2. Change any of the options in the Program Item Properties dialog box 
and choose the OK button. 

Creating a Program Item Using File Manager 
You can also use File Manager to create program-item icons in Program Manager 
groups. You can move applications and associated documents from File Manager 
directories to Program Manager group windows or group icons. 

To create a program item in a common program group, you must be logged on 
as a member of the Administrators or Power Users group. 

The following steps require a mouse and have no keyboard equivalent. 

r> To create a program item using File Manager 

1. Arrange your desktop so that you can see both File Manager and the group 
where you want to place the new program item. 

The destination group can be either a window or an icon. 
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2. Open the File Manager window, and if necessary position and resize it. 

If no other application windows are open, you can use the Tile button in the 
Task List to arrange the File Manager and Program Manager windows. 

3. Locate and select the program or document file in File Manager that you want 
to add. You can select multiple items and add them all to a group at the same 
time. 

4. Drag the file from File Manager to Program Manager, and place it in the group 
window or on the group icon. 

As you drag the file, the mouse pointer turns into a replica of a file icon. If you 
have more than one file or document selected, you see a multiple-file icon. 

Once you have created the program item, you can customize its properties 
by selecting the icon and choosing Properties from the File menu. For more 
information on program-item properties, see "Creating or Changing a Program 
Item Using Program Manager," earlier in this chapter. 

Deleting Groups and Program Items 
When you no longer need a group or program item, you can delete it. When you 
delete a group, Program Manager deletes the program items it contains. Deleting 
program items has no effect on the corresponding application and document files. 
They are not removed from your hard disk. 

To delete a common program group or program items in a common group, you 
must be logged on as a member of the Administrators or Power Users group. 

~ To delete a group 

1. If the group contains program items, reduce it to an icon. If the group window 
is empty, you can delete it without reducing it to an icon. 

2. Select the group icon or empty group window. 

3. From the File menu, choose Delete. Or press DEL. 

4. A dialog box prompts you to confirm the deletion. Choose the Yes button 
to remove the group. 

~ To delete a program item from a group 

1. Open the group window that contains the item you want to delete. 

2. Select the program-item icon. 

3. From the File menu, choose Delete. Or press DEL. 

4. A dialog box prompts you to confirm the deletion. Choose the Yes button to 
remove the program item. 
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Changing the Description of a Group 
You can change the description of any group. The description is the label for 
the group icon and appears in the title bar of the group window. 

To change the description of a common group, you must be logged on as a 
member of the Administrators or Power Users group. 

t> To change the description of a group 

1. Make sure the group whose description you want to change is reduced to 
an icon. 

2. Select the group icon. 

3. From the File menu, choose Properties. Or press and hold down ALT while 
double-clicking the program-group icon. . 

4. In the Program Group Properties dialog box, type a new description, and 
then choose the OK button. 

Copying a Program Item to Another Group 
The easiest way to copy a program item from one group to another is to use the 
mouse to drag the program-item icon onto the other group icon or into the other 
group window. If you don't have a mouse, you can use the Copy command on 
the File menu. 

You can always copy a program item from a common group to one of 
your personal groups. However, you must be logged on as a member of the 
Administrators or Power Users group to copy a program item from a personal 
group to a common group. 

I> To copy a program item to another group 

1. If you're not concerned with where the new program-item icon is placed in 
the group window, open the group window containing the program-item icon 
you want to copy and leave the destination group reduced to an icon. 

If you want to place the new program-item icon in a particular location in 
a group window, open the group windows for both the source and the 
destination. 

2. Press and hold down CTRL while you drag the program-item icon from 
its current location to the destination group's icon or window. 

The mouse pointer becomes a replica of the program-item icon you are 
copying. 
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3. When the copied icon is on top of the destination group's icon or inside the 
destination group's window, release the mouse button and the CTRL key. 

You can create a duplicate program item within a group. Press CTRL while 
dragging the icon to another place in the window. . 

~ To copy a program item to another group using the Copy command 

1. Open the group window that contains the program item you want to copy. 

2. Select the program-item icon. 

3. From the File menu, choose Copy. 

4. In the To Group box, select the name of the group you want to copy the 
program item to. 

5. Choose the OK button. 

Moving a Program Item to Another Group 
Moving a program item is easiest if you have a mouse. You can simply drag the 
program-item icon onto the other group icon or into a group window. If you don't 
have a mouse, you can use the Move command on the File menu. 

~ To move a program item from a common group, you must be logged on as a 
member of the Administrators or Power Users group. 

~ To move a program item to another group 

1. Open the group window that contains the program item you want to move. 

2. Drag the program-item icon to the destination group's icon or window. 

The mouse pointer becomes a replica of the program-item icon you are 
moving. 

3. When the program-item icon is on top of the destination group's icon or 
inside the destination group's window, release the mouse button. 

r> To move a program item to another group using the Move command 

1. Open the group window that contains the program item you want to move. 

2. Select the program-item icon. 

3. From the File menu, choose Move. 

4. In the To Group box, select the name of the group you want to move the 
program item to. 

5. Choose the OK button. 
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Changing an Icon 
When you add a program item to a group, Program Manager selects an icon 
for that item. You can change the icon displayed in the group window. 

To change an icon in a common group, you must be logged on as a member 
of the Administrators or Power Users group. . 

~ To change an icon 

1. Select the program item whose icon you want to change. 

2. From the File menu, choose Properties. 

3. In the Program Item Properties dialog box, choose the Change Icon button. 

4. Use one of the following methods to select a new icon: 

• If more than one icon is available, select a different icon in the Current 
Icon box. 

• If no additional icons are available, Windows NT displays the icons 
available with PROGMAN.EXE. Select an icon in the Current Icon box. 

• In the File Name box, type the path to either PROGMAN.EXE or 
MORICONS.DLL, for example c:\winnt\system32\moricons.dll, and 
choose the OK button. Then select an icon in the Current Icon box. 

5. Choose the OK button. 

Starting an Application from a Group 
If an application is represented by a program-item icon in a group, the easiest 
way to start the application is to choose the program-item icon from the group 
window. If you included a document with the program item, it appears in the 
application workspace. For more information, see "Creating or Changing a 
Program Item Using Program Manager," earlier in this chapter. 

~ To start an application from a group 

1. Open the group window that contains the program-item icon for the 
application. 

2. Double-click the icon. 

When you start an application, Program Manager changes the current directory 
to the directory you specified in the Working Directory box when you added the 
program item to the group. If you are using an MS-DOS application, you can 
specify a working directory in either Program Manager or PIF Editor. Settings 
made in Program Manager override PIF Editor settings. 
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Use the following steps to run an application as an icon when you start the 
application. 

~ To run an application as an icon 

1. Open the group window that contains the program-item for the application. 

2. Press and hold down SHIFT while double-clicking the icon. 

You can have Windows reduce Program Manager to an icon whenever you start 
an application. This is useful because the icon remains visible on the lower edge 
of the desktop when most applications are running, making it easy to find when 
you want to switch to Program Manager. 

~ To reduce Program Manager to an icon whenever you run an application 

• From the Options menu, choose Minimize On Use. 

A check mark appears beside the command when it is in effect. To cancel 
the command, choose it again. 

Starting an Application When You Start Windows NT 
When you install Windows NT using the Setup program, Windows NT creates 
a Startup group. When you add a program item for an application to the Startup 
group, the application starts each time you log on to Windows NT. 

For example, if you want to start File Manager whenever you log on to Windows· 
NT, move the File Manager icon from the Main group to the Startup group. 
Program items in the Startup group start in the order their icons appear in the 
window starting with the top row, and moving left to right. 

You can also have Windows NT automatically reduce an application to an icon 
when it starts. To do this, select the Run Minimized box in the Program Item 
Properties dialog box for the application's program item. 

Returning to Program Manager from an Application 
When you are working with an application or document and you want to start 
a different application, you can do so by returning to Program Manager. 

~ To return to Program Manager from an application 

• Click the Program Manager window or double-click the Program Manager 
icon. Or press ALT+TAB repeatedly until the message box shows the Program 
Manager title and icon. Or press ALT+ESC repeatedly to move through open 
application windows and application icons until you reach Program Manager. 
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CHAPTER 4 

File Manager 

File Manager allows you to organize and work with directories and files. 

This chapter explains how to use File Manager and includes the following topics: 

• U sing directory windows to display directories and files 

• Navigating drives and directories 

• Working with directories and files 

• Sharing directories and files 

• Securing directories and files 

• Maintaining disks 
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Overview 
File Manager displays the organization of the directories and files on your disk 
drives and on network disk drives. Use File Manager to create and remove 
directories; move, copy, and delete files; connect to directories shared on the 
network; share directories; secure files and directories; and perform other disk, 
directory, and file management tasks. 

When you first start File Manager, the File Manager window appears. It contains 
a menu bar, toolbar, drivebar, status bar, and a directory window that shows the 
contents of the current drive. 
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Directory window 

The toolbar provides quick access to commands through buttons and allows 
you to change drives by selecting from a list. 

The drivebar allows you to change drives by selecting one of the drive icons. 
Different icons represent the floppy and hard drives on your computer, network 
drives to which you've connected, and CD-ROM drives. 

The status bar shows you how much free space remains and total space exists on 
the current drive. It also shows you how many files are in the current directory 
and how much space they take up. 

The toolbar, drivebar, and status bar are displayed by default. You can remove 
them from the screen by choosing the Toolbar, Drivebar, and Status Bar 
commands from the Options menu. 
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Starting and Quitting File Manager 

I> 

~ 

By default, when you start File Manager, its window appears as it was when you 
last quit File Manager. Settings you make using the Options menu are always 
saved when you quit. The positions of directory windows and icons and the 
settings on the View menu are saved as long as the Save Settings on Exit 
command is in effect when you quit. 

To start File Manager 

• Choose the File Manager icon in the Main Group. Or select the File Manager 
icon and press ENTER. 

To quit File Manager 

• Choose the Control-menu box. Or, from the File menu, choose Exit. 

Customizing the Toolbar 
You can add, remove, and rearrange the buttons on the tool bar. Every command 
available on File Manager menus has an equivalent button. 

I> To add a button to the toolbar 

1. From the Options menu, choose Customize Toolbar. Or double-click the 
background of the toolbar. 

2. In the Available Buttons box, select the button that you want to add. Select 
Separator to add a space between buttons. 

3. Choose the Add button. 

I> To move a toolbar button 

• Press and hold down SHIff while dragging the button to a new location 
on the toolbar. 

-Or-

1. From the Options menu, choose Customize Toolbar. Or double-click the 
background of the toolbar. 

2. In the Toolbar Buttons box, select the button or Separator you want to move. 

To move the selection to the left on the toolbar, choose the Move Up button. 

To move the selection to the right on the toolbar, choose the Move Down 
button. 

3. Choose the Close button. 
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l> To remove a toolbar button 

• Press and hold down SHIff while dragging the button off the toolbar. 

-Or-

1. From the Options menu, choose Customize Toolbar. Or double-click the 
background of the toolbar. 

2. In the Toolbar Buttons box, select the button or Separator you want to remove, 
and then choose the Remove button. 

3. Choose the Close button. 

l> To restore the default toolbar buttons 

1. From the Options menu, choose Customize Toolbar. Or double-click the 
background of the toolbar. 

2. Choose the Reset button. 

3. Choose the Close button. 

Working with Directory Windows 
Each directory window is divided into two panes: the left pane displays the 
directory tree, and the right pane lists the contents of the current directory. The 
directory tree shows the structure of the directories on a disk. The directory 
structure begins at the upper left with the root directory, the first directory on a 
disk. The root directory is created when you format a disk. It is represented by a 
backslash (\). For example, C:\ is the root directory for drive C. Other directories 
branch below the root directory. The contents list in the right pane of the directory 
window shows the names of files and directories within the current directory. 
Directories within a directory are known as subdirectories. The panes are 
separated by a split bar that allows you to adjust their widths. 

Current directory 

Directory path with volume 
label or network name 
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The following table describes the elements in a directory window. 

Element 

Directory path 

Volume label 

Network name 

File system name 

Directory icons 

Current directory 

File icons 

Up icon 

Description 

The name and location of the current directory is displayed in 
the title bar of the directory window. 

The name that identifies your disk is displayed in brackets ([ ]) 
to the right of the directory path. This information appears only 
if you have assigned a label to your disk. 

If you have selected a shared directory, its name is displayed 
instead of the volume label. 

The name of the file system used on the selected drive is 
displayed next to the root directory. 

Icons representing directories and shared directories appear in 
both panes. In the directory tree, directory icons are connected 
by a vertical line to the directory level above them. In the 
contents list, directory icons represent directories in the current 
directory. 

The directory you are currently using is represented by an icon 
that looks like an open directory folder in the directory tree. 
File Manager commands affect the current directory or files 
within it. 

Icons next to filenames indicate file type. There are icons to 
represent program files, document files, and other types of files. 
For more information, see "Working with Files and 
Directories," later in this chapter. 

Double-clicking the arrow at the top of the contents pane takes 
you up one level in the directory tree. 

Opening and Closing Directory Windows 
You can open additional directory windows that display the contents of the same 
drive or a different drive. Opening multiple directory windows makes it easy to 
move and copy files. 

If you have two or more windows displaying the same drive and directory 
information, a number appears in the title bar of each window indicating that 
there is more than one window displaying that directory. 

A new directory window inherits its display options from the previous one. 
For example, if you are working with a directory window that shows only the 
directory tree, and you open a new directory window, the new window displays 
only the directory tree. 
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~ To open a new directory window 

To open a window 

That displays information for the 
selected drive 

. That displays the same information 
as the previous active window 

That displays only the contents 
pane for the selected directory 

Do this 

Double-click the drive icon. Or press TAB to 
select the drivebar and use the arrow keys to 
select a drive icon. Then choose Open from the 
File menu, or press ENTER. 

From the Window menu, choose New Window . 
Or from the toolbar, click the New Window 
button. 

In the directory tree, press and hold down SHIFT 

while double-clicking the directory icon. Or in the 
directory tree, select the directory icon, and then 
press SHIFf +ENTER. 

When you finish working with a directory window, you can close it to clear space 
on your screen. If you have only one directory window open, you cannot close it. 

~ To close the active directory window 

• Double-click the Control-menu box, located in the upper-left corner of 
the directory window. Or, from the Control menu, choose Close. 

File Manager updates open directory windows automatically. For example, when 
you save a new file from an application, File Manager displays the new file name 
immediately. Sometimes File Manager cannot complete an update when, for 
example, you are using network directories or you have changed floppy disks. 
You can update the active directory window manually when this occurs. 

~ To update a directory window 

• Click the drive icon for the current drive, or choose Refresh from the 
Window menu. 

Selecting and Arranging Directory Windows and Icons 
Before you can work with the files and directories in a directory window, you 
must select the window. Selecting the window makes it active: the title bar 
changes color or intensity and the window moves in front of any other open 
windows. 

t> To select an open directory window 

• Click anywhere in the window. Or choose a window name from the list at the 
bottom of the Window menu. Or press CTRL+F6 or CTRL+ TAB until the window 
you want is selected. 
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If the window you want to select is hidden by another window, you can use the 
Cascade or Tile commands on the Window menu to rearrange the open directory 
windows so that all of them are visible. 

~ To arrange open directory windows 

To 

Overlap windows so that each window's 
title remains visible 

Resize and arrange windows without 
overlap so that each window is wider 
than it is long 

Resize and arrange windows without 
overlap so that each window is longer 
than it is wide 

From the Window menu, choose 

Cascade 

Tile Horizontally 

Tile Vertically 

When you minimize a directory window, it becomes an icon. You can move 
icons individually by dragging them with a mouse, or File Manager can arrange 
them evenly all at once. For information about changing the spacing between 
icons arranged by File Manager, see "Changing the Desktop" in Chapter 5, 
"Control Panel." 

~ To arrange icons 

• From the Window menu, choose Arrange Icons. 

Displaying the Directory Tree or Contents 
When you first start File Manager, the directory window displays both the 
directory tree for the current drive and the contents of the current directory. By 
using commands on the View menu, you can choose to display only the directory 
tree or only the contents of the current directory. When both panes of a directory 
window are displayed, they are separated by a split bar that you can move to . 
change the widths of the panes. 

l> To display the directory tree or directory contents 

To display From the View menu, choose 

Only the directory tree for the current drive Tree Only 

Only the contents of the current directory Directory Only 

The tree and contents for the current Tree And Directory 
directory 
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~ To move the split bar 

1. Point to the split bar. 

The pointer turns into a double bar with two arrows. 

2. Drag the bar to a new position. 

-Or-

1. From the View menu, choose Split to display a vertical bar. 

2. Use the arrow keys to move the selection bar to where you want to place 
the split bar, and then press ENTER. 

If you decide you do not want to move the split bar, press ESC to cancel 
the command. 

Changing the Font in File Manager 
You can change the font that File Manager uses to display the names of files 
and directories. When you change the font, it changes in all directory windows. 

~ To change the font 

1. From the Options menu, choose Font. 

2. In the Font box, select the font you want to use. 

When you select a font, a style, or a size, the text in the Sample box changes 
to reflect your choice. 

3. In the Font Style box, select a style option (for example, bold or italic). 

4. In the Size box, select a point size: the larger the point size, the larger the 
character appears on your screen. 

S. By default, file and directory names appear in lowercase letters on FAT drives. 
On drives formatted to use the Windows NT files system (NTFS), names 
appear as they were typed in uppercase and lowercase. 

To display names on FAT drives in uppercase, clear the Display Lowercase 
For FAT Drives check box. 

To display names on all drives in lowercase, select the Display Lowercase 
For All Drives check box. 

6. Choose the OK button. 
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Navigating Drives and Directories 
You can use File Manager to change to different local and network drives and 
to navigate through the directory structure. 

Changing Disk Drives 
A directory window shows the directory structure of the current drive. On the 
drive bar, the icon for the current drive is surrounded by a rectangle. On the 
toolbar, the current drive is shown in the list box. 

When you change to a different drive, the names of the files and directories on 
that drive are displayed in the directory window. When File Manager searches the 
drive to display its contents, you can press ESC to stop the search. If you stop the 
search, only a partial directory tree is displayed, as indicated by the status bar at 
the bottom of the File Manager window. 

~ To select another drive in a directory window 

• Click the drive bar icon representing the drive you want to use. 

l[3a [3b ~c ;~dl 

Or choose the drive from the toolbar drive list. 

Or press and hold down CTRL while typing the letter of the drive you want 
to select. 

-Or-

1. Press TAB or F6 to move to the drivebar. 

To move back to the directory tree or contents area without changing drives, 
press TAB or F6 again. 

2. Use the arrow keys to select the drive icon you want, and then press the 
SPACEBAR. 
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J> To change drives by using the Select Drive command 

1. From the Disk menu, choose Select Drive. Or double-click the background 
of the drive bar to display the Select Drive dialog box. 

2. Select the drive you want to change to. 

3. Choose the OK button. 

Changing Directories 
You can change directories using either the directory or the contents list. 

In the directory tree, the current directory is marked by the selection cursor, 
a dotted rectangle around the highlighted icon and text. You can select only 
one directory at a time in the directory tree. To change to a different directory, 
move the selection cursor. 

In the contents list, you can move up or down one level in the directory structure. 
You can go up one level by choosing the Up icon, and you can change to a 
subdirectory by choosing its icon in the list. 

J> To change to another directory in the directory tree 

• Click the directory name you want to change to. Or use the following keys 
to change to a different directory. 

Press 

UPARROW or 
DOWN ARROW 

HOME or 
BACKSLASH (\) 

END 

RIGHT ARROW 

LEFT ARROW or 
BACKSPACE 

PAGE UP 

PAGE DOWN 

CTRL+UP ARROW 

CTRL+DOWN ARROW 

A charader key 

To change to 

A directory above or below the current directory. 

The root directory. 

The last directory in the list. 

The first subdirectory of the current directory, if one is 
displayed in the directory tree. 

The next directory level up from the current directory. 

The directory one screen up from the current directory. 

The directory one screen down from the current directory. 

The previous directory at the same level. 

The next directory at the same level. 

The next directory whose name begins with that letter or 
number. 
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I> To change directories by using the contents list 

To Do this 

Move down a level 

Move up a level 

D Choose the directory icon next to the subdirectory's name. 

'it~~ Choose the Up icon, or press the BACKSPACE key. 

Expanding and Collapsing the Directory Tree 
When you first start File Manager, only the first level of directories are displayed 
in the directory tree. 

When you expand a directory, the directory tree displays the names of the 
subdirectories in that directory. Like the structure of a tree, subdirectories branch 
from directories. You can expand an entire directory branch, a single level of the 
branch, or all branches in the tree. You can also collapse a directory so that its 
branch of subdirectories is not listed in the directory tree. 

I> To expand or collapse a directory 

To 

Expand one level of 
a directory 

Expand an entire branch 

Expand all branches in the 
directory tree 

Collapse a directory 

Do this in the directory tree 

Choose the icon or name of the directory you want to 
expand, or select the directory, and then choose Expand 
One Level from the Tree menu. 

Select the directory, and then choose Expand Branch from 
the Tree menu. 

From the Tree menu, choose Expand All. 

Choose the icon or name of the directory you want 
to collapse, or select the directory, and then choose 
Collapse Branch from the Tree menu. 

Showing Which Directories Expand 
If you want to know which directories have subdirectories, you can use the 
Indicate Expandable Branches command on the Tree menu. When you use this 
command, a plus sign (+) marks each directory that has subdirectories. The plus 
sign means you can expand the directory to display its subdirectories in the 
directory tree. After you expand a directory, the plus sign changes to a minus sign 
(-), indicating that the directory is expanded and can be collapsed. If you choose 
the Indicate Expandable Branches command, File Manager may take longer to 
create the directory tree. 
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Collapsible directory 

LJProposal 
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~Ideas.wri 
[£) Jan Research Notes. doc 

L:lmk.exe 
~ Noon Logo. bmp 
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~ To mark expandable directories in the directory tree 

• From the Tree menu, choose Indicate Expandable Branches. 

A check mark appears next to the command in the Tree menu. 

To turn off this feature, choose Indicate Expandable Branches again. 

Connecting to and Disconnecting from a Network Drive 
You can use File Manager to connect to and disconnect from network drives. 
When you connect to a network drive, you can specify whether or not to 
reconnect to the drive each time you log on to Windows NT. 

When you connect to a network drive, File Manager opens a new window in 
which to display the directory information. You can switch this feature off from 
the Options menu by choosing the Open New Window On Connect command. 

Computers in your computer's domain or workgroup are displayed automatically 
in the Shared Directories box. If you are connecting over a slow network, for 
example connecting through Remote Access Service, you can switch this off by 
clearing the Expand By Default check box. 

If you are logged on as a member of the Administrators or Backup Operators 
groups, you can connect to a computer's administrative root shares, for example 
\\SALESERVER\C$. Administrative shares are not displayed by the Shared 
Directories box in the Connect Network Drive dialog box. 
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I> To connect to a network drive 

1. Choose Connect Network Drive from the Disk menu, or choose the 
Connect Drive button on the toolbar. 

!!rive: I DE: 
~================~~ ~ath: I 
~============~~ ~onnect As: I 
~------------------------~ 

[g] !!ecDnnect at Logon 

lihared Directories: 

r Microsoft Windows Network 
~ ACCOUNTS 

+~AIREDALE 
-a INVOICE 

{i;;J BACKUP 
{i;;J CURRENT 
{i;;J PUBLIC 

+~RECEIPTS 
+~SETTER 

~ PROJECTS 
~ SHIPPING 

[g] .E,.xpand by Default 

ChrisBr 486 

Backup Files 
Current Invoices 
Public Files 

Print Server 

2. File Manager displays the first free drive letter in the drive box. You can 
accept the displayed drive letter for the connection, or choose another. 

3. Select or type a network path in the Path box. A network path consists of 
a computer name followed by the name of a shared directory, for example, 
\ \shipping\public. 

• If you have connected to the directory before, select the path from the list 
displayed in the Path box. The Path box displays the previous 10 paths. 

• You can use the Shared· Directories box to select a network path. 
In Microsoft Windows-based networking you can browse domains, 
workgroups, and computers to look for shared directories. Other 
networks may contain different resources you can browse. 
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t> 

~ 

The networks, domains and workgroups, computers, and shared directories 
are organized in a tree structure. Choose an item to expand the list. Choose 
a network name to display available domains and workgroups, a domain or 
workgroup name to display available computers, a computer name to 
display its shared directories. When you select a shared directory, File 
Manager fills in the Path box with the name you selected. 

• If you know the name of a computer, but need to see the names of its 
shared directories, you can type the computer name in the Path box and 
choose the OK button. Preface the computer name with two backslashes 
(\\). Windows NT adds the name of the computer's first shared directory to 
the Path box and displays all of the computer's shared directories in the 
Shared Directories box. To connect to different directory, select it in the 
Shared Directories box. 

• You can type the name of a network resource in the Path box. On a 
Microsoft Windows-based network, type the name of a computer and 
shared directory. Preface the computer name with two backslashes (\ \) and 
separate the computer name from the shared directory's name with a single 
backslash (\), for example \\shipping\salesql. 

4. By default, you are connected under the username you used to log on. If you 
want to connect under a different username, type it in the Connect As box. For 
example, you may want to connect to a shared directory using a name that 
allows greater access to files in the directory. 

On a Microsoft Windows-based network, you can connect using an account on 
a different domain by specifying the domain and the username for the account. 
Separate the domain name from the username with a backslash, for example 
projects\chrisbr. 

5. If you do not want to connect to the shared directory each time you log on, 
clear the Reconnect At Logon box. 

6. Choose the OK button. 

To disconnect from a network drive 

1. Choose Disconnect Network Drive from the Disk menu, or choose the 
Disconnect Drive button on the toolbar. 

2. In the Disconnect Network Drive dialog box, select one or more network 
drives and choose the OK button. 



Chapter 4 File Manager 67 

Working with Directory Information 
You can control how File Manager displays directory information by using 
commands on the View menu. 

The changes you make by using commands on the View menu affect the active 
directory window and any new windows you open from that window. Other open 
windows are not affected. In the contents list, File Manager displays icons next to 
names so that you can quickly identify directories and files. The following table 
describes the icons. 

Icon Represents 

LJ Directories. These are listed first, in alphabetical order. 

{;;:J Shared directories. These are directories you can connect to on the network, or 
you are sharing on your computer. 

r:J Program files and batch files. Their default filename extensions are .EXE, 
.CMD, .COM, .PIF, and .BAT. These files start applications. 

§] Document files. These files are associated with applications. When you open 
one of these files, the associated application starts automatically. For more 
information, see "Associating Files with an Application," later in this chapter. 

ITl System or hidden files. These files have system or hidden attributes~ 
For more information, see "Setting File Attributes," later in this chapter. 

D All other files. 

Displaying Information on Files 

t> 
D­
D-

When you first start File Manager, only the names of directories and files are 
shown. In addition to names, you can also display size, last modification date 
and time, and attributes of files in the contents list. On drives formatted to use 
the Windows NT file system (NTFS), you can display the MS-DOS-style 
names that Windows NT creates to accompany long filenames. 

To display only names of files and directories 

• From the View menu, choose Name, or choose the Name button on the 
toolbar. 

To display complete information about each file 

• From the View menu, choose All File Details, or choose the All File Details 
button on the toolbar. 

The file size, last modification date and time, and file attributes are displayed 
next to each filename and directory name in the active directory window. If the 
directory is on a drive formatted to use the Windows NT file system (NTFS), 
the short, MS-DOS filename is shown as well as the long filename. 
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~ To display selected information about each file 

1. From the View menu, choose Partial Details. 

2. Select the check boxes of options you want to display, and clear the 
check boxes of options you don't want to display. 

The table that follows describes each option. 

3. Choose the OK button. 

You can select the following options in the Partial Details dialog box. 

Select 

Size 

Last Modification Date 

Last Modification Time 

File Attributes 

MS-DOS filenames for 
NTFS 

To 

Display the size in bytes of each file. 

Display the date each file was last modified, according 
to the system clock. 

Display the time of day each file was last modified, according 
to the system clock. 

Indicate whether files are hidden, system, archive, or 
read-only. For more information, see "Setting File Attributes," 
later in this chapter. 

Display short, MS-DOS-style names for long filenames 
on drives formatted to use NTFS. 

Sorting the Contents of a Directory 
When you first start File Manager, it lists directory contents alphabetically, with 
directories first, followed by filenames. You can sort the files and directories by 
name, type, size, or the date the file was last modified. Sorting files and 
directories affects the contents list only. 

~ To sort the contents of a directory 

To sort contents by 

Alphabet: Directories are sorted first, 
then files. 

Type: Directories and then files are sorted 
alphabetically by filename extension. 

Size: The largest file is listed first. 

Date: Directories and then files are 
sorted with the most recent first. 

Or from the 
Use View menu, choose 

Sort By Name 

Sort By Type 

Sort By Size 

Sort By Date 
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Limiting the Files to Display 
When you first start File Manager, the contents list displays the names of all the 
files and directories in the current directory, except hidden and system files. (For 
information about hidden and system files, see "Setting File Attributes," later in 
this chapter.) You can specify whether File Manager displays only certain types 
of files, or groups of files with similar filenames or extensions. 

1> To specify which types of files are displayed in a directory window 

1. From the View menu, choose By File Type. 

2. In the By File Type dialog box, use the Name box to limit the display to a 
single filename. Use wildcards to limit the display to files with similar names. 

A wildcard substitutes for one or more characters. Use an asterisk (*) to 
represent a group of characters. Use a question mark (?) to represent a single 
character. The Name box default, *. *, means all files in the directory are listed .. 
For example, to display only those files with the extension .TXT, you can 
type * .txt. 

3. Under File Type, select the types of files you want to display. 

Select 

Directories 

Programs 

Documents 

Other Files 

To 

Display the names of directories that are in the current 
directory. 

Display all filenames that have an .EXE, .COM, .PIF, 
.CMD, or .BAT extension. 

Display the names of text or graphics files associated 
with an application. For information about associating files, 
see "Associating Files with an Application," later in this 
chapter. 

Display all filenames not included in the preceding 
three options. 

4. To display hidden and system files, select the Show Hidden/System Files 
check box. 

5. Choose the OK button. 

Caution If you choose to display hidden and system files, be careful not to 
rename or delete them. Your computer may not start or work properly without 
them. 
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Working with Files and Directories 
Once you select a file or directory, you can use File Manager to copy, move, 
delete, or rename it. You can also use File Manager to create a new directory . You 

. cart start applications from File Manager, and, once a type of file is associated 
with an application, you can open a file and start its application at the same time. 
Use File Manager to set the attributes for files. 

Naming a File or Directory 
An operating system's file system determines the conventions that apply to file 
and directory names. When you use Windows NT on drives formatted to use the 
Windows NT file system (NTFS), you can use long file and directory names. 
When you create a directory or rename a file and use a long filename, File 
Manager automatically creates a shorter, MS-DOS-style name. This allows 
applications that do not support long file names to use the file. 

NTFS uses the following naming conventions: 

• Names can be up to 256 characters long, including the extension. Separate 
the extension from the name using a period. 

• Names preserve case, but are not case sensitive. When you name a file, your 
use of uppercase and lowercase letters will be retained. However, Windows 
NT does not distinguish filenames by their case. For example, Windows NT 
considers the filenames August Sales and AUGUST SALES to be identical. 

• Names can contain any uppercase or lowercase characters except the 
following: 

? / \ < > * 

When Windows NT creates a long name, it automatically creates a short, 
MS-DOS-style name as well. This keeps Windows NT compatible with MS-DOS 
workstations and applications. For example, a workstation running MS-DOS 
will use short names to see the shared directories and files on a Windows NT 
computer. Applications that do not support long file names will be able to 
work with files by using the short name. However, if you save a file using an 
application that does not support long filenames, the long filename will be 
lost and the file will have only a short name. 

When you create a long name, Windows NT uses the following rules to create 
the short name: 

• Spaces are removed. 

• Periods are removed except for the last period in the filename that is followed 
by a character. Windows NT interprets this period as marking the start of the 
filename's extension. 
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• Characters not allowed in MS-DOS-style names are changed to underscores 

U· 
• The name, not including its extension, is truncated to 6 characters and a 

tilde (-) and a number are appended. 

• The name's extension is truncated to 3 characters. 

If you are using Windows NT in an environment where long file names are not 
always supported, you may want to continue using MS-DOS conventions for the 
first 6 characters of names and use periods only to separate the name from the 
extension. For example, you could name a file AUGSLS-August 1992 Sales 
Report.XLS. Then the short name would be AUGSLS-l.XLS. 

MS-DOS conventions for naming files are: 

• The name of a file or directory can have two parts: a name and an optional 
extension. The two parts are separated by a period. 

• The name can contain up to eight characters, and the extension can contain 
up to three characters. 

• The name must start with either a letter or number. It can contain any 
uppercase or lowercase characters except the following: 

/ \ [ ] = ? * + < > 

If you use these characters in a filename, you may get unexpected results. 

• The name cannot contain any spaces. 

• The following names are reserved and cannot be used for files or directories: 

AUX 

COM1 

COM2 

Selecting Files or Directories 

COM3 

COM4 

CON 

LPT1 

LPT2 

LPT3 

NUL 

PRN 

Before you can work with a file or a directory, you must select it. When a file or 
directory is selected, its name and icon are highlighted in the directory window. In 
the contents list, you can select more than one file or directory at a time in order 
to perform a task with several files at once. For example, you may want to select 
several files and move them to another directory . You can select a group of files 
or directories that appear in consecutive order, or you can select items that are 
not in sequence. 
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l> To select files or directories 

To select 

A single file or 
directory 

Two or more items 
in sequence 

Two or more items 
out of sequence 

More than one group 
of items 

All files in a directory 

Do this 

In the contents list, click the name of the file or directory you 
want to select. 
-Or-
Press TAB to move the selection cursor to the contents list. 
Then use the UP ARROW or DOWN ARROW keys to select the 
file or directory. 

Click the first file or directory you want to select. Then press 
and hold down SHIFf while you click the last item in the group. 
-Or-
Press TAB to move to the contents list, and then use the arrow 
keys to select the first item. Then press and hold down SHIFf 

while selecting the remaining items using the arrow keys. 

Press and hold down CTRL while you click each item. 
-Or-
Press TAB to move to the contents list, then use the arrow keys 
to select the first item. Press and release SHIFf+FS, then use the 
arrow keys to move to each item and press the SPACEBAR to 
select it. When you finish selecting items, press SHIFf +FS again. 

Use any method to select the first sequential group of items. 
Hold down CTRL while you click the first item in the next 
group, and press and hold down CTRL+SHIFf while you click 
the last item in the group. 
-Or'-
Use the keyboard method with SHIFT+FS to select the first 
group, then use the arrow keys to move to the first item in the 
next group and repeat the process, pressing SHIFf+FS again 
when all items are selected. 

Press CTRL+SLASH (f). 

When you are selecting files and directories using the keyboard, you can use 
the following keys. 

Press 

UP ARROW or 
DOWN ARROW 

END 

HOME 

PAGE UP 

PAGE DOWN 

A letter or number 

To select 

A file or directory above or below the current selection. 

The last file or directory in the list. 

The first file or directory in the list. 

The file or directory at the top of the previous screen. 

The file or directory at the bottom of the next screen. 

The next file or directory that begins with that letter or number. 
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l> To select a group of items by using the Select Files command 

1. From the File menu, choose Select Files. 

2. In the Files box, type the name of the file you want to select. 

Use wildcards to specify a group of files: For example, to select all files with 
a .TXT extension, type *.txt. Or, to select all files in a directory, leave the 
default *. * in the Files box. 

3. Choose the Select button. 

The Cancel button changes to the Close button. 

4. Repeat steps 2 and 3 until you have selected all the files you want. 

You can choose the Deselect button at any time to cancel a selection. The 
Deselect button cancels the selected files that you specify in the Files box. 

5. Choose the Close button. ' 

l> To cancel a selection of files or directories 

To cancel 

A single selection 

All selections 

Do this 

Press and hold down CfRL while you click the item. 
-Or-
Press and release SHIFf+F8, use the arrow keys to move to 
the selection you want to cancel and press the SPACEBAR. 

Then press SHIFf+F8 again. 

Press CTRL+BACKSLASH (\). 

l> To cancel a group of selected files by using the Select Files command 

1. From the File menu, choose Select Files. 

2. In the Files box in the Select Files dialog box, type the name of one of 
the selected files you want to cancel. 

You can use wildcards to specify a group of files or all files that are selected 
in a directory. 

3. Choose the Deselect button. 

4. Repeat steps 2 and 3 until you finish canceling selections. 

5. Choose the Close button. 

Creating a Directory 
You can create a directory by using the Create Directory command. Mter you 
create a directory, you can copy files and directories to it from other locations by 
using the Move and Copy commands. For more information, see "Moving and 
Copying Files and Directories," later in this chapter. 
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~ To create a directory 

1. In the directory tree, select the directory in which you want the new 
directory to appear. 

2. From the File menu, choose Create ,Directory. 

3. In the Name box, type a name for the new directory. 

Use the same conventions for naming directories as you do for naming files. 
For information, see "Naming a File or Directory," earlier in this chapter. 

If you decide to create the directory somewhere other than in the current 
directory, you can type the full path of the new directory. 

4. Choose the OK button. 

Moving and Copying Files and Directories 
You can move and copy files and directories from one location to another by 
dragging them with the mouse or by using the Copy or Move commands. You can 
copy and move items between directories and between drives. When you move or 
copy a directory, all the files and subdirectories in it are moved or copied. 

On drives formatted to use the Windows NT file syste,m (NTFS), you must have 
permission to move or copy a file or directory. For more information on file and 
directory permissions, see "Securing Directories and Files," later in this chapter. 

Important When you copy files or directories, security permissions set on them 
are discarded as is ownership and auditing information. They will inherit a new 
set of permissions from the directory into which they have been copied. In the 
case of files, if the new directory does not specify permissions for files, only the 
file's owner (the person who copied the file) will have permission to use the file. 
When you copy or move files or directories to a disk formatted to use the FAT 
file system, permissions are discarded and not replaced. 

~ To move or copy files or directories by dragging 

1. Make sure the source and destination locations are visible. You can use 
the Cascade or Tile command on the Window menu to rearrange directory 
windows. The destination can be a directory icon, directory window,' or drive 
icon. If the destination is a drive icon, the file will be placed in the current 
directory of that drive. 

2. Select the file or directory you want to move or copy . You can select more 
than one file or directory. 

When you drag a selection, Windows NT assumes you want to copy it when 
the destination is on a different drive and move it when the destination is on 
the same drive. 
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Move to a location on the same drive 

Move to a location on any drive 

Copy to a location on a different drive 

Copy to a location on any drive 
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Do this 

Drag the selection. 

Press and hold down SHIFT while 
dragging the selection. 

Drag the selection. 

Press and hold down CTRL while 
dragging the selection. 

3. Release the mouse button. If you are dragging while pressing SHIFf or CTRL, 

release the mouse button before releasing the key. 

4. To complete moving or copying, choose the Yes button in the confirmation 
message. 

You can choose not to receive confirmation messages. For more information, 
see "Turning Off Confirmation Messages," later in this chapter. 

If the destination directory contains a file with the same name, a dialog box 
prompts you to verify that you want to replace the existing file. Choose the Yes 
button to replace the existing file, or if you are moving or copying more than one 
file, choose the Yes To All button. If you choose the Yes To All button, File 
Manager does not prompt you for each file that is replaced. 

r> To move or copy files or directories using commands 

1. Select the file or directory you want to move or copy. 

You can select more than one file or directory. 

Ll§l 2. To move, from the File menu, choose Move. Or choose the Move button on 
the toolbar. 

To copy, from the File menu, choose Copy. Or choose the Copy button on the 
toolbar. 

The name of the selected file or directory appears in the From box of the Move 
or Copy dialog box. 

You can select a different file or directory by typing its name in the From box. 
If the file or directory is not in the current directory, include the path. 

3. In the To box, type the destination drive or directory. 

If you type a drive name without including a path, the file or directory will 
appear in the current directory of the drive. 

If you type a new name, the original file or directory will be renamed when 
it is moved or copied. 

4. Choose the OK button. 



76 System Guide 

If the destination directory contains a file with the same name, a message prompts 
you to verify that you want to replace the existing file. Choose the Yes button to 
replace the existing file, or if you are moving or copying more than· one file, 
choose the Yes To All button. If you choose the Yes To All button, File Manager 
does not prompt you for each file that is replaced. 

Copying a File to the Clipboard 
You can copy a file onto the Clipboard so that the file can be linked to or 
embedded in another document. For more information about object linking 
and embedding, see Chapter 10, "Object Linking and Embedding." 

~ To copy a file to the Clipboard 

1. Select the file you want to copy. 

2. From the File menu, choose Copy to Clipboard. 

The name of the selected file appears in the Copy to Clipboard box. You 
can copy a different file by typing its name in the box. If the file is not in 
the current directory, include its path. 

3. Choose the OK button. 

Deleting a File or Directory 
You can use File Manager to delete files and directories. By selecting multiple 
files or directories, you can delete them at one time. When you delete a directory, 
all files and subdirectories in the directory are deleted. 

On drives formatted to use the Windows NT file system (NTFS), you must have 
permission to delete a file or directory. For more information on file and directory 
permissions, see "Securing Directories and Files," later in this chapter. 

Caution Once you delete files or directories, they cannot be recovered. 

~ To delete a file or directory 

1. Select the file or directory you want to delete. 

X 2. From the File menu, choose Delete, or choose the Delete button on the toolbar. 
Or press DEL. 

3. Choose the OK button to delete the selected file or directory, or type the name 
of a different file or directory you want to remove. If you type a long name 
that contains spaces, be sure to enclose the name in quotation marks. 

File Manager prompts you to confirm the deletion. (You can choose not 
to receive confirmation messages. For more information, see "Turning Off 
Confirmation Messages," later in this chapter.) 
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4. To delete a single file or directory, choose the Yes button. To delete more than 
one file or directory and without confirming each deletion, choose the Yes To 
All button. 

Renaming a File or Directory 
You can rename any file or directory by choosing the Rename command from 
the File menu. 

On drives formatted to use the Windows NT file system (NTFS), you must 
have permission to rename a file or directory. For more information on file and 
directory permissions, see "Securing Directories and Files," later in this chapter. 

Caution Be careful when you rename files. If you rename a file that your system 
requires, for example, any file that has an .SYS extension, your system may not 
start or run correctly. 

~ To rename a file or directory 

1. Select the file or directory you want to rename. 

2. From the File menu, choose Rename. 

The name of the selected file or directory appears in the From box. If you 
decide to rename a different file, type the name in the From box. To rename 
a group of files, use wildcards (for example, * .bak). 

3. In the To box, type the new name. 

Use a file or directory name that does not already exist in the destination 
directory. You can specify only one filename in the To box. If you want to 
rename a group of files, you can only use wildcards (for example, *.txt). 

4. Choose the OK button. 

Searching for a File or Directory 
When you want to find a file or directory, use the Search command. You can 
select files and directories in the Search Results window and use File menu 
commands to print, copy, move, delete, and rename them. You can view file 
details by using commands on the View menu. However, although you can 
move or copy files from the Search Results window, you cannot move or copy 
files into it. 

~ To search for a file or directory 

1. Select the directory that you want to start the search from. 

2. From the File menu, choose Search. 
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3. In the Search For box, type the name of the file or directory. Use wildcards 
to search for a group of files or directories with similar names or extensions. 

For example, to search for all files with the extension .WRI, you would type 
*. wri in the Search For box. 

4. In the Start From box, the current directory is listed. To start the search from 
a different directory, type the directory name in the Start From box. 

5. By default, File Manager searches the directory listed in the Start From box, 
and all its subdirectories. If you do not want File Manager to search the 
subdirectories, clear the Search All Subdirectories check box. 

6. Choose the OK button. 

File Manager searches the directory and subdirectories you specified, displaying 
its progress in a dialog box. To cancel the search, choose the Cancel button. 
You can continue working with File Manager while the search continues in the 
background. To hide the dialog box while the search continues, choose the 
Hide button. When the search is complete, the Search Results window appears, 
displaying all the filenames and directories found. 

If you modify the drive on which the search was performed and the Search 
Results window is active (or is made active), a message appears, asking whether 
you want to update the Search Results window. If you choose the Yes button, 
the search is performed again on the modified drive. 

Associating Files. with an Application· 
A file is associated with an application through the file's filename extension 
and the application's file type. Once a file is associated with an application, you 
can choose any file with the same extension in the directory window to start the 
application and load the file. Associating a file with an application also allows 
you to print the file from within File Manager if the application supports this 
feature. A file extension can be associated with only one application; however, 
an application can be associated with several different file extensions. 

Many applications are associated with files when you install them. If an 
application does not automatically set up an association, you can associate 
files with it by using the Associate command. 

I> To create or change a file association using the Associate dialog box 

1. In a directory window, select a file that has the extension you want to 
associate. 

For example, to associate files that have a .DAT extension with an application, 
select any file that has a .DAT extension. 

2. From the File menu, choose Associate. 
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Delete Type 

3. The filename extension of the file you selected appears in the Files With 
Extension box. To associate a different filename extension, or if no file was 
selected when you chose the Associate command, type the extension in the 
Files With Extension box. 

The extension's current association is selected in the Associate With list. 
If the extension is not associated with a file type, (None) is selected. 

4. To associate the extension with a file type: 

If the file type and program name appear in the Associate With list, select 
the file type and program name. 

If the file type and program name do not appear in the Associate With list, 
type the program name including its extension in the Associate With box, for 
example newapp.exe. You can also choose the Browse button to search for the 
program name. In the Browse dialog box, selecting the program filename and 
choosing the OK button places the program name and its path in the Associate 
With box. 

5. Choose the OK button. 

If you specified a program name, File Manager automatically creates 
a new file type for it. 

t> To remove an association 

1. In a directory window, select a file with the extension that you want 
to remove. 

2. From the File menu, choose Associate. 

3. In the Associate dialog box, the extension of the selected file appears in the 
Files With Extension box. To remove the association for a different filename 
extension, or if no file was selected when you chose the Associate command, 
type the extension in the Files With Extension box. 

4. In the Associate With File Type box, select (None). 

5. Choose the OK button. 
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Working with File Types 
From the Associate dialog box, you can create, change, or delete file types. You 
can also work with file associations. To create a file type, name the file type and 
then provide the information that File Manager uses when opening or printing a 
file of that type either by starting the program or by using dynamic data exchange 
(DDE). 

When DDE is used, you can specify the following options: 

Option 

DDE Message 

DDE Message 
Application Not 
Running 

Application 

Topic 

Purpose 

Specifies the DDE command to use if the application 
is already running 

Specifies the DDE command to use if the application 
is not running 

Specifies the DDE application string used to initiate 
a DDE conversation with the application specified in the 
Command box 

Specifies the DDE topic string used to initiate a 
DDE conversation with the application specified in the 
Command box 

I> To create a file type 

1. In the Associate dialog box, choose the New Type button. 

2. In the New File Type dialog box, type the name of the file type in the 
File Type box. 

3. In the Action box, choose Open to specify the command File Manager 
executes when opening files of that type or Print to specify the command 
File Manager executes when printing files of that type. 

4. In the Command box, type the command for the Open or Print actions. 

Commands start with the name of the program file followed by application­
specific parameters and the %1 parameter. The %1 parameter represents the 
filename of the file currently selected in File Manager when the action is 
performed. 

You can choose the Browse button to search for a program name. In the 
Browse dialog box, selecting the program filename and choosing the OK 
button places the program name and its path in the Command box. 

If the application supports DDE, specify the name of the program file in 
the Command box. Then select the Uses DDE check box and specify the 
application-specific DDE commands. 
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5. To associate an extension with the file type, type the extension in the New 
Extension box and choose the Add button. You can add multiple extensions. 

6. Choose the OK button. 

File type information for an application is added when the application is installed. 
In general, you should not need to change existing file types. 

Some file types are protected. To change a protected file type, you must be logged 
on as a member of the Administrators or Power Users group. 

To change a file type 

1. In the Associate dialog box, select the file type you want to change in the 
Associate With list, and then choose the Change Type button. 

2. In the Change File Type dialog box, make any changes to the file type name 
or the commands associated with the Open and Print actions. 

3. You can also add or remove extensions associated with the file type. 

To associate an extension with the file type, type the extension in the New 
Extension box and choose the Add button. You, can add multiple extensions. 

To remove an associated extension, select it in the Extensions box and 
choose the Remove button. 

4. Choose the OK button. 

I> To delete a file type 

• In the Associate dialog box, select the file type you want to delete in the 
Associate With list, and then choose the Delete Type button. 

Starting an Application from File Manager 
You can use File Manager to start your applications. You start an application by 
opening a program file or document file from a directory window. Program files 
almost always have a .COM, .EXE, .PIF, .CMD, or .BAT filename extension. 
Document files are associated with applications and are represented by document­
file icons in directory windows. For information about the types of file icons, see 
"Working with Files and Directories," earlier in this chapter. 

When you start an application that runs in a window, the window appears in front 
of any open File Manager windows. When you start an application that uses the 
entire screen, the application replaces the File Manager window. If you want to 
reduce File Manager to an icon each time you start an application, choose the 
Minimize On Use command from the Options menu. 
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I> To start an application from a program file 'or document file 

• In the directory window, choose the filename. 

-Or-

1. Select the filename in the directory window. 

2. From the File menu, choose Open; or press ENTER. 

I> To start an application and open a file 

• Drag the icon for the data file onto the icon for the program file. 

-Or-

1. Select the program file for the application you want to use. 

2. From the File menu, choose Run. 

3. The name of the program file appears in the Command Line box. If you did 
not select a program file, or if you want to run a different application, type the 
name (and path, if necessary) of the program file in the Command Line box. 

Then, in the Command Line box, add the name of the data file after the 
program filename. Include the path if the data file is not in the same directory 
as the program file. 

4. If you want the application to start minimized, select the Run Minimized 
check box. 

5. Choose the OK button. 

Printing a File from File Manager 
Using File Manager, you can print files that are associated with applications. 
You can use the Print command, or, if you are using a mouse, you can simply 
drag the file icon onto the minimized Print Manager icon. 

Note Some applications do not support printing through File Manager. If this 
is the case, or if a file is not associated with an application, you must open the 
application and print the file from there. 

I> To print a file by dragging the file icon 

1. Make sure Print Manager is started and minimized to an icon on the desktop. 

2. Drag the document-file icon onto the Print Manager icon. 

I> To print a file by using the Print command 

1. In the directory window, select the file you want to print. 

2. From the File menu, choose Print. 

3. Choose the OK button. 
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Turning Off Confirmation Messages 
If you do not want a confirmation message to appear each time you delete or 
replace files and directories, you can change the confirmation settings. You can 
also turn off messages that appear when you perform certain mouse actions, such 
as moving and copying. If you turn off confirmation messages, File Manager 
carries out commands as soon as they are issued. 

I> To turn off confirmation messages 

1. From the Options menu, choose Confirmation. 

2. Clear the check box for each confirmation option you want to cancel, and then 
choose the OK button. 

Clear this option 

File Delete 

Directory Delete 

File Replace 

Mouse Action 

Disk Commands 

Modifying System, 
Hidden, Read Only files 

If you don't want a warning message 

Before deleting files 

Before deleting directories 

Before writing over existing files 

Before moving or copying files by dragging 

Before formatting or copying a disk 

Before deleting, replacing, or moving system, hidden, 
and read-only files 

Caution If you clear the Directory Delete check box, remember that when you 
delete a directory, all files and subdirectories in that directory are deleted. Also, 
to avoid accidentally writing over files you want to keep, do not clear the File 
Replace check box. 

Setting File Attributes 
File attributes are part of the directory information the operating system 
maintains for each file. This information helps the operating system identify 
a file and controls the kinds of tasks you can perform with the file. You can see 
file attributes in a directory window by choosing the All File Details command 
on the View menu. 

On drives formatted to use the Windows NT file system (NTFS), you must have 
permission to change file attributes. For more information on file and directory 
permissions, see "Securing Directories and Files," later in this chapter. 
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The four file attributes are described in the following table. 

Attribute 

Read-only (R) 

Archive (A) 

Hidden (H) 

System (S) 

Description 

Prevents a file from being changed. 

Identifies a file that has been modified since it was last backed 
up. When you use some commands, such as backup, the archive 
attribute is turned off. 

Prevents a file froin appearing in a directory listing at the 
command prompt. Files that have a hidden attribute appear in 
directory windows only if you select the Show Hidden/System 
Files check box by using the By File Type command on the 
View menu. 

Identifies the file as a system file. Files that have a system 
attribute appear in a directory window only if you select the 
Show Hidden/System Files check box by using the By File Type 
command on the View menu. 

t> To change file attributes for one or more files 

1. Select the files whose attributes you want to set. 

2. From the File menu, choose Properties. 

If you are using a network, more options may be available in the 
Properties dialog box. 

3. Select or clear the check boxes for the attribute settings. 

When you have selected more than one file, check boxes will appear 
gray if the attribute for the files is not set alike. 

4. Choose the OK button. 

Viewing a File's Version Information 
File Manager allows you to see version information for files. This is information 
supplied by the manufacturer of an application including the company name and 
other comments. 

I> To view a file's version information 

1. Select the file whose information you want to see. 

2. From the File menu, choose Properties. 

3. In the Version Information box, select the subject in the left box. 

The information on the subject is displayed in the right box. 
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Working with Shared Directories and Files 
Windows NT allows you to share directories and files over the network. Use File 
Manager to share and stop sharing directories. File Manager also allows you to 
monitor and control the use of shared files. 

Windows NT automatically creates special shares for administrative and system 
use. When the Server service starts, an administrative shared directory is created 
for the root directory of each drive on the computer and for the Windows NT 
system root, for example C:\WINNT. Administrative shares created for drives 
are named using the drive letter and a dollar sign, for example C$. The shared 
directory created for the system root is called ADMIN$. Members of the 
Administrators or Backup Operators groups can connect to these shared 
directories. Only members of the Administrators group can change properties 
for them. 

Sharing a Directory 
Share a directory when you want to make information located there available 
to others on the network. 

Before you can share a directory, the Server service must be running. You can 
start the server service using the Services option in Control Panel. 

To share a directory, you must be logged on as a member of the Administrators 
or Power Users group. 

t> To share a directory 

1. Select the directory you want to share in either the tree or contents panes of 
the directory window. 

If you are logged on as a member of the Administrators group, you can share a 
directory on a remote computer. First connect to the computer's administrative 
root directory, for example C$. Then select the directory you want to share 

tID 2. From the Disk menu, choose Share As, or choose the Share Directory button 
on the toolbar. 
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If the directory you selected is already shared, the Shared Directories 
dialog box is displayed. Choose the New Share button to create a share 
using the New Share dialog box. 

~hare Name: L.;;;;1[I!=(fL=l'~=!i,=¥1l,--____ ----, 

Eath: I D: \Proiect N oon\Proposal 

!;omment: 

User limit:---------. 

@ .!J.nlimited 

o Allow 1'---__ -'l!I ..... = Users 

OK 

Cancel 

Ipe!missions.;. 'I 
I' Help 

3. The Share Name box shows the name users will specify to connect to the 
shared directory. By default, File Manager uses the name of the directory you 
selected. If you want to share the directory using a different name, type a new 
share name in the Share Name box. Share names can be up to 12 characters 
long. 

4. The path for the directory you selected appears in the Path box. If you decide 
you want to share a different directory, you can type a different path. 

S. Type a comment in the Comment box. 

Users will see the comment when connecting to the directory using the 
Connect Network Drive dialog box. A comment is optional. 

6. Set a limit on the number of users who can connect to the shared directory 
at one time in the User Limit box. 

By default, no limit is set. 

7. To set permissions on the shared directory, choose the Permissions button. 

For more information on setting permissions, see "Setting Permissions 
Through Shared Directories," later in this chapter. 

8. Choose the OK button. 

File Manager shows that the directory is shared by displaying a shared 
directory icon next to the directory's name. 
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Stopping Directory Sharing 
Once you stop sharing a directory, it is no longer available over the network. 

The Stop Sharing Directory dialog box displays shared directories you have 
created as well as shared directories created by the system. In general, you should 
not stop sharing directories created by the system, for example C$ or PRINT$. 
Administrative shares that are deleted are re-created automatically the next time 
the Server service is started. 

To stop sharing a directory, you must be logged on as a member of the 
Administrators or Power Users group. 

Caution If you choose to stop sharing a directory while users are connected, 
those users may lose their data. 

I> To stop sharing a directory 

1. Select the drive containing the directories you want to stop sharing by 
selecting the drive's directory window or drivebar button. 

2. From the Disk menu, choose Stop Sharing. Or choose the Stop Sharing 
button on the toolbar. 

~.At. .......................................... A.:'\ ...................................................................................................................... . 
GJ AD MIN $ C: \winnt 
GJB$ B:\ 
GJC$ C:\ 
GJD$ D:\ 
GJ Project Road D: \Project Road 
GJ Proposal D:\Project Noon\Proposal 

3. The Stop Sharing dialog box shows the computer name of the selected drive 
and, in the Shared Directories On box, the shared directories on the drive. 
For each share name, the directory path on the computer is shown. Select the 
directories you want to stop sharing. If you selected a shared directory before 
opening the Stop Sharing Directory dialog box, the shared directories 
corresponding to that directory are already selected. 

4. Choose the OK button. 

If any users are connected to a shared directory, File Manager will warn you 
before sharing is stopped. 
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Changing Share Properties 

J> 

You can change the number of users allowed to connect to a shared directory, 
a shared directory's comment information, or the shared directory's permissions. 

To change a shared directory's properties, you must be logged on as a member 
of the Administrators or Power Users group. Only members of the Administrators 
group can change share properties on administrative shares, for example, C$. 

To change a shared directory's properties 

1. Select the shared directory whose properties you want to change in either the 
tree or contents panes of the directory window. 

,g 2. From the Disk menu, choose Share As. Or choose the Share Directory button 
on the toolbar. 

~hare Name: 

fath: D:\Project Noon\Proposal 

I;omment: 

User Limit-----------, 

@ !!nlimited 

o ~lIow ,-I ___ --'ffl ..... : Users 

Ii "OK I 
I':" C~nceiH"1 

3. If the directory has been shared more than once, select the name in the Share 
Name box of the shared directory whose properties you want to change. You 
can then: 

• Change the number of users allowed to connect to the direc!ory at one time 
by selecting, under User Limit, the Unlimited option or the Users option. 
When you select the Users option, you can either type a limit or click the 
scroll arrows to raise or lower the limit. 

• Edit the Comment box to change the description that appears when users 
see the shared directory listed in the Network Connections dialog box. 

• Choose the Permissions button to change the permissions on the shared 
directory. For more information on setting permissions, see "Setting 
Permissions Through Shared Directories," later in this chapter. 

4. Choose the OK button. 
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Viewing or Closing Shared Files 
You can view who is using shared files and stop the use of a file. When you 
are viewing the status of a shared file, File Manager provides the following 
information. 

Item 

Total Opens 

Total Locks 

Open By 

For 

Locks 

File ID 

Shows 

The total number of users who are working with the file 

The total number of locks on the file 

The name of the user who has the file open 

The type of access the user has to the file 

The number of locks the user has placed on the file 

The identification number of the file 

To stop the use of shared files, you must be logged on as a member of the 
Administrators or Power Users group. 

To view or close a shared file 

1. Choose the file in the contents pane of the directory window. 

2. From the File menu, choose Properties. 

3. Choose the Open By button in the Properties dialog box. 

4. To stop use by one or more users, select the user or users and choose the 
Close Selected button. 

To stop use by all users, choose the Close All button. 

Caution When you close a file that is in use, changes made to that file 
will not be saved. 

5. Choose the OK button. 
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Securing Directories and Files 
You can control users' access to directories and files on drives formatted to use 
the Windows NT file system (NTFS). Drives formatted to use FAT and HPFS do 
not support Windows NT security. You can, however, secure shared directories 
no matter what file system is in use. 

To secure a directory or file, set permissions on it. Each permission you set 
specifies the access that a group or user can have to the directory or file. For 
example, when you set Read permission for the group called coworkers on the file 
MY IDEAS.DOC, the users in that group can display the file's data and attributes, 
but cannot change the file or delete it. For more information on how to work with 
groups and users, see Chapter 13, "User Manager." 

Windows NT offers a set of standard permissions you can set on directories and 
files. The standard permissions for directories are No Access, List, Read, Add, 
Add & Read, Change, and Full Control. The standard permissions for files are 
No Access, Read, Change, and Full Control. 

The standard permissions are groups of individual permissions. When you set 
a standard permission, the abbreviations for the individual permissions are 
displayed beside the standard permission. For example, when you set the standard 
permission Read on a file, the abbreviation RX appears beside it. The individual 
permissions and their abbreviations are: 

Read (R) 

Delete (D) 

Write (W) 

Change Permissions (P) 

Execute (X) 

Take Ownership (0) 

In addition to setting standard permissions, you can set special access 
permissions. Special access permissions allow you to define a custom set 
of individual permissions for directories and files. 

To effectively work with NTFS security, keep the following in mind: 

• Users cannot use a directory or file unless they have been granted permission 
to do so or belong to a group that has permission to do so. 

• Permissions are cumulative except that the No Access permission overrides 
all other permissions. For example, if the coworkers group has Change 
permission for a file while the finance group has only Read permission and 
John is a member of both groups, John will be granted Change permission. 
However, if you change the finance group's permission for the file to No 
Access, John will not be able to use the file even though he is a member of 
a group that has access to it. 
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• When you create files and subdirectories in a directory, they inherit 
permissions from the directory. For example, if you add a file to a directory 
that allows the coworkers group Change permission and the finance group 
Read permission, those same permissions will apply to the file. 

• The user who creates a file or directory is the owner of that file or directory. 
The owner can always control access to the file or directory by changing the 
permissions set on it. Users who are members of the Administrators group 
can always take ownership of a file or directory. 

• The easiest way to administer security is by setting permissions for groups, not 
individual users. Typically, a user will need access to many files. If the user is 
a member of a group that has access to the files, you can end the user's access 
by removing the user from the group rather than changing the permissions on 
each of the files. Note that setting permission for an individual user does not 
override the access granted to the user through groups to which the user 
belongs. 

Setting Directory Permissions 
When you first display a directory's permissions, the Directory Permissions 
dialog box shows the permissions that the directory inherited from the directory 
containing it. The Name box shows the groups and users for whom permissions 
have been set. If you have selected multiple directories, permissions are shown 
only if they are the same for all of the directories. You can change permissions, 
add a group or user to the list, or remove a group or user from the list. For more 
information on adding users and groups to the permissions list, see "Adding 
Users and Groups to Permissions and Auditing Lists," later in this chapter. 

Setting permissions on a directory controls what users can do in that directory. 
When you set directory permissions, you are setting permissions on the directory 
and, by default, all the files that exist in the directory. Existing subdirectories and 
their files are not changed unless you specify to change them. When you create 
new files and new subdirectories, they inherit their permissions from the 
directory. 

In some cases, directory permissions for a group or user are not passed on to 
subdirectories. This occurs, for example, when a group or user has been granted 
permissions through the CREATOR OWNER special group. Permissions that will 
not be inherited by subdirectories are marked with an asterisk, for example (All) * . 

When you set a standard permission, two sets of individual permissions are 
displayed next to it: the permissions set on the directory and the permissions set 
on files in the directory. For example, when you set Add & Read permission on 
a directory, you see (RWX), signifying Read, Write, and Execute permissions on 
the directory, and (RX), signifying Read and Execute permission on files in the 
directory. 
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Some directory permissions set file permissions to Not Specified. When access 
to files for a user or group is not specified, that group or user cannot use files in 
the directory unless access is granted by another means, for example, by setting 
permissions that grant access on individual files. 

When you are setting permissions on a directory, you can use the CREATOR 
OWNER special group to allow users to control only the subdirectories and files 
that they create within the directory. Permissions set on CREATOR OWNER are 
transferred to the user who creates a directory or file within the directory. For 
example, if you give Everyone Add & Read permission to the directory and 
CREATOR OWNER Change permission, when Annie adds files to the directory, 
she will be able to change and delete the files, while other users will only be able 
to read them. 

To change permissions on the directory, you must be the owner of the directory, 
or have been granted permission to do so by the owner. 

The following table shows permissions for directories and the actions on 
directories available to users for each permission. 

• Permission allows use 
0 Permission does not allow use 

Display directory filenames 

Display the directory's attributes 0 • • • • • 
Go to the directory's subdirectories 0 • • • • • 
Change the directory's attributes 0 0 0 • • • 
Create subdirectories and add files 0 0 0 • • • 
Display the directory's owner 0 • • • • • 
and permissions 

Delete the directory 0 0 0 0 0 • 
Delete any file or empty 0 0 0 0 0 0 
subdirectory in the directory 

Change directory permissions 0 0 0 0 0 0 

Take ownership of the directory 0 0 0 0 0 0 

• 
• 
• 
• 
• 
• 
• 
• 
• 

Note Groups or users granted Full Control permission on a directory can delete 
files in that directory no matter what permissions protect the files. 
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The following table shows permissions for directories and the actions on files 
available to users for each permission. 

• Permission allows use b ", ~ ~ iJi : ~ 
0 Permission does not allow use & ~' §' 

C,l -e- ,,/ ~~., 0 "\': ~ .c:, -§ ~ ~c ,.,:; ~ 
-§;' ~,' i{,'::;' 

~ ~ . c:J, 

Display the file's owner and permissions 0 0 • 0 • • 
Display the file's data 0 0 • 0 • • 
Display the file's attributes 0 0 • 0 • • 
Run the file if it is a program 0 0 • 0 • • 
Change the file's attributes 0 0 0 0 0 • 
Change data in and append data to the file 0 0 0 0 0 • 
Delete the file 0 0 0 0 0 • 
Change the file's permissions 0 0 0 0 0 0 

Take ownership of the file 0 0 0 0 0 0 

To view or change directory permissions 

1. Select the directory in the directory window. You can select multiple 
directories. 

• 
• 
• 
• 
• 
• 
• 
• 
• 

~ 2. From the Security menu, choose Permissions. Or choose the Permissions 
button on the toolbar. 

DIrectory: D:\Project Noon 

!!wner: SteveW (Steve Wood) 

o RIDJlace Permissions on Subdirectories 

[g] Replace Permissions on Existing files 
!tame: 

~ l Executives 
~ l Noon Leads 
~ l Noon Project T earn 
~ l Sales Staff 
fi SteveW (Steve Wood) 

Read (RX) (RX) 
Change (RWXD) (RWXD) 
Add & Read (RWX) (RX) 
NoAccess (None) (None) 
Full Control (All) (All) 

llpe of Access: .... IC_h_a--'ng::..,.e __________ ---"'I ..... :!:1 

Add ... Help 
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3. By default, the Replace Permissions On Existing Files check box is selected, 
so the changes you make to permissions apply to the directory and its files 
only. 

Select both the Replace Permissions On Subdirectories and the Replace 
Permissions On Existing Files check boxes to apply changed permissions 
to the directory and its files, and to existing subdirectories and their files. 

To apply changed permissions to the directory only (not to existing files in the 
directory or to subdirectories and their existing files), clear both the Replace 
Permissions On Subdirectories and Replace Permissions On Existing Files 
check boxes. 

To apply changed permissions to the directory and subdirectories only (not to 
existing files in the directory or subdirectories), select the Replace Permissions 
On Subdirectories check box and clear the Replace Permissions On Existing 
Files check box. 

4. Select the name of a group or user and choose a permission from the Type Of 
Access box. 

You can customize directory and file permissions by choosing Special 
Directory Access ... or Special File Access .... For more information on special 
access permissions, see "Setting Special Access Permissions," later in this 
chapter." 

5. Choose the OK button. 

t> To remove directory permissions for a group or user 

1. In the Directory Permissions dialog box, select the name of the group or user. 

2. Choose the Remove button. 

Setting File Permissions 
When you first display a file's permissions, the File Permissions dialog box shows 
the permissions that the file inherited from the directory containing it. The Name 
box shows the groups and users for whom permissions have been set on the file. 
If you have selected multiple files, permissions are shown only if they are the 
same for all of the files. You can change permissions set for the listed groups and 
users, add a group or user to the list, or remove a group or user from the list. For 
more information on adding users and groups to the permissions list, see "Adding 
Users and Groups to Permissions and Auditing Lists," later in this chapter. 
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To change permissions on the file, you must be the owner of the file, or have been 
granted permission to do so by the owner. The following table shows permissions 
for files and the actions available to users for each permission. 

• Permission allows use 
o Permission does not allow use 

Display the file's data 0 • 
Display the file's attributes 0 • 
Run the file if it is a program 0 • • • 
Display the file's owner and permissions 0 • • • 
Change the file's attributes 0 0 • • 
Change data in and append data to the file 0 0 • • 
Delete the file 0 0 • • 
Change the file's owner and permissions 0 0 0 • 

To change permissions on a file 

1. Select one or more files from the contents pane of the directory window. 

2. Choose Permissions from the Security menu, or choose the Permissions 
button on the toolbar. 

[ile: D:\Project Noon\PJoposal\PROPOSALDOC 

QwneJ: SteveW (Steve Wood) 

Name: 

Read (RX) 
Read (RX) 
Change (RWXD) 
Read (RX) 
No Access (None) 
Full Control (All) 

lYpe of Access: 1....1 F_u_II_C_on_t_ro_1 ________ -"'1 ± .... I 

3. Select the name of the group or user whose permission you want to change. 
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4. Choose a permission from the Type Of Access box. 

To customize the permissions set for the group or user, choose Special 
Access ... from the Type Of Access box. For more information on special 
access file permissions, see "Setting Special Access Permissions," later in 
this chapter. 

5. Choose the OK button. 

I> To remove file permissions for a group or user 

1. In the File Permissions dialog box, select the name of the group or user. 

2. Choose the Remove button. 

Setting Special Access Permissions 
In general, the standard directory and file permissions are all you need to 
secure your directories and files. However, if you need to create a custom set of 
permissions, you can use special access permissions. You can set special access 
permissions on directories, on all the files in selected directories, or on selected 
files. When you set special access permissions on a directory, the permissions 
affect the directory only. 

The following table shows special access permissions for directories and the 
actions available to users for each directory permission. 

• Permission allows use 
o Permission does not allow use 

Display filenames in the directory 

Display the directory's attributes 

Add files and subdirectories 

Change the directory's attributes 

Go to the directory's subdirectories 

Display directory owner and permissions 

Delete the directory 

Change the directory's permissions 

Take ownership of the directory 

• I • 
• 
o 

o 

o 

o 

• o i 0 o 

o 
• 
• I o 

• 0 i 0 
• i 0 l' 0 

o ! 0 

• • 
• o 

• } 0 
0 0 0 • 
0 0 0 0 

i 

0 0 0 0 

o 
o i 0 

• ! ~ 
o 
o 

o 

• 
o 

J 

o 
• ! o 
• i 01· 

o ! • 

• • 
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The following table shows special access permissions for files and the actions 
available to users for each permission. 

• Permission allows use 
' ~;' ,~ 

)' .§".; .~/ $ ,,' 
0 Permission does not allow use ;1 </) 

y ~ ~i/ ~,/ ~/ /' <$' (::t,:' </) $:,' (;0 /: 
~ </)iJ, *' (J §::;f ~t::1/ ~ ,/ 
~ ~ /' ,::)</) .Q.,</)/' O,/'~::::i·( 

Display the file's owner and permissions • • • 0 0 0 • ~ 

Display the file's data • 0 0 0 0 0 • 
Display the file's attributes • 0 • 0 0 0 • 
Change the file's attributes 0 • 0 0 0 0 • 
Change data in and append data to the file 0 • 0 0 0 0 • 
Run the file if it is a program 0 0 • 0 0 0 • 
Delete the file 0 0 0 • 0 0 • 
Change the file's permissions 0 0 0 0 • 0 • 
Take ownership of the file 0 0 0 0 0 • • 

t> To set special access permissions 

1. You can set special access permissions on directories, all files in directories, 
or selected files. 

To set permissions on directories, select them in the directory window. 

To set permissions on all the files in one or more directories, select the files' 
directories in the directory window. 

To set permissions on selected files, select the files in the contents pane 
of the directory window. 

t:o 2. Choose Permissions from the Security menu, or choose the Permissions 
button on the toolbar. 

3. In the Permissions dialog box, select the group or user you want to grant 
special access. 

If no groups or users are shown, indicating that the directories or files 'you 
selected have differing permissions, add a group or user before setting special 
access permissions. 

4. Open the appropriate Special Access dialog box. 

To set permissions on directories, choose Special Directory Access ... from 
the Type Of Access box or double-click the name of the group or user. 

To set permissions on all the files in the selected directories, choose Special 
File Access ... from the Type Of Access box. 

To set permissions on selected files, choose Special File Access ... from 
the Type Of Access box or double-click the name of the group or user. 
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The Special Access dialog box shows which access permissions have been 
granted based on the current standard or special permissions setting. 

Directory: D:\Project Noon 

N arne: Noon Project T earn 

o Full ControllAlI) 

• O!her 

[g] !! ead (R) 

[g] :Y{rite (\II) 

[g] E.1!ecute (X) 

o !!elete (D) 

o Change ferrnissions (P) 

o Take Qwnership (0) 

3. To set special access permissions, select the check boxes for the access 
you want to grant. 

To grant full control, select Full Control (All). 

If you are setting permissions for all files in directories, you can select Access 
Not Specified. This removes permissions from files in the selected directories 
and prevents files from inheriting permissions from their directories. 

4. Choose the OK button. 

Setting Permissions Through Shared Directories 
You can set permissions through a shared directory whether the directory is on 
a drive formatted to use the Windows NT file system (NTFS), FAT, or HPFS. 

You can use the Access Through Share Permissions dialog box to change 
permissions set for the listed groups and users and remove a group or user 
from the permissions list. For information on adding users and groups to the 
permissions list for a shared directory, see "Adding Users and Groups to 
Permissions and Auditing Lists," later in this chapter. 

E> To work with shared directory permissions, you must be logged on as a member 
of the Administrators or Power Users group. 
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To secure shared directories effectively, keep the following in mind: 

• Permissions set through a shared directQry are effective only when the 
directory is reached over the network. 

• Permissions set through a shared directory apply to all files and subdirectories 
in the shared directory. 

• Permissions set through a shared directory that is on an NTFS volume operate 
in addition to NTFS permissions set on the directory itself. Shared directory 
permissions specify the maximum access allowed. For example, if a user has 
Read permission on the shared directory but List permission on the directory 
itself, the user's access is limited to List. 

The following table shows the permissions for files and directories granted 
through the shared directory and the actions available to users for each 
permission. 

• Permission allows use 
o Permission does not allow use 

Display subdirectory names and filenames 

Display the data and attributes of files 

Run program files 

Go to the directory's subdirectories 

Create subdirectories and add files 

Change data in and append data to files 

Change the file's attributes 

Delete subdirectories and files 

Change permissions 
(NTFS files and directories only) 

Take ownership 
(NTFS files and directories only) 

~ 
~ 0 • • 

0 • • 
0 • • 
0 • • 
0 0 • 
o ! 0 • I 

o ; 0 .! 
o : 0 ,. 0 

I 0 o o 
\ 
i 

t> To view or change permissions on a shared directory 

• 
• ! ! 
• 
• 
• 
• ! 

• I 
• ! 
• ! 
• i ; 

1. Select the shared directory whose permissions you want to change in either 
the tree or contents panes of the directory window. 

~ 2. From the Disk menu, choose Share As. Or choose the Share Directory 
button on the toolbar. 

3. In the Share Directory dialog box, choose the Permissions button. 

4. In the Access Through Share Permissions dialog box, select the name of 
a group or user and select a permission from the Type Of Access box. 

5. Choose the OK button. 
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~ To remove shared directory permissions for a group or user. 

1. In the Access Through Share Permissions dialog box, select the name of 
the group or user. 

2. Choose the Remove button. 

Auditing Files and Directories 
Auditing files and directories allows you to track their usage. For a particular 

. file or directory, you can specify which groups or users and which actions to 
audit. You can' audit both successful and failed actions. Windows NT stores the. 
information generated from auditing in a file. You can view the information using 
Event Viewer. For more information on Event Viewer, see Chapter 15, "Event 
Viewer." 

You can use the File Auditing and Directory Auditing dialog boxes to change 
auditing set for the listed groups and users and remove a group or user from 
the audit list. For information on adding users and groups to the audit list, see 
"Adding Users and Groups to Permissions and Auditing Lists," later in this 
chapter. 

Important To audit files and directories, you must set the audit policy to audit file 
and object access. Set the audit policy using User Manager. For more information 
on audit policy, see Chapter 13, "User Manager." 

To audit files and directories, you must be logged on as a member of the 
Administrators group. 

To audit the following activities on a directory, select the events shown. 

• Event audits action 
o Event does not audit action 

Displaying filenames 

Displaying attributes 

Changing attributes 

Creating subdirectories and files 

Going to the directory's subdirectories 

Displaying owner and permissions 

Deleting the directory 

Changing directory permissions 

Changing directory ownership 

• 0 000 
} 1> 

• ! 0 • to! 0 
» t t 

o :. 0 I 0 0 

o .; 0 0 i 0 

o 0 ;,\.'. 0 i 0 
t 

o 

o 

o 

o ! 
o ! 

• 
<- 0 

• .! 0 

o ! 0 ( • 

o 0 

o ; 0 

! 0 
I 

i 0 
::? 

1 ! 0 0 0 

! 0 0 0 
; 

• i 0 
t 

o i.! 
~: 
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To audit the following activities on a file, select the events shown. 

• Event audits action 
o Event does not audit action 

Displaying the file's data 

Displaying attributes 

Displaying the file's owner 
and permissions 

Changing data 

Changing attributes 

Running the file 

Deleting the file 

Changing the file's permissions 

Changing the file's ownership 

• 
• 
• 
o 

ii 0 

o 
o 

o 

o 

o 
o 

o 

• 
• ! • 

t 

• 0 
• ; 0 

o • 
o 0 

o 
o 

o 
o 

t> To view or change file or directory auditing 

o 

o 
o 

o 
o 

o 

• 
o 

o 

1. In the File Manager window, select the file or directory. 

2. From the Security menu, choose Auditing. 

Directory: D:\Project Noon 

D R~lace Auditing on Subdirectories 

[g] Replace Auditing on Existing files 

E vents to Audit 
Success 

Read D 
~rite n~n 
Ellecute D 
Q.elete D 
Change ~ermissions D 
Take Q wnership D 

Failure 

D 
D 
D 
D 
D 
D 

o 
o 
o 

o 

o 
o 

o 

• 
o 

o 

o 

o 

o 

o 

o 

o 

o 

• 
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3. If you are setting auditing on a directory, two check boxes allow you to 
control how auditing changes apply to existing files and subdirectories. 

By default, the Replace Auditing On Existing Files check box is selected, 
so the changes you make to auditing apply to the directory and its files only. 

Select both the Replace Auditing On Subdirectories and the Replace Auditing 
On Existing Files check boxes to apply auditing changes to the directory and 
its files, and to existing subdirectories and their files. 

To apply auditing changes to the directory only (not to existing files in the 
directory or to subdirectories and their existing files), clear both the Replace 
Auditing On Subdirectories and Replace Auditing On Existing Files check 
boxes. 

To apply auditing changes to the directory and subdirectories only (not to 
existing files in the directory or subdirectories), select the Replace Auditing 
on Subdirectories check box and clear the Replace Auditing on Existing Files 
check box. 

4. Set auditing for each group and user in the list: 

Select the name of a group or user and then select the events to audit for 
that group or user. 

5. Choose the OK button. 

I> To remove file or directory auditing for a group or user 

1. In the Auditing dialog box, select the name of the group or user in the list. 

2. Choose the Remove button. 

Adding Users and Groups to Permissions and Auditing Lists 
The Add Users And Groups dialog box is available from the dialog boxes that 
allow you to change and remove permissions and auditing for users and groups. 
Use the dialog box to add users and groups to the permissions or auditing list, 
search for the members of a group, and find the domain to which a group or 
user belongs. 

l> To add a user or group to a permissions or auditing list 

1. In the permissions or auditing dialog box, choose the Add button. 

The Add Users And Groups dialog box displays the groups on the computer or 
in the domain shown by the List Names From box. Local groups are shown for 
the computer or domain whose name is followed by an asterisk (*). You can 
select another domain by using the List Names From box. 
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Domains appear only if your computer is a member of a domain on a 
Windows NT Advanced Server network. The domains shown have a trust 
relationship . 

.list Names From: L:I ©:::::. _"_se_tte_rx _______ ...1I....a!) 

A!!d Names: 

..................... ~.!?IT!!?!?r.?.g.~n .. r.\J.I),I! .. ~.qn~ink!.~.~ .. t h!?JY..~!.~n~.............. + 
Members can assign file backup and restore 
The user who creates this object 
All Users 
Guests of the domain 
Users accessing this object locally 
Users accessing this object remotely 
Members can treat the computer as their own + 

Add I Show Users I IMemberL·1 I Searchm I 

lYpe of Access: LI R_e_ad _______ --L..I f....J1 

OK Help 

2. You can use options in the Add Users And Groups dialog box to display users, 
find the users in a group, or find the domain to which a group or user belongs. 

• To display the names of users on the selected computer or domain, choose 
the Show Users button 

• To see a group's content, select the group and choose the Members button. 
Users are listed in a new dialog box. On a Windows NT Advanced Server 
network, global groups that are members of a local group appear in the list. 
To see a global group's users, select the group and choose the Members 
button. To include the group in the Add Users And Groups dialog box, 
choose the Add button. To include some of the group's users, select them 
and choose the Add button. 

• To add a group or user, you must know the domain which contains the 
group's or user's account. On a Windows NT Advanced Server network, 
choose the Search button to find the domain of a group or user. In the Find 
Account dialog box, type the name of the group or user in the Find User Or 
Group box and specify the domains you want to search. Then choose the 
Search button. To include the groups or users in the Add Users And Groups 
~ialog box, select them in the Search Results box and choose the Add 
button. 
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3. To add groups or users to the list, select them in the Names box and choose 
the Add button, or double-click the name of the group or user. Or you can type 
the names of groups and users in the Add Names box. Separate names using 
a semicolon. 

If the account of the group or user is not located on the computer or domain 
shown by the List Names From box, you must specify the location. Type the 
computer or domain name followed by the group or user name and separate 
the names using a backslash, for example shipping\ernesta. You can type the 
name without waiting for Windows NT to list groups in the Names box. 

4. If you are adding users or groups to a permissions list, select the permission 
for the groups or users shown in the Add Names box using the Type Of Access 
box. 

5. Choose the OK button. 

Taking Ownership of Files or Directories 
When you create a file or directory, you become the owner of it. By granting 
permissions, the owner controls how the file or directory is used. The owner 
can grant permission to another user to take ownership of a file or directory. 
Otherwise, you must be logged on as a member of the Administrators group 
to take ownership. 

Although an administrator can take ownership, an administrator cannot transfer 
ownership to others. This preserves security. For example, only an administrator 
who takes ownership and changes permissions can gain access to a file on which 
you have set No Access permission. By checking the ownership of the file, you 
would see the ownership change and know who had violated the permission you 
set on the file. To make sure that your files are secure, you should check their 
ownership regularly. 

~ To take ownership of a file or directory 

1. Select the file or directory in the File Manager window . You can select more 
than one file or directory at a time. 

2. From the Security menu, choose Owner. 

3. Choose the Take Ownership button. 

If you have selected one or more directories, File Manager asks whether 
you want to take ownership of all files and subdirectories in the trees of the 
selected directories. Choose Yes if you want to do so. 
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Maintaining Disks 
Use commands on the Disk menu to format, copy, and label floppy disks. 

Formatting a Floppy Disk 
Formatting prepares a floppy disk so that information can be stored on it 
and retrieved from it. Windows NT uses the MS-DOS FAT file system when 
formatting a disk. When you format a disk, File Manager removes all the 
information from it, writes new directory information to it, and checks for 
unusable portions called bad s"ectors. 

~ To format a floppy disk 

1. Insert a disk into a drive. 

2. From the Disk menu, choose Format Disk. 

3. In the Disk In box, make sure that the drive shown is the one containing 
the floppy you want to format. If necessary, select the correct drive. 

4. In the Capacity box, select the size of the disk you want to format. 

5. To give the disk a volume label, type a name in the Label box under Options. 

6. To quickly reformat a disk that has been formatted previously, select the Quick 
Format check box. A quick format deletes directory information in the file 
allocation table and root directory. The disk is not checked for bad sectors. 

7. Choose the OK button. 

8. A message prompts you to confirm that you want to format the disk. 
Formatting deletes all information on a disk, so make sure the disk is the 
one you want to format. Then choose the Yes button. 

File Manager displays its progress in a dialog box as formatting proceeds. You 
can work with File Manager while formatting continues in the background. To 
cancel formatting, choose the Cancel button. To hide the dialog box while 
formatting continues, choose the Hide button. 

Mter your disk is formatted, a message prompts you to indicate whether you 
want to format another disk. 

Caution You cannot recover information on a disk that has been formatted. 
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Copying a Floppy Disk 
You can make a copy of a floppy disk by using the Copy Disk command on the 
Disk menu. When you copy a floppy disk, both disks must have the same storage 
capacity. For example, if the disk you are copying from (the source disk) has a 
capacity of 720K, the disk you are copying to (the destination disk) must also. 

l> To copy an entire disk 

1. Insert the source disk in the drive you want to copy from. If you have two 
floppy disk drives of the same size, insert the destination disk in the drive 
you want to copy to. 

2. From the Disk menu, choose Copy Disk. 

3. If your computer has two floppy disk drives, select the letter of the source 
drive and the destination drive in the Copy Disk dialog box. Then choose 
the OK button. 

If your computer has only one floppy disk drive, you are not prompted to 
select drives. 

4. A message prompts you to confirm that you want to copy the disk. There is no 
way to recover information previously stored on the destination disk, so make 
sure the disk in the destination drive is one you want to overwrite. Then 
choose the Yes button. 

If you are making a copy using a single floppy disk drive, you are prompted 
to switch source and destination disks as needed. 

A message informs you of the percentage of your disk that has been copied. 

File Manager displays its progress in a dialog box as the copy is made. You can 
work with File Manager while copying continues in the background. To cancel 
copying, choose the Cancel button. To hide the dialog box while copying 
continues, choose the Hide button. 
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Labeling a Disk 
You can assign or change a label for a disk by selecting the Label Disk command 
on the Disk menu. 

I> To assign or change a volume label 

1. Click the drive icon for the disk you want to label. 

2. From the Disk menu, choose Label Disk. 

3. In the Label box, type the label for the disk. 

Labels on NTFS disks can contain up to 32 characters. Labels on FAT 
and HPFS disks can contain up to 11 characters. 

4. Choose the OK button. 
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Control Panel 

You can use Control Panel to customize various features of Windows NT. 

This chapter describes the options available in Control Panel, which include 
the following: 

• Changing the desktop 

• Setting serial port communications options 

• Working with fonts 

• Working with date, time, and international settings 

• Customizing the keyboard, cursor, and mouse 

• Working with printers 

• Working with device drivers 

• Defining options for the operating system and 
the uninterruptible power supply 

• Configuring the network 

• Managing server properties and services 

109 
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Overview 
Control Panel provides many options for customizing Windows NT so that it 
works and looks the way you want. The icons in Control Panel represent options, 
including network and sound capabilities, for configuring a computer. For each 
icon, there is a corresponding command on the Settings menu. Your Control Panel 
window may look different, depending on the devices you have installed, such as 
an extra pointing device. 

Most changes made in Control Panei (except adding and removing fonts) will 
affect only the user who is currently logged on to the computer. 

Some options in Control Panel require you to be logged on as a member of a 
specific group. If you are not a member of the necessary group, a message 
appears. 

.!:!.elp 

A\ c::J 

~ """' - g p 
Fonts Ports Mouse Desktop Keyboard Printers 

~ ~ ~~ Jl~ ~ ~ 
International System Date/Time Network Cursors Sound MIDI Mappe 

~ & ~ ~ -- , 

Drivers Server Services Devices UPS 
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The following table describes Control Panel options. 

Choose 

Color 

Cursors 

Dateffime 

Desktop 

Devices 

Drivers 

Fonts 

International 

Keyboard 

MIDI Mapper 

Mouse 

Network 

Ports 

Printers 

Server 

Services 

Sound 

System 

UPS 

To 

Set the color of the various elements of the desktop. 

Change the appearance of the cursor. 

Change the system date, time, and time zone. 

Specify the pattern, screen saver, alignment grid, icon spacing, 
and cursor blink rate. 

Start, stop, and configure the startup type for device drivers. 

Install and configure drivers for optional devices such as 
sound boards and synthesizers. 

Add or remove screen, vector, and TrueType fonts. (Some 
printer fonts are installed automatically when you install a 
printer. Other printer fonts must be installed using a font 
installation program provided by the font manufacturer.) 

Specify international settings such as the country and language, 
number and currency formats, and date and time formats 
without changing the language of the product itself. 

Adjust the keyboard delay and repeat rate. 

Select, change, or create MIDI setups, patch maps, or key 
maps for playing a synthesizer connected to your computer. 

Customize elements such as speed and button function for 
your pointing device. 

Install and configure network adapter cards and other network 
software, and join a workgroup or a domain. 

Set parameters for serial communications ports. 

Open Print Manager to work with local and network printers. 

For the local computer, view and manage connected users, 
directory shares, open resources, directory replication, and 
recipients of administrative alerts. 

Start, stop, pause, or continue the services available on the 
computer and configure startup options. 

Assign sounds to system and application events, and turn on 
or off the warning beep and system sounds. 

Specify the default operating system for startup, change user 
environment variables, and define paging file size. 

Configure the uninterruptible power supply to ensure safe 
shutdown during a power failure. 

For additional information about any option in Control Panel, see the online Help. 
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Changing the Desktop 
You can use the Desktop option to customize the appearance of your desktop 
(which is where elements such as windows, icons, and dialog boxes appear). You 
can specify a pattern or wallpaper for the desktop, adjust icon spacing, wrap icon 
titles, or set an invisible grid to easily align windows and icons. Use the Color 
option to select the colors used for displaying desktop elements. 

Customizing Desktop Colors 
The colors assigned to the different parts of the desktop are saved in color 
schemes. Several predefined color schemes are provided. A solid color in 
Windows NT is directly supported by your display adapter. VGA adapters support 
16 solid colors, and 256-color adapters support 20 solid colors. Both types of 
displays support hundreds of dithered colors, which are produced by patterns of 
colored dots to simulate a color or pattern. Depending on the screen resolution, 
dithered colors can look almost exactly like solid colors. 

Changing an Existing Color Scheme 
You can change individual colors assigned to a color scheme. If you find that 
you use only one or two color schemes,you can shorten the list of selections by 
deleting schemes. The only color scheme that cannot be deleted is Windows 
Default, the scheme you see the first time you start Windows NT. 

Note Deleting a color scheme on a particular computer will remove that scheme 
for every user on that computer. 

r> To change the colors of a color scheme 

I~I 1. In the Control Panel window, double-click the Color icon. 

t 2. In the Color Schemes box of the Color dialog box, select the color scheme 
you want to change. 

3. Choose the Color Palette button. 

The Color dialog box expands to include a list of screen elements, a palette 
of basic colors, and a palette titled Custom Colors. 



Inactive 

File Edit 

Clicking "Highlightedll 

alternately selects the 
Highlight and Highlighted 
Text elements. 

+ 
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,!!asic Colors: 

~ustom Colors: 

DDDDDDDD 
DDDDDDDD 

Qefine Custom Colors .. _ 

Clicking the OK button alternately selects 
the Button Face, Button Shadow, Button 
Text, and Button Highlight elements. 

4. Click the part of the sample screen where you want to change the color. 
Or in the Screen Element box, select the element from the list. 

You can see which element is selected in the Screen Element list. 

S. In the Basic Colors palette, select the color you want. 

The color is displayed in the sample screen. 

6. Change the color of any other screen elements until you are satisfied with 
the color scheme. 

Control Panel uses the solid color closest to the selected dithered color for 
the following screen elements: 

Window Frame Window Text 

Menu Bar 

Button Face 

Highlight 

Menu Text 

Button Text 

Highlighted Text 

Window Background 

Active and Inactive Title 
Bar Text 

Disabled Text 
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7. To save the new color selections, choose the Save Scheme button, and then 
type a name for the scheme. 

If you don't save the scheme, Windows NT still uses the new color selections 
until you change them again, even if you quit and restart Windows. However, 
when you make another change or choose an existing scheme, the color 
selections are lost. 

8. Choose the OK button. 

Defining Custom Colors 
The Basic Colors palette contains 48 colors. You can define and use up to 16 
additional custom colors in a color refiner box by specifying the hue, saturation, 
luminosity, and relative amounts of red, green, and blue. 

Hue is the position of the color along the color spectrum. Saturation is the purity 
of the hue, moving from gray to the pure color. Luminosity is the brightness of the 
color on a scale from black to white. 

k> To define a custom color 

1. In the Color dialog box, choose the Color Palette button, and then choose 
the Define Custom Colors button. 

Hye:l~ ~ Red:~ 
~at: ~.!!.reen: ~ 

Colorl5.Q.lid !,um: ~ !!Jue: ~ 

Color refiner box 

Luminosity bar 

2. Move the color refiner cursor to the area of the color refiner box that shows 
the color you want. Then drag the arrow next to the luminosity bar to adjust 
the luminosity. 

The new color is displayed on the left side of the Color/Solid box. The right 
side of the box displays the solid color closest to your choice. To select the 
solid color, choose the right side of the box, or press ALT +0. 
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3. When you are satisfied with the color, select a box in the Custom Colors 
palette for the new color. You can select an empty box or one that contains 
a color you want to change. 

If you do not select a box for the new color, it is placed in the first available 
empty box or in the upper-left position in the Custom Colors palette. 
Subsequent custom colors fill the boxes in sequence from upper left to lower 
right unless you choose a specific box for the new color. 

4. Choose the Add Color button to add the new color to the Custom Colors 
palette. 

5. Define any other custom colors you want to add to the palette, and then 
choose the Close button to return to the Color dialog box. Or to return to the 
Color dialog box without closing the Custom Color Selector dialog box, drag 
the Custom Color Selector dialog box to a new position. 

You can now choose the custom colors the same way you would choose colors 
from the Basic Colors palette. 

Configuring Desktop Appearance 
You can use the Desktop icon in Control Panel to configure the appearance 
of your desktop. 

PaUern----------, 

N.ame: Ilmli.ll[n:.·.·:;;·2:;.~·;.~·.:;.:;·L~~.·;:;:~·.~.:;;:·::.';.:]1 f I 
" Edit p.auern... I 

Screen Saver --------;:::======;_, 
N.!!me:IBeziers 1 fl Test 

Q.elal': ~ Minutes Setyp ... 

D Passw,Q,rd protected 

Wallpaper 
file: I'--W-in-n-t. b-m-p----.I [!J 
@ ,kenter 0 J.ile 

Sizing Grid 

Icons------, 

fulacing: ~ PiKels 

[8J ~r ap Title 

Cursor Blink Rate 

!!.ranularitl': Ia Slow Fast 
.!!.order Width: ~ 1"-1 +-'I---rC---',J '--'-1+--'1 
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Changing or Creating a Pattern 
You can change a predefined desktop pattern, create a new pattern, or remove 
a pattern. 

l> To change an existing pattern 

1. In the Control Panel window, double-click the Desktop icon. 

2. Choose the Edit Pattern button. 

Sample 

Click areas in the cell where you 
want to reverse the color. 

3. In the Name list, select a pattern. 

A sample of the current pattern appears in the Sample box. The cell shows 
an enlarged version so you can make changes to the pattern. 

4. In the cell, click locations where you want to reverse the colors in the pattern. 

S. When the Sample box shows the pattern you want, choose the Change button. 

6. Choose the OK button to return to the Desktop dialog box. 

l> To create a pattern 

1. In the Name box of the Edit Pattern dialog box, type a name for the new 
pattern. 

2. Click locations in the cell where you want to reverse the colors in the pattern. 

3. When the cell shows the pattern you want, choose the Add button. 

4. Choose the OK button to return to the Desktop dialog box. 

The pattern you define is repeated as many times as necessary to completely fill 
the background. The colors of the pattern are determined by the Desktop and 
Window Text colors you choose. 

If you find that you use only one or two patterns, you can select patterns you no 
longer use and choose the Remove button in the Edit Pattern dialog box. 
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Displaying Custom Wallpaper 
You can display a .BMP bitmap graphic on your desktop instead of a solid color 
or pattern. Paint programs that produce .BMP files, such as Windows Paintbrush, 
can be used to create a bitmap or to modify a scanned image. Mter you create the 
bitmap, save the .BMP file in the \ WINNT directory (or specify the full path when 
choosing the bitmap as wallpaper). 

Note Windows uses more memory when displaying wallpaper than when 
displaying a solid color or a pattern on the desktop. If you run out of memory 
when running an application, you can change to a color or pattern to free some 
memory. 

t> To choose a bitmap to display as wallpaper 

lo~ I 1. In the Control Panel window, double-click the Desktop icon. 

2. In the File box under Wallpaper, select a bitmap from the list. 

If you saved the bitmap in a directory other than the Windows NT directory, 
type the full path and bitmap filename. 

3. Select Center or Tile. 

The Center option positions the bitmap in the center of the desktop. The Tile 
option repeats the bitmap as many times as necessary to cover the desktop. 

If you select both a pattern and custom wallpaper in the Desktop dialog box, the 
wallpaper lies over the pattern. If you select the Center option for the wallpaper 
and the bitmap doesn't cover the entire desktop, you'll see the pattern around the 
edges of the bitmap. If the original bitmap is too large to fit on the screen or takes 
up too much memory, Windows NT does not display it. 

If you want to remove a wallpaper from the list, delete the bitmap file from the 
\ WINNT directory. 

Preventing Icon Titles from Overlapping 
Sometimes an icon's title is so wide that it overlaps an adjacent icon. You can use 
the Desktop icon to control the display of icon titles. 

Windows NT calculates the standard spacing for application, document, and 
program-item icons based on the size of the widest icon. Usually this spacing is 
adequate. However, sometimes the description for an icon exceeds the icon's 
width, causing it to overlap adjacent icons. 
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Icon spacing is measured in pixels, the smallest unit of measurement on the 
screen. Increments of 10 pixels result in noticeable increases in spacing between 
icons. 

I> To increase icon spacing and wrap an icon title 

1. Under Icons in the Desktop dialog box, click the up or down arrow in the 
Spacing box to increase or decrease the spacing between icons, or type a 
number. 

2. Select the Wrap Title check box if you want the title to wrap. 

Changing Window Border Width 
Many windows can be resized by using the mouse to drag the window border 
to a new size. If a window can be resized, you can make it easier to "grab" the 
window border by increasing the border width. 

I> To change the border width of windows 

• Under the Sizing Grid in the Desktop dialog box, click the up or down arrow 
in the Border Width box to increase or decrease the border width. Or type a 
number from 1 to 50, with 1 being the narrowest border. 

Changing the Sizing Grid of Windows 
The position and alignment of application windows and icons on your desktop 
are determined by an invisible grid. When Windows NT is set up, the sizing grid 
is turned off so that icons and windows remain where you place them on the 
desktop. When the sizing grid is turned on, application windows and minimized 
icons align with the nearest invisible gridline. 

The grid changes in multiples of 8 pixels. A value of 1 creates a grid with 8 pixels 
between gridlines, a value of 2 creates a grid with 16 pixels between gridlines, 
and so forth. A value of 0 cancels the grid. 

This option only affects application windows and the application icons that appear 
at the bottom of your screen. The sizing grid has no effect on document windows 
and icons. 

I> To set the grid spacing 

• Under the Sizing Grid in the Desktop dialog box, click the up or down arrow 
in the Granularity box to increase or decrease the size of the grid, or type a 

. number from 0 to 49. 
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Switching Between Applications 
Windows NT allows you to run multiple applications at one time. However, 
when doing this, it is sometimes difficult to locate a specific application window. 
You can use fast application switching to switch between your applications. 

t> To use fast application switching 

lo~ I 1. In the Control Panel window, choose the Desktop icon. 

2. In the Desktop dialog box, select the Fast Alt+ Tab Switching check box, 
and then choose the OK button. 

If Fast Task Switch is selected, you can quickly cycle through the names of the 
applications running at that time. If Fast Task Switch is not selected, pressing 
ALT+TAB still works, but only the title bar of each window is highlighted. 

3. Press ALT+TAB to cycle through the running applications. When you see the 
name of the application you want, release the keys. 

If, while moving through the applications by pressing ALT + TAB, you want 
to return to your original application, press ALT+TAB+ESC. 

Working with Screen Savers 
Screen savers are used to reduce wear on your display and to provide security for 
your system. A screen saver is a moving pattern or bitmap that appears after you 
have not used your computer for a specified time. 

When Windows NT is set up, a default screen saver is selected. However, several 
other screen savers are available. Move the mouse or press any key to turn off the 
screen saver. 

You can use the Windows NT screen savers or the IdleWild screen savers 
included in the Microsoft Entertainment Pack for Windows. To use the IdleWild 
screen savers, the IWLIB.DLL file and the screen saver files (those with the 
extension .IW) must be in the same directory. Place these files in your \WINNT 
directory .. 

When you use a screen saver provided by Windows NT, you can ensure that 
unauthorized users do not have access to your work by using password protection 
with a screen saver. If someone tries to use your computer once the password­
protected screen saver is displayed, a Lock Workstation dialog box appears. To 
unlock the computer, the same password used to log on to the computer must be 
entered. 
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~ To select a screen saver and turn password protection on and off 

1. Under Screen Saver in the Desktop dialog box, select a screen saver in the 
Names box. 

2. In the Delay box, click the up or down arrow to increase or decrease the 
number of minutes before the screen saver is activated, or type a number 
between 1 and 99. 

3. If you want to protect your display with a password, select the Password 
Protect check box. 

4. To configure your screen saver, choose the Setup button, and then complete 
the setup dialog box that appears. 

5. To see how your screen saver looks, choose the Test button, and then move 
the mouse or press a key on the keyboard to stop the screen saver. 

Setting Serial Port Communications Options 
You can specify the communications settings for each serial port your system uses 
by using the Ports option. Windows NT can support up to 256 serial ports. Serial 
ports (named COMI through COM256) are used to connect to serial pointing 
devices, printers, and other serial devices. Most computers include at least two 
serial ports: COMI and COM2. Some devices, such as serial-port adapters, 
modems, and fax cards, use COM3 through COM256. The settings you specify 
determine how information is transferred between your computer and the serial 
device. 

The communications settings you can specify include standard settings such as 
those for baud rate, parity, and flow control, and more advanced settings such 
as those that specify the base port address and interrupt request (IRQ) line that 
Windows NT uses to send information to a serial port. If you plan on using only 
COMI and COM2, you may only need to change the standard settings. If you use 
COM3 through COM256, you may need to change the advanced settings. 

Most communications applications that you use to exchange information between 
computers, such as Windows Terminal, require that you specify standard port 
settings within the application. These settings, such as baud rate, parity, and data 
bits, override the settings you specify by using the Ports option in Control Panel. 
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t> To specify standard communications settings 

1. In the Control Panel window, choose the Ports icon. 

2. In the Ports dialog box, select the name of the port for which you want to 
specify communications settings. 

3. Choose the Settings button. 

4. In the Settings dialog box, display the options for each setting by clicking 
the scroll arrow to the right of each box. 

5. Set the options to match the device connected to the port. 

For information about the correct settings, see the documentation supplied 
with the device. 

6. When you finish specifying the settings, choose the OK button to return to 
the Ports dialog box, and then choose the Close button. 

For additional help on setting Advanced Options, see the online Help in the 
Ports dialog box. 

Working with Fonts 
A font, or typeface, is a collection of letters, numerals, symbols, and punctuation 
marks that have common characteristics. Fonts come in different sizes and 
styles. Font sizes are the height of a character measured in points-a point is 
approximately 1/72 of an inch. Font styles include characteristics such as bold 
and italic. Because of the differences in display resolution between the screen and 
the printer, what appears on screen and what appears in the printed document 
may be different. 

If you use TrueType fonts in your documents, Windows NT and all Windows 
applications display the fonts on the screen exactly as they appear when printed; 
there is no need to install matching screen fonts. In addition, by using TrueType 
fonts, your documents become more portable because they look the same printed 
on different printers, as long as you use the same application and print at the same 
resolution. If you print at a different resolution or are printing a document from an 
older application, line and page breaks might change. 
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Adding Screen Fonts and TrueType Fonts 
When you install a printer driver, screen fonts that match the printer fonts are 
usually installed. If you are using cartridge or soft fonts, your font manufacturer 
usually supplies an installation program for installing screen fonts, or the 
installation program that installs the cartridge or soft fonts may install the 
screen fonts automatically. 

If no installation program is provided for installing screen fonts, you can use 
the Fonts option to install them. You can also use the Fonts option to install 
any additional TrueType fonts that you purchase. 

To add a font 

1. In the Control Panel window, choose the Fonts icon. 

Installed fonts: 

ti~.w:rtilir!JWIG~;;5i:.LhiJ;i1Lh:it.; i!)lE.l\Gi£;j.LiE.;;Lilili1i;ti~;L + 
Arial Bold (T rue Type) 
Arial Bold Italic (TrueType) 
Arial Italic (T rue Type) 
Courier 10.12.15 (VGA res) 
Courier New True T e 

~ample 

aBbCcXxYyZz 123 

This is a scalable TrueType font which can be 
displayed on the screen and printed on your printer. 

Size of Font on Disk: 67 KB 

:Cancel"j 

Remove I 
Add ... J 

I.rueT 
!:!eJp· 

The Fonts dialog box lists all the installed fonts and the font type (for example, 
TrueType) displayed in parentheses. 

The Sample box displays the selected font in all available sizes unless the font 
is a vector font or a TrueType font. Vector fonts can be scaled to any height, 
so the only size displayed is the size used to design the font. TrueType fonts 
can also be scaled to any height and are displayed in about 24-point size. 
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2. In the Fonts dialog box, choose the Add button. 

List of Fonts: 
Arial (TrueType) 
Arial Bold (TrueType) 
Arial Bold Italic (TrueType) 
Arialltalic (TrueType) 
Courier 10.12.15 (8514/a res) 
Courier 10.12.15 (VGA res) 
Courier New (TrueType) 
Courier New Bold rTruehoel 

Qirectories: 
c: \winnt\system32 

12:> winnt 
~H:m~Y/ 
-LJCo~"""--

.. I IS c: 

OK 

Cancel 

I Select All 

I Help 

N etl!ork~:: 

LJ drivers 
LJ os2 
LJ repl .. [2J !;opy Fonts to Windows Directory 

3. In the Directories and Drives boxes of the Add Fonts dialog box, select 
the drive and directory that contains the fonts you want to add. 

4. In the List Of Fonts box, select the fonts you want to add. 

To select a nonconsecutive list of fonts in the box, click the fonts while 
pressing CTRL. 

To add every font in the list, choose the Select All button. 

5. If you have limited disk space, you can clear the Copy Fonts To Windows 
Directory check box. You can then use the fonts directly from the directory in 
which they are located, without copying them to your \ WINNT\SYSTEM32 
directory. 

6. Choose the OK button to add the selected fonts, and then choose the 
Close button. 
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Removing a Font 
The fonts installed in Windows NT occupy memory. If you don't use all the fonts 
you have installed, you can remove them from your system and free memory for 
use by your applications. 

Important The MS Sans Serif font set is used by most Windows NT dialog boxes. 
Do not remove this font; if you do, the text in the dialog boxes will be difficult to 
read. Deleting a font on a particular computer removes that font for every user 
who logs on to that computer. 

~ To remove a font 

1. In the Installed Fonts list of the Fonts dialog box, select the fonts you want. 
to remove. 

To select a nonconsecutive list of fonts in the box, click the fonts while 
pressing CTRL. 

2. Choose the Remove button. 

3. If you want to delete the font files from your disk as well as remove the fonts 
from memory, select the Delete Font File From Disk check box. 

Caution It is recommended that you not delete fonts from the disk if you 
chose not to copy the fonts to your \ WINN1\SYSTEM32 directory. If you 
delete the fonts from your hard disK~'you must supply the original Windows 
NT installation disks if you decide to add these fonts later. 

4. In the message that appears, choose the Yes button, or, if you are removing 
several fonts at the same time, choose the Yes To All button. 

5. In the Fonts dialog box, choose the Close button. 
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Working with Date, Time, and International Settings 
The system date and time are used in some Windows applications and in various 
places in Windows NT such as File Manager and Event Viewer. Before setting 
the date and time on your system, you must be sure to set the correct time zone. 
The way the date and time are displayed can be specified through the 
International option. 

Configuring Date and Time 
The system date and time are reflected in Clock and Calendar (two Windows NT 
applications in the Accessories group), as well as in the information kept by File 
Manager for each file you save on your disk. 

Setting the System Date and Time 
You can set the date and time on your system. 

t> To set the date and time 

1. In the Control Panel window, choose the Date/Time icon. 

Qate: I 121 2 192 f'$J lime (local): 

I 
D Automatically Adjust for Daylight Savings Time 

I OK 

4:39:53PM ~ I Cancel···.i 

I' Help 

The order of the elements in date 
and time depends on settings in 
the International Format boxes. 

2. In the Time Zone box, select the time zone for your area. 

If your area uses daylight saving time, select the check box to automatically 
adjust the time. 

3. In the Date box, select the part of the date (day, month, or year) you want to 
change, and then type the new value, or click the up or down arrow. 

4. In the Time box, select the part of the time (hour, minute, second, suffix) you 
want to change, and then type the new value, or click the up or down arrow. 

5. Choose the OK button. 
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Changing the Date and Time Display 
You can change the way the date is displayed in applications that have a date 
function. For example, you can vary the order of the month, day, and year, or 
change the punctuation used to separate parts of the date. 

r> To change the date format 

1. In the Control Panel window, choose the International icon. 

2. Under Date Format in the International dialog box, choose the Change button. 

r Short Date Format IK 

.Qrder: @ l~f~Yj 0 DhtV OVMD .,;.. . 
~eparator: [D 
D D. ay leading Zero (07 vs. 7) I: Heip·· I 
D .Month leading Zero (02 vs. 2) 

D ~entury (1990 vs. 90) 

r-long Date Format 
Older: @ htDV o DhtV OVMD 

1 Sunday 1 !I D 1 March 1!IDI05[!JDI1992III 

Sunday. March 05. 1992 

3. In the International - Date Format dialog box, set the options you want for 
both the Short Date Format and Long Date Format. 

The Short Date Format displays the date as three numbers representing the 
month, day, and year. You can specify the order and number of digits for each 
part of the date. For example, selecting Century displays the year as a four­
digit number. . 

The Long Date Format displays the date as a combination of words and 
numbers (for example, Monday, October 19, 1992) or a variation you specify. 

4. Choose the OK button to return to the International dialog box. 

You can also specify how the time is displayed in applications. For example, 
you can display the time in a 12-hour or 24-hour format, change the punctuation 
between the hour, minute, and second, or add suffixes to the time, such as A.M. for 
morning or PST for Pacific Standard Time. 
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I> To change the time format 

1. Under Time Format in the International dialog box, choose the Change button. 

@l~I"~.~·~.~j 00:00-11:59 lAM 
~===: o 2! hour 12:00-23:591 ':-P_M-,--_-J 

~eparator: D 
!:eading Zero: @ 9:15 

OK 

Cancel 

Help 

Two different suffixes can be added to the 
12-hour format; only one suffix is visible 
and can be added in the 24-hour fon;lat. 

2. Set the options you want, and then choose the OK button to leturn to the 
International dialog box. 

Working with Other International Settings 
With the International option, you can specify basic international settings such 
as the country, language, and system of measurement you want to use. When you 
select a country, Windows NT automatically adjusts other formats to reflect those 
used by the selected country . You can also customize these settings. 

I> To select international settings 

1. In the Control Panel window, double-click the International icon. 

!:anguage: 1 English (American) 

~eyboard layout: ,:-1 U_S_E_n.::...gl_is_h ______ ..... 1 !,...j] 

Measurement: ,:-1 E_ng=-li_sh _______ ---""I !_I 
list ~eparator: D 
Qate Format Cyrrency Format 

12122/92 

Tuesday. December 22. 1992 

[l;me F .. ma' 
4:33:37 PM I Chang em I 

.!::Ielp· 
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2. In the International dialog box, specify the settings for Country, Language, 
Keyboard Layout, Measurement, and List Separator. 

A description of each option follows this procedure. 

3. Choose the appropriate Change button to customize settings for Date and 
Time Format as specified in the preceding section. 

4. Choose the Change button under Currency Format. 

In the International - Currency Format dialog box, you can control the way 
currency is represented. For example, you can place the currency symbol in 
different locations relative to the amount, specify how negative currency 
values are represented, or change the currency symbol for your country. 

5. Set the options you want, and then choose the OK button to return to the 
International dialog box. 

6. Choose the Change button under Number Format. 

In the International - Number Format dialog box, you can control the way 
numbers are displayed. For example, you can choose the punctuation 
separating thousands and punctuation separating the fractional part of a 
decimal number, or change the decimal display of numbers. 

7. Set the options you want, and then choose the OK button to return to the 
International dialog box. 

Use this option 

Country 

Language 

Keyboard Layout 

Measurement 

List Separator 

To 

Specify the country with the standard settings you want to 
use. When you select a country, Windows NT automatically 
adjusts the settings for the date, time, number, and currency 
formats, as well as the Paper Size option in the Print Setup 
dialog box, to match the standard formats used by that 
country. 

Specify the language you want to work in. The language 
you select affects the way applications sort information and 
provides ANSI code page, OEM code page, and OEM font 
information. For example, if the language you are working 
in includes extended characters, setting this option to that 
language ensures that your applications will correctly . sort 
words or phrases that include these characters. 

Specify the keyboard layout of your computer. Keyboard 
layouts vary to accommodate the special characters and 
symbols used in different languages. Windows NT uses 
this setting to interpret the keys you press. 

Select the metric or English system of measurement. 

Specify a symbol to separate elements in a list. In English, 
the list separator is typically a comma and is used to separate 
words or numbers that appear in a series. 
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Customizing the Keyboard, Cursor, and Mouse 
You may have personal preferences about how your cursor, keyboard, mouse, 
or other pointing device works. For example, you may want the mouse pointer to 
move rapidly, the keyboard to repeat rapidly when you hold down a key, or the 
cursor to blink more slowly. You can use Control Panel to customize several 
options. 

Choose 

Keyboard 

Desktop 

Cursors 

Mouse 

To 

Adjust the keyboard speed. 

Adjust the cursor blink rate. 

Change the cursor appearance. 

Adjust the speed of the pointer, set the double-click speed, 
swap the functions of the left and right mouse buttons, and set 
any options specific to the mouse you are using. 

Adjusting the Keyboard Delay and Repeat Rate 
You can adjust how long your computer waits after you hold down a key before 
it repeats that key, and then how fast the key repeats when you hold it down. 

t> To change the keyboard delay and repeat rate 

I~~I 1. In the Control Panel window, choose the Keyboard icon. 
V A'"A" A" ' ., v,, ,,'<,. , .• "'" ,. "' ."., ~. , ... ""." .. ~ 

1=-1 .··lb{}l?lnmJ'¥t{··.· 

1 Keyboard Speed --------, I: OK > I: I 
1 ,l!elay Before First Repeat . > -' 

I I
l:r9 I I 5,:; I Cancel I! 

I Repeat Rate 

I t~,w 

I Ie,' 

Help I: 
Fast 

1+1 

.... 

2. Under Delay Before First Repeat, drag the scroll box toward Long or Short 
to increase or decrease the delay. Or click the appropriate scroll arrow. 

3. Under Repeat Rate, drag the scroll box toward Fast or Slow to increase or 
decrease the repeat rate. Or click the appropriate scroll arrow. 

4. To test the speed, move to the Test box and type or hold down any key on the 
keyboard. Adjust the box positions until you reach a delay speed and repeat 
rate you are comfortable with. 

5. Choose the OK button. 
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Adjusting the Cursor Blink Rate 
You can adjust how fast the cursor blinks. 

r> To change the cursor blink rate 

1. In t~e Control Panel window, choose the Desktop icon. 
~---------------------

Sizing Grid r- Cursor Blink Hate 

granularity: ~ Slow Fast 
Horder Width: ~ I,...,I • ....,..-,,-----.-[..,...,j,: "----"-1.,--::11 

2. Under Cursor Blink Rate, drag the scroll box toward Fast or Slow or click 
the appropriate scroll arrow. 

3. Choose the OK button. 

Changing the Cursor Appearance 
You can change the look of your cursor with animated or static cursors provided 
by Windows NT. 

~ To change your cursor 

h:t~ 1. In the Control Panel window, choose the Cursors icon. 

Application Starting 

No 

I I-Beam '---_________ ---"'_ I,SetQ.tifaultl ' 

2. In the System Cursors box, select an action whose cursor you want to change. 

3. Choose the Browse button. 
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4. In the Directories and Drives boxes of the Browse dialog box, select the drive 
and directory that contains the cursor files you want to view. 

5. In the File Name box, select a file. 

An example of what the cursor looks like appears in the Preview Window. 

6. Choose the OK button to return to the Cursors dialog box. 

7. Change the cursors for any other actions and then choose the OK button. 

8. To reset the selected action to the system default cursor, choose the Set 
Default button. 

Customizing Your Mouse or Other Pointing Device 
You can adjust the way Windows NT works with your mouse or other pointing 
devices. For example, if you are using a mouse, you may be able to switch the 
functions of the left and right buttons, change the speed of the mouse pointer, 
or change the double-click rate. 

Before customizing settings for your pointing device, you need to install it and 
its driver, using Windows NT Setup. For information, see Chapter 12, "System 
Maintenance with Windows NT Setup." 

C"".M.ouse Tracking Speed- OK 
Slow Fast 

1 +~ jF'~l I .. t I Cancel 

.!louble Click Speed Kelp 

Slow Fast 
1+1 1 I I .. , 

TEST o li.wap left/Right Buttons 

~ To customize your pointing device 

1. In the Control Panel window, choose the icon for your pointing device. 

A dialog box appears for the device you are using. 

2. Set the options you want, and then choose the OK button. 

For details about the options and their settings, see the documentation for 
your pointing device and Help, if available. 
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Working with Printers 

~ The Printers option in Control Panel opens Print Manager and allows you to work 
with local and network printers. With Print Manager you can: 

• Install local printers 

• Set printer properties 

• Connect to and share printers on a network 

• Remotely administer printers 

For more information about Print Manager, see Chapter 6, "Print Manager." 

Working with Device Drivers 
When you add a new device to your system, such as a new sound board or video 
player, you need to install the driver that controls the device. A device driver is 
a program that allows a specific piece of hardware (or device) to communicate 
with Windows NT. Although the device may be installed in or connected to your 
computer, Windows NT does not recognize the device until after you install and 
configure the appropriate driver. 

Installing and Configuring Drivers 
Most devices come with the appropriate driver. Windows NT also supplies sound 
drivers for common sound devices, such as sound boards and synthesizers. If you 
do not have a driver for your device, contact your device dealer or manufacturer 
about providing one. 

Installing a New Driver 
To install kernel drivers (drivers that access hardware), you must be logged on as 
a member of the Administrators group. The drivers you install will be available to 
all users. 

~ To install a new driver 

1. In the Control Panel window, choose the Drivers icon. 

The Drivers dialog box displays a list of the drivers already installed. 
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2. In the Drivers dialog box, choose the Add button. 

List of Drivers 

llJtifdH.ilti),kLWr1.U1Li.;';JUikFL " •• W.'~."" •• ", ,,~C'~"M r!­
(MCI) CD Audio 
(M CI) Midi Sequencer 
(MCI) Sound 
Ad Lib 
Creative Labs Sound Blaster 1.X 
Low level Wave. MIDI and AUX support 
Media Vision Thunder Board 
MIDI Mapper 

I OK 

I: Cancel 

I, Help 

3. In the Add dialog box, select the driver you want to install from the list, 
or select Unlisted or Updated Driver if your driver is not yet known to the 
system, and then choose the OK button. 

4. You will often get a message saying the driver is already present on your 
system. If you don't have a driver disk or a new driver somewhere else on 
your system, you should select the Current button. 

If a message asks you to insert the disk that contains the driver file, insert the 
disk containing the driver you want to install into drive A. Or, if the driver is 
located on your hard disk, type the drive and directory where the driver is 
located. 

If you do not know where the driver file is located, choose the Browse button 
to locate and select the drive and directory that contain the driver file, but do 
not type the filename for the driver. 

5. If a setup dialog box appears, select the settings required by the driver, such as 
the port address and interrupts for a sound board. 

Important The settings you specify must not conflict with the settings used by 
other devices installed on your system, such as a mouse or network card. For 
example, the interrupts used by each device must be unique. You may get a 
message about a configuration error having occurred if the hardware used by 
the drivers you are installing or the options you have requested conflict with 
the hardware or drivers already installed on your system. 

To avoid conflicts, see the manuals for your other hardware devices to 
determine the settings they use. Then see the manual that came with the device 
you are configuring for information about its settings. 
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6. When you finish selecting the settings, choose the OK button. 

Windows NT installs any additional related drivers automatically. These 
drivers may also require specific settings. In this case, other setup dialog boxes 
may appear. 

7. Repeat steps.S and 6 until all related drivers have been configured. 

The new driver and any changed driver settings do not take effect until you 
restart Windows NT. A message asks you if you want to restart Windows NT. 

8. To have the new driver take effect immediately, choose the Restart Now 
button. 

Installing a Driver Not Supplied with Windows NT 
When you purchase a new device, such as a sound board, the associated driver 
should be included with the device. If you do not have a driver for your device, 
contact the device manufacturer or dealer to get one. Follow any instructions the 
manufacturer provides for installing the driver. 

Note Most drivers written for Windows 3.1 cannot be installed. Drivers should 
be written specifically for Windows NT. If a driver can't be installed, a message 
indicating the problem will be displayed. 

Setting Driver Options 
Mter you have installed a driver, you can change any of its settings. If you want 
to use more than one set of settings for the same driver, you need to install that 
driver twice. For instructions on how to install a driver, see "Installing and 
Configuring Drivers,"earlier in this section. 

~ To adjust driver settings 

~i!! 1. In the Control Panel window, choose the Drivers icon. 

2. In the Installed Drivers list in the Drivers dialog box, select the driver you 
want to configure. 

3. Choose the Setup button. 

Some drivers do not require specific settings. If you select such a driver, 
the Setup button is unavailable. 

The Setup dialog box appears. The options in this dialog box vary according 
to the driver you are configuring. 

4. Set the options as described in the manual for your device. 

5. Choose the OK button. 

The changes you make do not take effect until you restart Windows NT. 
A message asks if you want to restart Windows NT. 
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6. To have the new settings take effect immediately, choose the Restart Now 
button. 

Removing a Driver 
You need to be logged on as a member of the Administrators group to remove 
some drivers. 

If you are no longer using a device, you can remove its driver from the Drivers 
list. Removing a driver from the Drivers list does not remove the driver file from 
your hard disk. If you need to use the same device later, you can add its driver 
again. 

Caution The drivers that are automatically installed while running Setup are 
required by your system (these are the drivers that are displayed when you first 
open the Drivers dialog box). If you remove one of these drivers, your system 
may not work properly. 

To remove a driver 

1. In the Control Panel window, choose the Drivers icon. 

2. From the list of installed drivers in the Drivers dialog box, select the driver 
you want to remove. 

3. Choose the Remove button. 

4. When the message asks you to confirm your decision to remove the driver, 
choose the Yes button. 

A message asks if you want to restart Windows NT. 

5. To have the removal take effect immediately, choose the Restart Now button. 

Using Audio and MIDI Sounds in Windows NT 
The Sound icon provides several options for controlling audio sound in Windows 
NT. To use audio sounds, you need to install a sound card and a sound driver, and 
then choose the Sound icon to assign different sounds to system and application 
events. 

The Musical Instrument Digital Interface (MIDI) Mapper provides options for 
setting up and playing MIDI sound in Windows NT. To use MIDI sounds, you 
need a sound device such as a synthesizer and MIDI device drivers. Windows NT 
supports two different standards, the General MIDI guidelines and the Microsoft 
authoring guidelines for MIDI files (for playing MIDI information generated by 
an application or stored in a MIDI file). 
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The information in this section is intended only as a general guide. For more 
specific help, see the documentation for the sound device you install. 

Assigning Sounds to Events 
With the Sound option, you can assign sounds to different application and system 
events. For example, you can select a sound to play whenever you start Windows 
NT. Other sounds playas specified by the application you are using. For example, 
some applications play the sound assigned to Default Beep whenever you click 
the mouse outside of an open dialog box. The sounds you can assign to these 
events are stored in files with the .WA V filename extension. 

To use sound in Windows NT, the sound driver that controls your sound board 
must be installed and configured for your system. If you do not have a sound 
board or if the sound driver is not configured properly, you hear a warning beep 
when an error occurs. Windows NT does not support playing a waveform sound 
through the PC speaker; therefore, if you do not have sound hardware, the Test 
button is unavailable. 

t> To assign sounds to events 

E~ 1. In the Control Panel window, choose the Sound icon. 

['Z] Enable System Sounds c:\windows 

2. From the Events box in the Sound dialog box, select the event that you want 
to assign a sound to. 

If a sound file is already assigned to that event, it is selected in the Files box. 
Otherwise, "none" is selected. 

3. In the Files box, select the sound file you want to use. If the file you want is 
not listed, select the drive and directory where the file is located by scrolling 
in the Files box, and then select the file. 

If you don't want to assign a sound to the selected event, select "none." 

4. To hear the sound, choose the Test button or choose the event or filename. 

5. Repeat steps 2 through 4 until you have assigned a sound to each event you 
want. 
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6. Select the Enable System Sounds check box. 

7. Choose the OK button. 

You can turn the warning beep and all other sounds off by clearing the Enable 
System Sounds check box and assigning "none" to Windows Logon and Windows 
Logoff. 

Changing MIDI Settings 
If you are using a sound device such as a synthesizer that has MIDI capabilities, 
you can specify MIDI settings for the setups, patch maps, and key maps. 

[~hli;.~.~ii~; 0 ~atch Maps 0 };,ey Maps 

Nilme: IL-A_d_Li_b _______ .......... ~=== 
Description: Base-level setup 

New ... 

For additional help on the MIDI Mapper, see the documentation for the sound 
device you are installing, or see the online Help in the MIDI Mapper dialog box. 

Caution To use MIDI Mapper, you should have a basic understanding of MIDI 
concepts and terminology. It is recommended that you not use MIDI Mapper to 
edit or create MIDI setups unless you are experienced with MIDI and understand 
the results of the changes you make. 
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Managing Devices 
Use the Devices option in Control Panel to start, stop, and configure the startup 
type for device drivers. 

Starting and Stopping Devices 
Use the Devices dialog box to start and stop devices. 

l> To start or stop a device 

~ 1. In the Control Panel window, choose the Devices icon. 

Started 
Started 

System 
System 
Disabled 

In the Devices dialog box, if Started is displayed in the Status column for a 
device, that device driver is loaded. If the Status column is blank, that device 
driver is not loaded. 

The Startup column displays the startup type of each device. The startup types 
are described in the following procedure under "Configuring Device Startup." 

2. Select a device. 

3. Choose the Start or Stop button. 

Some devices are essential to system operation and cannot be stopped. When 
such a device is selected, the Stop button is unavailable. 

4. Choose the Close button. 
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Configuring Device Startup 
You can determine when a device will start by specifying the startup type. 

To configure device startup you must be logged on to a user account that is 
a member of the Administrators local group. 

I> To set the startup type of a device 

~ 1. In the Control Panel window, choose the Devices icon. 

2. In the Devices dialog box, select a device. 

3. Choose the Startup button. 

-",:" , ~>t! 

r- Startup Type -----------, I OK t~ O.!l.oot 

o fulstem 

o Automatic 

@ !M~~:~~:!) 
o Q.isabled 

4. Select a startup type. 

Select 

Boot 

System 

Automatic 

Manual 

Disabled 

I: Cancel I 
I Help I 

To 

Start the device every time the computer starts. Boot 
devices start before any other devices. Use for critical 
devices essential to system operation. 

Start the device every time the system starts. System 
devices start after Boot devices. Use for critical devices 
essential to system operation. 

Start the device every time the system starts. Automatic 
devices start after Boot and System devices. Use for devices 
that are not critical for basic system operation. 

Allow the device to be started by a user or by a dependent 
device. 

Prevent the device from being started by a user. However, 
the device can be started by the system. 

Caution Changing the startup type of a Boot or System device can leave the 
system in an unusable state. 

5. Choose the OK button. 

6. In the Devices dialog box, choose the Close button. 
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Defining Options for the Operating System 
You can have more than one operating system installed on your computer if you 
want to use different operating systems at different times. Choose the System 
option in Control Panel to specify the operating system that the boot loader 
will use the next time you start your computer . You can also specify the user 
environment variables and view or change the size of your computer's virtual­
memory paging file by using the System option. 

~ To specify the default operating system for startup 

~. 1. In the Control Panel window, double-click the System icon. 

~ The System dialog box shows the settings for the user whose profile is 
currently active on this computer. 

Operating System -------------, 

~tartup: I ''Windows NT" 

Show list for ~ seconds 

System Environment Variables: 

ComSpec = D:\winnt\s}'stem32\cmd.exe 
o s2LibP ath = D: \winnt\s}'stem32\os2\dll; 
Path = D:\winnt\s},stem32 
windir = D:\winnt 

!!ser Environment Variables for chrisdr 

. temp = D:\temp 

~ariable: I tmp 

~================~ V!!.lue: LIO_:\_te_m...:..p ___________ ---I 

2~ In the Startup box, select the default operating system from the list of systems 
installed on your computer. 

This is the operating system that the boot loader will propose to start 
automatically the next time you start your computer. 
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3. In the Show List For box, specify the number of seconds the list of choices 
should be displayed before automatically starting the default operating system. 

4. Choose the OK button. 

Changing the Environment Variables 
Windows NT requires certain information to find programs, to allocate memory 
space for some programs to run, and to control the behavior of various programs. 
This information -called the system and user environment variables- can be 
viewed in the System dialog box. These environment variables are similar to 
those that can be set in the MS-DOS operating system, such as PATH and TEMP. 

The system environment variables are defined by Windows NT, and you cannot 
add new variables or change the values. 

The user environment variables include any environment variables you want to 
define or variables defined by your applications, such as the path where 
application files are located. 

Mter you change any user environment variables in the System dialog box and 
choose the OK button, Windows NT saves the new values in the registry so they 
are available automatically the next time you start your computer. 

If any conflict exists between environment variables, Windows NT resolves the 
conflict in this way: 

• System environment variables are set first. 

• User environment variables defined in the System dialog box are set next and 
override system variables. 

• Variables defined in AUTOEXEC.BAT are set last and do not override system 
or environmental variables. 

This means, for example, that although you cannot change the values of a system 
environment variable directly, you can overwrite it by creating a user environment 
variable with a name that is identical to the name of the system environment 
variable you want to overwrite. 

Note Path settings, unlike other environmental variables, are cumulative. The full 
path (what you see when you type path at the command prompt) is created by 
appending the path contained in AUTOEXEC.BAT to the paths defined in the 
System option of Control Panel. 
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To change user environment variables for your computer 

1. In the Control Panel window, choose the System icon. 

The System dialog box shows the current system environment variables.and 
the environment variables for the user whose profile is currently active on this 
computer. 

2. In the User Environment Variables box, select the variable you want to 
change. 

The name of the selected variable appears in the Variable box, and its current 
value appears in the Value box. 

You can also click the Variable box, and then type a variable name that does 
not appear in the list. Variables that you add in this way are appended to the 
list of environment variables for the current user profile. 

3. In the Value box, type a new value for the variable. 

4. To remove a variable completely, select it in the User Environment Variables 
box, and then choose the Delete button. 

5. When the Variable and Value boxes contain the new information you want 
to specify, choose the Set button. 

Choose the Cancel button at any time to remove all changes made in the 
System dialog box and restore the previous values. 

6. When you have completed all changes you want to make to environment 
variables, choose the OK button. 

Changes to these variables are stored immediately, but the changes won't 
affect programs that are already running when the changes are made. You 
must restart your computer to see the effects of the changes while running, 
for example, the command prompt. 

Changing the Virtual-Memory Paging File 
Windows NT uses a special file on your hard disk called a virtual-memory 
paging file (or swap 'file). With virtual memory under Windows NT, some of the 
program code and other information are kept in RAM while other information is 
temporarily swapped to virtual memory. When that information is required again, 
Windows NT pulls it back into RAM and, if necessary, swaps.other information 
to virtual memory. This activity is invisible, although you might notice that your 
hard disk is working. The resulting benefit is that you can run more programs at 
one time than your system's RAM would usually allow. ' 
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If you are logged on as a member of the Administrators group for a computer, 
you can change the size of the virtual-memory paging file or create additional 
paging files on other local hard drives. 

A virtual-memory paging file is created automatically on your computer 
when you install Windows NT. Usually, you should leave the paging file at its 
recommended size for each drive. However, you might want to change the file 
size if, for example, you frequently work with applications that require a large 
amount of memory and that could therefore benefit from a larger paging file. 

Note The virtual-memory paging file is a file named P AGEFILE.SYS in your 
system partition. You cannot delete this file while running Windows NT. If you 
delete this file while running under another operating system, a new paging file is 
created automatically the next time you start Windows NT. 

The recommended size for the virtual-memory paging file, which Windows NT 
identifies as the size that ensures the best performance, is equivalent to the 
amount of RAM available on your system plus 12 MB. However, the size of the 
file also depends on the amount of free space available on your hard disk when 
the paging file is created. 

If you have multiple hard disks, you should consider creating a paging file for 
each local hard drive on your computer. Depending on the capabilities of your 
system's hard disk controller, the disks can be reading or writing information 
simultaneously, greatly improving performance. Also, because Windows NT 
expands the paging file as necessary, multiple paging files make expansion easier, 
since each file expands a little rather than a single file expanding a lot. 

t> To change the size of your system's virtual-memory paging file 

1. In the System dialog box, choose the Virtual Memory button. 

If you are not logged on as a member of the Administrators group for a 
computer, the Virtual Memory button is not available, so you cannot change 
the size of your computer's paging file. 

2. In the Drive box of the Virtual Memory dialog box, select the drive for which 
you want to change the paging file size. 
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Qrive [Volume label] 

I D [ANAMV Ol2] 

Paging File Size for Selected Drive------, 
Drive: C:[ANAMVOll] 

Space Available: 25 MB 

!nitial Size (MB): ~ 
MalCimum Size (MB): ~ 

Total Paging File Size for All Drives------, 
Minimum Allowed: 2 MB 

Recommended: 27 MB 

Currently Allocated: 20 M B 

3. In each Paging File Size box, type a number in megabytes to specify the 
new initial size or maximum size for the paging file, and then choose the 
Set button. 

For example, type 20 to create a 20 MB paging file .. 

4. Choose the OK button to return to the System dialog box. 

You must restart your computer to see the effects of the changes. 

Changing Application Response Time 
By default, Windows NT gives priority to the application running in the 
foreground of your display screen. This application receives more processor 
time relative to other applications running in the background. (A foreground 
application is the application running in the active window, topmost on your 
screen.) 

t> To change the priority (response time) of a foreground application relative 
to other running applications 

1. Double-click the System icon in Control Panel. 

2. In the System dialog box, choose the Tasking button. 
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3. In the Tasking dialog box, select one of the following options: 

• Best Foreground Application Response Time (Default) 

• Foreground Application More Responsive Than Background 

• Foreground And Background Applications Equally Responsive 

The first two options vary the degree of priority given to the foreground 
application; the last button gives all applications an equal share of processing 
time. 

Setting Up the Uninterruptible Power Supply 
An uninterruptible power supply (UPS) is a battery-operated power supply 
connected to a computer to keep the system running during a power failure. The 
UPS service for Windows NT detects and warns users of power failures, and 
manages a safe system shutdown when the backup power supply is about to fail. 

Before purchasing a UPS device to use with Windows NT, confirm with the UPS 
manufacturer that both the device and its serial cable are compatible with 
Windows NT. 

You can use the UPS option in Control Panel to set various options for 
configuring how UPS works on a computer, such as: 

• The serial port where the UPS device is connected. 

• Whether the UPS device sends a signal if the regular power supply fails. 

• Whether the UPS device sends a warning when battery power is low. 

• Whether the UPS service sends a signal telling the UPS device to shut off. 

• A command file to execute at shutdown time. 

• The expected life and recharge time for the battery. 

• The timing for warning messages. 

The actual options for configuring the UPS service depend on the specific UPS 
hardware installed on your system. Incorrect settings can cause undesirable 
operation of your UPS hardware. For details about possible settings, see the 
documentation for your UPS device. 
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J, -
'Ji: +, 

To set up the UPS service for a computer 

1. In Control Panel, double-click the UPS icon. 

UPS Configuration 

[g] eower failure signal 

o .low battery signal at least 
2 minutes before shutdown 

o Remote UPS Shutdown 

UPS Interface Voltages: 

@ Negative 0 Positive 

@ 

@ 

o 

10 Execute Command File 

L File Name: =1 ============================= 
UPS Characteristics ---------, 

£.xpected Battery life: ~ min 

UPS Service ----------, 

!tattery recharge time ~ 
per minute of run time: ~ min 

!.im,,: ~~tween ~ower failure ~ sec 
and mllial warnmg message: ~ 

messages: 
.!lelay between warning ~sec 

2. In the UPS dialog box, select or clear the Uninterruptible Power Supply Is 
Installed On check box, and then specify the serial port where the UPS device 
is connected. 

You cannot specify a serial port unless the Uninterruptible Power Supply Is 
Installed On check box is selected. 

3. If the UPS device on your system can assert a main power failure indication, 
select the Power Failure Signal check box. 

This setting corresponds to the CTS pin for the UPS serial port connection. 

4. If the UPS device on your system can send a warning when battery power is 
low, select the Low Battery Signal check box. 

This setting corresponds to the DCD pin for the UPS serial port connection. 
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5. If the UPS device can accept a signal from the UPS service telling it to shut 
off, select the Remote UPS Shutdown check box. 

This shuts off the UPS device battery when it is no longer needed. This setting 
corresponds to the DTR pin for the UPS serial port connection. 

6. For each item that is checked in the UPS Configuration group, specify 
Negative or Positive for the UPS Interface Voltages. 

This setting defines how your UPS device expects to communicate with the 
UPS service. For information about making this choice, see the documentation 
for your UPS device. 

Depending on which items you've checked in the UPS Configuration group, 
steps 7 through 10 mayor may not be necessary. 

7. In the Expected Battery Life box, specify the time in minutes that the system 
can run on battery power. Check the UPS device documentation for the 
appropriate setting. 

The range is 2 to 720 minutes; the default is 2 minutes. 

8. In the Battery Recharge Time box, specify the time in minutes that the battery 
must be recharged for every minute of run time. Check the UPS device 
documentation for the appropriate setting. 

The range is 1 to 250 minutes; the default is 100 minutes for each minute of 
battery run-time. 

9. In the Time Between Power Failure box, specify the time, in seconds, between 
when a power failure occurs and when the first message is sent to notify users. 

The range is 0 to 120 seconds; the default is 5 seconds. 

10. In the Delay Between Warning Messages box, specify the interval, in seconds, 
between messages sent to notify users of a power failure and to advise them to 
stop using the computer. 

The range is 5 to 300 seconds; the default is 120 seconds. 

11. Choose the OK button. 

Depending on the changes you make in the UPS dialog box, a message asks if you 
want to start, stop, or restart the UPS service, depending on whether it is currently 
running. Choose Yes or No. If you choose Yes, Windows NT configures the UPS 
service to begin automatically each time your system starts up. 
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You can also start and stop the UPS service using the Services option in Control 
Panel once the UPS is configured. 

You can also configure the UPS option to execute a command file immediately 
prior to system shutdown. For example, such a file might run a command to close 
remote connections. This command file must execute within 30 seconds. Failure 
to complete execution in 30 seconds jeopardizes the safe shutdown of your 
Windows NT computer. 

~ To set up the UPS service to execute a file prior to system shutdown 

1. In the \WINNT\SYSTEM32 directory, create a command file with one of 
the following file extensions: .BAT, .CMD, .EXE, or .COM. 

2. Select the Execute Command File box. 

3. In the UPS dialog box, type the name of the command file in the File 
Name box. 

Using UPS with Other System Services 
The UPS service should be used in conjunction with the Windows NT Alerter, 
Messenger, and Event Log services. This will ensure that events related to the 
UPS service, such as a power failure or a UPS connection failure, are recorded 
in the system log of Event Viewer and that designated users are notified of these 
events over the network. 

The Alerter and Messenger services must be started for a computer to generate 
a UPS or other type of network alert. Mter setting up the UPS service on your 
computer, use the Services tool in Control Panel to make sure the Alerter, 
Messenger, and Event Log services are configured to start automatically. Use 
the Server option in Control Panel to designate which users and computers will 
receive alerts. The Messenger service must be started on computers that are to 
receive UPS alerts and UPS warning messages. 
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Testing Your UPS Configuration 
After configuring UPS options, you or your system administrator should test that 
your computer is protected from power failure. 

t> To test UPS configuration 

1. Simulate a power failure by disconnecting the power to the UPS device. 

The computer and peripherals connected to the UPS device should remain 
operational and a warning message and/or alert should appear on the computer 
screen. 

2. Wait until the UPS battery reaches a low level. 

At that point system shutdown should occur. 

3. Restore power to the UPS device. 

4. Check the system log in Event Viewer to ensure that all actions were logged 
and that there were no errors. 

If the UPS service is configured to run a command file, you should test that file 
execution does not exceed the 30 second time limit. 

t> To test command file configuration 

• Determine a worst case scenario. For example, if your command file starts 
up a custom application to disconnect logon sessions to a remote computer, 
test command file execution with a maximum number of logon sessions. 

If you have problems running the UPS service, see the system log in Event 
Viewer for event details related to UPS. 
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Configuring the Network 
You can use the Network option in Control Panel to make changes in your 
computer's network configuration. For example, if you add a new adapter card 
to your computer after installing Windows NT, you need to specify the network 
device drivers and supporting software that Windows NT needs to work with 
network adapter cards. You can also use the Network option to join a workgroup 
or domain, configure network bindings, and set network provider search order. 

To make changes in the Network Settings dialog box, you must be logged on 
as a member of the Administrators group for your computer. 

~ To use the Network option 

" • Choose the Network icon in Control Panel. 

Computer Name: SCOTTIE 

Workgroup: TERRIER 

Network Software and Adapter Cards 

Installed Net!tork Software: 

N etB E U I Protocol 
Workstation 
Server 
3Com Etherlink" Adapter Driver 
Computer Browser 

Installed ,adapter Cards: 

Descrip!ion: 13Com Etherlink II Adapter 

I: Add S ott~~ie ... 

llPdate I 
Rerllove J 

I !!.indingsu.q 

I 
I ....• 
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The following table summarizes the buttons in the Network Settings dialog box. 

Choose 

Change 
(Computer name) 

Change (Domain or 
Workgroup) 

Add Software 

Add Adapter 

Configure 

Update 

Remove 

Bindings 

Networks 

To 

Change the computer name for this computer. 

Display a dialog box for joining a workgroup or domain. 

Display one or more dialog boxes for installing a network 
software component. 

Display one or more dialog boxes for installing a network 
adapter card. 

Display one or more dialog boxes for configuring the selected 
network software component or adapter card. 

Display one or more dialog boxes for updating a network 
software component or adapter card. 

Remove a selected network software component or adapter 
card. 

Display a dialog box for adding and removing bindings for 
network components. 

Display a dialog box for setting network search order if your 
computer is connected to more than one kind of network 
provider. (This button is available only if other network 
providers are present.) 

Changing the Computer Name 
You can change the computer name for the current computer in the Network 
Settings dialog box~ A computer name cannot be the same as any other computer, 
workgroup, or domain name on the network. 

r> To change the computer name 

1. In the Network Settings dialog box, choose the Change button next to the 
computer name. 

komputer Name: I'-S_CO_T_T_IE ___ ----' 
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2. In the Computer Name dialog box, type a unique name for this computer, 
and then choose the OK button. 

Caution If you change the computer name for a computer that participates in a 
Windows NT Advanced Server domain, the new computer name must have an 
account in the domain. If the computer does not have an account, you will not be 
able to log on to the domain or access any domain user accounts (including your 
own account). Check with your network administrator to ensure that you specify 
a correct computer name and that the computer has an account in the domain. 

Installing Network Adapter Cards 
To communicate over the network, a computer must have a network adapter 
card installed. Windows NT uses a network device driver, which is software 
that coordinates communication between the adapter card and the computer's 
hardware and other software, controlling the physical function of the network 
adapter cards. 

During the initial installation of Windows NT, you have the opportunity to install 
at least one network card. To add to or change your computer's network adapter 
cards after installation, you must choose the Network icon in Control Panel. 

l> To install one or more network adapter cards 

1. In the Network Settings dialog box, choose the Add Adapter button. 

2. In the Add Network Adapter dialog box, select the name of the adapter card 
that is installed in your computer, and then choose the Continue button. 

If you have a disk with software from a vendor, select Other. 

3. When Setup asks for a disk, insert the disk in the drive, or type the path 
of the driver if the file is located on your hard disk or on a network drive. 
Then choose the OK button. 

You may be asked to insert additional disks if more than one disk was 
provided by the hardware manufacturer. You may also be asked for specific 
Windows NT installation disks. 

4. When you complete all your changes and close the Network Settings dialog 
box, a message asks if you want to restart your computer for the changes to 
take effect. To restart your computer immediately, choose the Yes button. 
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Installing Network Software 
Windows NT also uses network software (or protocol) drivers that bind to 
the adapter card driver. You can also add supporting software for network 
components in the Network Settings dialog box. 

~ To install network software 

1. In the Network Settings dialog box, choose the Add Software button. 

153 

2. In the Add Network Software dialog box, select the software component you 
want to install, and then choose the Continue button. 

If you have a disk with software from a vendor, select Other. 

3. When Setup asks for a disk, insert the disk in the drive. Or type the path of the 
software component if the file is located on your hard disk or on a network 
drive. Then choose the OK button. 

You may be asked for additional disks if more than one disk was provided by 
the hardware manufacturer. You might also be asked for specific Windows NT 
installation disks. 

4. When you complete all your changes and close the Network Settings dialog 
box, a message asks if you want to restart your computer for the changes to 
take effect. To restart your computer immediately, choose the Yes button. 
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Updating or Removing Network Components 
You can either update or remove the configuration information for an installed 
network software component or adapter card. 

t> To update a network component 

1. In the Network Settings dialog box, select the component you want to update 
in the Installed Network Software box or the Installed Adapter Cards box. 

2. Choose the Update button. 

3. Complete the dialog boxes that appear. 

You will be asked to insert disks from the manufacturer that contain the 
updated driver information for the selected component. 

When you remove a network component, the information is removed from your 
system configuration. The related software remains on your hard disk. Mter 
removing a network component, you must restart your system before you can 
reinstall that component. 

t> To remove a network component 

1. In the Network Settings dialog box, select the component you want to remove 
in the Installed Network Software box or the Installed Adapter Cards box. 

2. Choose the Remove button. 

3. Complete the dialog boxes that appear. 

The dialog box for removing the component is supplied by the manufacturer. 
Choose the Help button in the dialog box for more information. 

For your changes to take effect, you must restart your computer. 
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Configuring Network Software and Adapter Cards 
Many adapter cards and their supporting software can be configured to achieve 
the best performance on your system. You can set the appropriate configuration 
for your network components in the Network Settings dialog box. 

The dialog boxes for configuring your adapter and software are supplied by the 
manufacturer. Most of these dialog boxes contain a Help button to guide you 
through making choices for optimal settings. For additional information, refer 
. to the documentation for your network adapter card or software. 

t> To configure network software or an adapter card 

1. In the Network Settings dialog box, select the name of the item you want to 
configure in either the Installed Network Software box or the Installed Adapter 
Cards box. 

Optionally, in the Description box, type text to describe the component, 
or keep the description provided by the manufacturer. If you have multiple 
adapter cards, consider including the slot number of the card in its description. 

2. Choose the Configure button. 

Windows NT displays a dialog box specifically for the selected component, 
as provided by the component manufacturer. 

For information about any items in the dialog box, choose the Help button. 

3. Complete options in the dialog box to specify your choices, and then choose 
the OK button. 

For example, the following illustration shows a typical configuration dialog box 
for a 3Com® EtherLink II® network adapter card. 

These settings specify the interrupt number 
and 110 address jumper settings for the card. 

110 fort Address: 1'--0_113_00 __ ...... 1:9:_1 

Transceiver Type 

@ ~lIternal OOnBoard 

o Memory Mapped 

This setting specifies whether the 
base address for the card IS 110 port 
is mapped in the computer's memory. 

!'O'K:i .. wi 
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Choosing and Configuring Protocol Software 
To communicate over a network, each computer must be configured with at least 
one type of protocol software. Protocol software works between the upper-level 
network software and the network adapter card. The protocol packages data that 
is to be sent on the network in a way that the computer on the receiving end can 
understand. Microsoft provides four protocols for use with Windows NT: 
NetBEUI (NetBIOS extended user interface), TCP/IP (transmission control 
protocol/internet protocol), NWLink (NetWare Link), and Data link control. 

Protocol software 

NetBEUI3.0 

TCPjIP 

NWLink 

Data link control 

Description 

A small, efficient, and fast protocol tuned for small LANs. 
It is installed automatically when you install Windows NT. 

Provides communication across wide area networks (WANs) 
and routers. 

Provides a protocol compatible with the Novell NetWare 
IPX/SPX protocol, so that Windows NT computers can 
interoperate with Novell NetWare servers. 

Not designed to be a primary protocol for use between pes. 
It is useful if your computer needs to access IBM mainframe 
computers or if you are setting up a printer that attaches directly 
to the network, instead of to a serial or parallel port on a print 
server. 

NetBEUI is the standard Windows networking protocol and is automatically 
installed during Windows NT setup. If there are no wide area network (WAN) 
links in the network, and if there is no need to connect to any devices other than 
computers running Windows NT or other Windows operating systems, you do 
not need to add any protocol software. If you need WAN internet capability, 
add TCP/IP. With both protocols supported, you can benefit from NetBEUI 
performance when connecting to local computers and you can still connect 
over WAN s to other networks. 

To install other protocols included with Windows NT, choose the Add Software 
button in the Network Settings dialog box. All adapter card drivers that come with 
Windows NT can use any of the included protocols. 

For additional information on installing and configuring network protocols, 
see Appendix A, "Network Protocols." 
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Setting LAN Adapter Numbers 
When you install Windows NT on a computer (and when you install additional 
protocols or network adapter cards), Windows NT automatically assigns LAN 
adapter (Lana) numbers to protocol/network adapter card bindings. You need 
to change a LAN adapter number only if you have a NetBIOS application that 
specifies that it must use a certain LAN adapter number. 

I> To set LAN adapter numbers for special applications 

1. In the Network Settings dialog box, select NetBIOS Interface in the Installed 
Network Software box. 

2. Choose the Configure button. 

3. In the Network Route box, select the protocol whose LAN adapter number 
you need to change and then type in a new number in the Lana Number box. 

4. Complete options in the dialog box to specify your choices, and then choose 
the OK button. 

Joining a Workgroup or Domain 
You can assign the workgroup for the current computer, such as the workgroup 
created if you were previously using Windows for Workgroups. If the computer 
will participate in a Windows NT Advanced Server domain, you can use the 
Network Settings dialog box to join the domain. 

In Windows NT, a workgroup is a collection of computers that appear, for 
convenience, under the same workgroup name when you browse network 
resources. Any computer can join any workgroup. 

A domain is a collection of computers, defined by the administrator of a 
Windows NT Advanced Server network, that share an account database and 
security policy. A domain provides the same convenience for network browsing 
and also provides access to the centralized user accounts and group accounts 
maintained by the domain administrator. In most cases, you will want a 
Windows NT workstation to join a domain-this is the only way for a user who 
has an account on a Windows NT Advanced Server domain to be able to log on to 
that account at a Windows NT workstation. 

There are two ways for a computer to join a domain. One method is for 
the domain administrator to log on to the computer and then, in the Network 
Settings dialog box, create a domain account for the computer and add it to the 
domain. Alternatively, a domain administrator can use Server Manager to create 
a domain account for the computer, after which you can join the domain at the 
current computer using the Domain/Workgroup Settings dialog box. 



158 System Guide 

Computer Name: BEAGLE 

Member of: --------------, 

o ~orkgroup: 
@ !!.omain: IDOMAIN 

!SJ :t:~:~~:~:~::¢.~:~p.:~~~i:A:~~:Q~:~G:ri::!?:Q~:~l:~] ----------, 
DQmain Administrator User Name: 

Domain Administrator Password: 

This option will create a computer account on the domain for this 
computer. It is for use by domain administrators only_ 

I> To join a workgroup 

1. In the Network Settings dialog box,. choose the Change button next to the 
current workgroup or domain name. 

The Change button is unavailable if you previously changed the computer 
name in the current session. 

2. In the Domain/Workgroup Settings dialog box, select the Workgroup option, 
and then type the name of the workgroup you want to the computer to join. 

The workgroup name must not be the same as the computer name. 

3. Choose the OK button. 

I> To join a domain 

1. Verify that the domain administrator has already created a domain account 
for your computer. 

2. In the Network Settings dialog box, choose the Change button next to the 
current domain or workgroup name. 

The Change button is unavailable if you previously changed the computer 
name in the current session. 

3. In the Domain/Workgroup Settings dialog box, select the Domain option, and 
then type the name of the domain you want the computer to join. 

4. Choose the OK button. 
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If you are logged on as a domain administrator, you can automatically add an 
account for the current computer when the computer joins the domain. 

To add a computer to a domain 

1. In the Domain/Workgroup Settings dialog box, select the Domain option, 
and then type the name of the domain you want the computer to join. 

The computer name, as shown at the top of this dialog box, must be a unique 
name in the domain. 

2. Select the Create Computer Account In Domain check box. 

3. In the appropriate boxes, type the username and password for your domain 
administrator user account. 

If you are a member of a trusted domain, type the name of that domain, 
followed by your account name. For example, type Shipping\Chrisdr, 
where shipping is a trusted domain of the domain in which you are creating 
a computer account, and Chrisdr is an account in shipping with authority 
to administer the local domain. 

4. Choose the OK button. 

JOining a Domain from a Remote Access Workstation 
~ To join a domain from a remote workstation, you must be logged on as a member 

of the Administrators group for your computer or as a member of the Domain 
Administrators group. 

I> To join a domain from a remote workstation 

1. Start the Remote Access Service from your computer. 

2. Connect to the network. 

3. Start Control Panel and double-click the Network icon. 

4. In the Network Settings dialog box, choose the Change button next to your 
workgroup name. 

S. In the Domain box, type the name of the domain you want to join. Unless you 
are a domain administrator, your computer must already have an account in the 
domain you intend to join. 

6. Choose the OK button. 
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Configuring Network Bindings 
The network consists of a series of software layers, where software in each 
layer performs specific functions for the layers above and below it. All network 
software layers end at the network adapter card, which moves information 
between computers. Each network component can be bound to one or more 
network components above it or below it to make the component's services 
available to any other component that can benefit from them. 

By default, Windows NT maximally binds all network components to ensure 
that they are fully utilized. If you rarely use a particular adapter card and want 
to reduce the software loaded into memory, you can simply unbind (disconnect) 
that network adapter card from all network components. 

When you choose the Bindings button in the Network Settings dialog box to 
add or remove bindings, the Network Bindings dialog box shows the bindings 
of network components as a series of bound paths, from the upper layer services 
and protocols to the lowest layer of adapter-card device drivers. 

~how Bindings for: 

(-- Upper Bindings 

This list shows the binding paths 
that pass through the selected 
component, or shows all binding 
paths if All Components is selected. 

lower Bindings --> 

Workstation .) NetBEUI Protocol·) 3Com Etherlink II Adapter Driver. .. 
Server·) NetBEUI Protocol·> 3Com Etherlink II Adapter Driver ... 

OK 'Cancel 

These icons indicate whether 
the binding is currently enabled. 

Disable 

Caution Do not attempt to reconfigure binding settings unless you are an 
experienced network administrator familiar with the requirements of your 
network software. 
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If you have more than one kind of protocol installed, you can set the order in 
which workstation and NetBIOS software bind to each protocol. You might want 
to change the binding order for one of the following reasons: 

• If the protocol you use most frequently is first in the Binding list, average 
connection time decreases. 

• Some protocols are faster than others for certain network topologies. Putting 
the faster protocol first in the Bindings list improves performance. 

For example, if you use both the NetBEUI and TCP/IP protocols, but only 
connect to TCP/IP periodically, put NetBEUI first in the protocol binding list. 

t> To view bindings for network components 

1. In the Network Settings dialog box, choose the Bindings button. 

2. In the Show Bindings For box of the Network Bindings dialog box, select 
one or more components. Or choose All Components to see a list of all bound 
components. 

t> To enable or disable binding paths for selected network components 

1. In the Network Bindings dialog box, select a binding path. 

2. To enable the binding path, choose the Enable button. 

To disable the binding path, choose the Disable button. 

The icon next to the selected binding shows the current state of that binding 
path. 

3. Choose the OK button. 

I> To change protocol binding order 

1. In the Network Settings dialog box, choose the Bindings button. 

2. In the Show Bindings For box of the Network Bindings dialog box, select a 
top level component such as Workstation. 

3. Select the binding path to move up or down and use the protocol order buttons 
to change the binding order. 

4. Choose the OK button. 
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Configuring the Remote Procedure Call Service 
Windows NT Setup automatically installs the files you need for the Remote 
Procedure Call (RPC) service, a mechanism that enables programmers to easily 
develop distributed applications. However, to use this functionality, you need 
to specify the Name Service Interface (NSI) that the RPC service uses to 
communicate with name service databases. Use the RPC Name Service Provider 
Configuration dialog box to specify settings for the name service provider. To see 
this dialog box, choose the Network icon in Control Panel, select RPC Name 
Service Provider in the Network Software list, and then choose Configure. 

To configure the name service provider, you must know which provider you want. 
If you choose the DCE Cell Directory Service, you must also supply the network 
address of the provider. The Windows NT Locator is the default name service that 
is installed with Windows NT. 

Setting Network Provider Search Order 
If you have more than one kind of network installed at your site, you can specify 
the order in which Windows NT searches the various networks for certain 
operations. 

After you specify the network search order, Windows NT will always search in 
that order. After Windows NT finds the specified server, directory, file, or other 
item on one network, it does not continue to search the networks listed lower in 
the search order. 

r> To set network provider search order 

1. In the Network Settings dialog box, choose the Networks button. (This button 
is dimmed if no other network providers are available.) 

2. In the Access Networks In This Order box, select the name of the network 
whose order you want to change, and then choose the Up or Down button to 
move that network higher or lower in the search order. 

3. Continue selecting network names to define the order until all networks are 
listed in the order you want for searching, and then choose the OK button. 
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Managing Server Properties 
Use the Server option in Control Panel to display a summary of connections and 
resource use for the computer; to edit the computer description; to view connected 
users, shared resources, and open resources; and to manage directory replication 
and the recipients of administrative alerts. 

t> To manage properties 

& 1. In the Control Panel window, choose the Server icon. 

Usage Summarv 

Sessions: 

File locks: 

Q.escription: 

5 

o 
Open Files: 

Open Named Pipes: 

11 

I Dick tot oselev. room 7122. ext 345 

The Server dialog box displays a usage summary for the computer. 

Item 

Sessions 

Open Files. 

File Locks 

Open Named Pipes 

Meaning 

The number of users remotely connected to the computer 

The number of shared resources opened on the computer 

The number of file locks on open resources of the computer 

The number of named pipes opened on the computer 

2. To change the computer description, type new text in the Description box. 

3. To administer a property associated with one of the five buttons at the bottom 
of the Server dialog box, choose a button and complete the dialog box that 
appears. These buttons and their associated dialog boxes are described in 
procedures following this one. 
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Choose 

Users 

Shares 

In Use 

Replication 

Alerts 

To 

View a list of all the users connected over the network to 
the computer and the resources opened by a selected user. 
One or all of the connected users can be disconnected. 

View a list of the computer's shared resources and the 
users connected over the network to a selected resource. 
One or all of the connected users can be disconnected. 

View a list of the open shared resources on the computer. 
One resource or all resources can be closed. 

Manage directory replication for the computer. 

View and manage the list of users and computers that are 
notified when administrative alerts occur on the computer. 

4. To exit, choose the OK button. 

Viewing User Sessions 
Use the User Sessions dialog box to view all the users connected over the network 
to the computer, and the resources opened by a selected user. 

One or all of the connected users can be disconnected. There are several reasons 
to do this. For example, you might be about to stop the Server service on the 
computer, or you might be aboutto shut down the computer. To avoid data loss, 
always warn users before disconnecting them. 

~ To view users connected over the network to the computer 

1. In the Control Panel window, choose the Server icon. 

2. In the Server dialog box, choose the Users button. 

Opens Time Idle Guest 

DONALEEE DONALEEE 0 00:31 00:12 No 
ERNESTA ERNESTA1 2 00:59 00:58 No 
JEFFHO JEFFHO 1 00:28 00:28 No 

Connected Users: 7 

Resource Opens Time 

[i;;J BUDGET 2 01:09 ~ 
[i;;J EXPORT 0 00:29 i"-' 
[i;;J MONITOR 0 01:10 

~ 
[i;;J SCHEDULE 1 01:09 • 

I :cloiE; "I Disriorlnect O"li:'c('mnecIAII 
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In the User Sessions dialog box, the Connected Users box lists the users 
remotely connected to the computer. 

Item 

Connected Users 

Computer 

Opens 

Time 

Idle 

Guest 

Meaning 

The user name of a connected user. In some cases the user's 
computer name may be displayed instead of the user name. 

The computer name of the computer where the user is 
logged on. 

The number of resources opened on the computer by 
the user. 

The hours and minutes that have elapsed since this session 
was established. 

The hours and minutes that have elapsed since the user 
last initiated an action. 

Whether this user has guest status on the computer. 

Below the Connected Users box, the Connected Users summary shows the 
number of users remotely connected to the computer. 

3. To view the resources used by a user, select a user name from the Connected 
Users box. 

The Resource box lists the shared resources that user is connected to. 

Item 

Icon 

Resource 

Opens 

Time 

Meaning 

Graphically indicates the type of each listed resource: 

6:J A shared directory 

QtF A named pipe 

~ A shared printer 

A resource of an unrecognized type 

The name of a shared resource to which the selected user 
is connected 

The number of opens against this resource by this user 

The hours and minutes that have elapsed since this resource 
was first opened 

In some cases, a connection to a printer is monitored here as a connection to 
a named pipe. 

4. To disconnect one user, select the user name from the Connected Users box 
and then choose the Disconnect button. To disconnect all users, choose the 
Disconnect All button. 

Warn users before disconnecting them. 

5. To exit, choose the Close button, and then in the Server dialog box choose the 
OK button. 
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Viewing Shared Resources 
Use the Shared Resources dialog box to view the shared resources available on 
the computer and the users connected over the network to a selected resource. 

Note To share directories or manage shared directories, use File Manager. 
To share printers or manage shared printers, use Print Manager. 

One or all of the connected users can be disconnected. There are several reasons 
to do this. For example, you may need to allow another user to connect to a shared 
directory that already has its maximum number of users connected. To avoid data 
loss, always warn users before disconnecting them. 

I> To view shared resources 

1. In the Control Panel window, choose the Server icon. 

2. In the Server dialog box, choose the Shares button. 

konnected Users Time In Use 

•. :ii:!!;iiL; 
cristalw 00:53 No 
ERNESTA 01:02 Yes 
JEFFHO 00:31 Yes 
STEVENA 01:13 Yes 

Connected Users: 5 

In the Shared Resources dialog box, the Sharename box lists available 
resources. 



Item 

Icon 

Sharename 

Uses 

Path 
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Meaning 

Graphically indicates the type of each listed resource: 

{;;J A shared directory 

110= A named pipe 

~ A shared printer 

A resource of an unrecognized type 

The name of a shared resource 

The number of connections to the shared resource 

The path of the shared resource 

In some cases, a connection to a printer is monitored here as a connection to 
a named pipe. 

3. To view the users connected to a shared resource, select a share name from 
the Sharename box. The Connected Users box lists the connected users. 

Item 

Connected Users 

Time 

In Use 

Meaning 

The user name of a user connected to the selected shared 
resource. In some cases the user's computer name may 
appear instead of the user name. 

The hours and minutes that have elapsed since the user 
first connected to this shared resource. 

Whether the user currently has a file open from this 
shared resource. 

Below the Connected Users box, the Connected Users summary shows the 
number of users connected to the selected resource. 

4. To disconnect one user from all shared resources, select the user name 
from the Connected Users box and then choose the Disconnect button. To 
disconnect all users from all shared resources, choose the Disconnect All 
button. 

Warn users before disconnecting them. Each disconnected user is disconnected 
from all shared resources on the computer-not just the resource selected in 
the Sharename box. 

5. To exit, choose the Close button, and then in the Server dialog box choose the 
OK button. 
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Viewing Resources In Use 
Use the Open Resources dialog box to view the resources open on the computer. 
One or all of the resources can be closed. To avoid data loss, always warn 
connected users before closing resources. 

I> To view resources in use 

1. In the Control Panel window, choose the Server icon. 

2. In the Server dialog box, choose the In Use button. 

Open Resources: 11 
File locks: 0 

.Qpened bV 

ERNESTA 
JEFFHO 
STEVENA 

For locks Path 

Execute 0 
Write 0 
Write 0 
Write 0 
Write 0 

C:\MONI T 0 R\EVENTVWR.EXE 
C:\STOCK\SCHED03.DOC 
C:\STOCK\ TIMECll.RD.XLS 
C: \S T 0 CK \1 NV09.XLS 
C:\BUDGET\BUDGET.XLS 

The Open Resources dialog box shows the resources open on the computer. 

Item 

Open Resources 

File Locks 

Icon 

Opened By 

For 

Locks 

Path 

Meaning 

The total number on open resources on the computer 

The total number of file locks on open resources 

Graphically indicates the type of each listed resource: 

~ Afile 

cfI A named pipe 

~ A print job in a print spooler 

A resource of an unrecognized type 

The user name (or sometimes the computer name) for a user 
who opened a resource 

The permission granted when the resource was opened 

The number of locks on the resource 

The path of the open resource 

In some cases, a print job is monitored here as an open named pipe. 
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3. To close a single resource, select one resource from the list and then 
choose the Close Resource button. To close all resources, choose the Close 
All Resources button. 

Warn connected users before closing resources. 

4. To update the displayed information, choose the Refresh button. 

5. To exit, choose the Close button, and then in the Server dialog box choose the 
OK button. 

Managing Directory Replication 
Use the Directory Replication dialog box to manage replication for the computer. 
Directory replication is the duplication of a master set of directories from a server 
(called an export server) to specified servers or workstations (called import 
computers) in the same or other domains. A Windows NT workstation can only 
be set up as an import computer. 

Before replication can occur, a special user account must be created, configured, 
and assigned to the Replicator service. For information on preparing the 
Replicator service, and for detailed information explaining directory replication, 
see the Microsoft Windows NT Advanced Server System Guide, which is provided 
with the Microsoft Windows NT Advanced Server software required for the 
replication export server. 

The procedures that follow describe how to use the Server option in the Control 
Panel to set up the computer as an import computer. When setting up an import 
computer you do not need to create the imported subdirectories, because a 
subdirectory is automatically created the first time it is imported. 

I> To set up an import computer 

1. In the Control Panel window, choose the Server icon. 

2. In the Server dialog box, choose the Replication button. 
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o Do Not ImPort 

To ~ath: 

I C: \winnt\S ystem32\R epl\1 I 
Fr.Q.m List: 

SHIPPING 

The Directory Replication dialog box contains the following items relating 
to import replication. 

Item 

Do Not Import 

Import Directories 

To Path 

Manage 

From List 

Add 

Remove 

Description 

Prevents import of replicated subdirectories and files. 

Allows replicated subdirectories and their files to be 
imported. 

The directory in which replicated subdirectories and files 
will be stored. The default is C:\ WINNT\SYSTEM32 
\REPL\IMPORT. (If Windows NT is installed in a location 
other than C:\WINNT, the system adjusts this default 
accordingl y.) 

Displays the Imported Directories dialog box, where the 
subdirectories to be imported are specified, and where 
import locks are added or removed. 

Subdirectories are replicated to this import computer 
from the domains and computers listed here. By default, the 
From List contains a [blank] entry and this computer 
automatically imports from the local domain. 

Displays the Select Computer dialog box. Used to add a 
computer or domain to the From List. 

Removes a selected computer or domain from the 
From List. 



Chapter 5 Control Panel 171 

3. In the Directory Replication dialog box, select Import Directories. 

4. To change the directory where imported subdirectories will be stored, 
type a new path in the To Path box. 

5. To import subdirectories from a domain or computer, under Import Directories 
choose the Add button, and then complete the Select Domain dialog box that 
appears. 

The domain name or computer name is added to the From List. 

Note By default, the From List contains a [blank] entry and this computer 
automatically imports from the local domain. If any entries are added to the 
From List, the local domain is no longer imported from. If needed, it must be 
explicitly added to the From List. 

6. To stop importing subdirectories from an export server or domain, select the 
domain or server name in the From List, and then choose the Remove button. 

7. To view a list of the subdirectories that have been imported to this computer, 
or to manage locks on those imported subdirectories, under Import Directories 
choose the Manage button, and then complete the dialog box that appears. 
For more information, see the following procedure. 

8. To exit, choose the OK buttons in the Directory Replication and Server dialog 
boxes. 

t> To view a list of, or manage locks for, imported subdirectories 

1. In the Directory Replication dialog box, under Import Directories, choose 
the Manage button. 

I'· HeipSI L-____________________________________________ ~ 

Import Settings for FORIoIS 

Add lock. . I r-I R-e--m=oy--e=(=·()c"""·k-'--'I 
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The Manage Imported Directories dialog box contains the following items. 

Item 

Import Path 

Sub-Directory 

Locks 

Status 

Last Update 

Locked Since 

Import Settings For 

Add Lock 

Remove Lock 

Description 

The directory in which replicated subdii-ectories and files are 
stored on this computer. 

A list of the subdirectories that are imported to this computer. 
A subdirectory is automatically imported if it is exported by 
one of the export servers or domains in the From List of the 
Directory Replication dialog box. 

A lock prevents import to the subdirectory. More than one lock 
might be applied to a subdirectory. Import to a subdirectory 
only occurs if this column has a value of O. 

OK indicates that the subdirectory is receiving regular updates 
from an export server and the imported data is identical to the 
exported data. 

No Master indicates that the subdirectory is not receiving 
updates. The export server might not be running, or the export 
server might have stopped exporting updates. 

No Sync indicates that the·subdirectory has received 
updates, but the data is not up to date. This could be due to a 
communications failure, open files on the import computer 
or export server, the import computer not having access 
permissions at the export server, or an export server 
malfunction. 

[blank] indicates that replication has never occurred for that 
subdirectory. Replication may not be properly configured for 
this import computer, for the export server, or both. 

The date and time the last update was made to a file in this 
import subdirectory, or in its subtree. 

The date and time the oldest lock was placed on this 
subdirectory. 

Shows the selected subdirectory. 

Adds a lock to the selected subdirectory, preventing import. 

Removes a lock from the selected subdirectory. Import only 
occurs when a subdirectory has 0 locks. 



Item 

Add 

Remove 
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Description 

Displays the Add Sub-Directory dialog box, used to add new 
subdirectories to the list of imported subdirectories. 

However, this is usually unnecessary. This does not create the 
actual subdirectory; and when a subdirectory is exported by 
one of the export servers or domains in the From.List of the 
Directory Replication dialog box, it is automatically imported 
and is added to this list. 

Removes the selected subdirectory from the list. 

However, this is usually unnecessary. If that subdirectory 
is exported by one of the export servers or domains in the 
From List of the Directory Replication dialog box, it will 
still be imported and will later reappear in this list. 

2. To temporarily stop importing to a subdirectory, select the subdirectory from 
the list and then choose the Add Lock button. 

3. To resume importing to a locked subdirectory, select the subdirectory and 
then choose the Remove Lock button. 

Usually, you should only remove locks that you have applied. Import only 
resumes when the Locks column shows a value of 0 for the subdirectory. 

4. To return to the Directory Replication dialog box, choose the OK button. 

Managing Administrative Alerts 
The Alerts dialog box displays and manages the list of users and computers 
that are notified when administrative alerts occur at this computer. 

Alerts relate to server and resource use. They warn about security and access 
problems, user session problems, server shutdown because of power loss when 
the UPS service is available, and printer problems. For example, an alert can be 
generated when disk space becomes low. 

For alerts to be sent, the Alerter and Messenger services must be running on the 
computer originating the alert. For alerts to be received, the Messenger service 
must be running on the destination computer. 
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I> To manage the recipients of administrative alerts 

1. In the Control Panel window, choose the Server icon. 

2. In the Server dialog box, choose the Alerts button. 

~end Administrative Alerts To: 

Hew Computer or Username: I' 'A' d'd' " 'J~ JEFFHO 
-.. -) ~ POINTER 

L-I A_I R_E_D_A_LE _____ --'I TERRIER 

OK Cancel Help 

3. To add a user or computer to the list of alert recipients, type the user name or 
computer name in the New Computer Or Username box, and then choose the 
Add button. ' 

4. To remove a user or computer from the list of alert recipients, select the user 
name or computer name from the Send Administrative Alerts To box, and then 
choose the Remove button. 

5. To exit, in the Alerts dialog box choose the OK button, and then in the Server 
dialog box choose the OK button. 
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Managing Services 
Use the Services option in Control Panel to start, stop, pause, or continue each of 
the services available on the computer, to determine whether a service will start 
up automatically when the system starts, and to control some other service startup 
parameters. 

The default services provided with the system are shown in the following table. 

Service 

Alerter 

Clipbook Server 

Computer Browser 

Directory Replicator 

Event Log 

Messenger 

Net Logon 

NetworkDDE 

Network DDE DSDM 

Remote Procedure 
Call Locator 

Description 

Notifies selected users and computers of administrative alerts 
that occur on this computer. Used by the Server and other 
services. Requires the Messenger service. 

Supports the ClipBook Viewer application, allowing pages to 
be seen by remote ClipBooks. 

Maintains an up-to-date list of computers, and provides the list 
to applications when requested. Provides the computer lists 
displayed in the Select Computer and Select Domain dialog 
boxes. 

Replicates directories, and the files in those directories, 
between computers. 

Records system, security, and application events in the 
event logs. 

Sends and receives messages sent by administrators or 
by the Alerter service. 

Supports pass-through authentication of account logons. 
Used when the workstation participates in a domain. 

Provides a network transport for DDE (dynamic data exchange) 
conversations and provides security for DDE conversations. 

Manages the shared DDE conversations. It is used by the 
Network DDE service. DSDM stands for DDE share database 
manager. 

Allows distributed applications to use the Microsoft RPC name 
service. The RPC Locator service manages the RPC name 
service database. 

The server side of a distributed application registers its 
availability with the RPC Locator service. The client side of a 
distributed application queries the RPC Locator service to find 
available compatible server applications. 
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Service Description 

Remote Procedure Call Is the RPC subsystem for Windows NT. The RPC subsystem 
includes the endpoint mapper and other miscellaneous RPC 
services. 

Schedule 

Server 

UPS 

Workstation 

Must be running for the at command to be used. The at 
command can be used to schedule commands and programs to 
run on a computer at a specified time and date. 

Provides RPC (remote procedure call) support, and file, print, 
and named pipe sharing. 

Manages an uninterruptible power supply connected to this 
computer. 

Provides network connections and communications. 

Starting and Stopping Services 
Use the Services dialog box to start, stop, pause, or continue each of the services 
available on the computer, and to pass startup parameters to the service. 

I> To start, stop, pause, or continue a service 

, 1. In the Control Panel window, choose the Services icon. 

Status Startup 

Started Automatic 

EventLog 
Messenger 
Net Logon Started Automatic 
Network DDE Started Automatic 
Network DDE DSDM Started Automatic 

St~rtup Parameters: 

A blank in the Status column indicates that the service is stopped. 

2. In the Services dialog box, select a service. 

3. Choose the Start, Stop, Pause, or Continue button. 

Optionally, to pass startup parameters to a service, type the parameters in the 
Startup Parameters box before choosing the Start button. 

4. In the Services dialog box, choose the Cl9se button. 
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Because stopping the Server service disconnects all remote connected users, use 
the following procedure to stop that service. 

r> To stop the Server service 

1. Use the Services option in Control Panel to pause the Server service. 

This prevents new users from establishing a connection with this computer. 

2. Notify all connected users, warning them to disconnect within a specified 
time period. 

3. After expiration of your warning period, use the Services option in Control 
Panel to stop the Server service. 

Configuring Service Startup 
Use the Service Startup dialog box to configure when and how a service is started 
and, optionally, to specify a user account the service will use to log on. 

When services start, they log on. By default, most services log on using a special 
system account. (Of the services provided with Windows NT, only the Directory 
Replicator and Schedule services will usually log on using other user accounts.) 

When a user account other than the system account is used to log on a service, 
that user account must have the Password Never Expires option selected. For 
instructions on configuring a user account, see Chapter 13, "User Manager." 

If it is the Directory Replicator service that you are assigning the user account 
to, it must be a domain user account, and it must be a member of the domain's 
Backup Operators group. For instructions on configuring a domain user account 
as described here, see the Microsoft Windows NT Advanced Server System Guide 
provided with the Microsoft Windows NT Advanced Server software required 
for the replication export server. 

To configure service startup you must be logged on to a user account that is a 
member of the Administrators local group. 

r> To configure startup for a service 

1. In the Control Panel window, choose the Services icon. 

2. In the Services dialog box, select a service. 

3. Choose the Startup button. 
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Startup Type---------, ,---..." 

@ automatic 

o Manual 

o D.isabled 

log On As: --------------, 

o fulstem Account 
@J.hisAccount: r-IS-H-IP-P-IN-G-\-D-ire-c-to-ry-R-e-p-I-Yld"""'E~':· 

~assword: 

Confirm 
Password: 

I 

4. Specify a startup type. 

Select 

Automatic 

Manual 

Disabled 

To 

Start the service every time the system starts. (The Server 
service will not start automatically unless the computer has 
at least 12 MB of memory.) 

Allow the service to be started by a user or by a dependent 
service. 

Prevent the service from being started. 

5. Specify the user account the service will use to log on. 

Select 

System Account 

This Account 

To 

Specify that the service will log on using the system 
account. 

Specify a user account the service will use to log on. 

Note Most services must log on using the system account. 

6. If you select This Account, choose the Browse button and specify a user 
account in the Add User dialog box that appears. After completing and exiting 
that dialog box, type the password for the user account in both the Password 
and Confirm Password boxes. 

7. Choose the OK button, and then in the Services dialog box, choose the Close 
button. 

If a user account has been assigned to a service as described in steps 5 and 6 of 
the previous procedure, and if the password for that user account is later changed. 
(for example, while using the User Properties dialog box in User Manager to 
administer the user account), the password for that user account must also be 
changed here, in the Service Startup dialog box. 



CHAPTER 6 

Print Manager 

Use Print Manager to work with local and network printers. 

This chapter explains how to control printing and printers, and includes 
the following topics: 

• Installing a printer for use with Windows NT and your applications 

• Connecting to a network printer 

179 

• Changing a printer's properties, including sharing a printer over the network 

• Securing a printer and auditing its use 

• Printing documents 

• Administering network print servers remotely 
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Overview 
Use Print Manager to install local printers and to connect to printers on the 
network so that you can print to them from your applications. Each printer that is 
available appears in its own window in Print Manager. Printer windows show you 
the current activity of the printer, including a list of the documents waiting to be 
printed. If you have several printers available to you on the network, you can use 
Print Manager to find one that is ready to print and not busy printing other users' 
documents. 

You can use Print Manager to control documents that have been sent to a printer. 
You can pause and resume printing, arrange the order in which waiting documents 
will be printed, and remove documents that are waiting to print. 

Print Manager allows you to manage both local and remote printers to suit your 
needs. Use Print Manager to share printers on the network, control access to 
printers, and set other printer properties such as the hours the printer is available 
to print. 

The Print Manager window contains a menu bar, toolbar, and status bar. Printer 
windows and icons represent printers you have installed or to which you are 
connected over the network. Server windows and icons represent servers to which 
you have connected in order to administer printers remotely. 

Window tlelp 

\Iifeboat\dinghy shared printer Server: laser3 
~\SETTER 

rshipping Documentswaiting: 0 
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The toolbar provides quick access to commands through buttons. 

The status bar shows the status of the current job or printer, including how 
many pages of the job have been printed and how many documents are waiting 
to be printed. . 

The printer window shows information for one of the printers that you have 
installed or to which you are connected. For each printer, you can see what 
documents are waiting to be printed, who owns them, how large they are, 
and other information. 

The server window shows information for all printers connected to a 
Windows NT-based server. 

The toolbar and status bar are displayed by default. You can hide them by 
choosing the Toolbar and Status Bar commands from the Options menu. 

Starting and Quitting Print Manager 
By default, when you start Print Manager, its window appears as it was when you 
last quit Print Manager. The positions of printer and server windows are saved as 
long as the Save Settings on Exit command is in effect when you quit. 

~ To start Print Manager 

• From the Main Group, choose the Print Manager icon. 

-Or-

• In Control Panel, choose the Printers option. 

I> To quit Print Manager 

• From the Printer menu, choose Exit. 

Installing a Printer 
Use the Print Manager Create Printer option from the Printer menu when: 

• You are physically installing a printer on a computer. 

• You are physically installing a printer that connects directly to the network. 

• You want to define a printer that prints to a file. 

• You want to define multiple printers with varying properties for the same 
physical printer. 
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~ To create a printer, you must be logged on as a member of the Administrators 
or Power Users group. 

The printers you create using Print Manager represent physical devices, 
usually physical printers. Because Print Manager printers are representations of 
physical devices, they can be used flexibly. You can create more than one printer 
representing the same physical printer, or you can create a printer that prints to a 
file. For example, if you have a printer in your office, but also share it with others 
over the network, you might want to create two printers for the physical printer. 
You can create a printer for yourself that is not shared over the network and a 
second printer that is shared. Then it's easy to control the use of the shared 
printer. You can set permissions on it, ensuring that only members of your 
department can print to it. Or you can set a low priority for it, ensuring that 
documents you send to the printer will always print before documents sent by 
those who share it. 

Note If you want to print to a printer that is already shared on a network, add it 
to the printers in Print Manager by connecting to it. For more information, see 
"Connecting to a Network Printer," later in this chapter. 

When you choose Create Printer from the Printer menu, Print Manager displays 
a Create Printer dialog box where you can define the operation of the printer. 
To complete a basic printer installation, specify the printer name, driver, and an 
optional description. Then specify a printing destination. The destination can be 
a port, a file, or a network address. Print Manager will prompt you to select the 
appropriate printer driver or to install a new one if necessary. 

J> To install a printer 

1. From the Printer menu, choose Create Printer. 

Printer N.ame: ,-I S--.,;hip~p_ing=---_______ ---l 

.!2river: IHP LaserJet IllSi 

D~scription: 1 department printer available 6AM to 6 PM 1 

Print to: ILPT1: 

[g] ~hare this printer on the network -----, 

Sh!!re Name: 1 Shipping 

~==============~ 
!,.ocation:1 L-R_oo_m_3_42 ________ --' 
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2. In the Printer Name box, type a name for the printer. 

This name appears in the title bar of the printer window. It is the name 
network users running Windows NT will see when connecting 1 the printer if 
you share the printer over the network. The name can be up to 32 charactr s 
long. 

3. In the Driver box, select the printer's driver. 

If your printer does not appear in the list, you can try installing the printer 
using a compatible driver. For example, if your printer is Hewlett-Packard® 
PCL® compatible, you may be able to use one of the HP® LaserJet® drive s 
included with Windows NT. Consult your printer's documentation to 
determine which drivers you can choose; 

4. In the Description box, type an optional description. 

Network users will see this description when adding the printer to their 
available printers. Use the description to inform them about the printer. 
For example, if the printer is available only during certain hours, you 
could include that information here. 

5. In the Print To box, choose a destination for printing output: 

• If you are installing a printer that you have physically connected to a 
computer, choose the appropriate parallel or serial port, for example, LPTl. 

If the port you want does not appear in the list, choose Network Printer. 
In the Print Destinations dialog box, choose Local Port and then choose 
the OK button. Type the name of the new port in the Port Name dialog 
box and choose the OK button. Print Manager adds the port to the list of 
print destinations. 

• If you want to print to a file, choose File. When you print, you are 
prompted for a file name. 

• If you are installing a Hewlett-Packard printer that connects directly to 
the network, choose Network Printer. In the Print Destinations dialog box, 
choose Hewlett-Packard Network Port and then choose the OK button. In 
the Add A Hewlett-Packard Network Port dialog box, select the network 
address in the Card Address box and name the port. Then choose the OK 
button. 

Before you can create a printer that uses a Hewlett-Packard network port, 
the Data Link Control protocol must be installed and running. You can 
install the protocol using the Network option in Control Panel. 
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6. Choose the OK button. 

7. If the appropriate printer driver is not already installed, Windows NT prompts 
you to enter the path of the distribution files where the driver is located. Type 
the path and choose the OK button. Windows NT prompts you to insert disks 
as necessary to install the driver. 

Print Manager displays a dialog box that allows you to set up your printer's 
features. You can set these now or later. 

This completes a basic printer installation. You can specify many other options 
when installing a printer. For more information, see "Changing a Printer's 
Properties," later in this chapter. 

Installing a Printer Driver 
Use Print Manager when you need to install a new ot additional printer driver 
for your printer. . 

Because RISe and x86-based computers use different printer drivers, you may 
want to install printer drivers for both platforms on your print servers if your 
network contains a mixture of RISC and x86-based computers. For example, 
when a RISC-based Windows NT computer connects to an x86-based Windows 
NT print server, the RISC version of the printer's driver must be available to the 
RISe-based computer. You can install the RISC printer driver on either the local 
computer or on the x86-based print server. If you install the driver on the server, 
it will be available to any other RISC-based Windows NT computer on your 
network. 

~ To install a printer driver not listed in the Driver box 

1. Select the printer's icon or window. 

~ 2. From the Printer menu, choose Properties. Or choose the Properties button 
on the toolbar. 

3. In the Printer Properties dialog box, select Other in the Driver box. 

4. In the Install Driver dialog box, specify the drive and path where the printer 
driver is located and choose the OK button. 

If you are installing a second driver for a printer on a server, for example 
a RISe driver on an x86-based computer, specify the location of the 
PRINTER.INF file for the RISC drivers, for example a shared directory 
on the network. 

5. In the Select Driver dialog box, select the driver in the Printer Driver box. 
If the driver is not located in the directory shown by the Source Directory box, 
edit the path. Then choose the OK button. 

Print Manager installs the new driver. 
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Connecting to a Network Printer 
To print to a printer that is shared over the network, connect to it. Connecting to 
the printer adds the printer to the available printers displayed in the Print Manager 
window. 

By default, printers in your computer's domain or workgroup are displayed 
automatically in the Shared Printers box. If you are connecting over a slow 
network, for example connecting through Remote Access Service, you can 
switch this off by clearing the Expand By Default check box. 

t> To connect to a network printer 

1. From the Printer menu, choose the Connect To Printer command. Or choose 
the Connect Printer button on the toolbar. 

r OK 

I t~ncel 
p-rinter: I \\5 E TT E R \shipping 

~hared Printers: r2l !;.xpand by Default I Help 

Microsoft Windows Network 
ACCOUNTING 
ENGINEERING 
SHIPPING 

Printer Information--------------------, 

Description: department printer available 6 AM to 6 PM 
Status: Ready Documents Waiting: 0 

2. In the Connect To Printer dialog box, select a printer. 

The Shared Printers box shows networks, domains or workgroups, and shared 
printers organized in a tree structure. Double-click an item to expand the list: 
double-click a network name to display domains or workgroups. Double-click 
a domain or workgroup name to display printers shared by computers running 
Windows NT and to display other print servers. To display printers shared by 
other print servers, for example computers running LAN Manager 2.x, double­
click a computer name. 
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When you select a printer, Print Manager fills in the Printer box with the name 
of the computer sharing the printer and the name of the printer. The Printer 
Information box displays additional information, including the printer's 
description, status, and the number of waiting documents. 

Or you can type the name of a computer and shared printer in the Printer 
box. Precede the computer name with two backslashes (\ \) and separate the 
computer name from the shared printer's name with a single backslash (\), 
for example, \ \printserver\laser. 

3. Choose the OK button. 

4. If the printer you selected is shared by a Windows NT computer and has a 
printer driver compatible with your computer, Print Manager connects you 
to the printer and you can print. 

Print Manager prompts you to install a printer driver if the computer sharing 
the printer is not a Windows NT computer or if the printer driver available on 
the computer is not compatible. For example if your computer is RISC-based 
and the computer sharing the printer is x86-based, a RISC-compatible driver 
must be installed on either the computer sharing the printer or your computer. 
Choose the OK button to continue in order to install a driver. 

5. In the Select Driver dialog box, select the appropriate driver for the printer 
in the Driver box. 

6. In the Windows NT Setup dialog box, type the directory and path where 
Windows NT printer drivers are stored, and then choose the Continue button. 

Windows NT installs the driver and displays a printer window for the 
connected printer. 

Removing a Printer 
You can use Print Manager to remove printers that you have installed and to 
which you are connected. 

r> To remove a printer 

1. Select the printer window or printer icon. 

~.:-l: 2. To remove a printer to which you are connected over the network, choose 
Remove Printer from the Printer menu, or choose the Disconnect Printer 
button on the toolbar. 

To remove an installed printer, choose Remove Printer from the Printer menu. 

3. Print Manager prompts you for confirmation. Choose the Yes button to 
remove the printer. 
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Changing a Printer's Properties 
You can set printer properties when you create a printer or you can change 
a printer's properties after you have created it. Properties include: 

• Sharing the printer on the network. 

• Setting printing options such as the size and format of paper available at 
the printer and the font cartridges that are installed. 

• Setting job defaults such as the default paper size and printing orientation. 

• Setting printer details such as the hours the printer is available and the 
printing priority of documents sent to the printer. 

To change printer properties, you must be logged on as a member of the 
Administrators or Power Users group, or you must have been granted Full 
Control permission for the printer. 

t> To change the properties of an installed printer 

1. Select the printer's icon or window. 

~ 2. From the Printer menu, choose Properties. Or choose the Properties button 
on the toolbar. 

Printer Harne: ,-I sh....,;ip-'-p....,;ing:.....-_______ ---' 

.!2river: I HP LaserJet I/lSi Ijj 

D ~scription: I department printer available 6 AM to 6 PM I 
Print!o: ILPT1: Ii] 

[g] ~hare this printer on the network -----, 

Sh.!!re Name: I shipping 

~==============~ 
hocation: ,-I R_oo_m_3_42 _______ ----' 

You can now change the printer's properties as discussed in the sections 
that follow. 
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Sharing a Printer 
Sharing a printer allows others on the network to connect to the printer and to . 
print their documents on it. Before you can share a printer, the Server service 
must be running. You can start the Server service by using the Services option 
in Control Panel. 

~ To share a printer on the network 

1. In the Printer Properties dialog box, select the Share This Printer On The 
Network check box. 

[g] ~hare this printer on the network -------, 

Sh!!.re Name: 1 shipping 

~===============: 
!:.ocation: ,-I R_oo_m_3_42 _______ ----' 

2. In the Share Name box, Print Manager creates a share name for the printer. 
Computers running Windows NT see the printer name when connecting to 
the printer; however, computers running MS-DOS require a share name that 
conforms to MS-DOS naming conventions in order to connect. 

The share name is based on the printer name. You can edit the share name; 
however, if you want MS-DOS-based computers to connect to the printer, the 
share name must follow MS-DOS naming conventions and cannot be longer 
than 12 characters. 

3. In the Location box,type a description of the printer's location to let users 
know where their documents will be printed. Users see the printer's location 
in the Connect To Printer dialog box when they add the printer to their list of 
available printers. 

4. Choose the OK button. 

Setting Printing Options 
Setup options allow you to configure the printer to take full advantage of its 
features. The options that are available depend on the printer. The following 
table lists typical setup options: 

Option 

Forms 

Memory 

Font 

Halftone 

Purpose 

Specifies the size and format of paper used in the printer. 
Printers that support multiple paper trays or sources for 
paper allow you to match a form with a source. 

Specifies the amount of memory available in the printer. 

Specifies the font cartridges installed in the printer. Controls 
the loading of soft fonts and font substitution. 

Adjusts the printing of halftone colors. 
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For more information on setup options available for your printer, choose the 
Help button in the Printer Setup dialog box. 

1> To set or change printing options 

1. In the Printer Setup dialog box, choose the Setup button. 

A typical Printer Setup dialog box used for setting printing options is shown 
below. The options available for your printer may be different. 

Printer tdemory---------------, 

Amount (kilobytes) 
11536 1 !I D fane Protect 

Font Cartridges ( 2 maximum) 

HP: ProCollection 
HP: WordPerfect 
HP: Global Text 
HP: Great Start 
HP: TextEquations 
H P: Polished Worksheets 

2. Set the options and then choose the OK button. 

Setting Job Defaults 
Job defaults include printing settings such as paper size and orientation. The 
settings in Print Manager establish how documents print by default, so you 
should use settings that are appropriate for the type of document you print most 
frequently. When you need to change a setting, you can do so from within your 
applications when you print. Settings made from within an application override 
the defaults set in Print Manager. 

The settings that are available depend on the printer. The following table lists 
typical settings. 
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Setting 

Form 

Orientation 

Copies 

2 Sided 

Resolution 

Color 

Download Fonts 

Purpose 

Selects a paper size 

Sets printing the page vertically or horizontally 

Sets the number of copies to print 

Sets printing on both sides of the paper 

Sets the resolution at which graphics print 

Switches between color and monochrome printing 

Specifies whether or not to download TrueType fonts 
to the printer 

For more information on options available for your printer, choose the Help 
button in the Document Properties, Advanced Document Properties, and Halftone 
Color Adjustment dialog boxes. 

l> To set or change job defaults 

1. In the Printer Properties dialog box, choose the Details button. 

2. In the Printer Details dialog box, choose the Job Defaults button, and set 
defaults in the Document Properties dialog box. 

A typical Document Properties dialog box used for setting job defaults is 
shown below. The options available for your printer may be different. 

Orientation --------, 

@ e.ortrait 

o .Landscape 

2-Sided Printing 

@ Non~ 

~ 0 Lon~Side 

o ~hort Side 

OK 

About.. 

3. In the Document Properties dialog box, choose the Options button to set more 
defaults in the Advanced Document Properties dialog box. 

4. In the Document Properties dialog box, choose the Halftone button to adjust 
halftone printing for color and monochrome graphics. 

5. Choose the OK button to close each dialog box. 
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Setting Printer Details 
Use the Printer Details dialog box to set the following printer features: 

• Set the hours a printer is available 

• Print a separator page 

• Create a pool of printers 

• Set printer priority 

• Specify a print processor 

• Specify a default data type 

• Print directly to ports 

t> To set printer details 

1. In the Printer Properties dialog box, choose the Details button. 

Available [rom: 112: 00 AM 1.0: 112: 00 AM 

~eparator File: 1L--_______ -I.o..-.iJ 

I J..ob Defaults ... ) 

.. e.riority: ~ I Help 
Print to Additional Ports: 

COM1: Print Processor: I'-W_in_Pr_int __ ----"'1 !:_, 
COM2: 
COM3: D~fault Datatype: IL-RA_w ___ ----"'1 !:""",I 

Qelete Port D Print Directly to Ports 

2. Set or change printer details and then choose the OK button. 

Setting Printing Hours 
Setting printing hours sets the period during which the printer will print 
documents sent to it. Documents can be sent to the printer at any time, but they 
will only be printed during the hours that you have set. By default, printing 
hours are not limited. 

Setting printing hours allows you to control the flow of work to a printer. For 
example, you can create two printers in Print Manager for the same physical 
printer and restrict the printing hours for one printer to nighttime hours. You can 
send documents to the nighttime printer at any time, but they will print only at 
night. Use the nighttime printer to print documents that are large or that you don't 
need immediately. This keeps the physical printer available during the day to print 
the documents you need right away. Print those documents by directing them to 
the printer whose hours you have not limited. 
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J> To set or change printer availability 

• In the Printer Details dialog box, set the period that the printer is available 
using the Available From and To scroll boxes. 

Available from: 112: 00 AM iii 10: 112: 00 AM iii 

Using Separator Files 
You can use separator files for a variety of purposes. Windows NT includes 
separator files that print a page at the beginning of each document to make it easy 
to find a document among others at the printer and separator files that can switch 
a printer between PostScript® and peL printing. You can create your own 
separator files and specify their use by Print Manager. 

The following table shows the names of separator files supplied with 
Windows NT, the purpose of each, the type of printer with which each is 
compatible, and whether or not the file can be edited. 

Filename Purpose Compatible with Can be edited 

DEFAULT.SEP Prints a page before PCL No 
each document 

PSLANMAN.SEP Prints a page before PostScript Yes 
each document 

PCL.SEP Switches printer to PCL Yes 
PCL printing 

PSCRIPT.SEP Switches printer to PostScript Yes 
PostScript printing 

J> To specify a separator page 

• In the Printer Details dialog box, type the name of the separator file, including 
its path, in the Separator File box. To use the Windows NT default separator 
page, type DEFAULT.SEP in the Separator File box. 

~eparator File: 1'---______ ---11_2_:·1 

If you want to search for a file, choose the browse button next to the Separator 
File box. You can then search for the file using the Select Separator Page 
dialog box. 
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Setting Printer Priority 
Use the priority setting to control which documents will print first when sent to 
a printer. When you create two printers for the same physical printer and set 
different priorities for them, documents sent to the printer whose priority is higher 
will always print before documents sent to the printer whose priority is lower. 

For example, if you are the primary user of the printer in your office, but you 
also share it with others over the network, you can ensure that your print jobs 
will always print before those of others by creating two different printers for 
the physical printer and setting a low priority for the shared printer. 

~ To set or change the priority 

• In the Printer Details dialog box, set the priority in the Priority box. 

By default, the priority is set to 1, which is the lowest priority. You can set 
a priority from 1 to 99. 

friority: 

Creating a Printer Pool 
Print Manager allows you to pool printers. When printers are pooled, several 
printers connected to a server behave as a single printer. When a document is sent 
to the server, the first available printer in the pool will print it. The printers in the 
pool must be identical to ensure printing consistency. To create a pool of printers, 
create a printer and include in the printer definition the additional ports to which 
the pool printers are connected. 

~ To create a printer pool 

• In the Printer Details dialog box, select port names from the ·Print To 
Additional Ports box that correspond to the ports where you have connected 
printers. 

Print to Additional Ports: 

COM1: 
COM2: 
COM3: .. 

!!.elete Port 

If the ports you need do not appear in the list, you can add them. 
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r;. To add a port 

1. In the Printer Properties dialog box, select Network Printer in the Print To box. 

2. In the Print Destinations dialog box, select Local Port and choose the OK 
button. 

3. In the Port Name dialog box, type the name of the port you want to add in the 
Enter A Port Name box, and then choose the OK button. 

Printing Directly to Ports 
You can control how Print Manager sends documents to the printer. By default, 
documents are spooled before starting to print. When a document is spooled, it is 
stored on the hard disk first and then the spooler sends it to the printer. You can 
continue working with your application as soon as the document is stored on the 
disk. The spooler sends the document to the printer in the background. 

If you want to bypass spooling, you can print directly to the printer. However, 
you will have to wait until the document is printed before continuing to work 
with your application. . 

~ To print directly to ports 

• In the Printer Details dialog box, select Print Directly To Ports. 

D Print Directly to Ports 

Specifying a Print Processor or Data Type 
The Windows NT print processor supports Journal and Raw data types. In 
general, you should not need to change either the default print processor or data 
type. These options are available so that specialized applications can modify the 
printing process. Such an application may require you to specify a specialized 
print processor and a particular data type when you create a printer to use with 
the application. 

f> To set or change the print processor 

• In the Printer Details dialog box, select the filename of the processor in the 
Print Processor box. 

Print Processor: IWinPrint I!J 

t> To set or change the default data type 

• In the Printer Details dialog box, select a data type in the Default Datatype 
box. 

D~fault Datatype: IRAw I!J 
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Setting Time-outs 
For printers that are connected to a computer's parallel port, for example LPTl, 
you can control the amount of time that elapses before Print Manager decides that 
the printer is not responding and notifies you of an error. The setting affects the 
printer you've selected and any other local printers that use the same driver. The 
setting for Transmission Retry determines how long Print Manager will wait for 
a printer to ready itself to accept more data. 

1> To set time-out options 

1. Select the printer whose time-outs you want to set. 

Time-outs can be set only for printers connected to a parallel port. 

2. From the Printer menu, choose Properties. 

3. In the Printer Properties dialog box, choose the Settings button. 

I.ransmission Retry: =Irn=..._---I 

Help 

4. Set the number of seconds in the Transmission Retry box, and then choose 
the OK button. 

Securing a Printer 
You can secure printers by setting permissions on them. Each permission you set 
specifies the access that a group or user has to the printer. For example, when you 
set Print permission for the group called marketing on the printer, members of that 
group can print documents on the printer, but cannot change any of the printer's 
properties. 

Permissions are cumulative except that the No Access permission overrides 
all other permissions. For example, if the marketing group has Full Control 
permission while the finance group has only Print permission, and Annie is a 
member of both groups, Annie will have Full Control permission. However, if 
you change the finance group's permission to No Access, Annie will not be able 
to use the printer even though she is a member of a group that has access to it. 

By default, if you have permission to print, you also can control the printing of 
any document you print. As creator of the document at the printer, you are 
allowed to control the document through permissions granted the Creator Owner. 
In general, you should not change the permissions granted to the Creator Owner 
or remove the Creator Owner from the permissions list. 
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~ To change permissions on a printer, you must be the owner of the printer or have 
been granted Full Control permission. 

The following table shows the permissions for printers and the actions available 
to users for each permission. 

• Permission allows use 
o Permission does not allow use 

Print documents 

Control settings for documents 

Pause, resume, restart, 
and delete documents 

Change the printing order of documents 

Pause, resume, purge printer 

Change printer properties 

Delete printer 

Change printer permissions 

i 0 j • 
~ 
l 0 0 
I 

0 0 

o 0 

o ! 0 

o ! 0 

o 
! 0 
r 

o 
o 

0 • 
• • 
• • 
o .! 
0·1 
o 'i • 1 

o ; • 
o • 

~ To set or change printer permissions 

1. Select the printer window or icon for the printer whose permissions you want 
to set or change. 

2. From the Security menu, choose Permissions. 

Printer: shipping 

.!lwner: Administrators 

N.ame: 

~ CREATOR OWNER 
@ Everyone 
r!!1 Power Users 

Manage Documents 
Print 
Full Control (All) (All) 

lvpe of Access: I Full Control Iii 
I····· 10K!·· .. H , ...•..• Can~ell Remove 

3. Select the name of the group or user and choose a permission from the 
Type Of Access box. 

4. Choose the OK button. 
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1> To add a group or user to the printer permissions list 

1. In the Printer Permissions dialog box, choose the Add button . 

.list Names From: ,-I ~=-"_\_\s_e_tte_r· ______ ----"I ..... !I 

Add 

A!!d Names: 

~ setter\shipstaff 

Members can assign file backup and restore 
T he user who creates this obiect 
All Users 
Guests of the domain 
Users accessing this obiect locally 
Users accessing this obiect remotely 
shipping department staff 

shipping department staff 

llpe of Access: L-lp_ri_nt _______ .... 1 ! ..... I 

OK Cancel Help 

The Add Users And Groups dialog box displays the groups on the computer 
or in the domain shown by the List Names From box. Local groups are shown 
for the computer or domain whose name is followed by an asterisk (*). 

You can select another domain by using the List Names From box. Domains 
appear only if your computer is a member of a domain on a Windows NT 
Advanced Server network. The domains shown have a trust relationship. 

2. You can use options in the Add Users And Groups dialog box to display users, 
find the users in a group, or find the domain to which a group or user belongs. 

• Choose the Show Users button to display the names of users on the current 
computer or domain. 

• To see a group's content, select the group and choose the Members button. 
Users are listed in a new dialog box. On a Windows NT Advanced Server 
network, global groups that are members of a local group appear in the list. 
To see a global group's users, select the group and choose the Members 
button. To include the group in the Add Users And Groups dialog box, 
choose the Add button. To include some of the group's users, select them 
and choose the Add button. 
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• To add a group or user, you must know the domain which contains the 
group's or user's account. On a Windows NT Advanced Server network, 
choose the Search button to find the domain of a group or user. In the Find 
Account dialog box, type the name of the group or user in the Find User 
Or Group box and specify the domains to search. Then choose the Search 
button. To include the groups or users in the Add Users And Groups dialog 
box, select them in the Search Results box and choose the Add button. 

3. To add groups or users to the permissions list, select them and choose the 
Add button, or double-click the name of the group or user. 

Or you can type the names of groups and users in the Add Names box. 
Separate names using a semicolon. If the account of the group or user is not 
located on the computer or domain shown by the List Names From box, you 
must specify the location. Type the computer or domain name followed by 
group or user name and separate the names using a backslash, for example 
shipping\ernesta. You can type the name without waiting for Windows NT 
to list groups in the Names box. 

4. Select the permission for the groups or .users shown in the Add Names box 
using the Type Of Access box. 

5. Choose the OK button. 

I> To remove printer permissions for a group or user 

1. In the Printer Permissions dialog box, select the name of the group or user. 

2. Choose the Remove button. 

Auditing a Printer 
Auditing a printer allows you to track its usage. For a particular printer, you can 
specify which groups or users and which actions to audit. You can audit both 
successful and failed actions. Windows NT stores the information generated from 
auditing in a file. You can view the information using Event Viewer. For more 
information, see Chapter 15, "Event Viewer." 

Important To audit a printer, you must set the audit policy to audit file and object 
access. Set the audit policy using User Manager. For more information on audit 
policy, see Chapter 13, "User Manager." 
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To audit the following activities for a printer, select the events shown. 

• Event audits action d' '19.,; ,," ..s ''<)~' ~~;' 
0 Event does not audit action § 

0 ~ ~.~ '<) $: 
.$' ~ ~ &§;f§ 

~4;, ~:::: <:)'<) ~'<) 0 

Printing documents • 0 0 0 0 

Changing job settings for documents 0 • 0 0 0 

Pausing, restarting, moving, 0 • 0 0 0 
and deleting documents 

Sharing a printer 0 • 0 0 0 

Changing printer properties 0 • 0 0 0 

Deleting a printer 0 0 • 0 0 

Changing printer permissions 0 0 0 • 0 

Taking ownership 0 0 0 0 • 

I> To set or change printer auditing 

1. Select the printer window or icon for the printer that you want to audit. 

2. From the Security menu, choose Auditing. 

3. Set auditing for each group and user in the list: select the name of a group 
or user, and then select the events to audit for that group or user. 

4. Choose the OK button. 

I> To add a group or user to the printer auditing list 

1. In the Printer Auditing dialog box, choose the Add button. 

The Add Users And Groups dialog box displays the groups on the computer or 
in the domain shown by the List Names From box. Local groups are shown for 
the computer or domain whose name is followed by an asterisk (*). 

You can select another domain by using the List Names From box. Domains 
appear only if your computer is a member of a domain on a Windows NT 
Advanced Server network. The domains shown have a trust relationship. 

2. You can use options in the Add Users And Groups dialog box to display users, 
find the users in a group, or find the domain to which a group or user belongs. 

• Choose the Show Users button to display the names of users on the current 
computer or domain. 

• To see a group's content, select the group and choose the Members button. 
Users are listed in a new dialog box. On a Windows NT Advanced Server 
network, global groups that are members of a local group appear in the list. 
To see a global group's users, select the group and choose the Members 
button. To include the group in the Add Users And Groups dialog box, 
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choose the Add button. To include some of the group's users, select them 
and choose the Add button. 

• To add a group or user, you must know the domain which contains the 
group's or user's account. On a Windows NT Advanced Server network, 
choose the Search button to find the domain of a group or user. In the Find 
Account dialog box, type the name of the group or user in the Find User 
Or Group box and specify the domains to search. Then choose the Search 
button. To include the groups or users in the Add Users And Groups dialog 
box, select them in the Search Results box and choose the Add button. 

3. To add groups or users to the auditing list, select them and choose the Add 
button, or double-click the name of the group or user. 

Or you can type the names of groups and users in the Add Names box. 
Separate names using a semicolon. If the account of the group or user is not 
located on the computer or domain shown by the List Names From box, you 
must specify the location. Type the computer or domain name followed by 
group or user name and separate the names using a backslash, for example 
shipping\ernesta. You can type the name without waiting for Windows NT 
to list groups in the Names box. 

4. Choose the OK button. 

I> To remove printer auditing for a group or user 

1. In the Printer Auditing dialog box, select the name of the group or user. 

2. Choose the Remove button. 

Taking Ownership of a Printer 
The owner of a printer can always change the permissions set on the printer. 
If you have Full Control permission for a printer, you can take ownership of 
it. Otherwise, you must be logged on as a member of the Administrators group 
to take ownership. 

I> To take ownership of a printer 

1. Select the printer window or icon for the printer. 

2. From the Security menu, choose Owner. 

Printer Name: shipping 

Owner: Administrators 

3. Choose the Take Ownership button. 
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Using Forms 
A form specifies paper size and the size of margins. Many printers support a range 
of forms: letter, legal, A4, #10 envelope, and so on. When you create a printer, 
you assign a form to each of the printer's trays. In addition to supporting standard 
forms, Print Manager allows you to create custom forms and assign them to 
printers. Use this feature to ensure that a printer is always ready to print your 
special forms. 

For example, you can define a letter-sized form called Letterhead whose 
expanded top margin reserves space for the information on your company's 
letterhead. You can then assign this form to a paper tray on one of your printers 
and keep that tray filled with letterhead paper. Users connected to the printer can 
select the Letterhead form when printing from their applications and be assured 
that their documents will be printed on the company stationery. If a user selects 
a form that is not assigned to a tray on the printer, the document will wait to print 
until the selected form has been assigned to the printer. 

Forms you create are stored on the computer. When you create a form for use with 
a particular printer, create the form on the computer used as the printer's server. 

l> To create a form 

1. From the Printer menu, choose Forms. 

(.;;.:, '" "",m, '" • "T;hJiiJr!~ ,'" w"'Hw"':;;'::;;;i 
ji-L...;...;";";""'-. -""'"----....;.....;"""---'---------~! 

; Forms on thiS Computer: OK ! 

I "blcid I 
11 Ledger 

Legal 
I Statement 
1 Executive 

- Form Description 

Harne: I Letter 

r-paper Size-

~idth:~ 

I H~ight: 111.00in I 

Help 

I 

r- Print Area Margins 

left: IO.OOin I lop: IO.OOin I 

flight: IO.50in I !! oUom: I O. OOin I 

,Units o Metric @ English II 
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2. In the Form Description box: 

• In the Name box, type a name for the form. 

• In the Paper Size box, type the measurements for the width and height 
of the paper. 

• In the Print Area Margins box, type the measurements for the left, right, 
top, and bottom margins. 

You can enter sizes in either inches or centimeters by selecting the 
English or Metric option buttons in the Units box. 

3. Choose the Add button. 

4. Choose the OK button. 

~ To assign a form to a printer 

1. Select the printer to which you want to assign the form. 

2. Choose the Properties button, or choose Properties from the Printer menu. 

3. In the Printer Properties dialog box, choose the Setup button. 

4. Select the source, for example Upper Paper Tray, and the name of the form, 
for example Letter. 

Source and form options are dependent on the printer. 

5. Choose the OK button. 

t> To remove a form 

1. From the Printer menu, choose Forms. 

2. In the Forms On This Computer box, select the form you want to remove. 
You cannot delete any of the standard forms supplied with Windows NT. 

3. In the Forms dialog box, choose the Delete button. 

Printing Documents 
The way you print documents depends on the application you are using. Use Print 
Manager to manipulate the documents at the printer. You can pause printing, and 
change the order of or remove documents that are waiting to print. 

You can always control printing of your own documents. However, to control 
printing of other users' documents, you must be logged on as a member of the 
Administrators or Power Users group, or you must have been granted Manage 
Documents or Full Control permission for the printer. 
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Setting the Default Printer 
When you choose the Print command in an application, the application sends 
the document to the default printer. Some applications allow you to select any 
of the available printers when you print. Set the default printer to be the printer 
you print to most often. 

~ To set the default printer 

• On the Print Manager toolbar, choose the Default box and select a printer 
from the list. 

: Default: I Greyhound 

Viewing Documents at the Printer 
To see the documents that are printing or waiting to be printed, display the 
printer's window. Print Manager displays documents sorted by the order in 
which they will print. 

The printer window shows each document's status, name, and owner; the time 
it was sent to the printer; its size in pages and bytes; and its priority . You can 
change the widths of the columns that display this information. 

CI.. Spooling 
Notepad· APPN 0 T E S. TXT S teveW 
Remote Downlevel Document SYSTEM 

~ To change the widths of columns 

2:16PM 
2:39 PM 

2 
o 

654 b 
Ob 

o 
o 

• Using the mouse, point to the vertical bar that follows the heading of the 
column whose width you want to change, and then drag the bar to widen 
or narrow the column. 
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Pausing and Resuming Printing 
You can interrupt and restart printing of all documents on a printer or of one 
document on a printer. 

r> To pause all printing 

1. Select the printer's window or icon. 

If a document is selected in the printer window, deselect it by pressing 
the right mouse button or by pressing the SPACEBAR. 

~II 2. From the Printer menu, choose Pause. Or choose the Pause button on 
~he toolbar. 

r> To resume all printing 

1. Select the printer's window or icon. 

If a document is selected in the printer window, deselect it by pressing 
the right mouse button or by pressing the SPACEBAR. 

EJ' 2. From the Printer menu, choose Resume. Or choose the Resume button 
on the toolbar. 

r> To pause printing of a document 

1. Selectthe document in the printer window. 

PII 2. From the Document menu, choose Pause. Or choose the Pause button 
on the toolbar. 

r> To resume printing a document 

1. Select the document in the printer window. 

[) 2. From the Document menu, choose Resume. Or choose the Resume button 
on the toolbar. 



Chapter 6 Print Manager 205 

Changing Printing Order 
You can change the order in which documents will be printed. 

t> To change the order of a document 

• Select the document in the printer window, and then drag it to a new position 
in the printing order. 

-Or-

• Select the document in the printer window, and then press CTRL+UP ARROW or 
CTRL+DOWN ARROW to move the document up or down in the printing order. 

Restarting Documents 
You can restart printing from Print Manager. When you restart a document, Print 
Manager reprints it from the beginning. For example, if your printer experiences 
a problem such as wrinkled paper, use Print Manager to restart printing. You can 
restart printing only when the Print Directly To Ports option is off. 

t> To restart printing of a document 

• Select the document in the printer window, and then choose Restart from 
the Document menu. 

Removing Waiting Documents 
You can remove documents that are waiting to print one at a time, or you can 
remove all documents that are waiting to print. 

t> To remove a waiting document 

1. Select the document in the printer window. 

*:J 2. From the Document menu, choose Remove Document. Or choose the 
Remove Document button on the toolbar. 

t> To remove all waiting documents 

1. Select the printer's window or icon. 

2. From the Printer menu, choose Purge Printer. 
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Displaying or Changing Document Details 
When you display detailed information on a document, Print Manager displays 
the file's name, status, owner, size in pages and kilobytes, and the time it was sent 
tothe printer. Print Manager also shows who will be notified of the document's 
status when it prints, the range of time in which the document can be printed, the 
document's priority, and the document's print processor. 

~ To display details about a document 

1. Select the document in the printer window. 

[] 2. From the Document menu, choose Details. Or choose the Details button 
on the toolbar. 

Status: Printing 

Size: 1159576 

Printed On: Laser3 

Printed At: 12:59 AM 

P!ocessor: WinPrint 

Datatype: NT JNL lOOO 

Pages: 20 

Owner: SteveW 

Notify: IV;il4!i'±~ 

friority: L-11_----'1iI ..... 

~tart Time: 112: 00 AM lit 
,!!ntil Time: 112: 00 AM lit 

Changing Print Notification 

Cancel 

By default, the owner of a document is notified when the document has been 
printed. You can change who is notified. 

~ To change print notification 

• In the Document Details dialog box, type the username of the person you want 
to notify in the Notify box. 
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Changing Document Priority 
By default, documents sent to a printer have the same priority while waiting to 
print. But when you raise the priority of a document, it will print before other 
documents that are waiting at that printer. If multiple printers with different 
priorities have been defined for a physical printer, documents sent to printers with 
higher priority will still print before documents sent to lower priority printers. For 
more information on printer priority, see "Setting Printer Priority," earlier in this 
chapter. 

t> To change a document's priority 

• In the Document Details dialog box, set the document's priority in the priority 
box. 

You can set a priority from 1, the lowest priority, to 99. 

Changing Document Printing Hours 
You can specify a period of time during which the document will print. If, for 
example, you have a long document to print, you can specify that it print during 
the evening. The hours you set must be within the hours the printer is available. 
For more information on setting hours for a printer, see "Setting Printing Hours," 
earlier in this chapter. 

t> To change printing hours for a document 

• In the Document Details dialog box, set the period of time during which 
the document will print in the Start Time and Until Time boxes. 

Administering Network Print Servers Remotely 
Print Manager allows you to administer network print servers remotely. You can 
change the properties of existing printers, as well as install new printers or remove 
printers. 

To administer a printer, you must be logged on as a member of the Administrators 
or Power Users group, and you must have been granted Full Control permission 
for the printer. 
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l> To install, remove, or change a printer remotely 

1. From the Printer menu, choose Server Viewer. 

r 'OK 

.computer: ..... I\_\S_E_T_T_ER ________ --' 

,S.elect Computer: 

2. In the Select Computer dialog box, double-click the name of a domain 
to display the servers in the domain. Choose the print server you want 
to administer, and choose the OK button. 

3. Print Manager displays a window that shows the printers on the server you 
have chosen. You can minimize server windows. 

To 

Install a new printer 

Remove a printer 

Change a printer 

Choose 

Create Printer from the Printer menu. You can then install 
the printer just as you would a local printer. 

Remove Printer from the Printer menu. 

Properties from the Printer menu. 



CHAPTER 7 

Mail 

The Mail electronic mail system helps you communicate efficiently with 
coworkers. This chapter provides an overview of the basic features of Mail for 
all users, and also provides information for the administrator who creates and 
manages the workgroup postoffice (WGPO). 

The following topics are presented in this chapter: 

• An overview of Mail 

• Using Mail 

• Setting up the Mail system 

• Managing the workgroup postoffice 

• Using Mail with other networks and other messaging systems 

Although this chapter will get you started using Mail, your main source of 
information is online Help. To get Help, press Fl wherever you are working 
in Mail. 

209 
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Overview 
With Mail, you can: 

• Send and receive electronic messages (e-mail). 

• Attach files created with other applications, such as spreadsheet and 
word-processing applications, to your messages. 

• Find messages in your mailbox according to criteria you specify. 

• Print messages, organize and store messages in folders. 

Before you can use Mail, an administrator must create a workgroup postoffice 
(WGPO), which contains all the information about Mail user accounts and serves 
as a collective mail drop facility for users. For information about how to create a 
WGPO, see "Setting Up the Mail System," later in this chapter. 

When you connect to your postoffice and sign in for the first time (as described 
in "Starting and Quitting Mail"), Mail creates a file named username.MMF in 
the directory where you installed Windows NT. Mail uses this file to store your 
messages, message folders, and Personal Address Book. The postoffice updates 
the file when it receives messages for you. Each Mail user in your workgroup 
has a message file, which is like a private mailbox. Each message file and the 
messages in it are protected by a password that only their owner knows. 

The first time you sign in, Mail displays the Inbox, showing your messages 
and folders. 

Deleted mail 
IC5lnbox 
CJ Inventory 
CJ Personnel 
CJ Scheduling 
CJ Sent mail 
CJ Suppliers 
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The Inbox displays message headers, which show who sent the message, the 
subject, and the date and time the message was received in your mailbox. If the 
sender specifies an urgent priority for the message, an exclamation point appears 
beside the message icon; a low-priority message appears with a down arrow; and 
a message that includes an attachment appears with a paper clip in the message 
icon. When you read a message, it appears in a Read Note form, as described in 
"Reading a Message," later in this chapter. 

You can use either the toolbar or menus to reply to messages, forward them 
to other Mail users, or print or delete them. You can move or copy messages to 
organize and store them in folders. You can also sort messages by priority, sender, 
subject, or date. If you want to keep a record of the messages you send to other 
people, you can automatically save copies in the Sent Mail folder. For more 
information about these activities, see "Using Mail," later in this chapter. 

In the message body, you can cut and paste text between messages and files. 
If you want to send formatted files, such as Microsoft Word or Microsoft Excel 
documents, you can attach them to a message. You can send as many attachments 
as you like with each message. For more information, see "Advanced Features of 
Mail," later in this chapter. 

Starting and Quitting Mail 
This section explains how to connect to a postoffice, sign in to Mail, change 
your password, and quit Mail. 

When you start Mail for the first time, you must create or connect to a postoffice 
and create an account for yourself in the postoffice if the administrator has not set 
up an account for you. 

If an existing Microsoft Mail postoffice has been assigned for your workgroup or 
if someone in your workgroup has already created a WGPO, you must connect to 
that postoffice. If you need to create a new postoffice, see "Creating a Workgroup 
Postoffice," later in this chapter. 

If you have already connected to a postoffice and created your account, 
see "Signing In to Mail," later in this section. 

Connecting to a Postoffice 
Before connecting to a postoffice, ask the administrator for the path to the post­
office, and verify that your computer has enough available disk space for your 
message file (username.MMF). The required disk space depends on the number 
and type of messages stored in your mailbox. A typical small mailbox requires 
about lOOK of disk space; a large mailbox might require several megabytes of 
disk space. 
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t> To connect to a postoffice 

1. From the Main group in Program Manager, choose the Mail icon . 

.Mkr9.~~ft 

~ 
Defore you can use Mail. you must either 
connect to an existing postoffice or create 
a new Workgroup Postoffice. 

Postoffice 5 election 

@ Connect to an existing postoffice 

o Create a new Workgroup Postoffice 

2. In the Welcome To Mail dialog box, select the Connect To An Existing 
Postoffice option button. 

3. In the Network Disk Resources dialog box, select the postoffice you want to 
connect to. In the Network Path box, type the path of the postoffice in the form 
\\computername\sharename; for example, type \\blake\wgpo. 

4. Choose the OK button: 

5. When Mail asks if you have an account on this postoffice, choose Yes if 
you already have an account. You will be asked for your password. 

Or choose No if you need to create an account. The Enter Your Account 
Details dialog box appears, so you can create your account, as explained in 
the following section. 

Creating an Account 
Mter you connect to a postoffice, you need to create an account. Before creating 
one, check that the administrator has not already created an account for you. 

t> To create an account 

• In the Enter Your Account Details dialog box, fill in the appropriate 
information, as described in the following tables. 



Mailbox: 

fassword: 

Phone HI: 

Phone HZ: 

!!.ffice: 

.Q.epartment: 

Noles: 

Item 
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1 Blake R ambach 

Iblaker 

1 PASSWORD 

11056 

1 Executive Staff 

OK 1/ I Cancel 

Description 

Required information to create an account: 

Name Type your full name, for example, Blake Rambach. The maximum 
length is 30 characters, and the default is the user name you entered 
when you installed Windows NT. 

Mailbox 

Password 

Type a unique name with which you will sign in to Mail. Choose 
a mailbox name that is easy to remember, for example, BLAKER. 
The maximum length is 10 characters, and the default is your 
Windows NT username. 

Type a password. You will use this password and your mailbox 
name to sign in to Mail. Choose a password that is easy to 
remember. The maximum length is 8 characters, and the default 
is PASSWORD. 

Optional information to create an account: 

Phone #1 Type your phone number. The maximum length is 32 characters. 

Phone #2 

Office 

Department 

Notes 

If you have two phone numbers or a phone number and a fax, type 
your second phone number. The maximum length is 32 characters. 

Type your office location, for example, 1056 to represent a room 
number. The maximum length is 32 characters. 

Type your department's name, for example, Executive staff. 
The maximum length is 32 characters. 

Type any comments about your account. The maximum length 
is 128 characters. 

After you create an account, Mail displays the Inbox, where your messages 
and folders appear, as shown earlier in this chapter. 
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Signing In to Mail 
When you create an account, you are signed in automatically. The next time you 
start Mail, you sign in by typing your mailbox name and password. You can also 
set up Mail to enter your mailbox name or name and password automatically 
when you start it. 

t> To sign in to Mail 

1. In the Main group in Program Manager, choose the Mail icon. 

2. In the Name box of the Sign In dialog box, type your mailbox name and 
then press TAB. 

The Postoffice Manager does not distinguish between uppercase and lowercase 
letters; "BLAKER," "BlakeR," and "blaker" are considered to be the same. 

3. In the Password box, type your password and then press ENTER. 

Mail displays your Inbox so that you can begin reading and sending messages, 
as described in "Using Mail," later in this chapter. 

t> To sign in to Mail automatically 

1. In the Main group in Program Manager, choose the Mail icon. 

2. From the File menu, choose Properties. 

3. To have Mail automatically enter your mailbox name, at the end of the 
path in the Command Line box, type a space and then your mailbox name. 
For example, type c:\winnt\msmail32.exe blaker. 

Or to have Mail automatically enter your mailbox name and password, at the 
end of the path in the Command Line box, type a space, your mailbox name, 
another space, and then your password. For example, type 
c:\winnt\msmail32.exe blaker secret 

Important If security is important in your workgroup, record only your mailbox 
name and not your password, so others cannot read your messages or send 
messages under your name. 

Changing Your Password 
For security, change your password regularly. If security is not a concern, you 
don't need to change it. If you forget your password, you must ask the postoffice 
administrator to define a new password for you. 
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r> To change your password 

1. From the Mail menu, choose Change Password. 

2. Type your old password, and then press TAB. 

For security, you do not see the characters as you type them. 

3. Type your new password, and then press TAB. 

4. To verify the new password, type it again exactly the same way, and then 
press ENTER. 

Password verification distinguishes between uppercase and lowercase 
letters. "BLAKER," "BlakeR," and "blaker" are not considered the same. If 
your second attempt to type the new password does not match the first, the 
computer beeps; start over with a new password and then verify it. 

Y our new password is registered. You must use it the next time you sign 
in to Mail. 

Quitting Mail 
There are two commands on the File menu you can use to quit Mail: Exit and 
Exit And Sign Out. If Mail is the only application you are running that requires 
you to sign in to your mailbox, both of these commands close Mail and sign 
you out. 

If you are running another application, such as Schedule+, that uses Mail to 
communicate with your workgroup, the Exit command does not sign you out. 
This allows the other application to continue using the postoffice when Mail is 
closed. If you restart Mail, you don't need to sign in. 

The Exit And Sign Out command closes Mail and signs you out. This command 
also closes any other application using Mail that might be running. If you restart 
Mail, you will need to sign in again. 

When you quit Mail, by default Mail permanently deletes all the messages in the 
Deleted Mail folder. If you don't want the messages in this folder deleted when 
you quit Mail, turn off this option. 

r> To preserve deleted mail 

1. From the Mail menu, choose Options. 

2. Under Other, clear the Empty Deleted Mail When Exiting check box. 

r> To quit Mail and sign out 

• From the File menu, choose Exit And Sign Out. 
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t> To quit Mail and remain signed in 

USing Mail 

• From the File menu, choose Exit. 

If other applications that use Mail are not running, the Exit command also 
signs you out. 

This section covers the basic steps for sending, reading, replying to, and 
deleting messages. 

Some advanced features of Mail are described at the end of this section. 

Sending a Message 
Sending a message involves a few simple steps: addressing it, typing a subject 
and message, and then sending it. 

Addressing a Message 
The first step in sending a message is to open a Send Note form and choose the 
users to whom you want!~ sel1d th~,_message.: 

t> To address a message 

1. Choose the Compose button, or from the Mail menu, choose Compose Note. 

A Send Note form appears. 

'~end IlChec1 Names II 8tta6h II Opljons II A£:jdiess 

1Q: 

~c: 

Subiect:1 

3me??agel>: 2 unread 
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2. Choose the Address button. 

Mail displays the Address Book, which contains the names of users on your 
postoffice. 

For information about using the buttons in the Address Book and about using 
shortcut keys, see the table following this procedure. 

i Directory: Posloffice list 
llml .. ; ... ll;.';;..;.:.U::.;:.t:.:.::2J:0.:. ..... , ...... ""' .. " .. M .... _ ... ~m.''' ...... ""''' ... " ......... " ......... ~ 
!. I £!:'ill Andy MacKay I-
; E:EP Bob Andrews 
, Bonita Gonzalez 
j I ~ I Bruce Bergstrom 

! I D I ~~~hn~~nLea~~" 
j Design Group I Gertrude Chorel 

Add: I To II Cc '@ II Details I 
To: 

Cc: 

r--~~=OK==~II=c=a=nc=el~I~I=_=He=IP~==~j 
3. To locate usernames in the address list: 

• Type the first few characters of a name. The address list scrolls to the first 
name in the list with those characters and selects it. This is the fastest way 
to find a name. 

• Or use the scroll arrows in the scroll bar. 

• Or press the arrow keys to scroll through the list. 

4. To select a name that is highlighted in the list, choose the To button or press 
ENTER. 

The selected username is added to the To box. 

5. To add names to the Cc list, repeat the steps for locating and selecting names, 
and then choose the Cc button or press ENTER. 

6. Choose the OK button. 

The display shows the Send Note form with the selected name entered in the 
To box. If you select a name from the Address Book, the name is underlined in 
the Send Note form. The underline indicates that Mail verified the name in the 
postoffice. 
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Button Shortcut key Use 

CTRL+L 

CfRL+P 

CTRL+F 

CfRL+N 
CTRL+A 

The Directory button to select a user directory from the 
list of available directories for postoffices and gateways 
on your network. 

The Personal Address Book button to display names and 
groups in your Personal Address Book. 

The Find button to find a name or first part of a name in 
the current user directory. 

The New Address button to add a new name and address 
to your Personal Address Book or to address a message to 
another mail system. You can add a gateway address plus 
the name and address of a user on another mail postoffice. 

You can copy the names of people to whom you often send messages from the 
Postoffice List into your own Personal Address Book. If you often send messages 
to the same group of people, you can choose Personal Groups from the Mail menu 
to create a personal group name for them. When you include that group name on a 
message's recipient list, all the individuals in the group receive the message. 

You can also address mail to users on another mail system if a gateway has 
been added to your Mail network. A gateway is software that enables direct mail 
systems to communicate with each· other. When a message is sent from one mail 
system to another, the gateway filters out information specific to the originating 
mail system, attaches information the second mail system needs to deliver the 
message, and sends the message on its way. If a gateway has been added to your 
Mail network, its name appears in the Address Book. 

Typing and Sending a Message 
The next step is to type the subject and message text. 

t> To type a message subject and a message 

1. In the Send Note form, click the Subject box, or press TAB until the insertion 
point is in the Subject box, and then type a short description of the message. 

If you make a mistake while typing, press the BACKSPACE key to erase the 
error, and then continue typing. 

2. Click anywhere in the message body, or press TAB, and then type the message 
you want to send. 

If the text reaches the right margin of the form, the next word automatically 
moves to the next line; you don't need to press ENTER at the end of each line. 

The last step is to send the message. 
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r> To send a message 

1. If you want to set options for the message you are sending, choose the 
Options button in the toolbar, and then select the options you want to set. 

D l1i.~'f~,~,~''','~'~,~'~,~'p',~ 
[8:J ~aye sent messages 

Prioritl',-------. 

o High 
@Hormal 

O!:.ow 

OK 

Cancel 

. HeiR 

2. In the Send Note form, choose the Send button. 

For more information about the Options dialog box, see online Help. 

Reading a Message 
The message header in your Inbox displays information about the message, 
including who the message is from and the date and time it was received. If you 
hayen't r,ead a ~~w mes~age, Mail ~isplays a closed-envelope symbol and displays 
the message header in bold. 

Private Folders 
D Deleted mail 
fC5lnbox 
D Inventory 
D Personnel 
D Scheduling 
DSentmail 
D Suppliers 

Outbox 

Bill O'Daly 
8 Cristol Weber Vacation request 5/17/9310:1 DAM 

Sent mail 

3 messages: 2 unread 
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~ To read a message 

• Double-click the message in the Inbox. Or press TAB to move the highlight 
from the Folders list to the message list; use the arrow keys to highlight the 
message, and then press ENTER. 

The message appears in a Read Note form. 

1-...;...;..;---,--,---"';"';";-"-"';"';";"';"';";-1--+1- Message 

Attached is the dr ft of the annual company report. Please review it and return 
your comments to e by next Friday. 

Attached file 

heading 

The gray area at the top of the form is the message heading, which shows who 
sent the message, when it was received, the people or groups it was sent to, and 
the message subject. 

Attached files appear in messages as icons. An attached file can contain any kind 
of data, including text, graphics, a spreadsheet, executable code, and so on. If you 
have the application used to create an attached data file, you can open the file 
while reading the message by double-clicking the icon. 

Note To avoid introducing a computer virus, you should use the same care when 
opening or activating an attached file or object in a message that you do when 
opening or activating a file or object from the network or a floppy disk. 
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Replying to a Message 
After reading a message, you may want to send a reply. The Reply button or 
command automatically addresses the message to the person who sent it and 
includes the original message in the message body. Including the original message 
is useful because you can add comments above or within the original message. 

1> To reply to a message 

1. Choose the Reply button, or from the Mail menu, choose Reply. 

If you want to reply to everyone who received the original message, choose 
the Reply All button. 

A Send Note form appears. The name of the original sender appears in the To 
box, and the title of the original message appears in the Subject box, preceded 
by the prefix RE: (for "reply"). The original message is included in the form, 
below the solid line. 

2. At the top of the message box, type your reply. 

3. If you want to insert comments within the message you received, use the 
arrow keys to move the insertion point to where you want to enter a comment. 
Press ENTER to start a new line after the original message, and then type the 
comment you want to insert. 

4. Choose the Send button. 

1.0: I Bill O'De!v 

kC: 

Subiect: I RE: Draft company report 

Thanks for preparing this so quickly!1 

From: Bill O'Daly 
To: Annie Pearson 
Cc: Blake Rambach 
Subject: Draft company report 
Date: Monday, May 17,199311 :01AM 

«File Attachment: coreport.doc» 
+ 

1 message I 1:06PM 
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Deleting a Message 
To manage the number of messages in your Inbox, you should delete messages 
you've already read and no longer need. 

~ To delete a message from the Inbox 

1. In the Inbox, select the message you want to delete. 

2. Choose the Delete button, or from the File menu, choose Delete. 

The message is moved to the Deleted Mail folder, whe're you can retrieve it 
until it is deleted there. By default, Mail deletes messages in the Deleted Mail 
folder when you quit Mail. To change this option, choose Options from the 
Mail menu. 

Advanced Features of Mail 
This section presents some advanced features of Mail. Use Help to find more 
details. 

Attaching Files and Embedding Objects 
You can choose the Attach button from the toolbar to send one or more 
application files, such as Microsoft Word or' Microsoft Excel documents, or batch 
files, programs, graphics files, or any other files that are available to you. 

Mail displays the Attach dialog box, where you can select a file to attach in the 
same way that you select a filename in the Open or Save As dialog boxes. 

Mail also includes object linking and embedding (OLE) capability, so you can 
copy parts of formatted documents from other applications, such as spreadsheets 
and word processing, into a message without losing formatting. You embed or 
iink an object in a Mail message in the same ways as you do in any application 
with OLE capabilities. For information, see Chapter 10, "Object Linking and 
Embedding." 
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Creating Message Templates 
If yo~ send a specific message on a regular basis, such as a weekly progress 
report, you can set up a Send Note template for the message and basic addresses. 

t> To create a message template 

1. Choose the Compose button on the toolbar, or from the Mail menu, 
choose Compose Note. 

2. Address the message to the people you will be sending it to regularly, 
and type the subject and template information. 

3. Close the message window by double-clicking the Send Note window's 
close box or by pressing CTRL+F4. 

4. When Mail asks if you want to save the message, choose the Yes button. 

Mail displays the template message in your Inbox, but you can move this 
message to any folder. 

t> To use a message template 

1. Display the message template by doing one of the following: 

• Drag the message header to the Outbox icon. 

• Or select the message, and from the Mail menu, choose Forward. 

2. Fill in the message. If necessary, change the list of recipients. 

3. Choose the Send button. 

Finding Messages 
You can choose Message Finder from the File menu to search for messages you 
stored in Mail folders. You can also keep multiple Message Finder windows 
minimized on the Mail workspace, each with its own search criteria. Then, when 
you want to search for a message with the criteria, maximize the icon. 

From: 

Subject: I company reportj 

Re£.ipients: :=1 =============~ 
Message Iext:1 

I Where 10 hook ... 
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Using Folders 
Mail stores your private messages in folders that you create and manage using 
the New Folder and Folder Properties commands from the File menu. Your 
private messages are stored on your hard disk. Shared folders are stored in your 
postoffice and can be accessed by other users in your postoffice. 

Harne: 

II 

Level---------, 

o LOP Level Folder 
@ Su.!!folder Of: 

IOth~r,U sers c~~ ... 
LD, .. D ... ·, .. ' .. Dr 

kornrnent: 

Working Offline 

Help 

You may want to create new messages or work with messages you received 
without being connected to the postoffice (for example, while you are traveling or 
working at home). If you have Mail installed on your computer, you can compose 
and work with messages without being connected to the postoffice. This is called 
working offline. 

r> To move your message file to a computer or disk from your postoffice 

1. From the Mail menu, choose Options. 

2. In the Options dialog box, choose the Server button. 

3. In the Storage box, select the Local option button. 

4. In the File box, type the path to the drive or directory where you want 
to save your message file, and then choose the OK button. 
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r> To work offline 

1. Start Mail on a computer that is not connected to the postoffice. 

2. In the message that asks if you want to work offline, choose the OK button. 

3. Type your password in the dialog box, and then choose the OK button. 

4. If Mail cannot find your message file, specify the path to it. 

After you finish composing a message, choose the Send button. The message 
is moved to the Outbox. To move it to the postoffice when you resume working 
online, follow the procedure above for copying your message file to a computer 
or disk, but choose the Postoffice option instead of the Local option. When you 
connect to the Mail system, the messages in your Outbox are sent automatically. 

Defining Other Mail Options 
You can choose the Options command from the Mail menu to define various 
preferences for sending mail, checking for new mail, choosing the server, and 
emptying the Deleted Mail folder. For more information, see Help. 

Sending---------------, 
r8J ~ave copy of outgoing messages in Sent Mail folder 

r8J Add recipients to eersonal Address Book 

New Mail---------------, 
Check for new mail every ~ minutes 
When new mail arrives: 

r8J S oun!! chime 

r8J [lash envelope 

Other---------------, 
r8J f.mpty Deleted Mail folder when exiting 
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Setting Up the Mail System 
The following sections explain the concepts and procedures related to setting up 
and administering Mail in Windows NT and using Mail with other networks and 
other messaging systems. The rest of this chapter is written for the administrator 
who is responsible for creating and managing the workgroup postoffice (WGPO). 

Planning a Workgroup Postoffice 
Before your workgroup can use Mail, each user needs to connect to a postoffice. 
If your workgroup does not have an existing postoffice, an administrator in your 
workgroup needs to create and manage a WGPO using the Postoffice Manager. 

This section describes the Mail messaging system and the workgroup postoffice 
to help you plan your WGPO. 

The Mail Messaging System 
The Windows NT messaging system consists of the Mail application and the 
WGPO. The Mail application runs on each user's computer, and the WGPO 
is stored in a shared directory on a computer running Windows NT. 

If your company already has a messaging system, you can use the Mail 
application with the postoffice or messaging (mail) server that is part of that 
system. For information, see "Using Mail with Other Messaging Systems," later 
in this chapter. 

The WGPO contains all the information about Mail user accounts and serves as a 
collective mail-drop facility for users in your workgroup. To communicate, users 
must be connected to the same postoffice and have an account on that postoffice. 

The following figure shows three users in a workgroup with a WGPO. Bill, Blake, 
and Cristal belong to a workgroup called Engineering. To allow users in the 
Engineering workgroup to use Mail, Bill created a WGPO on his computer and 
accounts for himself, Blake, and Crista!. Because he created the WGPO, he will 
be its administrator. Bill, Blake, and Cristal use their respective computers to run 
Mail, and their message files are stored on their computers as well. They can now 
use Mail to send messages and files to each other. 



Blake 

Postoffice 

Engineering 
Workgroup 
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Two users connected to different WGPOs cannot exchange messages. 

The following figure shows a new workgroup that includes the original 
Engineering workgroup and three new users from Marketing, Ernest, Chris, 
and Peggy. Ernest created another WGPO on his computer, and he created 
accounts for himself, Chris, and Peggy. In this configuration, Bill, Blake, and 
Cristal can communicate with each other. Similarly, Ernest, Chris, and Peggy 
can communicate. However, Ernest, Chris, and Peggy cannot communicate 
with Bill, Blake, and Cristal because they are not connected to the same 
postoffice. 

If Ernest deletes his postoffice and Bill creates accounts for Ernest, Peggy, 
and Chris on his postoffice, all six can communicate with each other. 
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Postoffice 

Engineering-Marketing 
Workgroup 

Blake 

You can create a WGPO on a computer that is part of your workgroup, on 
a Windows NT Advanced Server, or on an existing network such as Novell 
NetWare. 

Creating a Workgroup Postoffice 
This section explains how to create a workgroup postoffice (WGPO). The person 
who creates the WGPO should plan to manage it. Creating the WGPO requires 
that you complete the following actions: 

• Verify that there is enough disk space on the computer where you will 
install it. 

• Create the WGPO and an account for the administrator. 

• Share the WGPO so that all users in your workgroup can use it. 



Chapter 7 Mail 229 

Planning for Disk Space 
Before creating a WGPO, verify that your computer meets the following 
requirements. 

On the computer where the WGPO will be installed, there must be: 

• 360K of available disk space for an empty postoffice. 

• 16K of available disk space for each user account. 

On each user's computer, there must be: 

• Enough available disk space for each user's mailbox, depending on the 
number and type of messages stored in a mailbox. A typical small mailbox 
requires about lOOK of disk space; a large mailbox can use several megabytes 
of disk space. 

Creating the Postoffice and the Administrator Account 
Mter you verify that the computer has enough disk space to create a WGPO, you 
can create a WGPO and an Administrator account. The Administrator account is 
the first account you create in the WGPO. Mter you create the Administrator 
account, you can modify it, but you cannot remove it. 

This section describes how to create the WGPO on a Windows NT workstation 
or Advanced Server. If you want to create the WGPO on a network server, see 
"Using Mail with Other Networks and Other Messaging Systems," later in this 
chapter. 

Important The computer where you create a WGPO must be turned on at all 
times so that users can exchange mail. 

You should create only one WGPO per workgroup. Only the users connected to 
the same WGPO can communicate with each other. 

t> To create a WGPO and the Administrator account 

1. S tart Mail. 

If a WGPO has not been assigned to your workgroup, Mail starts the 
Workgroup Postoffice Manager and displays the Welcome To Mail dialog 
box, as described in "Connecting to a Postoffice," earlier in this chapter. 

2. In the Welcome To Mail dialog box, select the Create A New Workgroup 
Postoffice option button, and then choose the OK button. 

A message reminds you that there should be only one WGPO in a workgroup 
and that you will be responsible for managing any new WGPO you create. 
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3. To create a new postoffice, choose the Yes button. 

Or choose No to return to the Welcome To Mail dialog box so that you can 
connect to an existing postoffice. 

4. In the Create Workgroup Postoffice dialog box, select a location for the 
wapo. You can create the wapo either on your hard drive or on a network 
server: 

• To create the wapo on your hard drive, select a drive from the Drives box 
and a directory from the Create wapo In list, and then choose the OK 
button. 

• To create the wapo on a network server, choose the Network button, and 
select a server and shared directory from the dialog box. Then choose the 
OK button. 

c: \ sharedir 

~ c:\ sharedir 
CJ wgpo 
CJ documents 

Driyes: 

lIS c: main I!J 

5. In the Administrator Account Details dialog box, fill in the appropriate 
information to create the Administrator account. 

The requirements and optional information in this dialog box are the same 
as those described in "Creating an Account," earlier in this chapter. 

, When you fill in this dialog box, type names that are easy to read. You can use 
extended characters (such as letters with accents), but it is not recommended. 
Only alphanumeric characters are allowed in the Mailbox and Password boxes. 
The Postoffice Manager is not case-sensitive; that is, "BLAKER," "BlakeR," 
and "blaker" are considered to be the same. 

6. Choose the OK button. 

When the message reminds you to share the wapo directory that you just 
created, choose the OK button. 
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Important If you are not able to create a WGPO, it is probably because you don't 
have enough disk space or, if you are creating the WGPO on a sen:er, because 
you don't have write permission on that server. In either case, the solution is to 
find another location with enough disk space and where you have sufficient 
privileges to create the WGPO. 

Sharing the Workgroup Postoffice 
Mter you create a WGPO, you must share the WGPO directory that contains 
the data files with all users on the postoffice. 

t> To share a workgroup postoffice on a Windows NT Workstation 

1. Open File Manager and select the WGPO directory. 

2. From File Manager's Disk menu, choose Share As. 

3. In the Share Name box, type a name for the postoffice. The default name 
is WGPO. 

4. If you want to, you can enter a comment in the Comment box. This comment 
appears in the shares list Connect Network Drive dialog box. 

5. In the User Limit box, set a limit on the number of users who can connect 
to the shared directory at the same time. 

By default, no limit is set. 

6. Choose the Permissions button and give all members of the postoffice Full 
Control access to the WGPO share. 

For information on setting permissions, see "Setting Permissions Through 
Shared Directories" in Chapter 4, "File Manager," or press Fi while the 
Access Through Share Permissions dialog box is displayed. 

7. In the New Share dialog box, choose the OK button. 

In the File Manager window, the WGPO directory is shown as a shared 
directory. 

t> To share a WGPO on a Windows NT Advanced Server 

1. Create a directory on the Windows NT Advanced Server where the WGPO 
will be located. This can be a domain controller or backup server. 

2. Share the directory you just created. Make sure you don't share the parent 
directory. 

3. Provide full access permissions to the directory. 

4. Create a WGPO as explained in "Creating a Workgroup Postoffice," earlier 
in this chapter. 
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Mter you create a WGPO, the Postoffice Manager command appears on the Mail 
menu when you start Mail. This command appears only on the computer where 
you create the WGPO. 

Managing Your Workgroup Postoffice 
Mter you create a WGPO and an Administrator account, you can manage the 
WGPO with the Postoffice Manager. 

With the Postoffice Manager, you can complete the following actions: 

• Add users to the WGPO 

• Modify existing user accounts 

• Remove users from the WGPO 

• Manage the disk space where the WGPO is stored 

You may also need to change the name of the WGPO, move or remove a WGPO, 
or manage the Mail system files, as described in this section. 

Starting the Postoffice Manager 
Before you can start the Postoffice Manager, you must start Mail. 

t> To start the Postofflce Manager 

• From the Mail menu, choose Postoffice Manager. 

In the Postoffice Manager dialog box, you can add users, modify user 
accounts, and remove users. 
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Adding a User 
To add a user to a WGPO, you must provide the user's name, mailbox name, 
and password. Optionally, you can also provide the user's phone number(s), 
office location, department, and comments about the user's account. 

Note Users can create their own WGPO account. If you create user accounts, 
be sure to give the necessary account information to the users. 

1> To add a user 

1. From the Mail menu, choose Postoffice Manager. 

2. From the Postoffice Manager dialog box, choose the Add User button. 

3. In the Add User dialog box, fill in the appropriate information, and then 
choose the OK button. 

For a complete description of the entries in the Add User dialog box, 
see "Creating an Account," earlier in this chapter. 

Modifying a User Account 
With the Postoffice Manager, you can modify any information about the user's 
account. 

1> To modify a user account 

1. From the Mail menu, choose Postoffice Manager. 

2. From the Postoffice Manager dialog box, select the username you want to 
modify. . 

3. Choose the Details button. 

A dialog box appears, showing the user's account information, which is 
identical to the information defined in "Creating an Account," earlier in 
this chapter. 

4. Change the appropriate entries, and then choose the OK button. 
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Removing a User 
With the Postoffice Manager, you can remove a user from a WGPO. 

Note You cannot remove the Administrator account. 

l> To remove a user 

1. From the Mail menu, choose Postoffice Manager. 

2. From the Postoffice Manager dialog box, select the username you want to 
remove. 

3. Choose the Remove User button. 

When the message asks you to confirm that you want to remove the selected 
username, choose the Yes button. 

Managing Disk Space 
One of the most important administrative tasks is managing the disk space where 
the WGPO is stored. To manage disk space, you need to check the current status 
of shared folders and recover unused disk space by compressing shared folders. 

A shared folder is a public folder stored in the WGPO directory, unlike users' 
private folders, which are stored on their own computers. All users in a 
workgroup can open shared folders and see the messages they contain. Any user 
in the WGPO can create a shared folder and choose the appropriate access 
permissions (Read, Write, or Delete). 

By checking the status of shared folders, you determine the following: 

• The number of shared folders 

• The number of messages stored in shared folders 

• The amount of disk space the messages use 

• The amount of disk space you can recover by compressing shared folders 
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I> To check the status of shared folders 

1. From the Mail menu, choose Postoffice Manager. 

2. From the Postoffice Manager dialog box, choose the Shared Folders button. 

The Shared Folders dialog box shows the current status of shared folders 
in a WGPO. 

Current Status of Shared Folders---------, 

Number of folders: 0 

Total messages in folders: 0 

Bytes used by messages: 0 

Recover able bytes in folders: 0 

Compressing shared folders recovers disk space. When the Mail system runs out 
of disk space, this is the first step to take. If you still require more space, you can 
delete old messages and unused folders. You might also need to move the WGPO 
to a different location (see "Moving a Workgroup Postoffice," later in this 
chapter). 

If the shared folders contain a large number of messages, the compression process 
may take a long time. 

Important Do not attempt to compress shared folders while others are using them. 

I> To compress shared folders 

1. Before compressing a shared folder, ask all users in a workgroup to close 
the folder. 

2. From the Mail menu, choose Postoffice Manager. 

3. From the Postoffice Manager dialog box, choose the Shared Folders button. 

4. In the Shared Folders dialog box, choose the Compress button. 

S. Choose the Close button. 
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Managing the Mail System Files 
When you create a WGPO or when users connect to a postoffice, the Mail system 
files are modified. For each user, Mail creates a message file, username.MMF. 
This file stores messages, message folders, and the Personal Address Book for the 
user. The WGPO updates this file when it receives messages. The message file for 
each user is stored on his or her computer. Your message file is located in the 
directory where Windows NT was installed (the default is C:\WINNT). 

The Mail system files are automatically managed by Mail, so you shouldn't need 
to alter them unless you want to change specific functionality or you want to 
restore these files to·a particular state. 

The following sections describe how these files are modified when you create a 
WGPO and when a user connects to a WGPO. They also describe how to back up 
and restore the Mail system files. 

When you create a WGPO, the Postoffice Manager makes the following changes 
to the system files for the Administrator account: 

• The WGPO directory is created in the specified location. 

• A message file is created for the Administrator account, with the default name 
of username.MMF. 

Backing Up and Restoring the Mail System Files' 
When a user connects to a WGPO, a message file is created for the user, with the 
default name of username.MMF. Mail automatically manages this file for each 
user. In general, you don't need to alter the Mail system files; however, you might 
want to restore them to a given state. 

You should back up the Mail system files regularly. Then, if there is a problem, 
you can recover your mail and the Mail environment from the last backup copy. 
The following procedures explain how to back up and restore your 
username.MMF file and restore all folders in your mailbox. 

If you want to back up or restore only some of the folders in your mailbox, use the 
Export Folder and Import Folder commands. For information about using Export 
and Import, see Help. 

J> To back up your username.MMF file 

1. From the Mail menu, choose Backup. 

2. In the File Name box, specify the name and location of your backup file; 
for example, C:\USER\BILL.MMF. 

3. Choose the OK button. 
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t> To restore an username.MMF file 

1. Open File Manager and select the backup copy of your message file. 

2. From the File menu, choose Rename. 

3. In the To box, type c:\WINNT\username.MMF (assuming that, by default, 
you installed Mail in the same directory that contains your Windows NT files). 

4. Choose the OK button. 

The backup file becomes your message file, and your mailbox displays the 
messages and folders you had when you last backed up the file. New messages 
that you received after you backed up the message file do not appear in your 
Inbox. 

Important If a message file becomes corrupted, a message appears with this 
information and also presents an option to repair the file. The user or the 
administrator for the postoffice can repair the file immediately or quit Mail 
and repair it later. However, the user cannot use Mail until the corrupted file 
is repaired. 

Restoring a User's Password 
If a user forgets a password, the administrator for the postoffice can define 
a new password. 

t> To define a new password for a user 

1. Sign in to Mail and start the Postoffice Manager. 

2. In the Postoffice Manager dialog box, select the name of the user, 
and then choose the Details button. 

3. In the Password box, type a new password, and then choose the OK button. 

4. In the Postoffice Manager dialog box, choose the Close button. 

The user can now sign in to Mail with the new password. 

Caution If the administrator for the postoffice forgets the password, that 
password cannot be recovered. The administrator must create a new WGPO. 
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Using Mail with Other Networks and Other Messaging Systems 
You can also create a workgroup postoffice on a file server that is part of an 
existing network, such as a Novell NetWare server. 

If you want to use Mail with another network, you need to ~et up support for 
that network in Windows NT, using the Control Panel. For information about 
the necessary drivers and any further instructions, contact your network vendor. 

Using Mail with a NetWare Network 
To use Mail with a Novell NetWare network, you need to create a WGPO on 
a NetWare server and grant full trustee rights to the WGPO directory. 

J> To create a WGPO on a NetWare server 

1. Create a directory on the NetWare server where the WGPO will be located. 

2. Grant full trustee rights to this directory. 

3. Use the Control Panel to set up NetWare support in Windows NT, as described 
in "Configuring the Network" in Chapter 5, "Control Panel." 

4. Restart Windows NT. 

5. Log on to your NetWare server. 

6. Use File Manager to assign a drive letter to the NetWare directory where 
you want to create the WGPO. 

7. Create the WGPO as explained in "Creating a Workgroup Postoffice," 
earlier in this chapter. 
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CHAPTER 8 

Schedule+ 

Schedule+ is a personal scheduling tool that you can use to track important 
appointments and tasks, block out time for meetings, and record notes. 

This chapter describes the basic features and how to use Schedule+ in the 
following topics: 

• An overview of Schedule+ 

• Using the Appointment Book 

• Using the Task list 

• Using the Planner to schedule a meeting 

• U sing the Messages window to schedule a meeting 

• Advanced features of Schedule+ 

Although this chapter contains the basic information you need to use Schedule+, 
your main source of information is the online Help. To get help, press Fl wherever 
you are working in Schedule+. 



240 System Guide 

Overview 
Schedule+, which you can choose to install on your system when you install 
Windows NT, can be used to schedule individual events and tasks, and to set 
automatic reminders for events. 

Schedule+ can also be used as a workgroup scheduling tool. When you need to 
meet with coworkers, you can view the times they are available. Then you can 
schedule the meeting in one step-without leaving your desk or contacting each 
person individually. 

You can also designate another Schedule+ user as your assistant, who can 
schedule appointments and set up meetings for you. 

A scheduling tool is most effective when it's always accessible for reference and 
for recording impromptu appointments. With Schedule+, you can print copies of 
your schedule, and you can use Schedule+ from a portable or home computer that 
has the software installed. 

In Schedule+, you can work online or offline, and then merge your changes into 
the copy of your schedule ori the postoffice later. For more'information, see 
"Advanced Features of Schedule+," later in this chapter. 

Starting and QuittingSchedule+ 
You use your mailbox name and password to sign in to Schedule+. (If you are 
already signed in to Mail, you won't be prompted to sign in.) 

I> To start Schedule+ and sign in R 1. From the Main group in the Program Manager, choose the Schedule+ icon. 

2. In the Name box of the Sign In dialog box, type your mailbox name and 
press TAB. 

3. In the Password box, type your password for Mail, and then press ENTER. 

When you're finished working with Schedule+, you can either quit Schedule+ 
or quit and sign out. 
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I> To quit Schedule+ and keep running Mail and Reminders 

• From the File menu, choose Exit. 

Choose this method to quit if you want to continue using Mail or receiving 
reminders while you aren't working with Schedule+. You can restart Mail 
without signing in. 

I> To quit Schedule+, Mail, and Reminders 

• From the File menu, choose Exit And Sign Out. 

Choose this method to quit if you're finished working with Schedule+, Mail, 
and the Reminders program (MSRMND32.EXE), which tracks reminders you 
set and notifies you in advance of these events. The next time you start 
Schedule+, the Reminders program starts automatically. (If any reminders 
were set to occur when Reminders wasn't running, they are not displayed 
when you start Schedule+.) 

Organizing Your Screen 
Organizing the workday requires two types of tasks: scheduling events and 
communicating with coworkers about scheduled events. Schedule+ provides 
a window for each type of task: 

• The Schedule window. This window has your name on the title bar and tabs 
on the left side for your Appointment Book (Appts), Planner, and Task list 
(Tasks). When you want to work with your appointments or tasks, schedule 
meetings with others, or schedule a conference room or other resource, you 
work in the Schedule window. 

• The Messages window (if your computer is connected to your postoffice). 
When you receive meeting requests or replies to your meeting requests, 
the messages appear in this window. 
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I> To display the Schedule window 

• From the Window menu in Schedule+, choose your name. 

.Edit Appointments Tasks Qptions 

Annie Pearson 

In this example, the Messages 
window is represented as an icon. 

I> To display the Messages window 

The Schedule window is where you 
schedule events, tasks, or resources . 

• From the Window menu, choose Messages. Or double-click the Messages icon 
to restore the window. 

For more information about the Messages window, see "Using the Messages 
Window to Schedule Meetings," later in this chapter. 
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Using the ApPointment Book 
The Appointment Book displays your daily schedule. A time slot can contain a 
combination of appointments and tentative appointments. Appointments appear as 
"busy" times on your schedule when other users view it. Tentative appointments 
appear in gray time slots in the Appointment Book and don't appear as busy times 
on your schedule. 

Time slots Appointments 

Hotes: 

Order new equipment 

Pick up packag~ 

Tentative 
appointments 

Notes box 

If you have an appointment that occurs regularly, you can schedule it once in 
your Appointment Book and designate it as recurring. Schedule+ automatically 
schedules the remaining occurrences in your Appointment Book. 

You can also set Schedule+ to remind you before specific appointments or before 
all appointments, and you can designate specific appointments to be private so 
that other users can see that you are not available during that time, but they cannot 
see the description of your appointment. Schedule+ puts icons in time slots 
containing recurring appointments, meetings, private appointments, or 
appointments with reminders. 

You can change the date you're viewing by choosing a new one in the calendar 
next to your appointments, and you can quickly return to today's date by choosing 
the Today tab on the left. You can also leave yourself notes for any day by typing 
them in the Notes box for that day. 
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Adding an Appointment 
You can add up to six appointments and tentative appointments for a particular 
time slot. You can also set options to control which users (if any) can view your 
appointments from their Appointment Book. 

t> To add an appointment to your Appointment Book 

1. If your Appointment Book is not already displayed, click the Appts tab. 

To maximize the Schedule window, double-click the title bar or press ALT, 

HYPHEN, x. To restore your Schedule window to its original size, double-click 
the title bar again or press ALT, HYPHEN, R. 

2. If you need to change the date, from the Edit menu, choose Go To Date. In the 
Go To Date dialog box, type the new number for the month, day, and year 
over the existing numbers. Then choose the OK button or press ENTER. 

Or click the month box in the top right corner of the Appointment Book to 
display a menu, and then click the month you want. Then click the year box to 
display a menu, and then click the year you want. Or finally, in the calendar, 
click a number to change the date. "., " .. 

The status bar at the bottom of the Schedule+ workspace displays the selected 
time slot. 

3. To select the appointment time, click in the box corresponding to the starting 
time, and then drag the mouse to block out the entire meeting time. 

Or press SHIff + TAB to move the selection to the appointment list, if it is 
not already there. Press the DOWN ARROW until the time slot you want is 
highlighted, and then press SHIFf+DOWN ARROW to include all the time 
slots you want in the selection. 

4. In the selected time slot, type text to describe the appointment. 
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~ To set a reminder for the appointment 

1. Double-click the time slot for the appointment. Or select it and then, from 
the Edit menu, choose Edit Appt. 

When I" 
~tart: I 9: OOAM f$i I Fri 12111 J 92 f$i I Choose .TimtETI . !lK 

f.nd: I 9: 30 AM f$i I F ri 12 J 11 J 92 f$i 0 T entatiye I Cancel 

!!.escription: It', !nvite~~~1 
I~S-ta-tU-S~-le-e-tin-g------------------------~~-'~ 

[SJ t$.·.~I.ii~·~I~.~~~.~~.J~·!][illlminute(s) If I Beforehand 

o f,rivate 

2. In the Appointment dialog box, select the Set Reminder For check box. 

Schedule+ automatically enters 15 minutes for you, but you can specify 
a different amount of time. 

You can also change the text in the Description box of the Appointment 
dialog box. The change will appear in your Appointment Book. 

3. To return to the Appointment Book, choose the OK button. 

A small bell icon appears in the time slot of the appointment in the 
Appointment Book, indicating that you set a reminder. 

10:00 

This bell icon shows that 
a reminder was set. 

You can choose General Options from the Options menu to specify whether 
Schedule+ automatically sets reminders for all new appointments and tasks. 
When you remove the reminder option, you must specifically set reminders 
for any appointments and tasks you want to be reminded of. 
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Adding a Tentative Appointment 
When you add an appointment to the Appointment Book, that time is blocked out 
in your Planner. When other people view your Planner to set up a meeting, they 
know that you're not available at that time. Sometimes, though, you might want to 
schedule an event in your Appointment Book but still leave yourself available for 
appointments during that time slot. For these times, you can add a tentative 
appointment to your Appointment Book. 

Tentative appointments appear in gray time slots in your Appointment Book, and 
they do not appear in your Planner. When other people look at your schedule, you 
appear to be available for meetings during that time slot. 

I> To add a tentative appointment 

1. In your Appointment Book, select the time slot you want. 

2. Type text to describe the tentative appointment. 

3. Double-click the time slot. Or from the Edit menu, choose Edit Appt. 

4. In the Appointment dialog box, select the Tentative check box, and then 
choose the OK button. 

Your Appointment Book now displays the tentative appointment in a gray time 
slot. When you or other viewers look at your Planner, you don't see the tentative 
time slot marked as busy, so it appears that you are available for meetings during 
this time. Except for being "invisible" in your Planner, tentative appointments are 
just like regular appointments-you can set the same options for either type. 

If you decide later to make this tentative appointment a regular appointment, 
you can clear the Tentative check box for the appointment. When you clear the 
Tentative check box, the appointment appears as a regular appointment. 

Adding a Recurring Appointment 
If you have a meeting that occurs regularly, you can have Schedule+ enter it 
automatically on the appropriate days. You can designate a new or existing 
appointment to be recurring. For example, if you attend a staff meeting that 
occurs every other Monday, you can book that time on your schedule. 
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t> To add a recurring appointment 

1. If the Appointment Book is not already displayed, click the Appts tab, 
or press ALT+A. 

2. From the Appointments menu, choose New Recurring Appt. 

3. In the Recurring Appointment dialog box, choose the Change button. 

This Appointment Occurs-----------, ,....",~~-, 
E ver.v F ri starting 12/11/92 

~tart: I 9: OOAM I'$J ~nd: I 9: 30AM I'$J 0 T entatiye 

.!lescription: 

[8J Set Reminder for [illiminute(s) I !I Beforehand 

o ~rivate 

4. In the Change Recurrence dialog box, select the appropriate option button 
to specify whether this appointment should occur daily, weekly, biweekly, 
monthly, or yearly. 

This Occurs 
O.!laily 

@ [§.t.~:~.~'!f.J 
o !!.i-Weekly 

o Monthly 

o Yearly 

~very Week On: 

o Sun 0 Mon 0 Tue 

OWed 0 Thu 0 Fri 0 Sat 

No dates match this pattern. 

Duration----------------, 

~tarts.JFri 12/11/921'ei 0 Ends ISat 12111/931'$J 

@ NQEnd Date OK J I cancel' 

5. If the meeting occurs every week, select one or mbre check boxes to specify 
the day on which the meeting occurs. 
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6. In the Duration box, specify a date when the recurring appointment begins. 

7. If there's an end date for the recurring appointment, in the Duration box, 
select the Ends option button and enter a date in the text box. 

Otherwise, select the No End Date option button. 

8. Choose the OK button. 

You can also designate an existing appointment to be a recurring appointment 
by selecting it and then performing the steps described above. 

Using the Task List 
When you are working on a task over a period of time, you can track it in the 
Schedule+ Task list. To reserve time for working on a particular task during the 
day, you can copy it to a specific time slot in your Appointment Book. 

~riority controls 

Adding a Task to the Task List 
Your Task list helps you keep track of tasks over a period of time. When you 
create a task, you give it a priority letter or number. If you need to complete the 
task by a certain date, you can note that, too. Tasks can be sorted by priority, due 
date, or alphabetically by description. You can group related tasks into projects, 
and then sort them by project. 
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~ To add a task to the Task list 

1. Display the Task list by clicking the Tasks tab or pressing ALT + T. 

2. In the New Task box of the Task list, enter a description of the task. 

3. Choose the Add button to add the new task to your Task list, or press ENTER. 

4. If you want to define a due date for the task, from the Task list, double-click 
the task, or select it and choose the Edit button . 

.!2escription: I Write memo to marketing 

Project: I Sales Report 10 

Due Date: LI O~N=o.:..:.ne=--_....::@=--=fuI~l::w=e=d =6=/::2=/:::£~E;=f$i:J1 
~tart Work: ~Iday(s) I fl Before Due D Set Reminder 

Priori!Y: I 3 f$i Derivate 

OK II Cancel I 

If you do not want to set a due date, make sure None is selected in the Due 
Date box (the default). No due date will be assigned to the task, regardless 
of the date displayed in the By box. 

5. In the Due Date box of the Task dialog box, select the By option button and 
then change the date to the one you want. 

To change each element of the date, select the element, and then either type 
the correct day or number over the existing one or click the arrows beside the 
box until the day or number you want appears. Schedule+ automatically fills in 
the correct day of the week. 

6. In the Start Work box, type a number and then select whether the work should 
start days, weeks, or months before it is due. 

For example, type 1 and select Day(s) to specify that the task will become 
active one day before it is due. 

7. In the Priority box, type a number to indicate the priority for the task. 

The default priority indicators are the numbers 1-9. If you want to change the 
priority indicator to letters, type the letter. You can mix letters and numbers in 
your Task list; number priorities are higher than letter priorities. 
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8. If you want to set a reminder for the Start Work date, select the Set Reminder 
check box. 

9. If you want to ensure that other users do not see this task in your Appointment 
Book, select the Private check box. 

10. Choose the OK button. 

The task is entered in your Task list with the due date and priority you set. 

l> To modify a task 

• Double-click it in the Task list. 

• Or select the task and choose the Edit button. 

l> To remove a task from your Task list 

1. From the Task list, select the task. 

2. Choose the Delete button, or press either ALT+L or the DEL key. 

Scheduling Time in the Appoin,tmen_ Book for a T.ask 
Your Task list helps you keep track of the work you need to do by the end of 
each day, but you can also schedule a specific time during the day to complete a 
task. For example, if one of your tasks is to file a trip report, you can schedule a 
specific time slot in your Appointment Book to be sure you have time to do it. 

l> To schedule time in your Appointment Book for a task 

1. In the Task list, select the task you want to schedule. 

2. Choose the Add To Schedule button. 
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3. In the Choose Time dialog box, select the date and time slot you want to 
schedule the task for, and then choose the OK button. 

The task remains in your Task list, but now it is also booked as an appointment in 
your Appointment Book for the day and time slot you chose. If the Private option 
is selected in the Task dialog box, other users cannot see the description for this 
task in your appointment book, although the time is reserved. 

Using the Planner to Schedule Meetings 
With the Schedule+ Planner, you can scan appointments several days at a time 
or compare other people's schedules to your own to determine when others are 
available for a meeting. You can also schedule resources. 

Scheduling Attendees 
When you compare potential attendees' schedules to your own, their 
appointments show a different-colored bar from your appointments. Empty slots 
are times when everyone is available for a meeting. When two or more people 
have overlapping appointments, the color bar shows a pattern of diagonal stripe. 
Unless you change the colors, your busy time slots contain a blue color bar. Other 
users' busy time slots contain a gray color bar. You can change these display 
colors. For details, from the Options menu choose the Display command, and 
then press Fl for help. 

Other attendee is busy. 

Both people are busy. 

Schedule owner is busy. 
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After you see the schedules for everyone, you can decide the time and date for the 
meeting and send requests from the Planner. The Auto-Pick feature automatically 
highlights the next time slot when all attendees are available. 

Note To schedule meetings with other Schedule+ users, you must be working 
online-your computer must be connected to your postoffice. 

~ To set up a meeting 

1. Display your Planner by clicking the Planner tab or pressing ALT+P. 

2. To select a date for a meeting, from the Edit menu, choose the Go To Date 
command, and then type the correct numbers. 

The vertical color bars in the time slots indicate your current appointments. 

Note that your name automatically appears in the Attendees box. 

3. Choose the Change button. 

The names listed in the Select Attendees dialog box are the Schedule+ users 
on your postoffice. If any conference rooms or other resources have been set 
up on Schedule+, the rooms and resource names also appear in the address list. 

4. From the address list, select the name of a person you want to invite to the . 
meeting, and then choose the Add button or press ENTER. 

The person's name appears with yours in the Attendees box. 

Repeat this step for each additional person you want to invite. 
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5. Choose the OK button. 

In your Planner, the names you selected appear in the Attendees box, and 
those users' schedules are overlaid on yours. The color bars indicate busy 
time slots. The empty time slots indicate when all attendees are available. 

To view the schedule for a particular individual, select the names of the other 
attendees in the Attendees box and choose the Remove button to remove their 
schedule information from the grid. 

6. In the Planner, select a time slot when all the attendees are available by 
dragging across the desired time, or press the appropriate arrow keys until 
the time slot is selected. 

7. Choose the Request Meeting button, or press ENTER. 

The attendees, date, and time you selected in your Planner are entered 
automatically in the Send Request dialog box. 

8. In the Subject box of the Send Request dialog box, type a brief description 
of the meeting. 

9. If you want to receive a response, select the Ask For Responses check box. 

These responses will be collected in your Messages window and in your 
Mail Inbox. 

10. Choose the Send button. 

When Schedule+ has successfully sent the request to the attendees, it books 
the meeting automatically for the appropriate date and time slot in your 
Appointment Book. 

Scheduling Resources 
You can use Schedule+ to reserve resources, such as conference rooms, 
equipment, or services. 

A technician, conference room, piece of equipment, or anything else can be 
assigned an Appointment Book by the Schedule+ administrator. The administrator 
who designates an account as a resource account can set it up so that an assistant 
controls the resource's schedule, or can give users access privileges to reserve the 
resource directly. 

t> To schedule a room or resource while you are scheduling a meeting 

• Include the room or resource in the Attendees list. 
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J> To schedule a room or resource without inviting people to a meeting 

1. Display your Planner. 

2. If the conference room or resource isn't in the Attendees box, choose the 
Change button and select the name of the room or resource from the address 
list. Then choose the OK button. 

If the name of the resource you want to invite isn't in the address list currently 
shown, check another address list. You can view other address lists the same 
way you do in mail. 

3~ Select a time slot for using the resource, based on the times when it is 
available. 

4. Choose the Request Meeting button. 

5. In the Subject box, type a brief description of the meeting (optional). 

6. Optionally, in the message area, type any message you want to include in 
your meeting request. 

7. Choose the Send button. 

If the room or resource has been set up so that you can enter your own requests 
in its Appointment Book, the appointment is booked automatically. If an assistant 
controls the schedule for the resource, he or she sends you a reply to your request. 

Using the Messages Window to Schedule Meetings 
If you are connected to a postoffice, the Messages window is available. The 
Messages window contains meeting requests and meeting responses. Meeting 
requests invite you to meetings other users have set up, and meeting responses 
are other users' replies to your meeting requests. 

To use the Messages window, you must make it the active window by double­
clicking its icon, clicking the restored window, or choosing Messages from 
the Window menu. 
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I Read II !!elete 

Bill will attend - v' Bill O'Oaly Yes: Marketing planning me ... 2/25/93 3:31 PM 

Cristal might attend - t::::::l.~i!.[;i=:ii.B.Eil~.~.:~.::~.~.:~i~lmE!i~.:I~i~i:~.~~1E;:::·:~i~Xfit~.:::~.~2i~~~Efi1ffiR:·:.::.::~: 
Cristal Weber Meeting request 2/20/1 :17PM 

Blake won't attend - ,Blake Rambach No: Marketing planning me ... 2/25/93 2:24PM 
Blake Rambach Meeting request 2/20/93 1 :18PM 

Schedule+ messages appear in your Mail Inbox, as well as in your Schedule+ 
Messages window. You can read, respond to, and delete messages from either 
place. For more information about your Mail Inbox, see Chapter 7, "Mail." 

When you accept a request, Schedule+ automatically notifies the sender that you 
will attend and then schedules the meeting in your Appointment Book. When you 
decline a request, Schedule+ notifies the sender that you won't attend and makes 
no changes to your Appointment·Book. When you tentatively accept a request, 
Schedule+ notifies the sender that you might attend and schedules the meeting 
as a tentative appointment in your Appointment Book. 

When you invite people to a meeting, they reply by sending meeting responses 
to let you know whether they'll attend. The meeting responses arrive in your 
Schedule+ Messages window as entries in the message list. A check mark in a 
meeting response entry means the person is planning to attend; an X means the 
person is not planning to attend; and a question mark means the person might 
attend. Entries in bold letters are requests or responses you haven't read. 

When you read a Schedule+ meeting request in the Mail Inbox or Schedule+ 
Messages window, you can accept, decline, or tentatively accept the invitation, 
using the buttons at the top of the request. 

Although you can see whether someone is planning to attend by looking at the 
symbol in the message list, you can also display the message to see whether the 
person provided more information in the reply. 
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Advanced Features of Schedule+ 
Some of the advanced features of Schedule+ are described here briefly. 
For more information, see online Help. 

• You can choose General Options from the Options menu to define how 
Reminders are sent, the start and end times for your daily schedule, and 
other items. 

• You can allow other users to see or update your schedule. 

You can choose Set Access Privileges from the Options menu to specify which 
users can see your Appointment Book and Task list. When other users check 
your schedule to coordinate an event, they usually can view only the times you 
are available or busy. 

If you want another person to update your schedule for you, you can designate 
that person as your assistant in the Set Access Privileges dialog box. Your 
assistant can modify your schedule and send and receive meeting requests on 
your behalf. 
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• You can archive data and exchange data with other schedule programs. 

To create and manage your Schedule+ archives, choose Create Archive or 
Open Archive from the File menu. To exchange appointment information 
with other scheduling programs, choose Export Appointments or Import 
Appointments from the File menu. 

File Format: 1;:141trmmf' I fl 
Schedule Range: 0 >, " .} ':','f'$i 

@all 
[8J !nclude Dailv Notes 

r---O-K, -,""':111 . Cancel I 

• You can work offline and then merge changes back into your schedule on 
the postoffice. 

When your computer is connected to your postoffice, you are working 
online, and your appointments are recorded in a file on the postoffice and on 
your computer. The filename for this file is has your username plus the .CAL 
filename extension. If you have the Schedule+ software on another computer, 
such as a portable or home computer, you can use the Move Local File 
command from the File menu to copy this file to the other computer. 

While you are working offline (without connection to your postoffice), you can 
add and modify appointments. When you return to your office computer and 
reconnect to Schedule+ on the postoffice, Schedule+ automatically merges the 
changes made offline into the copy of your schedule on the postoffice. 
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CHAPTER 9 

Command Prompt 

The command prompt is the character-based interface to Windows NT and its 
subsystems. Any supported command or application can be run at the command 
prompt regardless of the operating system it was designed for: Windows NT, 
Windows 3.1, MS-DOS, MS OS/21.x, or POSIX. The command prompt also 
supports batch programs, redirection between subsystems, cutting and pasting 
information between subsystems, command line editing, and file management 
for the NTFS, FAT, and HPFS file systems. 

This chapter explains how to use the Windows NT command prompt. The chapter 
includes the following topics: 

• An overview of the Windows NT command prompt 

• Lists of available commands 

• An explanation of command syntax 

• An explanation of command prompt functions 

• A comparison of Windows NT and MS-DOS commands and Windows NT 
and LAN Manager commands 
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Overview 
The Windows NT command prompt is a single interface providing seamless 
operation and integration of applications from four different operating systems. 
The Windows NT command prompt is a major enhancement to the command line 
interface on current personal computer operating systems allowing you to: 

• Start any Windows NT, Windows 3.1, MS-DOS, character-based MS OS/2 
version Lx, or POSIX-compliant programs. 

• Issue Windows NT commands. The command prompt retains and enhances 
almost all the commands used in MS-DOS (except new utilities in version 6.0) 
and contains several new commands. 

• Administer or use network resources. Many LAN Manager commands 
are available. 

• Cut and paste information between applications with the Clipboard. 

• Use piping or redirection of data between subsystems. 

Starting and Quitting the Command Prompt 
Start the command prompt by double-clicking the command prompt icon. 
The command prompt window displays the command prompt in monospaced 
characters followed by a blinking cursor. The default command prompt is the 
current drive and directory enclosed in brackets. 

~ To quit the command prompt 

• Type exit at the command prompt, or choose Close from the Control menu, 
or double-click the Control-menu box. 

~ To quit the command prompt when it, or an application started at the 
command prompt, fails to respond 

1. From the Control menu, choose Settings. 

2. In the Special box, choose the Terminate button. 

Use Terminate as a last resort. You should quit applications by using the 
application's Quit or Exit command. 
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Changing the Command Prompt Display 
You can configure the appearance of the command prompt window using 
the Control menu. The icon in the upper-left corner of any window is that 
window's Control menu. The Control menu allows you to: 

• Cut and paste information between any two windows. 

• Toggle between window mode and full-screen mode. 

• Enable QuickEdit mode. 

• Change fonts used in window mode. 

• Set the screen buffer size and the position of the window. 

• Change the colors of text and background for the main screen and 
pop-up boxes. 

• Hide the mouse pointer for character-based subsystem applications. 

Click the Control-menu box 
to display the Control menu. 

Bestore 
Move 
~ize 

Minimize 
Ma~imize 

Copy information 
between windows 
using the Edit command. 

Use these menu commands to 
change command prompt 
window behavior and display. 
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I> To open the Control menu 

• Click the Control-menu box once, or press ALT+SPACEBAR. 

The Control menu opens and you can select from the list of commands. (If you 
are in full~screen mode, the application will minimize and the control menu 
will appear from the icon.) For information on Control menu commands not 
listed below, see Chapter 2, "Windows NT Basics." 

Control menu settings are stored based on the initial window title. The settings for 
each command prompt icon are independent for each unique title. This allows you 
to have different defaults for different needs. 

An application's internal display settings will usually override font and color 
settings made in the Control menu. 

Changing Window Modes 
The command prompt can be used in either window or full-screen mode. You can 
also use QuickEdit mode which allows you to use your mouse to cut and paste, 
bypassing the Edit menu. 

t> To toggle between window and full-screen mode 

• Press ALT+ENTER. 

By default, the command prompt opens as a window on your desktop. 

I> To change the default window display options 

1. From the Control menu, choose Settings. 

2. In the Display Options box, choose either Window or Full Screen. 

3. To use this display option every time you start the command prompt from 
this icon, ensure that the Save Configuration check box is selected. If this box 
is not selected, the display option will be in effect only while the current 
command prompt window is open. 

4. Choose the OK button. 

I> To turn QuickEdit mode on or off 

1. From the Control menu, choose Settings. 

2. Select the QuickEdit Mode check box. 
~ 

3. Choose the OK button. 

You can always use the Edit menu commands, whether QuickEdit mode is on 
or off. For more information about QuickEdit, see "Transferring Information to 
or from a Command Prompt Window," later in this chapter. 
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Changing Fonts for Window Mode 
You can choose from many font sizes for the window mode of the command 
prompt display. Fonts for the command prompt are measured in screen pixels. 
Default fonts are saved based on the title of the window. The size of the window 
will change relative to the font selected, but you can always resize the command 
prompt window up to the maximum screen buffer size, as discussed in the 
following section. 

t> To change fonts for the command prompt 

1. From the Control menu, choose Fonts. 

Eont Window Preview 

4 X 6 ~ 
5 X 6 
5 X 12 f-

6 X 8 
6 X 12 
7 X 12 
8 X 8 

L OK 

I Cancel 

D .s.ave configuration 

Selected Font-----------------------, 

2. In the Font box, choose a font size. 

Each character is: 
B screen pixels wide 

12 screen pixels high 

The Selected Font box displays an example of the selected font and its width 
and height. The Window Preview box displays how the current window size 
will change based on the font you choose, although you can later resize the 
window up to the maximum screen buffer size. 

3. To use the font every time you start the command prompt from this icon, 
ensure that the Save Configuration check box is selected. If this box is not 
selected, the new font is displayed only while the current command prompt 
window is open. 

4. Choose the OK button. 



264 System Guide 

Changing the Screen Size and Position 
The screen buffer size is the size reserved in memory for the command prompt 
display. The buffer size is measured by the number of characters wide by the 
number of lines high. The position is the current window position on the screen. 

Scroll bars are displayed if the current size of the window is smaller than the 
screen buffer size settings. You cannot resize a window to be larger than the area 
set by the screen buffer settings. The settings have no effect when you are using 
a full screen display. 

t> To change the screen buffer size 

1. From the Control menu, choose Screen Size And Position. 

Screen Buffer Size 

Width: IlillJ I~ 
Height: ~~ 

D Save !creen buffer size 

1::>:oK.'::'1 

I;:: ]::ancel'" I 

D Save !tindow size and position 

2. In the Screen Buffer Size box, set the width and height of the window using 
the up or down arrows next to the settings, or type the new value. 

The width setting determines the number of characters in width. The height 
setting determines how many lines are stored in memory. 

3. To use these screen buffer size settings every time you start the command 
prompt from this icon, ensure that the Save Screen Buffer Size check box is 
selected. If this box is not selected, your screen buffer settings are displayed 
only while the current command prompt window is open. 

4. Ensure that the Save Window Size And Position check box is selected if 
you want to use the current window size and position every time you start 
the command prompt. 

5. Choose the OK button. 
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Changing Screen Colors 
You can specify the color of the text and background of the command prompt 
window. You can also specify the color of the text and background of pop-up 
windows that originate from the command prompt. Pop-up windows (for 
example, command history windows) are smaller character-based windows 
that present information to choose from. 

t> To change screen colors 

1. From the Control menu, choose Screen Colors. 

o Screen TeKt OK 
@ l~.·~.~.~·~.~·""~"~.~·~.~·~·~.~·~.~: 
o PopUp Text Cancel 

o PopUp Background D liave configuration 

2. In the Screen Colors dialog box, choose the colors for screen text, screen 
background, pop-up text, and pop-up background by clicking the element 
you want to change, and then clicking the color you want. 

The Selected Screen Colors or Selected Popup Colors box displays your 
choice. 

3. To use the same colors every time you start the command prompt from this 
icon, ensure that the Save Configuration check box is selected. If this box is 
not selected, your settings are displayed only while the current command 
prompt window is open. 

4. Choose the OK button. 
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Getting Help for the Command Prompt 
Online Help is available for all commands at the command prompt and in a 
Windows NT help file. 

Help at the Command Prompt 
Online Help is available for all Windows NT commands. The following table 
shows how to access the different types of help available at the command prompt 
and the information provided. 

Syntax 

help 

command!? 

help command 

net help 

net help command 

net command /help 

net command !? 

Information provided 

Names of native system commands. 

Description, syntax, parameters, and switches for commands. 
This syntax also provides help for commands that are not 
listed when you type help. 

Description, syntax, parameters, and switches for native 
system commands. 

Names of available network commands. 

Description, syntax, parameters, and switches for network 
commands. 

Description, syntax, parameters, and switches for network 
commands. 

Syntax only for network commands. 

Online Command Reference 
The Windows NT online Command Reference is available to provide command 
syntax and parameters, details about a command, and examples of the command 
in use. To use the online Command Reference, double-click the Help icon in the 
Main program group. 

Command Prompt Commands 
Any supported Windows NT command can be run at the same command prompt. 
Windows NT commands are classified as follows: 

• Native commands 

• Subsystem commands 

• Configuration commands 

• TCP/IP utilities 

• Special purpose utilities 

• Command symbols 
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Native Commands 
A native command takes advantage of the 32-bit operating system. Most 
commands familiar to MS-DOS users are now native Windows NT system 
commands. 

Some commands, such as dir and chdir, are internal, meaning the command is 
processed by CMD.EXE and resides in memory at all times. Internal commands 
can be run only at the command prompt. Other commands, such as chkdsk and 
xcopy, are external, meaning the command is stored in its own file and loads from 
disk when you use the command. External commands can be run at the command 
prompt, from the Program Manager dialog box in the File menu, or from the Task 
List's New Task box. Batch commands are for use in batch programs only, as 
described later in this chapter. 

Note Many of the new utilities provided in MS-DOS version 6.0 are not available 
in Windows NT version 3.1, or the functionality is provided by a different means. 
For more information, see "Differences from MS-DOS Commands," later in this 
chapter. 

Command 

at 

attrib 

break 

call 

chcp 

chdir (cd) 

chkdsk 

cis 

cmd 

comp 

convert 

Purpose 

Schedules commands and programs to run on a computer at 
a specified time and date. 

Displays or changes file attributes. 

Sets or clears extended CTRL+C checking. 

Calls one batch program from another (batch command only). 

Displays or sets the active code page number. 

Displays the name of or changes the current directory. 

Checks a disk and displays a status report. 

Clears the screen. 

Starts a new session of the Windows NT command interpreter. 

Compares the contents of two files or sets of files. 

Converts FAT and HPFS disk partitions to NTFS partitions. 
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Command 

copy 

date 

del 

dir 

diskcomp 

diskcopy 

doskey 

echo 

endlocal 

erase 

exit 

fc 

find 

findstr 

for 

format 

go to 

graftabl 

help 

if 

keyb 

label 

mkdir (md) 

mode 

Purpose 

Copies one or more files to another location. 

Displays or sets the date. 

Deletes one or more files. 

Displays a list of files and subdirectories in a directory. 

Compares the contents of two floppy disks. 

Copies the contents of one floppy disk to another. 

Edits command lines, recalls commands, and creates macros. 

Displays messages or turns command echoing on or off. 

Ends localization of environment changes in a batch file (batch 
command only). 

Deletes one or more files. (See del.) 

Quits the Windows NT command interpreter (CMD.EXE). 

Compares two files or sets of files, and displays the differences 
between them. 

Searches for a text string in a file or files. 

Searches for strings in files using literal text or regular 
expressions. 

Runs a specified command for each file in a set of files. 

Formats a disk for use with MS-DOS or Windows NT. 

Directs Windows NT to a labeled line in a batch program (batch 
command only). 

Enables Windows NT to display an extended character set 
in full-screen mode. 

Provides Help information for Windows NT commands. 

Performs conditional processing in batch programs (batch 
command only). 

Configures a keyboard for a specific language. 

Creates, changes, or deletes the volume label of a disk. 

Creates a directory. 

Configures a system device. 



Command 

more 

move 

net accounts 

net computer 

net con fig 

net con fig server 

net config workstation 

net continue 

net file 

net group 

net help 

net helpmsg 

net localgroup 

net name 

net pause 

net print 

net send 

net session 

net share 

net start 

net start alerter 

net start c1ipbook 
server 

net start computer 
browser 

Chapter 9 Command Prompt 269 

Purpose 

Displays output one screen at a time. 

Moves one or more files from one directory to the specified 
directory. 

Displays or sets password and logon requirements of servers 
in a domain. 

Adds computers to Windows NT Advanced Server domains 
(Advanced Servers only). 

Displays the controllable services that are running. 

Displays or changes settings for the Server service while the 
service is running. 

Displays or changes settings for the Workstation service 
while it is running. 

Reactivates suspended services. 

Displays the names of all open shared files on a server and the 
number of file locks, if any, on each file. This command also 
closes individual shared files and removes file locks. 

Adds, displays, or modifies global groups. 

Provides a list of network commands and topics you can get 
help with, or provides help with a specific command or topic. 

Provides help with a network error message. 

Adds, displays, or modifies local groups. 

Adds, deletes, or displays messaging names on a workstation. 

Pauses services or shared printers. 

Displays or controls print jobs. 

Sends messages to other computers on the network. 

Lists or disconnects sessions between a server and 
workstations. 

Creates, deletes, or displays shared resources. 

Starts a service or displays a list of started services. 

Starts the Alerter service. 

Starts the Clipbook Server service. 

Starts the Computer Browser service. 
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Command 

net start directory 
replicator 

net start eventlog 

net start messenger 

net start net logon 

net start network dde 

net start network dde 
dsdm 

net start nwlink 

net start nwnblink 

net start 
remoteaccess 

net start rpclocator 

net start rpcss 

net start schedule 

net start server 

net start ups 

net start workstation 

net statistics 

net stop 

net time 

net use 

net user 

net view 

path 

pause 

Purpose 

Starts the Directory Replicator service. 

Starts the Eventlog service. 

Starts the Messenger service. 

Starts the Net Logon service. 

Starts the Network Dynamic Data Exchange service. 

Starts the Network Dynamic Data Exchange Server service. 

Starts the NWLink service. 

Starts the NWLink NetBIOS service. 

Starts the Remote Access service. 

Starts the RPC Locator service. 

Starts the RPC subsystem. 

Starts the Schedule service. 

Starts the Server service. 

Starts the Un interruptible Power Supply service. 

Starts the Workstation service. 

Displays the statistics log. 

Stops a network service. 

Synchronizes the workstation's clock with that of a server 
or domain, or displays the time for a server or domain. 

Connects a workstation to or disconnects a workstation from 
a shared resource, or displays information about workstation 
connections. 

Adds or modifies user accounts or displays user account 
information. 

Displays a list of servers or displays resources being shared 
by a server. 

Displays or sets a search path for executable files. 

Suspends processing of a batch file and displays a message 
(batch command only). 



Command 

popd 

print 

prompt 

pushd 

recover 

rem 

rename (ren) 

replace 

restore 

rmdir (rd) 

set 

setlocal 

shift 

sort 

start 

subst 

time 

title 

tree 

type 

ver 

verify 

vol 

xcopy 
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Purpose 

Changes to the directory stored by the pushd command. 

Prints a text file while you are using other Windows NT 
commands. 

Changes the Windows NT command prompt. 

Stores the current directory for use by the popd command, 
and then changes to the specified directory. 

Recovers readable information from a bad disk. 

Records comments (remarks) in batch files. Also available as a 
configuration command for the MS-DOS and OS/2 subsystems. 

Renames a file or files. 

Replaces files. 

Restores files that were backed up with MS-DOS backup. 

Removes a directory or directory tree. 

Displays, sets, or removes Windows NT environment variables. 

Begins localization of environment changes in a batch file 
(batch command only). 

Shifts the position of replaceable parameters in batch files 
(batch command only). 

Sorts input. 

Starts a separate window to run a program or command. 

Associates a path with a drive letter. 

Displays or sets the system time. 

Sets the title for the command prompt window. 

Graphically displays the directory structure of a drive or path. 

Displays the contents of a text file. 

Displays the Windows NT version number. 

Tells Windows NT whether to verify that your files are 
written correctly to a disk. 

Displays a disk volume label and serial number. 

Copies files and directory trees. 
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Subsystem Commands 
Windows NT includes 16-bit commands for the MS-DOS and other subsystems. 
These are older commands, such as edlin or graphics, and MS-DOS-specific 
commands, such as debug or exe2bin. These 16-bit commands are included to 
maintain MS-DOS compatibility. 

Other MS-DOS subsystem commands, such as share, perform functions that are 
now inherent to Windows NT or the MS-DOS subsystem. The commands are 
accepted to preserve compatibility with existing files, but the commands have 
no effect because the functionality is automatic in Windows NT. 

Command 

append 

backup 

debug 

edit 

edlin 

exe2bin 

expand 

fastopen 

graphics 

loadfix 

loadhigh (Ih) 

mem 

nlsfunc 

qbasic 

setver 

share 

Purpose 

Allows programs to open data files in specified directories 
as if they were in the current directory. 

Backs up one or more files from one disk onto another. 

Runs Debug, a program testing and editing tool for MS-DOS 
applications. 

Starts MS-DOS Editor, which creates and changes ASCII files. 

Starts Edlin, a line-oriented text editor. 

Converts .EXE (executable) files to binary format. 

Expands one or more compressed files. 

Starts the Fastopen program. 

Loads a program that can print graphics. 

Loads a program above the first 64K of memory, and then runs 
the program. 

Loads a program into the upper memory area. 

Displays the amount of used and free memory for the MS-DOS 
subsystem. 

Loads country-specific information. 

Starts the QBasic™ programming environment. 

Sets the version number for MS-DOS that Windows NT reports 
to a program. 

Starts the share program. 
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Configuration Commands 
You configure the MS-DOS subsystem with configuration commands, such 
as device or lastdrive. Place these commands in the CONFIG.NT file in the 
\WINNT\SYSTEM32 directory. These commands affect only the MS-DOS 
subsystem. Many of them, such as buffers and break, are ignored because the 
MS-DOS subsystem does not use them. They are accepted for compatibility only. 

You configure the OS/2 subsystem with CONFIG.SYS commands, such as 
devicename or Iibpath. You must use an OS/2 editor to edit C:\CONFIG.SYS. 
No other method can be used to change the OS/2 subsystem CONFIG.SYS file. 
These commands affect only the OS/2 subsystem. 

For more information on Windows NT subsystems, see Chapter 11, "Other 
Application Environments." 

Command 

buffers 

codepage 

country 

device 

devicehigh 

devinfo 

dos 

dosonly 

driveparm 

echoconfig 

fcbs 

files 

Purpose 

Allocates memory for a specified number of disk buffers when 
the system starts. 

Specifies which code pages your system is prepared to use 
(OS/2 only). 

Enables a subsystem to use international time, dates, currency, 
case conversions, and decimal separators. 

Loads into memory the device driver you specify. 

Loads into high memory the device driver you specify. 

Specifies the information a device needs in order to use a 
particular code page (OS/2 only). 

Specifies that the MS-DOS subsystem is to maintain a link to 
its upper memory area or is to load part of itself in the high 
memory area (HMA). 

Prevents starting applications other than MS-DOS-based 
applications from the COMMAND.COM prompt. 

Defines parameters for block devices (OS/2 only). 

Displays messages when the MS-DOS subsystem CONFIG.NT 
file is read. 

Specifies the number of file control blocks (FCBs) the 
command prompt can have open at the same time. 

Sets the number of files that the command prompt can access 
at one time. 
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Command 

install 

lastdrive 

libpath 

ntcmdprompt 

protshell 

shell . 

stacks 

switches 

TCP/IP Utilities and Services 

Purpose 

Loads a memory-resident program into memory. 

Specifies the maximum number of drives you can access. 

Specifies the location of OS/2 dynamic-link libraries 
(OS/2 only). 

Runs the Windows NT command interpreter, CMD.EXE, rather 
than COMMAND. COM after running a TSR or after starting 
the command prompt from within an MS-DOS application. 

Specifies the name and location of the MS OS/2 command 
interpreter (OS/2 only). 

Specifies the name and location of the command interpreter 
for the MS-DOS subsystem. 

Supports the dynamic use of data stacks to handle hardware 
interrupts. 

Forces an enhanced keyboard to behave like a conventional one. 

The TCP/IP utilities offer network connections to non-Microsoft hosts such as 
UNIX® system computers. You must have the TCP/IP network protocol installed 
to use the TCP/IP utilities. 

For more information about the TCP/IP utilities and network protocol, see 
Appendix A, "Network Protocols." 

Command 

arp 

finger 

ftp 

hostname 

nbtstat 

net start snmp 

Purpose 

Displays and modifies the IP-to-Ethernet address translation 
tables. 

Displays information about users on a remote system. 

Transfers files to and from a node running ftp service; similar 
to tftp. 

Prints the name of the current host. 

Displays protocol statistics and current TCP/IP connections 
usingNBT. 

Starts the Simple Network Management Protocol (SNMP) 
service. 



Command 

net start tepip 

net start tep/ip netbios 

net start tep/ip netbios 
helper 

net start telnet 

netstat 

ping 

rep 

rexee 

route 

rsh 

telnet 

tftp 

Special Purpose Utilities 
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Purpose 

Starts the TCP/IP service. 

Starts the NetBIOS over TCP/IP service. 

Starts the NetBIOS over TCP/IP service. 

Starts the TELNET service. 

Displays protocol statistics and current TCP/IP connections. 

Verifies connections to a remote host or hosts. 

Copies files between computers. 

Provides remote execution facilities similar to rsh. Rexec 
is password protected. 

Manually manipulates network routing tables. 

Runs commands on remote hosts. 

Enables terminal emulation. 

Transfers files to and from a node running ftp service 
using trivial file transfer protocol; similar to ftp. 

Special purpose utilities are native 32-bit utilities, but they have a very limited 
purpose and may not appear in future versions of Windows NT. 

Command 

acleonv 

diskperf 

ipxroute 

portuas 

Command Symbols 

Purpose 

Restores OS/2 2.x ACLs to NTFS volumes. 

Starts, stops, and displays system disk performance counter use. 

Manages the source routing variables of the NWLink protocol 
on a token-ring network. This command is available only if the 
NWLink protocol has been installed. 

Converts a LAN Manager user account subsystem to a 
Windows NT user account database. 

Eleven command symbols allow you to manipulate the input or output of a 
command and permit conditional execution of a command. Used with commands 
and filter commands, the command symbols are powerful tools. 
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Symbol 

> 
» 

< 

I 
II 

& 
&& 

() 

; or, 

Purpose 

Redirects output. 

Appends redirected output to existing data. 

Redirects input. 

Pipes output. 

Runs the command following the symbol only if the command 
preceding the symbol fails. 

Separates multiple commands on the command line. 

Runs the command following the symbol only if the command 
preceding the symbol is successful. 

Groups commands. 

Allows input of command symbols as text. Escape character. 

Separates parameters. 

Sort, more, and find are the native filter commands that allow you to sort input 
and output, cause output to the screen to be displayed one screen at a time, and 
search for specified text in a file. 

For complete syntax and explanations of the command symbols and filter 
commands, see the online Command Reference. 

Command Syntax 

Syntax is the order in which you must type a command and the elements that 
follow the command. Windows NT commands have up to four elements: 
command name, parameters, switches, and values. 

These two examples contain all four elements. Each element is explained below. 

~ 
~ 
~ * ~. Qf 
~ ~ G ~ cr ~ ~ ~ ? 1- Vj ~ 

0-1 --<-----.1 1 1 ~ ~ 
net share public=c:\users\public /users:l0 

The first example lists all hidden files in the C:\LETTERS directory. The second 
example allows up to 10 users to connect to the C:\USERS\PUBLIC directory. 
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Command Names 

Parameters 

The command name, which you type first, states the action you want Windows 
NT to carry out. Some commands (such as the cis command, which clears your 
screen) consist only of a command name. Most Windows NT commands require 
more than a name. All network commands are preceded by the word net, for 
example, net share or net use. 

Windows NT sometimes requires additional information, which you specify in 
one or more parameters after the command name. A parameter defines or creates 
the object you want Windows NT to act on. For example, the del command 
requires a parameter that is the name of the file you want to delete. 

Some commands require more than one parameter. For example, to rename a file 
by using the rename (ren) command, you must include the original name of the 
file in addition to the new name. The following command renames LETTER. TXT 
to MEMO. TXT: ren letter. txt memo.txt. 

Caution Some Windows NT commands accept semicolons to separate 
parameters. For example, if you wanted to delete all files on drive A and 
mistakenly typed del a;\*.*, Windows NT would erase the file A in the current 
directory and all files in the root directory of the current drive. 

Position in the syntax line determines how a command works and whether a 
parameter is a source (first) or a destination (second). In the example above, the 
source, LETTER.TXT, specifies the location of data to be transferred or used as 
input to a command. The destination, MEMO.TXT, specifies a location to which 
the data specified by source is to be transferred. 

Using Special Characters in Parameters 
In a Windows NT command, a computer name, share name, username, or group 
name can contain special characters (for example, PROFIT&LOSS). 

t> To type a parameter with a special character 

• Type the escape character (1\) before the special character. For example, 
type net use g: \ \profit 1\ &loss\reports 
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Switches 

Values 

Switches modify how a command performs a task. A switch is a forward slash (I) 
or a hyphen (-) usually followed by words, letters, or numbers. Some Windows 
NT commands do not have switches, whereas others have several. 

If a command has more than one switch, you type them one after the other, 
separated with a space. Switches may be in any position or order after the 
command name. Some commands accept more than one switch after a forward 
slash. Other commands, such as TCP/IP utilities, accept a hyphen (-) instead of 
the forward slash. 

The terms "parameter" and "switch" are often interchanged, since both elements 
follow the command name. The only meaningful difference between a switch and 
parameter is the presence of a forward slash or hyphen to indicate a switch and the 
parameter position in the syntax line to indicate whether the parameter is a source 
or destination. The term "argument" is also used to refer to parameters or 
switches. 

Using the /Yes and INo Switches 
With some network commands, Windows NT issues a prompt that requires a user 
response before a task can be completed. You can append the Iyes (/y) or Ino (In) 
switch to a command to force a Yes or No answer for all responses. For example, 
stopping the Workstation service causes Windows NT to stop dependent services; 
Windows NT will prompt you before stopping each dependent service unless the 
Iyes switch is included, as in the following: net stop workstation Iy. 

Values determine how a switch works. A value is a colon (:) or an equal sign (=) 
followed by a word, letter, or number and must immediately follow the switch it 
modifies without a space. The following example of the format command 
contains two values, the file system to use (NTFS) and a volume label (Backup2): 
format d: Ifs:ntfs /v:backup2. 

Check the syntax for the specific command in online Help to determine if the 
command you want to use requires an equal sign or a colon. 
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Using the Command Prompt 
This section explains how to: 

• Start applications and use batch programs. 

• Cut and paste information to or from a command prompt window. 

• Simplify entering repetitive commands. 

• Pause or cancel execution of a command. 

Starting Programs at the Command Prompt 
You can start any program at the command prompt by typing the filename of 
the program. 

t> To start a program at the command prompt 

• Type the program's executable file name, and then press ENTER. 

For example, typing clock will start Clock (from the Accessories group). 

The command prompt window used to start the program is unavailable until 
you stop the program. 

t> To start a program at the command prompt and retainuse of the command 
prompt widow 

• Type start followed by the program's executable file name, and then press 
ENTER. 

For example, typing start calc will start Calculator (from the Accessories 
group). 

The command prompt window still accepts commands. 

You can also pass additional parameters to a program at the command prompt. 
For example, the command notepad letter.txt starts Notepad and automatically 
loads the file LETTER.TXT. 

When starting Event Viewer, User Manager, or Server Manager at the command 
prompt, you can improve their performance on networks with slow speeds by 
using the II switch to run in low speed mode or the Ih switch to run in high speed 
mode. These options are also available within each program; it is necessary to use 
these command prompt switches only if you choose to start these programs at the 
command prompt. 
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Other programs may accept parameters specific to the program. Each program 
determines the parameters it will accept at the command prompt. To determine 
whether a program will accept parameters at the command prompt, see the 
documentation for that program. 

While a program or command is running, the window or icon title displays the 
program or command currently running. When the command finishes running, 
the program or command is removed from the window or icon title. 

Batch Programs 
Batch programs (also called batch files) allow you to simplify routine or repetitive 
tasks. A batch program is an unformatted text file that contains one or more 
commands and has a .BAT or . CMD filename extension. When the filename is 
typed at the command prompt, the commands in the file are executed sequentially. 

Any command can be included in a batch file. In addition, several commands 
allow conditional processing of the commands in the batch file. For example, 
the if command carries out a command based on the results of a condition. Other 
commands allow you to control input and output and call other batch programs. 

Transferring Information to or from a Command Prompt Window 
You can transfer information to or from the command prompt using either 
QuickEdit mode or the Edit menu commands. 

Note To quickly switch a command prompt or subsystem application between a 
full screen and a window, press AL T + ENTER. 

Copying and Pasting Information using QuickEdit Mode 
QuickEdit mode allows you to copy and paste text in command prompt windows 
using only your mouse, bypassing the Control menu's Edit commands. QuickEdit 
mode copies data only when the command prompt is running as a window; 
however, you can paste in QuickEdit mode when the command prompt is either 
a window or a full screen. The data is treated as text. Use the Settings command 
from the Control menu to turn QuickEdit mode on or off. 

Note When QuickEdit mode is on, the mouse is disabled in all programs started 
at that command prompt. Use the start command to retain use of the mouse when 
starting a program from a command prompt window with QuickEdit mode 
enabled. 
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t> To cut and paste text at the command prompt using QuickEdit mode 

1. If necessary, use the Settings command from the Control menu to turn 
QuickEdit mode on. 

2. Position the arrow cursor at the beginning of the text you want to copy. 
Press the left mouse button. Keeping the left mouse button depressed, drag 
the cursor to the last character of the section you want to copy and release the 
left mouse button. The portion of the screen you want to copy is highlighted. 

3. Press the right mouse button to copy the highlighted area to the Clipboard. 
The highlight will disappear. 

4. Press the right mouse button to copy the contents of the Clipboard to the 
command prompt cursor. If the area copied was more than one line, a carriage 
return (ENTER) is added at the end of each line. 

You must still use the Edit Paste command to paste the contents of the 
Clipboard into Windows applications. 

Copying and Pasting Information Using the Edit Menu 
The Edit menu commands allow you to copy and paste information in any 
window, not just command prompt windows. The data is transferred as text 
or as a bitmap to the Clipboard depending on how it was copied. 

I> To copy selected information as text from a command prompt window 
or character-based application running in a window 

1. Press ALT+SPACEBAR to open the Control menu. 

2. From the Control menu, choose Edit. 

3. From the Edit menu, choose Mark. 

4. Select the information you want to copy using a mouse. 

5. Press the right mouse button to transfer the selected information to the 
Clipboard or choose Edit Copy from the Control Menu. 

I> To copy the contents of an entire screen onto the Clipboard as a bitmap 

1. Make sure the information you want to copy is on the screen. 

2. Press PRINT SCREEN. 

The contents of the screen are copied onto the Clipboard. 
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t> To copy a window and its contents onto the Clipboard as a bitmap 

1. Make sure the window you want to copy is the active window. 

2. Press ALT + PRINT SCREEN. 

A bitmap of the active window is created and placed onto the Clipboard. The 
application you want to transfer the information to must be able to read bitmap 
(.BMP) files. 

I> To paste information into an application as text 

1. Make sure the information you want is on the Clipboard. 

2. Switch to the destination window. 

3. Place the insertion point where you want the information from the Clipboard 
to appear. 

4. If the application is running in full-screen mode, press ALT+SPACEBAR to open 
the Control menu. 

5. From the window's Control menu, choose Edit. 

6. From the Edit menu, choose Paste. If the area copied was more than Clne line, 
a carriage return (ENTER) is added at the end of each line. 

Editing Commands with Doskey and Editing Keys 
Windows NT provides Doskey to give you quick access to your most recent 
commands and enable you to assign frequently used command(s) to a single 
keystroke. Doskey is always available; you do not need to load the program into 

. memory. Doskey is also available for character-based programs that accept 
buffered input. 

The UP ARROW and DOWN ARROW keys cycle through commands previously 
entered. Press F7 to display all of the previous commands in a pop-up box; then 
use the UP ARROW and DOWN ARROW keys to select a command and press ENTER 

(or press ESCAPE to cancel). Doskey also allows you to assign multiple commands 
to a single key or typed alias. 

In addition to Doskey, several editing keys allow you to use and edit the last 
command you typed. Press Fl to display the last command one character at a time, 
or press F3 to display the entire command. Use the BACKSPACE or LEFT ARROW 

key to move the cursor in a command. The INSERT key toggles between insert and 
overtype mode. 

For more information on Doskey and the command editing keys, see the online 
Command Reference. 
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Pausing or Canceling a Command 
You can pause or stop the output of a command. 

I> To pause the output of a command 

• Press CTRL+S or PAUSE. 

Press any key except PAUSE to restart the output of the command. You can 
stop and restart the output of a command as many times as you want. 

I> To stop Windows NT from completing a command 

• Press CTRL+BREAK or CTRL+C. 

Your command is canceled, and the command prompt appears. 

Important Any action Windows NT carried out before you pressed CTRL+BREAK 

or CTRL+C cannot be undone. 

Differences from MS-DOS Commands 
Windows NT retains and enhances almost all the functionality of MS-DOS. This 
section explains the significant differences between Windows NT commands and 
MS-DOS commands. 

New Windows NT Commands 
This table explains new Windows NT system commands. 

Command 

at 

aclconv 

convert 

diskperf 

dosonly 

echoconfig 

endlocal 

Function 

Schedules commands and programs to run on a computer 
at a specified time and date. 

Restores OS/2 2.x ACLs to NTFS volumes. 

Converts file systems from FAT or HPFS to NTFS. 

Starts, stops, and displays system disk performance counter use. 

Prevents starting applications other than MS-DOS-based 
applications from the COMMAND. COM prompt. 

Displays messages when reading the MS-DOS subsystem 
CONFIG.NT file. 

Ends localization of environment variables. 
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Command 

findstr 

ntcmdprompt 

popd 

pushd 

setlocal 

start 

title 

&& 

II 

& 
() 

; or, 

Function 

Searches for text in files using regular expressions. 

Runs the Windows NT command interpreter, CMD.EXE, rather 
than COMMAND.COM after running a TSR or after starting 
the command prompt from within an MS-DOS application. 

Changes to the directory last set with the pushd command. 

Saves the current directory for use by the popd command, 
and then changes to the specified directory. 

Begins localization of environmental variables. 

Runs a specified program or command in a secondary window. 

Sets the title of the command prompt window. 

Command following this symbol runs only if the command 
preceding the symbol succeeds. 

Command following this symbol runs only if the command 
preceding the symbol fails. 

Separates multiple commands on the command line. 

Groups commands. 

Escape character. Allows input of command symbols as text. 

Separates parameters. 

Changes to MS-DOS Commands 
This table lists changes and improvements to MS-DOS commands. 

Command 

chcp 

cmd 

del 

dir 

diskcomp 

diskcopy 

doskey 

format 

keyb 

label 

Changed features 

Changes code pages for full-screen mode only. 

CMD.EXE replaces COMMAND.COM. 

New switches provide many more functions. 

New switches provide many more functions. 

Switches /1 and /8 are not supported. 

Switch /1 is not supported. 

Available for all character-based programs that accept buffered 
input. Several other enhancements improve doskey. 

20.8 MB floptical drive supported. Switches /b, Is, and /u are 
not supported. 

KEYBOARD.SYS is no longer used. 

The symbols" and & can be used in a volume label. 



Command 

mode 

more 

path 

print 

prompt 

recover 

rmdir 

sort 

xcopy 
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Changed features 

Extensive changes. 

New switches provide many more functions. 

The % PATH % environment variable can be used at the 
command prompt. 

Switches /b, /u, /m, Is, /q, It, /c, and /p are not supported. 

New character combinations allow you to add ampersands ($a), 
parentheses ($c and $f), and spaces ($s) to your prompt. 

Recovers files only. 

New /s switch deletes directories containing files and 
subdirectories. 

Does not require TEMP environment variable. File size is 
unlimited. 

New switches provide many more functions. 

Unavailable MS-DOS Commands 
The following MS-DOS commands are not available at the command prompt. See 
also the following section, "MS-DOS Version 6.0 Commands." 

Command 

assign 

cUy 

dosshell 

emm386 

fdisk 

join 

mirror 

sys 

undelete 

unformat 

New procedure or reason for obsolescence 

Not supported in Windows NT. 

Not currently supported. 

Unnecessary with Windows NT. 

Unnecessary with Windows NT. 

Disk Administrator prepares hard disks for use with 
Windows NT. 

Increased partition size and an improved file system eliminate 
the need to join drives. 

Not supported in Windows NT. 

Windows NT will not fit on a standard 1.2 MB or 1.44 MB 
floppy disk. 

Not supported in Windows NT. 

Not supported in Windows NT. 
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MS·DOS Version 6.0 Commands 
The MS-DOS version 6.0 upgrade contains many new utilities that are either 
available in Windows NT in another form, or are incompatible with Windows NT 
architecture. Certain commands may be supported in future versions of 
Windows NT. 

The following commands, introduced in MS-DOS version 6.0, are not supported 
in Windows NT version 3.1. 

Command 

choice 

dblspace 

defrag 

deltree 

fasthelp 

include 

interlnk 

intersrv 

memmaker 

menucolor 

menu default 

menuitem 

msav 

msbackup 

Comment 

The choice batch program command is not currently supported. 

The Dblspace program is not currently supported. 

The Defrag program is not currently supported. 

The rmdir Is command deletes directories containing files 
and subdirectories. 

This MS-DOS 6.0 command is the same as the Windows NT 
command help. Windows NT also provides an online Command 
Reference in the Windows NT Help icon in the Main program 
group. 

Multi-configurations for the MS-DOS subsystem are 
unnecessary. Use the PIF Editor Windows NT button to specify 
the location and name of unique AUTOEXEC and CONFIG 
files for each MS-DOS program you want to use. 

The Interlnk program is not supported. 

The Intersrv program is not supported. 

Windows NT automatically optimizes the MS-DOS 
subsystem's memory use. 

Multi-configurations for the MS-DOS subsystem are 
unnecessary. Use the PIF Editor Windows NT button to specify 
the location and name of unique AUTO EXEC and CONFIG 
files for each MS-DOS program you want to use. 

Multi-configurations for the MS-DOS subsystem are 
unnecessary. Use the PIF Editor Windows NT button to specify 
the location and name of unique AUTO EXEC and CONFIG 
files for each MS-DOS program you want to use. 

Multi-configurations for the MS-DOS subsystem are 
unnecessary. Use the PIF Editor Windows NT button to specify 
the location and name of unique AUTOEXEC and CONFIG 
files for each MS-DOS program you want to use. 

The Msav program is not currently supported. 

Windows NT provides the Backup utility (in the Administrative 
Tools group) for computers with tape drives, or the backup and 
xcopy commands for computers without tape drives. 



Command 

mscdex 

msd 

numlock 

power 

smartdrv 

submenu 

vsafe 
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Comment 

It is unnecessary to configure the MS-DOS subsystem to use 
a CD-ROM drive. Windows NT provides access to CD-ROM 
drives for the MS-DOS subsystem. 

Use WINMSD.EXE in the \WINN1\SYSTEM32 directory. 

The numlock command is not currently supported. 

The Power utility is not currently supported. 

Windows NT automatically provides caching for the MS-DOS 
subsystem. 

Multi-configurations for the MS-DOS subsystem are 
unnecessary. Use the PIF Editor Windows NT button to specify 
the location and name of unique AUTO EXEC and CONFIG 
files for each MS-DOS program you want to use. 

The Vsafe program is not currently supported. 

Differences from LAN Manager Commands 
Windows NT retains many LAN Manager commands. This section explains the 
significant differences between Windows NT commands and LAN Manager 
commands. 

New Windows NT Network Commands 
This table explains' new network related commands. 

Command 

ipxroute 

net computer 

net local group 

net start c1ipbook 
server 

net start computer 
browser 

net start eventlog 

net start locator 

Function 

Manages the source routing variables of the NWLink protocol 
. on a token-ring network. This command is available only if the 
NWLink protocol has been installed. 

Adds computers to Windows NT Advanced Server domains 
(Advanced Server only). 

Manages local groups. 

Starts the Clipbook Server service. 

Starts the Computer Browser service. 

Logs any significant system, security, and application 
occurrences that require users to be notified. 

Starts the RPC Locator service. 
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Command 

net start network dde 

net start network dde 
dsdm 

net start rpcss 

netstart schedule 

net start tcpip 

net start tcp/ip netbios 

net start tcp/ip netbios 
helper 

net start telnet 

portuas 

Function 

Starts the Network Dynamic Data Exchange service. 

Starts the Network Dynamic Data Exchange service. 

Starts the RPC subsystem. 

Starts the Schedule service, enabling the at command. 

Starts the TCP/IP service. 

Starts the NetBIOS over TCP/IP service. 

Starts the NetBIOS over TCP/IP service. 

Starts the Telnet service. 

Converts a LAN Manager user account subsystem to a 
Windows NT user account database. 

Changes to LAN Manager Commands 
This table identifies changes to LAN Manager commands. 

Command 

net accounts 

net config 

net config server 

net config 
workstation 

net continue 

net group 

net pause 

net print 

net send 

New or changed feature 

Server roles cannot be set. Windows NT security controls 
lockout. 

Peer functionality is an inherent part of Windows NT and no 
longer requires separate commands. 

Most network services are self-configuring. The switches 
/autodisconnect, /srvcomment, and /hidden can be configured. 
The switch /srvhidden is now /hidden. 

Most network services are self-configuring. The switches 
/charcount, /chartime, and /charwait can be configured. 

Use Print Manager to control printing. See net pause in this table 
for the list of services that can be paused. 

Manages global groups and is only for computers that are 
members of a domain. 

You can pause these network services: Alerter, Clipbook Server, 
Computer Browser, Directory Replicator, Messenger, Net Logon, 
Server, Telnet, and Workstation. Use Print Manager to manage 
printers. 

Use Print Manager to manage printers. 

Sending files is not supported. 



Command 

net share 

net start 

net start alerter 

net start directory 
replicator 

net start messenger 

net start net logon 

net start server 

net start snmp 

net start workstation 

net statistics 

net stop 

net use 

net user 

net view 
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New or changed feature 

Remote administration is automatic. Use Print Manager to share 
printers. Communication-device queues are not supported in this 
release. 

You can start these network services: Alerter, Computer 
Browser, Directory Replicator, Eventlog, Messenger, Net Logon, 
Network DDE, Network DDE DSDM, NWLink, NWNBLink, 
RemoteAccess, RFC NetBIOS over TCPIP, RFC NetBIOS over 
TCPIP Helper, RPCLo~ator, RPCSS, Schedule, Server, Snmp, 
Tcpip, Telnet, UPS, and Workstation. Services can be configured 
to start automatically. 

Self-configuring. 

Use Server Manager to configure the Directory Replicator 
service. Previously called net start replica tor. 

Self-configuring. 

Self-configuring. Service name is now two words. 

Use Server Manager to configure the Server service. 

New options permit logging. 

The Workstation service is configured at setup and in various 
applications. 

Peer functionality is an inherent part of Windows NT and no 
longer requires separate commands. The statistics log cannot be 
cleared. 

See net start in this table for the list of services that can be 
stopped. 

The /persistent switch has only yes and no values. 
Comumnication-device queues are not supported in this release. 

Switches /logmlst.:l vel', /max.stOl'age, /operatOl', and /privilege 
are not supported. 

New /domain switch permits viewing of domains and computers 
in a specified domain. 

Unavailable LAN Manager Commands 
This table lists LAN Manager commands that are no longer available at the 
command prompt. The table tells how to accomplish the command, or explains 
why the command no longer exists. 
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Command 

net 

net access 

net admin 

net audit 

netcomm 

net con fig peer 

net console 

net copy 

net device 

net error 

net forward 

net log 

net logoff 

net logon 

net move 

net password 

net run 

net separator 

net start netpopup 

net start netrun 

net start nvalert 

net start peer 

net start remoteboot 

net start timesource 

net status 

net version 

net who 

New procedure or reason for obsolescence 

Use the Windows NT administrative tools to administer 
the network. 

Use File Manager to set permissions on files. 

Use the Windows NT administrative tools to administer 
the network. 

Use Event Viewer to track network resource use. 

Communication-device queues are not currently supported. 

Not needed with Windows NT. 

Use Windows NT security features to prevent unwanted access. 

Identical functionality is not available in Windows NT, however, 
you can use File Manager or the system copy command to copy 
files. 

Use Print Manager to display information about shared printers. 

Use Event Viewer to track network resource use. 

You cannot forward network messages with Windows NT. 

Message logging is not supported. 

Logging off is inherent to Windows NT. 

Logging on is inherent to Windows NT. 

Identical functionality is not available in Windows NT, 
however, you can use File Manager or the system copy and 
delete commands to move files. 

Press CfRL+ALT+DEL to change your password. 

Programs cannot be executed remotely in Windows NT. 

Use Print Manager to control separator pages. 

Windows NT processes network messages automatically. 

Not supported in Windows NT. 

The Nvalert service is not currently supported. 

Peer functionality is an inherent part of Windows NT. 

The Remoteboot service is not currently supported. 

The functionality is included in the Server service. 

The information can be found using net config server 
and net share. 

Use winver to determine the current Windows NT version. 

Use Server Manager to view connections to a server. 



CHAPTER 10 

Object Linking and Embedding 

In \Vindows NT, you can share information between applications using the 
special object linking and embedding (OLE) capabilities of Windows-based 
applications. . 

This chapter provides an overview of methods for sharing information between 
applications or docUlnents, including the following topics: 

• An overview of object linking and embedding 

• Linking or embedding an object with menu commands 

• Linking or embedding objects with OLE applications 

a MdiHtainli~g linked or embedded objects 

291 
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Overview 
With object linking and embedding, you can combine information from several 
applications into one compound document. You can also edit the information, 
without knowing which application was used to create it. 

The applications included with Windows NT that have OLE capabilities are 
Cardfile, ClipBook Viewer, Mail, Paintbrush, Sound Recorder, and Write. For 
more information about how to use the OLE features of these Windows NT 
accessories, see the online Help for each. For information about the OLE 
capabilities of other Windows-based applications, see the documentation for 
those applications. 

Basic Building M.aterials:.S.ton.es Required 

Site Arch I Arch II Arch III 
Alhambra· 103 107 11 
mon 107 111 105 
Total· 210 218 116 

Use object linking and embedding 
to display information from other 
applications in a compound 
document. 

t!.elp 

Building Plan for New Arches 

for the new arches to be built at Alhambra and Dijon. 

Basic Building Materials: Stones Required 

Site: Arch I Arch II Arch III 

Alhambra 103 107 11 
Dijon 107 111 105 

Total: 210 218 116 

The following are basic OLE terms: 

• An object is any document, part of a document, or command created in a 
Windows-based application that has OLE capabilities. For example, a single 
cell in a spreadsheet, a range of cells, or an entire spreadsheet might be 
inserted as a linked or embedded object in a word processing document. When 
you choose an object to edit it, the application associated with that object starts 
automatically. 
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• A package is an embedded icon that contains an object. A package can be 
inserted into any document created in an OLE application. When you choose a 
package, Windows executes any command associated with the package or runs 
the application in which the packaged information was originally created. 

• A compound document is any document that contains a linked or embedded 
object or package. 

for the new arches to be built at Alhambra and Dijon. 

Basic Buildinq Materials: Stones Required 

Site: Arch I Arch II Arch III 
Alhambra 103 107 11 
Dijon 107 111 105 
Total: 210 218 116 

Double-click a linked or embedded 
object like this Paintbrush object 

to start the original application. 

Double-click a package like 
this icon to open it-for 
example, to playa sound file. 

Iext 

Two kinds of documents can be involved when you create linked or embedded 
objects and packages: 

• A source document is the file where the information in the object or package 
was originally created. For example, if you want to paste art from Paintbrush 
into another document, the .BMP or .PCX file that contains the original 
artwork is the source document. If an object is embedded, it no longer has a 
source document. 

• A destination document is the file where the object or package is inserted. For 
an embedded object, this is sometimes also called the container document. For 
example, if you paste art from Paintbrush into a document created in Microsoft 
Write, that text file is the destination document. 
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You can insert a linked object in a destination document to display information 
that was created and saved in another document. The information in the 
destination document can be updated dynamically (that is, continuously and 
automatically) whenever the source document changes. 

The content of a linked object is 
saved in the source document, so 
you always edit the original file. 

Source document 
in X:\DATA 

Link 

client.wri 

Destination document 
in C:\REPORT 

You can insert an embedded object in a destination document to present 
information created in another application; the information in the embedded 
object need not exist in another file outside your document. Use an embedded 
object when you want to make changes while working in your document, but 
do not need to save the information separately. 

--+-14- An embedded object is saved in the 
destination document, so you always 
edit its contents directly. 

You can also insert a package in a document when you want users to be able 
to run a command from within a compound document or when you need only to 
display a representation of the information the source document contains. For 
example, if some readers will want to view background information, you might 
place a background document as a package in a summary report; readers can 
choose the package to open that document or ignore it. 
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OLE applications can act as either client or server: 

• A client application is any Windows-based application that can display and 
store linked or embedded objects. For example, if you paste art i.nto a Write 
document, then Write is the client application. The OLE client application 
stores all information for an embedded object, such as its page position and 
how the object is activated and displayed. 

• A server application is any Windows-based application in which you can edit 
an object that you selected in an OLE client application. For example, if you 
choose art you pasted in a Write document, then the server application runs 
(for example, Paintbrush). 

You can create a compound document that includes formatted text, graphics, and 
information from a spreadsheet or a database, plus icons that run sound recordings 
or play multimedia devices. The more hardware your system has for creating and 
playing multimedia through sound boards, CD-ROM, and other media players, 
the more complex and rich a document you can create using object linking and 
embedding. 

But even using a basic PC and the applications included with Windows NT such 
as Write and Paintbrush, you can take advantage of linking and embedding to 
create compound documents. You use applications and features in Windows with 
which you maY'already be familiar, including several Edit menu commands in 
Windows-based applications, plus ClipBook Viewer, File Manager, and Object 
Packager. 

Feature or application 

Edit-menu commands 
in Windows-based applications 

ClipBook Viewer 

File Manager 

Object Packager 

Used for 

Creating objects, editing object content, and repairing or 
removing links. For details, see "Linking or Embedding 
an Object with Menu Commands." 

Saving and sharing Clipboard contents, and linking 
objects saved on another computer. For details, see 
"Using ClipBook Viewer." 

Linking or embedding files in documents through 
copying or drag-and-drop. For details, see "Using File 
Manager to Create a Package." 

Creating and editing packages that contain files, parts 
of documents, or commands. For details, see "Using 
Object Packager to Create a Package." 
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File Security and Linked Objects 
Because an embedded object is simply part of the document that contains it, the 
access restrictions that apply to the document also apply to embedded objects 
within the document. 

The security of linked objects, however, is defined with the source document. 
The object you see in the destination document is only a representation of data 
contained in the source document. Suppose, for example, a word processing 
document contains a linked chart that was created in a spreadsheet product. The 
word processing document contains a copy of the chart, which you can view or 
print. But to edit the chart, you must have write permission for the source 
document, the file that contains the chart. 

Linking or Embedding an Object with Menu Commands 
The procedures for linking or embedding objects with menu commands are 
generally the same as those you use for copying and pasting information. 

The following table shows typical commands used for sharing information in 
Windows-based applications. Check the documentation for your application to 
find the actual command names used. 

Command 

Paste 

Paste Link 

Paste Special 

Links 

Insert Object 

Action 

Inserts information from the Clipboard into the destination 
document. 

Inserts a linked object from the Clipboard. The information 
appears in the destination document but is defined and stored 
in the source document. 

Displays a dialog box so you can choose the data format for 
the object before pasting it, and also choose either to paste a 
linked object or to paste only the information. 

Displays the Links dialog box so you can update the display 
of an object, cancel links, repair broken links, or edit an 
object. 

Displays a dialog box so you can choose the type of object 
to insert, and then embeds the object you create in the 
destination document. This command is a shortcut for 
running the server application to create the information, 
copying the information to the Clipboard, and then pasting 
it into the destination document with Paste Special. 



Command 

Object 
(command name varies) 
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Action 

Starts the server application so you can edit or open a linked 
or embedded object. The actual command name depends on 
the selected object, such as Package Object or Picture. This 
command name might also be, for example, Edit Object, 
depending on the action allowed for that object. If several 
actions are possible, choosing this command displays 
another menu that lists other commands. 

Some Windows-based applications such as Microsoft® Excel provide macros 
to control linking and embedding actions, using dynamic data exchange (DDE). 
For more information, see the technical reference for your application. 

The following sections describe basic procedures for linking and embedding 
objects using the menu commands in your Windows-based applications. 

Creating a Linked or Embedded Object 
You can use the copy-and-paste commands from the Edit menu of OLE 
applications to create linked or embedded objects. 

1> To create an embedded object using the Edit menu commands 

1. Open the source document, select the information to be embedded, 
and then choose Copy from the Edit menu. 

2. Open the destination document, and then move the insertion point to 
where you want to insert the embedded object. 

3. Choose Paste from the Edit menu. 

The result depends on the OLE capabilities of the applications used to create 
the source and destination documents. If you choose the Paste command in an 
application that does not support OLE, a static copy of the information is placed 
in the document. But if the application supports OLE, the information is placed 
in the best available format. For example, in Microsoft Write when there is 
text on the Clipboard, the information is pasted as text, not as an object. If the 
information is in Bitmap format, then the information is pasted as a Picture object. 

You can also create an embedded object while working in the destination 
document by choosing the Insert Object command. For more information, see 
the documentation for your application. 

1> To create a linked object using the Edit menu commands 

1. In the server application, open the source document. 

If you want to create a linked object, make sure the file for the source 
document has been saved. 
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2. Select the information to be linked. 

3. From the server application's Edit menu, choose Copy. 

4. In the client application, open the destination document, and then move the 
insertion point to where you want to insert the linked or embedded object. 

5. Choose Paste Link from the client application's Edit menu. 

If the Paste Link command is not available, but you know there is information on 
the Clipboard, then the source document has not been saved. You must save the 
document before copying information, or save the information on the Clipboard 
in your local ClipBook as described in "Using ClipBook Viewer," later in this 
chapter. 

In some applications, you can choose Paste Special if you want to choose the 
data type before pasting. Choosing the Paste button in this dialog box without 
choosing another data type has the same effect as choosing Paste from the Edit 
menu. The Paste Link button is available only if the format you select is 
supported by the application used to create the destination document. 

Qata Type: . 

Microsoft Word Object 

Unformatted Text Choose Paste Link to 
create a linked object. 

Note If you copy a linked object and paste it into another destination document, 
the link to the original source document is also copied and pasted. 

Linking or Embedding Objects 
with OLE Applications in Windows NT 

In addition to the accessories included with Windows NT such as Write and 
Sound Recorder that have OLE capabilities, several applications in Windows NT 
can be used to manage activities related to creating linked or embedded objects. 
These applications include the ClipBook Viewer for managing the Clipboard 
contents, and also File Manager and Object Packager for creating packages. 
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Using ClipBook Viewer 

11 ClipBook Viewer provides temporary or permanent storage for information 
you want to transfer or share between applications and among members of 
your workgroup. You start ClipBook Viewer in the same way you do other 
applications, by choosing its icon in the Program Manager Main group. For 
information about all the options available in Clip Book Viewer, choose the 
Help button or press Fl. 

The following list shows the tools on the ClipBook Viewer toolbar. You can 
use these tools to choose commands and switch views. 

Use To Use To 

tltJD Connect to a ClipBook on another ~ Paste the contents of the Clipboard 
computer into the ClipBook 

~ Disconnect from a ClipBook on [8] Delete contents of the Clipboard 
another computer or selected ClipBook page 

~ Share a ClipBook page ~ Display the titles of the pages saved 
in the ClipBook 

~ Stop sharing a ClipBook page ~ Display thumbnail pictures of each 
,> 

page in the ClipBook 

~ Copy a selected ClipBook page ~ Display the contents of a selected 
onto the Clipboard ClipBook page 

Saving and Sharing Information with ClipBook Viewer 
You can use the Cut, Copy, and Paste commands in Windows-based applications 
to place part or all of a document onto the Clipboard for pasting into another 
document. To store information placed on the Clipboard, you can paste it into 
your local ClipBook. Each item you paste into the ClipBook is called a page. 

Your local ClipBook can hold up to 127 pages of information, and each page can 
have a name of up to 47 characters. The amount of information each page can 
hold is limited only by available storage space on your computer's hard disk. 

Clipboard ClipBook Viewer 

A 
~ 
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~ To save information in ClipBook Viewer 

~ 
1. 

2. 

3. 

Cut or copy any amount of information in your Windows-based application. 

From the Edit menu in ClipBook Viewer, choose Paste. Or choose the Paste 
button from the toolbar. 

In the Paste dialog box, type a name for the page, and then choose the OK 
button. 

f.age Name OK 

[3J ~hare Item Now 

····Help 

You can copy information from ClipBook pages to place into documents created 
by other OLE applications, and you can share ClipBook pages with other users. 

~ To share a ClipBook page 

1. In ClipBook Viewer, select the page you want to share. 

D 2. From the File menu, choose Share. Or choose the Share button on the toolbar. 

3. In the Share ClipBook Page dialog box, select the Start Application On 
Connect check box if the page contains data other than a bitmap or plain text. 

Other users cannot establish links to formatted data unless the application used 
to create the information is already running on your computer. 

4. If the Start Application On Connect check box is selected, select the Run 
Minimized check box if you want the application to start"as a minimized icon. 

S. If you want to change users' permissions to access the shared page, choose the 
Permissions button. For help in setting permissions, see "Setting Permissions 
on a ClipBook Page," later in this chapter. 

By default, you have full control over a page you create, and everyone else has 
Read and Link access. 

After you share a page, other workgroup members who know the correct 
password for the page can connect to your computer and use the shared page 
in their documents. You can also use ClipBook Viewer to connect to another 
person's computer, and then use any shared ClipBook pages from that computer 
in your documents, as described in the following section. 
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Linking an Object from Another Computer 
If the source document is stored on a different computer, you can use 
ClipBook Viewer to place a linked object in a destination document stored on 
your computer. To take advantage of this, the object must be pasted as a page 
on the other computer's ClipBook, and the page must be designated as shared. 

When you usc ClipBook Viewer to link objects, the changes made in the source 
document are made automatically in all destination documents that contain the 
object. 

Source document 

Clipboard 

Clipboard 

Destination document 

t> To link an object stored on another computer 

Shared Clip Book pages 
on Computer1 

A 
§ 

Clip Book Viewer 
on Computer2 

PTI 
L:lJ 

lutJo! 1. Start ClipBook Viewer, and then from the File menu, choose Connect. 
WW) Or choose the Connect button from the toolbar. 

2. In the Select Computer dialog box, type the name of the computer you want to 
connect to, or select the name from the Computers list, and then choose the 
OK button. 

ClipBook Viewer displays the shared pages available in the ClipBook on the 
other computer. 

3. Select the page that contains the information you want to place as a linked 
object in your document. 
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4. From the Edit menu, choose Copy. Or choose the Copy button from the 
toolbar. 

5. From the Edit menu of the destination document, choose Paste Link. 

Or, if the application has a Paste Special command, choose Paste Special. 
Select the format for displaying the information, and then choose the Paste 
Link button. 

6. Open the destination document where you want to place the linked object. 

7. Save the destination document. 

Maintaining the Security of Shared ClipBook Pages 
You can control the access that individual users and groups have to shared 
ClipBook pages. You can also audit users who access shared pages, and you 
can take ownership of a page. 

Setting Permissions on a ClipBook Page 
Setting permissions on a ClipBook page specifies the access that a group or 
user has to it. Permissions are cumulative, except that the No Access permission 
overrides all other permissions. For example, if a user is a member of a group 
with Read permission and a member of a group with Change permission, the 
user will have Change permission. 

To change permissions on the ClipBook page, you must be the owner of the page, 
or have been granted permission to do so by the owner. 

r> To change or remove permissions on a ClipBook page 

1. Select a ClipBook page from the ClipBook window. 

2. From the Security menu, choose Permissions. 

3. Select the name of the group or user whose permission you want to change. 

4. Choose a permission from the Type of Access box. 

Or, to remove ClipBook page permissions, select the name of the group or user 
in the ClipBook Permissions dialog box, and then choose the Remove button. 

5. Choose the OK button. 

~ To add a group or user to the ClipBook permissions list 

1. From the Security menu, choose Permissions. 

2. In the ClipBook Permissions dialog box, choose the Add button. 

The Add Users And Groups dialog box displays the groups on the computer 
or in the domain shown in the List Names From box. You can select another 
computer or domain from the List Names From box. 
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Domains appear only if your computer is a member of a domain on a Windows 
NT Advanced Server network. The domains shown have a trust relationship 
with the domain your computer belongs to. 

3. You can use options in the Add Users And Groups dialog box to display users, 
find the users in a group, or find the domain to which a group or user belongs. 

• To display the names of users on the selected computer or domain, choose 
the Show Users button. 

• To list a group's members, select the group, and then choose the Members 
button. Users are listed in a new dialog box. On a Windows NT Advanced 
Server network, global groups that are members of a local group appear in 
the list. To see a global group's members, select the group and choose the 
Members button. To include the group in the Add Users And Groups dialog 
box, choose the Add button. To include some of the group's users, select 
those users, and then choose the Add button. 

• To add a domain group or domain user, you must know which domain 
contains the group's or user's account. On a Windows NT Advanced 
Server network, choose the Search button to find the domain of a group or 
user. In the Find Account dialog box, type the name of the group or user in 
the Find User Or Group box, and specify the domains you want to search. 
Then choose the Search button. To include the groups or users in the Add 
Users And Groups dialog box, select them in the Search Results box, and 
then choose the Add button. 

4. To add groups or users to the permissions list, select them and choose the 
Add button, or double-click the name of the group or user. Or you can type 
the names of groups and users in the Add Names box, separating the names 
with a semicolon. 

If the account of the group or user is not located on the computer or domain 
shown by the List Names From box, you must specify the location. Type the 
computer or domain name followed by the group or user name and separate 
the names using a backslash, for example shipping\ernesta. You can type the 
name without waiting for Windows NT to list groups in the Names box. 

5. In the Type of Access box, select the permission for the groups or users 
shown in the Add Names box. 

6. Choose the OK button. 

For help with any dialog box, choose the Help button, or press FI while using 
the dialog box. 



304 System Guide 

Auditing ClipBook Pages 
You can monitor, or audit, how specified individual users or members of groups 
are using shared ClipBook pages. You can audit both successful and failed 
actions. Windows NT stores the information generated from auditing in the 
security log. For information on the security log, see Chapter 15, "Event Viewer." 

To audit ClipBook pages, you must set the file and object access. Set audit policy 
in User Manager. 

~ To audit pages, you must be logged on as a member of the Administrators group. 

I> To audit a ClipBook page 

1. In the ClipBook window, select the ClipBook page. 

2. From the Security menu, choose Auditing. 

3. Select the name of the group or user. 

4. Select the events to audit, and then choose the OK button. 

You can modify the aUditing list for a shared ClipBook page at any time. You can 
add groups or users, and you can remove them. 

I> To add a group or user to the auditing list 

1. In the ClipBook window, select the ClipBook page. 

2. From the Security menu, choose Auditing. 

3. In the Auditing dialog box, choose the Add button. 

The Add Users And Groups dialog box displays the groups on the computer 
or in the domain shown by the List Names From box. You can select another 
computer or domain by using the List Names From box. 

4. You can use options in the Add Users And Groups dialog box to display users, 
find the users in a group, or find the domain to which a group or user belongs. 

• To display the names of users on the current computer or domain, choose 
the Show Users button 

• To list a group's members, select the group and choose the Members 
button. Users are listed in a new dialog box. On a Windows NT Advanced 
Server network, global groups that are members of a local group appear 
in the list. To see a global group's members, select the group and choose 
the Members button. To include the selected group in the Add Users And 
Groups dialog box, choose the Add button. To include some of the group's 
users, select those users, and then choose the Add button. 
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• To add a domain group or domain user, you must know which domain 
contains the group's or user's account. On a Windows NT Advanced 
Server network, choose the Search button to find the domain of a group or 
user. In the Find Account dialog box, type the name of the group or user in 
the Find User Or Group box and specify the domains you want to search. 
Then choose the Search button. To include the groups or users in the Add 
Users And Groups dialog box, select them in the Search Results box and 
choose the Add button. 

5. To add groups or users to the audit list, select them in the Names box and 
choose the Add button, or double-click the name of the group or user. Or you 
can type the names of groups and users in the Add Names box. Separate names 
with a semicolon. 

If the account of the group or user is not located onthe computer or domain 
shown by the List Names From box, you must specify the location. Type the 
computer or domain name followed by the group or user name and separate 
the names using a backslash, for example, shipping\ernesta. You can type 
the name without waiting for Windows NT to list groups in the Names box. 

6. Choose the OK button. 

t> To remove ClipBook page auditing for a group or user 

1. In the ClipBook window, select the ClipBook page. 

2. From the Security menu, choose Auditing. 

3. In the Auditing dialog box, select the name of the group or user in the list. 

4. Choose the Remove button. 

For help with any dialog box, choose the Help button, or press Fl while using the 
dialog box. 

Taking Ownership of a ClipBook Page 
When you create a ClipBook page, you become the owner of it. By granting 
permissions, the owner controls how the ClipBook page is used. 

To take ownership of a ClipBook page, you must either have Full Control access 
to the page or you must be logged on as a member of the Administrators group. 

Although an administrator can take ownership, an administrator cannot transfer 
ownership to others. This preserves security. For example, only an administrator 
who takes ownership and changes permissions can gain access to a ClipBook 
page on which the original owner has set No Access permission. 
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J> To take ownership of a ClipBook page 

1. Select the ClipBook page in the ClipBook Viewer window. 

2. From the Security menu, choose Owner. 

3. Choose the Take Ownership button. 

Viewing the Contents of the Clipboard 
With the Windows NT Clipboard, you can view information that has been cut or 
copied. You can view the contents of the Clipboard in a variety of formats, and 
you can save it as either a page in a ClipBook or as a file. You can also open files 
created in Clipboard and paste them in other documents. 

J> To start Clipboard in ClipBook Viewer II · In the ClipBook Viewer window, choose the Clipboard icon. 

The View menu lists all the formats you can use to display the information 
currently on the Clipboard. Formats that are internal descriptions used by 
applications cannot be displayed on the screen. Such formats are also unavailable 
on the menu. 

• To view the Clipboard contents in another format, choose a format name from 
the View menu. To return to the format that appeared when you first started 
Clipboard, choose Default Format. 

The formats available depend on the source application. For example, a 
graphics application such as Paintbrush might provide formats that other 
graphics applications can use, such as Bitmap, Picture, and Enhanced Metafile. 
The Native, ObjectLink, and OwnerLink formats cannot be displayed in 
Clipboard, but are used by the client application to identify what kind of 
information is on the Clipboard. 

• To save the Clipboard contents in a file that you can later open for pasting into 
documents, choose Save As from the File menu, and then specify a filename. 
Clipboard automatically adds the .CLP filename extension to the file. 

• To open a Clipboard file for pasting contents into a document, choose Open 
from the File menu, and then select a filename from the list provided. 

Embedding a Package 
A package is an embedded icon that contains an object, a file or part of a file, 
or a command. You might choose to embed a package in a document in various 
situations. For example, you can embed an icon: 

• To represent non-visual information, such as a sound clip for multimedia. 
At any time, you can choose the icon to play the recording. 
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• To represent a specific document or executably file in a Mail message, 
so your readers can easily view or use the file contents. 

• To serve as a navigational link that connects information in various parts 
of other documents. 

You can create, edit, and insert a package in several other ways, as described 
in the following sections. The following table summarizes these methods. 

To create a package 

Copy a file in File Manager. 

Drag a file icon from File Manager. 

Start Object Packager and follow 
the steps in Help. 

To insert a package 
in a destination· document 

From the client application's Edit menu, 
choose Paste or Paste Link. 

Drop the file icon in the window of the 
destination document. 

From the client application's Edit menu, 
choose Paste. 

Using File Manager to Create a Package 
You can copy a file in File Manager and then use the Edit menu commands in 
your application to insert it as a package in a destination document. Or you can 
drag a file icon from File Manager to an application window if you want to link 
or embed the file as a packaged object. 

For example, in a summary document you might embed a file package to serve as 
a token for another report or supporting details. Anyone who reads the summary 
document online can choose the icon to view the supporting report. 

The embedded file must be associated with a file type and its filename extension 
defined in the Associate dialog box in File Manager. For information about how 
to add or change these associations, see Chapter 4, "File Manager." 

I> To link or embed a file package with Edit menu commands 

~ 1. In File Manager, copy the file you want to link or embed. 

2. From the Edit menu in the destination document, choose Paste or Paste Link. 

~ To embed a file package with drag-and-drop 

1. Start File Manager. 

2. Start the client application and open the destination document. 

3. To embed a file as a packaged object, drag its icon from File Manager, 
and then drop it in the window that contains the destination document. 

The icon for the associated application is displayed in the destination 
document, with the filename as its label. 
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Note If you want to create a file package with File Manager, the server 
application must have been written for Windows NT or Windows 3.1. If your 
application was written for an earlier version of Windows or for another operating 
system, you must use Object Packager to create the file package. Also, if you 
want the package to contain a linked document, you must use File Manager to 
place the file in Object Packager. 

Using Object Packager to Create a Package 
Object Packager is an application provided with Windows NT that you can use 
to create packages for placement in documents. With Object Packager, you can: 

• Create a package that contains a document or an executable command. 

• Create a package that contains a linked object. 

• Edit a package's contents, icon, or label. 

Creating a package with Object Packager is the best choice when you want, for 
example, to share an object by including it in an electronic mail message. This 
way, all users can view the object contents without having to receive large files 
that mayor may not be important to individual recipients. 

~ To start Object Packager 

1. From the File menu in Program Manager, choose Run. 

2. In the Command Line box, type packager and then press ENTER. 

To get help with Object Packager features and commands, press FI. 

Note If you place information in Object Packager that was created in an 
application that does not support OLE, the Picture option is not available. 

I> To create a package in an e-mail message 

1. Save the source document in a shared directory. 

2. Start Mail and compose your e-mail message. 

3. From the Edit menu in Mail, choose Insert Object, and then in the Object Type 
box select Package. 

4. From the Edit menu in Object Packager, choose Command Line, and then type 
a complete path name for the file that you saved in a shared directory in step 1. 

For example, type \\server! \public\filename.txt to identify a file saved in the 
root directory of the network server named \\server1 \public. 
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5. Choose the Insert Icon button in the Object Packager window, and then select 
an icon for the package you are sending. You can also choose Label from the 
Edit menu to define a label for the package. 

6. From the File menu in Object Packager, choose Exit, and then choose Yes in 
the message that asks if you want to update the mail message. 

7. Send your e-mail message in the usual way. 

Each user who receives this e-mail message can choose the icon in the 
message to start the server application and view the contents of the file in the 
shared directory. 

Maintaining Linked or Embedded Objects 
After you create a linked object, you can edit, change, or break the link. You can 
also follow several steps to solve problems you might encounter with objects in 
destination documents, such as fixing broken links, finding unavailable server 
applications, or updating a linked object. 

Editing an Object 
After a linked or embedded object has been inserted into a document, you can edit 
it by choosing the object or by using menu commands to run the server 
application. 

If the object is a package, you must copy that package to the Clipboard and paste 
it into Object Packager to edit it. Then you can place the revised package back in 
your destination document as described earlier in this chapter. 

t> To edit a linked object 

1. In the destination document, choose the object. The associated server 
application starts and the source document for the object is opened. 

2. Edit the object using the server application. 

After you finish editing, the changes are automatically reflected in any 
destination document that displays the linked object. 

Or, if the object has a manual link, choose the Update Now button in the Links 
dialog box to update the object. (For more information, see the online Help for 
the Links command in the destination application.) 

3. To save changes, choose Save from the server application's File menu while 
working in the source document. 

t> To edit an embedded object 

1. In the destination document, choose the object to run the server application 
associated with the object. 
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2. After you finish editing, choose Update from the server application's File 
menu, and then choose Exit to close the server application. 

3. To save changes, while working in the destination document choose Save from 
the client application's File menu. 

The changes are saved only in the destination document, not in a separate file. 

You can cancel a link so that updates in the source document are no longer made 
in the destination document. If you cancel a link and then decide you want to 
make changes, you must edit the object in the original application or source 
document, and then copy and paste it back into the destination document. 

I> To cancel a link 

1. In the destination document, select the object whose link you want to cancel. 

2. In the Links dialog box, make sure the selected object is highlighted in the list. 
Choose the Cancel Link button, and then choose the OK button. 

The information contained in the linked object remains in the destination 
document. Only the link has been removed. 

In many applications, you can temporarily lock a linked object so that its contents 
are not updated or changed when other links are updated. You cannot edit a linked 
object that is locked. 

I> To lock or unlock a linked object 

1. Select the linked object in your document, and then from the application's Edit 
menu, choose Links. 

2. Select or clear the Locked check box to lock or unlock a linked object, 
respectively, and then choose the OK button . 

. You can delete an unlocked object, like any other object, from the destination 
document by choosing the Cut or Clear command from the Edit menu. 

Solving Problems with Linked or Embedded Objects 
This section describes solutions to problems you might encounter with linked 
or embedded objects in OLE applications. 

Changing a Link or Fixing a Broken Link 
You can use the Links command in the client application to change the filename 
of the source document to which an object is linked. For example, you might 
insert a report as a linked object in a spreadsheet. If you want that linked report 
to show information from a new file, you can change the link without replacing 
the object. 
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Also, the link to a source document can be broken if the location of the source 
document changes. To repair a broken link in the destination document, you can 
use the Links command to change the filename or path of the source document so 
that the link will work correctly again. 

~ To change a link or fix a broken link 

1. In the destination document, select the object whose link you want to change. 

2. From the Edit menu, choose Links. 

The following illustration shows an example of the Links dialog box, though 
it may appear somewhat different in various applications. 

!oinks: 

Update: @ Au!omatic 0 Manual 
Edit 

I llPdate Now I I Cancel Link l'thaniJ~J!ri~~:'J' 

3. In the Links dialog box, choose the Change Link button. 

The Change Link dialog box appears, with options and control buttons 
that work the same way as those in the Open or Save As dialog box. 

4. In the File Name box of the Change Link dialog box, select the source 
document for the object's link, and then choose the OK button. 

5. When the Links dialog box reappears with the filename of the new source 
document selected, choose the OK button. 

If a link no longer works after you try to repair it, you might need to delete the 
linked object, and then start over by pasting the object from the source document. 

Responding to a "Server Unavailable" Message 
You might receive a "server unavailable" message when you try to create, edit, 
play, or update an object in a destination document. The server application cannot 
respond if it is currently printing or performing other actions, or if a dialog box is 
open. To solve this problem: 

• Wait a few moments to find out if the application becomes available. If it does, 
the message disappears and your request is processed. 

• Or choose the Cancel button in the message, and then switch to the server 
application. Complete or cancel the action that causes the application to be 
unavailable. 
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• Or make sure that the server application and source document are located in 
shared directories to which you have access. If the source document is on a 
different computer, make sure that computer is running. 

Finding an Application if the Insert Object Command Fails 
If you select an object type in the Insert Object dialog box, but the application 
doesn't open, then Windows NT cannot find the application. To solve this 
problem: 

• Make sure the server application for this object type is on your computer. 
For example, Sound Recorder (SOUNDREC.EXE) must be on your computer 
before you can insert or run a Sound object. 

• Make sure the directory for the server application matches the location 
specified in the Associate dialog box in File Manager. 

Updating a Linked Object 
Sometimes a linked object must be manually updated in the destination document 
before changes appear in the destination document, regardless of whether the 
object is designated for auto"matic or manual updating. This is true for links that 
contain text, spreadsheets, or pictures because these objects are represented by 
images reproducing the information in the source documents. This is not true for 
links to sound or animation files because these links are represented by icons. 

If you make changes in the source document while the destination document is 
open, you must save the source document and update the linked object in the 
destination document to see the changes. 

~ To update a linked object 

1. In the destination document, select the linked object. 

2. From the Edit menu, choose Links. 

3. In the Links dialog box, choose the Update Now button, and then choose 
the OK button. 

If you still have problems when you are trying to edit a linked object from the 
destination location, try the following: 

• Make sure the source document for the linked object you are editing is not 
located on another computer. 

• If the source document is located on another computer, make sure that 
computer is running. 
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Other Application Environments 

In addition to 32-bit applications designed for Windows NT, Windows NT 
supports applications designed for the following environments: Windows 3.1, 
MS-DOS, 16-bit OS/2, and POSIX. 

This chapter provides information on these environments, including the 
following topics: 

• How Windows NT runs applications 

• The Windows 3.1 environment 

• The MS-DOS environment 

• The OS/2 environment 

• Setting up and starting applications 

• Creating program information files (PIFs) 

313 
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How Windows NT Runs Applications 
Windows NT is a modular operating system that uses operating subsystems to 
run applications. Each subsystem provides a different operating environment for 
applications. Windows NT runs Windows 3.1, MS-DOS, 16-bit OS/2, and POSIX 
based applications in addition to 32-bit applications designed for Windows NT. 

The table below shows the Windows NT subsystems and the applications each 
subsystem supports. 

Subsystem 

Windows 

MS-DOS 

OS/2 

POSIX 

Supports 

Windows NT and Windows 3.1 based applications 

Windows 3.1 and MS-DOS based applications 

16-bit character-based OS/2 applications (on x86-based 
computers only) 

POSIX applications compliant with IEEE Std 1003.1 and 
compiled using Windows NT 

The Windows NT Executive is the portion of the operating system at the center of 
Windows NT that manages processes and memory. You can think of a process as 
a discrete set of computing tasks. Each time you start an MS-DOS, Windows 3.1, 
OS/2, or POSIX application, the Executive starts a process for the application's 
subsystem and starts the application within the process. When you run Windows 
3.1 based applications, applications run as tasks within a single process. 

Each process is protected. That is, the Executive makes sure that each process 
runs in its own area of the computer's memory. In this way, processes cannot 
interfere with one another. If an application fails, that failure will not affect the 
rest of the system. 

Any application that you can run in Windows NT runs seamlessly. That is, you 
can start any application from Program Manager, File Manager, or the command 
prompt without concern for what sort of operating environment the application 
requires. This seamlessness allows full interaction among applications. 
Windows NT supports object linking and embedding (OLE), dynamic data 
exchange (DDE), full clipboard operation, and named pipes. 

Supported Applications 
Windows NT can run most Windows 3.1, MS-DOS, and 16-bit character-based 
OS/2 applications. Some existing applications require special device driver 
support because they directly address computer hardware. Without special device 
drivers, these applications could cause the entire system to fail or could violate 
system security. 
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In many cases, such applications require only a new device driver in order to 
run on Windows NT. If you have an application for which a device driver is not 
supplied, check the application's manufacturer for the availability of new drivers. 
In other cases, the manufacturer may have upgraded the application. Check the 
application's manufacturer for the availability of an upgrade designed to run with 
Windows NT. 

The following types of existing applications require either new device drivers 
or an application upgrade: 

• Applications that directly address hardware; for example, FAX cards, scanner 
cards, or terminal emulation cards 

• Applications that rely on their own disk device drivers; for example, 
applications that increase hard disk capacity 

• Applications that directly address disk drives; for example, disk maintenance 
applications 

• Applications that rely on their own graphics device drivers to address the 
hardware; for example, applications that use private printer drivers 

Windows 3.1 Environment 
Windows NT provides a complete operating environment for Windows 3.1 
applications. The environment is comparable to the enhanced mode environment 
in Windows 3.1 where: 

• Virtual memory is supported (on x86-based computers only). 

• Object linking and embedding (OLE) is supported. 

• Dynamic data exchange is supported. 

On RISC-based computers, Windows NT provides the equivalent of the Windows 
Standard Mode environment. 

Configuring the Windows 3.1 Environment 
When you install Windows NT, the installation program checks to see whether 
a previous version of Windows is installed on the computer. If it is, you should 
install Windows NT in the same directory as the previous version of Windows. 
This allows Windows NT to configure its environment based on the existing 
environment and allows Windows NT to support all the features of currently 
installed Windows 3.1-based applications. 
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Previous versions of Windows store Windows environment information in 
the WIN.INI and SYSTEM.INI files. Unlike previous versions of Windows, 
Windows NT stores this information in its registry database. If you installed 
Windows NT in the same directory as Windows 3.1, when you first log on to 
Windows NT, Windows NT migrates any program groups that are not predefined 
for Windows NT (such as Main or Accessories) and the settings that configure 
your desktop. 

Windows NT maintains the information needed to support Windows 3.1 
applications by reading the WIN.INI, SYSTEM.INI, and REG.DAT files each 
time you start Windows NT. At startup, Windows NT retrieves the information 
and stores it in the registry. For example, if you installed a new application while 
running Windows 3.1, Windows NT will automatically gather file association and 
object linking and embedding (OLE) information for the new application when 
you start Windows NT. 

If you run Windows NT only, the WIN.INI and SYSTEM.INI files will not 
contain any Windows environment information. However, the files are available 
for use by Windows 3.1-based applications that require them to store their own 
configuration information. 

MS-DOS Environment 
Windows NT provides a complete operating environment for MS-DOS 
applications. 

• Expanded memory is emulated for applications that require it. 

• On x86-based computers, character-based applications run either in a window 
or the full screen. Applications that use graphics run in the full screen. 

• On RISC-based computers, character-based and graphics-based applications 
run in a window only. You can change the size of the window using the Screen 
Size And Position command from the Control menu. 

Configuring the MS-DOS Environment 
Windows NT configures the MS-DOS environment by reading the 
AUTOEXEC.BAT file when you log on, and by reading the AUTOEXEC.NT 
and CONFIG.NT files when you start an application in a new command window. 
The AUTOEXEC.NT and CONFIG.NT files are the Windows NT versions of 
AUTOEXEC.BAT and CONFIG.SYS. In addition, you can use custom startup 
files to configure the MS-DOS environment. For more information on custom 
startup files, see "Creating Program Information Files (PIFs )," later in this 
chapter. 
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When you log on to Windows NT, the path and environment variables stored 
in the AUTOEXEC.BAT file are appended to the Windows NT path and 
environment settings. Because this portion of the operating environment is 
established at logon, the values set for the path and environment variables are 
available to each application you use. If you change these values, you must 
log off and log on to Windows NT again so that the changes take effect. 

When you start an application in a new command window, Windows NT reads 
the CONFIG.NT and AUTOEXEC.NT files to configure the environment for 
the application. If, for example, you change an application's driver in the 
CONFIG.NT file, restarting the application puts the change into effect. You can 
edit these files just as you would CONFIG.SYS and AUTOEXEC.BAT. The files 
are located in the C:\ WINN1\SYSTEM32 directory. 

As in previous versions of Windows, Windows NT allows you to customize the 
environment for each MS-DOS application by using program information files 
(PIFs). 

Commands Available in CONFIG.NT 
Windows NT supports the configuration commands shown in the table below. 
If you include commands in your CONFIG.NT file that are not supported, 
Windows NT ignores them. For more information on Windows NT commands, 
see Chapter 9, "Command Prompt." 

Command 

country 

device 

dos 

dosonly 

echoconfig 

fcbs 

files 

install 

loadhigh 

ntcmdprompt 

Function 

Sets the language conventions for a specific country. 

Loads an installable device driver. If necessary, you can load 
drivers that control memory, such as HIMEM.SYS, or that 
control character-based display, such as ANSI.SYS. 

Specifies how the upper memory area will be used. 

Prevents starting applications other than MS-DOS-based 
applications from the COMMAND.COM prompt. 

Switches on the display of CONFIG.NT and AUTOEXEC.NT 
messages when you start an application. 

Sets the number of file control blocks (FCBs) that can be 
opened concurrently. 

Sets the number of files that can be open at one time. 

Loads a memory-resident program into memory. 

Loads device drivers into the upper memory area. 

Runs the Windows NT command interpreter, CMD.EXE, rather 
than COMMAND.COM after running a TSR or after starting 
the command prompt from within an MS-DOS application. 
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Command 

rem 

shell 

stacks 

Function 

Marks lines in the CONFIG.NT file as comments (remarks). 

Specifies the command interpreter. Only the Windows NT 
command interpreter is supported. 

Sets the amount of RAM reserved for processing hardware 
interrupts. 

Commands Available in AUTOEXEC.NT 
Windows NT supports a similar range of commands as MS-DOS for use in the 
AUTOEXEC.NT file. For more information on Windows NT commands, see 
Chapter 9, "Command Prompt." 

Using Program Information Files 
As in previous versions of Windows, when you start an MS-DOS application, 
Windows NT looks for a program information file (PIF) to use with the 
application. If you have been using a PIF to run an application in previous 
versions of Windows, you can continue to use it with Windows NT. However, 
Windows NT eliminates the need to set many PIF options and ignores options that 
do not apply. Windows NT also supports new options. You can specify startup 
files to configure an application's environment for each application you run. 
For more information on PIF options and creating PIFs, see "Creating Program 
Information Files (PIFs)," later in this chapter. 

Some software manufacturers provide a PIF for an application. To determine 
whether a PIF has been supplied, contact the software manufacturer or search 
the disks for a file that has a .PIF filename extension. If you have PIFs from both 
Windows NT and the software manufacturer, use the PIF supplied by the 
manufacturer. 

To use a PIF supplied with an application, copy the PIF to the directory where the 
application's files are located or to the directory where you set up Windows NT. 
Then, set up a program item so you can run the application from its PIF. For 
information about setting up a program item, see Chapter 3, "Program Manager." 

Windows NT includes a PIF named _DEFAULT.PIF, located in the \WINNT 
directory. This PIF contains settings that work with most MS-DOS applications. 
Windows NT uses this PIF when it is the only one available for your application. 
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Running Memory-Resident Programs 
Windows NT supports MS-DOS memory-resident programs, also called pop-up 
and TSR (terminate-and-stay-resident) programs. Like any MS-DOS-based 
application you run in Windows NT, memory-resident programs run in the 
window in which they are started and can be used only within that window. 
MS-DOS-based TSR programs can function reliably only when running alone 
or with other MS-DOS-based applications. 

In general, you should not start memory-resident programs from your 
AUTOEXEC.NT or CONFIG.NT files. If you do, each time you start an 
application that reads these files, you will also start another copy of the memory­
resident program, thereby wasting memory. 

If one of your applications requires a memory-resident program to work properly, 
start the memory-resident program and then start the application in the same 
command window. You can also create a custom startup file that starts the 
memory resident program, and then specify that startup file in the application's 
PIF. For more information on custom startup files, see "Custom Startup Files," 
later in this chapter. 

When you exit an MS-DOS-based application, Windows NT returns to the 
Windows NT command interpreter, CMD.EXE. However, by default, when 
you run a TSR or temporarily suspend an MS-DOS-based application to return 
to the command prompt, Windows NT runs COMMAND.COM, the command 
interpreter for the MS-DOS environment. This preserves the MS-DOS . 
environment, allowing you to use the TSR immediately. Because starting and 
running other types of applications from the COMMAND.COM prompt can 
disrupt a TSR or suspended MS-DOS-based application, Windows NT provides 
the dosonly command. The dosonly command allows only MS-DOS-based 
applications to be started from the COMMAND.COM prompt. You can include 
the dosonly command in your CONFIG.NT file or the equivalent custom startup 
file in an application's PIF. 

When COMMAND.COM is running, some features of the Windows NT 
command prompt, such as the Doskey display of command history, are not 
available. If you would prefer to run the Windows NT command interpreter 
after you have started a TSR or started the command prompt from within an 
MS-DOS-based application, you can use the ntcmdprompt command. However, 
keep in mind that the TSR may not be available for use when you are running 
CMD.EXE. You can include the ntcmdprompt command in your CONFIG.NT 
file or the equivalent custom startup file in an application's PIF. 
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~ To run a memory-resident program with another application 

1. Start the memory-resident program. 

You can start the program as you would any program in Windows NT: 
from the command prompt, from File Manager, or from Program Manager. 

2. Start the application in the same window by typing its name at the command 
prompt and pressing ENTER. 

A convenient way to start a memory-resident program with an application is to 
create a batch program that starts both programs, and then create a PIF for the 
batch program. For example, to create a batch program that starts the pop-up 
program SideKick® 2.0 and the word processor XyWrite®, use Notepad to create 
the following program and save the file as SKXYLOAD.BAT. 

SK2 
EDITOR 

Then use PIF Editor to create a PIF that specifies SKXYLOAD.BAT in the 
Program Filename box. Give the PIF the same base name as the batch program, 
for example SKXYLOAD.PIF. You can start the programs from Program 
Manager by creating a program item for either the PIF or the batch program. You 
can also start both programs using the PIF or batch program in File Manager. 

If you want to keep a pop-up program easily available while you are using 
Windows NT, you can start and run the program in a window. You can then 
switch to the window whenever you want, just as with any other program. 

~ To run a pop-up program in a window 

1. Start the pop-up program. 

You can start the program as you would any program in Windows NT: 
from the command prompt, from File Manager, or from Program Manager. 

2. Press the appropriate key combination to display the program in the window. 

A few pop-up programs require a key combination that is reserved for 
Windows NT, for example ALT+ESC. In such a case, create a PIF for the pop­
up program. and select the Reserve Shortcut Keys option for the conflicting 
key combination. Windows NT will reserve the key combination for use by 
the program so that you can display it. 

OS/2 Environment 
Windows NT supports 16-bit character-based OS/2 applications on x86-based 
computers only. OS/2 bound applications (applications that can run under both 
OS/2 and MS-DOS) will run on RISe-based computers using the MS-DOS 
subsystem. 
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Configuring the OS/2 Environment 
When Windows NT starts for the first time, it checks the registry for OS/2 
subsystem configuration information. If none is found, it looks for information 
in the original CONFIG.SYS file and adds the information to the registry. If the 
original CONFIG.SYS file does not exist or is not an OS/2 configuration file, 
the subsystem adds the following default information to the registry: 

PROTSHELL=c:\os2\pmshell.exe c:\os2\os2.ini c:\os2\os2sys.ini 
%SystemRoot%\system32\cmd.exe 

SET COMSPEC=%SystemRoot%\system32\cmd.exe 

The subsystem updates the environment variable Os2LibPath with LIBPATH 
information found in the original CONFIG.SYS file. The updated Os2LibPath 
is %SystemRoot%\system32\os2\dll concatenated with the list of directories 
specified in the LIBPATH line of the original CONFIG.SYS file. 

Windows NT supports the OS/2 configuration commands shown in the table 
below. If you use commands that are not supported, Windows NT ignores them. 

Command 

protshell 

devicename 

libpath 

set 

country 

codepage 

devinfo=KBD 

Function 

Specifies the command interpreter. Only the Windows NT 
command interpreter is supported. 

Specifies a user-defined Windows NT device driver used by 
OS/2 applications. 

Specifies the location of OS/2 16-bit dynamic-link libraries. 

Sets environment variables. 

Sets a country code that defines country-dependent information 
such as time, date, and currency conventions. 

Specifies which code pages your system is prepared to use. 

Specifies the information the keyboard needs in order to use 
a particular code page. 

The Iibpath, set, and devicename commands are processed as follows: 

• In CONFIG.SYS, Iibpath appends path information to the OS/2 library path 
in the Windows NT environment. At the command prompt, you can change 
the library path for OS/2 applications by using the os2libpath command. 

• The following set commands are ignored in CONFIG.SYS: 

set vio_ihmvga 

set compspec 

set vio_vga 

set video_devices 

set prompt 
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• devicename specifies a device driver compatible with Windows NT for use 
with an OS/2 application. The syntax of the command is: 

DEVICENAME=OS/2devicename [[path][NTdevicename]] 

Devicename is the logical name OS/2 applications use to address the device. 
Path and NTdevicename specify the Windows NT device driver to which the 
OS/2 device name is mapped. If these are not specified, the device is mapped 
to \DEVICE\os/2devicename. 

Changing OS/2 Configuration Information 
Although the OS/2 configuration information is stored in the registry, you can 
edit that information just as you would edit an OS/2 CONFIG.SYS file. To edit 
the information, you must use an OS/2 text editor. 

To change configuration information, you must be logged on as a member of 
the Administrators group. 

To change configuration information 

1. While running Windows NT, start an OS/2 text editor in a window. 

2. Open the file called C:\CONFIG.SYS. 

Windows NT retrieves the configuration information from the registry 
and stores it in a temporary file that you can edit. 

3. Edit the configuration information. 

4. Save and close the file. 

5. Exit the editor. 

Windows NT stores the new information in the registry. 

6. Log off from Windows NT and restart your computer. 

Setting Up and Starting Applications 
Set up a Windows 3.1, MS-DOS, OS/2, or POSIX application just as you 
would other applications, by using the Windows NT Setup program or Program 
Manager. 

When you use the Windows NT Setup program to set up an MS-DOS application, 
Setup creates a PIF (program information file) or uses the PIF that accompanies 
the application or the Windows NT default PIF. Windows 3.1, OS/2, and POSIX 
applications do not use PIFs. For more information on Windows NT Setup, see 
Chapter 12, "System Maintenance with Windows NT Setup." 
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When you use Program Manager to set up an MS-DOS-based application, 
Program Manager searches for a PIF to use with that application: 

• If it finds one, it sets up the application and the PIF to work together. 

• If no PIF is available, Windows NT uses the default PIF, named 
_DEFAULT.PIF, when you start the application. 

For more information on using Program Manager to set up applications, 
see Chapter 3, "Program Manager." 

You can start applications for all supported application environments from 
Program Manager, File Manager, or from the command prompt. 

~ To start an application from Program Manager 

1. Open the group that contains the program-item icon for the application. 

2. Choose the icon. Or select it, and then press ENTER. 

I> To start an application using the Program Manager Run command 

1. From the File menu, choose Run. 

2. In the Command Line box, type the name of the file that starts the application, 
including the filename extension. You can also include any optional 
parameters that the application uses when it starts. 

If the application is MS-DOS-based, you can type the name of the 
application's PIF. 

3. Choose the OK button. 

t> To start an application from File Manager 

1. In the Main group, choose the File Manager icon. 

2. In the directory window, choose the filename for the application. Or select 
the filename, and then press ENTER. 

If the application is MS-DOS-based, you can use the filename of its PIF. 

~ To start an application from the command prompt 

1. In the Main group, choose the Command Prompt icon. 

2. At the command prompt, type the application's executable filename, 
and then press ENTER. 

Or, to run the application and retain use of the current command window, 
type start and the application's executable filename, and then press ENTER. 

Include the path to the application if necessary. You can include any startup 
parameters for the application after the application's name. 
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When you start an MS-DOS-based application at the command prompt, 
Windows NT uses DEFAULT.PIF to establish the MS-DOS environment. 
The following PIF settings in _DEFAULT.PIF are used to establish 
the environment: 

EMS Memory 

XMS Memory 

Multitasking Options 

Reserve Shortcut Keys 

Application Shortcut Key 

Custom MS-DOS Initialization Files 

Compatible Timer Hardware Emulation 

To start an MS-DOS-based application at the command prompt using its PIF, 
use the start command. For example, to start MYAPP.EXE using MYAPP.PIF, 
type start myapp. 

The first MS-DOS-based application started at the command prompt establishes 
the MS-DOS environment for all MS-DOS-based applications run in that 
window. 

In a few cases, Windows NT may not recognize that a program is MS-DOS based. 
If an MS-DOS-based application fails to start, try starting it using the forcedos 
command. For example, to start a program called MYPROG in the \OLDAPPS 
directory, typeforcedos \oldapps\myprog at the command prompt. 

Creating Program Information Files 
A program information file (PIF) provides information to Windows NT on'how 
best to run MS-DOS applications. Windows 3.1, OS/2, and POSIX applications 
do not use or require PIFs. 

Create, modify, and save PIFs using PIF Editor. On both x86-based and 
RISC-based computers, create PIFs using the Enhanced mode version of PIF 
Editor. Typically, a PIF has the same filename as the associated application's 
main program file, except that a PIF has the .PIF filename extension. During 
Windows NT setup, PIFs are placed in the \ WINNT directory. 

Windows NT includes a PIF named _DEFAULT.PIF, located in the \WINNT 
directory where you set up Windows NT. This PIF contains settings that work 
with most MS-DOS applications. Windows NT uses this PIF when there is no 
other one available for your application, or when the application is started at the 
command prompt. 

Because Windows NT might use the default PIF with more than one MS-DOS 
application, you should not modify it. You can use the default PIF as a starting 
point for creating a new PIF. ' 
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t> To create or change a PIF 

<@ 1. Start PIF Editor by choosing the PIF Editor icon in the Main group. 

PIF Editor displays a new, untitled PIF window with PIF options set to their 
default values. 

To edit an existing PIF, choose Open from the File menu, and then specify 
the PIF you want. 

2. Specify the PIF options for the application. 

For more information on PIF options, see "Specifying PIF Options," later 
in this chapter. 

3. Save the PIF by choosing the Save or Save As command from the File menu. 

If you are modifying the _DEFAULT.PIF file, be sure to choose the Save As 
command and to rename the file when you save it. 

Always use the .PIF extension when you name a PIF file. 

Using Multiple PIFs for an Application 
You can create more than one PIF for an application. You may find it useful to 
do this if you run an application differently under different circumstances. 

For example, you can specify in a PIF how much EMS (expanded) memory an 
application has access to. By using two PIFs, you could give an application access 
to a large amount of EMS memory when you're using large data files, but limit its 
use of memory when you're working with smaller files. 

t> To set up two PIFs for an application 

1. Create two PIFs. 

2. For each PIF, indicate the appropriate settings. 

In this example, you would set the EMS Required: KB Limit setting to -1 
for one PIF. For the other PIF, you would set the EMS Required: KB Limit 
setting to 1024K. 

3. Save each PIF with a unique filename. 

4. Create program-item icons for both PIFs in Program Manager, giving each 
a distinct title. Because you want to start the application from its PIF in this 
case, be sure to specify the PIF filename, not the application's filename, in 
the Command Line box. 

You can choose either icon to start the application. 
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Specifying PIF Options 
Windows NT eliminates the need to set many PIF options for MS-DOS 
applications. However, Windows NT allows you to specify all PIF options in case 
you want to create PIFs for use when running applications with Windows 3.1. 
Only PIF options used by Windows NT are explained below. For information on 
other PIF options, including standard mode options, see your Windows 3.1 User's 
Guide. 

~I <, ifi :;;dr ;::::j':::.:j'y I ..... 
file Mode t:!.elp 

~rogr am Filename: II I 
Window I.itle: I I 
Qptional Parameters: I I 
.s..tartup Directory: I I 
~ideo Memory: @ Text o Low Graphics o High Graphics 

Memory Requirements: KB Required @!] KB Preferre!!. 1640 I 
EMS Memory: ~B Required [CJ KBlimit ~ 
XM S Memory: KB Reguired [CJ KB Limit ~ 
Display Usage: @ Fyll Screen Execution: o .H,.ackground 

o ~indowed o f.xclusive 

r2l Close Window on Exit I Advanced ... I I:Windows:1:iT... I 
IPressF1 forHelp on Program Filename. 

Program Filename 
In the Program Filename box, type the name of the file that starts the application. 
Include the path if necessary. 

For most applications, you can type the path of the main program file, which 
usually has the extension .EXE or .COM. For example, to create a PIF for 
Microsoft Word, type c:\word\word.exe. If you start the application from a batch 
program, type its path, including the filename extension (usually .BAT). 
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You can also specify an environment variable in this box. Using an environment 
variable allows you to place the variable name in the PIF and assign it a value 
using the set command in the AUTOEXEC.BAT file. When you type the variable 
name, enclose it in percent signs (%). For example, in your AUTOEXEC.BAT 
file assign the value "c:\word\word.exe" to an environment variable named 
"worddir" by adding the line set worddir = c:\word\word.exe. Then in PIF 
Editor specify the environment variable %worddir% as the Program Filename. 

Window Title 
You can type a descriptive name in the Window Title box. For example, type 
Lotus 1-2-3 if you are creating a PIF for that application. The name you type 
appears under the application's icon when the application is minimized, and in 
the window title bar when the application is running in a window. 

This entry is optional. If you leave the Window Title box blank, the application's 
title bar displays the name of the PIF without the filename extension. 

You can also specify a title by using Program Manager. You do this by choosing 
the Properties command from Program Manager's File menu, and specifying a 
name in the Description box. Program Manager settings override PIF settings. 

You can also specify an environment variable in this field. By using an 
environment variable, you can place a variable name in the PIF and assign it a 
value by using the set command in the AUTOEXEC.BAT file. When you type 
the variable name, enclose it in percent signs (%). 

Optional Parameters 
You can type application parameters in the Optional Parameters box. These are 
the same parameters you type after the application's filename when starting the 
program at the command prompt. For example, if you use the Ie when you start 
Microsoft Word at the command prompt, type Ie in the Optional Parameters box. 

Parameters can be filenames, letters, numbers, or any type of information up to 62 
characters in length. For information about valid parameters, see the application's 
documentation. 
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If you want Windows NT to prompt you for parameters whenever you start 
the application, type a question mark (?) in this box. You can also specify an 
environment variable in this field. By using an environment variable, you can 
place a variable name in the PIF and assign it a value by using the set command 
in the AUTOEXEC.BAT file. When you type the variable name, enclose it in 
percent signs (%). 

This entry is optional. If the application does not require parameters, or if you 
do not want to use any parameters when you start your application, leave this 
box blank. 

When you start the application by using the Run command in File Manager or 
Program Manager, any optional parameters you specify· override the optional 
parameters specified in the PIF. 

Startup Directory 
Some applications require access to files in a particular directory before they can 
run. You can type a path in the Startup Directory box to specify the directory you 
want to be the current directory when the application starts, usually the directory 
where the application's program file is located. This entry is optional. 

You can also specify this directory by using Program Manager. You do this by 
choosing the Properties command from Program Manager's File menu, and then 
specifying a directory in the Working Directory box. Program Manager settings 
override PIF Editor settings. 

You can also specify an environment variable in this field. By using an 
environment variable, you can place a variable name in the PIF and assign it a 
value by using the set command in the AUTO EXEC. BAT file. When you type 
the variable name, enclose it in percent signs (%). 
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EMS Memory 
Windows NT can simulate expanded memory for applications that use it. Use 
the EMS Memory options to specify how much expanded memory Windows NT 
should provide to an application. Although few applications actually require 
expanded memory, many run better if they can use it. For more information on 
how a particular application uses expanded memory, see the application's 
documentation. The following table describes the options. 

Use 

KB Required 

KB Limit 

To 

Specify how many kilobytes of expanded memory are needed 
to start the application. In general, you can leave this option at 
the standard setting of 0, indicating that the application does not 
require expanded memory. The KB Required option does not 
limit how much expanded memory the application receives; 
Windows NT gives it at least as much as is specified by KB 
Required, plus any available expanded memory up to the 
amount specified by the KB Limit option. 

Windows NT starts the application only if it can provide at 
least as much expanded memory as the KB Required option 
specifies. Otherwise, Windows NT displays a message 
indicating there is not enough expanded memory to run the 
application. If other applications are running, you can quit one 
or more of them, and then try running the application again. 

Limit the amount of expanded memory provided to the 
application. Windows NT gives an application as much 
expanded memory as it requests, up to the amount you type 
in this box, or until no more memory is available. 

This option is useful for limiting an application's access to 
expanded memory, since some applications take all available 
expanded memory whether they need it or not. The default 
setting of 1024 provides the application with as much expanded 
memory as it requests, up to a limit of 1024K, or until no more 
memory is available. 

A setting of -1 allocates as much expanded memory to an 
application as it requests, up to a limit determined by the 
system. This can slow down the rest of your system. 

To prevent Windows NT from providing any expanded memory 
to the application, set both KB Required and KB Limit to o. 
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XMS Memory 
Use the XMS Memory options to allocate extended memory to an application 
that uses memory according to the Lotus-Intel-Microsoft-AST eXtended Memory 
Specification (XMS) standard. Because few applications require extended 
memory, you can usually leave these options at their default settings. 
A description of the options follows. 

Use 

KB Required 

KB Limit 

To 

Specify how many kilobytes of extended memory are needed to 
start the application. In general, you can leave this option at the 
default setting of 0, indicating that this application does not 
require extended memory. 

The KB Required option does not limit how much extended 
memory the application receives; Windows NT gives it as much 
extended memory as the application requests, up to the limit set 
by the KB Limit option or until no more memory is available. 

Windows NT starts the application only if it can provide at least 
as much extended memory as the KB Required option specifies. 
Otherwise, Windows NT displays a message indicating there is 
not enough memory to run the application. If other applications 
are running, you can quit one or more of them and try running 
the application again. 

Limit the amount of extended memory provided to the 
application. Windows NT gives an application as much 
extended memory as it requests, up to the amount you type in 
this box, or until no more memory is available. This option is 
useful for limiting an application's access to extended memory, 
since some applications take all available extended memory 
whether they need it or not. 

The default setting of 1024 provides the application with as 
much extended memory as it requests, up to a limit of 1024K, 
or until there is no more memory available. 

A setting of -1 allocates as much extended memory to an 
application as it requests, up to a limit determined by the 
system. This can slow down the rest of your system. 
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Display Usage 
Use the Display Usage options to set whether a character-based application starts 
in a window or in a full screen. While a character-based application is running, 
you can move it from a window to a full screen, or vice versa, by pressing 
ALT+ENTER. 

Use 

Full Screen 

Windowed 

To 

Start the application in a full screen. 

Start the application in a window. 

While an application is running, you can set display usage from the Control menu 
using the Settings command. Display usage set using the Control menu overrides 
the setting made using PIP Editor. 

On RISC-based computers, applications run in a window only and this option 
does not apply. On x86-based computers, graphical applications run using the 
full screen only. If a character-based application running in a window switches 
to graphics mode, for example to display a chart, Windows NT will switch the 
display to the full screen automatically. 

Close Window on Exit 
Clear this check box if you want the window (or screen) to remain open when you 
quit the application. This is especially useful if you are running an application that 
displays output on the screen. If the window closes too quickly, you won't see the 
output. 

By default, the window closes when you quit the application. 

Multitasking Options 
Specifying foreground and background priority determines how CPU (processor) 
resources are allocated to applications. The numbers that you specify for an 
application set the priority for the application relative to other applications 
that are running. (Therefore, these numbers cannot be translated into a fixed 
percentage of CPU time.) The higher the priority number an application has, 
the more CPU resources are allocated to it. 

The default foreground priority is 100. Setting a number lower than 100 allows 
other applications to run faster by reducing the amount of CPU time given the 
MS-DOS-based application in the foreground. The default background priority 
is 50. You can set a number from 0 to 10000. 

By default, the Detect Idle Time check box is selected. This allows the system 
to give processing resources to other applications while the application is idle, 
for example while it is waiting for keyboard input. Clear this option only if your 
application is running too slowly or not running correctly. 
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J> To set multitasking options 

1. In the PIF Editor window, choose the Advanced button. 

2. In the Multitasking area, set the background and foreground priorities by 
typing appropriate values in the Background Priority and Foreground Priority 
boxes. 

3. Select or clear the Detect Idle Time check box. 

4. Choose the OK button. 

Reserve Shortcut Keys 
Normally, Windows NT uses the key combinations in the table below to perform 
some action. Selecting one or more of the shortcut-key check boxes instructs 
Windows NT to ignore the specified key combination when the application is 
running in the foreground. Instead, the application responds to the key 
combination. 

Use 

ALT+TAB 

ALT+ESC 

CTRL+ESC 

PRTSC 

ALT+PRTSC 

ALT+SPACE 

ALT+ENTER 

To 

Reserve the ALT+TAB shortcut key for the application. 
Otherwise, Windows NT switches between applications when 
you press this key combination. 

Reserve the ALT+ESC shortcut key for the application. 
Otherwise, when you press this key combination, Windows NT 
cycles through the applications in the order each was started. 

Reserve the CTRL+ESC shortcut key for the application. 
Otherwise, Windows NT displays the Task List when you press 
this key combination. 

Reserve the PRINT SCREEN shortcut key for the application. 
Otherwise, Windows NT copies the contents of the screen onto 
the Clipboard when you press this key. 

Reserve the ALT +PRINT SCREEN shortcut key for the application. 
Otherwise, Windows NT copies the contents of the active 
window onto the Clipboard when you press this key 
combination. 

Reserve the ALT+SPACEBAR shortcut key for the application. 
Otherwise, Windows NT displays the application's Control 
menu when you press this key combination. 

Reserve the ALT+ENTER shortcut key for the application. 
Otherwise, when you press this key combination, Windows NT 
switches the application between a window (if it can run in one) 
and a full screen. 
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~ To reserve shortcut keys 

1. In the PIF Editor window, choose the Advanced button. 

2. In the Other Options area, select the check boxes for the keys you want to 
reserve, and then choose the OK button. 

Application Shortcut Key 
An application shortcut key allows you to switch immediately to an application 
that is running in the background. By using an application shortcut key, you can 
switch to a particular application quickly, no matter where you are in Windows 
NT or which application you are using. 

To assign an application shortcut key to an application, you can use the Properties 
command on the File menu in Program Manager, or you can use the Application 
Shortcut Key option in the application's PIF. Shortcut-key settings made in 
Program Manager override settings made in a PIF. The key combination you 
specify must include either the ALT or CTRL key. For example, the key 
combinations CTRL+Y, ALT+F4, CTRL+SHIFT+Fll, and CTRL+ALT+7 are all valid 
application shortcut keys. You cannot specify a key combination that includes 
the ESC, ENTER, TAB, SPACEBAR, PRINT SCREEN, or BACKSPACE key. 

After you assign an application shortcut key, the key combination works as a 
shortcut key only when that application is loaded. No other application (including 
Windows NT, Windows NT applications, and the application that uses the 
shortcut key) can use that key combination for any other purpose. For this reason, 
you should select application shortcut keys carefully. For example, suppose you 
specify ALT+F as the application shortcut key for Lotus Freelance. In many 
Windows applications, ALT+F is a shortcut key that displays the File menu. 
However, if Freelance is loaded when you are using Notepad, pressing ALT+F 

makes Freelance the active application, rather than displaying Notepad's File 
menu. 

~ To specify a shortcut key by using Program Manager 

1. Switch to Program Manager. 

2. Select the icon for the application whose shortcut key you want to specify. 

3. From the File menu, choose Properties. 

4. Select the· Shortcut Key box, and then press the key combination you want 
to use for this application. 

5. Choose the OK button. 
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If you press an invalid key combination, a message appears and Windows NT 
resets the key definition to its previous value. 

~ To delete a shortcut-key definition by using Program Manager 

1. Switch to Program Manager. 

2. Select the application's icon. 

3. From the File menu, choose Properties. 

4. Select the Shortcut Key box, and then press SHIFT+BACKSPACE. 

The shortcut key is set to None. 

5. Choose the OK button. 

~ To specify a shortcut key by using PIF Editor 

1. From the File menu, choose Open. 

2. Select the PIF for the application whose shortcut key you want to specify, 
and then choose the OK button. 

3. Choose the Advanced button. 

4. In the Advanced dialog box, select the Application Shortcut Key box. 

5. Press the key combination you want. 

Windows NT interprets any key combination you press as an application 
shortcut key unless you press keys that move you to another area in the dialog 
box (such as TAB). 

6. Choose the OK button. 

If you press an invalid key combination, a message appears, and Windows NT 
resets the key definition to its previous value. 

r> To delete a shortcut-key definition by using PIF Editor 

1. Open the PIF for the application whose shortcut key you want to delete. 

2. Choose the Advanced button. 

3. Select the Application Shortcut Key box. 

4. Press SHIFT+BACKSPACE to set the shortcut key to None. 

Or, while pressing a key combination, press BACKSPACE to reset the shortcut 
key definition to its previous value. 
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Custom Startup Files 
Windows NT allows you to create custom startup files that you can specify in 
an application's PIF. When you start the application, Windows NT will read the 
custom files you specify rather than the CONFIG.NT and AUTOEXEC.NT files. 
This allows you to create a custom MS-DOS environment for each application 
you use. For example, if one of your applications requires a memory resident 
program when it runs, you can include the name of that program in a custom 
startup file. When you start the application using its PIF, Windows NT will 
automatically start the memory resident program. 

When you create startup files, base them on the AUTOEXEC.NT and 
CONFIG.NT files. That way, the basic information needed to configure the 
MS-:DOS environment will already be included in your files. In configuration 
files, Windows NT uses the variable %SystemRoot% to represent the Windows 
directory. When processing the files, Windows NT automatically expands this 
variable. 

I> To create custom startup files 

1. Using a text editor, for example Notepad, edit the CONFIG.NT and 
AUTOEXEC.NT files. 

The files are located with your other Windows NT files in the directory 
\ WINNT\SYSTEM32. 

2. Save each file under a new name. 

I> To specify custom startup files in PIF Editor 

1. From the File menu, choose Open. 

2. Select the PIF for the application whose startup files you want to specify, 
and then choose the OK button. 

3. Choose the Windows NT button. 

J;;.onfig Filename: IC:\WINNT\SYSTEIot32\CONFIIi.NT 

D Compatible I.imer Hardware Emulation 

IPressF1for Help on Autoexec Filename. 
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4. In the Config Filename box, type the name of the file you want to use in 
place of CONFIG.NT. 

5. In the Autoexec Filename box, type the name of the file you want to use in 
place of AUTOEXEC.NT. 

6. Choose the OK button. 

Compatible Timer Hardware Emulation 
By default, Windows NT allows MS-DOS-based applications to specify the rate 
at which the computer's timer sends timing signals. If an application sets the rate 
too high, it may stop running. Some applications, such as games, are particularly 
sensitive. If your application starts but then fails to run correctly, try selecting the 
Compatible Timer Hardware Emulation check box. Selecting the check box 
reduces the rate at which timing signals are sent. 

Use this option only if an application requires it. Selecting this option if an 
application does not require it can degrade the application's performance or 
affect the application's ability to calculate time. 

t> To set' compatible timer hardware emulation in PIF Editor 

1. From the File menu, choose Open. 

2. Select the PIF for the application whose timer emulation you want to change, 
and then choose the OK button. 

3. Choose the Windows NT button. 

4. In the Windows NT Options dialog box, select the Compatible Timer 
Hardware Emulation check box. 

5. Choose the OK button. 
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You can use Windows NT Setup for system maintenance-whether Windows NT 
was initially installed from disks or from the network, or was installed by your 
equipment manufacturer. If you change the hardware or software in your 
computer, you need to ensure that your system configuration includes the correct 
device drivers and components for Windows NT. 

This chapter presents the following topics: 

• Changing system configuration settings 

• Setting up applications to run from Program Manager 

• Installing a new device driver 

• Adding and removing drivers for SCSI adapters and tape drives 

• Adding and removing Windows NT components 

• Deleting user profiles 

• Repairing your system 

To change printer drivers, use Print Manager. To install and configure network 
components, choose the Network icon in Control Panel. To change your keyboard 
layout or language, choose the International icon in Control Panel. 
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Starting and Quitting Windows NT Setup 
When you want to run Windows NT Setup for system maintenance, you start it 
like any other application that appears in a program group-by double-clicking 
its icon. 

You can change some system settings only if you are logged on as a member of 
the Administrators group. If you cannot run Windows NT Setup or use the tools 
in Control Panel to change system settings, ask your network administrator for 
assistance. 

To run Windows NT Setup for system maintenance 

• In Program Manager, choose the Windows NT Setup icon. 

You can press Fl at any time to get help for Windows NT Setup. 

Qptions .!:ielp 

Display: VGA -IBM standard VGA 

Mouse: Microsoft Serial Mouse 

Keyboard: Enhanced 101 or 102 key US and Non US keyboards 

Important Before running the setup program for an application created for any 
version of Windows, you must quit Windows NT Setup. Otherwise, the 
application's setup program will fail. 

E> To quit Windows NT Setup 

• From the Options menu, choose Exit. 

Changing System Configuration Settings 
You can use Windows NT Setup to change the system setting for your display, 
keyboard, or mouse by specifying new options in the Change System Settings 
dialog box. For example, if your computer currently uses a device driver for a 
256-color SuperVGA display and you want the display to appear in standard 
VGA 16-color mode, you must use Windows NT Setup to change this setting. 
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To make system setting changes, you must be logged on as a member of the 
Administrators group for your computer. 

!!.isplay: IStandard VGA (640)(480. 16 colors) Iii 

Mouse: I Microsoft Serial Mouse I ::!:I 
~eyboard: IXT. AT or Enhanced Keyboard (83-102 key) I:!:I 

t> To change system settings for the display, keyboard, or mouse 

1. Make sure your hardware is set up to match the setting you are changing to. 

2. From the Options menu in Windows NT Setup, choose Change System 
Settings. 

3. In the Change System Settings dialog box, open the list for the setting you 
want to change by clicking the arrow at the right of the list. 

4. Make sure your hardware is listed, and then select the setting you want. 

To install a new or updated driver file, choose Other, and then when Setup 
prompts you for a disk, insert a disk containing the driver file into drive A. 
If Setup asks you to supply a Windows NT disk, insert the disk in the drive. 

To install a sound driver or a supporting driver for multimedia devices, see 
"Working with Device Drivers" in Chapter 5, "Control Panel." 

5. Choose the OK button. 

If Setup asks you to supply a Windows NT disk, insert the disk in the drive. 
Mter you complete all Setup options and quit Windows NT Setup, a message 
reminds you to restart your computer for the changes to take effect. 

6. To restart your computer, choose Shutdown from Program Manager's File 
menu. Do not flip the power switch to restart your computer. 

Setting Up Applications to Run from Program Manager 
~ You can choose to set up applications on your hard disk that you want to run 

under Windows NT. To do this, you must be logged on as a member of the 
Administrators group. 

t> To set up applications to run from Program Manager 

1. From the Options menu, choose Set Up Applications. 

2. In the Set Up Applications dialog box, specify where Setup should search 
for applications. 
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You can search either directories on your hard disk or only the directories 
listed in your path. 

3. Choose the Search Now button. 

Setup will search your hard disk.(s) for existing applications and then 
set them up to run with Windows NT. Select the place(s) you want 
Setup to search. Then choose Search Now or press ENTER. 

Setup will search: 

4. If Setup finds applications with executable filenames identical to other 
applications, a message asks you to select the correct names for the 
ambiguously named applications on your hard disk. Select the application 
name(s) in the list, and then choose the OK button. 

5. In the second Set Up Applications dialog box, select the specific applications 
you want in the left box, and then choose the Add button. 

Applications found on hard disk.(s): ~et up for use with Windows. 

QUICKEYS .! tBROWSER 
,', =-::---==c-o EX"C'E'l· .. ·· .................... ·· .. · ...... ·· ............ · .... · .. · .. ··· .... · .... · ........ .. 

WINWORD 
C:\WINWORD\WINWORD.EXE 

Microsoft QBASIC 
7- ~IIEWER 
~ =W~mD~~~~~mmu 
~ 
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6. When all the applications you want to install appear in the right list, choose 
the Continue button. 

Setup adds program-item icons for the selected applications in the common 
Applications group in Program Manager. You can move the program-item icons 
to other program groups, if you want. 

For more information about running applications created for other operating 
environments, see Chapter 11, "Other Application Environments." 
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Installing a New Device Driver 
New device drivers may periodically become available to supplement the device 
drivers supplied with Windows NT. You must use Windows NT Setup to install 
a new device driver. 

If a new version is made available of a device driver already installed on your 
computer, use the procedure described in this section to install the revised driver. 

To start a new device driver, use the Devices option in Control Panel or restart 
your computer. 

Obtaining New Device Drivers 
For information about obtaining new device drivers for your system, contact 
your hardware manufacturer or Microsoft Customer Support Services. 

The Windows NT Driver Library is updated regularly to provide the most current 
Windows NT -compatible device drivers for printers, displays, networks, and other 
devices not included in the Windows NT and Windows NT Advanced Server 
retail packages. All drivers are tested by Microsoft for compatibility with the 
Windows NT and Windows NT Advanced Server operating systems. The 
Windows NT Driver Library is distributed through the Microsoft Download 
Service at 206-936-MSDL, between 6:00 A.M. and 6:00 P.M. Pacific time, Monday 
through Friday; it's also available through CompuServe and GEnie®, or call 
1-800-227-4679 to order the library from Microsoft. 

Note If you bought your copy of Windows NT outside the United States, the 
package contains an information card listing Microsoft subsidiary telephone 
numbers you can call to obtain information. 

Setting Up New or Revised Device Drivers 
Before running Windows NT Setup to install a new device driver, check for any 
special installation instructions that came with the driver. There may be other 
steps you need to take to set up the hardware. Some drivers include information 
files that tell Windows NT Setup what type of files (such as font files) the driver 
supports. If you are not sure what your driver supports, contact the hardware 
manufacturer. 
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J> To install a device driver not supplied with Windows NT 

1. Make sure your hardware matches the setting you are changing to. 

2. From the Options menu in Windows NT Setup, choose Change System 
Settings. 

3. In the Change System Settings dialog box, click the arrow beside the display, 
mouse, or keyboard setting you want to change and choose Other. 

Setup prompts you to insert the disk containing the device driver. 

4. Insert the disk in the drive, and then choose the OK button. 

If the file is located on your hard disk or on a network drive, type the path 
of the drive that contains the file, and then choose the OK button. 

Setup displays a list of the device drivers on that disk or drive. 

S. From the list of drivers, select the appropriate driver, and then choose the 
OK button. 

If you are sure you want the displayed option, choose the OK button in the 
Change System Settings dialog box. 

You may be asked for additional disks if more than one disk was provided by 
the hardware manufacturer. You might also be asked for specific Windows NT 
disks. 

Setup copies the appropriate files to the Windows NT system driver 
subdirectory. The default subdirectory is \WINNT\SYSTEM32\DRIVERS. 

Mter all files are copied and you quit Windows NT Setup, a message reminds 
you to restart your computer for the changes to take effect. 

6. To restart your computer, choose Shutdown from Program Manager's File 
menu. Do not flip the power switch to restart your computer. 

Correcting a Faulty Device-Driver Installation 
Occasionally, Windows NT may not be able to run using the changes you make 
to the Windows NT system configuration. For example, you might specify the 
wrong video device driver when you change the system settings. 

If a new configuration leaves your computer unable to start correctly, 
Windows NT will automatically restore your previous working system 
configuration the next time you restart your computer. Windows NT can 
automatically maintain a working system configuration because changes that you 
make in Windows NT Setup and the previous working configuration are both 
saved. For more information, see "Repairing Your System," later in this chapter. 

Note If you cannot correctly install a new device driver, check with your 
hardware manufacturer to ensure that you have the current driver. 
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Adding and Removing Drivers for SCSI Adapters and Tape Drives 
[pI If you add or remove a tape drive or a SCSI drive such as a CD-ROM device as 

part of your system, you must tell Windows NT about the change by choosing the 
appropriate Add/Remove command from the Options menu in Windows NT 
Setup. This requires that you be logged on as a member of the Administrators 
group. 

Note When you use a SCSI tape drive, the tape drive must be turned on before 
you start your computer. Otherwise, the driver will not load properly. 

t> To add a driver for a SCSI device or tape drive 

1. From the Options menu in Windows NT Setup, choose Add/Remove SCSI 
Adapters or choose Add/Remove Tape Devices. 

2. In the SCSI Adapter Setup dialog box, choose the Add button. 

3. In the Select SCSI Adapter Option dialog box, select a driver from the list, 
and then choose the Install button. 

Follow the instructions on the screen. If you are asked to insert a disk, insert 
the disk in the designated drive, and then choose the OK button. 

4. When driver installation is complete, choose the Continue button to return 
to Windows NT Setup. 

t> To remove a driver for a SCSI device or tape drive 

1. In the SCSI Adapter Setup list in the Add/Remove dialog box, select the SCSI 
device or tape device you want to remove 

2. Choose the Remove button, and then choose the Continue button to return 
to Windows NT Setup. 

When you complete any other Setup options and quit Windows NT Setup, a 
message reminds you to restart your computer so that the changes will take effect. 
To restart your computer, choose Shutdown from Program Manager's File menu. 
Do not flip the power switch to restart your computer. The next time you start 
Windows NT, the correct system configuration will appear. 

Adding and Removing Windows NT Components 
You can use Windows NT Setup to add and remove various components that are 
not essential to the operation of Windows NT. For example, you might want to 
remove some non-essential Windows files to free up space on your hard disk, or 
add components you previously removed or that you did not install during initial 
setup. You can decide at any time to add or remove all or parts of components 
such as README files, accessories, games, screen savers, and wallpapers. 
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Caution When you remove components, the files are deleted from your computer. 
If you want to add them later, you must supply the files from the Windows NT 
installation disks or from a source directory on your network. 

The following optional groups of files (components) are 
installed on your system_ 

To remove a component. clear its checkbox_ 

To install a component. check its checkbox_ 

To remove or install specific files within a component. 
choose Files ___ for that component 

Component 

r8J i:iji~~:ii.i~::fI!~:;j 
r8J Accessories 

r8J §ames 

r8J S creen ~ avers 

r8J ~allpapers. Misc_ 

Bytes Used 

512 

1.951,744-

398.848 

192.000 

210.944 

Total Disk Space Required: 2,754.048 Bytes 

Disk Space Available: 22.020.096 Bytes 

Add/Remove 
Individual Files 

j; "Files:::" ~ I 
I" Files:.] J 

IFilei~.~ 

1""Filei;:.' 

~ To add or remove Windows NT components 

1. From the Options menu in Windows NT Setup, choose Add/Remove Windows 
Components. 

In the Optional Windows Components dialog box, Setup lists the optional 
components and the hard disk space required to set them up on your computer: 

• Components currently on your computer are marked with an X in the check 
boxes. You can remove some or all of these components. 

• Total Disk Space Required shows the total hard disk space required by all 
selected components. This number increases or decreases as you select or 
clear the components' check boxes. 

• Disk Space Available shows your computer's total unused hard disk space. 
This number changes after adding or removing components or files. 

Note Windows NT Setup does not check whether the space required for 
the files you want to add matches the space available on disk. Check these 
amounts carefully before proceeding to ensure that you have adequate disk 
space to add the selected components. 
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2. To add or remove a component, do one or more of the following: 

• To add an entire component (for example, all README files), 
select the check box next to it. 

• To remove an entire component, clear the check box. 

• To add or remove part of a component, follow the steps in the next 
procedure. 

3. Choose the OK button. 

If you are adding a component or part of a component, a message asks you to 
insert the appropriate Windows NT disk. Insert the disk in the drive, and then 
choose the OK button. 

If you are removing files, a message asks you to confirm the deletion. Choose 
the Yes button to delete the files. 

Not all files for various components are required. For example, you may want to 
delete some screen saver files but keep others on your computer. You can add or 
remove just a portion of a Windows NT component. 

1> To add or remove part of a Windows NT component 

1. In the Windows NT Setup dialog box for adding and removing components, 
choose the Files button next to the component you want to change. \ 

\ 
The Customize dialog box lists that component's files. Files on the right are 
currently included on your computer and can be removed. Files on the left are 
not included and can be added. 

2. In either list of files, select the names of the files you want to add or remove, 
and then choose the Add or Remove button. Or choose the Add All button to 
add all files. 

Total Disk Space Required shows the total hard disk space needed for the files 
you want to set up on your computer. Check this number to be sure there is 
adequate space on your disk for the files you have selected. 

3. Choose the OK button to return to the Windows NT Setup dialog box, and 
then choose the Continue button to add or remove the selected files. 

Deleting User Profiles 
A user profile defines the content and arrangement of Program Manager groups, 
screen colors, network and printer connections, mouse and keyboard settings, and 
other settings in the Windows NT environment. The user profile ensures that 
Windows NT will look and act in a familiar way while another user is working on 
your computer. 
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Each copy of a user profile remains on your computer until you delete it. You can 
remove these additional profiles from your computer with Windows NT Setup. 

~ To delete a user profile from your computer 

1. From the Options menu in Windows NT Setup, choose Delete User Profiles. 

2. In the User Profiles list, select the user profile you want to remove from your 
computer. 

3. Choose the Delete button to remove the selected profile. 

4. Repeat this process until you have removed all the profiles you want, and then 
choose the Close button. 

Setup warns you if it cannot delete a profile because the profile is currently in 
use or because you are not logged on as a member of a group that can delete 
profiles. Otherwise, the selected profiles are deleted from your computer. 

Repairing Your System 
When you use NTFS, Windows NT logs all file transactions, replaces bad sectors 
automatically, and stores copies of key information for all files on the NTFS 
volume. Regardless of which file system you use, Windows NT automatically 
preserves the previous working startup configuration to ensure that you can 
always start Windows NT in spite of any changes to the system configuration that 
may occur during a work session. This previous working configuration is called 
the Last Known Good Configuration. 

You can also restore corrupt or missing system files using the Emergency Repair 
disk you create during Setup. 

Using the Last Known Good Configuration 
If you encounter difficulty starting Windows NT, you may choose to start 
Windows NT using the Last Known Good Configuration. 

~ To start Windows NT with the Last Known Good Configuration 

1. Start your computer and select Windows NT from the boot loader menu 
(if it does not start automatically). 

2. After you choose Windows NT, or as soon as the screen clears and the words 
"OS Loader" appear on the screen, hold down the space bar. 

Windows NT displays the Configuration Recovery menu, which asks you to 
choose between Current Startup Configuration and Last Known Good. 

3. To restore the last working system configuration, choose Use Last Known 
Good Configuration (Configuration changes since your system was last 
successfully started are lost). 
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Using the Emergency Repair Disk 
If your system files are corrupt and you are unable to recover the previous startup 
configuration (Last Known Good), you can use the Emergency Repair disk to 
restore your system to its initial setup state. To repair a Windows NT installation, 
you must use the Emergency Repair disk specifically created for that installation 
during Windows NT Setup. 

If your system becomes corrupt but you did not create an Emergency Repair disk 
during installation, you must reinstall Windows NT from the original installation 
disks. 

t> To restore Windows NT with an Emergency Repair disk on an x86-based 
computer 

1. If you installed Windows NT using the original Setup floppy disks or 
CD-ROM, start Setup just as you did originally. (For example, insert Setup 
Disk #1 of the original Windows NT installation disks in drive A and start 
the computer.) 

If you installed Windows NT using WINNT.EXE, insert the Setup disk 
created by WINNT.EXE in drive A and start the computer. 

2. In the first text-based Setup screen, type r to indicate that you want to repair 
your Windows NT files. 

3. Follow the instructions on the screen, inserting the Emergency Repair disk 
in drive A and providing any other Windows NT Setup disks as requested. 

4. When the final message appears, remove the Emergency Repair disk from 
drive A, and then press CTRL+ALT+DEL to restart your computer. 

t> To restore Windows NT with an Emergency Repair disk on a RISe-based 
computer 

1. Start the Windows NT Setup Program as instructed in your manufacturer­
supplied documentation. (How you start Windows NT Setup depends on the 
type of RISC-based computer you are installing on.) 

2. In the first text-based Setup screen, type r to indicate that you want to repair 
your Windows NT files. 

3. Follow the instructions on the screen, inserting the Repair disk in drive A 
if Repair asks for it. 

4. When the final message appears, remove the Repair disk, and then press 
ENTER to restart your computer. 
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The Repair program automatically runs the chkdsk utility on the system partition 
and on the partition that contains the Windows NT system files. (Chkdsk 
searches for and attempts to fix hard disk errors.) Then, the Repair program 
optionally performs the following tasks: 

• Checks the Windows NT directory tree against the log file on the Emergency 
Repair disk to ensure that all system files are present and none are corrupt. 

If any files are missing or corrupt, Repair restores the files from the 
appropriate Windows NT Setup disk or CD-ROM. On an x86-based computer, 
you are asked to insert the floppy disk or CD-ROM originally used for 
installation. 

The Repair program will identify corrupt files on a system installed using 
WINNT.EXE, but it will not replace them. To repair a WINNT.EXE 
installation, you need to run the Repair program using the Windows NT Setup 
disk set or CD-ROM used to create the original network share. 

• Checks the Windows NT files on the system partition to ensure that all boot 
files are present and none are corrupt. 

If any files are missing or corrupt, Repair restores the files from the 
appropriate Windows NT Setup disk or CD-ROM. If you have accidentally 
reformatted or changed the system partition on your x86 computer so that 
Windows NT no longer starts, the Repair program restores your original boot 
configuration so that you can start Windows NT. 

To repair the boot files on a WINNT.EXE installation, you may have to rerun 
the Repair program using the Setup disk set or CD-ROM used to create the 
original network share. 

• Checks the configuration registry for errors. If any registry files are found to 
be corrupt, Repair gives you the option of restoring the original files from the 
Emergency Repair disk. Note that user accounts and file security added since 
you first ran Setup are lost, unless you have backed up the \ WINNT 
\SYSTEM32\CONFIG directory. 

• Removes security from Windows NT system files if Windows NT is installed 
on an NTFS partition. This option is useful if you have accidentally set 
permissions on a system file or directory so that Windows NT cannot access 
the system files it needs to start your system. 
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CHAPTER 13 

User Manager 

User Manager is a tool used to manage security for a Windows NT workstation. 

This chapter presents a brief overview of User Manager, and then provides 
procedures for: ' 

• Managing user accounts 

• Managing groups 

• Managing security policies 
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Overview 
With User Manager you can create and manage user accounts, create and manage 
groups, and manage the workstation's account, user rights, and auditing policies. 

The User Manager window contains two lists, one showing the user accounts of 
the workstation, and the other the groups of the workstation . 

...... . )7'\;; ;('.'; '1'i<;::;:< ..... : • 

!lser Eolicies Qptions Help 

Username ·.···:IFuIlNiuDe , ':':.:" .. :' , .. : .. : !Oescription 
.. , 

··V ' . 

:ii + n Billo O'Daly, Bill Accountant f-' n Dickm Moseley, Dick System Analyst .. 

n Ernesta Aydelotte, Ernest Administr ator 

n Guest Built-in account for guest access to the com n Jeant -.:' 
Thompson, Jean C,ll,D/C,ll,M Operator ¥ 

Group~ ':" .. : .,: !Oescription 
.. ': . 

, 

I ~ , Administrators Members can fully administer the computer/domain 

I~' Backup Operators Members can bypass file security to back up files 
~ ~ Guests Users granted guest access to the computer/domain 

I~' Power Users M embers can share directories and printers 
I ~ , R eplicator Supports file replication in a domain 

I~' Users Ordinary users 

Starting and Quitting User Manager 
I> To start User Manager 

1. Open the Administrative Tools group. E 2. Choose the User Manager icon. 

I> To start User Manager from the command line 

1. From the File menu in Program Manager, choose Run. 

2. In the Command Line box, type musrmgr. 

3. Choose the OK button. 

t> To quit User Manager 

• From the User menu, choose Exit. 

When you quit User Manager, if the Options menu Save Settings On Exit 
command is enabled, the main window size and position and the setting of the 
Confirmation command are saved. 
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Who Can Use User Manager? 
The actions a user can perform in User Manager are determined by the group 
memberships of the user account the user is logged on to. 

If a user does not have sufficient authority to perform an action in User Manager, 
that command or option is usually shown as unavailable. In some cases, the 
command is displayed as available and the user is able to invoke it, but the 
command is not executed by the system. 

Following are discussions of the User Manager abilities provided by some of the 
built-in Windows NT groups. If a user account belongs to more than one group, 
the user receives the greater of the possible abilities. 

Administrators 
A user who is logged on to a user account that is a member of the Administrators 
group can perform all User Manager functions. 

Power Users 
A user who is logged on to a user account that is a member of the Power Users 
group can use User Manager to create user accounts and groups, and to modify 
or delete those user accounts and groups. A Power User can also add and remove 
users from the Power Users, Users, and Guests groups. 

Users 
A user who is logged on to a user account that is a member of the Users group 
can use User Manager to create groups, can modify or delete those groups, and 
can give any user account membership in those groups. 

Managing User Accounts 
A user account consists of all the information that defines a user to Windows NT. 
This includes such things as the user name and password required for the user to 
log on, the groups in which the user account has membership, and the rights and 
permissions the user has for using the system and accessing its resources. It also 
includes an account description, the user's full name, and other account 
configuration information. 

Some built-in user accounts are provided when Windows NT is installed. You 
can add additional user accounts, and you can modify existing user accounts. 
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Built-In User Accounts 
The following built-in user accounts are provided when Windows NT is installed 
on a workstation. 

Administrator 
The built-in Administrator account is a member of the built-in Administrators 
group, and receives the rights and permissions granted to that group. It cannot 
be removed from that group. 

The Administrator account is the account used by the person who manages 
the workstation's overall configuration. The Administrator has more control 
over the Windows NT workstation than does any other user. For example, the 
Administrator can create, modify, or delete user accounts and groups; manage 
security policies; create, administer, and connect to administrative shares; install 
and connect to printers; format or partition a fixed disk; back up and restore files; 
debug the system; take ownership of files and other objects; modify operating 
system software; install or update device drivers; unlock a workstation; and more. 

The built-in Administrator account can be renamed, but it cannot be deleted. 

During installation, Windows NT prompts the person doing the installation to 
enter a password for the built-in Administrator account. Guard this password 
carefully, not only for security purposes but also because if the password is 
forgotten or the person who knows the password becomes unavailable, the built-in 
Administrator account becomes unusable. 

Following installation, it is a good idea to create an additional administrative 
account for each person who needs administrative-level abilities, and reserve the 
built-in Administrator account for emergency purposes. When each administrative 
user has a separate account, their actions can be audited. For information on 
creating user accounts, see "Adding User Accounts," later in this chapter. 

Guest 
The built-in Guest account is a member of the Guests group, and receives the 
rights and permissions granted to that group. For example, a user can log on to 
the Guest account, create files and delete those files, and read files that an 
administrator specifically permits Guests to read. 

The Guest account is provided as a convenience so that occasional or one-time 
users of the computer can log on and be granted limited abilities. The Guest 
account is installed with a blank password. 

The built-in Guest account can be renamed, but it cannot be deleted. 
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Initial User 
The computer's primary user is expected to use the Initial User account. Because 
it is a member of the Administrators group, the Initial User account can fully 
administer the workstation. 

The Initial User account is created if, during Windows NT installation, the 
computer is added to a workgroup or if it is not configured for network operation. 
The system prompts the installation user to provide a user name and password. An 
account is created under the provided user name, so there is never an account that 
is actually named "Initial User." 

If the computer is added to a domain during Windows NT installation, the Initial 
User account is not created, since the user of the computer is expected to log on 
using an account from the domain. 

Adding User Accounts 
If more users need to log on than are supported by the built-in user accounts, 
additional user accounts can be added. A user account can be added either by 
creating a new user account, or by copying an existing user account. 

When adding a user account you will be asked to provide a user name, which can 
be up to 20 characters. It must be unique, meaning it cannot be identical to any 
other user name or group name of the workstation. It can contain any uppercase 
or lowercase characters except the following: 

" / \ [ ] = + * ? < > 

Be consistent in the way you enter user names, because when Windows NT 
presents lists of user accounts they are usually sorted by the user names. It is a 
good idea to establish a standard for user names, such as a shortened combination 
of the first and last names (Louisem for Louise G. Morgan). 

You will also be asked to provide a full name, which is the complete name of the 
user. It is a good idea to establish a standard for full names, so that they always 
begin with either the last name (Morgan, Louise G.) or the first name (Louise G. 
Morgan). 
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Note When Windows NT displays a user name and when the distinction is 
necessary, Windows NT identifies the domain or workstation the user account 
is from by presenting the name in the form DOMAINNAME\username or 
COMPUTERNAME\username. This happens most often when a Windows NT 
workstation participates in a Windows NT Advanced Server domain and 
a user name from the domain is displayed. For example, a user account 
named Jeffho from a domain named Engineering would be displayed as 
ENGINEERING\Jeffho. In some situations the full name will be appended, 
for example, ENGINEERING\Jeffho (Howard, Jeff). 

I> To create a new user account 

1. From the User menu, choose New User. 

.!!sername: 

Full Hame: 

.!2escription: 

f.assword: 

Confirm 
Password: 

D User Mus Change Password at Next logon 

D U!.er Cannot Change Password 

D Pass!!ord Never Expires 

D Account Disahled 

OK 

!!elp 

2. In the Username box, type a user name of up to 20 characters. 

3. In the Full Name box, type the user's complete name. This entry is optional, 
but recommended. 

4. In the Description box, type a description of the user or the user account. 
This entry is optional, but recommended. 

5. In both the Password and Confirm Password boxes, type a password of up 
to 14 characters. 

Passwords are case-sensitive. Password attributes are controlled by the 
Account policy. For information see "Managing the Account Policy," 
later in this chapter. 
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6. Select or clear the following options. 

Option 

User Must Change 
Password At Next Logon 

User Cannot Change 
Password 

Password Never Expires 

Account Disabled 

Description 

Forces the user to change the password. 

Prevents the user from changing the assigned password. 
Usually, this option is selected only for user accounts 
(such as the Guest account) used by more than one 
person. 

Prevents the password from expiring, overriding the 
Maximum Password Age setting in the Account policy. 
Use this option for user accounts to which services (for 
example, the Replicator service) will be assigned using 
the Services option in Control Panel. 

Selection of this option overrides a selection of the User 
Must Change Password At Next Logon option. 

Prevents use of this account. For example, you might 
disable a new account to create an inactive template 
account that can be copied to create new accounts. 
Or, you might temporarily disable an account if it does 
not need to be used until a later date. 

For more information, see the discussion of disabled 
accounts under "Disabling or Deleting User Accounts," 
later in this chapter. 

7. To administer a user account property associated with one of the buttons at the 
bottom of the dialog box, choose a button and complete the dialog box that 
appears. 

Choose 

Groups 

Profile 

To 

Specify the groups in which the user account will be 
a member. 

Specify a logon script or home directory for the user 
account. 

These buttons and their dialog boxes are described later in this chapter. 

8. Choose the OK button. 

In many situations it may be quicker and more convenient to copy an existing 
user account than it would be to create an entirely new one. The main benefit of 
copying a user account is that the group memberships are copied to the new 
account. 
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When a user account is copied, the description and group memberships are 
copied exactly. The profile information is copied, but it is copied conditionally 
as described in "Managing the User Environment Profile," later in this chapter. 
The user name, full name, and password of the new account are blank, and must 
be entered. The User Must Change Password At Next Logon check box is always 
cleared, and the User Cannot Change Password and Password Never Expires 
check boxes are copied. 

The Account Disabled check box is always cleared so that a new account is 
always active, regardless of the setting in the original user account. This is done 
so that you can create a new user account~ configure it as needed, disable it, and 
then use it as a template. To rapidly create several similar accounts, you can 
repeatedly copy the disabled template account. 

User Manager does not copy any rights and permissions that have been granted 
to a user account. However, it is recommended that these be provided only to 
groups, and not be granted directly to user accounts. Because the group 
memberships of the original account are copied to the new user account, the 
new user account will usually have the same abilities and access to resources 
as the original account. 

~ To make a copy of an existing user account 

1. Select a user account from the list in the User Manager window, and then 
choose Copy from the User menu. 

2. In the Copy Of dialog box, configure the user account as described in the 
previous procedure for creating a new user account. 

3. When the user account is configured, choose the OK button. 

Managing User Account Properties 
The procedure you use to modify user accounts differs slightly, depending 
on whether you are modifying one user account or multiple user accounts. 

When you change the properties of an existing user account, the changes take 
effect the next time that user logs on. 

~ To modify one user account 

1. In the User Manager, double-click a user account. Or select a user account, 
and then choose Properties from the User menu. 



Username: louis em 

Full Rame: I Morgan. louise 

Qescription: IAdministrative Assistant 

e.assword: I zz,uzzu.zzzzzz 
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I: ····Ot(· I I 
1:"'C;n~el I 

Help····1 

Confirm ,---------------, 
Password: Izzzzzzzzzzzzzz 

D User Must Change Password at Next logon 

D U!.er Cannot Change Password 

D Pass~ord Never Expires 

D Account Disal!.led 

For security, the password is represented by a row of asterisks, with the 
number of asterisks different from the actual number of characters in the 
password. 

2. To change the Full Name or the Description, type new text in those boxes. 

3. To change the password, type a password of up to 14 characters in both the 
Password and Confirm Password boxes. 

Remember to provide the new password to the user of this account. 

4. To change the settings of the Account Disabled option or the three password 
options, select or clear those check boxes. 

5. To administer a property associated with one of the buttons at the bottom of 
the User Properties dialog box, choose a button and complete the dialog box 
that appears. 

These buttons and their dialog boxes are described later in this chapter. 

6. Choose the OK button. 

The advantage of modifying multiple user accounts is that you can make the same 
change simultaneously to several accounts. For example, you might select several 
accounts and add them to a new local group. 
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~ To modify two or more user accounts in the same way 

1. In the User Manager window, select two or more user accounts. 

2. From the User menu, choose Properties. 

Users: n Dickm 

n Ernesta 
n Jeant 

In Louisem 

,!2escription: 

Moseley, Dick 

Aydelotte, Ernest 

Thompson, Jean 

M organ, Louise 

o U.!ers Cannot Change Password 

o Pass~ords Never Expire 

III Accounts Disa.!!led 

If all the selected user accounts have an identical description, that text 
appears in the Description box. If one or more of the accounts have a different 
description, the Description box is empty. 

If all the selected user accounts have the same setting for the Accourits 
Disabled option or one of the password options, the setting for that check box 
is displayed. If one or more of the accounts have a different setting for one of 
the options, that check box is indeterminate (filled with gray). 

3. To change the Description for all the selected user accounts, type new text in 
that box. 

4. To change the settings of the Account Disabled and the two password options 
for all the selected user accounts, select or clear those check boxes. 

5. To administer a property associated with one of the buttons at the bottom of 
the User Properties dialog box, choose a button and complete the dialog box 
that appears. 

These buttons and their dialog boxes are described later in this chapter. 

6. Choose the OK button. 

Any changes you made are applied to all the selected user accounts. 
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Managing Group Memberships 
Use the Group Memberships dialog box to manage, for the selected user accounts, 
membership in the groups of this workstation. 

The procedure you use to manage group memberships depends on whether you 
are administering one user account or multiple user accounts. 

t> To manage group memberships when only one user account is selected 

1. Choose the Groups button from the New User, Copy Of, or User Properties 
dialog box. 

User: Jeant (Thompson. Jean) 

Member of: Not member of: 

I (- Add I ~ ~ Backup Operators 
, - - ~ ~ Guests 

1:,Bemove-> ,I ~ ~ Pow~r Users 
w.-__ """", ~ ~ Repllcator 

Help 

I

£&C{} Users I a. 'if",N,<; 

~----------------~ ~----------------~ 

In the Group Memberships dialog box, the Member Of box lists the groups 
this user account belongs to, and the Not Member Of box lists the groups this 
user account does not belong to. 

2. To add the user account to one or more groups, select one or more groups in 
the Not Member Of box, and then choose the Add button. Or, select one or 
more groups in the Not Member Of box, and then drag one of the selected 
group icons into the Member Of box. 

3. To remove the user account from one or more groups, select one or more 
groups in the Member Of box, and then choose the Remove button. Or, select 
one or more groups in the Member Of box, and then drag one of the selected 
group icons into the Not Member Of box. 

4. Choose the OK button. 

When two or more user accounts are selected, you can use the Group 
Memberships dialog box to add all the selected user accounts to one or more 
groups of this workstation, or to remove all the selected user accounts from one 
or more groups of this workstation. 
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r> To manage common group memberships for two or more user accounts 

1. In the User Manager window, select two or more user accounts, and then 
choose Properties from the User menu. 

2. In the User Properties dialog box, choose the Groups button. 

Users: Billo 
Jeant 
Jimgr 

All Are Members Of: 

I~ 
Users 

O'Daly. Bill 
Thompson. Jean 
Groves. Jim 

Hot All Are Members Of: 

Backup Operators 
Guests 
Power Users 
Replicator 

In the Group Memberships dialog box, the All Are Members Of box lists the 
groups that everyone of the selected user accounts belong to. If one or more 
of the selected user accounts do not belong to a particular group, that group 
is listed in the Not All Are Members Of box. 

3. To add the selected user accounts to one or more groups, select one or more 
groups in the Not All Are Members Of box, and then choose the Add button. 
Or, select one or more groups in the Not All Are Members Of box, and then 
drag one of the selected group icons into the All Are Members Of box. 

4. To remove the selected user accounts from one or more groups, select one or 
more groups in the All Are Members Of box, and then choose the Remove 
button. Or, select one or more groups in the All Are Members Of box, and 
then drag one of the selected group icons into the Not All Are Members Of 
box. 

5. Choose the OK button. 

When multiple user accounts are selected and the Group Memberships dialog box 
is open, the groups in the All Are Members Of box always have all the selected 
user accounts as members. But the groups in the Not All Are Members Of box 
may have none or some of the selected user accounts as members. 

Because of this, if you need to ensure that a group has none of the selected user 
accounts as members, perform the following procedure. 
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l> To ensure that a group has none of the selected user accounts as members 

1. In the Group Memberships dialog box, move the group from the Not All 
Are Members Of box into the All Are Members Of box. 

2. Choose the OK button to save the change. 

3. In the User Properties dialog box, choose Groups. 

4. In the Group Memberships dialog box, move the group from the All Are 
Members Of box back into the Not All Are Members Of box. 

5. Choose the OK button. 

Managing Profiles 
Use the User Environment Profile dialog box to define the logon script name and 
home directory for the selected user accounts. All entries in this dialog box are 
optional. 

Logon Script Name 
Logon scripts are optional. If a logon script is assigned to a user account, it runs 
automatically every time the user logs on. It can be used to configure a user's 
working environment at every logon, and it allows an administrator to affect a 
user's environment without managing all aspects of it. A logon script can be 
assigned to one or more user accounts. 

A logon script is typically a batch file (any text file with a .BAT or .CMD file 
name extension), but any executable program (.EXE file name extension) can 
also be used. 

In the User Environment Profile dialog box, logon scripts are assigned to user 
accounts by typing the file name (for example, clerks.bat) in the Logon Script 
Name box. At logon, the system finds the logon script by looking for that file 
following the workstation's logon script path. If a relative path is provided in 
front of the file name (for example, ADMINS\CRISTALW.BAT), the system 
looks for the logon script in that subdirectory of the logon script path. 

The logon script path for a Windows NT workstation is C:\WINNT\SYSTEM32 
\REPL\IMPORT\SCRIPTS. If Windows NT is installed in a location other than 
C:\WINNT, the system adjusts the logon script path accordingly. 

The entry in the Logon Script Name box only specifies the file name (and 
optionally the relative path) and does not create the actual logon script. You will 
need to create a logon script of the specified name, and place it in the appropriate 
directory. 
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Home Directory 
A home directory is a directory that is accessible to the user and contains files and 
programs for that user. It becomes that user's default directory for the File Open 
and Save As dialog boxes, for the command prompt, and for all applications that 
do not have a working directory defined. A home directory can be assigned to an 
individual user or can be shared by many users. 

Home directories make it easier for an administrator to back up user files and 
delete user accounts, because they collect many or all of a user's files in one 
location. 

The default home directory is \USERS\DEFAULT, on the local drive where 
Windows NT is installed. With User Manager, you can change this to another 
local directory or to a shared network directory. When administering the user 
accounts of a Windows NT workstation, you will usually assign local directories. 

In most cases, User Manager automatically creates the home directory you specify 
in the User Environment Profile dialog box. If it can't, a message appears 
instructing you to manually create the directory. 

In order for users to access their home directories, appropriate permissions must 
be granted. User Manager automatically applies those permissions if it creates the 
home directory. When one user account is being administered and a new home 
directory is created, that user is granted Full Control. When two or more user 
accounts are being administered and a new home directory is created, Full Control 
is granted to Everyone. 

User Manager does not automatically apply permissions if the directory already 
exists. In this case, you must apply the permissions using File Manager. 

Using %U5ERNAME% in the Home Directory Patn 
When entering a path for a home directory, %USERNAME% can be substituted 
for the last subdirectory in the path, and the system will later substitute the user 
name of the user account. This is useful when multiple user accounts are selected. 

For example, say eight user accounts are selected. Under Home Directory you 
might select the Local Path box and type c:\users\%username%. When you 
choose the OK button and the User Environment Profile is saved, for each user 
account the actual user name will be substituted for the %USERNAME% entry. 
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Note When assigning home directories that are on a FAT volume, if the user 
name of at least one of the selected user accounts is longer than 8 characters (or if 
it is longer than 8.3 characters when the user name contains a period), do not use 
the %USERNAME% wild card. User names can contain up to 20 characters, but 
FAT volumes restrict directory and file names to the 8.3 length convention (up to 
8 characters, optionally followed by a period and up to 3 characters). 

The assignment of home directories on NTFS volumes is not affected by this 
limit, so for NTFS volumes the %USERNAME% wild card can always be used 
regardless of the length of any user name. 

Managing the User Environment Profile 

t> To configure the user environment profile 

1. Choose the Profile button from the New User, Copy Of, or User Properties 
dialog box. 

O'Daly, Bill 
Thompson, Jean 
Groves, Jim 

!:.ogon Script Name: ,-I C_lE_R_K._S __ B_A_T _______ --' 

Home Directory 

@ local Eath: 1 C:\USERS\%USERNAME% 

o konnect D III To ,-I ________ ---' 

2. Optionally, to assign a logon script, type the filename in the Logon Script 
Name box. For example, type c1erks.bat. 

If the logon script is stored in a subdirectory of the logon script path, precede 
the file name with that relative path. For example, type admins\ernesta.cmd. 

3. Optionally, to specify a local directory as a home directory, select the Local 
Path box and type the local path (including the drive letter). For example, 
you might type c:\users\%username%. 

A local directory is recommended. 

4. Optionally, to specify a network directory as the home directory, select the 
Connect option, specify a drive letter, and then select the To box and type 
a network path. For example, you might specify drive H and type 
\\airedale\users\jeffbo. 
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Note If no home directory is specified, the system will use the default local 
home directory (\USERS\DEFAULT on the drive where Windows NT is 
installed) for each of the user accounts being administered. 

5. Choose the OK button. 

How the User Environment Profile Is Copied 
When a user account is copied, the logon script name is copied exactly. 

The home directory for the new account is copied based on this rule: if in the 
original account the last subdirectory in the home directory path is identical to the 
user name, the new account substitutes the new user name there. If not, the entry 
is copied exactly. Here are two examples: 

• If the original account has a user name of CARYR and a home directory of 
C:\USERS\CARYR, then a new account with a user name of BILLO is given 
a home directory of C:\USERS\BILLO. 

• If the original account has a user name of BLAKER and a home directory of 
\\HOUND\USERS\HOME, then a new account with a user name of JIMGR 
is given the same home directory: \\HOUND\USERS\HOME. 

Disabling or Deleting User Accounts 
A user's ability to log on can be rescinded by either disabling or deleting the user 
account. A disabled user account still exists, but the user is not permitted to log 
on. A disabled account continues to appear in the user account list of the User 
Manager window. A disabled account can be restored to enabled status at any 
time. 

Be certain you want to delete a user account before you do so, because a deleted 
user account cannot be recovered. Internally, Windows NT knows every user 
account by its security identifier (SID), a unique number that identifies it. Every 
group and user account ever created on the workstation has a SID. Internal 
processes in Windows NT refer to a user account's SID rather than its user name. 
So if you delete a user account and then create another user account with the same 
user name, the new user account will not have any of the rights or permissions 
previously granted to the old user account because the user accounts have 
different SID numbers. 

Because of this it is a good idea to first disable a user account, and then 
periodically delete the workstation's disabled accounts. This is a low-risk way 
to remove users from the workstation. 

Another reason to disable an account occurs when you want to create an inactive 
template account that can be copied to create new accounts. You can create a new 
user account, configure it as needed, disable it, and then use it as a template. As 
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described earlier in "Adding User Accounts," you can quickly make numerous 
enabled copies of a disabled template account. 

t> To disable one or more user accounts 

1. In the User Manager window, select one or more user accounts. 

2. From the User menu, choose Properties. 

3. Select the Account Disabled check box. 

4. Choose the OK button. 

Logons are no longer allowed for those user accounts. 

t> To enable one or more disabled accounts 

1. In the User Manager window, select one or more user accounts. 

2. From the User menu, choose Properties. 

3. Clear the Account Disabled check box. 

4. Choose the OK button. 

Logons are now allowed for those user accounts. 

t> To delete one or more user accounts 

1. In the User Manager window, select one or more user accounts. 

The built-in Administrator and Guest accounts cannot be deleted. 

2. From the User menu, choose Delete. 

3. If a confirmation message appears, choose the OK button. 

4. When the delete message appears, choose the Yes button. If multiple 
user accounts are selected, choose the Yes To All button. 

Renaming User Accounts 
Any user account can be renamed, including the built-in user accounts provided 
with the system. Because it retains its security identifier (SID), a renamed user 
account retains all its other properties - for example, its description, password, 
group memberships, user environment profile, and any assigned permissions and 
rights. The Rename command is only available when one user account is selected. 

t> To rename a user account 

1. In the User Manager window, select one user account. 

2. From the User menu, choose Rename. 

3. In the Rename dialog box, type a user name of up to 20 characters in 
the Change To box. . 

4. Choose the OK button. 
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Managing Groups 
Groups are collections of user accounts. Giving a user account membership in a 
group gives that user all the rights and permissions that have been granted to the 
group. This provides an easy way to grant common capabilities to sets of users. 

The built-in groups provided with Windows NT have been granted useful 
collections of rights and built-in abilities. In most cases, one of these built-in 
groups will provide all the capabilities needed by a particular user. For example, 
logging on to a user account that belongs to the built-in Administrators group 
gives you administrative capabilities over the workstation. To give a user account 
a needed set of capabilities, assign it to the appropriate built-in group. 

You can also use groups to easily manage access to resources such as directories, 
files, or printers. You assign resource permissions to a group, and then add user 
accounts to that group. If you need to change the permissions provided to that set 
of users, you simply add or remove the permissions assigned to the group, rather 
than to each of the user accounts. Or, if you need to give a new user access to a 
specific set of resources (for example, a number of directories and files), all you 
have to do is add the user's account to the appropriate group, rather than changing 
the permissions on each individual resource. Maintaining permissions for a group 
is simpler than maintaining permissions for many user accounts. 

In most situations the built-in groups provide all the capabilities needed by users 
of a workstation. However, if necessary, User Manager can be used to create and 
define additional groups in order to control access to specific sets of resources by 
specific sets of users. 

All the groups that can be maintained on a Windows NT workstation are of the 
same type. They are called local groups, and are represented by the local group 
icon. Such a group is called local because it can only be granted permissions and 
rights for its own workstation. However, it can contain user accounts from the 
workstation, and if the workstation participates in a domain, it can contain user 
accounts and global groups from its domain and from trusted domains. Local 
groups provide a way for you to create handy sets of users from both inside and 
outside the workstation, to be used only at the workstation. 
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~ If a Windows NT workstation participates in a domain there is another type of 
group that can be given access to the workstation. This is a global group, and it 
is represented by the global group icon. Such a group is called global because it 
can be used in many places: its own domain, servers and workstations of the 
domain, and trusting domains. This means that if a workstation participates in a 
domain, the global groups of that domain and of trusted domains can be granted 
permissions and rights for the workstation and membership in local groups of the 
workstation. A global group can contain only user accounts from its own domain. 

When adding a group you will be asked to provide a group name. It must be 
unique, meaning it cannot be identical to any other group name or user name of 
the workstation. It can contain any uppercase or lowercase characters except the 
following: 

" / \ [ ] = + * ? < > 

Note When Windows NT displays a group name and when the distinction 
is necessary, Windows NT identifies the domain or workstation the group is 
from by presenting the name in the form DOMAINNAME\groupname or 
COMPUTERNAME\groupname. This happens most often when a Windows NT 
workstation participates in a Windows NT Advanced Server domain and a domain 
group name is displayed. For example, a group named Managers from a domain 
named Engineering wouid be displayed as ENGINEERING\Managers. . 

Built-In Groups 
The actions a user can perform depend on the group memberships of his or 
her user account. Several built-in groups are provided with Windows NT, and 
by default each of these groups is granted a particular set of user rights. 

In addition to rights, some of the built-in local groups are granted built-in 
abilities. Although rights can be directly granted to and removed from groups 
and user accounts, these built-in abilities are not directly administerable. The 
only way for you to provide these built-in abilities to a user is to make that 
user a member of the appropriate local group. 
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The rights and built-in abilities granted to the built-in groups are shown in the 
following table. In most situations these built-in groups provide all the capabilities 
needed by the users of a workstation: 

• Local group has right or ability / t:' /' /' 

.3 $.{i / 

0 Local group does not have ~. ;' ~/§. $/ right or ability .(:;/~ ;.;:; .~, ~ 
~ ,r $. i"cf ii/3

' !S';§~.' ~ ;"' ~./.Q..,0 ~ .. ' ~~ 0:::i ;. ::..~ '~"ti~ 
~., -'5." 4i;, 0" 

Rights: 

Log on locally • • • • • • 
Access this computer from network • • 0 0 • 0 

Take ownership of files • 0 0 0 0 0 

Manage auditing and security log • 0 0 0 0 0 

Change the system time • • 0 0 0 0 

Shut down the system • • • 0 • • 
Force shutdown from a remote system • • 0 0 0 0 

Back up files and directories • 0 0 0 0 • 
Restore files and directories • 0 0 0 0 • 
Built-in abilities: 

Create and manage user accounts • .1 0 0 0 0 

Create and manage local groups • .2 .3 0 0 0 

Assign user rights • 0 0 0 0 0 

Lock the workstation • • 0 0 • 0 

Override the lock of the workstation • 0 0 0 0 0 

Format workstation's hard disk • 0 0 0 0 0 

Create common groups • • 0 0 0 0 

Keep local profile • • 0 0 0 • 
Share and stop sharing directories • • 0 0 0 0 

Share and stop sharing printers • • 0 0 0 0 

1 A Power User can create user accounts, but can modify and delete only those accounts he 
or she creates. 

2 A Power User can create local groups. A Power User can also add and remove users from 
local groups he or she has created, as well as the Power Users, Users, and Guests local groups, 
but cannot modify the Administrators or Backup Operators local groups. 

3 Users can create local groups, but a User can modify only the local groups that he or she created. 
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To provide these rights and built-in abilities to a user, add the user's account to 
the appropriate group. Following are brief discussions of each built-in group. 

Administrators 
The Administrators group is the most powerful group on a workstation. 
Administrators have more control over the Windows NT workstation than do any 
other users, and they manage the workstation's overall configuration. The built-in 
Administrator user account is a member of the Administrators group, as is the 
Initial User account (if one was created during installation). 

If the Windows NT workstation participates in a domain, the Domain Admins 
group is by default a member of the workstation's Administrators group, and 
members of that domain group can administer the workstation. (However, this 
can be prevented by removing the Domain Admins global group from the 
workstation's Administrators group.) 

Note that administrators do not automatically have access to every file on the 
workstation. If a file's permissions do not grant access, the administrator cannot 
access the file. Every file on an NTFS volume has an owner, who can set 
permissions on the file. If needed, an administrator can take ownership of a file 
and thus have access to it. But if the administrator does so, this event is recorded 
in the security log (if auditing of files is turned on), and the administrator cannot 
give ownership back to the original owner. For more information, see Chapter 4, 
"File Manager." 

Power Users 
The Power Users group provides limited administrative abilities to its 
member user accounts. A Power User can share directories on the network; 
set the computer's internal dock; install, share, and manage printers; and create 
common program groups. 

A Power User can use User Manager to create user accounts and groups, and to 
modify or delete those user accounts and groups. A Power User can also add and 
remove users from the Power Users, Users, and Guests group. 

Users 
Membership in the Users group provides the abilities a user needs to perform 
normal tasks. Except for the built-in Administrator, Guest, and Initial User 
accounts, all workstation user accounts belong to the Users group. When a 
new user account is added, it is automatically a member of this group. 
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If a Windows NT workstation participates in a domain, the Domain Users group 
is by default a member of the workstation's Users group, and domain users have 
normal user access to and abilities on the workstation. (However, this can be 
prevented by removing the Domain Users global group from the workstation's 
Users group.) 

Guests 
The Guests group allows occasional or one-time users to log on and be granted 
limited abilities. The built-in Guest user account is a member of the Guests group. 

Resource permissions granted to the Users group can be withheld from the Guests 
group, effectively restricting the abilities of Guests. 

Backup Operators 
Members of the Backup Operators group can back up directories and files, and 
restore directories and files. 

Replicator 
The Replicator group supports directory replication functions. The only member 
of the Replicator group should be a domain user account used to log on the 
workstation's Replicator Service. Do not add the accounts of actual users to this 
group. 

Special Groups 
In addition to the built-in groups mentioned above, some other groups are created 
by the system and are used for special purposes. These groups are not listed in the 
User Manager window. 

However, when you administer a workstation and Windows NT presents lists of 
groups, these special groups sometimes appear in the list. For example, they can 
appear when assigning permissions to directories, files, shared network 
directories, or printers. 



Group 

Everyone 

INTERACTIVE 

NETWORK 

SYSTEM 

CREATOR OWNER 

Adding Local Groups 
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Refers to 

Anyone using the computer. This includes all local and remote 
users (that is, the INTERACTIVE and NETWORK groups 
combined). 

Members can access the network, connect to the workstation's 
shared network directories, and print to the workstation's 
printers. 

Anyone using the computer locally. 

All users connected over the network to the computer. 

The operating system. 

Transfer of permissions to creators of subdirectories, files, 
and print jobs. For a directory, if permissions are granted to the 
CREATOR OWNER group, the 'creator of a subdirectory or file 
will be granted those permissions for that subdirectory or file. 
For a printer, if permissions are granted to the CREATOR 
OWNER group, the creator of a print job will be granted those 
permissions for that print job. 

A local group can be added either by creating a completely new local group, 
or by copying an existing local group. 

1> To create a new local group 

1. In the User Manager window either select the user accounts you want to be 
the initial members of the new group, or select any group to ensure no user 
accounts are initially selected. 

2. From the User menu, choose New Local Group. 

If you selected one or more user accounts in step 1, the selected users are 
the initial members of the new group. 

liroup Name: 

Qescription: 

Members: 

f} Louisem 
f} Natesun 
f} Pammu 

I lihow Full Names 

OK 

Cancel 

.!!elp 

Add. __ 

I Removo 
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3. To view the full names of the listed user accounts, choose the Show Full 
Names button. 

This can be a lengthy operation when the workstation participates in a domain, 
and the local group contains numerous users from other domains. 

4. In the Group Name box, type a name for the new group. 

5. In the Description box, type a description. 

6. To add members to the local group, choose the Add button and complete the 
Add Users And Groups dialog box that appears. 

You can add user accounts from the local workstation. If the workstation 
participates in a domain, you can also add user accounts and global groups 
from that domain and from trusted domains. For information on the Add Users 
And Groups dialog box, see Chapter 4, "File Manager." 

7. To remove members from the local group, select one or more names from the 
Members box, and then choose the Remove button. 

8. Choose the OK button. 

The main advantage of copying a group is that the new group will have the same 
members as the original group. However, the permissions, rights, and built-in 
abilities of the original group are not copied to the new group. 

t> To make a copy of an existing local group 

1. In the User Manager window, select one local group. 

2. From the User menu, choose Copy. 

3. Define the new group as described in the previous procedure for creating a 
new local group. 

You must provide a group name. You can accept or change the description 
and group members, which were copied from the original account. 

4. Choose the OK button. 

After a local group has been created, it can be granted permissions at its 
workstation. These permissions might allow, for example, access to files (as set 
in File Manager) or printers (as set in Print Manager). 
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Managing Local Group Properties 
The description and the membership of an existing local group can be modified. 

I> To modify a local group 

1. In the User Manager window, double-click one local group. Or select the 
local group, and then choose Properties from the User menu. 

In the Local Group Properties dialog box, the group name is displayed but 
cannot be changed. 

liroup Name: Administrators 

J2escription: Members can full), administer the computerJdom 

Members: 
Show Fuji N~unes ~I I:',:r:f:l.eti{ 

n Administr ator 
~ Ernesta 

2. To view the full names of the listed user accounts, choose the Show Full 
Names button. 

This can be a lengthy operation when the workstation participates in a domain, 
and the local group contains numerous users from other domains. 

3. To change the description, type new text in the Description box. 

4. To add members to the local group, choose the Add button and complete 
the Add Users And Groups dialog box that appears. 

You can add user accounts from the local workstation. If the workstation 
participates in a domain, you can also add user accounts and global groups 
from that domain and from trusted domains. For information on the Add 
Users And Groups dialog box, see Chapter 4, "File Manager." 

5. To remove members from the local group, select one or more names from 
the Members box, and then choose the Remove button. 

6. Choose the OK button. 
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Deleting Groups 
Groups that have been created using User Manager can be deleted, but the built-in 
groups provided with Windows NT cannot. 

Be certain you want to delete a group before you do so, because a deleted group 
cannot be recovered. Internally, Windows NT knows every group by its security 
identifier (SID), a unique number that identifies it. Every group and user account 
ever created on the workstation has a SID. Internal processes in Windows NT 
refer to a group's SID rather than its group name. So if you delete a group and 
then create another group with the same group name, the new group will not have 
any of the rights or permissions granted the old group, because the groups have 
different SID numbers. 

Deleting a local group removes only that group: it does not delete the user 
accounts or global groups that are members of the deleted local group. 

t> To delete a local group 

1. Select the local group from the group list in the User Manager window. 

2. From the User menu, choose Delete. 

3. If a confirmation message appears, choose the OK button. 

4. When the delete message appears, choose the Yes button. 

Managing the Security Policies 
The following security policies can be managed with User Manager: 

• The Account policy, which controls the way passwords must be used by 
all user accounts 

• The User Rights policy, which controls the rights assigned to groups and 
user accounts 

• The Audit policy, which defines the security events that will be audited 

Managing the Account Policy 
The Account policy controls the way passwords must be used by all user 
accounts. Changes to this policy affect each user at the next logon. 
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t> To manage the Account policy 

1. From the Policy menu, choose Account. 

Computer: AIREDALE 

.Maximum Password Age 

o Password Rever Expires 

@ fxpires In I 42 f33 Days 

Minimum password. L. engt

d o Permit .!llank Password 

@ At least ~ Characters 

Minimum Password Age 

o allow Changes Immediately 

@ Allow ~hanges In I 7 ~ Days 

Password Uniqueness 

o Q.o Not Keep Password History 

@ Remember ~ Passwords 

2. In the Account Policy dialog box, define the four password parameters. 

Parameter Meaning 
-------------------------------------------------------------------
Maximum Password Age The period of time a password can be used before 

the system requires the user to change it. 

Minimum Password Age The period of time a password must be used before 
the user is allowed to change it. 

If you select the Allow Changes Immediately option 
here, then under Password Uniqueness you must select 
the Do Not Keep Password History option. 

Minimum Password Length The fewest characters a password can contain. 

Password Uniqueness The number of new passwords that must be used by 
a user account before an old password can be reused. 

3. Choose the OK button. 

If you enter a uniqueness value here (for example, 
Remember 4 Passwords), then under Minimum 
Password Age you must specify an age value 
(for example, Allow Changes In 7 Days). 
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Managing the User Rights Policy 
A right authorizes a user to perform certain actions on the system. A user who 
logs on to an account to which the appropriate rights have been granted can carry 
out the corresponding actions. When a user does not have appropriate rights, 
Windows NT blocks attempts to carry out those actions. 

Rights apply to the system as a whole, and are different from permissions, which 
apply to specific objects. Apermission is a rule associated with an object (usually 
a directory, file, or printer) to regulate which users can have access to the object 
and in what manner. Most often the creator or owner of the object sets the 
permissions for the object. 

Rights are not associated with a specific object. Instead, a right applies to the 
entire system, and may override permissions set on an object. For example, a user 
logged on as a member of the Backup Operators group has the right to perform 
backup tasks. Doing so requires the ability to read all files on the system, even 
files on which their owners have set permissions that explicitly deny access to all 
users, including members of the Backup Operators group. A right, in this case the 
right to perform backup, takes precedence over all file and directory permissions. 

Each of the built-in groups conveys certain rights and built-in abilities to the user 
accounts that belong to it. For information on the capabilities of these groups see 
"Built-In Groups," earlier in this chapter. 

The following table describes the user rights managed with the User Rights 
policy. 

User right 

Access this computer 
from network 

Back up files and 
directories 

Change the system time 

Force shutdown from a 
remote system 

Log on locally 

Manage auditing and 
security log 

Restore files and 
directories 

Shut down the system 

Take ownership of files 
or other objects 

Allows a user to 

Connect over the network to the computer. 

Back up files and directories. This right supersedes files 
and directory permissions. 

Set the time for the internal clock of the computer. 

This right is not currently implemented. It is reserved for 
future use. 

Log on at the computer itself, from the computer's keyboard. 

Specify what types of events and resource access are to be 
audited. View and clear the security log. 

Restore files and directories. This right supersedes files 
and directory permissions. 

Shut down Windows NT. 

Take ownership of files, directories, and other objects on 
the computer. 
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In addition to the user rights listed above, if the Show Advanced User Rights 
option is selected, some additional rights can be managed with the User Rights 
policy. Many of these advanced rights are useful only to programmers writing 
applications to run on Windows NT, and usually will not be granted to a group 
or user. For more information on their use, see the Windows NT programming 
documentation. These programming rights are shown in the following list. 

• Act as part of the operating system 

• Bypass traverse checking 

• Create a pagefile 

• Create a token object 

• Create permanent shared objects 

• Debug programs 

• Generate security audits 

• Increase quotas 

• Increase scheduling priority 

• Load and unload device drivers 

• Lock pages in memory 

• Log on as a batch job 

• Log on as a service 

• Modify firmware environment values 

• Profile single process 

• Profile system performance 

• Receive unsolicited device input 

• Replace a process level token 

A few of the advanced rights may be of interest to workstation administrators. 

Advanced user right 

Bypass traverse checking 

Log on as a service 

Allows 

A user to change directories and travel through a directory 
tree, even if the user has no permissions for the traversed 
directories. 

A process to register with the system as a service. 



378 System Guide 

In most situations the easiest way to provide rights to a user is to add that user's 
account to one of the built-in groups that already possesses the needed rights, 
rather than by administering the User Rights policy. However, if a special 
situation occurs, it is possible to assign a right to or remove it from a user or 
a group by employing the following procedure. 

r> To manage the User Rights policy 

1. From the Policy menu, choose User Rights. 

~rant To: 

Backup Operators 
Everyone 

Guests 
Power Users 

Users 

o ~how Advanced User Rights 

2. Select a user right from those listed in the Right box. 

When you select a right, the Grant To box lists the groups and user accounts 
that are assigned that right. 

3. To grant the selected right to additional groups or user accounts, choose the 
Add button and complete the Add Users And Groups dialog box that appears. 

Local groups and user accounts from this workstation can be granted rights. 
If this workstation participates in a domain, user accounts and global groups 
from the local domain and trusted domains can also be granted rights. For 
information on the Add Users And Groups dialog box, see Chapter 4, "File 
Manager." 

4. To remove a group or user account from the list of those granted this right, 
select a name in the Grant To box, and then choose the Remove button. 

S. Repeat steps 2 through 4 as necessary. 

6. To administer the advanced user rights, select the Show Advanced User 
Rights check box, and then follow steps 2 through 4. 

7. Choose the OK button. 
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Managing the Audit Policy 
Through auditing, you can track selected activities of users. The Audit policy 
determines the amount and type of security logging Windows NT will perform. 

Windows NT can record a range of event types, from a system-wide event such 
as a user logging on, to an attempt by a particular user to read a specific file. Both 
successful and unsuccessful attempts to perform an action can be recorded. 

Use the Audit policy to select the types of security events that will be audited. 
When such an event occurs, an entry is added to the workstation's security log. 
The security log can be viewed with Event Viewer. 

The following table describes the types of events that can be audited. 

Type of event 

Logon and Logoff 

File and Object Access 

Use of User Rights 

User and Group 
Management 

Security Policy Changes 

Restart, Shutdown, and 
System 

Process Tracking 

Description 

A user logged on or off the workstation, or made a network 
connection. 

A user accessed a directory or a file that is set for auditing 
in File Manager, or a user sent a print job to a printer that 
.is set for auditing in Print Manager. 

A user used a user right (except those rights related to 
logon and logoff). 

A user account or group was created, changed, or deleted. 
A user account was renamed, disabled, or enabled; or a 
password was set or changed. 

A change was made to the User Rights or Audit policies. 

A user restarted or shut down the computer, or an event has 
occurred that affects system security or the security log. 

These events provided detailed tracking information 
for things like program activation, some forms of handle 
duplication, indirect object accesses, and process exit. 

Because the security log is limited in size, carefully choose the events to be 
audited, and consider the amount of disk space you are willing to devote to the 
security log. The maximum size of the security log is defined in Event Viewer. 
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J> To manage the Audit policy 

1. From the Policy menu, choose Audit. 

Computer: AIREDALE I: iOKO 
o Do Not Audit 

• Audit These Events: 
Success Failure I . Help 

1,.ogon and Logoff D [81 
Eile and Object Access [81 [81 
!!se of User Rights [81 [81 
User and y'roup Management D [81 
~ecurity Policy Changes [81 [81 
Restart. Shutdown. and System [81 [81 
e.rocess Tracking D D 

2. Select one of the two main auditing options. 

If you select 

Do Not Audit 

Audit These Events 

Then 

Security events are not recorded in the security log 

Selected events are recorded in the security log 

3. If you select Audit These Events, specify the events to be audited by selecting 
or clearing the Success and Failure check box for each type of event. 

4. Choose the OK button. 



381 

CHAPTER 14 

Backup 

Backup is a graphical tool for protecting data from accidental loss or hardware 
and media failures. It makes it easy for you to use a tape drive to back up and 
restore your important files on either the NTFS, FAT, or HPFS file system. It also 
makes it easier to archive that data for legal or historical purposes and remove 
older, unused files, safe in the knowledge that you can recover them if necessary. 

This chapter provides information on how to use the graphical commands for 
selective backups and restores or to create your own batch file to automate the 
process, and includes the following main topics: 

• Backing up disk files to tape 

• Restoring tape files to disk 

• Maintaining tapes 
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Overview 
In Microsoft Windows NT, doing simple backups and restores on your local tape 
drive has been made easy with the Backup program. This program is located in 
the Administrative Tools group in Program Manager. 

The following list provides an overview of some of the things you can do with 
this graphical tool to protect your data: 

• Back up and restore both local and remote files on an NTFS, FAT, or HPFS 
file system from your own computer using an attached tape drive. 

• Select files for backing up or restoring by volume, directory, or individual 
filename and view detailed file information, such as size or modification date. 

• Select an optional verification pass to ensure reliable backups or restorations. 

• Perform any of the following common backup operations: Normal, Copy, 
Incremental, Differential, and Daily. 

• Place multiple backup sets on a tape, and either append new backup sets 
or replace the old ones with new ones. 

• Span multiple tapes with both backup sets and files, since there is no 
file-size restriction. 

• Create a batch file to automate repeated backups of drives. 

• Review a full catalog of backup sets and individual file and directory 
information so you can select files to be restored. 

• Control a restore's destination drive and directory. 

• Save log information on tape operations to a file. Also view tape-operation 
information in the Windows NT Event Viewer. 

Starting and Quitting Backup 
Double-click the Backup icon in the Administrative Tools group to display the 
main Backup window with the Drives window open and a Tapes icon. (You can 
also type ntbackup or start ntbackup at the command prompt.) The menu bar 
is supplemented with a toolbar for easier access to the most commonly used 
commands. The status bar at the bottom of the window provides descriptions of 
each of the commands and program-status information. Both context-sensitive 
and standard Help are provided for all Backup commands. 

If this is the first time that you have used Backup or if you have just installed 
a new or additional tape backup device, you need to load the appropriate tape 
backup device driver and then restart your computer to activate it. 
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t> To load a tape driver 

1. In the Main program group, double-click the Windows NT Setup icon. 

After determining your hardware configuration, the Windows NT Setup 
dialog box appears. 

2. From the Options menu, choose Add/Remove Tape Devices. . 

3. In the Tape Device Setup dialog box, choose the Add button to view a list 
of the tape devices that are compatible with Windows NT. 

4. Select a device from the list and choose the Install button. 

A message advises you that the driver for this tape device is already installed 
and asks if you want to use the current one or install a new one. 

5. Unless you have a disk for a newer version, choose the Current button. 

The name of the selected tape device appears within a box in the Tape Device 
Setup dialog box. ' 

6. Choose the OK button. 

7. From the Options menu, choose Exit. 

A message advises you that your computer configuration has changed and 
that you must shut down and then restart your computer to use the new 
configuration. 

8. In the Setup Message box, choose the OK button. 

To avoid restarting your computer, you can also use the Devices option in 
Control Panel to start the tape device. 

,.~ .... ~ .. ~,ELLi1rul:}2;~I:L;~L\,~,*";,,,,*.J D ~ G: 
D [£] D: \\poodle\public D [£] H: \\sheepdog\public 

D [£] E: \\shepherd\razzle 

D [E.1 F: \\SETTER\STATS 

Tapes icon Drives window 
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You can only back up files on a disk drive to which you normally have access. 
Otherwise, you need to be logged on as a member of the Administrators or 
Backup Operators group. Notice that backup rights enable you to bypass the 
protection provided by normal file permissions. Also, use caution in granting 
restore rights since they enable a user to ignore normal file-permission conflicts 
during restoration and to overwrite existing files. 

The following most commonly used commands from the Operations and Select 
menus are also available on the toolbar: 

Backup 

Restore 

Catalog 

Retension Tape 

Eject Tape 

Erase Tape 

Check 

Uncheck 

The Tree, View, ~nd Window menus provide commands for manipulating 
your windows the same as in File Manager. The View menu also enables you 
to display or hide the status bar and toolbar, and to change your font selection. 
See online Help for detailed procedures. 

1;1.. To quit Backup, you can choose either Exit from the Operations menu or Close 
from the Control menu. To remove the tape before quitting, you can choose Eject 
Tape from the Operations menu or click the Eject Tape button on the toolbar. If 
the tape device supports software control of tape ejection, the tape is rewound and 
ejected. If it does not, the tape is simply rewound in preparation for manual 
ejection. 

Selecting Your Hardware 
The system automatically checks for the proper hardware when you start 
Windows NT and initializes it each time you start Backup. Notice, however, that 
the tape drive must be turned on before you start Windows NT for the drivers to 
be loaded properly. If you have more than one tape backup device, you can use 
the Hardware Setup command from the Operations menu to select a different 
device. 

Note If you do not have a tape drive, you can use the backup or xcopy 
commands to back up files to a floppy disk. 

Windows NT currently supports both high-capacity SCSI tape backup devices 
for 4 mm DAT, 8 mm, and .25-inch drives and the less expensive mini-cartridge 
drives. You may have more than one tape drive connected to your system. 
However, only one tape drive may be selected at a time. 
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Backing Up Disk Files to Tape 
Because information is the most important resource on a workstation or network, 
backing up that information is an administrator's most critical function. And, 
therefore, you need to create backup policies and standard hardware-maintenance 
policies for disaster avoidance rather than just recovery. 

When formulating your policies, decide what needs to be backed up and what you 
consider to be a reasonable period of time during which essential services can be 
unavailable. Based on that decision, determine what steps you will take to protect 
critical data, which can range from a simple backup done with the Windows NT 
Backup program to the use of alternate sites or disk fault-tolerance methods. 
The Windows NT Advanced Server Disk Administrator program provides fault­
tolerance functionality for creating mirror sets and stripe sets with parity. 

Then decide how often you need to redo such a complete risk assessment. 
You will need to evaluate the continuing importance of various operations and 
determine likely new areas of exposure. If security is important to you, your 
backup policy should also provide for an independent review of the security 
audit log to ensure that backups are being performed according to policy. 

Choosing Files to Back Up 
You can select either all the files on a disk or individual files only, the same way 

. you would in File Manager. Mter selecting your files, choose the Check button on 
the toolbar to select each file's check box. Or if you only want to select a few 
files, just select the check box for each filename. 

The Drives window will normally be open when you start the Backup program. 
However, sometimes you will want to minimize it and then reopen it when 
needed, either by double-clicking the Drives icon or by choosing Drives from 
the Window menu. 

There will also be times when you will leave Backup, use File Manager to 
connect to another network drive, and then return to Backup and need to choose 
Refresh from the Window menu to update the Drives window and view the 
additional network drive. 
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~ To open the Disk File Selection window 

• In the Drives window, double-click the appropriate disk drive icon or letter. 

Disk and Tape File Selection windows are organized the same as in File Manager, 
with the same viewing options for seeing the directory tree structure and the 
directory and filenames list. The default is a split, resizable panel showing both 
options. Filenames are only shown in the Directory List panel. Selecting All File 
Details displays filenames, size, last modification date and time, and file attributes 
(such as hidden, system, read-only, or archive). 

~ To select all the files on a disk 

C[fu • In the Drives window, select the disk drive and then, from the Select menu, 
choose the Check command. Or choose the Check button on the toolbar. 

-Or-

• In the Drives window, select the check box for the appropriate disk drive. 

Notice that, even when a disk drive is selected, the program will not back up 
those files and directories that the user does not have security permission to read, 
including files that are hidden in a directory with no read permission and 
displayed with an exclamation point in the file's icon. All file attributes are 
preserved, including permissions. 
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t> To select files individually 

1. Open the Disk File Selection window. 

2. To select a few files, select the check box for each filename. 

To select several files, select the first filename and then do one of the 
following: 

• Press and hold down the SHIFT key and then select the last contiguous 
filename. 

• Drag the mouse to the last contiguous filename. 

• Press and hold down the CTRL key and then select each non-contiguous 
filename. 

3. Choose the Check command from the Select menu, or the Check button on 
the toolbar, to select each file's check box. 

Choose the Uncheck command from the Select menu, or the Uncheck button 
on the toolbar, to undo all your selections. 

Notice that when only some files are selected, the corresponding disk-drive 
and directory check boxes have a gray background. 

Setting the Tape Options 
After selecting one or more disk drives or files to back up, choose the Backup 
command from the Operations menu to open the Backup Information dialog box. 
The upper section provides information on the tape that you loaded. You can 
choose whether you want to append the new backup set after the last backup set 
or replace an old set with the new one. If you want to secure the tape by limiting 
access to it, select the check box for Restrict Access To Owner Or Administrator. 
If you want to confirm that the tape was backed up accurately, select the Verify 
After Backup check box. If you want to add a copy of your Windows NT Registry 
files to the backup set, select the Backup Local Registry check box. 
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Current Tape: 

Creation Date: 

Owner: 

Lape Name: 

Directory Backups 1128/93 

1128/93 1 :,(6:1,( PM 

pegetl \Administrator 

[g] ~erify After Backup D Backup local Registry 

[g] R,@.strict Access to Owner or Administrator 

Backup Set Information (1 of 1 sets) 

Drive Name: C: PEGETl 

!!.escription: I Update to MSPUB directory 

!tackup Type: I Incremental Iii 

Operation 

@,wpend 

o Replace 

log Information----------------------, 

hog File: I C:\nt\BACKU P.lO G 

o ~ummary Only 0 DQn't log 

V OK . ·1 Cancel 

The following table describes the options in the upper section of the Backup 
Information dialog box. 

Item 

Current Tape 

Creation Date 

Owner 

Tape Name 

Append 

Replace 

Description 

The current tape's name is shown here unless there is no 
tape loaded, it is blank, or it has an unrecognized format. 

The creation date of the original backup set, or the date 
when it was last replaced, is automatically displayed here 

The owner of the tape, that is, whoever put the first backup 
set on the tape, is automatically displayed here. 

You can use up to 32 characters to create or change a 
current tape name. 

This operation adds the backup set(s) to the end of the 
last backup set on the active tape. Tape Name and Restrict 
Access To Owner Or Administrator are unavailable with 
this operation. 

This operation overwrites all the information on the 
tape. However, if you do not confirm the choice, another 
message gives you the option of appending instead. 



Item 

Verify After Backup 

Restrict Access To Owner 
Or Administrator 

Backup Local Registry 

Setting the Backup Set Options 
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Description 

You can select whether or not to perform a verification 
comparison of the files that are written to tape and the files 
on the disks. 

You can designate the tape as "secure." Only the tape 
owner, or a member of the Administrators or Backup 
Operators group, can read, write, or erase the tape on the 
owner's original computer using the Windows NT Backup 
program. To restore it on another computer, even if it has 
the same username, you must be logged on as a member 
of the Administrators or Backup Operators group. 

You can include a copy of the local Windows NT Registry 
files in the backup set. 

The second section of the Backup Information dialog box shows how many 
backup sets have been selected, each set being a collection of related files on one 
drive that is backed up during a single backup operation. If you select more than 
one disk drive, Backup provides a scroll bar for moving between backup sets so 
you can enter separate descriptions, up to a length of 32 characters, and select 
different backup types for each drive selected. 

When deciding which backup type to use, one of the criteria should be whether 
or not it will mark the files as having been backed up. Windows NT maintains a 
marker (called the archive bit) for each file that allows backup programs to mark 
the files after backing them up. When the file changes, Windows NT marks the 
file as needing to be backed up again. 

With Windows NT Backup, you can choose to back up only those files that 
have this marker set, and you can choose whether or not to mark the files as 
having been backed up. The normal (or full) backup type is best when a large 
amount of data changes between backups, or to provide a baseline for the other 
backup types. The incremental backup type is good if you need to keep frequent 
"checkpoint" versions of changed data. The differential backup type simplifies the 
process for restoring files. To provide for long-term storage with fewer tapes, you 
can use a combination of a normal backup plus either incremental or differential 
backups. 
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The following table describes the different types of backup operations that you 
can choose. 

Choose 

Normal 

Copy 

Incremental 

Differential 

Daily 

Setting the Log Options 

To 

Back up and mark as such all the selected files on the disk. 
A normal backup is the same as a full backup. 

Back up, but not mark as such, all the selected files on the disk. 

Back up and mark as such only those selected files that have 
been modified on the disk. 

Back up, but not mark as such, only those selected files that 
have been modified on the disk. 

Back up, but not mark as such, only those selected files that 
have been modified that same day on the disk. (This can be 
useful if you want to take work home and need a quick way 
to select the files that you worked on that day.) 

In the final section of the Backup Information dialog box, you can choose not to 
log information or you can choose to create a log that contains either a summary 
of major operations or full details on all operations. If you choose to create a log, 
you can type the name of the text file into which the information on completed 
tape operations will be logged. You can also use the Browse button at the end of 
the Log File box to help you locate the correct filename for the log. 

The following are descriptions of the three logging options. 

Choose 

Full Detail 

Summary Only 

Don't Log 

To 

Log all operations information including the names of all the 
files and directories that are backed up. 

Log only the major operations such as loading a tape, starting 
the backup, and failing to open a file. 

Log no information. 

When you are done, choose the OK button to display the Backup Status dialog 
box and start the backup process. 
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Checking the Backup Status 
The Backup Status dialog box contains an active status area; the names of the 
drive, directory, and file(s) that are being backed up; and a Summary section 
showing a log of major operations. You can also choose to stop the backup 
operation. If a large backup operation reaches the end of a tape before finishing, 
the Insert New Tape dialog box prompts you to insert a new tape. A collection 
of related tapes containing several backup sets is called a family set. 

t> To display the Backup Status dialog box and start backing up 

• In the Backup Information dialog box, choose the OK button. 

:=>1 ",--
ih'WiJSiiF ;H~iHH~: -_,tIt -- -; :: 

Directories: 19 Elapsed time: 00:18 
Files: 117 Corrupt files: 0 

Bytes: 2.766.910 Skipped files: 0 
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I 
LJ \mspub 
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Summary 
Backup set U5 on tape Ul .:!. 
Backup description: MSPUB Directory 
Backup started on 2/11/93 at 10:24:23 AM. 
Backup completed on 2111/93 at 10:24:42 AM. 
Backed up 117 files in 19 directories. 
Processed 2.766.910 bytes in 19 seconds. ......, 

The operation was successfully completed. 7 
I ttfKi I I /1bmt I I Help I 

The status area at the top of the box shows the following information: 

• Directories, files, and bytes processed 

• Elapsed time in hours, minutes, and seconds 

• Number of corrupt or skipped files (that is, files that are unable to be copied 
because of both read errors and open/locked files) 

Additional information provided includes the selected disk drive, directory 
path, and filename, along with a Summary section showing the tape label and 
an event log. 
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Note If the status area shows the existence of any corrupt files, a record of them 
is available in a file called CORRUPT.LST. You should check that file before 
trying to restore the tape and then delete it. If you do not delete it, you will see a 
message about the existence of corrupt files whenever you try to restore from that 
tape or any other tape in your collection. 

If you need to stop a backup job before it is completed, choose the Abort 
'button. The current file will be completed if less than 1 MB remains. Otherwise, 
a message asks whether to continue or stop now and show it as a corrupted file. 
The Summary section then gives the final operation details and shows whether 
or not the operation completed successfully. 

USing Batch Files to Do Backups 
You can create a command-line batch file to back up one or more drives on a 
regular basis. The parameters included in this batch command give you most of 
the same functionality that is provided in the graphical user interface. 

NTBackup [operation pathnames [options]] 

where 

operation 

Backup 

pathnames 

{A: B: C: ... Z: }[\directory\ ... ] * 

options 

{Mode Verify Restrict_Access Description Backup_Local_Registry 
Backup_Type Log_Options} 

where. 

Mode = I A[ppend] 

Verify = IV[ erify ] 

Restrict_Access = IR[ estrict] 

Description = ID[ escription] "text" 

Backup_Local_Registry = IB 
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Backup_Type = IT[ype] {Normal Copy Incremental Differential Daily} 

Log_Options = [Log_filename] [Log_exceptions _ only] 

where 

Log_filename = IL[ ogfile] "filename" 

Log_exceptions _only = IE[xceptions] 

When the Append option is not specified, the program reuses the tape and 
replaces previous data. Specifying Append causes backup sets to be added after 
the last backup set on the tape. When more than one drive is specified and the 
Append option is not, the program overwrites the contents of the tape with the 
information from the first drive selected and then appends the backup sets for 
the remaining drives. 

The following are two examples that show how to implement this command. 
Notice that a path name may also include wildcards (* and ?) to specify only 
certain files in a directory. For example, to back up all the batch files in the 
directory called C:\MYDIR, type: 

NTBackup Backup C:\MYDIR\*.BAT 

To do a normal backup of drives C, D, and E; restrict access to the owner or 
administrator; apply the description "Full Backup of drives C, D, and E" to all 
three backup sets; perform a verification pass upon completion of the backup; and 
record the results of the session in the log file named C:\LOG\LOG.TXT, type: 

NTBackup Backup C: D: E: IV IR ID "Full Backup of drives C, D, and E" IL 
"C:\LOG\LOG.TXT" 

To do a normal Copy-type backup of the files in C:\EXCEL and not restrict 
access, use the description "Copy of Excel Directory," perform a verification pass 
upon completion of the backup; and record the results of the session in the log file 
named C:\LOG.TXT, type: 

NTBackup Backup C:\EXCEL IT COpy IV IR ID "Copy of Excel Directory" 
IL "C:\LOG.TXT" 
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Restoring Tape Files to Disk 
Backed-up information is useless if it cannot be restored. Windows NT provides 
a Restore command to give access to tapes, backup sets, and files for restoring 
as they are needed. 

Restoration policies for everyday maintenance, as well as disaster recovery, 
are just as important as backup policies. Practice ahead of time on spare drives, 
though, so you do not risk real data. You should also periodically do trial 
restorations to check whether or not files have been backed up properly. These 
verification restores can check for possible hardware problems that do not show 
up with the software or whose symptoms are not easily recognized. For that 
reason, you should also keep a backup status log and check it regularly for error 
messages. 

When restoring a large number of files, you will need to consider what backup 
type you used. If you did differential or incremental backups, you will first need 
to restore the selected files from the most recent normal backup, then files from 
all subsequent incremental backups of those files, and finally the most recent 
differential backup performed after the last incremental backup . 

. For tape-management purposes, each tape has the following information 
associated with it: 

• A user-specified tape name 

• An original tape-creation date plus the date and time that each backup set 
was created 

• The computer name and the username of the user who created the tape 

• A tape-sequence number in the case of tape sets 

Choosing What You Want to Restore 
You can choose to restore either the current tape, one or more backup sets, 
or individual files. Open the Tapes window and make your selections the same 
way you would in File Manager and for backing up. 

All catalog information is maintained on the corresponding tape for that backup 
set. Family sets have the information on the last tape. 
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The tape name appears in the left panel of the Tapes window to the right of each 
tape icon. The following information is shown in the right panel of the Tapes 
window: 

• Drive backed up 

• Backup set number 

• Tape number, and what number it is in a set of tapes 

• Backup type 

• Date and time of backup 

• Backup description 

When you insert a tape to be restored, only information on the first backup set 
appears in the right panel. If you want to restore the entire tape, you need to load 
the tape's catalog to display a list of any other backup sets. If you want to know 
which files are in each backup set, you need to load the individual catalogs for 
each backup set. 

t> To load a catalog of the backup sets on a tape 

1. In the Tapes window, select the tape whose catalog you want to load. 

2. Double-click that tape's icon. Or, from the Operations menu, choose Catalog. 
Or choose the Catalog button on the toolbar. 

The Catalog Status dialog box appears and provides the option of stopping 
the cataloging process. 

After searching the tape, a complete list of backup sets appears in the Tapes 
window, with question marks displayed in each of their icons to show that 
their individual catalogs have not been loaded. 

t> To load a catalog'for an individual backup set 

1. In the Tapes window, select the backup set whose catalog you want to load. 

2. Double-click that backup set's icon. Or, from the Operations menu, choose 
Catalog. Or choose the Catalog button on the toolbar. 

The Catalog Status dialog box appears and provides the option of stopping 
the cataloging process. 

After searching the tape, a complete list of the directories and files in the 
backup set appears in a Tape File Selection window. The list in the Tapes 
window now appears with a plus sign in the backup set's icon to show that 
it has been cataloged. Corrupt files (that is, files that contain errors) and 
their corresponding directories are marked by an icon with a red X. 
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The procedures for selecting files to restore are similar to those for selecting files 
to back up. Notice, however, that when you load a tape, only the first backup set 
on the tape is displayed until you load the tape's catalog. Therefore, when you 
select an entire tape, you are really only selecting those sets that are already 
displayed, and so you must load the tape's catalog first to get the complete list 
of backup sets. See online Help for detailed procedures. 

Building Partial Tape and Backup Set Catalogs 
If a backup operation spans several tapes and you choose to restore a single 
backup set, you are prompted to insert the last tape to load the tape catalog 
information and get a complete list of all the backup sets and their locations. 
However, if the last tape in such a family set is missing or damaged, you must 
build a partial tape catalog by inserting the available tapes and loading each tape's 
catalog of backup sets. If the backup set that you want spans several tapes and you 
are looking for a specific directory, you must then load each backup set's catalog 
of directories and files. 

Sometimes, you will want to restore from a tape with files that were not backed 
up with the Windows NT Backup program. If the tape has the Microsoft/Connor 
Software tape format (MTF), Windows NT Backup can read it. However, the tape 
mayor may not have the full on-tape catalog (OTC) information that Windows 
NT Backup produces. Also, some older tape backup devices may not support 
creating full on-tape catalogs with the Windows NT Backup program. 

~ To build a catalog from a tape without a full on-tape catalog 

1. Insert the MTF-compatible tape in the tape backup device. 

2. Load whatever on-tape catalog information is available. 

The Catalog Status dialog box appears and provides the option of stopping the 
cataloging process. 

• If there is no catalog information, the entire tape is scanned to determine all 
the backup sets and then scanned again slowly to determine the contents of 
each backup set. 

• If there is partial information on the backup sets, that information is 
accessed quickly and then the entire tape is scanned slowly to determine 
the contents of each backup set. 
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Setting the Restore Options 
After selecting one or more tapes, backup sets, or files to restore, choose the 
Restore command from the Operations menu to open the Restore Information 
dialog box. The first section provides information about the backup set(s) on the 
loaded tape and tells you how many other tapes are in that family set. For each 
backup set, you must specify the drive to which you want the information 
restored. 

You can also specify an alternate directory path to place a backup set's files into a 
different directory instead of into the original one on the default drive. This might 
be done to compare them to the files on the disk. You can use the Browse button 
at the end of the Alternate Path box to help you find the correct path name. 

If you want to verify the contents of the files restored onto disk against the files 
on tape and then log any exceptions, select the Verify Mter Restore check box. 
When you select the Restore File Permissions check box, the system restores 
the permissions information along with the file. Otherwise, the files inherit the 
permissions information of the directory into which they are restored. When you 
want to restore the Registry files, select the Restore Local Registry check box. 
However, you will need to restart the computer for the restored information to 
take effect. 

When you restore files that were backed up from an NTFS volume to an NTFS 
volume, you can restore the original file-access permissions as well. You should 
do so only if you are restoring files to the computer from which they were 
originally backed up and want the original file-access controls to be in effect. 
Do not restore file permissions if you are using the backup tape to transfer files 
to another computer or if you are restoring files to a computer that has not been 
completely restored following the corruption of the operating system. Because 
file permissions include the unique identifier of the computer on which the files 
are stored, they are valid only on the original computer. 
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Backup Set Information (1 of 1 sets) 

Tape Name: Directory Backups from 2111193 

Backup Set: MSPUB Directory 

Creation Date: 2/11/93 10:05:25 AM 

Owner: pegetl \Administrator 

Restore to .!2rive: Ic: [PEGETl] l:il 
~================~ Alternate ~ath: 1:=:1 

[g] :'{erify After Restore D Restore file Permissions 

D Restore local Re,gistry 

log Information----------------------, 

.log File: Ic: \nt\RESTORE.lOG 

@::tij:!i:::~:~I~m 0 .s.~mmary Onl1' 0 DQn't log 

Setting the Log Options 
In the bottom section of the Restore Information dialog box, you can choose 
not to log information or you can choose to create a log that contains either a 
summary of major operations or full details on all operations. If you choose to 
create a log, you can type the name of the text file into which the information on 
completed tape operations will be logged. You can also use the Browse button at 
the end of the Log File box to help you locate the correct filename for the log. 

The following are descriptions of the three logging options. 

Choose 

Full Detail 

Summary Only 

Don't Log 

To 

Log all operations information including the names of all the 
files and directories that are restored. 

Log only the major operations such as loading a tape, starting 
the restore process, and failing to create a file. 

Log no information. 

When you are done, choose the OK button to display the Restore Status dialog 
box and start the restore process. 
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Checking the Restore Status 
The Restore Status dialog box contains an active status area; the names of the 
drive, directory, and files that are being restored; and a Summary section showing 
a log of major operations. You can also choose to stop the restore operation. If a 
file being restored already exists on disk and is newer than the one on the tape, 
the Confirm File Replace dialog box will prompt you to confirm whether or not 
to restore the file from the tape. If the restore operation reaches the end of a tape 
before finishing the restoration of a backup set or file, the Insert New Tape dialog 
box will prompt you to insert a new tape. 

t> To display the Restore Status dialog box and start restoring 

• In the Restore Information dialog box, choose the OK button. 

The status area at the top of the box shows the same types of information as in the 
Backup Status dialog box. 

If you need to stop a restore job before it is completed, choose the Abort button. 
The current file will be completed if less than 1 MB remains. Otherwise, a 
message asks whether to continue or stop now. The Summary section then gives 
the final operation details and shows whether or not the operation completed 
successfull y. 
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Maintaining Tapes 
~ The Windows NT Backup program provides three commands under the 

Operations menu to help you maintain your backup tapes. The Erase Tape 
command causes the whole tape to be erased. A warning message in the Erase 
Tape dialog box advises you that all the information on the tape will be destroyed. 
It also gives you the name of the tape and when it was created. 

You can do either a Quick Erase, during which the tape header is simply 
rewritten, or a Secure Erase, during which the entire tape is overwritten. The 
secure-erase method may take several hours to complete, depending on the drive 
technology and tape length. You should categorize the information on the backup 
tapes by which method of erasing to use, and then create and maintain a list for 
easy reference. 

The Retension Tape command eliminates loose spots on the tape by fast 
forwarding to the end of the tape and then rewinding. This procedure winds the 
tape evenly so it will run more smoothly past the tape drive heads. 

To reduce tape slippage, manufacturers of tape backup drives recommend 
that you retension .25-inch tape once every 20 uses. 4 mm and 8 mm tapes do 
not require retensioning, and so the command is unavailable. How much time it 
takes to forward and rewind the media depends on the device technology. 
See the manufacturer's documentation for specific retensioning requirements. 

The Format Tape command formats an unformatted mini-cartridge tape. This type 
of tape is treated like a floppy disk and must be formatted before it can be used. If 
you do not have a mini-cartridge drive installed and activated, this command is 
unavailable. 
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Event Viewer 

In Windows NT, an event is any significant occurrence in the system or in an 
application that requires users to be notified. For some critical events such as a 
full server or an interrupted power supply, you may see a message on screen. 
For many other events that do not require immediate attention, Windows NT 
adds information to an event log file to provide information without disturbing 
your usual work. This event logging service starts automatically each time you 
start Windows NT. 

401 

You can use Event Viewer to view and manage event logs for your system. You 
can also save event logs to view later or to generate reports about your system. 
This chapter describes how to use Event Viewer, with the following topics: 

• An overview of Event Viewer 

• Viewing event logs 

• Setting options for logging events 

• Viewing specific logged events 

• Using archived log files 
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Overview 
Event Viewer is the tool you can use to monitorvariouskinds of events in your 
system, which are recorded in event logs. Windows NT records events in three 
kinds of logs: 

• The system log records events logged by the Windows NT system 
components. For example, the failure of a driver or other system component 
to load during startup is recorded in the system log. 

• The application log records events logged by applications. For example, 
a database program might record a file error in the application log. 

• The security log records security events. This helps track changes to the 
security system and identify any possible breaches to security. For example, 
attempts to log on to the system may be recorded in the security log, 
depending on the Audit settings in User Manager. 

To control the types of security events that are audited, choose the Audit 
command from the Policies menu in User Manager. For more information, 
see "Managing the Audit Policy" in Chapter 13, "User Manager." 

To control the auditing of file and directory access, choose the Auditing 
command from the Security menu in File Manager. For more information, 
see "Auditing Files and Directories" in Chapter 4, "File Manager." 

Mter you select a log for display in Event Viewer, you can view, sort, filter, and 
search for details about events. You can also archive logs in various file formats. 

Event Viewer displays events from a single log. Each line in the log shows 
information about one event, including date, time, source, event type, category, 
Event ID, user account, and computer name . 

.... 

;~ht£i~:'ii~t31}l;nr 
04/2/93 11:54:53 AM Service Control Manager None 7001 N/A SCOTTIE 
0412193 11:54:53 AM Service Control Manager None 7002 N/A SCOTTIE 
04/2/93 11:54:53AM NetDDE None 13 N/A SCOTTIE 
04/2/93 11:54:53 AM Service Control Manager None 7002 N/A SCOTTIE 
04/2/93 11:54:53 AM NetDDE None 204 N/A SCOTTIE 
04/2/93 11:54:51 AM Service Control Manager None 7002 N/A SCOTTIE 
04/2/93 11:54:51 AM Service Control Manager None 7002 N/A SCOTTIE 
04/2/93 11:54:51 AM Service Control Manager None 7000 N/A SCOTTIE 
04/2/93 11:54:51 AM Elnkii None 5003 N/A SCOTTIE 
64/2/93 11:54:51 AM EventLog None 6005 N/A SCOTTIE 
64/2/93 11:53:41 AM EventLog None 6006 N/A SCOTTIE 
004/2/93 11:19:41 AM EventLog None 6005 N/A SCOTTIE 
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The terms in the following table describe items in the Event Viewer window. 

Item 

Source 

Category 

Event 

User 

Computer 

Meaning 

The software that logged the event, which can be either an 
application name, such as "SQL Server," or a component of 
the system or of a large application, such as a driver name. 
For example, "Elnkii" indicates the EtherLink II driver. 

A classification of the event by the event source. For example, 
the security categories include Logon and Logoff, Policy 
Change, Privilege Use, System Event, Object Access, Detailed 
Tracking, and Account Management. 

A unique number for each source to identify the event. The 
Event ID can also be used by product support representatives 
to track what event occurred in the system . 

. The user name for the user who was logged on and working 
when the event occurred. "N/ A" indicates that the entry did not 
specify a user. 

The computer name for the computer where the event occurred. 

The icon on the left side of the Event Viewer screen describes the classification 
of the event by Windows NT such as Error, Warning, Information, Success Audit, 
and Failure Audit. 

Icon Event Type Meaning 

~ Error Significant problems, such as a loss of data or loss of functions. 
For example, an Error event might be logged if a service was not 
loaded during Windows NT startup. 

CD Warning Events that are not necessarily significant but that indicate 
possible future problems. For example, a Warning event might 
be logged when disk space is low. 

o Information Infrequent significant events that describe successful operations 
of major server services. For example, when a database program 
loads successfully, it may log an Information event. 

ffi Success Audit Audited security access attempts that were successful. For 
example, a user's successful attempt to log on to the system 
might be logged as a Success Audit event. 

~ Failure Audit Audited security access attempts that failed. For example, if a 
user tried to access a network drive and failed, the attempt might 
be logged as a Failure Audit event. 
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Starting and Quitting Event Viewer 
You start and quit Event Viewe{ in the same way as any application in 
Program Manager. 

t> To start Event Viewer 

l:r11 • In the Administrative Tools group in Program Manager, choose the 
:!:: Event Viewer icon. 

t> To quit Event Viewer 

• From the Log menu, choose Exit. 

Viewing Event Logs 
You determine the log and computer selected for viewing in Event Viewer, 
and you can refresh the view, as described in the sections that follow. 

Selecting a Log for Event Viewing 
By default, the system log on the local computer is displayed the first time you 
start Event Viewer. You can also view the security and application logs. 

I> To select another log for viewing 

• From the Log menu, choose System, Security, or Application. 

Event Viewer shows the events recorded in that log. The corresponding 
command name is checked on the Log menu, and the log name appears on 
the title bar. 

To view the content of a security log, you must be logged on as a member of 
the Administrators group. 

Selecting a Computer for Event Viewing 
When you first start Event Viewer, the events for the local computer are 
displayed. 

If you want to view events for another computer, choose Select Computer from 
the Log menu. If the computer you select is across a link with slow transmission 
rates, select the Low Speed Connection box. If this box is selected, Windows NT 
does not list all the computers in the default domain, thereby minimizing network 
traffic across the link. (If slow transmission rates are commonplace, choose Low 
Speed Connection from the Event Viewer Options menu.) 
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t> To select another computer in Event Viewer 

1. From the Log menu, choose Select Computer. 

2. In the Computer box, type the computer name of the computer to view. 
Or select a computer name in the Select Computer box. 

3. Choose the OK button. 

Refreshing the View 
When you first open a log, Event Viewer displays the current information for that 
log. Unless you choose the Refresh command to refresh the view, this information 
is not updated. That is, any new events that occur while viewing the log are not 
added to the list, and overwritten entries are not removed from the list. The event 
listing is updated automatically only when you select a different log for viewing 
or when you start Event Viewer again. 

t> To update the events currently shown in Event Viewer 

• From the View menu, choose Refresh. Or press F5. 

If you are viewing an archived log, the Refresh command is not available because 
archived files are never updated. 

Setting Options for Logging Events 
You can use the Log Settings command from the Log menu to define parameters 
for logging events in each kind of log, including the maximum size for the log and 
whether the events are overwritten or stored for a certain period of time. 

For the security log, the administrator can also set auditing policies in User 
Manager that cause the system to halt when the security log is full. 

t> To set event logging options 

1. From the Log menu, choose Log Settings. 

Maximum log Size: L-15_12_---"rB_"" Kilobytes (64K Increments) 

Event log Wrapping 

o Overwrite E vents as N.eeded 

@OverwriteEvents!!Jderthan r-17--'-1f)=: Days 

o Q.o Not Overwrite Events (Clear log Manually) 
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2. In the Change Settings For box, select the kind of log for which you want 
to specify settings. 

3. In the Maximum Log Size box, specify the size of the log in kilobytes. 

For example, type 640 for a maximum log size of 640 kilobytes. The default 
setting is 512. The size must be an increment of 64K. 

4. Select an Event Log Wrapping option to define how the events are retained 
in the log selected in the Change Settings For box. The options include the 
following. 

Use 

Overwrite Events As 
Needed 

Overwrite Events Older 
Than [ ] days 

Do Not Overwrite 
Events 

To 

Have new events continue to be written when the log is full. 
Each new event will replace the oldest event in the log. 

Retain the log for the number of days you specify before 
overwriting events. The default setting for this option is 
seven days. This is the best choice if you want to archive 
log files weekly. 

Clear the log manually rather than automatically. Select 
this option only if you cannot afford to miss an event­
for example, for the security log at a site where security 
is extremely important. 

5. If you want to restore all default settings, choose the Default button. 

6. Choose the OK button. 

Note When a log is full (no more events can be logged), you can free the log by 
clearing it. Reducing the amount of time you keep an event also frees the log if it 
allows the next record to be overwritten. 

If you specify that events cannot be overwritten in a log, you must clear the log 
periodically - either when the log reaches a certain size or when a message 
notifies you that the log is full. Archived logs cannot be cleared. 

t> To clear a log 

1. Switch to the log whose events you want to clear. 

2. From the Log menu, choose Clear All Events. 

A message asks if you want to archive the currently logged events. If you 
answer Yes, the Save As dialog box appears. For more information about this 
dialog box, see "Archiving a Log," later in this chapter. 

Mter you answer Yes or No, Event Viewer empties the current log. All new 
events· are recorded in the log. 



Chapter 15 Event Viewer 407 

Viewing Specific Logged Events 
After you select a log to view in Event Viewer, you can: 

• Sort events from old to new or from new to old. 

• Filter events so that only events with specific characteristics are displayed. 

• Search for events based on specific characteristics or event descriptions. 

• View descriptions and additional details that the event source might log. 

These subjects are covered in detail in the following sections. 

Sorting Events 
The events displayed in Event Viewer are listed in sequence by date and time 
of occurrence. You can specify the order as newest events first or oldest first. 
The default listing order is from newest to oldest. 

When a log is archived, the sort order affects the order in which event records are 
archived in a text format or comma-delimited text format file, but sort order does 
not affect the order of event records in a log archived in log file format. For more 
information, see "Using Archived Log Files," later in this chapter. If the Save 
Settings On Exit command from the Options menu is checked when you quit, 
the current sort order is used the next time you start Event Viewer. 

t> To specify sort order 

• From the View menu, choose Newest First or Oldest First. 

The command currently in effect is checked on the menu. 

Filtering Events 
When you first start Event Viewer, all events recorded in the selected log are 
displayed automatically. You can choose Filter Events from the View menu if you 
want to view only events with specified characteristics. Filtering has no effect on 
the event log whatsoever; all events are logged all the time, whether the filter is 
active or not. The filter affects only what is displayed, and you can see all the 
logged events any time you want by turning off the event filter. 

Your choices for filtering are used throughout the current Event Viewer session, 
unless you decide to change them. If Save Settings On Exit from the Options . 
menu is checked when you quit Event Viewer, your choices for filtering remain 
in effect the next time you start Event Viewer. When filtering is on, a check mark 
appears by the Filter command on the View menu and "(Filtered)" appears on the 
title bar. 
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~ To filter events 

1. From the View menu, choose Filter Events. 

o EyentsQn: 

9 nBJ92;i 

I 2:11 :09 AM/tJ 

Types 

[g] Information 

[g] ~arning 

[g] Error 

Sou!ce: I (All) 

Ca!egory: I (All) 

.!J.ser: I 
Co!!!puter: I 
El!ent 10: I 

'View Through­

@ last Eyent 

o Eyents On: 

9 nBJ92~ If;iK.cidiiiT 
I 10: 4B : 53 AM fit 

[g] ~uccess Audit 

[g] Failure Audit 

2. In the Filter dialog box, specify the characteristics that qualify an event 
for display in Event Viewer. 

The following table describes the options in the Filter dialog box. Entries 
in the Filter dialog box are not case sensitive. 

3. Choose the OK button to view the filtered events. 

~ To return to the default criteria 

• In the Filter dialog box, choose the Clear button. 

~ To turn off filtering of events 

• From the View menu, choose All Events. 
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The following table describes the options available in the Filter dialog box. 

Use 

View From 

View Through 

Information 

Warning 

Error 

Success Audit 

Failure Audit 

Source 

Category 

User 

Computer 

Event ID 

To filter for 

Events after a specific date and time. By default, this is the 
date of the first event in the log file. 

Events up to and including a specific date and time. By default, 
this is the date of the last event in the log file. 

Infrequent significant events that describe successfui operations 
of major server services. For example, when a database 
program loads successfully, it may log an Information event. 

Events that are not necessarily significant but that indicate 
possible future problems. For example, a Warning event might 
be logged when disk space is low. 

Significant problems, such as a loss of data or loss of functions. 
For example, an Error event might be logged if a service was 
not loaded during Windows NT startup. 

Audited security access attempts that were successful. For 
example, a user's successful attempt to log on to the system 
might be logged as a Success Audit event. 

Audited security access attempts that failed. For example, 
if a user tried to access a network drive and failed, the attempt 
might be logged as a Failure Audit event. 

A source for logging events, such as an application, a system 
component, or a driver. 

A classification of events defined by the source. For example, 
the security event categories are Logon and Logoff, Policy 
Change, Privilege Use, System Event, Object Access, Detailed 
Tracking, and Account Management. 

A specific user that matches an actual user name. This field 
is not case sensitive. 

A specific computer that matches an actual computer name. 
This field is not case sensitive. 

A specific number that corresponds to an actual event. 
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Searching for Events 
Searching for events can b~ useful when you are viewing large logs. You can 
search for each event that matches the type, source, or category that you want by 
choosing Find from the View menu. For example, you can search for all Warning· 
events related to a specific application. Or search for all Error events from all 
sources. 

Your choices in the Find dialog box are in effectthroughout the current session. 
The default settings are restored the next time you start Event Viewer, if Save 
Settings On Exit is selected on the Event Viewer Options menu. 

t> To search for specific kinds of events in a log 

1. From the View menu, choose Find. 

2. In the Find dialog box, select any of the Types of events you want to find. 

3. Specify any other Source, Category, Event ID, Computer, and User events 
you want to find, as described in "Filtering Events," earlier in this chapter. 

4. In the Description box, type text that matches any portion of an event record 
description. 

Because you can search for any portion of an event record description, 
the complete description is not required. 

5. To specify the direction of the search, select the Up or Down option button. 

The search direction is independent of the sort order checked on the 
View menu. 

6. Choose Find Next to begin the search. 

t> To find the next matching event 

• Press F3 to continue searching without displaying the Find dialog box again. 

t> To restore the default search criteria 

• In the Find dialog box, choose the Clear button. 
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Viewing Details About Events 
For many events, you can view more information than is displayed in Event 
Viewer by choosing Detail from the View menu. 

The Event Detail dialog box shows a text description of the selected event and 
any available binary data for the selected event. This information is generated 
by the application that was the source of the event record. Because the data 
appears in hexadecimal format, its meaning can only be interpreted by a support 
technician familiar with the source application. Not all events generate such data. 

The event data is saved if you archive a log in log file format, but is discarded 
if you archive it in text or comma-delimited text format. The event description 
is saved in all archived logs. 

l> To view more details about an event 

1. In Event Viewer, double-click the event you want to view details about. 
Or select an event in the list, and then choose Detail from the View menu. 

Date: 9/28/92 
Time: 10:48:53AM 
!J.ser: N/A 
Computer: anam·1 

Qescription: 

E Inkii02 : Could not find an adapter. 

Data: @ !!,vtes 0 Words - -
0000: 00 00 00 00 02 00 
0008: 00 00 00 00 8b 13 
0010: 00 00 00 00 00 00 
0018: 00 00 00 00 00 00 
0020: 00 00 00 00 00 00 

+1 J 

r Close IPrevious I 

Event ID: 5003 
Source: E Inkii 
Type: Error 
Category: None 

4e 00 ...... N. 
00 cO .... 1 .. 1 
00 00 ........ 
00 00 ........ 
00 00 ........ 

~ 
f--

f---, 
+ 

L+ 

2. In the Description or Data box, use the scroll box to browse the information 
about the event. 

3. To view details about other events in sort-order sequence, choose the Next 
or Previous button. 

4. When you finish viewing details, choose the Close button to return to 
Event Viewer. 



412 System Guide 

Using Archived Log Files 
You can archive an event log in log file format so that you can later reopen it 
in Event Viewer. Or the log can be saved in text format or comma-delimited text 
format so that you can use the archived information in other applications. 

These subjects are covered in more detail in the sections that follow: 

• Saving a log as an archived file 

• Viewing a log archived in log file format 

• Using log files saved in text format or comma-delimited text format 

For example, you might choose to archive security logs so that you can monitor 
security events over a period of time. Or you might archive application logs so 
that you can track the Warning and Error events that occur for specific 
applications. 

When you archive a log file, the entire log is saved, regardless of any filtering 
options you specified in Event Viewer. If you changed the sort order in Event 
Viewer, the event records are saved exactly as displayed if you archive the log 
in a text or comma-delimited text file. 

An archived log contains all events that were current when the file was saved, 
so the archived file might contain new events or might not contain events 
overwritten after you first displayed the log in Event Viewer. 

Archiving a Log 
When you archive an event log, you can save the log in one of three file formats: 

• Log file format, which you should choose if you want to view the archived 
log again in Event Viewer. 

• Text file format, for using the information in an application such as a word 
processor. 

• Comma-delimited text file format, for using the information in an application 
such as a spreadsheet or a flat-file database. 
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I> To ~rchive an event log 

1. From the Log menu, choose Save As. 

2. In the File Name box, type a filename for the archived log file. 

Event Viewer adds the .EVT filename extension for log files, or the .TXT 
extension for either kind of text format file. 

3. In the Save File As Type box, select a file format option for saving the 
log information, and then choose the OK button. 

Archiving a log has no effect on the current contents of the active log. To 
clear the original log, you must choose Clear All Events from the Log menu. 
To remove an archived log file, delete the file in the same way that you delete 
other kinds of files. 

Viewing a Log Archived in Log File Format 
You can view an archived file in Event Viewer only if the log was saved in log 
file format. You cannot choose the Refresh or Clear All Events commands to 
update the display or to clear an archived log. To remove an archived log file, 
you must delete the file in File Manager. 

I> To display an archived log in Event Viewer 

1. From the Log menu, choose Open. 

2. In the File Name list, select the filename of the log you want to view, 
and then choose the OK button. 

3. In the Open File Type dialog box, select the kind of log you saved originally 
-System, Security, or Application. Then choose the OK button. 

Note If you do not specify the correct log type, the Description displayed 
for the archived log in the Event Detail dialog box will not be correct. 
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Using Logs Archived in a Text Format 
If you save an event log in text or comma-delimited text format, you can open that 
file in other applications. Those other applications can be used to filter, sort, and 
format the archived event records. Or you might combine event records from two 
or more archived text files to create reports. 

If an archived log is saved in text or comma-delimited text format, the binary data 
for each event record is discarded. The sequence of data in an event record saved 
in either text format is the following: 

1. Date1 4. Type 7. User 

2. Time 5. Category 8. Computer 

3. Source 6. Event 9. Description 

1 Depends on the sort order specified in the View menu. 

For example, you might copy lines of text from an archived log to include 
as supporting information in an electronic mail message. As another example, 
you might archive a security log in comma-delimited format so you can place 
the information in a spreadsheet and produce a chart depicting the archived 
information. 
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CHAPTER 16 

Disk Administrator 

Disk Administrator is a graphical tool for managing disk resources. This tool 
encompasses and extends the functionality of character-based disk management 
programs such as MS-DOS Fdisk. 

This chapter provides information on using Disk Administrator to set up and 
organize your hard disks to function more efficiently. The following main topics 
are included: 

• Partitioning disks 

• Creating and deleting volume sets 

• Extending volumes and volume sets 

• Creating and deleting stripe sets 
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Overview 
Partitioning the internal hard disk on a new computer is done during initial setup 
when you load the Windows NT operating software. Making changes to that disk 
or partitioning an additional new hard disk is done using the Disk Administrator 
program. Disk Administrator is located in the Administrative Tools group in 
Program Manager. 

The following list provides an overview of some of the things you can do with 
this graphical tool: 

• Create and delete partitions on a hard disk and logical drives within an 
extended partition. 

• Read status information about disks such as the partition sizes and the amount 
of unformatted free space that is available for creating additional partitions. 

• Read status information about Windows NT volumes such as the drive-letter 
assignment, volume label, file system type, and size. 

• Make and change drive-letter assignments. 

• Create and delete volume sets. 

• Extend volumes and volume sets. 

• Create and delete stripe sets without parity. 

Starting and Quitting Disk Administrator 
You can only open Disk Administrator if you are logged on as a member 
of the Administrators group. Double-click the Disk Administrator icon in the 
Administrative Tools group to display a scrollable graphical representation of 
all the physical disks connected to your workstation along with their partitions. 
(You can also type windisk or start win disk at the command prompt.) 

A status bar at the bottom of the window provides basic information on partitions. 
A color-coded legend on top of the status bar shows what the different partition 
colors and patterns represent. Both context-sensitive and standard Help are 
provided for all Disk Administrator commands. 
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To quit Disk Administrator, you can choose either Exit from the Partition menu 
or Close from the Control menu. If you have requested any significant changes 
to your disk partitions or drive-letter assignments, Disk Administrator displays 
a message to remind you about the irreversibility of certain changes, such as 
deleting a partition, and to ask whether or not you want to save those changes. 
Disk Administrator only performs updates to the disks after you agree to saving 
those changes and quit the program. If you decide 110t to save the changes, choose 
the No button and Disk Administrator will close without making any changes. 
If you decide not to quit and want to continue using Disk Administrator, choose 
the Cancel button. 

If you make changes and commit to them upon quitting, Disk Administrator 
makes the requested changes and displays a message when the disks have been 
successfully updated. Mter you choose the OK button, another message advises 
you that changes have been made that require you to restart the computer. When 
you choose the OK button, Disk Administrator initiates a complete system 
shutdown, closes all open applications, and restarts the computer for you. 
Restarting makes the new volumes accessible. You can then format and label 
your volumes. 
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Organizing Your Screen 
From the Options menu, you can choose whether or not to display the status 
bar and legend, customize the colors and patterns used in the legend and disk 
displays, and change how the disk regions are displayed. See online Help for 
detailed procedures. 

When you select an area of free space, notice that Disk Administrator makes a 
distinction in the status bar between free space on the disk and free space in an 
extended partition. You can also see the distinction graphically in the way Disk 
Administrator uses forward slanting lines to fill free space on the disk and 
backward slanting lines to fill free space in an extended partition. 

You can change the colors and patterns that are used on the screen to distinguish 
between the following items: primary partition, logical drive, stripe set, mirror 
set, and volume set. 

Since you may have several disks with a wide range of capacities, you can 
change the relative display size of partitions. Disk regions are shown as being 
proportionate to each other within a single disk bar. You can choose either to 
display the regions on each disk based on their relative size, size all the regions 
equally, or let Disk Administrator decide how to size the regions. You can do this 
differently for each disk or choose the Reset All button to let Disk Administrator 
decide how to display all the disks connected to your system. 

Note The total lengths of the bars used to represent disks are generally 
proportional to the size of the disk. However, the total length of a single disk 
bar is never less than 25 percent of the total length of the largest disk bar. 

Managing Disks 
Windows NT Disk Administrator provides a simple, graphical way for you to 
enhance your system's performance and to manage your disks by creating and 
deleting all the partitions you may need to run your system effectively. 

If you use only the Windows NT operating system, you can create one partition 
that occupies your entire disk or as many as four partitions. If you want to use 
other operating systems on your hard disk (such as UNIX or MS-DOS) with file 
systems that are not recognized by Windows NT, you must create separate 
partitions for each non-Microsoft operating system. Notice, though, that MS-DOS 
and Windows NT can share the same partition when using the File Allocation 
Table (FAT) file system. 
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On an x86-based computer, the operating system starts from the active system 
partition on the first internal hard disk (that is, Disk 0). Computers using reduced 
instruction set computing (RISC) processors can have several system partitions 
that are configurable by the manufacturer's configuration program. Such 
partitions must be formatted for the FAT file system. Consult your hardware 
documentation for detailed information on setting up more than one system 
partition on a RISC-based computer. 

When you partition a disk, you specify which portion of the disk a file system 
can use. When you format a partition, Windows NT prepares an existing partition 
with a drive letter to use a specific file system. After you partition a disk and save 
the changes, Disk Administrator restarts the computer for you to make those new 
volumes accessible. You must then go to the Windows NT command prompt and 
format each new partition. To do this, use the Format command and the 
appropriate switch for the file system that you will use on that partition. For 
more information on formatting partitions under Windows NT, see "Formatting 
and Labeling Partitions," later in this chapter, and online Help for the Format 
command. 

Partitioning Disks 
Disk management under Windows NT is very flexible. You can create up to four 
partitions in the free space on a physical hard disk, create multiple logical drives 
in the free space of an extended partition, and delete partitions. You can also add 
hard disks to your system configuration, recover disk configuration information, 
and assign specific drive letters to each primary partition or logical drive. 

Setting Up a New Hard Disk 
You can create any of the following in the free space on a hard disk: 

• A single primary partition 

• Additional partitions up to the maximum of four 

• An extended partition with a number of logical drives that is limited only 
by the size of the partition 

• Other types of Windows NT volumes, such as volume sets and stripe sets 

Free space is an unused and unformatted portion of a hard disk that can be 
partitioned or subpartitioned. Free space within an extended partition is available 
for the creation of logical drives. Free space that is not within an extended 
partition is available for the creation of a partition, with a maximum of four 
partitions allowed. 
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A partition is a portion of a physical disk that functions as though it were a 
physically separate unit. A volume is a partition or collection of partitions that 
have been formatted for use by a file system. A Windows NT volume can be 
assigned a drive letter and used to organize directories and files. 

A partition is usually referred to as either a primary or an extended partition. 
A primary partition is a portion of a physical disk that can be marked for use by 
an operating system. There can be up to four primary partitions (or up to three, 
if there is an extended partition) per physical disk. A primary partition cannot 
be subpartitioned. 

An extended partition is created from free space on a hard disk and can be 
subpartitioned into zero or more logical drives. The free space in an extended 
partition can also be used to create volume sets or other kinds of volumes for fault 
tolerance purposes. Only one of the four partitions allowed per physical disk can 
be an extended partition, and no primary partition needs to be present to create an 
extended partition. Free space in an extended partition is described as such in the 
status bar. 

The following illustration shows examples of different disk-partitioning schemes 
on x86- and RISe-based computers and where certain files might be located. 
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Creating Primary Partitions 
When creating primary partitions, the system assigns space to a partition starting 
from the beginning of the space available. Therefore, in the beginning, there are 
no gaps between partitions. Gaps only happen when you delete a partition later 
on. For example, if you delete the second of three partitions and create a new 
smaller-sized second partition, that will leave a gap of free space between the 
second and third partitions. 
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r> To create a primary partition 

1. Select an area of free space on a disk. 

2. From the Partition menu, choose Create. 

Minimum size for the partition is 

Maximum size for the partition is: 

1 MB 

121 MB 

Create partition of size 16~ f$l MB 

Cancel 

Disk Administrator displays what the minimum and maximum sizes for the 
primary partition can be. 

3. In the Create Primary Partition dialog box, type the size of the primary 
partition that you want to create. 

4. Choose the OK button. 

Creating an Extended Partition 
One of the four partitions that you can create under Windows NT, if disk space 
allows, is an extended partition. You can use the free space in the extended 
partition to create multiple logical drives or use all or part of it when creating 
volume sets or other kinds of volumes for fault-tolerance purposes. 

r> To create an extended partition 

1. Select an area of free space on a disk. 

2. From the Partition menu, choose Create Extended. 

Disk Administrator displays what the minimum and maximum sizes for the 
extended partition can be. 

3. Inthe Create Extended Partition dialog box, type the size of the extended 
partition that you want to create. 

4. Choose the OK button. 
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I> To create logical drives in an extended partition 

1. Select an area of free space in an extended partition. 

2. From the Partition menu, choose Create. 

Disk Administrator displays what the minimum and maximum sizes for 
the logical drive can be. 

3. In the Create Logical Drive dialog box, type the size of the logical drive 
that you ~ant to create. 

4. Choose the OK button. 

Formatting and Labeling Partitions 
Before you can store files and directories on the partitions that you have created, 
you must restart your computer and then format each partition individually for use 
with the file system of the operating system with which you want to work. You 
can also assign descriptive volume labels at this time. 

I> To format a partition and label the volume 

.1. In the Program Manager window, choose the Command Prompt icon. 

2. At the command prompt, type format /? 
Help information is displayed, showing you the complete command syntax 
and the meaning of each switch. Be careful not to reformat a partition that 
already contains information. After typing the appropriate format command, 
you are asked to assign a volume label to the new volume. 

I> To change or delete a volume label 

1. In the Program Manager window, choose the Command Prompt icon. 

2. At the command prompt, type label [drive:] [label] 

If you do not add a volume label name, the system displays the current label, 
the volume serial number, and then asks for a new label. Pressing ENTER 

before supplying a label deletes the current label or leaves the volume without 
a label. 

If you want to change the file system on an existing HPFS or FAT partition to 
the NTFS format, you can use the CONVERT.EXE utility from the command 
prompt. 

If you want to change the file system on an existing NTFS partition, you must 
first back up all the information, reformat the partition, and then restore the files. 
However, if Windows NT is installed on the NTFS partition, you cannot reformat 
the partition from the command prompt nor delete it from within Disk 
Administrator. Instead, you must use the Setup program. 
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~ To reformat an NTFS partition containing Windows NT 

1. Back up the information on the partition. 

2. Start the Windows NT installation procedure. 

3. Choose Express or Custom Installation. 

4. When Windows NT Setup asks you to select the partition on which you would 
like to install, select the NTFS partition and press p to delete the partition. 

5. Either continue from here using the Setup program to recreate and format the 
partition, or quit the Setup program and use the MS-DOS fdisk and format 
commands to complete the process. 

Marking Partitions as Active 
The names commonly used for the partition(s) containing the startup and 
operating system files are the system and boot partitions, respectively. 

The system partition for Windows NT is the volume that has the hardware­
specific files needed to load Windows NT. On x86-based computers, it must be a 
primary partition that has been marked as active for startup purposes and must be 
located on the disk that the computer accesses when starting up the system. There 
can only be one active system partition at a time, which is denoted on the screen 
by an asterisk. If you want to use another operating system, you must first mark 
its system partition as active before restarting the computer. 

Partitions on a RISe-based computer are not marked active. Instead, they are 
configured by a hardware configuration program supplied by the manufacturer. 
On RISC-based computers, the system partition must be formatted for the FAT 
file system. On either type of computer, the system partition can never be part of 
a stripe set or volume set. 

The boot partition for Windows NT is the volume, formatted for either an NTFS, 
FAT, or HPFS file system, that has the Windows NT operating system and its 
support files. The boot partition can be (but does not have to be) the same as the 
system partition. It also cannot be part of a stripe set or volume set. 

~ To mark a partition as active on an x86-based computer 

1. Select the primary partition that contains the startup files for the operating 
system that you want to activate. 

2. From the Partition menu, choose Mark Active. 

A message advises you that the partition has been marked active and that 
the operating system on that partition will be started after you restart your 
computer. 

3. In the Disk Administrator message box, choose the OK button. 

An asterisk appears in the color bar of the active partition. 
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Securing System Partitions 
Since the system partition on a RISC-based computer must be formatted for the 
FAT file system, there is no way to secure information in individual directories 
and files on that partition. Therefore, the only way to secure the system partition 
is to allow access only to members of the Administrators group. 

t> To secure the system partition on a RISC-based computer 

1. From the Partition menu, choose Secure System Partition. 

A message asks you to confirm this request. When the command is in effect, 
a check mark appears next to the command in the Partition menu. 

2. To activate security on the system partition, restart your computer. 

t> To remove security from the system partition on a RISC-based computer 

1. From the Partition menu, choose Secure System Partition. 

The check mark disappears, but security on the system partition will not 
actually be removed until you restart your computer. 

2. Restart your computer. 

Assigning Drive Letters 
You can create more than 24 volumes with Windows NT, but you will not be able 
to assign more than 24 drive letters for accessing these volumes. Drive letters A 
and B are reserved for floppy disk drives. However, if you do not have a physical 
B drive, you can use the letter B for a network drive. 

Windows NT allows the static assignment of drive letters. This means that a drive 
letter can be permanently assigned to a specific hard disk and partition/volume. 
When a new hard disk is added to an existing computer system, it will not affect 
statically assigned drive letters. 

However, this static assignment of drive letters occurs only after Disk 
Administrator has been used on the workstation. Until then, drive letters are 
assigned by Windows NT in the same manner as by MS-DOS, which adheres 
to the following rule: first the primary partitions on each hard disk get letters 
assigned starting with the letter "C." Windows NT then continues assigning the 
next available drive letter to each of the logical drives in order on each hard disk, 
and then to the secondary primary partitions on each hard disk. The active system 
partition is typically the C drive. 
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The following is an example with three hard disks: 

[ Primary 1 [ Logical 
,r_---...L...------,.\/ , 

[ Logical 
I \ 

I., I Disk 1 

[ Primary 1 [ Logical [ Primary 2 
,r_--~--vv-----~----~vr---~---~\ 

The following is an example with only one hard disk: 

[ Primary 1 [ Logical [ Primary 2 
I'---~--~vr---------~-------~v~--~----~\ 

Note You should be careful when making drive-letter assignments because 
many MS-DOS and Windows programs make references to a specific drive letter. 
For example, the Path environment variable shows specific drive letters in 
conjunction with program names. 
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I> To assign a drive letter 

1. Select the partition or logical drive whose drive letter you want to assign. 

2. From the Partition menu, choose Drive Letter. 

3. In the Assign Drive Letter dialog box, select the appropriate option button. 

If you decide to assign a drive letter, you can either accept the next letter 
available or select a different one. 

4. Choose the OK button. 

Deleting Partitions, Volumes, or Logical Drives 
Before deleting partitions, volumes, or logical drives under Windows NT, you 
need to ensure that the information on them has been backed up onto another 
storage medium and verified, or is no longer needed. 

Windows NT places certain restrictions on your freedom to delete. It will not 
let you delete the volume with the files needed to run Windows NT. Nor can you 
delete individual partitions that are part of a set without deleting the entire set. 
But, on a RISC-based computer, you can delete the system partition with the files 
needed to load Windows NT, so be very careful. Windows NT also requires that 
all the logical drives or other volumes in an extended partition be deleted before 
you can delete the extended partition. 

However, remember that no changes actually happen until you agree to save 
them when you quit Disk Administrator. 

I> To delete a partition, volume, or logical drive 

1. Select the partition, volume, or logical drive. 

2. From the Partition menu, choose Delete. 

A message advises you that all data will be lost and asks you to confirm 
your action. 

3. In the Confirm message, choose the Yes button. 

The partition, volume, or logical drive and any data are deleted, and the 
space becomes free again. 
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Adding Hard Disks 
The maximum number of hard disks that you can add to a computer depends on 
your hardware configuration, such as how many SCSI adapters you have attached. 
After adding additional hard disks to your computer, restart your computer and 
then start Disk Administrator. Before the Disk Administrator window opens, a 
message advises you that Disk Administrator has noticed a change and will 
update the system configuration after you choose the OK button. However, drive 
letters are not changed by the system when you add new hard disks if they have 
already been statically assigned. 

Recovering Disk Configuration Information 
In addition to the Emergency Repair disk that you created during Setup, Disk 
Administrator provides options for saving and restoring the following currently 
defined disk configuration information: assigned drive letters, volume sets, 
stripe sets, stripe sets with parity, and mirror sets. 

You can also search for disk configuration information among different 
installed versions of Windows NT and select a specific version to replace 
another. However, you should be careful to update this version's information 
every time you make a change to your disk's configuration. Make your changes 
first, quit Disk Administrator, restart your computer and Disk Administrator, 
and then save the configuration information and quit Disk Administrator. 

t> To save disk configuration information 

1. From the Partition menu, choose Configuration. 

2. From the Configuration menu, choose Save. 

A message describes what will be saved and where you should save it. It 
also warns you that changes made during this session will not be included. 

3. Insert a blank floppy disk,a floppy disk with a previous version of the 
configuration information, or the Emergency Repair disk. 

4. Choose the OK button. 
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I> To restore disk configuration information 

1. From the Partition menu, choose Configuration. 

2. From the Configuration menu, choose Restore. 

A message warns you that this operation will overwrite your current disk 
configuration information with what was previously saved on the floppy 
disk. Also, any changes made during this session will be lost. 

3. Insert the floppy disk containing the saved configuration information. 

4. Choose the OK button. 

I> To search for disk configuration information 

1. From the Partition menu, choose Configuration. 

2. From the Configuration menu, choose Search. 

A message warns you that this operation will overwrite your current disk 
configuration information with the information from a different installation 
of Windows NT. Also, any changes made during this session will be lost. 

3. Choose the OK button. 

Disk Administrator scans your disk for other Windows NT installations 
and then displays a list of the installations. 

4. Select an installation. 

5. Choose the OK button. 

Deleting Mirror Sets 
If you are using Windows NT on your computer and inherit several hard disks 
that were formerly used on a Windows NT Advanced Server computer, you may 
also inherit two volumes with duplicated, or mirrored, information. Establishing 
mirror sets and then breaking them, without deleting the information in the two 
volumes, is part of the fault-tolerance functionality provided with Windows NT 
Advanced Server. 

However, Windows NT will not recognize such volumes unless you first saved 
the configuration information from the Windows NT Advanced Server computer 
to a floppy disk and then restored that information on the Windows NT computer. 
They will appear in the disk bar with the color bar for a primary partition or 
logical drive, and there will be no drive letter assigned. You may then choose 
either to assign them drive letters or to delete the volumes and regain the use 
of that disk space. 
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Creating and Deleting Volume Sets 
Volume sets are a mechanism for more effectively using the total available 
free space on a disk. They are created, as shown in the following illustration, 
by combining various-sized areas of free space on from one to 32 disks into 
one large logical volume set that is treated like a single partition. 

Note Operating systems, such as MS-DOS, that do not have volume-set 
functionality cannot recognize any volume sets that are created by Windows NT. 
Therefore, if you create a volume set on a dual-boot computer, those partitions 
become invisible to MS-DOS. 
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The areas of free space used to create volume sets can be of different sizes, as 
shown in the following illustration. Volume sets are organized in such a way that 
the free space on one disk gets filled up and then, starting at the beginning of the 
next disk, all that free space gets filled up. The process continues in the same way 
on each subsequent disk up to a maximum of 32. 

This volume set is a combination of different-sized areas of free space on 
5 hard disks for a total of 2360 MB. 

Information is stored in the following order: 
1st 2nd 3rd 

I~J 1~.ll I.J! 
Disk 0 

Free Space 
320MB 

Disk 1 

Free Space 
500MB 

Disk 2 

Free Space 
400MB 

Disk 3 

Free Space 
640MB 

Disk4 

Free Space 
'500MB 

Deleting partitions to create free space that is then combined into one volume set 
also frees up drive letters for other uses, enables the creation of a large volume for 
file system use, and may improve system performance by better balancing data 
input and output (I/O) across the drives. 

!> To create a volume set 

1. Select two or more areas of free space on from one to 32 hard disks by 
selecting the first area of free space, and then pressing CTRL and clicking 
each of the other areas. 

2. From the Partition menu, choose Create Volume Set. 

Disk Administrator displays the minimum and maximum sizes for the volume 
set. 

3. In the Create Volume Set dialog box, type the size of the volume set that 
you want to create. 

4. Choose the OK button. 

If you choose to use less than the total available space, Disk Administrator 
divides the total size by the number of disks to create almost equal-sized 
unformatted partitions in each of the selected disks and assigns a single drive 
letter to the collection of partitions that make up the volume set. 
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When you no longer want to have a volume set, or you want to reorganize the 
data on your disks, or you have a problem with a faulty disk drive, you should 
first back up all the information on the volume set and then choose the Delete 
command. Deleting the volume set deletes all the information contained in the 
volume set. 

~ To delete a volume set 

1. Select the volume set that you want to delete. 

2. From the Partition menu, choose Delete. 

A message advises you that all the data will be lost and asks you to confirm 
that you want to delete it. 

3. In the Confirm message, choose the Yes button. 

Extending Volumes and Volume Sets 
Existing NTFS volumes and volume sets can also be extended by adding free 
space. Disk Administrator forces the system to restart after you quit and save your 
changes, and then formats the new area without affecting any existing files on the 
original volume or volume set. 

~ To extend a volume or volume set 

1. Select an existing volume (that is not part of a stripe set or mirror set) 
or a volume set and one or more areas of free space. 

2. From the Partition menu, choose Extend Volume Set. 

Disk Administrator displays the minimum and maximum sizes for the 
volume set. 

3. In the Create Extended Volume Set dialog box, type the size of the 
volume set that you want to create. 

4. Choose the OK button. 

Depending on the size that you specified, Disk Administrator determines 
how much of the free space to use. 
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Creating and Deleting Stripe Sets 
Stripe sets are created similarly to volume sets, but with more restrictions. Each 
member partition of the stripe set must be on a different disk up to a limit of 32 
disks. Also, Disk Administrator will make all the partitions approximately the 
same size. 

Note Operating systems, such as MS-DOS, that do not have stripe-set 
functionality cannot recognize any stripe sets that are created by Windows NT. 
Therefore, if you create a stripe set on a dual-boot computer, those partitions 
become invisible to MS-DOS. 

Stripe sets are created by combining areas of free space on from two to 32 disks 
into one large logical volume. The partitions in stripe sets are all approximately 
the same size so that the data can be written in stripes across each partition. This 
enables I/O commands to be issued concurrently and increases throughput. 

The following illustration shows a set of six hard disks and how the stripes 
are distributed across them. 

Information is written across the 5 rows of each partition 
from stripe #0 to #29, leaving 2 areas of unused space. 

'Iv~' 'I 
DiskO 

IlL 
18 
24 

I .•........ , . ;1 

Disk 1 

1 
7 

13 
19 
25 

unused 
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Disk2 
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14 
20 

. 26 

ca 
Disk3 

3 
9 

15 
21 
27 

unused 
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10 11 

.. 16 17 
22 23 
28 29 

': 

: 

.:. 



434 System Guide 

l> To create a stripe set 

1. Select two or more areas of free space on from two to 32 hard disks by 
selecting the first area of free space on the first disk, and then pressing CTRL 

and clicking an additional area of free space on each of the other hard disks. 

2. From the Partition menu, choose Create Stripe Set. 

Disk Administrator displays the minimum and maximum sizes for the stripe 
set. 

3. In the Create Stripe Set dialog box, type the size of the stripe set that you want 
to create. 

4. Choose the OK button. 

Disk Administrator divides the total size by the number of disks to create 
equal-sized unformatted partitions in each of the selected disks and assigns 
a single drive letter to the collection of partitions that make up the stripe set. 
If you choose a number that cannot be divided equally, Disk Administrator 
rounds to the closest higher or lower value. 

When you no longer want a stripe set or you have a problem with a faulty disk 
drive, you should first back up all the information on the stripe set and then 
choose the Delete command. Deleting the stripe set deletes all the information 
there. 

l> To delete a stripe set 

1. Select the stripe set that you want to delete. 

2. From the Partition menu, choose Delete. 

A message advises you that all the data will be lost and asks you to confirm 
that you want to delete it. 

3. In the Confirm message, choose the Yes button. 
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CHAPTER 17 

Performance Monitor 

Performance Monitor provides administrators and other users with a very capable 
monitoring tool to help with initial performance troubleshooting and capacity 
planning. 

This chapter explains how to use the four windows in Performance Monitor to 
better understand how well your own computer or other computers on a network 
are performing. The following main topics are included: 

• Monitoring performance 

• Charting current activity 

• Logging current activity 

• Setting alerts on current activity 

• Creating reports on current activity 

• Working with existing log files 
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Overview 
Performance Monitor is a graphical tool for measuring the performance of your 
own computer or other computers on a network. On each computer, you can 
view the behavior of objects such as processors, memory, cache, threads, and 
processes. Each of these objects has an associated set of counters that provide 
information on such things as device usage, queue lengths, and delays, as well 
as information used for throughput and internal congestion measurements. 

It provides charting, alerting, and reporting capabilities that reflect current activity 
along with ongoing logging. You can also open log files at a later time for 
browsing and charting as if they were reflecting current activity. Performance 
Monitor is located in the Administrative Tools group in Program Manager. 

The following list provides an overview of what you can do with this graphical 
tool to view the performance of objects: 

• View data from any number of computers simultaneously. 

• View and dynamically change charts reflecting current-activity counter values 
that are updated at a user-defined frequency. 

• Export data from charts, logs, alert logs, and reports to spreadsheet or database 
programs for further manipulation and .printing. 

• Add system alerts that list an event in the Alert Log and, optionally, notify 
you by reverting to the Alert view or issuing a network alert. 

• Run a predefined program every time, or just the first time, a counter value 
goes over or under a user-defined value. 

• Create log files containing data about various objects from different 
computers. 

• Append to one file selected sections of other existing log files to form a 
long-term archive. 

• View current-activity reports or create reports from existing log files. 

• Save individual chart, alert, log, or report settings, or the entire workspace 
setup, and reuse when needed. 

Starting and Quitting Performance Monitor 
You do not need any special privileges to open Performance Monitor. However, 
you do need to be logged on as a member of the Administrators group to use the 
diskperf command. This command turns on and off the counters for physical and 
logical disk activity on your own or another computer. The ability to control the 
activation of these counters is useful because disk counters can increase disk 
access time by approximately 1.5% on 386 processors. Mter restarting the 
computer, you can then use Performance Monitor to view disk performance data. 
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~ To activate the physical and logical disk counters 

1. Log on as a member of the Administrators group. 

2. At the command prompt, type diskperf to view help information on how 
to turn diskperf on and off and specify a remote computer's name. 

It will also state whether or not the disk performance counters have been 
activated already on that computer. 

3. Restart the computer to activate the disk performance counters. 

Double-click the Performance Monitor icon in the Administrative Tools group 
to display the Performance Monitor window in the Chart view. (You can also type 
perfmon [settings file] at the command prompt. The previously saved settings file 
can consist of selections made within a single view or within all four views, which 
is known as a Workspace and is saved as a .PMW file. If you do not specify a 
settings file, Performance Monitor searches the current working directory for the 
default chart file _DEFAULT.PMC.) 

Performance Monitor actually consists of four main windows, which you display 
by choosing to view Chart, Alert, Log, or Report. All four windows contain 
different information and have only the menu bar, status bar, and toolbar in 
common. Both context-sensitive and standard Help is provided for all the 
Performance Monitor commands. 

Computer: \\pegetl 
Object: Proce.sor 

% Processor Time 

Object: Process 

% Processor Time 

Object: Id emor}, 

Page F aultslsec 
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The following most commonly used commands from the View, Edit, and 
Options menus are also available on the toolbar: 

Chart 

Alert 

Log 

Report 

Add To 

Edit 

Delete From 

Update Now 

Bookmark 

Options 

An important menu item that is available in all four windows is the Data From 
command under the Options menu. You use this command to specify if you 
want to view current activity and work with current values or if you would rather 
manipulate an existing log file. The default value for displaying data is from 
current activity. Therefore, you will not need to change it until you want to 
examine an existing log file. 

You can quit Performance Monitor by choosing either Exit from the File menu 
or Close from the Control menu. Be sure to save your individual chart, alert, log, 
or report settings, or the entire workspace, to a file before quitting, unless you 
are sure you will not need that exact combination of settings again. 

t> To save settings in any view 

. 1. From the File menu, choose the corresponding Save Settings command. 

If you have not already assigned a filename, the Performance Monitor -Save 
As dialog box appears. 

2. Type a name in the File Name box. 

3. Choose the OK button. 

The assigned filename now appears in the status bar. 

t> To change the name of a settings file 

1. From the File menu, choose the corresponding Save Settings As command. 

2. In the Performance Monitor Save As dialog box, type a name in the File Name 
box or choose one from the list of existing filenames. 

3. Choose the OK button. 

The new filename now appears in the status bar. 

t> To save related settings from all four windows 

1. From the File menu, choose Save Workspace. 

2. In the Performance Monitor- Save Workspace As dialog box, type a name 
in the File Name box or choose one from the list of existing filenames. 

3. Choose the OK button. 



Chapter 17 Performance Monitor 439 

Organizing Your Screen 
You can choose to view one of four windows: Chart, Alert, Log, or Report. 
The only consistent elements among the four windows are the display options: 
Menu and Title, Toolbar, Status Bar, and Always On Top. By showing or hiding 
any of these options, you can vary the amount of screen space available for 
display purposes. The Always On Top option ensures that Performance Monitor, 
even when no longer the active window, stays visible over any other window on 
your screen. 

Performance Monitor also has a chart-highlighting feature that provides better 
visibility for a selected counter by changing the counter's on-screen color to 
white. While in chart-highlighting mode, you can change selections in the legend 
area and see the corresponding chart line change to white on the screen. To stop 
highlighting your selections, you must turn off the chart-highlighting mode. 

t> To show or hide a display option 

• From the Options menu, choose the appropriate display option's command. 

When an option is in effect, a check mark appears next to the command on 
the Options menu. 

t> To show or hide only the menu bar and title bar 

1. Double-click anywhere in the display area that does not contain text 
information. 

2. Double-click again to reverse the action. 

t> To move the window while the title bar is hidden 

• Click anywhere in the display area that does not contain text information 
and drag the mouse to move the window. 

t> To turn the chart-highlighting mode on or off 

1. To turn the chart-highlighting mode on and change the color of the selected 
counter to white, press CTRL+H. 

2. To stop highlighting selected counters, press CTRL+H again. 
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Monitoring Performance 
Performance Monitor is a graphical tool that almost everybody can use to gain a 
better understanding of how efficiently their computer is functioning and what the 
problems might be if it is performing poorly. You can use it to find bottlenecks on 
a network, to help in capacity planning, to do configuration management, and to 
·verify or predict problem areas in a program design. 

You can create charts, set alerts, build log files, and format reports that enable you 
to monitor the current performance of selected counters and instances for objects 
on Windows NT such as the following. However, notice that the objects will be 
different when viewing computers with different operating systems. 

Cache Paging File Redirector 

LogicalDisk PhysicalDisk Server 

Memory Process System 

Objects Processor Thread 

Different scenarios may demand the use of different features in Performance 
Monitor. For example, a network administrator may routinely monitor network 
activity to watch for problems and may also need to report on any failure to 
provide guaranteed service levels. There may be workload discrepancies between 
servers, one server may be paging excessively because of insufficient memory, 
or a server disk may be almost saturated. 

System throughput problems usually occur when the demand for resources 
exceeds the supply. The available resources, in this case, are the 
microprocessor( s), memory, hard disk( s), and networking hardware and software. 
Finding out how user applications interact with each of these resources is a logical 
first step when you start monitoring. 

An important second step is to assess the overall load on each of these resources. 
How close to being saturated is a system processor? How many applications 
are waiting to use the disk drive? User applications are not the only programs 
demanding resource time; a number of operating-system processes also consume 
fixed amounts of each resource. 

You can receive immediate feedback on how changes that you make affect the 
computer. You can also view information gathered over a period of time to see 
trends before and after the changes were made. And you can view all this in 
several different ways. 
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Alert Interval: '-15 ______ ....J 

% Processor Time 
Alert Log: 

.9 Feb 93 10:15:21 am 185.008 > 15.00 ,.!; 
09 Feb 93 10:15:26 am 31.132 > 30.00 
e 9 Feb 93 10:15:41 am 92.807 > 90.00 

Object: Process 

% Processor Time 

e 9 Feb 93 10:15:51 am 91.678 > 90.001 
.9 Feb 93 10:16:01 am 19.171 > 15.00 

Object: Memory 

09 Feb 93 10:16:11 am 30.538 > 30.00 Page Faultslsec 0.000 
o 9 Feb 93 10:16:16 am 36.556 > 30.00 
09 Feb 93 10:16:21 am 50.177 > 30.00 Object: 0 bjects 

09 Feb 93 10:16:21 am 50.177 > 50.00 -09 Feb 93 10:16:26 am 30.588 > 30:00 - Processes 22.000 ... .. 
+1 J 1.+ 

Alert Legend: 

Color Value Counter Instance Parent Object Compult 

o 0.0000 % Proces 0 Process \\peget" 
., 0.0000 % Proces Idle Process \\peget" 
• 5.0000 Page Fat. ... Memory \\peget" 

jData: Current Activity, Save File: amtest.pma 

You can view information on current activity as well as from log files that you 
recorded earlier for viewing at a more convenient time. Current-activity data 
or selected data from log files can also be exported to a spreadsheet or database 
program and rearranged to fit your needs. Or, for a quick snapshot of the current 
activity, you can press ALT+PRINTSCREEN and then use the Paste command in 
Paintbrush to display a printable bitmap of the active window. 

The same objects and counters are available for monitoring in all four views. 
When you select an object to monitor in Log view, all the counters for that object, 
or for each instance of that object, are monitored when you start collecting data in 
a log file. However, when you choose to view the results in one of the other three 
view windows, you can selectively add those counters and instances that are of 
interest to you. 

Despite its wide applicability, Performance Monitor does not answer every 
performance-tuning question. It should be thought of as a broad tool that provides 
an overview of the computer's performance. And, generally, it will be the first 
tool used on any performance problem. Frequently, you will be able to use it to 
resolve the problem completely. In other cases, you will use it to indicate which 
specialized tool (such as a profiler, a working set monitor, a disk optimizer, or a 
LAN packet sniffer) to use next. 



442 System Guide 

Understanding Objects, Counters, and Instances 
When monitoring a system, you are really monitoring the behavior of its objects. 
In Windows NT, an object is a standard mechanism for identifying and using a 
system resource. Objects are created to represent individual processes, sections 
of shared memory, and physical devices. Performance Monitor groups counters 
by object type. A unique set of counters exists for the processor, memory, cache, 
hard disk, processes, and other object types that produce statistical information. 
Certain object types and their respective counters are present on all systems. 
However, other counters, such as transport-protocol counters, only appear if 
the computer is running the associated software. 

Each object type can have several instances. For example, the Processor object 
type will have multiple instances if a system has multiple processors. The 
PhysicalDisk object type has two instances if a system has two disks. Some object 
types, such as Memory and Server, do not have instanceS. If an object type has 
multiple instances, each instance produces the same set of statistics (counter 
information). 

Two object types, Process and Thread, have a particularly close relationship. 
A Windows NT process is created when a program runs. A process may be either 
an application (such as Microsoft Word or Corel® Draw), a service (such as Event 
Log or Computer Browser), or a subsystem (such as the print spooler or POSIX). 
In addition to an executable program, every process consists of a set of virtual 
memory addresses and at least one thread. 

Threads are objects within processes that execute program instructions. They 
allow concurrent operations within a process and enable one process to execute 
different parts of its program on different processors simultaneously. Each thread 
running on a system shows up as an instance for the Thread object type and is 
identified by association with its parent process. For example, if Print Manager 
has two active threads, Performance Monitor identifies them as Thread object 
instances Printman ==> 0 and Printman ==> 1. 

Note Instances of the Process object type appear as numbers if they are internal 
system processes. Other types of processes are identified by the name of the 
executable file. 

The following table provides a list of sample counters and why you would use 
them to resolve various problems. 



Object: Counter 

Process: 

Working Set 

Memory: 

Available Bytes 

Pages/sec 

Page Faults/sec 

Paging File: 

% Usage 

% Usage Peak 

Processor: 

Description 

The portion of 
physical memory 
allocated to a running 
application 

The size of the virtual 
memory that is 
currently available 

The number of pages 
that had to be read 
from or written to 
disk because they 
were not in physical 
memory 

The number of page 
faults in the processor 

The amount of the 
paging file that is in 
use 

The peak usage of the 
system paging file 

% Processor Time The percentage of 
elapsed time that a 
processor is busy 
executing a non-idle 
thread 

Interrupts/sec The rate of service 
requests from I/O 
devices 
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Significance 

This value may be larger than the minimum 
number of bytes actually needed by the 
process. Therefore, it will change slowly 
over time depending on the activity of the 
application. 

If this number falls below a certain 
threshold, less free memory is available 
and Windows NT gradually begins to take 
memory away from the working sets of 
running applications to ensure that a certain 
amount of free memory exists. 

Check this counter's value if you suspect 
excessive paging, which would mean that 
memory demand is exceeding supply and 
therefore system performance is decreasing. 
If it is consistently greater than 5 for a 
single disk, you probably have a memory­
caused bottleneck. 

Data was not immediately available in the 
specified working set in memory. 

Check this counter's value to see if the size 
of PAGEFILE.SYS is appropriate. If it 
nears 100%, consider increasing the initial 
file size. 

Check this counter's value to see if the size 
of P AGEFILE.SYS is appropriate. If it 
approaches the maximum paging-file 
setting, consider increasing the initial file 
size. 

Check this counter's value to see how busy 
a processor is. Since each process thread 
requires a certain number of processor 
cycles when it runs, demand can exceed 
supply. If long processor queues develop, 
system response time can suffer. 

If this counter's value increases 
dramatically without a corresponding 
increase in system activity, it could indicate 
a hardware problem. 
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Object: Counter 

PhysicaIDisk: 

% Disk Time 

Disk Queue 
Length 

Avg. Disk sec/IO 

Avg. Disk 
Bytes/lO 

Description 

The percentage of 
time that a drive is 
active 

The number of 
requests outstanding 
on the disk at the time 
the performance data 
is collected 

The amount of time a 
disk takes to fulfill 
requests 

The average number 
of bytes transferred to 
or from disk during 
read or write 
operations 

Significance 

Ifdisk I/O is performing properly, there 
will be less strain on virtual memory, and 
programs will run faster. If this counter's 
value is high, check the Disk Queue Length 
counter. If both values are consistently 
high, move some files to an additional disk 
or server or consider upgrading the disk 
drive. 

The number of waiting I/O requests should 
be sustained at no more than 1.5 to 2 times 
the number of spindles making up the 
physical disk. Most disks have one spindle. 
However, Redundant Array of Inexpensive 
Disks (RAID) disks usually have more and 
yet appear as only one physical disk in 
Performance Monitor. 

If this counter's value is high, it may 
indicate that the disk controller is 
continually retrying the disk because of 
failures. For most disks, high average disk­
transfer times correspond to values greater 
than 0.3 seconds. A missed disk revolution 
typically adds 16 ms to average disk­
transfer time. 

If this counter's value is greater than 20K, 
the disk drive is generally performing well. 
Low values result if an application is 
accessing a disk inefficiently. Applications 
that access a disk at random also raise A vg. 
Disk sec/IO times because random transfers. 
require increased seeking time. 

Working with Information on Current Activity 
Performance Monitor provides four different views for information on the current 
behavior of objects, counters, and instances. However, you can use the same 
approach to accessing and working with the information in all four windows: 
Chart, Alert, Log, or Report. 
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t> To work in any view with information on current activity 

1. From the view's File menu, choose either a new settings file or open an 
existing one. 

You can open either a separate chart (.PMC), alert (.PMA), log (.PML), or 
report (.PMR) settings file, or a workspace (.PMW) file containing settings 
for all four windows. 

2. From the view's Edit menu, choose the Add To command to select one or 
more computers to monitor and the appropriate objects, counters, or instances. 

For details on how to select a computer in any view, see the following 
procedure. 

To select multiple objects and counters, select the first item and then do one 
of the following: 

• Press and hold down the SHIFT key and then select the last contiguous item. 

• Drag the mouse until you reach the last contiguous item. 

• Press and hold down the CTRL key and select each non-contiguous item. 

3. Choose either the Add To or Edit command to make changes, if you want, 
to how selections are represented. 

4. From the view's File menu, choose to save selections in a new settings file 
or update the current one. 

5. From the view's Options menu, change any of the options provided with that 
view, such as specifying the time interval and update method, hiding and 
displaying items, changing the graphic format, starting and stopping logging, 
adding bookmarks, and specifying the notification method. 

6. Change to another window, or view, and repeat the process to gain a different 
perspective on the same information or to monitor some other aspect of the 
problem. 

7. If you have related information in all four windows, save the settings for the 
entire workspace. 

8. If you plan to open certain settings files regularly, use File Manager's File 
Associate command to associate the five Performance Monitor file-extension 
types with the Performance Monitor program. Then use Program Manager's 
File New command to create a new Personal Program Group into which you 
can put your settings files as new program items. Double-clicking on an item's 
icon will start Performance Monitor with that settings file already opened. 
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t> To select a different computer 

1. From the view's Edit menu, choose the Add To command. 

2. In the Computer box, type the computer's name. Or click the gray button at 
the end of the box to display the Select Computer dialog box. 

The names of the domains or workgroups to which you have access appear in 
the Select Computer box. The first time you use this, there may be some delay 
while Performance Monitor searches the accessible domains and workgroups 
for member computers. 

3. Double-click the name of the appropriate domain controller or workgroup to 
display a list of the servers and workstations connected to it. 

4. Select the name of the server or workstation that you want to monitor. 

5. Choose the OK button. 

Notice that the Add button is disabled while Performance Monitor searches 
for that computer. If the computer is found, the Add button is enabled again, 
and the boxes change to show the default settings of the new computer. If the 
computer is not found, a message appears and you revert back to your own 
computer's default settings. 

Clearing the Display vs. Deleting Selections 
You can also use the same approach in all four views to deleting either a full 
screen of information or a single selection. 

t> To clear the values displayed on the screen 

• From the view's Edit menu, choose Clear Display. 

l> To delete a selection 

1. Select the legend, log, or report item that you want to delete. 

X 2. From the view's Edit menu, choose the Delete command. Or choose the 
Delete button on the toolbar. 

Updating the Display 
All four views have a command under the Options menu and a button on the 
toolbar that enable you to update manually the information on the screen. You can 
use the Update Now command or button between automatic data updates to get a 
current snapshot of the situation. Each view also has within its own Options 
dialog box an Update Time box for choosing the automatic updating frequency 
or for switching to only manual updates. 
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Notice that time-interval settings also affect the amount of memory and processor 
time used by Performance Monitor. Monitoring is generally not a large burden on 
processor time or memory unless you retrieve data very frequently from a large 
number of computers. 

l> To update the screen display in any view 

/COl!1 • From the view's Options menu, choose Update Now. Or choose the 
Update Now button on the toolbar. 

l> To change the updating method within each view 

1. In the appropriate view's Options dialog box, select either periodic or 
manual updating. 

2. If you selected Periodic Update, type a number in the Interval box to 
determine the time, in seconds, between updates. 

3. Choose the OK button. 

Printing a Snapshot of the Window Display 
You can use the PRINTSCREEN key to capture a graphical view of the current 
window at certain intervals or during peak periods to keep a record over time. 
You can then use the Paintbrush program in the Accessories group to clean up 
and print out a copy of the window display. 

l> To print a snapshot of the current window 

1. Press ALT+PRINTSCREEN to copy a view of the active window. If Performance 
Monitor is maximized, press PRINTSCREEN to copy the whole desktop. 

2. Start the Paintbrush program in the Accessories group. 

3. From the Edit menu, choose Paste and then, if you want to save the bitmap 
to a file, choose Save As from the File menu~ 

4. From the- File menu, choose Print. 

Exporting Data 
When you want to manipulate a snapshot of the current window's data in a 
spreadsheet or database program before printing it or when you want to change 
how the information is presented, use the view's Export command. 

l> To export data to a spreadsheet or database program 

1. From the view's File menu, choose the Export command. 

The Performance Monitor - Export As dialog box appears. 

2. In the Column Delimiter box, choose either the Tab (* .TSV) or Comma 
(* .CSV) method for separating the data columns in the file. 
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3. Select or type a path name, with the appropriate extension for the column 
delimiter, for the file that you want to export. 

If you want to select a file that is on another computer, choose the Network 
button to display and select from the Network Connections dialog box. 

4. Choose the OK button. 

5. Start the spreadsheet or database program. 

6. Open your Performance Monitor file and work with it. 

Working with Information from Log Files 
Performance Monitor provides four different views of historical information on 
the behavior of objects, counters, and instances. As with information on current 
activity, you can use a similar approach to accessing and working with these 
existing log files in all four windows: Chart, Alert, Log, or Report. 

~ To work in any view with information from log files 

1. From the view's Options menu, choose Data From to select an existing 
log file. 

2. From the view's Edit menu, choose Time Window to change the starting 
and stopping times, if necessary. 

3. Choose the appropriate Add To command to select one or more computers 
to monitor and the appropriate objects, counters, or instances. 

Or you can open an existing settings file or workspace file with the Open 
command from the view's File menu. 

For details on how to select a computer in any view, see the procedure given 
in the "Working with Information on Current Activity" section. 

5. Choose either the Add To or Edit command to make changes, if appropriate, 
to how selections are represented. 

6. From the view's File menu, choose to save selections in a new settings file 
or update the current one. 

7. From the view's Options menu, change any options, if available, such 
as hiding and displaying items, changing the graphic format, starting and 
stopping relogging, specifying the logging interval, and adding bookmarks. 

8. Change to another window, or view, and repeat the process to gain a different 
perspective on the same information or to study some other aspect of the 
problem. 

9. If you have related information in all four windows, save the settings for 
the entire workspace. 
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Charting Current Activity 
The ability to create customized charts to monitor the current performance of 
selected counters and instances is useful for doing tasks such as the following: 

• Investigating why a computer or application is slow or inefficient 

• Continuously monitoring systems to find intermittent performance bottlenecks 

• Discovering why you need to increase capacity 

For help understanding a selected counter, choose the Explain button in the 
Add To Chart dialog box to display the Counter Definition box. 

t> To view the Chart window 

~."' ..... t. ~ • From the View menu, choose Chart. Or choose the Chart button on the toolbar. 

If you are switching from another view, the Chart window is blank unless you 
already created or opened a chart during that session or from the command 
prompt. 

t> To open an existing chart settings file 

1. From the File menu, choose Open. 

2. In the Performance Monitor - File Open dialog box, select or type the path 
name for the .PMC file containing the selections that you want to reuse. 

To select a file that is on another computer, choose the Network button 
to display and select from the Network Connections dialog box. 

3. Choose the OK button. 

t> To create a new blank chart 

• From the File menu, choose New Chart. 
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Adding Chart Selections 
Different problems require different settings. Creating charts to reflect these 
different requirements is a simple matter of selecting the computer to be 
monitored and adding the appropriate objects, counters, and instances. You can 
then save these selections under a filename for viewing whenever you want an 
update on their performance. To make the graphs more readable, vary the scale 
of the displayed information and the color, width, and style of the line for each 
counter as you add it to the chart. You can also modify these properties after 
you add a selection. 

Object: L-I P_ro_c_e_ss ________ ---'I ...... iJ Instance: 

Counter: 

Color: I~~~[I :t!J. I Scale: L-ll_.0 __ ....... I! .... 1 'Width: 1'----__ ..... liJ..... Style: ~II ~~~t!l.;liJ~ 

'Counter Definition------....,..--------------------. 

I 
Privileged Time is the percentage of elapsed time that this process's threads have spent executing code in ~ 
Privileged M ode. When a Windows NT system service is called, the service will often run in Privileged ~ 
Mode to gain access to system·private data. Such data is protected from access by threads executing in ., 

~ To add selections to a chart 

:+ 1. From the Edit menu, choose Add To Chart. Or choose the Add To Chart 
button on the toolbar. 

The Add To Chart dialog box appears with the default settings and your 
workstation or server listed in the Computer box. To select a different 
computer, see the procedure given in the "Working with Information on 
Current Activity" section earlier in this chapter. 

2. In the Object box, select an object to monitor from the list of those that are 
available on the chosen computer. 

The Counter and Instance boxes change to display the items that are available 
for that object on the chosen computer. 

3. In the Counter box, select one or more counters. 

For a definition of the selected counter, choose the Explain button. 

4. In the Instance box, select one or more instances if appropriate. 
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5. If you do not want the next available color to be assigned to a counter along 
with the default scale and the default line width and style, make your own 
selections now. 

The scale factor is applied to all the currently selected counters. The factor 
displayed is multiplied times the counter value, and the product is charted. 
Notice, however, that the value bar continues to show the actual value, not 
the scaled value. 

6. Choose the Add button. 

7. Repeat the process for any additional objects or computers that you want 
to monitor. 

8. When you finish adding selections, choose the Done button. 

A list of your selections appears in the legend at the bottom of the window, 
and Performance Monitor displays the changing values of your selections on 
the chart. Notice that each displayed value is usually an average over the last 
two data reads, which are separated by the length of the time interval. 

t> To save chart selections in a settings file 

1. From the File menu, choose Save Chart Settings As. 

2. In the Performance Monitor - Save As dialog box, select or type a path name 
for the file that will contain the selections that you want to reuse. 

3. Choose the OK button. 

Changing Chart Selections 
Creating a readable chart is important. Sometimes, you should change the scale 
at which you graph the counter information to display the activity more in the 
center of the chart, but the actual reported values are not changed. To make each 
counter's line stand out better, you might want to vary the color, style, and width 
used. You might also want to use the chart-highlighting mode on a selected 
counter. 

t> To change how a selected counter is represented on the chart 

1. In the legend, select the counter that you want to change. 

2. Double-click the selected counter. Or, from the Edit menu, choose Edit Chart 
Line. Or choose the Edit Chart Line button on thetoolbar. 

The same dialog box as the one used for Add To Chart appears, showing 
only the information for the counter that you selected in the legend. 
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3. Change any of the following options: 

Select an option under 

Color 

Scale 

Width 

Style 

4. Choose the OK button. 

To 

Use colors to reflect your personal preferences. 

Change the scale at which the information is displayed. 
The numbers shown in the value bar, however, are not 
scaled. 

Make the line thicker or thinner. Thick lines, however, 
cannot be styled. 

Use a different style with a thin line. 

The legend information area now displays the new selections. 

r> To update chart selections that have been saved in a settings file 

• From the File menu, choose Save Chart Settings. 

Changing the Chart Options 
The Chart window shows a blank grid area and legend until you add information 
to it by selecting objects, counters, and instances to be monitored with the Add To 
Chart command from the Edit menu. Choosing the Chart command from the 
Options menu enables you to customize the charts that you create and change the 
method used for updating the chart values. 

In the Chart Options dialog box, you can choose whether or not to display or hide 
horizontal and vertical grid lines, vertical labels, the value bar, and the legend and 
legend-information area. 

You can also change the vertical maximum value of the displayed graph labels 
and the time interval used for graphing the information from the counters. The 
chosen graph-time interval is reflected in the value bar, which also displays the 
last, average, minimum, and maximum values for the data visible on the chart. 

Finally, you can change from a graph format to a histogram bar-type 
representation (as shown in the following illustration) of the information that you 
are gathering. This is useful for better viewing the simultaneous behavior of many 
instances of the same object. 



IData: Current ActiYity,Save File: tstchart.pmc 

o 
Idle 
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Process 

The Options menu also enables you to update manually the information on the 
screen. You can use the Update Now command between automatic data updates 
to get a current snapshot of the situation. In the Chart Options dialog box, use the 
Update Time box for choosing the automatic updating frequency or for switching 
to only manual updates. 

~ To change chart options 

~ 1. From the Options menu, choose Chart. Or choose the Options button on the 
toolbar. 

2. In the Chart Options dialog box, select the options that you want to display. 

3. In the Vertical Maximum box, type the maximum value to which the vertical 
axis should extend. 

4. In the Update Time box, select either Manual Update or Periodic Update and 
then type a number in the Interval box to determine the time, in seconds, 
between updates of the charts. 

The Graph Time value displayed in the value bar shows the time, in seconds, 
that it takes to create a complete chart across the window. 

5. In the Gallery box, select how you want to display information in the chart. 

6. Choose the OK button. 
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Logging Current Activity 
Logging enables you to record information on the current activity of selected 
objects and computers for viewing later. 

You can create a log file on the performance of counters and instances for objects 
on Windows NT . You can also collect data from multiple systems into a single 
log file. Log files contain detailed data for bottleneck detection or other detailed 
analysis. For capacity planning, you need to view trends over a longer period, 
which requires the ability to create a log file and to produce reports from that file. 

t> To view the Log window 

• From the View menu, choose Log. Or choose the Log button on the toolbar. 

If you are switching from another view, the Log window is blank unless you 
already created or opened a log file during that session or from the command 
prompt. 
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t> To open an existing log settings file 

1. From the File menu, choose Open. 

2. In the Performance Monitor File Open dialog box, select or type the path name 
for the .PML file containing the selections that you want to reuse. 

If you want to select a file that is on another computer, choose the Network 
button to display and select from the Network Connections dialog box. 

3. Choose the OK button. 

t> To create a new blank log file 

• From the File menu, choose New Log Settings. 

Adding to a Log 
You can create different logs to accumulate information on the behavior of 
selected objects on various computers to be studied later. You can then save these 
selections under a filename and reuse them when you want to create another log 
of the same type of information for comparison. 

t> To add selections to a log 

L+I 1. From the Edit menu, choose Add To Log. Or choose the Add To Log button 
on the toolbar. 

The Add To Log dialog box appears with the default settings and your 
workstation or server listed in the Computer box. To select a different 
computer, see the procedure given in the "Working with Information on 
Current Activity" section earlier in this chapter. 

2. In the Objects box, select an object or set of objects to monitor from the list 
of those that are available on the chosen computer. 

3. Choose the Add button. 

4. Repeat the process for any additional computers that you want to monitor. 

5. When you finish adding objects, choose the Done button. 

A list of your selections appears in the display area. 

t> To save log selections in a settings file 

1. From the File menu, choose Save Log Settings As. 

2. In the Performance Monitor - Save As dialog box, select or type a path. 
name for the file that will contain the selections that you want to reuse. 

3. Choose the OK button. 
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Changing the Log Options 
The Log window has a display area for listing the objects and their corresponding 
computers that you have selected with the Add To Log command from the Edit 
menu. Choosing the Log command from the Options menu enables you to fill in 
or change the information shown in the gray boxes in the Log window, to start or 
stop logging, and to change the method used for updating the log values. 

The Log window displays a list of objects and computers along with the current 
file size and the following items that you can specify in the Log Options dialog 
box: 

• Complete path and name of the log file. 

• Log Interval in seconds, from 1 to 3600 seconds (1 hour). 

• Status, either Collecting or Closed. 

The Options menu also enables you to update manually the information on the 
screen. You can use the Update Now command between automatic data updates 
to get a current snapshot of the situation. In the Log Options dialog box, use the 
Update Time box to select either an automatic updating frequency or only manual 
updates. 

t; To change the log options 

~ 1. From the Options menu, choose Log. Or choose the Options button on the 
toolbar. 

2. In the Log File box, type a name for the log file that you are creating. 

If this is the name of an existing file, the new data will be appended to the 
old data. To replace the old data, you must first delete the file and then create 
a new one with the old name. 

3. In the Update Time box, select either Manual Update or Periodic Update and 
then type a number in the Interval box, or open the list and select a number to 
determine the time, in seconds, between updates of the log. 

4. If you do not want to start logging yet, choose the OK button. 

t> To start or stop logging 

1. From the Options menu, choose Log. 

2. To start logging, choose the Start Log button, which then changes to Stop Log. 

If the Start Log button is not enabled, you must first type or select a log file 
name and add some objects to log. 

After you start logging, a log symbol with the changing total file size appears 
on the right side of the status bar and remains there in all four views. 

3. To stop logging, choose the Stop Log button. 
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Adding Bookmarks 
Log files become more usable when you add bookmark comments at various 
points while logging. Bookmarks serve as reminders by describing the 
circumstances under which the file was created or by highlighting major points 
of interest. You can then refer to these bookmarks when you work with the log 
file later. The Bookmark command becomes available when you start logging. 

t> To add a bookmark 

1. From the Options menu, choose Bookmark. Or choose the Bookmark button 
on the toolbar. 

2. In the Bookmark Comment box, type a comment. 

3. Choose the Add button. 

Setting Alerts on Current Activity 
Alerts enable you to continue working while Performance Monitor tracks events 
for you and notifies you in the way that you specify. In the Alert view, you can 
create an alert log that enables you to monitor the current performance of selected 
counters and instances for objects on Windows NT. 

Alert Interval: 1....15 ______ ----' 

Alert Log' 

• 9 Feb 93 10:32:58 am 31.090 > 30.000 % Processor Time. D. (null). Processor. \\peget1 .!. 
.9 Feb 93 10:32:58 am 30.561 > 15.000 Page Faults/sec. (null). (null). Memory. \\peget1 
.9 Feb 93 10:33:15 am 30.385 > 30.000 % Processor Time. D. (null). Processor. \\peget1 
.9 Feb 93 10:33:19 am 32.348 > 30.000 % Processor Time. D. (null). Processor. \\peget1 
• 9 Feb 93 10:33:53 am 90.104 > 90.000 % Processor Time. Idle. (null). Process. \\pegetl 

~ 

• 9 Feb 93 10:34:03 am 92.814 > 90.000 % Processor Time. Idle. (null). Process. \\pegetl I-' 
+ 

+1 J L+ 

Alert Legend: 
Value Counter 
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With the alert log, you can monitor several counters at the same time. When a 
counter exceeds a given value, the date and time of the event are recorded in the 
Alert window. A total of one thousand events are recorded, after which the oldest 
event is discarded when the next new one is added. An event can also generate a 
network alert. When an event occurs, you can have a specified program run every 
time or just the first time that it occurs. 

For help understanding what a selected counter shows, choose the Explain button 
in the Add To Alert dialog box to display the Counter Definition box. 

J> To view the Alert window 

'r • From the View menu, choose Alert. Or choose the Alert button on the toolbar. 

If you are switching from another view, the Alert Log area is blank unless you 
already created or opened an alert log file during that session or from the 
command prompt. 

J> To open an existing alert log settings file 

1. From the File menu, choose Open. 

2. In the Performance Monitor - File Open dialog box, select or type the path 
name for the .PMA file containing the selections that you want to reuse. 

If you want to select a file that is on another computer, choose the Network 
button to display and select from the Network Connections dialog box. 

3. Choose the OK button. 

J> To create a new blank alert log file 

• From the File menu, choose New Alert Settings. 

Adding Alert Selections 
You can create alert logs to warn yourself about problems in different situations. 
You can then save these selections under a filename and reuse them when you 
want to see if the problems have been fixed. 
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Computer: '-I'_'p_e_g_et_l _________________ --"'__ I Add 

Object: I'-P_ro_c_e_ss _________ -"'I-..! I Instance: IfR]mrmrr.::::C.:!.iI I ~ Cancel 
progman 

Counter: ~:;';i~~N~~'f;1;.Ntflf:<:::~:~~:::"~~:,.".m .~_~~.~ T 
% User Time .­
Base Priority 
Elapsed Time 
File Read Byteslsec 

Alert If -----, 

Color: ~I ~~~II +~I @Over 
o Under ,-I "----' 

PSKSS 

screg 
smss 
spoolss 
System 
taskman 

Run Program on Alert 

-
"'"'" Help 
"+ 

1 0 First Time 
'-----------',@EveryTime 

rCounter Definition------------------------, 

Processor Time is the percentage of elapsed time that all of the threads of this process used the processor ~ 
to execute instructions. An instruction is the basic unit of execution in a computer, a thread is the object 
that executes instructions, and a process is the object created when a program is run. Code executed to .. 

To add selections to an alert log 

1. From the Edit menu, choose Add To Alert. Or choose the Add To Alert 
button on the toolbar. 

The Add To Alert dialog box appears with the default settings and your 
workstation or server listed in the Computer box. To select a different 
computer, see the procedure given in the "Working with Information on 
Current Activity" section earlier in this chapter. 

2. In the Object box, select an object to monitor from the list of those that are 
available on the chosen computer. 

The Counter and Instance boxes change to display the items that are available 
for that object on the chosen computer. 

3. In the Counter box, select one or more counters. 

For a definition of the selected counter, choose the Explain button. 

4. In the Instance box, select one or more instances if appropriate. 

5. If you do not want the next available color to be assigned to a counter, 
make your own selection now. 

6. In the Alert If box, select either Over or Under and add a value that is 
appropriate for that counter. 

7. In the Run Program On Alert box, select either First Time or Every Time 
and type the complete path name for the program or macro that you want to 
run whenever the specified alert occurs. 

The Alert Log entry is passed to the program on the command line. 
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8. Choose the Add button. 

9. Repeat the process for any additional objects or computers that you want 
to monitor. 

10. When you finish adding selections,choose the Done button. 

A list of your selections appears in the Alert Legend box at the bottom of the 
window, and Performance Monitor displays the resulting alerts in the Alert 
Log area. Notice that each alert value is usually an average over the last two 
data reads, which are separated by the length of the time interval. 

When an alert occurs while you are not in the A1e'rt view, an alert icon appears 
in the status bar showing the number of alerts that have occurred since you 
were last in the Alert view. 

~ To save alert log selections in a settings file 

1. From the File menu, choose Save Alert Settings As. 

2. In the Performance Monitor - Save As dialog box, select or type a path name 
for the file that will contain the selections that you want to reuse. 

3. Choose the OK button. 

Changing Alert Selections 
Mter monitoring the alert log for a while, you may decide to change the Alert If 
criterion, what program to run and how often to run it, or the color used to display 
certain alerts. 

t> To change how a selected counter is represented in the alert log 

~ 1. Double-click the selected counter in the legend. Or, from the Edit menu, 
choose Edit Alert Entry. Or choose the Edit Alert Entry button on the toolbar. 

The same dialog box as the one used for Add To Alert appears, showing only 
the information for the counter that you selected in the legend. 

2. Change any of the following options: 

Select an option under 

Color 

Alert If 

Run Program On Alert 

3. Choose the OK button. 

To 

Use colors to reflect your personal preferences. 

Change the alert warning criterion. 

Change how often the program is run or change to 
a different program. 

The Alert Legend information area now displays the revised selections. 
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t> To update alert log selections that have been saved in a settings file 

• From the File menu, choose Save Alert Settings. 

Changing the Alert Options 
The Alert window has a display area for an alert log reflecting current activity, an 
Alert Legend box showing the information that you selected for logging with the 
Add To Alert command from the Edit menu, and an Alert Interval box showing, 
in seconds, how often you want the system to be monitored. 

The Options menu enables you to update manually the information on the screen. 
You can use the Update Now command between automatic data updates to get a 
current snapshot of the situation. In the Alert Options dialog box, use the Update 
Time box to select either an automatic updating frequency or only manual 
updates. 

Choosing the Alert command from the Options menu enables you to specify not 
only the alert interval but also how you want to be notified when an alert occurs, 
which can be by either or both of the following two methods: 

• Switching to the Alert view 

• Sending a network alert message to yourself or someone else 

t> To change alert options 

t~1 1. From the Options menu, choose Alert. Or choose the Options button on the 
toolbar. 

2. In the Alert Options dialog box, select one or both of the notification options: 
Switch to Alert View or Send Network Message. 

3. In the Network Alert box, type the computername, without backslashes (\\), 
of the recipient's computer or another predefined name on the recipient's 
computer in the Net Name box. 

The Messenger service must already be started and the net name defined on 
the recipient's computer. To do so, at the command prompt, type net start 
messenger /? and net name /? to view Help information on how to use these 
commands. 

4. In the Update Time box, select either Manual Update or Periodic Update 
and then type a number in the Interval box to determine the time, in seconds, 
between updates of the alert log. 

5. Choose the OK button. 
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Creating Reports on Current Activity 

~ 

~ 

The Report view provides a simple report format for displaying constantly 
changing values. 

Computer: \ \pegetl 
Object: Processor 

% Processor Time 
Interrupts/sec 

Object: S ydem 

% Total Processor Time 

Object: Process 

% Processor Time 
% User Time 

Object: Thread 

% Processor Time 

o 

43.687 
125.806 

43.687 

Idle 

56.313 

Idle 
0 

56.313 

PERFMON WINFllE PBRUSH 

3.295 2.995 
0.899 2.995 0.300 

PBRUSH PERFMON System 
0 1 15 

0.899 0.000 :::::::::::::::::::::::::0:.:0.0.0.1 

With Performance Monitor, you can create reports showing current information 
on counter and instance values for selected objects. The information is presented 
in columns for each individual instance. You can adjust report intervals, print 
snapshots, and export data. 

For help understanding a selected counter, choose the Explain button in the 
Add To Report dialog box to display the Counter Definition box. 

To view the Report window 

• From the View menu, choose Report. Or choose the Report button on the 
toolbar. 

If you are switching from another view, the Report window is blank unless you 
already created or opened a report file during that session or from the command 
prompt. 
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t> To open an existing report settings file 

1. From the File menu, choose Open. 

2. In the Performance Monitor - File Open dialog box, select or type the path 
name for the .PMR file containing the selections that you want to reuse. 

If you want to select a file that is on another computer, choose the Network 
button to display and select from the Network Connections dialog box. 

3. Choose the OK button. 

t> To create a new blank report file 

• From the File menu, choose New Report Settings. 

Adding to a Report 
: Creating reports using current activity can help you to gain a better understanding 

of object behavior. You can create a report on all the counters for a given object 
and then watch them change under various loads. For example, certain counter 
values, such as Working Set, are relatively static, while others, such as % 
Processor Time, change constantly. At application startup, it is normal to see the 
% Processor Time value climb sharply, decrease, and then level off. 

You can also create reports to reflect the same information that you are charting 
or to monitor other specific situations. You can then save these selections under 
a filename and reuse them when you need an update on the same information. 

t> To add selections to a report 

I± ~ 1. From the Edit menu, choose Add To Report. Or choose the Add To Report 
button on the toolbar. 

The Add To Report dialog box appears with the default settings and your 
workstation or server listed in the Computer box. To select a different 
computer, see the procedure given in the "Working with Information on 
Current Activity" section earlier in this chapter. 

2. In the Object box, select an object to monitor from the list of those that are 
available on the chosen computer. 

The Counter and Instance boxes change to display the items that are available 
for that object on the chosen computer. 

3. In the Counter box, select one or more counters. 

For a definition of the selected counter, choose the Explain button. 
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4. In the Instance box, select one or more instances if appropriate. 

5. Choose the Add button. 

6. Repeat the process for any additional objects or computers that you want 
to monitor. 

7. When you finish adding selections, choose the Done button. 

A list of your selections by computer and object appears in the report area, 
and Performance Monitor displays the changing values of your selections in 
the report. Notice that each displayed value is usually an average over the last 
two data reads, which are separated by the length of the time interval. 

J> To save report selections in a settings file 

1. From the File menu, choose Save Report Settings As. 

2. In the Performance Monitor - Save As dialog box, select or type a path name 
for the file that will contain the selections that you want to reuse. 

3. Choose the OK button. 

Changing the Report Option 
The Report window shows a blank screen until you add information to it by 
selecting objects, counters, and instances to be monitored with the Add To Report 
command from the Edit menu. The Options menu enables you to update manually 
the information on the screen. You can use the Update Now command between 
automatic data updates to get a current snapshot of the situation. Choosing the 
Report command from the Options menu enables you to select either an automatic 
updating frequency or only manual updates. 

J> To change the report updating method 

1. From the Options menu, choose Report. Or choose the Options button on the 
toolbar. 

2. In the Update Time box, select either Manual Update or Periodic Update and 
then type a number in the Interval box, or open the list and select a number to 
determine the time, in seconds, between updates of the report. 

3. Choose the OK button. 
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Working with Existing Log Files 
Existing log files can provide a wealth of information for troubleshooting or 
planning. Whereas charting, setting alerts, and creating reports on current activity 
provide instant feedback, working with existing log files enables you to change 
the way you look at that feedback and gain a different perspective on the 
information. 

You can examine the information much more thoroughly in a log file than you 
can while it is happening. You can move around in a log file (that is, change the 
start and stop times) by using the Time Window command from the view's Edit 
menu. The times selected will apply to all four views. 

Changing the times is easiest to do in the Chart window. Add your selections to 
the chart first. You can then move the Input Log File Timeframe dialog box out of 
the way so you can see the gray vertical lines move on the chart as you move the 
ends of the slide bar. Set up a time window with this method that is appropriate 
for your needs and then set your alerts, create reports, or relog the data. 

I> To select an existing log file 

1. From the Options menu, choose Data From. 

2. In the Data Values Displayed From box, select Log File. 

3. In the Log File box, type the log's filename. Or click the gray button at the 
end of the box to display the Open Input Log File dialog box from which you 
can select a file. 

If you want to select a file that is on another computer, choose the Network 
button to display and select from the Network Connections dialog box. 

4. Choose the OK button. 

This also activates the Time Window command in the Edit menu. 



466 System Guide 

~ To change the time window for the logged information 

1. From the Edit menu, choose Time Window. 

::iI~Lj 
Cancel I 

Bookmarh------------------------, 

I 'Set Asstiut I 
I Set As SlOp 'I 

2. In the Input Log File Timeframe dialog box, use one or a combination of 
both of the following methods to specify how much information you want to 
display. 

• To change the starting and stopping points to be used, drag the 
corresponding end of the time interval slide bar. 

Notice that in charting, as you drag the ends of the slide bar, you are also 
moving two gray vertical lines on the chart. 

• To use bookmarks as starting or stopping points, select the appropriate 
bookmark and choose either the Set As Start button or the Set As Stop 
button. 

3. Choose the OK button. 

The screen display changes to reflect the selected time frame. 
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Charting Input Log Files 
When you need a graphical view of a log file, you can open an existing one in 
Chart view to see how the values changed over a defined period of time. You can 
also change the time intervals displayed, choose which counters to chart, edit the 
chart, print a snapshot, and export the data to a spreadsheet or database program 
for further manipulation and printing. 

I> To chart an input log file 

1. From the Options menu in the Chart view window, choose Data From. 

2. Select a log file name from either your own computer or another one on the 
network. 

3. From the Edit menu, choose any of the following commands: 

• Add To Chart, to choose which counters from which computers to chart. 

• Edit Chart Line, to change any of the selection settings. 

• Delete From Chart, to remove any counters that are not interesting or 
needed. 

• Time Window, to change the displayed starting and stopping points. 

4. From the Options menu, choose Chart to hide or display any items, change the 
vertical maximum, or change from a graph format to a histogram. 

5. From the File menu, choose any of the following commands: 

• Save Chart Settings As, to update changes made to the current chart 
settings file or to create a new file for these setting selections. 

• Export Chart, to export the data from the displayed chart to a spreadsheet 
or database program. 
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Setting Alerts on Input Log Files 
You can take an existing log file and set alerts in the Alert Log to see where 
values exceeded or went below various alert values. All the counters for those 
objects that you chose to log will appear in the Add To Alert dialog box. You can 
now define your Alert Log by selecting only those computers and counters that 
you need .. 

~ To set alerts on an input log file 

1. From the Options menu in the Alert view window, choose Data From. 

2. Select a log file name from either your own computer or another one on the 
network. 

3. From the Edit menu, choose any of the following commands: 

• Add To Alert, to choose which counters from which computers to relog 
with alerts. 

• Edit Alert Entry, to change any of the selection settings. 

• Delete Alert, to remove any counters that are not interesting or needed. 

• Time Window, to change the displayed starting and stopping points. 

4. From the Options menu, choose Alert to select the update-time interval. 

5. From the File menu, choose any of the following commands: 

• Save Alert Settings As, to update changes made to the current alert settings 
file or to create a new file for these setting selections. 

• Export Alert, to export the data from the alert log to a spreadsheet or 
database program. 



Chapter 17 Performance Monitor 469 

Relogging Input Log Files 
By changing certain options when relogging, you can significantly condense large 
log files. You can relog with a longer time interval either all or only selected 
objects in an existing log file. You can also change the start and stop times and 
relog only the data within that time frame. 

When you direct the output to an existing log file, that output is appended to 
the end of the file, thus creating a single, smaller archive file. 

I> To relog an input log file 

1. From the Options menu in the Log view window, choose Data From. 

2. Select a log file name from either your own computer or another one on 
the network. 

3. From the Edit menu, choose any of the following commands: 

• Add To Log, to choose which objects from which computers to relog. 

• Delete From Log, to remove any objects that are not needed. 

• Time Window, to change the displayed starting and stopping points. 

4. From the Options menu, choose Log to change the log file name, the logging 
interval, and to start relogging. 

If you select an existing log file for output, the data will be appended. To 
enable the Relog File button, you must first provide a filename and select 
some objects to log. 

5. From the File menu, choose any of the following commands: 

• Save Log Settings As, to update changes made to the current log settings 
file or to create a new file for these setting selections. 

• Export Log, to export the log setting to a spreadsheet or database program. 
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Reporting Based on Input Log Files 
You can create simple reports from existing log files the same as you would with 
current activity values. However, here the values shown represent the counter 
values over the selected time frame. 

t> To create a report from an input log file 

1. From the Options menu in the Report view window, choose Data From. 

2. Select a log file name from either your own computer or another one on 
the network. 

3. From the Edit menu, choose any of the following commands: 

• Add To Report, to choose which counters from which computers to 
display in the report. 

• Delete From Report, to remove any counters that are not interesting or 
needed. 

• Time Window, to change the displayed starting and stopping points. 

4. From the File menu, choose any of the following commands: 

• Save Report Settings As, to update changes made to the current report 
settings file or to create a new file for these setting selections. 

• Export Report, to export the data from the report to a spreadsheet or 
database program. 
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Troubleshooting 

This chapter describes ways of troubleshooting various problems that can arise 
while installing, starting, and running Windows NT. The chapter discusses 
problems in these areas: 

• Hardware compatibility 

• Installation 

• Starting Windows NT or an alternate operating system 

• Logging on to Windows NT 

• Performance 

• Networking 

• Starting services or subsystems 

• Removing an NTFS partition 
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For additional information, check the Read Me icon in the Main program group. 
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Hardware Configuration .Problems 

SCSI Drives 

The following sections discuss common hardware problems that can prevent 
Windows NT from installing, starting, or operating properly. See also "Network 
Problems," later in this chapter. 

Windows NT currently supports up to seven SCSI and two non-SCSI drives on a 
given single controller. If you have trouble with a SCSI drive, make sure the SCSI 
bus is set up properly (refer to your hardware documentation for specific details): 

• The ends of the SCSI bus must have terminating resistor packs (also called 
"terminators") installed. If you have only internal or only external SCSI 
devices, the ends of the bus are probably the SCSI adapter and the last device 
on the cable. If you have both internal and external SCSI devices, the adapter 
probably is in the middle of the bus and should not have terminators installed. 

• If you disconnect a device that has terminators installed (such as an external 
CD-ROM drive), be sure to install terminators on whatever device then 
becomes the last one on the bus. 

• One of the devices on the SCSI bus, usually the adapter, should be configured 
to provide termination power to the bus. 

Make sure the SCSI ID of the CD-ROM drive is not 0 or 1. Some SCSI adapters 
reserve IDs 0 and 1 for hard drives. If your CD-ROM drive has an ID of 0 or 1, 
you may see an extra partition that does not exist. The SCSI ID is usually set by 
jumpers on the device. 

If you have a SCSI hard disk drive that uses removable media, such as a cartridge 
drive, make sure that there is media mounted in the drive before running Setup. 
If no media is in the drive, errors may occur during Setup that prevent installation 
of Windows NT. 

In some cases, adding or removing a SCSI adapter may prevent your system from 
starting correctly. For information on configuring SCSI adapters, check the Read 
Me item in the Main program group. 
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Network Adapter Cards 
Devices cannot share interrupt request (IRQ) numbers, memory buffer addresses, 
or ROM addresses. Make sure there are no conflicts among network adapters 
or between the system board and adapters. Sometimes these are set with jumpers 
or switches on the hardware (refer to your hardware documentation for specific 
details), sometimes with software. If the network card can be configured through 
software, you can do so with Windows NT Setup. For more information, see 
"Network Adapter Card Settings," later in this chapter. 

Video Display Drivers and Adapter Cards 
Note The information is this section is applicable to x86-based computers only. 

If you choose a display mode in Setup that your hardware does not support, 
you will need to reinstall Windows NT. Unsupported video adapters should 
be set up as VGA in Windows NT Setup. If, after installation, you change your 
display type to one that is not compatible with your display adapter and monitor, 
you can recover the previous working configuration (the Last Known Good 
Configuration). For more information, see "Repairing Your System," in Chapter 
12, "System Maintenance with Windows NT Setup." 

In certain cases Setup may incorrectly identify your video card. If this happens, 
reinstall and select a VGA card during Setup. 

Installing Windows NT 
Make sure your disk has enough space to install Windows NT. For more 
information, see "System Requirements" in "Welcome." 

Remember that you cannot install Windows NT on a disk partition configured 
with any disk compression products. 

Installing UsingWINNT.EXE 
The WINNT.EXE program must be run from MS-DOS on an x86-based 
computer. It cannot be run from Windows 3.1, OS/2, or Windows NT. To see 
.usage information for WINNT.EXE, type winnt /? at the MS-DOS prompt. 
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When you install Windows NT using WINNT.EXE, Setup stores temporary files 
on your computer. Setup puts these files on the first available drive with enough 
space on it. It may choose a drive that is not supported by Windows NT Setup, 
such as a drive on a secondary IDE or ESDI controller or on an unsupported SCSI 
disk. If this happens, the following message appears: "Setup is unable to locate 
the hard drive partition prepared by the MS-DOS portion of Setup." In this case, 
run WINNT.EXE again and specify a supported drive using the /t parameter. 

Starting Windows NT 
Windows NT starts in the following sequence: 

1. When Windows NT is installed, it alters the system's boot record to look for 
and run a program called NTLDR. 

2. NTLDR runs NTDETECT.COM, which builds a list of the system's hardware 
components. 

3. NTLDR reads BOOT.INI and builds a menu of the operating systems that you 
can start. 

BOOT.INI is a system text file that has two sections: the first specifies the 
default operating system to start and a time-out value specifying how long to 
wait before starting automatically, and the second specifies the operating 
systems that you can start. For example, if your system is configured to run 
either Windows NT or MS-DOS, BOOT.INI typically looks like this: 

[boot loader] 
timeout=30 
default=multi(0)disk(0)rdisk(0)partition(1)\winnt 

[operating systems] 
multi(0)disk(0)rdisk(0)partition(1)\winnt="Windows NT" 
c:\="MS-DOS" I 

Y O"U can edit the text displayed in quotes to customize the operating system 
choices, but you must first change the read-only attribute of the file. To do 
this, open File Manager. Choose By File Type in the View menu, and then 
select the Show Hidden/System Files box. Highlight the BOOT.INI file and 
select Properties from the File menu. Clear the Read Only Attribute box and 

, edit the file using Notepad. Make the file read-only when you are done. 

Alternatively, type attrib -s -r c:\boot.ini at the command prompt, and then 
edit the file. 

4. You can select an operating system from the menu, or let the time count down 
to 0 to start the default operating system. 

If you don't see the menu and the default operating system automatically 
starts, the time-out value has been set to O. 
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5. The low-level components of Windows NT load, and then Windows NT 
initializes the drivers and starts the services in accordance with information 
stored in the Registry. 

6. The high-level components of Windows NT load, and then the Welcome 
screen is displayed so you can log on. 

Once Windows NT starts successfully, back up your configuration directory 
(\ WINN1\SYSTEM32\CONFIG). As you change your configuration and 
accounts, maintain current backups. If you have to use the Emergency Repair 
disk that you made when you installed Windows NT to restore the system, the 
configuration may revert to what it was when the system was first installed. 
Rather than having to reconfigure the system and recreate all the accounts, 
you can just restore the configuration from your backup. 

If Windows NT does not start, make sure that the statements in BOOT.INI 
(found in the root directory of your system partition) refer to the correct path 
for the \ WINNT directory. 

For x86-based systems, do not delete BOOT.INI, NTLDR, BOOTSECT.DOS, 
NTDETECT.COM, or NTBOOTDD.SYS (if Windows NT is installed on a SCSI 
disk) in the root directory of the system partition. For RISC systems, do not delete 
HAL.DLL or OSLOADER.EXE in \OS\NT. If these hidden system files 'are 
deleted, the system will not start. Use the Emergency Repair disk to recover these 
files. 

If you made changes to a system that used to start Windows NT successfully 
and now doesn't start, you can return to your previous configuration and start 
Windows NT by doing the following: 

1. If your system starts both Windows NT and another operating system, press 
the SPACEBAR immediately after selecting Windows NT from the Boot Loader 
menu. If your system starts directly into Windows NT, press the SPACEBAR 

when the words "OS Loader" appear. 

A Configuration Recovery menu appears that lets you select one of the 
following choices: 

• Use Current Startup Configuration 

• Use Last Known Good Configuration 

• Restart Computer 

2. The Last Known Good Configuration is the configuration that last successfully 
started Windows NT. Select itto start Windows NT as it was before you made 
the changes that prevented it from starting. 
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If Windows NT still won't start, use the Emergency Repair disk to recover the 
system. If the Emergency Repair disk doesn't recover the system, reinstall 
Windows NT. For instructions on using the Emergency Repair disk, see 
"Repairing Your System" in Chapter 12, "System Maintenance with Windows NT 
Setup." 

Starting an Alternate Operating System 
If the alternate operating system does not start, make sure that the statements 
in BOOT.INI (found in the root directory of your system partition) specify the 
correct path for that operating system. 

The file BOOTSECT.DOS contains the boot record for the alternate operating 
system (whether or not the alternate is MS-DOS). The startup fails if the system 
cannot find BOOTSECT.DOS in the root directory of the system partition. 

If you have OS/2 Boot Manager installed on your computer and want to continue 
to use it after Windows NT installation is complete, you need to reenable it. Start 
Disk Administrator from the Administrative Tools group in Program Manager. 
Select the OS/2 Boot Manager partition, then select Mark Active from the 
Partition menu. To return to booting Windows NT, use FDISKPM in OS/2 to 
make the Windows NT partition available. 

Logging On 
There are a variety of reasons why you may not be able to log on to Windows NT. 
An administrator can use Event Viewer in Administrative Tools to look at the 
audit trail of security events to determine why you were not able to log on, and 
can use User Manager to resolve problems with your account or password. The 
Audit policies for your account must include Failure for Logon and Logoff events 
in order for such problems to be displayed in the security log. When viewing the 
security log, the administrator should filter out all events except Failure Audit. 

Some of the possible problems with logging on include the following: 

• Passwords are case-sensitive and you used the wrong case. For example, 
if your password is "Test," you cannot use a password of "TEST" to log on. 
Check that the CAPS LOCK key is not on. 

• You forgot your password. There is no way to determine your old password. 
An administrator can give you a new password. 

• Your account or your password may be expired. An administrator can 
reenable it. 
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• You were required to enter a new password, and you may have entered one 
that is less than the minimum length set for the account. Also, there may be 
a restriction on your account concerning the reuse of an old password. 

• You have reinstalled Windows NT but the domain administrator has not yet 
replaced your old computer account with a new one. Until your computer has 
a new account, you will be unable to log on to the domain. 

• Your account may be disabled. An administrator can re-enable it. 

• The workstation may be locked by a previous user. If that is the case, 
only that person or an administrator can unlock the workstation. 

• You may be trying to log on at a time during which you are not allowed. 
An administrator can set times that you are permitted to log on. 

• If you are logging on remotely from a workstation: 

• You may be allowed to log on only at certain computers. 

• You may be trying to log on to the wrong domain for your account. 

• The network may be down. 

Performance Problems 
If you experience performance problems while running Windows NT, make sure: 

• The turbo function on your computer (if present) is active. 

• The maximum system paging file size is adequate for your memory 
requirements. If its size approximates the maximum paging file size (set in 
the System option of Control Panel), consider increasing the maximum file 
size setting. 

You can improve screen display rates by decreasing video resolution. If lower 
resolution is acceptable, use Windows NT Setup in the Main program group to 
decrease your resolution. Video response depends largely on computer 
architecture and your video adapter card. 

Network Problems 
Common network problems include hardware problems with the network itself, 
incompatible protocols running on different devices in the network, duplicate 
computer names, and interrupt request (IRQ) number conflicts. There may also be 
physical problems with the cabling and other hardware that prevents the network 
from operating properly. 

If network problems persist, use Event Viewer from the Administrative Tools 
group to review the error log information generated during startup. Details in the 
system error log will reveal possible interrupt conflicts or other driver problems. 
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Duplicate Computer Names 
Each computer on a network must have a unique name.' If you specify a computer 
name that is the same as another computer on the network or the same as a 
workgroup or a domain, the network will not start when you run Windows NT. 

Network Adapter Card Settings 
If your network adapter card can accept more than one type of cable, make sure 
that the card is configured for the cable that you are plugging into it. Refer to the 
documentation that came with the card for details. 

When you configure the network adapter card, you must select the correct 
interrupt request (IRQ) number, I/O port base address, and memory buffer 
address. On older network cards, you set jumpers or switches on the card for each 
of these items; with newer cards, you can program them with the driver software 
using only the I/O port address. 

If you are not sure about which network card is installed in your computer or 
what its settings are, accept the defaults proposed by Windows NT Setup. After 
Setup is complete, you can use the Network option in Control Panel to install 
and configure network settings. For information about completing any options 
in the dialog boxes that appear during the network portion of Setup or when you 
run the Network option in Control Panel, use the Help button. 

For the correct settings for your particular hardware, see the documentation 
for your network card and other devices such as SCSI adapters, or contact your 
hardware manufacturer. 

You do not have to specify settings for built-in Ethernet capabilities on RISC­
based computers from Acer, MIPS, and Olivetti®. 

The default settings for network adapter cards in Windows NT are listed in the 
following table. 

Card name 

3Com: 

EtherLink II, 
EtherLink II I TP, 
EtherLink III 16, or 
EtherLink III 16 TP 

EtherLink® I Me 

EtherLink 16/16 TP 

Default setting 

IRQ =3 
IoBaseAddress = Ox300 
Transceiver = Internal 
MemoryMapped = Off 

Not required 

IRQ=3 
IoBaseAddress = Ox300 
Zero Wait State = Off 



Card name 

DEC: 

EtherWORKS LC 

EtherWORKS Turbo or 
EtherWORKS Turbo / TP 

IBM: 

Token Ring 16/4 

Token Ring 16/4A 

Novell : 

NE3200 

NE2000 

Proteon: 

P1390 

P1990 

SMC®/Western DigitaFM : 

8003EP 

8013EWC or 
8013WB 

8013EA 

Ungermann-Bass® : 

Ethernet NIUps (MC) or 
Ethernet NIUps/EOTP (short MC) 

Ethernet NIUpc (long) or 
Ethernet NIUpc/EOTP (short) 
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Default setting 

IRQ = 5 
Memory Address = OxDOOOO 
I/O Port Address = Primary 

IRQ =5 

I/O Port Address = Primary 

Not required 

Not required 

IRQ = 3 
I/O Port Address = 0,,300 

IRQ =5 
I/O Port Address = Oxa20 
DMA Channel = 5 
Cable Type = STP 
Card Speed = 16 

Not required 

IRQ =3 
Memory BaseAddress = OxDOOOO 
I/O Port Address = Ox300 

IRQ=3 
Memory BaseAddress = OxDOOOO 
I/O Port Address = Ox300 

Not required 

Not required 

IRQ=5 
loBaseAddress = Ox368 
MemoryMappedAddress = OxD8000 
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Network Adapter Card Interrupts 
The interrupt (IRQ) that you assign to a network adapter card should be unique; 
that is, it should not be used by any other device in the system. The standard 
assignments for IRQs in x86-based computers include the following: 

IRQ Used for 

0 Timer 

1 Keyboard 

2 (cascade) 

3 COM2/COM4 

4 COMl/COM3 

5 LPT2 

6 Floppy controller 

7 LPTI 

IRQ 

8 

9 

10 

11 

12 

13 

14 

15 

Used for 

Clock 

Math coprocessor 

Hard drive 

Secondary disk controller 

A network card should not be assigned an IRQ that is used by an active serial 
or parallel port, even if no device is currently attached to the port. Most newer 
x86-based computers let you disable the built-in serial or parallel ports. Mter 
you disable a port, you can assign its associated IRQ to another device, such as 
a network card. 

For example, if you use only a network printer you can usually disable the built-in 
parallel printer ports for both LPTl and LPT2. Network software does not use 
these interfaces when the underlying devices are redirected. 

For information on disabling serial or parallel ports, see the documentation for 
your computer. 

COMl (IRQ 4) and COM2 (IRQ 3) are usually poor choices because most 
x86-based computers come with two active serial ports. For example, a typical 
computer with a mouse on COMl and a modem on COM2 cannot use IRQ 3 or 
4 for a network adapter card. IRQ 5 is often a safe choice, because x86-based 
computers usually do not have two parallel printer ports. 

If you have two or more COM ports on your computer, you might find that a 
network adapter card (especially an EtherLink II card) will conflict with one port. 
Two common symptoms are that the workstation fails to start and that an error 
attributed to the network adapter card is logged in Event Viewer. 
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~ To change the interrupt of a network adapter card 

1. Choose the Network option in Control Panel. 

2. Double-click the correct entry in the list of Adapter Cards. 

3. In the Card Setup dialog box, change the interrupt number from 3, 
for example, to an available interrupt, such as 5 or 10. 

Make sure that the interrupt you choose is not being used by another device. 

Assigning I/O Port Base Addresses 
Most devices have unique default I/O port base addresses. In the rare case that 
an I/O port appears to be in conflict, it can usually be moved to another setting 
without harm. The following table shows some common I/O port addresses: 

I/O address 

3F8 

3BC 

378 

Used for 

COMl 

LPTl 

I/O address 

300 

2F8 

278 

Used for 

COM2 

LPT2 

Refer to the documentation for your network adapter card and other hardware 
devices to find what I/O addresses are required for your system. 

Assigning Memory Buffer Addresses 
No two devices can share memory buffers. Make sure that the network adapter 
card buffer address is not already used by another device, such as a SCSI adapter 
card or hard disk controller. Check the installation guide for your computer or 
peripherals to verify the setting of the memory buffer address. 

Some SCSI and network adapters use conflicting memory addresses, such as an 
Adaptec™ or Future Domain SCSI adapter and a DEC EtherWORKS Turbo TP 
network adapter. This requires reconfiguring the hardware by changing jumpers. 

You can use the Microsoft Diagnostics program (WINMSD.EXE) installed with 
Windows NT to check how memory buffers are being used. 
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Services or Subsystems Not Starting 
If services or subsystems do not start properly, use the Services and Devices icons 
in Control Panel to check their status. You can try to start them with those icons. 
Check the system log in Event Viewer for entries relating to the problem. 

Removing an NTFS Partition 
If Windows NT is not installed on an NTFS partition, you can use the format 
command from a Windows NT command prompt to reformat your NTFS partition 
to another file system. 

If Windows NT is installed on an NTFS partition and you want to remove the 
partition, do the following: 

1. Restart your system using Windows NT Setup. For example, with your 
computer turned off, insert Windows NT Setup Disk 1 in drive A and turn 
on your computer. 

2. Follow instructions until the screen appears that asks whether your want to 
install Windows NT on a particular partition, or want to create or delete a 
partition. Highlight the NTFS partition and type p to delete it. 

3. Either continue installing Windows NT or press F3 to exit the Setup program. 
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Installing Windows NT 

This chapter describes Windows NT Setup, the program you must use to 
install Windows NT on your computer. Setup copies the appropriate files to 
your computer's hard disk, and then configures the software you need to run 
applications and use the network with Windows NT. 

Topics in this chapter include the following: 

• Things you should know before running Setup 

• How to start Setup on an x86-based and on a RISC-based computer 

• Choosing Express or Custom Setup 

• Using Setup to prepare your computer for Windows NT, including 
creating disk partitions and formatting the partition that will contain 
the Windows NT files 

• How to create a sharepoint for network installations of Windows NT 

To check disk space requirements for installing Windows NT, see "System 
Requirements" in the "Welcome" chapter. If you have problems installing 
Windows NT, see Chapter 18, "Troubleshooting." 
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484 System Guide 

Things You Need to Know Before Running Setup 
Note This software is protected by United States copyright law. Copying is 
permitted only in accordance with the license agreement. 

Whatever kind of computer you have, you should know the following before you 
start installing Windows NT. If you do not know these items, ask your network 
administrator. 

• If your computer will use a network, the name of your computer and the name 
for the workgroup or domain that this computer will join. 

A computer name can be any name you invent as long as it is not the same 
as any other computer, workgroup, or domain name on the network. For more 
information on selecting a workgroup or domain name, see "Joining a 
Workgroup or Domain," later in this chapter. 

• If you have a printer connected directly to your computer, the printer model 
and porte s) used by the printer. 

• The type of network adapter in your computer, the card's interrupt request 
(IRQ) number, base I/O address, and other settings. Windows NT Setup 
suggests default values for these settings. See the documentation for your 
network adapter card to confirm these default settings. 

You also need to set aside a high-density floppy disk of the correct size for disk 
drive A. This disk, which does not need to be formatted in advance, should be 
labeled Emergency Repair disk and set aside until Setup prompts you to insert it. 

Note You may experience difficulty creating the Emergency Repair disk if 
your A drive is a 2.88 MB drive and you supply a disk formatted to 2.88 MB. 
If so, supply a disk formatted for 1.44 MB. 

For information about using the Emergency Repair disk, see "Repairing Your 
System" in Chapter 12, "System Maintenance with Windows NT Setup." 

Unless you are installing Windows NT on a new computer, you are upgrading 
an existing system to use Windows NT. You can preserve your existing operating 
system and install Windows NT, provided you make certain decisions about 
partitioning and formatting your disk while running Setup. For information on 
maintaining your existing operating system, see "Preparing the Computer for 
Windows NT," later in this chapter. 

Upgrading from Windows NT to Windows NT Advanced Server requires 
reinstalling the operating system. 
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Starting Setup on an x86-Based Computer 
How you start Windows NT Setup for an x86-based computer depends on the 
source media you are using to install Windows NT. The options include installing 
from floppy disks or installing from a compact disc drive. 

Note If you have only a 5.25-inch floppy drive, and you cannot install Windows 
NT from a CD-ROM or network share, order 5.25-inch Setup disks using the 
fulfillment coupon at the back of this manual. 

For an x86-based workstation, you can also install Windows NT over the network 
or from a CD-ROM device that is supported under MS-DOS but not under 
Windows NT. Check the hardware compatibility list in your Windows NT 
package to see whether your CD-ROM device is supported. 

You cannot place Windows NT on a partition configured with any disk 
compression products. 

t> To install Windows NT from floppy disks 

1. With your computer turned off, insert Windows NT Setup Disk #1 in drive A, 
and then turn on your computer. 

(Two versions of Setup Disk #1 are provided: one for 5.25-inch A drives 
and one for 3.5-inch A drives.) 

2. Follow the instructions on screen to complete Setup. 

If you are using a CD-ROM to run Setup, make sure that your SCSI CD-ROM 
drive is not set to ID 0 or 1. For information, see your hardware documentation. 

t> To install Windows NT from a SCSI CD-ROM drive 

1. Insert the floppy disk labeled "Setup Disk for CD-ROM Installation" 
in drive A, and then turn on your computer. 

2. When Setup asks for the Windows NT compact disc, insert it in the 
CD-ROM drive. 

3. Follow the instructions on screen to complete Setup. 

You perform the following procedures from the local computer where 
you want to install Windows NT. 
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You can install Windows NT on multiple x86-based computers by first installing 
the Windows NT files in a shared directory on a network server, and then 
installing Windows NT on each workstation using WINNT.EXE. 

You can also use this method to install Windows NT on x86-based computers 
with SCSI or CD-ROM devices that are supported under MS-DOS but are not 
supported by Windows NT. You cannot use this method to set up Windows NT 
on RISC-based computers. 

I> To install Windows NT from the network or an unsupported CD-ROM 
device 

1. Use your existing MS-DOS-based network software to connect to the shared 
network directory that contains the WINNT.EXE program. 

Or, if you have an unsupported local CD-ROM device, insert the Windows NT 
compact disc in the drive, and then, while running MS-DOS, change to the 
<cd .. drive>:\1386 directory on the CD-ROM drive. For example, if the CD­
ROM is drive E, change to the E:\I386 directory. 

2. At the MS-DOS command prompt, type winnt and press ENTER. 

3. When you are asked to confirm the Windows NT source directory, type the 
path for the directory where the WINNT.EXE program is stored (the same 
directory you specified in step 2). 

4. When prompted, insert a blank formatted high-density floppy disk into 
drive A. 

Mter the necessary files are transferred, a message asks you to press ENTER 

to restart the computer. 

5. Follow the instructions on screen to complete Setup. 

Make sure you keep the Setup and Emergency Repair disks WINNT.EXE 
creates during installation. If you have problems with your installation, 
you will need both of these disks to run the Repair program. 

For complete details about setting up a network sharepoint to install 
Windows NT, see "Setting Up Windows NT Master Files on a Server," 
later in this chapter. 
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Starting Setup on a RISC·Based Computer 
Before you can run Windows NT Setup on an ARC-compliant RISC-based 
computer, you must first read the manufacturer-supplied instructions for starting 
programs from CD-ROM or disk. How you start Windows NT Setup depends on 
the type of RISC-based computer you are installing on. Once Windows NT Setup 
starts, you can follow the instructions on screen. 

The following sample procedure for starting Windows NT Setup is typical 
of many (but not all) RISC-based computers. 

1. Insert the Windows NT compact disc in the CD-ROM drive. 

2. Restart your computer. 

3. At the ARC screen, choose Run A Program from the menu. 

4. At the prompt, type cd:\mips\setupldr and press ENTER. 

For some systems, you might need to supply a full device name instead 
of typing cd:. See your hardware documentation for details. 

5. Follow the instructions on screen. 

These instructions assume that your hard disk has been initialized and at least 
partially partitioned. The system partition-the partition that has the hardware­
specific files needed to load Windows NT -must be a FAT partition of at least 
2 MB. On a RISC-based computer, the system partition is the disk partition that 
contains the hidden files OSLOADER.EXE and HAL.DLL in the subdirectory 
\OS\NT. If the system partition is large enough, it can also contain Windows NT, 
or you may choose to use a separate partition. If your hard disk does not include 
a system partition, refer to your manufacturer-supplied instructions for 
creating one. 

Choosing Express vs. Custom Setup 
Early in the Setup process you must choose to use Express or Custom Setup. 
Express Setup is the easiest way to install Windows NT and is recommended 
for most standard installations. Express Setup asks you the minimum number 
of questions and installs all optional Windows NT components. It automatically 
configures your mouse, display adapter, and other components. 
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Custom Setup is designed for experienced users who want or need more control 
over how Windows NT is installed on their computers. With Custom Setup, you 
can override default values or accept recommended settings for the following: 

• The display adapter, mouse, keyboard, and keyboard layout 

• The specific Windows NT components you want to install, and the existing 
applications you want to set up to run with Windows NT 

• The virtual memory settings and local printer connections for your computer 

• Any additional network adapters or other network components you want to 
install and configure during Windows NT Setup 

If you want to make changes to your hardware after running Setup, use Control 
Panel or the Windows NT Setup icon in Program Manager to change the system 
configuration. For information, see Chapter 12, "System Maintenance with 
Windows NT Setup." 

Preparing the Computer for Windows NT 
After you choose Express or Custom Setup, you must make some basic decisions 
to prepare your computer for Windows NT. 

When you install Windows NT, the installation program checks to see whether 
a previous version of Windows is installed on the computer. If it is, you should 
install Windows NT in the same directory as the previous version of Windows. 
This allows Windows NT to configure the Windows environment based on the 
existing environment and to support all the features of currently installed 
Windows 3.1-based applications. 

If you do not install into an existing Windows directory, Setup asks you to 
choose one of the following options: 

• Install Windows NT on an existing partition. 

• Create or delete disk partitions, and then select the partition that will contain 
the Windows NT system files. 

After you choose the partition on which to install Windows NT, Setup asks 
whether you want to convert that partition to the Windows NTfile system (NTFS) 
or keep the existing file system. 

The choices you make may depend on whether you want to preserve an existing 
operating system and whether you want to take advantage of the security features 
available with NTFS. The rest of this section guides you through making these 
decisions. 
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Specifying the Disk Partitions 
A partition can be any size from 1 MB to the entire hard disk. But the partition 
where you plan to store Windows NT files must be on a permanently attached 
hard disk and must have enough unused disk space (for more information, see 
the section called "System Requirements" in "Welcome"). 

The system partition is the partition that has the hardware-specific files needed 
to load Windows NT. On an x86-based computer, the operating system starts 
from the active system partition on the first internal hard disk. This means that 
Windows NT looks for certain files in the root directory of the C drive (Disk 0) 
when you start your computer. This partition must be formatted with either the 
NTFS, FAT, or HPFS file system for Windows NT to start. It must be formatted 
with the FAT file system if you want to run both Windows NT and MS-DOS. 

A RISC-based computer can have several system partitions that are configurable 
by the manufacturer's configuration program, and each system partition must be 
formatted for the FAT file system. If you want to use NTFS, you need to create 
at least one FAT system partition of at least 2 MB plus a second partition large 
enough to contain all the files you want to protect with NTFS. For information 
about setting up more than one system partition on a RISC-based computer, see 
your hardware documentation. 

Caution If your hard disk contains stripe sets, volume sets, or mirrors, these 
elements appear on the Setup screen as "Windows NT Fault Tolerance." Be 
careful not to delete any of these elements. (For more information, see Chapter 
16, "Disk Administrator.") Also, do not delete partitions that contain data you 
want to keep. 

The following are guidelines for making decisions about your hard disk partitions. 

If you will use only the Windows NT operating system: 

• On a new x86-based computer, make a single partition and format it with 
NTFS, as described in the following section. 

• On an existing system that contains files you want to keep, maintain all 
existing partitions. You can place the Windows NT files on any partition 
with sufficient free space. 
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If you want to use another operating system such as MS-DOS in addition to 
Windows NT: 

• Make sure the system partition (the C drive) is formatted with the appropriate 
file system. For example, if you already have MS-DOS installed and want to 
keep it, preserve the C partition and keep the file system as FAT. You can 
place the Windows NT files on any partition with sufficient free space. 

• To use NTFS and have access to another operating system, you must have at 
least two disk partitions. Format the C drive with a file system that Windows 
NT and your other operating system can use, such as FAT. Format the other 
partition for NTFS. You can place the Windows NT files on any partition 
with sufficient free space. 

Note If you are installing Windows NT on a computer currently configured 
to start either OS/2 or MS-DOS using the boot command, Windows NT Setup 
sets up your system so that you can run Windows NT or whichever of the two 
operating systems (MS-DOS or OS/2) you last started before running Windows 
NT Setup. 

If you have OS/2 Boot Manager installed on your computer and want to continue 
to use it after Windows NT installation is complete, you need to re-enable it. Start 
Disk Administrator from the Administrative Tools group in Program Manager. 
Select the OS/2 Boot Manager partition, and then select Mark Active from the 
Partition menu. 

Selecting a File System for the Windows NT Partition 
Windows NT can use anyone of three file systems: the Windows NT file system 
(NTFS), the file allocation table (FAT), or the high-performance file system 
(HPFS).You can set up Windows NT on a partition with an existing file system, 
or you can choose to use a new file system. You can format a partition for NTFS 
or FAT during Setup. Setup cannot format a partition for HPFS. 
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The following notes will help you choose how to format or convert the partition 
where the Windows NT files will be stored: 

• For an unformatted partition, you can choose to format it with either the NTFS 
or FAT file system. Choose the FAT option if you want to access files on that 
partition when running MS-DOS or OS/2. Choose the NTFS option if you will 
use only Windows NT to access files on that partition. 

• For an existing partition, you probably want to choose the default option, 
which is to keep the current file systems intact, preserving all existing files on 
that partition. You can convert FAT or HPFS partitions to NTFS after running 
Setup. 

• You can choose to convert an existing partition to NTFS so you can use 
Windows NT security. This preserves existing files, but only Windows NT 
has access to files on that partition. 

• You can choose to reformat an existing partition to either the NTFS or FAT 
file system, which erases all existing files on that partition. If you choose to 
reformat the partition as NTFS, only Windows NT will have access to files 
created on that partition. 

Note The choices you make at this step are not final. After running Setup, you 
can change file systems on any partitions. However, to preserve data, you cannot 
convert an NTFS partition to any other file system without backing up all the 
files, reformatting the partition (which erases all files), and then restoring the files 
from the backup. You must also back up data before repartitioning a hard disk. 

Also, if you choose to convert the file system on an existing partition to NTFS, 
the conversion does not take place until all of Setup is complete and you first 
start your computer with Windows NT. So if you quit Setup before it is finished 
running, the file system on that partition is not converted. 
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The following table summarizes the advantages and disadvantages of each of the 
three file systems that Windows NT can use. 

Advantages 

Windows NT file system (NTFS): 

Supports complete Windows NT security, so you can 
specify who is allowed various kinds of access to a file 
or directory. 

Keeps a log of activities to restore the disk in the event 
of power failure or other problems. 

Supports file and directory names of up to 256 characters, 
and supports extended file attributes. Automatically 
generates correct MS-DOS filenames so that files can 
be shared with MS-DOS users. 

Allows a program designed to run under other operating 
systems such as MS-DOS access to NTFS files when it 
runs under Windows NT. 

File allocation table (FAT): 

Allows access to files when your computer is running 
another operating system, such as MS-DOS or OS/2. 

FAT is the most widely used file system for PCs. 

Enables you to share data on the partition with MS-DOS. 

High-performance file system (HPFS/HPFS386): 

Ensures file compatibility if you want to switch between 
Windows NT and OS/2 on your hard disk. 

Supports long filenames. 

Provides better error correction than does the FAT file 
system. 

Disadvantages 

Recognized only by Windows NT. When the 
computer is running another operating system (such 
as MS-DOS or OS/2), that operating system cannot 
access files on an NTFS partition. 

If drive C is formatted for NTFS, you cannot run 
MS-DOS from your hard disk. (But you can still run 
MS-DOS-based applications using Windows NT.) 

Files are not protected by the security features of 
Windows NT. 

Files are restricted to 8-character filenames with 
3-character filename extensions. 

Cannot support extremely large files. 

Less robust than NTFS; for example, no automatic 
disk restore features. 

Has not been widely adopted. 

Files are not protected by the security features of 
Windows NT. 

MS-DOS and Windows 3.1-based applications cannot 
access files with long filenames or with long directory 
names in their paths. 
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Selecting a Directory for Windows NT Files 
Setup next proposes to install the Windows NT files in the \ WINNT directory. 
You can accept the directory name that Setup suggests or type the directory name 
you prefer. We recommend that you accept the proposed directory. 

If Setup detects a version of Windows NT in the directory where you choose to 
place the new Windows NT files, it asks if you want to choose another directory. 
If so, Setup automatically configures your computer so that you can run either 
version of Windows NT. If you install Windows NT into a directory which 
contains a previous installation of Windows NT, Setup overwrites the earlier 
version. 

Configuring Windows NT 
After Setup copies several basic files, you will see the Windows NT logo for 
the first time, and then all subsequent requests for information will appear in 
Windows NT dialog boxes. You can use standard Windows keyboard and mouse 
techniques for all actions during this part of Setup, as described in Chapter 2, 
"Windows NT Basics." You can also press Fl for context-sensitive Help at 
any time. 

For either Express or Custom Setup, you must next supply the following 
information: 

a A name that Windows NT will use to identify you for various operations. 
You must type in a response and verify your response for Setup to continue. 

• A name that will identify your computer on the network. This name must be 
15 characters or fewer and must not be the same as any other computer name, 
domain name, or workgroup name on the network. You can invent a computer 
name, or ask your network administrator if a specific name has been assigned 
for your computer. If you need to change the computer name after Setup is 
completed, choose the Network icon in Control Panel. 

• The local language, or locale, that you want to use. This setting affects, for 
example, the format Windows NT uses to display the date, time and currency. 
If you want to change the language after Setup is complete, choose the 
International icon in Control Panel. For information, see Chapter 5, "Control 
Panel." 
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Setting Up a Local Printer 
For both Express and Custom Setup, you can set up a printer that is connected 
directly to your computer. 

If you don't have a printer connected to your computer, choose Cancel when the 
Printer Setup dialog box appears. After you install Windows NT, you can choose 
the Print Manager icon in Program Manager to set up network printers or change 
the printer configuration after completing Setup. For information about 
configuring and using printers, see Chapter 6, "Print Manager." 

Setting Up a Network Adapter Card 
For Express Setup, Windows NT Setup automatically checks for a network 
adapter card in your computer and installs the first one it recognizes. Some types 
of network cards may not be recognizable by Setup. If Express Setup cannot 
identify your adapter card, it asks if you want to install Microsoft Remote Access 
Service (for users connecting to a network over telephone lines). If you do not 
choose to install Remote Access Service, Setup displays the Network Adapter 
Setup dialog box and asks you to select from a list the name of the card you 
want to install. 

Express Setup installs only one network adapter card. If you have additional 
adapter cards, you can install them after running Setup by choosing the Network 
icon in Control Panel. 

Custom Setup uses the following steps to install a network adapter card: 

1. Setup asks if you want it to detect the network card in your computer. 

If you choose detection, Setup searches for a recognizable network adapter 
card (see step 2). If you reject detection, Setup displays the Network Adapter 
Setup dialog box and asks you to choose an adapter card name from a list. 

2. If you choose detection, Setup looks for a network adapter card and stops at 
the first one it finds. It identifies the card and asks you to choose one of three 
options: 

• You can accept the identified network card, in which case Setup installs 
it for you (see step 3). 

• You can select Find Next, which causes Setup to search for another 
network adapter card. 

• You can choose Do Not Detect, which causes Setup to discontinue 
detection and display the Network Adapter Setup dialog. 
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If Custom Setup cannot identify an adapter card to install, or if you do not 
choose any of the detected cards, Setup informs you that there are no more 
network cards and asks you to choose Detect to try again or Continue. If you 
choose Continue, you have the option of installing Microsoft Remote Access 
Service or of manually selecting an adapter card. 

3. If you accept the card that Setup detects, Setup installs and configures it and 
then displays a dialog box with the adapter card settings. We recommend that 
you accept these settings unless you are absolutely sure they are incorrect, 
in which case you can change them and then choose OK. 

4. If Setup cannot completely validate adapter card settings or if potential 
hardware conflicts exist, Setup warns you and allows you to change the 
settings. 

After Custom Setup installs your adapter card and other system software, the 
Network Settings dialog box appears so that you can install additional network 
cards and software. 

Both Express and Custom Setup detect only one network adapter card. 

If Setup cannot detect your network adapter card, or if you choose to bypass 
detection with Custom Setup, Setup allows you to select a specific network 
adapter card to install. 

Configuring the Network Adapter Card 
After Setup installs a network adapter card, it may display an Adapter Card Setup 
dialog box, so you can select the correct interrupt request (IRQ) number, I/O base 
port address, memory buffer address, and other settings. For many adapter cards, 
the settings are configured automatically so you don't have to identify settings. 

If you are an experienced user and know that you need to change adapter card 
settings, see the documentation for your network adapter card or ask your network 
administrator for the correct values. 

For Custom Setup, the Network Settings dialog box appears so that you can 
install additional network cards and supporting software. If you choose to install 
additional network components, you might be asked to insert additional disks 
supplied by the component manufacturer. For information- about completing 
the options in the Network Settings dialog box, choose the Help button. 
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JOining a Workgroup or Domain 
After you enter choices for the network configuration settings, Setup copies 
a large set of files and attempts to start the network. Then Setup displays the 
Domain Settings dialog box. 

• If Setup successfully started the network, you can specify whether this 
computer is a member of a workgroup or a Windows NT Advanced Server 
domain. 

• If the network did not start, you can accept or change the Workgroup entry 
in this dialog box, and then choose OK to continue Setup. 

In Windows NT, a workgroup is a collection of computers that appears, for 
convenience, under the same workgroup name when you browse network 
resources. Any computer can join any single workgroup. 

Belonging to a common workgroup is a way for coworkers to quickly find each 
other's computers on the network. When you browse the network, the names of 
all the computers in your workgroup appear first in the browsing directory. 

You can join an existing workgroup, or create a new one simply by typing in 
another name. Windows NT Setup will accept any workgroup name you choose, 
including the default WORKGROUP. 

A domain is a collection of computers defined by the administrator of a 
Windows NT Advanced Server network. A domain provides the same 
convenience for network browsing and also provides access to the centralized 
user accounts and group accounts maintained by the domain administrator. 

Unlike a workgroup, a domain must already exist for you to join it. Joining 
a domain also requires that the domain administrator add an account for your 
computer to the domain. 

If you do not know the precise domain name for your computer and you want 
to finish running Setup without this information, you can select the Workgroup 
option and then type any workgroup name. Mter running Setup, you can choose 
the Network option in Control Panel to join a domain or to change the workgroup 
name. 

Note If you are reinstalling Windows NT on a computer that belongs to a 
domain, you must ask your network administrator to delete your computer 
account and create a new one. Otherwise, you will not be able to log on to 
the domain after the second installation. 
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Setting Up a Local Account 
For both Express and Custom Setup, you are asked to provide a unique name for 
setting up a local user account if your computer is not a member of a Windows 
NT Advanced Server domain. This information is used for identification every 
time you log on to Windows NT. You can choose to cancel this dialog box and 
then set up a local account later using User Manager. 

If you set up a local account, this account automatically becomes a member of 
the Administrators group. For information on setting up groups, see Chapter 13, 
"User Manager." 

~ To set up a local account 

1. In the User Name box, type a unique name of 20 or fewer characters that does 
not include spaces. 

This name is used to identify your user account whenever you log on to 
Windows NT. For example, if your name is Annie Pearson, you might want to 
choose "anniep" or some other derivative of your full name. This name should 
be unique on the network so as to avoid addressing conflicts. 

2. In the Password box, type a unique name of 14 or fewer characters that does 
not include spaces, and then retype the password in the Confirm Password 
box. 

For security, neither the original nor the confirmation you type appear in the 
dialog box. 

If you do not want a password for this user account, leave the Password and 
Confirm Password boxes blank. 

Note Passwords are case-sensitive. This means that Windows NT identifies 
"mypassword" and "MyPassWord" as different passwords. 

3. Choose the Continue button. 
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Setting Up Virtual Memory 
Windows NT creates a special file on your hard disk called a paging file. The 
paging file makes it seem like your computer has more memory to run programs, 
because Windows NT can temporarily swap the contents of memory used by one 
program to the hard disk so that another program can use that memory. 

For Express Setup, all virtual-memory settings are configured automatically. 
For Custom Setup, you can change the size of the virtual-memory paging file or 
the drive where the file is stored. We recommend that you accept the proposed 

. settings unless you are an experienced Windows NT user. If you want to change 
the location or size of this file or create other paging files after Setup is complete, 
choose the System icon in Control Panel. For more information, see "Defining 
Options for the Operating System" in Chapter 5, "Control Panel." 

Setup will create a paging file on the indicated 
drive. Windows NT uses the paging file to 
temporarily store information that was taking 
space in memory. 

Virtual Memory Settings --------, 

Q.rive: I C: I :!I 
Space Available (MB): 
Minimum Size (M B): 
Recommended Size (MB): 

~ize Chosen (M B): 

96 
10 
27 

IPdJ I ::::'::::<.~M 

I" Continue 

Setting Up Applications to Run from Program Manager 
The easiest way to run programs in Windows NT is to choose program-item icons 
in Program Manager. The easiest way to create the program-item icons is to have 
Windows NT Setup create them for you. 

If you are installing Windows NT in a directory containing a version of 
MS-DOS-based Windows, Setup automatically installs all of your existing 
Windows groups, and you do not have to make choices during this part of Setup. 
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Completing Setup and Starting Windows NT 
~ To complete Setup and start Windows NT 

1. When Setup is finished running and the message asks you to restart your 
computer, remove any disks from the floppy disk drives and choose the 
Reboot button. 

2. When the boot loader menu appears, press ENTER. 

3. When the Welcome logon message appears, press CTRL+ALT+DEL to log on. 

~ Press Ctrl .. AU .. Del to log on 

4. In the Welcome dialog box, type and confirm your password, and then choose 
the OK button. 

Passwords are case-sensitive, which means that Windows NT identifies 
"mypassword" and "MyPassWord" as two different entries. 

Caution For an x86-based computer, the following files are copied to the root 
directory on the C drive: BOOT.INI, BOOTSECT.DOS (if another operating 
system is on your computer), NTLDR, and NTDETECT.COM. Also, the 
NTBOOTDD.SYS file is copied if you install Windows NT onto a SCSI disk. 
These files should never be deleted because your system will not start without 
them. 

For a RISC-based computer, HAL.DLL and OSLOADER.EXE are copied to the 
\OS\NT directory on your system partition. These files should never be deleted. 

Note that these files are all read-only, hidden system files. 



500 System Guide 

Migrating Windows 3.1 Settings 
If you installed Windows NT into an existing Windows 3.1 directory (including 
Windows for Workgroups), you have the opportunity to migrate a portion of 
your Windows 3.1 settings when you first log on as a new user (this option is not 
available for the Administrator user name). If you choose to preserve Windows 
3.1 system and program settings, Windows NT migrates: 

• Settings for your Windows-based applications. 

• All program groups that do not already exist in Windows NT. For example, a 
program group named "Spreadsheets" would migrate while the Main program 
group would not. All new program groups migrate as icons. 

• File associations. 

• Information used for object linking and embedding. 

• Desktop configuration settings, with the exception of screen savers. 

The location of each program group icon, and the location of each group window 
when the icon is opened remains'the same, except if Windows NT and Windows 
3.1 display resolutions differ. 

Setting Up Windows NT Master Files on a Server 
This section is written for the administrator responsible for installing Windows· 
NT on multiple computers. This section assumes that you have already installed 
Windows NT on a single computer and are familiar with Windows NT commands 
and procedures. 

You can install Windows NT on multiple x86-based computers by first installing 
the Windows NT files in a shared directory on a network server, and then 
installing Windows NT on each workstation using WINNT.EXE. 

You can also use this method to install Windows NT on x86-based computers 
with SCSI or CD-ROM devices that are supported under MS-DOS but are not 
supported by Windows NT. You cannot use this method to set up Windows NT 
on RISC-based computers. 

Important Every Windows NT user must have a Windows NT license, which 
is obtained by buying a retail package or a Microsoft License Pack. For more 
information on restrictions, see your Windows NT license agreement. 
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To use WINNT.EXE, you must first install the Windows NT master files in a 
shared directory on the network. You can set up the sharepoint using any type of 
network, such as Microsoft LAN Manager 2.1, Novell NetWare, Banyan VINES, 
or others. The directory containing the Windows NT files must be accessible from 
MS-DOS to all users who will be using WINNT.EXE. 

Note If the majority of users do not have CD-ROM drives, it is best to create 
Windows NT setup shares using floppy disks rather than the CD-ROM. To 
restore corrupt files using the Emergency Repair disk created by WINNT.EXE, 
users need the Setup disks or CD-ROM used to install the original Windows NT 
network share. If you create setup shares using floppy disks, users who installed 
using WINNT.EXE will be able to restore corrupt files without attaching a 
CD-ROM drive. 

Before you can install the master Windows NT files on a network: 

• You must already be running Windows NT on the computer from which 
you are installing the master files. 

• The network must be operational. 

• You must have read-write permission to the network directory where you want 
to install the Windows NT files, and other users must have read access to that 
directory. For more information, see your network software documentation. 

Important Do not use the MS-DOS or OS/2 copy command, the MS-DOS xcopy 
command, or the Copy command in File Manager to install Windows NT files on 
a network server. You must use the Windows NT setup command. 

t> To install the master Windows NT files on a network server 

1. From either a workstation or a server, log on to Windows NT and connect 
to the drive where you want to install the Windows NT master files. 

2. Create the directory on the network drive that will contain the Windows NT 
master files. 

3. In Program Manager, choose the Command Prompt icon to open a Windows 
NT command prompt window. 

4. At the command prompt, type setup -n -i initial.inf -s source -d destination 
and press ENTER. 

The switches -n, -i, -s, and -d must always appear in this order. 
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The switches for the setup command are described in the following table. 

Setup command switch 

-n 

-ifilename 

-s source 

-d destination 

For example, type: 

Meaning 

Specifies that the files are copied to a network sharepoint 

Specifies the .INF file to be used from the Windows NT 
Setup working directory 

Indicates the drive and directory that contains the original 
Windows NT Setup disks 

Indicates the network drive and directory where you 
want to copy the Windows NT master files 

setup -n -i initial.inf -s f:\i386 -d x:\ntadmin 

to install the Windows NT files from CD-ROM drive F to network drive X, 
which contains the directory \NTADMIN. 

Or type: 

setup -n -i initiaJ.inf -s a:\ -d x:\ntadmin 

to install Windows NT files from your floppy drive A to network drive X. 
Setup will prompt you to insert a disk for CD-ROM or floppy disk installation, 
depending on the original setup media. 

5. In the Group Information dialog box, type the workgroup name and the name 
of your company, and then choose the Continue button. 

Each name can be no longer than 31 characters. 

6. In the next Setup screen, verify the information, and then choose the Continue 
button. 
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APPENDIX A 

Network Protocols 

Network protocols can be compared to spoken language. A network protocol is 
a set of rules that allows computers on a network to communicate with each other. 
Two computers must use the same network protocol (speak the same language) 
to communicate. 

This appendix provides a brief overview of network protocols and installation 
and configuration information for the four Windows NT protocols and two 
TCP/IP-based network services: 

• NetBEUI 

• Data link control (DLC) 

• NWLink IPX/SPX compatible transport 

• TCP /IP protocol 

• Simple Network Management Protocol (SNMP) service 

• FTP Server service 
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Overview 

NetBEUI 

Choosing the protocol or protocols to use in a network requires evaluating 
several elements of the network, such as the number and types of computers in 
the network, special hardware or software in use in the network, and compatibility 
and integration into existing networks. If you are going to set up a local area 
network and do not have an experienced network administrator, it is suggested 
you have an understanding of all the complex elements of a local area network 
before attempting to install one. 

If you are establishing a small, isolated network, you should probably use 
NetBEUI, the Windows NT protocol automatically installed on all computers. 

If you are in a large network, the network administrator will have determined the 
network protocol to use based on network components and your company's 
requirements. 

Protocols communicate through other layers of software that control the flow of 
information. How network protocols and other layers of network software work 
together is determined by network bindings. Windows NT automatically binds 
network protocols to all appropriate layers. For more information about installing 
network software and configuring network bindings, see "Installing Network 
Software" in Chapter 5, "Control Panel." 

The NetBIOS extended user interface (NetBEUI) is a small, efficient, and fast 
protocol optimized for very high performance in smaller LAN s or LAN segments; 
for these environments, NetBEUI is the fastest protocol shipped with Windows 
NT. NetBEUI is self-configuring and self-tuning. 

NetBEUI is installed and bound to a network adapter card automatically when 
Windows NT is installed. You cannot prevent NetBEUI from installing on a 
Windows NT computer. If you will not use the NetBEUI protocol, you can 
remove the protocol to save system resources using the Network option in Control 
Panel. For information about removing or reinstalling the NetBEUI protocol, see 
"Installing Network Software" in Chapter 5, "Control Panel." 



OLe 

NWLink 

Appendix A Network Protocols 505 

The data link control (DLC) protocol is used primarily to access IBM® mainframe 
computers or printers attached directly to the network (instead of to a port on a 
print server). This protocol isn't used for general networking on Windows NT. 

To connect to and communicate with a mainframe computer, the DLC protocol 
must be installed and running. You use a terminal emulator, such as the 3270 
Emulator in the Accessories Group, to access a mainframe computer. 

To print to printers attached directly to the network, the DLC protocol must be 
installed and running on the print server for the printer. Computers sending print 
jobs to a printer using DLC do not need the DLC protocol-only the print server 
requires D Le. 

Install DLC using the Network option in Control Panel. For more information 
about installing the DLC protocol, see "Installing Network Software" in Chapter 
5, "Control Panel." 

The NetWare Link (NWLink) protocol is an implementation of the IPX, SPX, 
and NetBIOS protocols used in Novell NetWare networks. 

This section first provides background material on basic concepts and the 
information you need before installing Microsoft NWLink. The section then 
describes how to install and configure NWLink. 

This section assumes you are familiar with Novell networks and the IPX/SPX 
protocol. You should be familiar with implementing the IPX/SPX protocol before 
installing the NWLink protocol. 

What Is NWLink? 
NWLink provides communication between a Windows NT computer and either 
another Windows NT computer or a NetWare workstation. Two networking 
Application Programming Interfaces (APIs) are supported to allow this: 

• Windows Sockets 

• NetBIOS 

The Windows Sockets interface is ideal to support existing NetWare applications 
written to comply with the NetWar~ IPX/SPX Sockets interface. The Windows 
NT computer acts as an application Iserver responding to the IPX or SPX packets 
sent to or received from MS-DOS, Windows, or OS/2 NetWare workstations. 
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For example, SQL Server running on Windows NT takes advantage of the 
Windows Sockets interface to SPX to allow existing NetWare SQL Server 
clients to communicate with the server that is listening to requests via the 
Windows Sockets interface. 

The NetBIOS support can be used to send and receive Novell NetBIOS packets 
between a NetWare workstation running Novell NetBIOS and a Windows NT 
computer, or between two Windows NT computers. You will see a significant 
performance gain where all computers are Windows NT computers because of 
Microsoft enhancements to the Novell NetBIOS protocol. 

The Microsoft-enhanced Novell NetBIOS protocol not only conforms to the 
standard single request/reply implementation, but also automatically takes 
advantage of the knowledge that it is conversing with another computer that 
understands the enhancements. The enhancements improve efficiency by 
allowing the sender to send multiple NetBIOS packets before receiving an, 
acknowledgment (a sliding window) as well as supporting the piggybacking of 
NetBIOS acknowledgments. NetBIOS acknowledgments are sent by the receiver 
after receiving the last packet of a NetBIOS message. In the common scenario 
in which the sender and receiver are participating in two way traffic, allowing 
piggybacking of acknowledgments saves network bandwidth, as well as 
processing time on the computers, since a separate acknowledgment frame 
need not be processed and sent. 

The implementation on Windows NT separates the Novell NetBIOS component 
from the IPX/SPX component. NWLink refers to IPX/SPX, and NWNBLink 
refers to the Microsoft-enhanced implementation of Novell NetBIOS. 

As shown in the following illustration, NWLink supports a wide variety of 
application interfaces. 

Windows NT 
redirector 

Windows NT 
server 

Microsoft RPC 
applications and 
SQLServer 

Windows 
Sockets driver 

TDI interface 

STREAMS 

NWLlNK II 

NetBIOS applicationsl 
NetBIOS OLL 

TCP\IP 

NetBIOS 
driver 

I 
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How Does NWLink Work? 
Similar to the Windows NT TCP/IP implementation, NWLink is a STREAMS 
based protocol. STREAMS is a protocol interface and environment originally 
developed for UNIX systems that standardizes communication with adjacent 
software layers. Because the STREAMS environment supports the transport 
driver interface (TDI) at the top, and the network driver interface specification 
(NDIS) on the bottom, NWLink can seamlessly coexist with other protocols on 
the same network adapter as shown in the following illustration. 

Application 

Presentation 

Session 

Transport 
STREAMS 

NetBEUI ~ NWLlNK TCP/IP 
Network 

Data Link 

NOIS interface 

Network card driver 

Physical Network adapter card 

Installing and Configuring NWLink 

I 

The NWLink protocol is not installed as part of Windows NT when Express Setup 
is run. This section assumes that Windows NT has already been successfully 
installed on your system. 

Installing NWLink 
You must be a member of the Administrators group to install and configure 
NWLink. . 
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~ To install NWLink on a computer with Windows NT 

1. Choose the Network option in Control Panel. 

2. In the Network Settings dialog box, choose the Add Software button. 

3. In the Network Software Installation dialog box, select NWLink IPX/SPX 
Compatible Transport in the Network Software box, and then choose the 
Continue button. 

4. The Windows NT Setup dialog box prompts you for the full path to the 
Windows NT distribution files. Provide the appropriate location, and then 
choose the Continue button. 

NWLink software is copied to your computer, and the Network Settings dialog 
box reappears. Choose the OK button. The NWLink Configuration dialog box 
appears. 

5. Continue with the configuration procedure as described in the next section. 

NWLink must be configured in order to operate. 

Configuring NWLink 
Mter the NWLink protocol software is installed on your computer, you can 
configure it with a network number and frame type to work with your network. 
Typically, the defaults will not need to be changed. Additional advanced 
configuration parameters are documented in the Windows NT Resource Kit. 

~ To configure or reconfigure the NWLink protocol 

1. The Configuration dialog box appears automatically after the NWLink 
software is installed on your computer. 

If you are reconfiguring NWLink, choose the Networkoption in Control 
Panel. In the Installed Network Software box, select NWLink Protocol, 
and then choose the Configure button. 

Adapter Name: 

Network. Number: L-Io ____ --' 

frame Type: IETHERNET_802_3 
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2. Select the adapter to which NWLink will be bound, its network number, and 
the frame type to use. Descriptions for each field follow. 

Item 

Adapter Name 

Network Number 

Frame Type 

Description 

Lists available network adapter cards. 

Specifies the IPX network number to assign to this binding. 
To have Windows NT determine the correct network 
number for the computer, select 0 (the default option). 
To enter a specific number, enter the four byte hex value 
(for example, fe3dba9d). The network administrator should 
provide the correct value for this parameter. 

Specifies the frame format for NWLink packets. Supported 
topologies include Ethernet, Token Ring, ArcNet®, and 
FDDI. Supported frame types include Ethernet II, Ethernet 
802.3,802.2, SNAP, and ArcNet. The default frame type is 
Ethernet 802.3. This is commonly referred to as raw 802.3 
in NetWare networks. If the adapter is a Token Ring or 
FDDI adapter, specifying either Ethernet II or Ethernet 
802.3 will use the 802.2 frame format. It is important to 
ensure that both stations communicating in a conversation 
are using the same frame format. 

3. Choose the OK button to return to the Network Settings dialog box. Choose 
the OK button again. 

Microsoft NWLink has been configured. 

A message informs you that you must restart the computer so that the change 
you made will take effect. You can choose the Yes button to restart the 
computer. 

If you choose the No button, you can continue to work, but your changes to 
NWLink will not take effect until the computer is restarted. 

Configuring NWLink for Token Ring Networks with Ipxroute 
Ipxroute manages the source routing variables of NWLink on a token ring 
network. It is installed with the NWLink protocol. 

Ipxroute parameters are equivalent to the parameters in the ROUTE.EXE utility 
supplied by Novell. Complete syntax is described below and in the online 
Command Reference. 
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TCP/IP 

Ipxroute Syntax 
ipxroute board=n [clear] [def] [gbr] [mbr] [remove=x.x.xxx] 

board=n 
Specifies the network adapter card for which to query or set parameters. 

clear 
Clears the source routing table. 

def 
Sends packets to the ALL ROUTES broadcast. If a packet is transmitted 
to a unique MAC address that is not in the source routing table, the default 
is to send the packet to the SINGLE ROUTES broadcast. 

gbr 
Sends packets to the ALL ROUTES broadcast. If a packet is transmitted 
to the broadcast address (FFFFFFFFFFFF), the default is to send the packet 
to the SINGLE ROUTES broadcast. 

mbr 
Sends packets to the ALL ROUTES broadcast. If a packet is transmitted 
to a multicast address (COOOxxxxxxxx), the default is to send the packet 
to the SINGLE ROUTES broadcast. 

remove=x.x.xxx 
Removes the given node address from the source routing table. 

Transmission control protocol/internet protocol (TCP/IP) provides 
communication across interconnected networks, between computers with diverse 
hardware architectures and various operating systems. TCP lIP can be used with 
Windows NT alone to connect to other Microsoft networking products or to 
connect to non-Microsoft (for example, UNIX) hosts. 

This section first provides background material on basic TCP/IP concepts and 
the information you need before installing Microsoft TCP lIP for Windows NT. 
The section then describes how to install TCP/IP and SNMP for Windows NT 
and configure the protocols on your computer. 
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What Is TCP/IP. for Windows NT? 
The TCP/IP protocol family is a standard set of networking protocols, or rules, 
that govern how data is passed between systems on a network. MicrosoftTCP/IP 
for Windows NT enables enterprise networking and connectivity on your 
Windows NT-based computer. Adding TCP/IP to a Windows NT configuration 
offers the following advantages: 

• A standard, routable, enterprise networking protocol. TCP/IP is viewed as 
the most complete and accepted networking protocol available. Virtually all 
modern operating systems offer TCP/IP support, and most large networks rely 
on TCP /IP for much of their network traffic. 

• An architecture that facilitates connection to foreign systems. Because most 
operating systems offer TCP/IP, many standard utilities have been designed 
to access and transfer data between heterogeneous environments. Examples 
of such standards include file transfer protocol (FTP) and Telnet (terminal 
emulation protocol). Several standard connectivity utilities are included with 
Windows NT, such as the FTP Server service and Telnet driver. The Windows 
Sockets interface offers compatibility with many third-party foreign host 
connectivity products. Several applications vendors support this application 
programming interface (API) standard. 

• A robust, cross-platform client-server framework. TCP/IP for Windows NT 
offers the Windows Sockets interface, which is ideal for developing client­
server applications. A Windows Sockets application developed to be used 
with Microsoft TCP/IP will be able to run other vendors' Windows Sockets­
compliant applications as well. 

How Does TCP/IP Work? 
The name TCP/IP is somewhat misleading because TCP (transmission control 
protocol) and IP (Internet protocol) are only two protocols in the family of 
Internet protocols. However, TCP/IP has been used in the industry to mean the 
family of common Internet protocols. 

The following sections briefly explain how the TCP and IP protocols work. For 
a full explanation of the TCP/IP protocols, see Comer, D. Internetworking with 
TCP/IP Volume I, Principles, Protocols, and Architecture. Second edition. 
Englewood Cliffs, N.J.: Prentice Hall, 1991. 
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How TCP Works 
TCP is a reliable, connection-oriented protocol. Connection-oriented implies 
that TCP first establishes a connection between the two systems that intend to 
exchange data. Since most networks are built on shared media (for example, 
several systems sharing the same cabling), it is necessary to break chunks of data 
into manageable pieces so that no two communicating systems monopolize the 
network. These pieces are called packets. When an application sends a message 
to TCP for transmission, TCP breaks the message into packets sized appropriately 
for the network, and sends them over the network. 

Sequence Numbers, Checksum, and Port 10 
Because a single message is often broken into many packets, TCP marks these 
packets with sequence numbers before sending them. The sequence numbers 
allow the receiving system to properly reassemble the packets. Being able to 
reassemble the original message is not enough -the accuracy of the data must 
also be verified. TCP does this by computing a checksum. 

A checksum is a simple mathematical computation applied by the sender to the 
data contained in the TCP packet. The recipient then does the same calculation 
on the received data and compares the result with the checksum that the sender 
computed. If the results match, the recipient sends an acknowledgment (ACK) to 
verify the receipt of valid data. If the results do not match, the recipient discards 
the packet without acknowledging it. The sender must then retransmit the packet 
since no acknowledgment was received. 

Finally, TCP uses port IDs to specify which application running on the system 
is sending or receiving the data. 

TCP Headers 
The port ID, checksum, and sequence number are inserted into the TCP packet 
in a special section called the header. The header is at the beginning of the packet 
containing this and other "control" information for TCP. 

How IP Works 
IP is the messenger protocol of TCP/IP. The IP protocol, much simpler than TCP, 
basically addresses and sends packets. IP relies on three pieces of information, 
which you provide, to receive and deliver packets successfully: the IP address, 
subnet mask, and default gateway. 
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IP Addresses 
The IP address identifies your system on the TCP/IP network. IP addresses 
are 32-bit addresses that are globally unique on a network. They are generally 
represented in dotted decimal notation. Dotted decimal notation separates the 
four bytes of the address with periods. An IP address looks like this: 

102.54.94.97 

Although an IP address is a single value, it really contains two pieces of 
information: 

• Your system's network ID 

• Your system's host (or system) ID 

Subnet Mask 
The subnet mask, also represented in dotted decimal notation, is used to 
extract these two values from your IP address. The value of the subnet mask is 
determined by setting the network ID bits of the IP address to 1 's and the host ID 
bits to O's. The result allows TCP/IP to determine the host and network IDs of the 
local workstation, as shown in the following table. 

Understanding an IP Address 

When the IP address is 

And the subnet mask is 

The network ID is 

And the host ID is 

Network and Host IDs 

102.54.94.97 

255.255.0.0 

102.54 

94.97 

(specified by the user) 

(specified by the user) 

(IP address and sub net mask) 

(IP address and subnet mask) 

The network ID identifies a group of systems that are all located on the same 
logical network. In internetworks (networks formed by a collection of networks), 
there are as many unique network IDs as there are networks. TCP/IP networks are 
connected by routers (or gateways), which know the networks that are connected 
in the internet. The host ID identifies your system within a particular network ID. 
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Default Gateway 
The default gateway is needed only for systems that are part of an internet. 
When IP gets ready to send a packet on the wire, it inserts the local (source) IP 
address and destination address of the packet in the IP header, and verifies that 
the network ID of the destination matches the source. If they match, the packet 
is sent directly to the destination system on the local network. If the network IDs 
do not match, the packet is forwarded to the default gateway for delivery. Since 
the default gateway knows the network IDs of the networks in the internet, it 
forwards the packet to other gateways until the packet is eventually delivered to a 
gateway connected to the specified destina.tion. This process is known as routing. 

Example 
This example shows how TCPjIP might deliver a message, using an analogy 
with the U.S. postal system to describe how these protocols work. 

Steve (source host ID) in Seattle (source network ID) wants to send a two-page 
letter (message) to Dana (destination host ID) in Dartmouth (destination network 
ID). There is a limit to the length of the message that can be sent in a single letter 
(maximum transmission unit, or MTU) to a single page. 

First, Steve establishes the connection by writing a short note to Dana saying he 
is.going to mail her a two-page letter. Steve then puts the letter in an envelope 
(IP packet) and addresses it to Dana in Dartmouth (destination IP address) . 

. Steve's mail carrier (Steve's default gateway) picks up the letter, doesn't know 
where Dartmouth is, and forwards it to the Seattle post office (gateway). From 
Seattle, the message goes (routes) to the Dartmouth post office (Dana's default 
gateway). The Dartmouth mail carrier delivers it to Dana. 

Dana writes back (ACKs) to Steve saying she is ready and waiting for his letter. 
She addresses the envelope, using the return address from the envelope. (IP 
packet), to Steve in Seattle. Dana's mail carrier then carries her reply to the 
Dartmouth post office, and it travels to Steve. 

Steve realizes that his letter (message) is too long to fit in a single envelope 
(IP packet), tears off the first page (TCP packet) and writes "1 of 2" in the margin 
(TCP header), puts it into the envelope addressed to Dana (IP packet), and 
mails it. 

The first page is successfully routed to Dana, who opens the envelope and reads 
the contents. But the letter is incomplete, so Dana mails a quick note (ACK) to 
Steve saying she received the first page of the message, but hasn't seen any since. 
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Steve reads Dana's letter and immediately takes the second page (TCP packet), 
writes "2 of 2" in the margin (TCP header), puts it in an envelope addressed to 
Dana (IP packet), and mails it. 

The second note is also successfully routed to Dana, so she replies (ACKs) 
with one final note saying she received it. 

The following figure shows how one page of Steve's message traveled. 

Tep Header 

1--_----1 ----l> L...s_ou_rc~_e_sti_nat_ion_D....J' ----~ &1 
From Steve 

To Dana 

IP Packet 

Source 

Destination 

IP Packet 

Seattle 

D 

Dartmouth 

Installing and Configuring Microsoft TCP/IP and SNMP 
The TCP/IP protocol family is not installed as part of Windows NT when 
Express Setup is run. This section assumes that Windows NT has already been 
successfully installed on your system. 

You must be logged on as a member of the Administrators group to install and 
configure TCP/IP and SNMP. Also, SNMP must be installed to monitor TCP/IP 
network components using Performance Monitor. 

Before Installing Microsoft TCP/IP 
You need to know the following information before you install Microsoft TCP /IP 
on your computer: 

• Default gateway 

• IP address 

• Subnet mask 

• Whether to enable Domain Name Service (DNS), and if so, the IP addresses 
of the DNS servers on your network 

• LMHOSTS file for your network (if necessary) 
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Installing TCP/IP 
You must be a member of the Administrators group to install and configure 
TCP/IP. 

~ To install Microsoft TCP/IP on a Windows NT computer 

1. Choose the Network option in Control Panel. 

The Network Settings dialog box appears. 

2. Choose the Add Software button. 

The Add Network Software dialog box appears. 

3. Select TCP/IP Protocol in the Network Software box, and then choose 
the Continue button. 

4. The Windows NT Setup dialog box prompts you for the full path to the 
Windows NT distribution files. Provide the appropriate location, and then 
choose the Continue button. 

All necessary files are copied. 

5. Continue with the configuration procedure as described in the next section. 

TCP/IP must be configured in order to operate. 

Configuring TCP/IP 
After the Microsoft TCP/IP protocol software is installed on your computer, 
you must configure it with valid addressing information for TCP/IP to operate. 

~ To configure or reconfigure the TCP/IP protocol 

1. The Configuration dialog box appears automatically after the TCP/IP software 
is installed on your computer and you have chosen the OK button in the 
Network Settings dialog box. 

If you are reconfiguring TCP/IP, choose the Network option in Control Panel. 
In the Installed Network Software box, select TCP lIP Protocol, and then 
choose the Configure button. 
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General Information 

.!lefault Gateway: 1102 .54 .0 .1 

adapter: [01] Ungermann-Bass Ethernet NIUpc. f 

Help 
!P Address: 

1
102 .54 .94 .97 

Sybnet Mask: 
1
255 .255 .0 .0 

Descriptions: Ungermann-Bass Ethernet 

Windows Networking on TCPIIP (NetBIOS) 

~indows Networking Adapter: r"1 [O-l-]-U-n-ge-r-m-an-n--B-a-s-s-E-th-e-rn-e-t N-,'--I f-'I 

~cope ID for Windows Networking: 

The TCP/IP Configuration dialog box displays the following configuration 
options. 

Item 

Default Gateway 

IP Address 

Subnet Mask 

Description 

Specifies the IP address of the default gateway used to 
forward packets to other networks or subnets. This 
parameter is required only for nodes on internetworks. 
If this parameter is not provided, IP functionality will be 
limited to the local subnet unless a route is specified with 
the route command. The network administrator should 
provide the correct value for this parameter. 

Specifies the IP address for your local computer, or if more 
than one network card is installed in the computer, the 
network adapter card listed in the Adapter box. 

Duplicate IP addresses on a network might cause some 
systems on the network to stop working or function 
unpredictably. The network administrator should provide 
the correct value for this parameter. 

Specifies the subnet mask associated with the adapter to 
which TCP/IP is bound. Each interface used by TCP/IP 
must have a subnet mask configured. This allows the 
computer to separate the IP address into host and network 
IDs. The network administrator should provide the correct 
value for this parameter. 
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Item 

Windows 
Networking Adapter 

Scope ID 

Description 

Lists available network adapter cards. If your computer has 
multiple network interfaces, Windows Networking must be 
configured to use only one. 

Specifies the NetBIOS scope parameter for the NetBIOS 
over TCP/IP (NBT) module. To be able to communicate, all 
computers on a NetBIOS network must have the same scope 
ID. The network administrator should provide the correct 
value for this parameter, but you can usually leave this value 
blank. 

2. The values for Default Gateway, IP Address, and Subnet Mask must be 
configured. 

3. If necessary, select a TCP/IP adapter, and provide a Scope ID in the Windows 
Networking On TCP/IP (NetBIOS) box. 

4. A computer joining an existing Advanced Server domain on a different 
subnet may choose to import an LMHOSTS file containing the IP Address 
and NetBIOS name of that domain's controller. To import this file, choose the 
Import LMHOSTS button and provide the location in the dialog box that 
appears. 

Thenetwork administrator should determine if an LMHOSTS file should be 
imported. 

5. To enable the Domain Name Service (DNS), choose the Connectivity button. 
Continue with the configuration procedure as described in the next section. 

If you do not want to use DNS and rely on the HOSTS file for name 
resolution, choose the OK button to return to the Network Settings dialog box. 
Choose the OK button again. 

Microsoft TCP/IP has been configured. You must restart the computer for the 
configuration to take effect. 

Note The \WINNT\SYSTEM32\DRIVERS\ETC directory will contain several. 
files. You may need to replace the installed files with files from the network 
administrator. 
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Configuring TCP/IP to Use DNS 
Although TCP/IP uses IP addresses to identify and reach computers, users 
typically prefer using names. The Domain Name service (DNS) is a naming 
service generally used in the UNIX networking community to provide standard 
naming conventions for IP workstations. 

Microsoft Windows networking provides a dynamic naming system of its own 
using NBT; however, TCP/IP applications, such as ftp and telnet, can use DNS 
in addition to the HOSTS file. This allows the user to use names instead of IP 
addresses when connecting to foreign hosts. 

You must configure how your computer will use DNS and the HOSTS file. 
TCP/IP must be installed and configured to set up the DNS connectivity options. 

~ To configure or reconfigure TCP/IP DNS connectivity 

1. Choose the Network option in Control Panel. In the Installed Adapter Cards 
box, select the adapter card whose TCP/IP NetBIOS protocol you want to 
configure. In the Installed Network Software box, select TCP/IP Protocol 
and choose the Configure button. 

2. In the TCP/IP Configuration dialog box, choose the Connectivity button. 

Host N.ame: lL.::.g_riz_zl;;....Y ___ --' ICP Domain Name: I bruins. com 

Name Resolution Search Order 

o DNS Only 0 Hosts File First. Then DN5 

@ DNS First. Then Hosts File 0 Hosts File Only 

Domain Name li.ervice (DNS) Search Order----------, 
r-:-=,-;:-;-;::-::-------, Order 

10 .0 .0 .0 [!J 

~ 

DQ.main Search Order----------------, 
,..,.--,--------, Order 

[!J 

~ 

Cancel .!::!elp 
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The TCP/IP Connectivity Configuration dialog box displays the following 
options. 

Item 

Host Name 

TCP Domain Name 

Name Resolution 
Search Order 

Domain Name Service 
(DNS) Search Order 

Domain Search Order 

Description 

Specifies the host name for this computer. The host name is 
used to identify the local computer by name for 
authentication by some utilities. Other TCP/IP-based 
utilities and applications can use this value to learn the name 
of the local computer. This value defaults to the Windows 
NT computer name, and it can be altered without affecting 
the computer name's value. The Host name is optional. 

Identifies your group in the DNS hierarchical naming 
convention, with descending levels of detail. The fully 
qualified domain name (FQDN) for the computer is the 
host name, a period, and the domain name; for example, 
rhino.microsoft.com, where rhino is the host name and 
microsoft.com is the domain name. During DNS queries, 
the local domain name is appended to short names. The TCP 
Domain Name is optional. 

The DNS domain is not the same as a Windows NT or LAN 
Manager domain. 

Determines when to use DNS host name resolution. 
The domain name resolver (DNR) software is loaded at 
startup and is used to resolve host names, in conjunction 
with the locally maintained HOSTS file. This option allows 
you to specify the order and method to use when resolving 
names. 

Determines the order of servers that will provide name 
resolution. 

Determines the domains in which to search for host name 
resolution. 

3. Enter a the Host Name (usually your computer name) and TCP Domain 
Name (usually an organization name, a period, and an extension that indicates 
the type of organization). 

4. Select how you want your computer to search for name resolution in the 
Name Resolution Search Order dialog box. 

5. Enter the IP address of a server that will provide name resolution. Choose 
the Add button to move the IP address to the list on the right. 

You can add up to three IP addresses. The servers at the IP addresses are 
queried in the order listed. To change the order of the IP addresses, select 
an IP address to move, and use the up and down arrow buttons. To remove 
an IP address, select it and choose the Remove button. 
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6. Type the names of the domains in which to search for host name resolution. 

You can add up to six domain names. To change the search order of the 
domains, select a domain to move, and use the up and down arrow buttons. 
To remove a domain name, select it and choose the Remove button. 

7. When you are done setting connectivity values, choose the OK button. 

The Microsoft TCP/IP-Connectivity Configuration dialog box closes, 
and the TCP/IP Configuration dialog box appears. 

8. Choose the OK button. The Microsoft TCP/IP Configuration dialog box 
closes, and the Network Settings dialog box returns. 

9. To complete TCP/IP Installation and Configuration, choose the OK button. 
DNS resolution has been configured. 

A message informs you that you must restart the computer so that the change 
you made will take effect. 

If you reconfigured only DNS, the new configuration will take effect 
immediately, without restarting. 

If you have configured the default gateway, IP address, subnet mask, or scope 
ID, you must restart the computer for those changes to take effect. You can 
choose the Yes button to restart the computer. 

Troubleshooting IP Connections 
If you have trouble installing Microsoft TCP/IP on your computer, follow the 
suggestions in the error messages. You can also use the ping utility, as described 
below. 

ping 
The ping utility can isolate network hardware problems and incompatible 
configurations by allowing you to verify a physical connection to a remote 
computer. 

Use the ping utility to test both the host name and the IP address of the host. 
If the pinged IP address responds but the host name does not, you have a name 
resolution problem. In this case, be sure that the host name you are querying is 
in either the local HOSTS file or in the DNS database. 

Before Installing the SNMP Service 
You need to know the following information before you install the SNMP 
service on your computer: 

• Community names in your network 

• Trap destination for each community 
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Installing the SNMP Service 
You must be a member of the Administrators group to install and configure 
SNMP. 

~ To install the SNMP service on a Windows NT computer 

1. Choose the Network option in Control Panel. 

2. In the Network Settings dialog box, choose the Add Software button. 

The Add Network Software dialog box appears . 

. 3. Select SNMP Service in the Network Software box and choose the 
Continue button. 

4. The Windows NT Setup dialog box prompts you for the full path to the 
Windows NT distribution files. Provide the appropriate location, and then 
choose the Continue button. 

The SNMP service software is copied to your computer. The SNMP Service 
Configuration dialog box appears. 

5. Continue with the configuration procedure, as described in the next section, 
"Configuring SNMP." You can press the ESC key and configure SNMP later, 
but SNMP must be configured to operate. 

Configuring SNMP 
After the SNMP service software is installed on your computer, you must 
configure it with valid information for SNMP to operate. 

~ To configure or reconfigure the SNMP service 

1. The Configuration dialog box appears automatically after the SNMP software 
is installed on your computer. 

If you are reconfiguring SNMP, choose the Network option in Control Panel. 
In the Installed Network Software box, select SNMP Protocol, and then choose 
the Configure button. 
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~end Trap with Community Names 

C.Q.mmunity Names 

l!:lemove -> I 
ISe£urity· .. 1 

I.rap Destination for Engineering 
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Host N.ame or IPAddress 
Agent... 

H.elp 

The SNMP Service Configuration dialog box displays the following options. 

Item 

Send Trap With 
Community Names 

Trap Destinations For 
selected community 

Description 

A community is a group of hosts to which a server running 
the SNMP service belongs. You can specify one or more 
communities to send traps to. The community name is 
placed in the SNMP packet when the trap is sent. Typically, 
all hosts belong to Public, which is the standard name for 
the common community of all hosts. An entry in the list can 
be deleted by selecting it and choosing the Remove button. 

Trap destinations are the names or IP addresses of hosts 
to which you want the SNMP service to send traps with 
the selected community name. An entry in the list can be 
deleted by selecting it and choosing the Remove button. 

2. Enter the community names you want your computer to send traps to in the 
Community Names box. Choose the Add button after typing each name to 
move the name to the list on the left. 

For each community you send traps to, you can specify specific hosts in that 
community to send the traps to. After you have added the community, and 
while it is still highlighted, type the hosts in the Host Name Or IP Address 
box. Choose the Add button to move the host name or IP address to the box 
on the left. 
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3. To enable additional security for the SNMP service, choose the Security 
button. Continue with the configuration procedure, as described in the next 
section, "Configuring SNMP Security." 

To specify Agent information (comments about the user, location, and 
services), choose the Agent button. Continue with the configuration procedure, 
as described in "Configuring SNMP Agent Information," later in this 
appendix. 

If you do not want to use SNMP security or specify Agent information, choose 
the OK button. The Network Settings dialog box reappears. Choose the OK 
button. The Microsoft SNMP service has been configured and is ready to start. 
It is not necessary to restart the computer. 

Configuring SNMP Security 
SNMP security allows you to specify the communities and host your computer 
will accept requests from and to specify whether to send an authentication trap 
when an unauthorized community or host requests information. 

~ To configure or reconfigure SNMP security 

1. Choose the Network option in Control Panel. In the Installed Network 
Software box, select SNMP Service and choose the Configure button. 

The SNMP Service Configuration dialog box appears. 

2. Choose the Security button. 

[gJ Send Aythentication Trap 

Accepted Community Hames 

public 
~ffm~ms~:mTI![mil!J[iU"Ir]Ij;l:n···. ti'sS··j I {- Add' Community Name 

IRemove ~}I 
Help 

o A,!<.cept S N M P P ack.ets from Any Host 

• !!nly Accept SNMP Pack.ets from These Hosts: --------, 

Ho.!t or IP Address: 
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The SNMP Security Configuration dialog box displays the following options. 

Item 

Send Authentication 
Trap 

Accepted Community 
Names 

Accept SNMP Packets 
From Any Host 

Only Accept SNMP 
Packets From These 
Hosts 

Description 

When the SNMP service receives a request for information 
that does not contain the correct community name and 
doesn't match an accepted host name for the service, the 
SNMP service can send a trap to the trap destination(s), 
indicating that the request failed authentication. This check 
box specifies whether or not this authentication trap is sent. 

A host must belong to a community that appears on this list 
for the SNMP service to accept requests from that host. 
Typically, all hosts belong to Public, which is the standard 
name for the common community of all hosts. An entry in 
the list can be deleted by selecting it and choosing the 
Remove button. 

If this option is selected, no SNMP packets are rejected on 
the basis of source host ID, and the list of hosts under Only 
Accept SNMP Packets From These Hosts has no effect. 

If this option is selected, SNMP packets will be accepted 
only from the hosts listed. An entry in the list can be deleted 
by selecting it and choosing the Remove button. 

3. Enter the community names you will accept requests from in the Community 
Name box. Choose the Add button after typing each name to move it to the list 
on the left. 

4. To accept SNMP packets from any host, select that option. Otherwise, select 
the Only Accept SNMP Packets From These Hosts option. Then type the host 
names or IP addresses of the hosts you will accept requests from in the Host 
Or IP Address box. Choose the Add button to move the host name or IP 
address to the box on the left. 

5. To send a trap for failed authentications, select the Send Authentication 
Trap box. 

6. Choose the OK button. 

The SNMP Service Configuration dialog box reappears. 

To specify Agent information (comments about the user, location, and 
services) choose the Agent button. Continue with the configuration procedure 
as described in the next section. 

If you do not want to specify Agent information, choose the OK button to 
return to the Network Settings dialog box. Choose the OK button again. The 
Microsoft SNMP service and SNMP security have been configured and are 
ready to start. 
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Configuring SNMP Agent Information 
SNMP agent information allows you to include comments about the user and 
physical location of the computer and indicate the types of service to report. 
The types of service that can be reported are based on the computer's 
configuration. 

I> To configure or reconfigure SNMP agent information 

1. Choose the Network option in Control Panel. In the Installed Network 
Software box, select SNMP Service and choose the Configure button. 

2. In the SNMP Service Configuration dialog box, choose the Agent button. 

kontact: 

location: IOldg. 7. room 823 

Service----------------, 

D f.hysical D J!atalink I 5 ubnetwork 

D !nternet [;g] .E.nd-to-End 

3. Enter the computer user's name in the Contact box and a physical location 
in the Location box. 

The comments will be used as text and cannot include embedded control 
characters. 

4. Select the services to report in the Service box. 

This option specifies which TCP/IP services are enabled. SNMP must have 
this information to manage the enabled services. End-To-End and Applications 
should be selected for all Windows NT installations. If you have installed 
additional TCP lIP services, such as a bridge or router; you should consult 
RFC 1213 for additional information. 

5. Choose the OK button to return to the SNMP Agent dialog box. 

The SNMP Service Configuration dialog box appears. 
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6. Choose the OK button to close the SNMP Service Configuration dialog 
box and return to the Network Settings dialog box. 

7. To complete SNMP Service Installation and Configuration, choose the 
OK button. 

SNMP is ready to operate after installation and configuration without 
. restarting. 

Using the Microsoft FTP Server Service 
The Microsoft FTP Server service allows a Windows NT computer to transfer 
files to and from remote computers that support the FTP and TCP/IP protocols. 
The FTP Server service supports all Windows NT FTP client commands. Non­
Microsoft versions of FTP clients may contain commands that are not supported. 

The FTP Server service is implemented as a multithreaded Win32 service 
compliant with the requirements defined in Request For Comments (RFCs) 959 
and 1123. RFCs are the official working documents of the Internet Engineering 
Task Force (IETF). 

The FTP Server is integrated with the Windows NT security model. Users 
connecting to the FTP Server service are authenticated based on their Windows 
NT user accounts and receive access based on their user profile. For this reason, 
it is recommended that the FTP Server service be installed on a NTFS partition 
so the files made available via FTP can be secured. 

Caution The FTP Server protocol relies on the ability to pass user passwords over 
the network without data encryption. A user with physical access to the network 
could examine user passwords during the FTP validation process. 

The following section describes how to install, configure, and administer the 
Microsoft FTP Server service. It assumes that you have successfully installed 
TCP/IP and any necessary devices and device drivers. 

Installing the FTP Server Service 
The FTP Server service is not installed automatically because of the security risks 
mentioned above. You must be a member of the Administrators group to install 
and configure the FTP Server service. 
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t> To install the FTP Server service 

I. Choose the Network option in Control Panel. 

2. In the Network Settings dialog box, choose the Add Software button. 

The Add Network Software dialog box appears. 

3. Select FTP Server in the Network Software box, and then choose the Continue 
button. A warning message prompts you to confirm that you are familiar with 
FTP Security. 

C]) 
The File Transfer Protocol relies on the ability to pass user 
passwords over the network without data encryption. A 
user with physical access to the network may be able to 
examine users' passwords during FTP validalion. Are you 
sure you want to continue? 

4. Choose the Yes button to continue with FTP Server installation. 

The Windows NT Setup dialog box prompts you for the full path to the 
Windows NT distribution files. Provide the appropriate location, and choose 
the Continue button. 

5. Mter the necessary files are copied to your computer, the FTP Service dialog 
box appears. 

6. Continue with the configuration procedure as described in the next section. 
The FTP Server service must be configured in order to operate. 

Configuring the FTP Server Service 
Mter the FTP Server service software is installed on your computer, you must 
configure it to operate. 

r> To configure or reconfigure the FTP Server service 

1. The FTP Service configuration dialog box appears automatically after the 
FTP Server service software is installed on your computer. 

If you are reconfiguring the FTP Server service, choose the Network option 
in Control Panel. In the Installed Network Software box, select FTP Server, 
and then choose the Configure button. 
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Maximum Connections: ~ idle Timeout (min): 1 10 !!J 

Home J!irectory: L-Ic_:\_u_s_er_s ___________ ------' 

!!sername: L.:lg:....u_e_st __________ _ 

e.assword: I··KK.K.K •• KK •• 

o Allow !lnly Anonymous Connections 

OK Cancel Help 

The FTP Service dialog box displays the following options. 

Item 

Maximum Connections 

Idle Timeout 

Home Directory 

Allow Anonymous 
Connections 

Username 

Description 

Specifies the maximum number of FTP users who can 
connect to the system simultaneously. The default value 
is 20; the maximum is 50. 

Specifies how many minutes an inactive user may remain 
connected to the FTP Service. The default value is 10 
minutes; the maximum is 60 minutes. If the value is 0, users 
are never automatically disconnected. 

Specifies the initial directory for users. 

Enables users to connect to the FTP Server using the user 
name anonymous. A password is not necessary, but the user 
is prompted to enter his or her electronic mail address as the 
password. By default, anonymous connections are not 
allowed. Note that you cannot use a Windows NT user 
account with the name anonymous with the FTP Server. 
The anonymous user name is reserved in the FTP Server 
for the anonymous logon function. Users logging on with 
the username anonymous receive permissions based on the 
FTP Server configuration for anonymous logons. 

Specifies which local user account to use for FTP Server 
users who log on under anonymous. Access permissions for 
the anonymous FTP user will be the same as the specified 
local user account. The default is the standard guest system 
account. 
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Item 

Password 

Allow Only 
Anonymous 
Connections 

Description 

Specifies a password when connecting with anonymous as 
the user name. The default is the default Windows NT guest 
account password. If you will use the guest account for 
anonymous logons, and you have changed the default guest 
account password, you should enter the guest account 
password here. 

Allows only the user name anonymous to be accepted. 
This option is useful if you do not want users to use their 
own user names and passwords because FTP passwords are 
unencrypted. However, all users will have the same access 
privilege. By default, this option is not enabled. 

2. Default values are provided for Maximum Connections, Idle Timeout, and 
Home Directory. Accept the default values or change values for each field as 
necessary. 

3. Choose the OK button to close the FTP Service configuration dialog box and 
return to the Network Settings dialog .box. 

4. To complete initial FTP Server service installation and configuration, choose 
the OK button. 

A message informs you that you must restart the computer so that the change 
you made will take effect. It is not necessary to restart. If you are installing the 
FTP Server for the first time, you need only to exit Control Panel and restart 
Control Panel for the FTP Server icon to appear. If you are just reconfiguring 
the FTP Server service, you need only to restart the service for changes to take 
effect. 

Note On initial installation you must also complete security configuration as 
described below for users to access volumes on your computer. 
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f> To configure FTP Server security 

1. After the FTP Server has been installed and you have restarted Control Panel, 
start the FTP Server option in Control Panel. Advanced Server users can also 
use the FTP menu in Server Manager. Choose the Security button. 

[S] Allow .Read 

File System Type: NTFS [S] [AI!.~·~~~s.i.~I~~J 

2. Select the drive letter you want to set security on in the Partition box. 
Choose the Allow Read, the Allow Write, or both check boxes. 

3. Choose the OK button when you are finished setting security access on 
partitions. 

The changes take effect immediately. The FTP Server service is now ready 
to operate. 

Administering the FTP Server Service 
Once initial installation is complete, the FTP Server service is automatically 
started in the background as a service each time the computer is started. Remote 
computers are able to initiate an FTP session while the FTP Server service is 
running on your Windows NT computer. Both computers must be running the 
TCP lIP protocol. 

Remote users can connect to the FTP Server using their account on the FTP 
Server, an account on the FTP Server's domain (Advanced Server only), or using 
the anonymous account if the FTP Server service is configured to allow 
anonymous logons. 

Use the Services option in Control Panel to start and stop the FTP Server service. 
For more information about using the Services option of Control Panel, see 
Chapter 5, "Control Panel." If selected, the FTP Server icon will offer to start the 
FTP Server service if it is not running. Y oucan also start and stop the service at 
the command prompt using the commands net start ftpsvc or net stop ftpsvc. 
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Managing Users 
Use the FTP Server option in Control Panel to manage users connected to the FTP 
Server and to set security for each volume on the FTP Server. For convenience on 
Advanced Server computers, the same dialog box can be reached from Server 
Manager using the FTP menu item. 

You must be a member of the Administrators group to administer the FTP Server. 

konnected Users From Time 

!.~ .. ~g!:Q!!.!i~.\r.~.\9.r ............................................................. H.?:J.:.?~J..~.4 ...................... Q.:.Q~;.?~............................................... Close 
• ernesta 142.1.24.171 0:00:42 

Help 

The Connected Users box displays connected users, their IP addresses, and how 
long they have been connected. Users who have logged on using the anonymous 
user name display the password used when they logged on as their user name. If 
the user name contained a mail host (for example, ernesta@trey_research.com) 
only the username (ernesta) appears. The anonymous user also has a question 
mark (?) over the user icon. 

The FTP Server allows you to disconnect one or all users with the disconnect 
buttons. Users are not warned if you disconnect them. 

The FTP Server displays users as they connect, but does not update the display 
when users disconnect or their connect time elapses. The Refresh button allows 
you to update the display to show only users who are currently connected. 

Choosing the Security button displays the FTP Service Security dialog box, 
allowing you to set Read and Write permissions for each partition on the FTP 
Server. You must set the permissions for each partition you want FTP users to 
have access to. If you do not set partition parameters, no users are able to access 
files. If the partition uses a secure file system, such as NTFS, file system 
restrictions are also in effect. 

In addition to FTP Server partition security, if a user logs on using a Windows NT 
account, access permissions for that account are in effect. 
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APPENDIX B 

Remote Access Service 

This appendix helps you install and get started with the Remote Access Service. 
For details, see online Help. 

Overview and Planning 
The Windows NT Remote Access Service contains two main components: 

• The Remote Access server, a Windows NT workstation configured to 
accept incoming calls 

• The Remote Access client, a Windows NT, MS-DOS, or Microsoft Windows 
computer that dials in to a server 
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Windows NT can act as both a server and a client. 

A Remote Access client is a computer (or workstation) that is not directly 
connected to a network. The user calls a server and connects to the network 
through a telephone line, as shown in the following illustration. 

PC workstation 

Remote 
Access 
server 

Once connected, the telephone link is transparent. From the remote client, users 
can see and gain access to network resources on the LAN just as they do in the 
office from a computer physically connected to the LAN. In this way, the Remote 
Access Service acts as a gateway between the remote client and the network, 
as shown in the following illustration. 

PC workstation 
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The Remote Access Service features the Remote Access Phone Book program for 
entering and maintaining the names and telephone numbers of remote networks. 
Clients can connect to and disconnect from these networks through the Phone 
Book. For information about using the Remote Access Phone Book, see the online 
Help. 

The Remote Access Service also has a graphical Administrator's utility. 
Through the Administrator's utility, you can do the following: 

• Start, stop, pause, or continue the Remote Access server 

• Grant Remote Access permission to or revoke it from individual users 

• Monitor Remote Access traffic and user accounts 

The Administrator's utility allows you to monitor Remote Access servers and 
users from any computer on the network, including a remote one. With Windows 
NT Event Viewer, located in the Administrative Tools group, you can see events 
and errors audited by the Remote Access Service. For details about Event Viewer, 
see Chapter 15, "Event Viewer." 

Remote Access 
server (Windows NT) . 

line 

Overview of Windows NT Remote Access Service 



536 System Guide 

Features 
The Microsoft Windows NT Remote Access Service offers the following features: 

• Transparent access to the network for telecommuters, mobile workers, 
and remote system administrators. 

• Support for named pipes, remote procedure calls (RPC), and the 
LAN Manager application programming interface (API). 

• Client access to resources on application servers· such as SQL Server, 
SNA Server for Windows NT, and Lotus Notes®. 

• Compatibility with workstations and servers running previous versions 
of the Remote Access Service. 

• Support for public telephone, X.25, and integrated services digital network 
(ISDN) wide area networks. 

• Support for data compression and error control on modems. 

• Software compression. 

• Security: 

• Integration with Windows NT security. 

• . Encrypted authentication during connecti<.m. 

• Support for third-party security hosts that authenticate users. 

• Callback for either added security or user convenience. 

• Central administration of servers and users. 

• Support for over 100 modems. See the Microsoft Windows NT 
Hardware Compatibility List. 
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Setting Up the Remote Access Service 
First, install your wide area network adapters such as X.2S and ISDN adapters. 
(For information about installing adapter cards, see the hardware documentation.) 

Note Make sure the I/O address and interrupt request (IRQ) level settings you 
choose for your adapter do not conflict with other peripherals on your computer. 

~ To install a wide area network adapter 

1. In the Windows NT Control Panel, double-click the Network icon. 

2. Choose the Add Software button. 

3. From the list, choose Remote Access Service. 

4. Choose the Continue button. 

5. Follow the instructions on the screen. 

If you need help, choose the Help button on any of the Remote Access 
Setup screens. 

6. When the software is installed, restart the computer. 

When you return to Windows NT, you will see the Remote Access Service group, 
which contains the Remote Access icon. 

Allowing Others to Connect to Your Workstation 
Without permission, users cannot dial in to your workstation, even if the 
Remote Access client software has been installed on their computers. 

~ To grant Remote Access permission to users 

1. Start the Administrator's utility by double-clicking the Remote Access Admin 
icon in the Remote Access Service group. 

2. From the Users menu, choose Permissions. 

In the Remote Access Permissions dialog box, you can grant or revoke Remote 
Access permissions to either one user at a time or to all users at once. For more 
information on granting Remote Access permissions, choose the Help button. 

For information about setting up your modem, see online help. 

Note Microsoft recommends against granting dial-in permission to guest 
accounts. 
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X.25 Support 
The Remote Access Service lets you access an X.25 network in two general ways: 

• A client (for the Windows graphical environment or Windows NT system) 
can use asynchronous PADs. 

• A server and client (for the Windows NT system only) can use direct 
connections. 

X.25 Configurations 
The Remote Access Service for X.25 networks offers two configurations for 
the client and two for the server: 

Client/Server 

Client 

Client 

Client 

Server 

Server 

Configuration 

Dial-up PAD 

External PAD 

Direct connection through X.2S smart card 

Direct connection through X.2S smart card 

External PAD 

See the Windows NT Hardware Compatibility List for PADs that have been 
tested with the Remote Access Service. 

Accessing X.25 Through Dial-up PADs 
Operating between the client and the Remote Access server, an asynchronous 
PAD converts serially transmitted data into X.25 packets. When the PAD receives 
a packet from an X.25 network, it puts the packet out on a serial line, making 
communication possible between the client and the X.25 network. 

Remote Access clients can connect with Remote Access servers through dial-up 
PAD services supplied by X.25 carriers, such as Sprintnet and InfoNet. Once the 
client's modem (modem A in the following illustration) connects to the PAD's 
modem (modem B), the client software must converse with the dial-up PAD . 
. When their conversation is successfully completed, a connection is established 
between client and server. 

Note For best results, make sure the client modem is compatible with the PAD 
carrier's modem, or at least match the V. protocol supported by the carrier's 
modem. 
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The conversation ( command/response scripts) for the PADs supported by an 
X.25 carrier is stored in the PAD.lNF file. Remote Access software supplies one 
example. To customize for your PAD, see "P AD.lNF Format," later in this 
chapter, and use the editing program you're familiar with. 

Note For dial-up PADs, you must use the COMMAND= format, not the 
COMMAND_INIT, COMMAND_DIAL, and COMMAND_LISTEN format. 

The following illustration shows how a client connects to the Remote Access 
server through a dial-up PAD and the X.25 network. 

Applications 

Windows NT 
Advanced Server 
or LAN Manager 
server 

Remote Access 
server with 
X.25 smart card 

Remote client 

How Remote Access Connects to the Server Through a Dial-up PAD 

Dial-up asynchronous PADs are a practical choice for Remote Access clients 
because they don't require an X.25 line plugged into the back of the workstation. 
Their only requirement is the telephone number of the PAD service for the carrier. 
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The following table compares connecting through dial-up PADs and connecting 
directly: 

Dial-up PAD 

Saves the expense of a dedicated leased 
line (direct connection). 

Allows connections from hotels, airports, 
homes-anywhere a phone line is 
available. 

Requires two steps to connect. 

Limits maximum communication speed 
to the modem's or the PAD's speed, 
whichever is slower. 

Allows less control in configuring PADs. 

Client External PAD 

Direct connection 

Requires expensive leased line. 

Requires users to dial in from a fixed 
location. 

Connects conveniently in one step. 

Lets communication take place up to the 
speed of a leased line, 56 kilobits per 
second. 

Offers greater reliability. 

In this configuration, the PAD is connected to the client workstation by an 
RS-232 cable attached to a serial port. In the PAD.INF file, create a section that 
contains a dialog script for connecting to a server. For examples, see the P AD.INF 
file. 

Note The PAD.INF entry must have the COMMAND_INIT, 
COMMAND_DIAL, and COMMAND_LISTEN strings so that the 
PAD can be used for the client and server. 

Client Connecting to the X.2S Network Through an External PAD 
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Server External PAD 
Servers with external PADs must be configured to receive incoming calls. 
As with the client, in the P AD.INF file create a section that contains a dialog 
script for connecting to clients. For examples, see the P AD.INF file. 

Note The PAD.INF entry must have the COMMAND_INIT, 
COMMAND_DIAL, and COMMAND_LISTEN strings so that 
the PAD can be used for the client and server. 

Connection 
to LAN 

Server Connecting to the X.2S Network Through an External PAD 

PAD and Serial Configuration 
To configure your PAD correctly, set the X.3 parameters as shown in the 
following table. 

Parameter number X.3 parameter Value 

1 PAD Recall 0 

2 Echo 0 

3 Data Fwd. Char 0 

4 Idle Timer 1 

5 Device Ctrl 0 

6 PAD Service Signals 1 

7 Break Signal 0 

8 Discard Output 0 

9 Padding after CR 0 

10 Line Folding 0 
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Parameter number X.3 parameter Value 

11 Not Set 

12 Flow Control 0 

13 Linefeed Insertion 0 

14 Padding after LF 0 

15 Editing 0 

16 Character Delete 0 

17 Line Delete 0 

18 Line Display 0 

19 Editing PAD Srv Signals 0 

20 Echo Mask 0 

21 Parity Treatment 0 

22 Page Wait 0 

Caution Failure to set these values as shown prevents the Remote Access 
Service from functioning properly. For information on setting these values, 
see the instructions with your X.25 smart card. 

Also, configure external and dial-up PADs to the following serial communication 
settings: 

• 8 data bits 

• 1 stop bit 

• No parity serial communication 

For dial-up PADs, make sure your vendor supports this configuration. The PADs 
are often already set to the correct configuration for connecting directly through 
an internal X.25 smart card. Do not change it. 



Appendix B Remote Access Service 543 

Connecting to the X.2S Networ~ Directly 
The Remote Access Service also supports connecting directly from the remote 
workstation to the X.25 network through a smart card. An X.25 smart card is a 
hardware card with a PAD embedded in it. To the personal computer, the X.25 
virtual circuit looks like a communication port with an advanced modem 
connected to it. 

To access the X.25 network through a direct connection, you need: 

• A direct line connection to an X.25 network (clients only). 

• A smart card. 

Note The server side always requires an X.25 smart card, but the client side 
requires one only when connecting to the X.25 network directly. 

The following illustration shows how the server and a Windows NT-based client 
(both equipped with smart cards) connect to the X.25 network directly. 

Applications 

Windows NT 
Advanced Server 
or LAN Manager 

Remote client with 
X.25 smart card 

Connecting to an X.2S Network Directly 

Remote Access 
server with 
X.25 smart card 
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Callback 
The Remote Access server does not support callback on X.25 networks. 

Setting Up the Remote Access Server for an 
X.25 Network 

I> To set up the server to connect through an X.2S network 

1. Install the X.25 smart card (according to the manufacturer' s instructions). 

A communications driver for the X.25 smart card supplied by the hardware 
manufacturer or a third party then emulates communication ports. 

2. Make sure your X.25 smart card is configured with the X.3-parameter values 
shown in the section "PAD and Serial Configuration," earlier in this chapter. 

3. Install the Remote Access Service through Windows NT Control Panel. 

4. From the list of devices on the Remote Access Setup screen, select an entry 
corresponding to the X.25 smart card. 

5. In setting up the Remote Access server, make sure that the ports selected 
are configured for dial in. 

Note Make sure that the speed of the leased line can support all the serial 
communication (COM) ports at all speeds at which clients will dial in. For 
example, 4 clients connecting at 9600 bps (through dial-up PADs) will require 
a 38,400-bps (4 times 9600) leased line on the server end. If the leased line does 
not have adequate bandwidth, it can cause time-outs and degraded performance 
for connected clients. 

Setting Up a Remote Access Client 
This section tells you how to set up a Windows NT Remote Access client 
so that it can do the following: 

• Connect to the X.25 network through PAD services 

• Connect to the X.25 network directly 
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Connecting Through Dial-up PADs 
In general, a client connects to an X.25 network in two steps: 

1. Dial from the client's modem to a PAD (modem-to-~odem). 

2. Establish a connection over the X.25 network between the PAD and the 
server-side X.25 smart card. 

Once you've established a connection, communicate as you would through any 
asynchronous connection. For a more complete description of connecting through 
dial-up PADs, see "Accessing X.25 Through Dial-up PADs," earlier in this 
chapter. 

Configuring Client PADs 
The client PAD, through which a remote workstation connects to the 
X.25 network, may have previously been set to X.3-parameter values that are 
incompatible with the Remote Access Service. Therefore, it is very important to 
configure the X.25 smart card on the Remote Access server so that it changes the 
client PAD's X.3 settings to the values shown in the section "PAD and Serial 
Configuration," earlier in this chapter as soon as a connection is established 
through X.29 commands. To configure an X.25 smart card to make these 
changes, see the configuration manual for your specific card. 

Note If the X.25 smart card on the server end does not support commands for the 
X.29 language, the client PAD script must set the X.3 parameters locally. If you 
have problems, contact the support site for your X.25 smart card vendor. 

Connecting Directly 
To set up the client for connecting directly to the X.25 network, follow the same 
procedures as you did in setting up the Remote Access server. See "Setting Up the 
Remote Access Server for an X.25 Network," earlier in this chapter. Make sure 
the communication ports are selected as dial out. 
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Configuring Remote Access Software for X.25 
Connecting to a server through an X.25 network is similar to connecting through a 
phone line. The only difference is that the phone book entry must specify an X.25 
PAD type and an X.121 address. 

l> To add a phone book entry with X.25 or to add X.25 to an existing entry 

• See Remote Access online Help. 

PAD.lNF Format 
Similar in format to MODEM.INF, P AD.INF contains the conversations 
between the client software and the PAD, whereas MODEM.INF contains 
script information used to talk to the modem. You can find P AD.INF in the 
\ WINNT\SYSTEM32\RAS subdirectory. 

The macros in the following list are reserved words, which you cannot define 
in PAD.INF to create a new entry. Reserved words are case insensitive. 

• x25address 

• diagnostics 

• userdata 

• facilities 

Caution Using reserved words as macro names in PAD.INF could result in 
unpredictable behavior of the Remote Access software. 

In PAD.INF you can use the COMMAND_INIT, COMMAND_DIAL, and 
COMMAND_LISTEN family or the generic COMMAND= family. You cannot 
mix the two families within a single entry. 

Support for Security Hosts and Switches 
The Remote Access Service for Windows NT supports various kinds of 
intermediary devices (switches and hosts) between the Remote Access client 
and the Remote Access server. These devices include: 

• Modem-pool switch 

• Security host 
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Sample Configuration with Modem Pool and Security Host 

Connecting Through Intermediary Devices 

Connection 
to LAN 

Before a client can connect to the Remote Access server through intermediary 
devices, it usually has one of two possible dialogs with each intermediary device: 

Static 
A dialog that's always the same and requires no input from the user. 

Interactive 
A dialog that always changes, requiring input from the user. 

You must prepare the client to conduct the correct dialog with each intermediary. 

With a configuration that requires both types of dialogs, preparation takes 
two general steps: 

1. Write a script for the static dialog. 

For details, see the following section, "Writing Scripts." 

2. Activate terminal mode for the interactive dialogs. 

For more information, see online Help. 
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If your configuration requires only one kind of dialog, perform only one of 
these steps. For example: 

• If your clients connect through only one intermediary with a static dialog, 
such as an X.25 network, perform step 1 only. 

• If your clients connect through a security host with an interactive dialog, 
perform step 2 only. 

Writing Scripts 
To write a script for static dialogs, such as the one between the client and modem 
pool in the following illustration, add the modem pool to the SWITCH.INF file. 

1 Preconnect (static) 
2 Postconnect (interactive) 
3 Remote Access authentication 

Sample Dialogs Between Client and Intermediary Devices 

Remote 
Access 
server 

This illustration shows two dialogs, preconnect (the modem-pool switch) and 
postconnect (the security host). Although preconnect and postconnect dialogs 
can be either static or interactive, the preconnect dialog is usually static and the 
postconnect interactive. Static dialogs require no interaction between the switch 
and the user. Interactive dialogs require input from the user onto a terminal 
screen. 

With static dialogs, the user selects a user-written custom script from the Switch 
dialog box. With interactive dialogs, the user selects Terminal from the Switch 
dialog box. See online Help for accessing the Switch dialog box. 
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1> To write a script 

1. In the client's SWITCH.INF file, type the name of the device within brackets. 

2. Add one or more commands followed by zero or more responses. 

Note As with PAD.INF, responses in SWITCH.INF immediately follow 
their commands. 

Here is a hypothetical entry from a sample SWITCH.INF file: 

[Teleswitch] 
COMMAND=<cr><cr> 
OK=Ready<cr> 
Error=Failure<cr> 

To add an entry to your SWITCH.INF file, create a sequence of commands 
and responses that follows the order in the sample SWITCH.INF file. 

The Remote Access Terminal feature lets the user communicate with intermediary 
devices that require an interactive dialog. For instructions about activating 
Terminal, see Remote Access online Help. 

Security Hosts 
A security host is a third-party authentication device that verifies whether a caller 
from a remote client is authorized to connect to the Remote Access server. This 
verification supplements security already supplied by the Remote Access Service 
and Windows NT Advanced Server. 

For example, one kind of security system consists of two hardware devices, the 
security host and security card. The security host is installed between the Remote 
Access server and its modem. The security card is a small unit the size of a credit­
card, resembling a pocket calculator without keys. The security card displays in 
its window a different access number every minute. This number is synchronized 
with the same number calculated in the security host every minute. When 
connecting, the remote user sends the number on the security card to the host. 
If the number is correct, the security host connects the remote user with the 
Remote Access server. 

Another kind prompts the remote user to type in a username (which mayor may 
not be the same as the Remote Access username) and a password (which differs 
from the Remote Access password). 
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Note When this manual was printed, only the Security Dynamics ACM/400 had 
been tested with the Windows NT Remote Access Service. Please consult the 
Microsoft Windows NT Hardware Compatibility List for other supported security 
hosts. 

~ To make third-party security devices work with the Remote Access Service 

1. If the Remote Access server's modem is different from the modem in the 
security host's section in MODEM.INF, the MODEM.lNF file on the Remote 
Access server needs to be customited to link the security host to the server's 
modem. 

2. The remote user needs to activate Terminal mode to interact with the security 
host. 

Customizing the Remote Access Server's MODEM.lNF File 
When you install a security host between the Remote Access server and its 
modem(s), the server's modem and the security host act together as a new type 
of modem. The MODEM.lNF file is shipped with a template for each supported 
security host paired with a particular modem. For example, the ACM/400 is 
paired with an AT&T Comsphere 3820 modem. 

To use the security host with a different modem, you will have to modify the 
MODEM.lNF file. 

~ To customize MODEM.INF 

1. Make a backup copy of the MODEM.lNF file. 

2. In the security host's section, replace all of the values for the _on and _off 
macros (such as speaker_on=Ml) with the values from the section of the 
modem you'll be using. 

For a list of these macro values, see the modem's documentation. 

3. In the security host's section, replace all COMMAND _INIT= lines with the 
COMMAND _INIT= lines from the section for the modem you'll be using. 

The security host section must have the same number of COMMAND _ INIT 
lines as the section for the modem you want to use. 

Do not change any other line in the security host section. 
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Note LOOP= lines are not needed for all modems. However, if you are in doubt, 
leave them in. 

After customizing the security host section in MODEM.INF, install the security 
host and modem on the Remote Access server through the Windows NT 
Advanced Server Network Control Panel. 

~ To install a security device 

1. In the Windows NT Advanced Server Control Panel, choose the Network 
option. 

2. In the Installed Network Software window, select Remote Access Service. 

3. Choose the Configure button. 

4. On the Remote Access Setup screen, select the security device connected 
between the Remote Access server and its modem, and choose the Continue 
button. 

5. On the Network Setting screen, choose the OK button. 

Activating Terminal Mode on the Client 
Remote Access Terminal lets the remote user send the correct access number to 
the security device. If the number is correct, the user is connected to the Remote 
Access server. 

~ To prepare the client for Terminal mode 

1. In the Remote Access Phone Book, select the entry you want to connect to. 

2. Choose the Edit button. 

3. Choose the Advanced button. 

4. Choose the Switch button. 

5. In the Post-connect Script box, select Terminal. 

6. Choose the OK button. 

~ To connect to the Remote Access server 

1. Select the entry you have just prepared for Terminal mode. 

2. Choose the Dial button. 

When prompted, type your username and password, and then choose 
the OK button. 



552 System Guide 

3. When the Terminal screen appears, press ENTER. Type the access information 
required by your security host, for example, your personal identification 
number, followed by the number on the screen of the security card. Press 
ENTER again. 

4. As soon as you get the indication that you have been authenticated, 
choose the Done button. 

The indication varies from one security host to another. For example, 
you may get "OK," or the cursor may just drop to the next time. 

Authentication on the Remote Access server begins. 

ISDN Wide Area Network 

Installation 

Integrated services digital network (ISDN) offers a much faster communication 
speed than the telephone line. The phone line typically communicates at 9600 
bits per second (bps), whereas ISDN communicates at speeds of 64 or 128 
kilobits per second. Businesses that need this kind of speed usually have a large 
telecommuting work force or need to do extensive administrative tasks remotely 
such as installing software on off-site workstations. 

An ISDN line comes with two B channels and one D channel. Each B channel 
transmits data at 64 kilo bits per second. The D channel is for signaling, and it 
transmits data at 16 kilobits per second. 

Install ISDN cards on the server and on each client. (For instructions, see the 
card's documentation.) Then configure each B channel to act as a port or to act 
together as a single port. 

To configure the ISDN card to work with the Remote Access Service, see the 
Remote Access Service online Help. 

If your business has a large number of people calling in to the Remote Access 
server, configure each channel to operate as a port. Clients will be able to get 
higher throughputs by requesting channel aggregation at connection time. This 
feature is a dynamic and more efficient way of allocating ISDN resources. 

However, you can also statically assign a higher bandwidth by configuring both 
channels to act as a single port. With this configuration, line speed increases to 
128 kilobits per second. 
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APPENDIX C 

Limited Warranties 

This appendix contains information about the warranties that cover Microsoft 
products. The country or region in which you acquired your Microsoft product 
determines which warranty applies to you. This appendix includes warranties for 
the following countries or regions: 

• Australia, New Zealand, Papua New Guinea 

• Canada (English) 

• Canada (French) 

• England, Scotland, Wales, Ireland 

• USA or any other country 

To determine the warranty coverage for your Microsoft product, turn to the 
warranty for the country or region in which you acquired the product. 
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If you acquired your Microsoft® product in AUSTRALIA, NEW ZEALAND, or PAPUA 
NEW GUINEA, the following limited warranty applies to you: 

To the full extent permitted by the Commonwealth, State, Territory or other law or laws applicable 
to this Agreement, any conditions or warranties imposed by such legislation are hereby excluded. 
Insofar as liability under or pursuant to any legislation, whether of Commonwealth, State, Territory 
or other government, may not be excluded, such liability is limited to: 

(i) replacement of the SOFfW ARE (and any accompanying hardware, if supplied by Microsoft); or, 

(ii) correction of defects in the SOFfW ARE at the exclusive option of Microsoft. 

You acknowledge that no promise, representation or warranty or undertaking has been made or 
given by Microsoft or any person or company on its behalf in relation to the profitability of or any 
other consequences or benefits to be obtained from the delivery or use of the SOFfW ARE and any 
accompanying Microsoft supplied hardware, SOFfW ARE manuals, and written materials. You 
have relied upon your own skill and judgment in deciding to acquire the SOFfW ARE and any 
accompanying hardware, SOFfW ARE manuals, and written materials for use by you. This 
Agreement constitutes the entire agreement and understanding between you and Microsoft in relation 
to the supply of SOFfW ARE and any accompanying hardware, SOFfW ARE manuals, and written 
materials from Microsoft. 

Except as and to the extent that it is hereinbefore provided, under no circumstances shall Microsoft or 
any related company be liable for any loss, damage or injury (including without limitation any loss of 
profit, indirect, consequential or incidental loss, damage or injury) arising from the supply or use of 
the SOFfW ARE and any accompanying hardware and written materials or any failure by Microsoft 
or any related company to perform any obligation or observe any terms of this Agreement. 

This Agreement is governed by the laws of New South Wales, Australia. 

Should you have any questions concerning this Agreement, or if you desire to contact Microsoft 
for any reason, please use the address information enclosed in this product to contact the Microsoft 
subsidiary serving your country or write: Microsoft Customer Sales and Service, One Microsoft Way, 
Redmond, Washington 98052-6399, USA. 
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If you acquired your Microsoft® product in CANADA, the following limited warranty 
applies to you: 

LIMITED WARRANTY - Microsoft warrants that (a) the SOFTWARE will perform substantially 
in accordance with the accompanying Product Manual(s) for a period of 90 days from the date of 
receipt; and (b) any Microsoft supplied hardware accompanying the SOFTWARE will be free from 
defects in materials and workmanship under normal use and service for a period of one year from the 
date of receipt. Any implied warranties on the SOFTWARE and hardware are limited to 90 days and 
une (1) year, respectively. 

CUSTOMER REMEDIES - Microsoft's entire liability and your exclusive remedy shall be, at 
Microsoft's option, either (a) return of the price paid or (b) repair or replacement of the SOFTWARE 
or hardware that does not meet Microsoft's Limited Warranty and which is returned to Microsoft with 
a copy of your receipt. This Limited Warranty is void if failure of the SOFTWARE or hardware has 
resulted from accident, abuse, or misapplication. Any replacement SOFTWARE will be warranted 
for the remainder of the original warranty period or 30 days, whichever is longer. 

NO OTHER WARRANTIES -- MICROSOFT DISCLAIMS ALL OTHER WARRANTIES, 
EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, 
WITH RESPECT TO THE SOFTWARE, THE ACCOMPANYING PRODUCT MANUAL(S) 
AND WRITTEN MATERIALS, AND ANY ACCOMPANYING HARDWARE. THIS LIMITED 
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. 

NO LIABILITY FOR CONSEQUENTIAL DAMAGES - IN NO EVENT SHALL 
MICROSOFT OR ITS SUPPLIERS BE LIABLE FOR ANY OTHER DAMAGES WHATSOEVER 
(INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, 
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR OTHER PECUNIARY 
LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THIS MICROSOFT 
PRODUCT,EVEN IF MICROSOFT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. IN ANY CASE, MICROSOFT'S ENTIRE LIABILITY UNDER ANY PROVISION 
OF THIS AGREEMENT SHALL BE LIMITED TO THE AMOUNT ACTUALLY PAID BY YOU 
FOR THE SOFTWARE. 

This Agreement is governed by the laws of the Province of Ontario, Canada. Each of the parties 
hereto irrevocably attorns to the jurisdiction of the courts of the Province of Ontario and further 
agrees to commence any litigation which may arise hereunder in the courts located in the Judicial 
District of York, Province of Ontario. 

Should you have any questions concerning this Agreement, or if you desire to contact Microsoft 
for any reason, please use the address information enclosed in this product to contact the Microsoft 
subsidiary serving your country or write: Microsoft Customer Sales and Service, One Microsoft Way, 
Redmond, Washington 98052-6399, USA. 
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Si vous avez acquis votre produit Microsoft® au CANADA, la garantie limitee suivante 
vous concerne : 

GARANTIE LIMITEE - Microsoft garantit que (a) la performance du LOGICIEL sera 
substantiellement en conformite avec Ie(s) manuel(s) de produits qui accompagne(nt) Ie LOGICIEL 
pour une periode de quatre-vingt-dix (90) jours a compter de la date de reception; et (b) tout materiel 
fourni par Microsoft accompagnant Ie LOGICIEL sera exempt de detaut de matiere premiere au de 
vice de fabrication dans des conditions normaIes d'utilisation et d'entretien pour une periode d'un an 
a compter de la date de reception. Toute garantie implicite concernant Ie LOGICIEL et Ie materiel est 
limitee a quatre-vingt-dix (90) jours et un (1) an, respectivement. 

RECOURS DU CLIENT - La seule obligation de Microsoft et votre recours exclusif seront, au 
choix de Microsoft, soit (a) Ie remboursement du prix paye ou (b) la reparation ou Ie remplacement 
du LOGICIEL au du materiel qui n'est pas conforme a la Garantie Limitee de Microsoft et qui est 
retourne a Microsoft avec une copie de votre re<;u. CeUe Garantie Limitee est nulle si Ie detaut du 
LOGICIEL ou du materiel est cause par un accident, un traitement abusif ou une mauvaise 
application. Tout LOGICIEL de remplacement sera garanti pour Ie reste de la periode de garantie 
initiale ou pour trente (30) jours, selon laquelle de ces deux periodes est la plus longue. 

AUCUNE AUTRE GARANTIE - MICROSOFT DESAVOUE TOUTE AUTRE GARANTIE, 
EXPRESSE OU IMPLICITE, Y COMPRIS MAIS NE SE LIMITANT PAS AUX GARANTIES 
IMPLICITES DU CARACTERE ADEQUAT POUR LA COMMERCIALISATION OU UN 
USAGE PARTICULIER EN CE QUI CONCERNE LE LOGICIEL, LE(S) MANUEL(S) DE 
PRODUITS, LA DOCUMENTATION ECRITE ET TOUT MATERIEL QUI 
L' ACCOMPAGNENT. CETTE GARANTIE LIMITEE VOUS ACCORDE DES DROITS 
JURIDIQUES SPECIFIQUES. 

PAS D'OBLIGATION POUR LES DOMMAGES INDlRECTS - MICROSOFT OU SES 
FOURNISSEURS N' AURONT D'OBLIGATION EN AUCUNE CIRCONSTANCE POUR 
TOUT AUTRE DOMMAGE QUEL QU'IL SOIT (Y COMPRIS, SANS LIMITATION, LES 
DOMMAGES ENTRAINES PAR LA PERTE DE BENEFICES, L'INTERRUPTION DES 
AFFAIRES, LA PERTE D'INFORMATION COMMERCIALE OU TOUTE AUTRE PERTE 
PECUNIAIRE) DECOULANT DE L'UTILISATION OU DE L'IMPOSSIBILITE 
D'UTILISATION DE CE PRODUIT MICROSOFT, ET CE, MEME SI MICROSOFT A ETE 
A VISE DE LA POSSIBILITE DE TELS DOMMAGES. EN TOUT CAS, LA SEULE 
OBLIGATION DE MICROSOFT EN VERTU DE TOUTE DISPOSITION DE CETTE 
CONVENTION SE LIMITERA AU MONTANT EN FAIT PA YE PAR VOUS POUR LE 
LOGICIEL. 

La presente Convention est regie par Ies lois de la province d'Ontario, Canada. Chacune des parties 
ala presente reconnait irrevocablement la competence des tribunaux de la province d'Ontario et 
consent a instituer tout litige qui pourrait decouler de la presente aupres des tribunaux situes dans Ie 
district judiciaire de York, province d'Ontario. 

Au cas ou vous auriez des questions concernant cette licence ou que vous desiriez vous mettre en 
rapport avec Microsoft pour quelque raison que ce soit, veuillez contacter la succursale Microsoft 
desservant votre pays, dont l'adresse est fournie dans ce produit, ou ecrire a: Microsoft Customer 
Sales and Service, One Microsoft Way, Redmond, Washington 98052-6399, USA. 
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If you acquired your Microsoft® product in ENGLAND, SCOTLAND, WALES or IRELAND, the 
following limited warranty applies to you: 

LIMITED WARRANTY - Microsoft warrants that (a) the SOFTWARE will perform substantially 
in accordance with the accompanying Product Manual(s) for a period of 90 days from the date of 
receipt; and (b) any Microsoft supplied hardware accompanying the SOFTWARE will be free from 
defects in materials and workmanship under normal use and service for a period of one year from the 
date of receipt. Any implied warranties on the SOFTWARE and hardware are limited to 90 days and 
one (1) year, respectively, or the shortest period permitted by applicable law, whichever is greater. 

CUSTOMER REMEDIES - Microsoft's entire liability and your exclusive remedy shall be, at 
Microsoft's option, either (a) return of the price paid or (b) repair or replacement of the SOFTWARE 
or hardware that does not meet Microsoft's Limited Warranty and which is returned to Microsoft with 
a copy of your receipt. This Limited Warranty is void if failure of the SOFTWARE or hardware has 
resulted from accident, abuse, or misapplication. Any replacement SOFTWARE will be warranted 
for the remainder of the original warranty period or 30 days, whichever is longer. 

NO OTHER WARRANTIES - TO THE MAXIMUM EXTENT PERMITTED BY 
APPLICABLE LAW, MICROSOFT DISCLAIMS ALL OTHER WARRANTIES, EITHER 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO 

. THE SOFTWARE, THE ACCOMPANYING PRODUCT MANUAL(S) AND WRITTEN 
MATERIALS, AND ANY ACCOMPANYING HARDWARE. THE LIMITED WARRANTY 
CONTAINED HEREIN GIVES YOU SPECIFIC LEGAL RIGHTS. 

NO LIABILITY FOR CONSEQUENTIAL DAMAGES - TO THE MAXIMUM EXTENT 
PERMITTED BY APPLICABLE LAW, MICROSOFT AND ITS SUPPLIERS SHALL NOT 
BE LIABLE FOR ANY OTHER DAMAGES WHATSOEVER (INCLUDING, WITHOUT 
LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, 
LOSS OF BUSINESS INFORMATION, OR OTHER PECUNIARY LOSS) ARISING OUT OF 
THE USE OF OR INABILITY TO USE THIS MICROSOFT PRODUCT, EVEN IF MICROSOFT 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, 
MICROSOFT'S ENTIRE LIABILITY UNDER ANY PROVISION OF THIS AGREEMENT 
SHALL BE LIMITED TO THE AMOUNT ACTUALLY PAID BY YOU FOR THE SOFTWARE. 

This Agreement is governed by the laws of England. 

Should you have any questions concerning this Agreement, or if you desire to contact Microsoft for 
any reason, please use the address information enclosed in this product to contact the Microsoft 
subsidiary serving your country or write: Microsoft Customer Sales and Services, One Microsoft 
Way, Redmond, Washington 98052-6399, USA. 
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If you acquired your Microsoft® product in the United States of America or ANY OTHER 
COUNTRY, the following limited warranty applies to you: 

LIMITED WARRANTY - Microsoft warrants that (a) the SOFTWARE will perform substantially 
in accordance with the accompanying written materials for a period of ninety (90) days from the 
date of receipt, and (b) any hardware accompanying the SOFTWARE will be free from defects in 
materials and workmanship under normal use and service for a period of one (1) year from the date 
of receipt. Any implied warranties on the SOFTWARE and hardware are limited to ninety (90) days 
and one (1) year, respectively. Some states/jurisdictions do not allow limitations on duration of an 
implied warranty, so the above limitation may not apply to you. 

CUSTOMER REMEDIES - Microsoft's and its suppliers' entire liability and your exclusive 
remedy shall be, at Microsoft's option, either (a) return of the price paid, or (b) repair or replacement 
of the SOFTWARE or hardware that does not meet Microsoft's Limited Warranty and which is 
returned to Microsoft with a copy of your receipt. This Limited Warranty is void if failure of the 
SOFTWARE or hardware has resulted from accident, abuse, or misapplication. Any replacement 
SOFTWARE or hardware will be warranted for the remainder of the original warranty period or 
thirty (30) days, whichever is longer. Outside the United States, neither these remedies nor any 
product support services offered by Microsoft are available without proof of purchase from an 
authorized non-U.S. source, 

NO OTHE.R WARRANTIES -~ TO THE MAXIMUM EXTENT PERMITTED BY 
APPLICABLE LAW, MICROSOFT AND ITS SUPPLIERS DISCLAIM ALL OTHER 
WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE, WITH REGARD TO THE SOFTWARE, THE ACCOMPANYING WRITTEN 
MATERIALS, AND ANY ACCOMPANYING HARDWARE. THIS LIMITED WARRANTY 
GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHERS WHICH VARY FROM 
STATE/JURISDICTION TO STATE/JURISDICTION. 

NO LIABILITY FOR CONSEQUENTIAL DAMAGES - TO THE MAXIMUM EXTENT 
PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL MICROSOFT OR ITS 
SUPPLIERS BE LIABLE FOR ANY DAMAGES WHATSOEVER (INCLUDING WITHOUT 
LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, 
LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT 
OF THE USE OF OR INABILITY TO USE THIS MICROSOFT PRODUCT, EVEN IF 
MICROSOFT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE 
SOME STATES/JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF 
LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE 
LIMITATION MAY NOT APPLY TO YOU. 

If you acquired this product in the United States, this Agreement is governed by the laws of the State 
of Washington. If this product was acquired outside the United States, then local law may apply. 

Should you have any questions concerning this Agreement, or if you desire to contact Microsoft for 
any reason, please contact your local Microsoft subsidiary or sales office or write: Microsoft Sales 
and Service, One Microsoft Way, Redmond, Washington 98052-6399, USA. 



Glossary 

A 
account See user account. 

Account policy Controls the way passwords must 
be used by all user accounts of a domain, or of an 
individual computer. 

administrative alerts Relate to server and resource 
use; warn about problems in areas such as security 
and access, user sessions, server shutdown 
because of power loss (when UPS is available), 
directory replication, and printing. When a 
computer generates an administrative alert, a 
message is sent to a predefined list of users and 
computers. See also Alerter service. 

Alerter service Notifies selected users and 
computers of administrative alerts that occur on a 
computer. Used by the Server and other services. 
Requires the Messenger service. See also 
administrative alerts. 

archive bit Backup programs use the archive bit 
to mark files after backing them up, using the 
normal or incremental backup types. 

ASCII file See text file. 

associate To identify a filename extension as 
"belonging" to a certain application so that when 
you open any file with that extension, the 
application starts automatically. 

Audit policy For the servers of a domain or for an 
individual computer, defines the type of security 
events that are logged. 

559 

auditing Tracking activities of users by recording 
selected types of events in the security log of a 
server or a workstation. 

authentication Validation of a user's logon 
information. When a user logs on to an account 
on a Windows NT workstation, the authentication 
is performed by that workstation. When a user 
logs on to an account on a Windows NT 
Advanced Server domain, that authentication may 
be performed by any server of that domain. See 
also server, trust relationship. 

B 
batch program An ASCII file (unformatted text 
file) that contains one or more Windows NT 
commands. A batch program's filename has a 
.BAT or .CMD extension. When you type the 
filename at the command prompt, the commands 
are processed sequentially. 

boot loader Defines the information needed 
for system startup, such as the location for the 
operating system's files. Windows NT 
automatically creates the correct configuration 
and checks this information whenever you start 

I your system. 

boot partition The volume, formatted for either 
an NTFS, FAT, or HPFS file system, that contains 
the Windows NT operating system and its support 
files. The boot partition can be (but does not have 
to be) the same as the system partition. 

branch A segment of the directory tree, 
representing a directory and any subdirectories 
it contains. 
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browse To look through lists of directories, files, 
user accounts, groups, domains, or computers. 

buffer A temporary storage place for information. 

built-in groups The default groups provided with 
Windows NT and Windows NT Advanced Server. 
Built-in groups have been granted useful 
collections of rights and built-in abilities. 

In most cases, a built-in group will provide all 
the capabilities needed by a particular user. For 
example, if a domain user account belongs to the 
built-in Administrators group, logging on with 
that account gives a user administrative 
capabilities over the domain and the servers of the 
domain. To provide a needed set of capabilities to 
a user account, assign it to the appropriate built-in 
group. See also group, User Manager, User 
Manager for Domains. 

C 
check box A small, square box in a dialog box 
that can be selected or cleared, representing an 
option that you can turn on or off. When a check 
box is selected, an X appears in the box. 

choose To pick an item that begins an action in 
Windows NT. You often choose a command on a 
menu to perform a task, and you choose an icon to 
start an application. 

click To quickly press and release a mouse 
button. 

client A computer that accesses shared network 
resources provided by another computer (called a 
server). See also server. 

Clipboard A temporary storage area in memory, 
used to transfer information. You can cut or copy 
information onto the Clipboard and then paste it 
into another document or application, or into the 
ClipBook. See also ClipBook. 

ClipBook Permanent storage of information you 
want to save and share with others. This differs 
from the Clipboard, which temporarily stores 
information. You can save the current contents of 
the Clipboard by using the ClipBook Viewer to 
copy it into your local ClipBook. You can then 
share that information, allowing others to connect 
to the ClipBook on your computer. See also 
Clipboard, ClipBook page. 

ClipBook page A unit of information pasted 
into a local ClipBook. The ClipBook page is 
permanently saved. Information on a ClipBook 
page can be copied back onto the Clipboard and 
then pasted into documents. You can share 
ClipBook pages on the network. 

Clipbook service Supports the ClipBook Viewer 
application, allowing pages to be seen by remote 
ClipBooks. 

Computer Browser service Maintains an up­
to-date list of computers and provides the list 
to applications when requested. Provides the 
computer lists displayed in the Select Computer 
and Select Domain dialog boxes, and for 
Windows NT Advanced Server only, the lists 
in the Server Manager window. 

computer name A unique name of up to 15 
uppercase characters that identifies a computer to 
the network. The name cannot be the same as any 
other computer or domain name in the network. 

configuration registry A database repository for 
information about a computer's configuration. 

connected user A user accessing a computer or a 
resource across the network. 

Control menu A menu that contains commands 
you can use to manipulate a window. 



Control-menu box The icon at the left of the title 
bar. This icon opens the Control menu for a 
window. 

controller See domain controller. 

o 
DOE See dynamic data exchange. 

default printer The printer that is used if you 
choose the Print command without first 
specifying which printer you want to use with 
an application. You can have only one default 
printer; it should be the printer you use most 
often. 

default profile 
See system default profile, user default profile. 

dependent service 
A service that requires the support of another 
service. For example, the Alerter service is 
dependent on the Messenger service. 

desktop The background of your screen, on 
which windows, icons, and dialog boxes appear. 

destination directory The directory to which you 
intend to copy or move one or more files. 

destination document The document into which 
a package or a linked or embedded object is 
being inserted. For an embedded object, this is 
sometimes also called the container document. 

device contention The way Windows NT 
allocates access to peripheral devices, such as 
a modem or a printer, when more than one 
application is trying to use the same device. 

device driver A program that enables a specific 
piece of hardware (device) to communicate with 
Windows NT. Although a device may be installed 
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on your system, Windows NT cannot recognize 
the device until you have installed and configured 
the appropriate driver. 

dimmed Unavailable, disabled, or grayed. A 
dimmed button or command is displayed in light 
gray instead of black, and it cannot be chosen. 

directory Part of a structure for organizing your 
files on a disk. A directory can contain files and 
other directories (called subdirectories). See also 
directory tree. 

directory replication The copying of a master 
set of directories from a server (called an export 
server) to specified servers or workstations (called 
import computers) in the same or other domains. 
Replication simplifies the task of maintaining 
identical sets of directories and files on multiple 
computers, because only a single master copy of 
the data must be maintained. Files are replicated 
when they are added to an exported directory and 
every time a change is saved to the file. See also 
Directory Replicator service. 

Directory Replicator service Replicates 
directories, and the files in those directories, 
between computers. See also directory replication. 

directory tree A graphical display of a disk's 
directory structure. The directories on the disk are 
shown as a branching structure. The top-level 
directory is the root directory. 

directory window A File Manager window that 
displays the contents of a disk. The window 
shows both the directory tree and the contents of 
the current directory. 

disabled user account A user account that does 
not permit logons. The account appears in the user 
account list of the User Manager window and can 
be restored to enabled status at any time. See also 
user account. 
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disk configuration information 
The Windows NT Registry includes information 
on the configuration of your disk(s): assigned 
drive letters, stripe sets, mirror sets, volume sets, 
and stripe sets with parity. 

disk duplexing 
Establishing a mirrored copy on a disk with a 
different controller. 

disk mirroring Maintaining a fully redundant 
copy of a partition on another disk. 

disk striping Writing data in stripes across a 
volume that has been created from areas of free 
space on from 
2 to 32 disks. 

domain For Windows NT Advanced Server, a 
collection of computers that share a common 
domain database and security policy. Each 
domain has a unique name. See also workgroup. 

domain controller For a Windows NT Advanced 
Server domain, the server that authenticates 
domain logons and maintains the security policy 
and the master database for a domain. See also 
server. 

domain database See SAM database. 

domain name The name by which a domain is 
known to the network. 

domain synchronization See synchronize. 

double-click To rapidly press and release a mouse 
button twice without moving the mouse. Double­
clicking carries out an action, such as starting an 
application. 

downloaded fonts Fonts that you send to a printer 
either before or during the printing of a document. 
When you send a font to a printer, it is stored in 
printer memory until it is needed. 

drive icon An icon in a directory window in 
File Manager that represents a disk drive on your 
system. Different icons depict floppy disk drives, 
hard disk drives, network drives, RAM drives, 
and CD-ROM drives. 

drivebar Allows you to change drives by 
selecting one of the drive icons. 

dynamic data exchange A form of interprocess 
communication (IPC) implemented in the 
Microsoft Windows family of operating systems. 
Two or more programs that support dynamic data 
exchange (DDE) can exchange information and 
commands. 

E 
embedded object Presents information created in 
another application. Information in the embedded 
object does not exist in another file outside your 
document. 

encapsulated PostScript (EPS) file 
A file that prints at the highest possible resolution 
for your printer. An EPS file may print faster than 
other graphical representations. Some Windows 
NT and non-Windows NT graphical applications 
can import EPS files. 

environment variable A string consisting of 
environment information, such as a drive, path, 
or filename, associated with a symbolic name that 
can be used by Windows NT. You use the System 
option in Control Panel or the set command from 
the Windows NT command prompt to define 
environment variables. 

event Any significant occurrence in the system or 
in an application that requires users to be notified, 
or an entry to be added to a log. 

Event Log service Records events in the system, 
security, and application logs. 



export path In directory replication, a path from 
which subdirectories, and the files in those 
subdirectories, are automatically exported from an 
export server. See also directory replication. 

export server In directory replication, a server 
from which a master set of directories is exported 
to specified servers or workstations (called import 
computers) in the same or other domains. See also 
directory replication. 

extended partition Created from free space on 
a hard disk, it can be subpartitioned into zero 
or more logical drives. Only one of the four 
partitions allowed per physical disk can be an 
extended partition, and no primary partition needs 
to be present to create an extended partition. 

extension The period and up to three characters 
at the end of a filename. An extension usually 
indicates the type of file or directory. 

external command A command that is stored in 
its own file and loaded from disk when you use 
the command. 

F 
family set A collection of related tapes containing 
several backup sets. 

FAT File allocation table; a table or list 
maintained by some operating systems to keep 
track of the status of various segments of disk 
space used for file storage. 

file allocation table (FAT) See FAT. 

file system In an operating system, the overall 
structure in which files are named, stored, and 
organized. 

font set A collection of font sizes for one font, 
customized for a particular display and printer. 
Font sets determine what text looks like on screen 
and on paper. 
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free space An unused and unformatted portion 
of a hard disk that can be partitioned or 
subpartitioned. Free space within an extended 
partition is available for the creation of logical 
drives. Free space that is not within an extended 
partition is available for the creation of a partition, 
with a maximum of four partitions allowed. 

full name A user's complete name, usually 
consisting of the last name, first name, and middle 
initial. The full name is information that can be 
maintained by User Manager as part of the 
information identifying and defining a user 
account. See also user account. 

G 
global account For Windows NT Advanced 
Server, a normal user account in a user's home 
domain. Most user accounts are global accounts. 
If there are multiple domains in the network, it is 
best if each user in the network has only one user 
account, in only one domain, and each user's 
access to other domains is accomplished through 
the establishment of domain trust relationships. 
See also local account. 

global group For Windows NT Advanced Server, 
a group that can be used in its own domain, 
servers and workstations of the domain, and 
trusting domains. In all these places it can be 
granted rights and permissions and can become a 
member of local groups. However, it can contain 
only user accounts from its own domain. Global 
groups provide a way to create handy sets of users 
from inside the domain, available for use both in 
and out of the domain. 

Global groups cannot be created or maintained 
on Window NT workstations. However, for 
Windows NT workstations that participate in a 
domain, domain global groups can be granted 
rights and permissions at those workstations, and 
can become members of local groups at those 
workstations. See also group, local group. 
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group In User Manager, an account containing 
other accounts that are called members. The 
permissions and rights granted to a group are 
also provided to its members, making groups a 
convenient way to grant common capabilities to 
collections of user accounts. For Windows NT, 
groups are managed with User Manager~ For 
Windows NT Advanced Server, groups are 
managed with User Manager for Domains. See 
also built-in groups, global group, local group, 
user account. 

group memberships The groups to which a user 
account belongs. Permissions and rights granted 
to a group are also provided to its members. In 
most cases, the actions a user can perform in 
Windows NT are determined by the group 
memberships of the user account the user is 
logged on to. See also group. 

group name A unique name identifying a local or 
global group to Windows NT. A group's name 
cannot be identical to any other group name or 
user name of its own domain or workstation. See 
also global group, local group. 

group windO\ ... In Program Manager, a window 
that displays the program-item icons in a group. 

H 
high-performance file system See HPFS. 

home directory A directory that is accessible to 
the user and contains files and programs for that 
user. A home directory can be assigned to an 
individual user or can be shared by many users. 

HPFS High-performance file system (HPFS); 
primarily used with the OS/2 operating system 
version 1.2 or later. It supports long filenames but 
does not provide security. 

import computers In directory replication, the 
servers or workstations that receive copies of the 
master set of directories from an export server. 
See also directory replication. 

import path In directory replication, the path to 
which imported subdirectories, and the files in 
those subdirectories, will "be stored on an import 
computer. See also directory replication. 

internal command Commands that are stored in 
the file CMD.EXE and that reside in memory at 
all times. 

interrupt request lines (IRQ) Hardware lines over 
which devices can send signals to get the attention 
of the processor when the device is ready to 
accept or send information. Typically, each 
device connected to the computer uses a separate 
IRQ. 

l( 
kernel driver A driver that accesses hardware. 

L 
linked object A representation or placeholder 
for an obj ect that is inserted into a destination 
document. The object still exists in the source file 
and, when it is changed, the linked object is 
updated to reflect the changes. 

list box In a dialog box, a box that lists available 
choices-for example, a list of all files in a 
directory. If all the choices do not fit in the list 
box, there is a scroll bar. 

local account For Windows NT Advanced 
Server, a user account provided in a domain for 
a user whose global account is not in a trusted 
domain. Not required where trust relationships 
exist between domains. See also global account, 
user account. 



local group For Windows NT, a group that can 
be granted permissions and rights only for its 
own workstation. However, it can contain user 
accounts from its own computer, and (if the 
workstation participates in a domain) user 
accounts and global groups both from its own 
domain and from trusted domains. Local groups 
provide a way to create handy sets of users from 
both inside and outside the workstation, to be 
used only at the workstation. 

For Windows NT Advanced Server, a group that 
can be granted permissions and rights only for the 
servers of its own domain. However, it can 
contain user accounts and global groups both 
from its own domain and from trusted domains. 
Local groups provide a way to create handy sets 
of users from both inside and outside the domain, 
to be used only at servers of the domain. See also 
global group, group. 

local printer A printer that is directly connected 
to one of the ports on your computer. 

logical drive A subpartition of an extended 
partition on a hard disk. 

logon hours For Windows NT Advanced Server, 
a definition of the days and hours during which a 
user account can connect to a server. When a user 
is connected to a server and the logon hours are 
exceeded, the user will either be disconnected 
from all server connections or will be allowed to 
remain connected but denied any new 
connections. 

logon script Typically a batch file, a logon script 
runs automatically every time the user logs on. 
lt can be used to configure a user's working 
environment at every logon, and it allows an 
administrator to affect a user's environment 
without managing all aspects of it. A logon script 
can be assigned to one or more user accounts. 

MS· DOS • based application 565 

logon script path When a user logs on, the 
computer authenticating the logon locates the 
specified logon script (if one has been assigned to 
that user account) by following that computer's 
local logon script path (usually C:\WINNT 
\SYSTEM32\REPL\IMPORT\SCRIPTS). See also 
logon script. 

logon workstations For Windows NT Advanced 
Server, the workstations from which a user is 
allowed to log on. 

M 
mandatory user profile For Windows NT 
Advanced Server, a user profile created by an 
administrator and assigned to one or more users. 
A mandatory user profile cannot be changed by 
the user and remains the same from one logon 
session to the next. See also personal user profile, 
user profile. 

maximum password age The period of time a 
password can be used before the system requires 
the user to change it. See also Account policy. 

Messenger service Sends and receives messages 
sent by administrators or by the Alerter service. 

minimum password age The period of time a 
password must be used before the user can change 
it. See also Account policy. 

minimum password length The fewest characters 
a password can contain. See also Account policy. 

MS-DOS-based application An application that is 
designed to run with MS-DOS, and therefore may 
not be able to take full advantage of all Windows 
NT features. 
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N 
named pipe An interprocess communication 
mechanism that allows one process to 
communicate with another local or remote 
process. 

Net Logon service For Windows NT Advanced 
Server, performs authentication of domain logons, 
and keeps the domain's database synchronized 
between the domain controller and the other 
Windows NT Advanced Servers of the domain. 

Network DDE service The Network DDE 
(dynamic data exchange) service provides a 
network transport and security for DDE 
conversations. 

Network DDE DSDM service The Network DDE 
DSDM (DDE share database manager) service 
manages shared DDE conversations. It is used by 
the Network DDE service. 

network device driver Software that coordinates 
communication between the network adapter card 
and the computer's hardware and other software, 
controlling the physical function of the network 
adapter cards. 

network directory See shared directory. 

non-Windows NT application Refers to an 
application that is designed to run with Windows 
3.x, MS-DOS, OS/2, or POSIX, but not 
specifically with Windows NT and that may not 
be able to take full advantage of all Windows NT 
features (such as memory management). 

NT See Windows NT. 

NT file system See NTFS. 

NTFS Windows NT file system; an advanced file 
system designed for use specifically within the 
Windows NT operating system. It supports file 
system recovery, extremely large storage media, 

and various features for the POSIX subsystem. 
It also supports object-oriented applications by 
treating all files as objects with user-defined and 
system-defined attributes. 

o 
object Any piece of information, created by 
using a Windows-based application with object 
linking and embedding capabilities, that can be 
linked or embedded into another document. 

object linking and embedding A way to transfer 
and share information between applications. 

option button A small, round button that appears 
in a dialog box. Within a group of related option 
buttons, you can select only one button. 

orphan A member of a mirror set or a stripe set 
with parity that has failed in a severe manner, 
such as a loss of power or a complete head crash. 
When this happens, the fault-tolerance driver 
determines that it can no longer use the orphaned 
member and directs all new reads and writes to 
the remaining members of the fault-tolerance 
volume. 

p 
package An icon that represents an embedded or 
linked object. When you choose the package, the 
application used to create the object either plays 
the object (for example, a sound file) or opens and 
displays the object. 

page In ClipBook, one complete entry that has 
been pasted in. In memory, a fixed-size block. 

paging file See swap file. 

partition A portion of a physical disk that 
functions as though it were a physically separate 
unit. See also system partition. 



password A unique string of characters that 
must be provided before a logon or an access is 
authorized. A password is a security measure used 
to restrict logons to user accounts and access to 
computer systems and resources. For Windows 
NT, a password for a user account can be up to 
14 characters, and is case-sensitive. 
See also Account policy. 

password uniqueness The number of new 
passwords that must be used by a user account 
before an old password can be reused. See also 
Account policy. 

path Specifies the location of a file within the 
directory tree. For example, to specify the path 
of a file named README.WRI located in the 
WINDOWS directory on drive C, you would 
type c:\windows\readme.wri. 

permission A rule associated with an object 
(usually a directory, file, or printer) to regulate 
which users can have access to the object and in 
what manner. See also right. 

personal groups In Program Manager, a program 
group you have created and that contains program 
items. Personal groups are stored with your logon 
information and appear each time you log on. 
See also group. 

personal user profile For Windows NT Advanced 
Server, a user profile created by an administrator 
and assigned to one user. A personal user profile 
retains changes the user makes to the per-user 
settings of the Windows NT environment, and 
reimplements the newest settings each time that 
user logs on at any Windows NT workstation. 
See also mandatory user profile, user profile. 

plotter font A font created by a series of dots 
connected by lines. Plotter fonts can be scaled to 
any size and are most often printed on plotters. 
Some dot-matrix printers also support plotter 
fonts. 
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port A connection or socket used to connect a 
device, such as a printer, monitor, or modem, to 
your computer. Information is sent from your 
computer to the device through a cable. 

primary partition A portion of a physical disk that 
can be marked for use by an operating system. 
There can be up to four primary partitions (or 
up to three, if there is an extended partition) per 
physical disk. A primary partition cannot be 
subpartitioned, 

printer driver A program that controls how vour 
computer and printer interact " 

printer fonts Fonts that are built mto vour printer. 
These fonts are usually located in the printer's 
read-only memory (ROM), 

printer window Shows information for one of the 
printers that you have installed or to which you 
are connected. For each printer, you can see what 
documents are waiting to be printed, who owns 
them, how large they are, and other information. 

program file A file that starts an application or 
program. A program file has an .EXE, .PIF, 
.COM, or .BAT filename extension. 

program group In Program Manager, a collection 
of applications. Grouping your applications 
makes them easier to find when you want to start 
them. 

program information file (PIF) A file that provides 
information about how Windows NT should run a 
non-Windows NT application. PIFs contain such 
items as the name of the file, a start-up directory, 
and multitasking options for applications running 

, in 386 enhanced mode. 

program-item icon An application, accessory, 
or document represented as an icon in a group 
window. 
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Q 

quick format Deletes the file allocation table and 
root directory of a disk but does not scan the disk 
for bad areas. . 

R 
refresh To update displayed information with 
current data. 

registry See configuration registry. 

remote administration Administration of one 
computer by an administrator located at another 
computer and connected to the first computer 
across the network. 

remote procedure call RPC, a message-passing 
facility that allows a distributed application to 
call services available on various computers in a 
network. Used during remote administration of I 

computers. 

Remote Procedure Call service 
See RPC service. 

replication 
See directory replication. 

resource Any part of a computer system or a 
network, such as a disk drive, printer, or memory, 
that can be allotted to a program or a process 
while it is running. 

right Authorizes a user to perform certain actions 
on the system. Rights apply to the system as a 
whole, and are different from permissions, which 
apply to specific objects. See also permission. 

root directory See directory tree. 

RPC See remote procedure call. 

RPC Locator service The Remote Procedure Call 
Locator service allows distributed applications to 
use the RPC Name service. The RPC Locator 
service manages the RPC Name service database. 

The server side of a distributed application 
registers its availability with the RPC Locator 
service. The client side of a distributed 
application queries the RPC Locator service to 
find available compatible server applications. 

RPC service The Remote Procedure Call service 
is the RPC subsystem for Microsoft Windows NT. 
The RPC subsystem includes the endpoint mapper 
and other miscellaneous RPC services. 

5 
SAM Security accounts manager. A Windows NT 
protected subsystem that maintains the SAM 
database and provides an application 
programming interface (API) for accessing the 
database. 

SAM database A database of security information 
that includes security information (such as user 
account names and passwords) and the settings 
of the security policies. For a Windows NT 
workstation, it is managed with User Manager. 
For a Windows NT Advanced Server domain, 
it is managed with User Manager for Domains. 

Schedule service Supports and is required for 
use of the at command. The at command can 
schedule commands and programs to run on a 
computer at a specified time and date. 

screen buffer The size reserved in memory for 
the command prompt display. 

screen fonts Fonts displayed on your screen. 
Soft -font manufacturers often provide screen 
fonts that closely match the soft fonts for your 
printer. This ensures that your documents look the 
same on the screen as they do when printed. 



scroll To move through text or graphics (up, 
down, left, or right) in order to see parts of the file 
that cannot fit on the screen. 

scroll bar A bar that appears at the right and/or 
bottom edge of a window or list box whose 
contents are not completely visible. Each scroll 
bar contains two scroll arrows and a scroll box, 
which enable you to scroll through the contents 
of the window or list box. 

security accounts manager See SAM. 

security database See SAM database. 

security ID A unique name that identifies a 
logged-on user to the security system. Security 
IDs (SIDs) can identify one user or a group of 
users. 

security identifier 
See security ID. 

security log 
Records security events. This helps track changes 
to the security system and identify any possible 
breaches to security. For example, depending on 
the Audit settings in User Manager, attempts to 
log on to the system may be recorded in the 
security log. See also event. 

security pOlicies For a Windows NT workstation, 
the security policies consist of the Account, User 
Rights, and Audit policies, and are managed with 
User Manager. 

For a Windows NT Advanced Server domain, the 
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selection cursor The marking device that shows 
where you are in a window, menu, or dialog box 
and what you have selected. The selection cursor 
can appear as a highlight or as a dotted rectangle 
around text. 

server For Windows NT, refers to a computer 
that provides shared resources to network users. 
See also client. 

For Windows NT Advanced Server domains, 
refers to a computer that receives a copy of the 
domain's security policy and domain database, 
and authenticates network logons. See also 
domain controller. 

Server Manager In Windows NT Advanced 
Server, an application used to view and 
administer domains, workgroups, and computers. 

Server service Provides RPC (remote procedure 
call) support, and file, print, and named pipe 
sharing. 

service A process that performs a specific system 
function and often provides an application 
programming interface (API) for other processes 
to call. Windows NT services are RPC-enabled, 
meaning that their API routines can be called 
from remote computers. 

share To make resources, such as directories, 
printers, and ClipBook pages, available to 
network users. 

share name The name of a shared resource. 

security policies consist of the Account, User shared directory A directory that network users 
Rights, Audit, and Trust Relationships policies, can connect to. 
and are managed with User Manager for 
Domains. shared network directory See.shared directory. 
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shared page In ClipBook, a page that has been 
made available for others to access. 

shared resource Any device, data, or program 
that is lIsed by more than one other device or 
program. For Windows NT, shared resources refer 
to any resource that is made available to network 
lIsers, such as directories, files, printers, and 
named pipes. 

shortcut key A key or key combination, available 
for some commands, that you can press to carry 
out a command without first selecting a menu. 
Shortcut keys are listed to the right of commands 
on a menu. 

SID See security ID. 

source directory The directory that contains the 
file or files you intend to copy or move. 

source document The document where a linked 
or embedded object was originally created. 

split bar Divides a directory window in two parts: 
the directory tree is displayed on the left, and the 
contents of the current directory are on the right. 

status bar A line of information related to the 
appliCation in the window. Usually located at the 
bottom of a window. Not all windows have a 
status bar. 

string A data structure composed of a sequence 
of characters, usually representing human­
readable text. 

SUbdirectory A directory within a directory. 

swap file A special file on your hard disk. With 
virtual memory under Windows NT, some of the 
program code and other information is kept in 
RAM while other information is temporarily 
swapped to virtual memory. When that 
information is required again, Windows NT pulls 
it back into RAM and, if necessary, swaps other 

information to virtual memory. Also called a 
paging file. 

synchronize To replicate the domain database 
from the domain controller to one server of the 
domain, or to all the servers of a domain. This is 
usually performed automatically by the system, 
but can also be invoked manually by an 
administrator. 

syntax The order in which you must type a 
command and the elements that follow the 
command. Windows NT commands have up to 
four elements: command name, parameters, 
switches, and values. 

system default profile For Windows NT 
Advanced Server, the user profile that is loaded 
when Windows NT is running and no user is 
logged on. When the Welcome dialog box is 
visible, the system default profile is loaded. 
See also user default profile, user profile. 

system partition The volume that contains the 
hardware-specific files needed to load Windows 
NT. See also partition. 

T 
Task List A window that shows all running 
applications and enables you to switch between 
them. You can open Task List by choosing Switch 
To from the Control menu or by pressing 
CTRL+ESC. 

text file A file containing only letters, numbers, 
and symbols. A text file contains no formatting 
information, except possibly linefeeds and 
carriage returns. A text file is an ASCII file. 

text-only An ASCII file; contains no formatting. 

time-out If a device is not performing a task, the 
amount of time the computer should wait before 
detecting it as an error. 



time slice The amount of processor time allocated 
to an application, usually measured in 
milliseconds. 

toolbar A series of shortcut buttons providing 
quick access to commands. Usually located 
directly below the menu bar. Not all windows 
have a toolbar. 

trust See trust relationship. 

trust relationship Trust relationships are links 
between domains that enable pass-through 
authentication, in which a user has only one user 
account in one domain, yet can access the entire 
network. User accounts and global groups defined 
in a trusted domain can be given rights and 
resource permissions in a trusting domain, even 
though those accounts don't exist in the trusting 
domain's database. A trusting domain honors the 
logon authentications of a trusted domain. 

U 
uninterruptible power supply (UPS) 
See UPS. 

UPS Uninterruptible power supply; a battery­
operated power supply connected to a computer to 
keep the system running during a power failure. 

UPS service Manages an uninterruptible power 
supply connected to a computer. See also UPS. 

user account Consists of all the information that 
defines a user to Windows NT. This includes such 
things as the user name and password required for 
the user to log on, the groups in which the user 
account has membership, and the rights and 
permissions the user has for using the system and 
accessing its resources. For Windows NT, user 
accounts are managed with User Manager. For 
Windows NT Advanced Server, user accounts are 
managed with User Manager for Domains. See 
also group. 
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user account database See SAM database. 

user default profile For Windows NT Advanced 
Server, the user profile that is loaded by a server 
when a user's assigned profile cannot be accessed 
for any reason, when a user without an assigned 
profile logs on to the computer for the first time, 
or when a user logs on to the Guest account. See 
also system default profile, user profile. 

User Manager A Windows NT workstation tool 
used to manage the security for a workstation. 
Administers user accounts, groups, and security 
policies. 

User Manager for Domains A Windows NT 
Advanced Server tool used to manage security for 
a domain or an individual computer. Administers 
user accounts, groups, and security policies. 

user name A unique name identifying a user 
account to Windows NT. An account's user name 
cannot be identical to any other group name or 
user name of its own domain or workstation. See 
also user account. 

user profile Configuration information can be 
retained on a user-by-user basis, and is saved in 
user profiles. The information includes all the per­
user settings of the Windows NT environment, 
such as the desktop arrangement, personal 
program groups and the program items in those 
groups, screen colors, screen savers, network 
connections, printer connections, mouse settings, 
window size and position, and more. When a user 
logs on, the user's profile is loaded and the user's 
Windows NT environment is configured 
according to that profile. 

User Profile Editor For Windows NT Advanced 
Server, a tool used to create, edit, and save 
personal user profiles, mandatory user profiles, 
the user default profile, and the system default 
profile. See also user profile. 

user right See right. 
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User Rights policy Manages the assignment of 
rights to groups and user accounts. 

V 
virtual memory Space on a hard disk that 
Windows NT uses as if it were actually memory. 
Windows NT does this through the use of swap 
files. The benefit of using virtual memory is that 
you can run more applications at one time than 
your system's physical memory would otherwise 
allow. The drawbacks are the disk space required 
for the virtual-memory swap file and the 
decreased execution speed when swapping is 
required. 

virtual printer memory In a PostScript printer, a 
part of memory that stores font information. The 
memory in PostScript printers is divided into 
banded memory and virtual memory. The banded 
memory contains graphics and page-layout 
information needed to print your documents. The 
virtual memory contains any font information that 
is sent to your printer either when you print a 
document or when you download fonts. 

volume A partition or collection of partitions that 
have been formatted for use by a file system. 

w 
wildcard A character that represents one or more 
characters. The question mark (?) wildcard can be 
used to represent any single character, and the 
asterisk (*) wildcard can be used to represent any 
character or group of characters that might match 
that position in other filenames. 

Windows NT The portable, secure, 32-bit, 
preemptive multitasking member of the Microsoft 
Windows operating system family. 

Windows NT Advanced Server A superset of 
Windows NT, Windows NT Advanced Server 
provides centralized management and security, 
advanced fault tolerance, and additional 
connectivity. 

workgroup For Windows NT, a workgroup is 
a collection of computers that are grouped for 
viewing purposes. Each workgroup is identified 
by a unique name. See also domain. 

workstation In general, a powerful computer 
having considerable calculating and graphics 
capability. For Windows NT, computers running 
the Windows NT operating system are called 
workstations, as distinguished from computers 
running Windows NT Advanced Server, which 
are called servers. See also server, domain 
controller. 

Workstation service Provides network 
connections and communications. 
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A 
Access 

permissions See Permissions 
Remote Access Service (RAS) See Remote Access 

Service (RAS) 
restricting, to backup tapes 387-389 
to files and directories 

auditing 100-102,379,402 
controlling 15 
permissions 90-104 
viewing events 409 

Accounts See User accounts 
Addresses 

I/O port base addresses, troubleshooting 481 
Mail addresses 217 
memory buffer addresses, troubleshooting 481 

Administrators 
Administrative Tools group, Program Manager 7 
Administrator account 352 
Administrators group 369 
Mail administrator accounts 229-231 

Alerts 
Alerter service See Services, Alerter 
managing administrative alerts 173-174 
Performance Monitor alerts See Performance Monitor, 

alerts 
sending messages after power failure 147, 148 

Applications 
See also Programs 
Applications group 40 
associating files with applications 78-79 
changing application response time 144 
communications applications 120 
configuring the system, overview 12-14 
correct procedure for logging off 5, 39 
creating program items 45-48 
custom startup files 334-336 
defining startup applications 7 
displaying Control menu 23 
installing with Windows NT Setup 322, 338 
LAN adapter numbers 157 
memory use 142 
MS-DOS-based See MS-DOS-based applications 
OLE applications 295 

Applications (continued) 
OS/2 applications 314,320 
returning to Program Manager from applications 52 
running See Running applications 
setting up 322-323 
setting up to run from Program Manager 338, 498 
shortcut keys See Keys, application shortcut keys 
starting See Starting applications 
supported by Windows NT subsystems 314 
switching between applications 19,23,24,52, 119 
transferring information 30-32, 280-282 
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Windows 3.1-based See Windows 3.1-based applications 
Windows NT applications, overview 6-7 

Appointments, scheduling See Schedule+ 
Audio See Sounds 
Auditing 

access to files and directories 
description 402 
overview 100-102 
viewing events 409 

adding groups or users to auditing list 96-104 
Audit policy 16, 379-380 
events 379-380 
printer usage 198-200 
security events 379-380,402 

AUTOEXEC.BAT, customizing MS-DOS environment 13 
AUTOEXEC.NT 

B 

custom startup files 334-336 
description 316 
running memory-resident programs 319 

Backing up 
See also Backup tapes; Drives, tape drives 
automating with batch files 392-393 
Backup Operators group 370 
backup policies 385 
Backup program 

backing up files to tape· 385-393 
backup status 391-392 
overview 381-384 
restoring files from tape 394-399 
stopping before backup completion 392, 399 
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Backing up (continued) 
backup sets 

appending a new set 388 
backup catalog 394-396 
containing corrupt files 395 
family sets 391 
replacing old sets with new ones 388 
setting options 389 

backup types 390 
commands used 384 
files 

backing up to tape 385-393 
backup catalog 394-396 
backup status 391-392 
corrupt files 392, 395 
local registry files 387-389 

. log options 390 
overview 381-384 
selecting files 385-387 
to floppy disks with backup or xcopy commands 384 

mail folders and system files 236-237 
restoring files See Restoring files from tape 
risk assessment 385 
verifying backups 387-389, 394, 397 

Backup tapes 
See also Backing up; Drives, tape drives 
appending a new backup set 387-389 
building a partial catalog 396 
erasing 400 
formatting 400 
information on loaded tape 387-389, 397 
maintaining 400 
replacing old backup sets with new ones 387-389 
restricting access 387-389 
retensioning 400 
setting tape options 387-389 

Batch files 
automating repeated backups 392-393 
command prompt batch commands 267 
description 280 
logon scripts See Logon scripts 
starting memory-resident programs 320 
UPS command file executed prior to system 

shutdown 148-149 
Battery See UPS 
Bindings See Networks, bindings 
Bitmaps, OLE objects 297 
Booting 

See also Logging on; Starting Windows NT; Startup 
boot loader 13 
boot partitions 424 
defining operating system variables 13 

Booting (colltinued) 
setting boot devices 139 
starting Windows NT 2-3 
startup operating system 140,424 
troubleshooting 474-476 

Browsing the network 
Computer Browser service 175 
for available printers 11 
for shared directories 9 
for shared printers 9 
turning off domain browsing 3-4 

Built-in groups See Groups 
Built-in user accounts See User accounts 
Buttons 

dialog box buttons 29 
mouse buttons, customizing 131 

c 
Character-based applications See MS-DOS-based 

applications 
Characters 

case of NTFS filenames 11, 60, 70 
conventions used in Windows NT documentation xxii 
prohibited in names 11 
sorting international characters 128 
special characters in command prompt parameters 277 
wildcard characters used in filenames 11, 69 

Clipboard 
See also ClipBook 
ClipBook Viewer 306 
copying and cutting information 30-32 
copying files from File Manager 76 
copying screen images 32 
formats 306 
saving contents 306 

ClipBook 
ClipBook Viewer 

connecting to another computer 301 
description 299-306 
placing linked objects on another computer 30'1 
saving and sharing information 299-302 
tools 299 

online demonstration 4 
pages 299-300 

Colors 
command prompt windows 265 
customizing desktop colors 112-115 
printing halftone colors 188 
supported by display adapters 112 

Command prompt 
changing display 261-265 
commands See Command prompt commands 



Command prompt (col/til/I/ed) 
getting help 27,266 
including optional parameters in PIFs 327 
overview 260 
QuickEdit mode 

transferring information 280 
turning on or off 262 

screen buffer size 263-264 
special purpose utilities 275 
starting applications or programs 279-280, 323 
starting or quitting 260 
TCP/IP utilities reference 274 
transferring information 280-282 
windows 

colors 265 
fonts 263 
toggling between window and full screen mode 262 

Command prompt commands 
batch commands 267 
command symbols 275-276 
configuration commands 273-274 
editing 282 
LAN Manager commands 287-289 
MS-DOS commands 283-285 
native commands 267-271, 276 
net commands 267-271 
new Windows NT system commands 283 
online command reference 266 
pausing or canceling commands 283 
recalling with Doskey 282 
subsystem commands 272 
switches 278-279 
syntax 276-279 
using special characters in parameters 277 

Commands 
choosing 21-22 
command prompt commands See Command prompt 

commands 
dimmed 22 
included in OLE packages 308 
initiating with mouse 18 

Common groups See Program Manager, groups 
Communications 

applications 120 
mail messaging system See Mail, system 
settings 120-121 

Compression 
compressing shared Mail folders 235 
disk compression products 485 

Computername 
changing 151-152 
troubleshooting 478 
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Computers See RISC-based computers; X86-bascd 
computers 

CONFIG.NT 
custom startup files 334-336 
description 316 
MS-DOS commands 317 
running memory-resident programs 319 
subsystem configuration commands 273-274 

CONFIG.SYS 
customizing MS-DOS environment 13 
editing OS/2 configuration information 322 
subsystem configuration commands 273-274 

Configuration 
See also Control Panel 
commands 273-274 
customizing with Control Panel 110 

. customizing working environment, suggestions 6-8 
disk configuration information 

See also Registry 
recovering 428-429 
saving 428 
searching for 429 

MS-DOS configuration 316-318 
network 8-9 
OS/2 configuration 321-322 
system 12-14,338-339 
troubleshooting hardware configuration 472-473 
Windows NT 493-498 

Control menu 
description 23-24 
displaying 20 
keyboard shortcut reference 34 

Control Panel 
changing 

application response time 144 
computer name 151-152 
environment variables 141-142 
virtual memory paging file 142-144 

configuring 
desktop appearance 115-118 
device drivers 132-135 
device startup 139 
fonts 121-123 
screen savers 119-120 
serial ports 120-121 
system date, time, and time zone 125-127 
system, overview 12 
UPS 145-148 

customizing 
desktop colors 112-115 
keyboard, cursor, and mouse 129-131 

defining options for the operating system 140-149 
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Control Panel (colltinued) 
Devices option 138-139 
international options 111, 127-128 
joining a domain or workgroup 9, 157-158 
managing sounds 135-137 
network configuration 8, 150-162 
overview 110-111 
sending messages after power failure 147, 148 
Server option 

closing resources 169 
disconnecting users 165, 167 
managing administrative alerts 173-174 
managing server properties 163 
setting up an import computer for directory 

replication 169-173 
viewing connected users 164-165 
viewing resources in use 168-169 
viewing shared resources 166-167 

Services option 
configuring service startup 14 
configuring services 175 
sharing printers 188 

Conventions used in Windows NT documentation xxii 
Copying 

files and directories with File Manager 74-76 
floppy disks 106 
information 

from command prompt window 280-282 
overview 30-32 
with ClipBook Viewer 299 

program items to another program group 49-50 
screen images 32 

Counters See Performance Monitor, counters 
Cursor 

adjusting blink rate 130 
customizing with Control Panel 129, 130 

Cutting information 
overview 30-32 
with ClipBook Viewer 299 

o 
Data 

archiving in Schedule+ 257 
default data type for printers 194 
dynamic data exchange See DDE 
managing files, overview 10-11 
protecting, overview 16 
storing, ClipBook Viewer 299 

Data Link Control (DLC) See Protocols, Data Link Control 
Date, display and configuration 125-127 

DDE 
changing file type information in File Manager 80 
description 297 
Network DDE DSDM service 175 
Network DDE service 175 

Deleting 
application shortcut keys 334 
archived event logs 413 
device drivers 135 
directories See Directories, deleting 
files See Files, deleting 
fonts 124 
groups 374 
mail messages 215, 222 
mirror sets 429 
partitions 427, 431 
program items 48 
Program Manager groups 48 
stripe sets 434 
unlocked OLE objects 310 
user accounts 364-365 
user profiles 345 
volume sets 432 
volumes 427 

Demonstration See Online demonstration 
Desktop 

configuring appearance 7-8, 115-118 
customizing 7-8, 112-120 
icons 117-118 
patterns 116 
screen savers 119-120 
wallpaper 117 
windows 118 

Device drivers 
adding SCSI drives 343 
adding tape drives 343, 382 
changing system settings 134, 338 
command prompt commands 273 
configuring with Control Panel 132-135, 138 
correcting installation errors 342 
installing 132-135,341 
kernel drivers 132 
network adapter cards See Network adapter cards 
obtaining new device drivers 341 
OS/2 device names 322 
printer drivers, installing 182, 184 
removing 

from Drivers list 135 
SCSI drives 343 
tape drives 343 

required by some applications 315 



Device drivers (continued) 
setting device startup type 139 
setting up new or revised device drivers 342 
starting and stopping devices 138 
third party device drivers 134 
Windows NT Driver Library 341 

Devices See Control Panel, Devices option; Device drivers 
Dialog boxes 27-29 
Directories 

auditing See Auditing, access to files and directories 
copying with File Manager 74-76 
creating with File Manager 73 
deleting 

turning off confirmation messages 83 
with File Manager 76 

directory tree 
collapsing and expanding 63-64 
description 56 
displaying 59 
navigating in File Manager 61-66 
shortcut keys 62 

directory windows 
arranging 58 
description 56-57 
displaying only certain files 69 
moving split bar 60 
multiple windows 57 
navigating in File Manager 61-66 
sorting directory contents 68 
updating 58 

home directories 
assigning to user accounts 362 
copying user environment profiles 364 
description 362 
permissions 362 

keyboard shortcut reference 34 
managing with File Manager 70-84 
moving 

. turning off confirmation messages 83 
with File Manager 74-76 

naming conventions 11,60, 70-71 
network provider search order 162 
ownership 91, 104 
permissions 

adding groups or users 102-104 
changing 93 
customizing 96-98 
overview 90-91 
removing 94 
setting 91-94 
setting through shared directories 98-100 
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Directories, permissions (continued) 
special access permissions 90, 96-98 
standard permissions 90, 91 
viewing 93 

renaming 77 
replicating See Directory replication 
root directory, description 56 
securing 15,90-104 
selecting directory for Windows NT files 493 
selecting in File Manager 71-73 
shared directories See Shared directories 
sorting directory contents with File Manager 68 
specifying working directories when creating program 

items 46 
startup directory 328 

Directory replication 
description 169 
Directory Replicator service 

assigning user accounts 169, 177 
description 175 
restrictions 177 

import computers 
managing locks 171-173 
setting up 169-173 
viewing imported subdirectories 171-173 

importing directories to a workstation 169-173 
prerequisites 169 
Replicator group 177,370 

Directory Replicator service See Directory replication 
Disabling user accounts 364-365 
Disconnecting users 165, 167 
Disk Administrator 

See also Disks 
creating 

extended partitions 422-423 
primary partitions 421-422 
stripe sets 433-434 
volume sets 430-432 

deleting 
mirror sets 429 
partitions, volumes, or logical drives 427 
stripe sets 434 
volume sets 432 

extending volumes and volume sets 432 
managing disks 418-434 
managing partitions 419-429 
overview 416 
recovering disk configuration information 428-429 

Disk space 
checking before adding files from Setup 344 
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Disk space (COlltiIlIlCd) 

creating 
extended partitions 419,422-423 
logical drives 419,423 
primary partitions 421-422 
volume sets 430 

free space, description 419 
freeing by removing non-essential Windows NT 

components 343-345 
organizing 416 
required for Mail 229,234-235 

Disks 
configuration information 428-429 
Disk Administrator See Disk Administrator 
disk compression products 485 
disk space See Disk space 
drive letters See Drive letters 
Emergency Repair disk 428,475,484 
floppy disks 

backing up to 384 
checking for bad sectors 105 
copying 106 
drive letters reserved for floppy disk drives 425 
formatting 105 
labeling 107 

formatting See Formatting 
hard disks See Hard disks 
labeling See Labeling 
maintaining with File Manager 105-107 
managing 10-11,418-434 
new hard disks 

assigning drive letters to volumes 425, 428 
setting up 419-420 

partitions See Partitions 
physical disk activity See Performance Monitor 
restoring See Restoring 
stripe sets See Stripe sets 
volume sets See Volumes, volume sets 
volumes See Volumes 

Display 
See also Desktop; Screen 
changing system settings 338 
setting up new or revised device drivers 342 

Documentation 
conventions xxii 

. Windows NT documentation xxi 
Documents 

attaching to mail messages 211,220,222 
copying screen images 32 
document files displayed in File Manager 67 
document windows 21 

Documents (continued) 

keyboard shortcut reference 34 
OLE See OLE 
opening automatically when starting applications 46 
printing See Printing, documents 
transferring formats with Clipboard 306 
transferring information See Transferring information 

Domain Name Service (DNS) See TCPIIP 
Domains 

adding a computer 159 
description 9, 157 
joining 

after Setup 9 
during Setup 496 
from a remote workstation 159 
with Control Panel 157-158 

logging on from a remote workstation 3-4 
logon scripts See Logon scripts 

Doskey, description 282 
Dragging 

data file icons onto program file icons to start 
applications 82 

description 18 
files and directories to move or copy them 74 
files in File Manager to print them 82 
linking and embedding OLE file packages with 

drag-and-drop 307 
Drive letters 

caution for system partitions 426 
reserved for floppy disk drives 425 
restoring 428-429 
static assignment 425, 428 
stripe sets 434 
volumes 425 

Drivers See Device drivers; Network adapter cards, drivers; 
Protocols 

Drives 
command prompt commands 273 
disk-partitioning schemes, examples 420 
drive letters See Drive letters 
hard drives See Hard disks 
logical drives 

creating 423 
deleting 427 
free space in extended partitions 419 

navigating in File Manager 61-66 
network drives 64-66 
SCSI drives 

adding 343 
installing Windows NT 485 
removing 343 



Drives, SCSI drives (continued) 
tape backup devices supported by Windows NT 384 
troubleshooting 472 

tape drives 
See also Backing up; Backup tapes 
adding 343 
backup commands 384 
loading tape backup drivers 383 
multiple tape drives 384 
removing 343 
setting tape options 387-389 
setting up 384 

Duplicating program items 50 
Dynamic data exchange See DDE 

E 
E-mail See Mail 
Embedding See OLE 
Emergency Repair disk 346-348,428 
EMS memory See Memory, expanded (EMS) memory 
Environment 

customizing working environment, suggestions 6-8 
MS-DOS See MS-DOS, environment 
OS/2 See OS/2 
user environment profiles See User profiles, user 

environment profiles 
user environments See User environments 
variables See Environment variables 
Windows 3.1 See Windows 3.1 

Environment variables 
changing 141-142 
deleting 142 
viewing 140 

Event logs 
archived logs 407,412-414,484 
clearing 406, 413 
filtering options 409 
formatting in other applications 414 
full 406 
log file format 412 
logging options 405 
overwriting events 406 
searching for events 410 
security log 402 
sorting events 407, 414 
system log 402 
types 402 
viewing 404,413 
viewing specific logged events 407 

Event Viewer See Events, Event Viewer 
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Events 
assigning sounds 136-137 
auditing See Auditing 
description 401 
details 411,414 
Event Log service 

description 175 
logging events 401 
sending messages after power failure 148 

event logs See Event logs 
event types 379,403,410 
Event Viewer 

archiving logs 412 
filtering events 407 
overview 402 
searching for events 410 
selecting logs 404 
sorting events 407 
viewing event details 411 

filtering 
options 409 
procedure 407 
restoring default criteria 408 
turning off 408 

interpreting data 411 
monitoring 457-461 
overwriting 406 
reminders See Schedule+, reminders 
saving data 412 
scheduling See Schedule+ 
searching for events 410 
sorting 407 
viewing 

details 411 
for another computer 404 
specific logged events 407 

Executive, Windows NT 314 
Expanded memory See Memory, expanded (EMS) memory 
Export servers See Directory replication, export servers 

'Extended memory See Memory, extended (XMS) memory 
Extending volumes and volume sets 432 

F 
FAT file system See File systems, FAT 
File Manager 

associating embedded files with file types and 
extensions 307 

associating files with applications 78-81 
changing 

file type information 80 
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File Manager, changing (continued) 
font used 60 
program item properties 48 
share properties 88 

creating directories 73 
creating program items 45, 47 
displaying information 

contents list icons 67 
for the selected directory 58, 59 
for the selected drive 58,59 
in directory windows 57-58 
on files 67-68 
only certain files 69 
types of files 69 

drivebar 54, 61 
file version information 84 
files and directories 

collapsing and expanding 63-64 
copying 74-76 
deleting 76 
moving 74-76 
renaming 77 
searching for 77-78 
securing 90-104 
selecting 71-73 
setting attributes 83-84 
setting permissions 90-104 
sharing 85-89 
sorting 68 
taking ownership 104 

keyboard shortcut reference 34 
linking and embedding objects 307-308 
maintaining disks 105-107 
minimizing when running applications 81 
navigating through directory structure 61-66 
network drives 

connecting to 64-66 
disconnecting from 66 
displaying shared directories 64 
path 65 

overview 54 
printing files 82 
starting applications 81-82,323 
status bar 54 
toolbar 54-56 
turning off confirmation messages 83 

File replication See Directory replication 
File systems 

boot partitions 424 
disk-partitioning schemes, examples 420 

File systems (continued) 
FAT 

advantages and disadvantages 492 
disk partitions shared by Windows NT and 

MS-DOS 418 
installing Windows NT 490-493 
overview 10 
RISC-based computers 419,424 

HPFS 
advantages and disadvantages 492 
installing Windows NT 490-493 
overview 10 

NTFS 
advantages and disadvantages 492 
extending volumes and volume sets 432 
file-naming conventions 11, 70-71 
installing Windows NT 490-493 
overview 10-11 
reformatting NTFS partitions containing Windows 

NT 423 
removing NTFS partitions, troubleshooting 482 
security considerations 90-91 

supported by Windows NT 10-11 
Files 

associating files with applications 78-81 
attaching to mail messages 211,220,222 
attributes, setting 83-84 
auditing See Auditing, access to files and directories 
backing up See Backing up, files 
batch files See Batch files 
changing file type information in File Manager 80 
copying 

to the Clipboard 76 
turning off confirmation messages 83 
with File Manager 74-76 

custom startup files 335-336 
deleting 

caution 76,83 
files with long names 76 
non-essential Windows NT components 343-345 
turning off confirmation messages 83 
with File Manager 76 

document files 67,69,81-82 
embedding 306-308 
hidden files 67, 69 
keyboard shortcut reference 34 
linking 307-308 
mail system and message files See Mail message files; 

Mail, system 
managing 10-11, 70-84 



Files (colltinued) 
moving 

turning off confirmation messages 83 
with File Manager 74-76 

naming conventions 11, 70-71 
opening data files when starting applications 82 
opening with keyboard 34 
ownership 91, 104 
paging files See Paging files 
permissions 

adding groups or users 96-104 
changing 95 
customizing 96-98 
online demonstration 4 
removing 96 
securing directories and files 90-104 
setting 94-96 
special access permissions 90, 96-98 
standard permissions 90,91 

preventing data loss, overview 16 
printing See Printing, documents 
program files 67,69,81-82 
Program Information Files (PIFs) See PIF files 
removing non-essential Windows NT files 343-345 
renaming 77 
replicating See Directory replication 
restoring backup files from tape See Restoring files from 

tape 
searching for with File Manager 77-78 
securing 15,90-104 
selecting directory for Windows NT files 493 
selecting in File Manager?1-73 
separator files for printing 192 
setting up Windows NT master files on a server 500-502 
shared files See Shared files 
sound files 136 
system files 67,69 
viewing version information 84 

Filtering events See Events, filtering 
Floppy disks See Disks, floppy disks 
Fonts 

changing font used in File Manager 60 
command prompt fonts 263 
configuring with Control Panel 121-123 
description 121 
installing 122-123 
printer font cartridges 188 
removing 124 
screen fonts 121-123 
TrueType fonts 121-123 
vector fonts 122 
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Formats 
archived event log file format 412 
Clipboard formats 306 
currency 128 
date and time 126 
event data 412 
international options 127-128 
numbers 128 
OLE objects 297 
transferring with Clipboard 306 

Formatting 
floppy disks 105 
format command 423 
partitions 423-424, 490-493 
Quick Format 105 
volumes 423 

Forms See Printing, forms 
FIP Server service 527-532 

G 
Graphics, Clipboard formats 306 
Graphics-based applications See MS-DOS-based 

applications 
Groups 

adding to auditing or permissions list 96-104 
adding to printer permissions list 197-198 
Administrators group 369 
auditing events 379 
auditing printer usage 198-200 
Backup Operators group 370 
built-in groups 366-370 
common groups See Program Manager, groups 
deleting 374 
description 14,366 
granting permissions to groups rather than to users 356 
group memberships 

copying 355 
global groups 367 
local groups 366 
managing 359-364 

group names 367 
Guests group 370 
local groups 

adding 371-372 
adding user accounts 372 
copying 372 
creating 371 
description 366 
managing properties 373 
removing user accounts 372 
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Groups (contillucd) 
managing groups 366-374 
permissions 

copying 355 
customizing 96-98 
removing 94, 96, 100 
setting 91,102-104 

Power Users group 369 
Program Manager groups See Program Manager, groups 
Replicator group 370 
setting up 14 
special groups 370 
Users group 369 

Guests 

H 

Guest account 352 
Guests group 370 

I-lard disks 
adding new hard disks 428 
assigning drive letters to volumes 425,428 
guidelines for disk partitions 489 
setting up 419-420 
troubleshooting 472 

Hardware 
applications requiring new or updated device drivers 315 
configuring the system, overview 12-14 
hardware interrupt levels See Printers, hardware interrupt 

levels; Network adapter cards 
troubleshooting configuration 472-473 
Windows NT system requirements xix 

Help 
actions possible in Help 26 
at command prompt 27, 266 
keyboard shortcut reference 34 
product support 4 
searching for topics 4, 26 
using Help 4, 25 

Home directories See Directories, home directories 
HPFS file system See File systems, HPFS 

I/O 
command symbols 275-276 
optimizing the system with stripe sets 433 
troubleshooting I/O port base addresses 481 

Icons 
desktop arrangement 

aligning on desktop 118 
arranging File Manager icons 59 

Icons (colltillued) 
arranging program-item icons 42-43 
changing program-item icons 51 
preventing titles from overlapping 117 

starting and running applications 
choosing commands from toolbars 21 
dragging data file icons onto program file icons to 

start applications 82 
from program groups 19,51 
keyboard shortcut reference 34 
minimizing applications when you start them 33, 82 
minimizing Program Manager group windows 41 
order in Startup group 52 
running File Manager as an icon 81 
running Program Manager as an icon 52 
selecting with mouse 18 

types 
embedded as OLE packages 293,306-308 
files and directories in File Manager 67 
Program Manager group icons 39 
Schedule+ icons in time slots 243 

Import computers See Directory replication, import 
computers 

Installing Windows NT 
See also Setup 
caution with stripe sets, volume sets, and mirror sets 489 
configuring existing Windows environment 316 
configuring Windows NT 493-498 
Express vs. Custom Setup 487-488 
file systems 489, 490-493 
files copied 499 
formatting partitions for file systems 489, 490-493 
information required 484, 493 
into existing Windows directory 488, 493 
joining a workgroup or domain 496 
making an Emergency Repair disk 484 
migrating Windows 3.1 settings 500 
overview 483-500 
preparing the computer 488-493 
RISC-based computers 487 
selecting directory for Windows NT files 493 
setting up 

applications to run from Program Manager 498 
local accounts 497 
local printers 494 
network adapter cards 494-495 
virtual memory 498 
Windows NT master files on a server 500-502 

specifying disk partitions 488-492 
troubleshooting 473 
using multiple operating systems 490 
x86-based computers 485-486 



International settings 
configuring with Control Panel 127-128 
date and time formats 126 

Interrupts (IRQs) See Printers, hardware interrupt levels; 
Network adapter cards 

Key combinations See Keys 
Keyboard 

adjusting delay and repeat rate 129 
changing system settings 338 
choosing commands 21 
command prompt commands 273 
common actions 33 
customizing with Control Panel 129 
general conventions governing use of keys 33 
international options 127-128 
opening files 34 
overview 32-36 
setting up new or revised device drivers 342 
shortcut reference 34 
starting applications 33 

Keys 

L 

ALT +ENTER, toggling between window and full screen 
mode in command prompt window 262 

ALT +ESC, moving through open applications 52 
ALT+HYPHEN, displaying document window Control 

menu 23 
ALT+SPACEBAR, displaying application window 

Control menu 23 
ALT + TAB, moving through open 

applications 19, 52, 119 
ALT+TAB+ESC, returning to original application 119 
application shortcut keys 

assigning 333-334 
deleting 334 
reserved key combinations 320, 332 
specifying in PIFs 333 
specifying when creating program items 47 

conventions governing use of keys 33 
conventions used in documentation 32 
CTRL+ALT+DEL, logging on to Windows NT 2 
CTRL+ESC, displaying Task List 24 
opening files 34 
shortcut reference 34 
starting applications 33 

Labeling 
floppy disks 107 
label command 423 

Labeling (continued) 
new volumes 417,423 
OLE packages 308 
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LAN adapter numbers, network bindings 157 
LAN Manager commands 

changes 288 
not available at the Windows NT command prompt 289 
vs. Windows NT commands 287 

Linking See OLE 
Locator 162; 175 
Locking OLE objects 310 
Logging off 

correct procedure 39 
from Mail 215-216 
from Schedule+ 241 
quitting Windows NT 5, 39 

Logging on 
entering unique identifiers 2 
logon scripts See Logon scripts 
online demonstration 4 
starting applications automatically 52 
starting Windows NT 2-3 
to a domain from a remote workstation 2-4 
to Mail 214 
to Schedule+ 240 
to services 177 
troubleshooting 476 

Logon scripts 
assigning to users 361 
copying user environment profiles 364 

M 
Mail 

accounts 
adding to WGPOs 233 
administrator accounts 229-231 
changing passwords .214 
creating 212-213 
disk space required 229 
information contained in WGPOs 226 
modifying 233 
removing 234 
restoring passwords 237 

Address Book 217 
folders 

backing up 236 
description 211 
restoring 236 
shared folders 224, 234-235 
sharing folders 231-232 
storing messages 224 
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Mail (continued) 
message files 

copying to a computer or disk 224 
corrupted 237 
description 210 
moving offline 224 

Message Finder 223 
messages 

addressing 216-219 
attaching files 211,220,222 
creating without being connected to 

postoffice 224-225 
deleting 222 
finding 223 
headers 211 
including OLE packages 222, 308 
message templates 223,223 
reading 219-220 
replying to 221 
sending 216-219 
sending to another mail system 218, 238 
typing 218 

passwords 210,214,237 
Postoffice Manager 

creating WGPOs 229-231 
managing accounts 233-234 
managing mail system files 236-237 
managing WGPOs 232-237 
planning WGPOs 226-229 

postoffices See herein WGPOs 
starting 211,214 
system 

advanced features 222-225 
backing up 236-237 
description 226-228 
managing files 236-237 
overview 210-211 
quitting 215-216 
restoring 236-237 
restoring user passwords 237 
sending messages to another mail system 218, 238 
setting up 226-228 

using with other systems and networks 238 
WGPOs 

configuration examples 226-228 
connecting to 211-212 
creating 229-231 
description 210 
disk space required 229, 234-235 
existing Mail postoffice 211 
managing 232-237 

Mail, WGPOs (continued) 
planning 226-229 
sharing 231-232 

working offline 224-225 
Memory 

changing environment variables 141-142 
expanded (EMS) memory 

for MS-DOS-based applications 316 
including information in PIFs 325 
setting options 329 

extended (XMS) memory 330 
optimizing performance 142 
running different processes 314 
troubleshooting memory buffer addresses 481 
virtual memory 

changing virtual memory paging file 142-144 
configuring during Setup 498 
defining for operating system 13 
defining for Windows 3.1-based applications 315 

Windows NT system requirements xix 
Menus 21-22 
Messages 

general dialog messages 30 
low battery power warning 146 
Mail See Mail, messages 
sending after power failure 147,148 
Server Unavailable message during OLE 311 
turning off confirmation messages in File Manager 83 

Microsoft Locator 162, 175 
MIDI Mapper 136-137 
Mirror sets 

boot and system partitions 424 
caution when installing Windows NT 489 
deleting 429 
restoring 428--429 

Mouse 
configuring 

changing system settings 338 
customizing 129,131 
device drivers 132, 135,341 
pointers 18, 131 
switching functions of buttons 131 

turning off File Manager confirmation messages 83 
using 

choosing commands 21 
clicking 18 
creating program items quickly with File Manager 45 
double-clicking 18,131 
guidelines 18 
moving and sizing windows 20 
selecting items 18 



MS-DOS 
applications See MS-DOS-based applications 
commands 

changes and improvements 284 
configuration commands 273-274,317 
not available in Windows NT 285 
subsystem commands supported 272 
vs. Windows NT commands 283 

converting long file names 70 
disk partitions shared with Windows NT 418,490 
environment 

configuring 316-318 
custom startup files 13, 335-336 
customizing with PIFs 318 

memory-resident programs 319-320,327 
naming conventions 11, 71 
running pop-up programs in windows 320 
Windows NT Setup considerations 490 

MS-DOS-based applications 

N 

application shortcut keys 333 
character-based applications 316,331 
converting long file names 70 
creating PIFs 324-336 
expanded (EMS) memory 316,329 
extended (XMS) memory 330 
graphics-based applications 316,331 
naming conventions 11, 71 
run by Windows NT 314 
running from command prompt 259 
setting up 322-323 
starting 323 
toggling between window and full screen modes 331 
transferring information with Clipboard 30-32 

Names 
See also Renaming 
characters prohibited 11 
computer names 

changing 151-152 
troubleshooting 478 

Name Service Interface (NSI) 162 
naming files or directories 11, 70-71 
printer names 183 
RPC name service provider 162 

NetBEUI protocol 156, 504 
NetBIOS 

applications, LAN adapter numbers 157 
NetBEUI protocol 156, 504 
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NetWare 
NWLink protocol 156,505-510 
running Mail on a NetWare network 238 

Network adapter cards 
adding 151 
configuring during Setup 494-495 
configuring the network 155 
default settings in .Windows NT 478-479 
hardware interrupt levels 480-481 
I/O port base addresses, troubleshooting 481 
information required during Setup 484, 495 
installing 152 
LAN adapter numbers 157 
memory buffer addresses, troubleshooting 481 
removing 151, 154 
smart cards 543 
updating 151, 154 

Networks 
accessing X.25 networks remotely See Remote Access 

Service (RAS), X.25 networks 
bindings 157, 160-161 
browsing See Browsing the network 
configuring 

network software 155 
protocol software 156-157 
with Control Panel 8-9,150-162 

connecting to network drives with File Manager 64-66 
connecting to network printers 185-186 
home directories See Directories, home directories 
installing network software 153 
LAN adapter numbers 157 
logon scripts See Logon scripts 
mail system See Mail, system 
monitoring network activity and 

performance See Performance Monitor 
network provider search order 162 
network settings, summary 151 
printing See Printing; Printers 
protocols See Protocols 
removing components 154 
troubleshooting network problems 477-481 
updating components 154 
viewing 

connected users 164-165 
resources in use 168-169 
shared resources 166-167 

Windows NT system requirements xix 
NTFS file system See File systems, NTFS 
Numbers 

formats 128 
TCP/IP sequence numbers 512 
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NWLink protocol 156,505-510 

o 
Object Packager 308-310 
Objects 

description 292 
linking and embedding See OLE, objects 
Performance Monitor objects 441 

OLE 
applications managing OLE activities 298 
applications with OLE capabilities 292 
associating files with file extensions 307 
changing filename of source document 310 
choosing data types with Paste Special command 298 
client applications 295 
ClipBook pages 299-300 
commands used 296 
compound documents, uses 295 
copying files to Clipboard from File Manager 76 
destination documents 293 
dynamic updating 294 
links 

See also herein objects 
canceling 310 
creating linked objects 297 
fixing broken links 310 
manual links 309,312 
updating 309 

objects 
description 292 
editing 309-310 
embedded objects 222, 294, 297 
format 297 
inserting 296 
linked objects 222,294,297,301,309,312 
locking or unlocking 310 
maintaining 309 
managing 298 
pasting 296 

overview 292 
packages 

description 293 
editing 309-310 
embedding in mail messages 222, 307 
embedding sound clips 306 
embedding, procedure 306-308 
including commands 308 
linking and embedding files 307-308 
linking multiple documents 307 

OLE, packages (continued) 
navigating through linked documents 307 
running commands in documents 294 

picture formats 297 
server applications 295 
Server Unavailable message 311 
source documents 293 
text formats 297 
troubleshooting 310-312 
types of documents 293 
version restrictions 308 

Online demonstration 4 
Online Help See Help 
Operating systems 

boot partitions 13, 424 
default startup system 13, 140-141 
defining 

boot loader 13 
options with Control Panel 140-149 
user environment variables 13 
virtual memory 13 
which operating system to boot 13, 140,424 

MS-DOS See MS-DOS 
OS/2 See OS/2 
startup path 13 
system partitions 424 
troubleshooting alternate operating system 476 
using multiple operating systems 490 

Optimizing performance 
balancing data I/O across drives 431 
deleting partitions 431 
paging files 142-144 
stripe sets 433 

OS/2 
16-bit character-based applications 320 
applications run by Windows NT 314 
configuration commands 273-274,321 
configuring environment 321-322 
device names 322 
running applications from command prompt 259 
setting up applications 322-323 
subsystem commands supported by Windows NT 272 
Windows NT Setup considerations 490 

Ownership 
checking 104 
description 91 
information discarded when copying files or 

directories 74 
taking ow~ership of files or directories 104 
taking ownership of printers 200 



p 
Packages See Object Packager; OLE, packages 
Paging files 

configuring 13 
description 142 
modifying 142-144 
recommended size 143 
viewing 140 

Partitions 
assigning drive letters 425, 428 
boot partitions 424 
converting existing partitions during Setup 488-492 
creating 419-423 
deleting 427,431 
description 420, 424 
disk-partitioning schemes, examples 420 
extended partitions 420, 427 
file systems See File systems 
formatting 419,423,490-493 
installing Windows NT 488-493 
labeling new volumes 423 
managing with Disk Administrator 419-429 
marking as active 424 
number possible 418,420,425 
primary partitions 421-422 
reformatting NTFS partitions containing Windows 

NT 424 
removing, troubleshooting 482 
securing system partitions on RISC-based computers 425 
shared by Windows NT and MS-DOS 418 
stripe set restrictions 424, 433 
system partitions 

description 424, 489 
drive letters 425 
number possible according to operating system 418, 

420 
recommended size 489 

troubleshooting Windows NT installation 473 
volume set restrictions 430 

Passwords 
Account policy options 375 
ensuring system security at logon 2 
mail accounts 210,214 
managing workstation passwords 354 
pressing CTRL+ALT+DEL before entering at logon 2 
screen savers 119 
user account passwords 

changing 8, 178 
logging on to services 177, 178 
password options 355 
unique identifier used at logon 2 

Pasting information 
in command prompt windows 280--282 
with ClipBook Viewer 299 

Path 
changing path of OLE documents 311 
environment variables 141 
including in PIFs 326 
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Windows NT device drivers for OS/2 322 
Patterns, desktop See Desktop, patterns 
Performance 

monitoring See Performance Monitor 
optimizing See Optimizing performance 
troubleshooting 477 

Performance Monitor 
alerts 

alert selections 458-460 
changing alert options 461 
creating alert logs 457-461 
monitoring interval 461 
setting on current activity 457-461 
setting on input log files 468 
tracking events 457-461 

charts 
chart highlighting mode 439 
chart selections 450-451 
charting current activity 449-453 
charting input log files 467 
counter options 452 
customizing 452-453 
formats 452 

counters 
activating 437 
changing alert counters 460 
changing charting counters 451 
charting options 452 
explained 442-444 
logging current activity 454 
monitoring multiple counters 458 
selecting 445 

current activity 
logging 454-457 
monitoring 444-448 
reports 462-464 
setting alerts 457-461 

display 439-447 
exporting data 447 
instances 444 
log files 

adding bookmarks 457 
adding information 455 
changing log options 456 
charting input log files 467 
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Performance Monitor, log files (continued) 
current activity 454-457 
logging interval 456 
monitoring multiple counters with alert log 458 
relogging input log files 469 
reports based on input log files 470 
setting alerts on input log files 468 
working with log file information 448 

monitoring performance, overview 440-448 
objects 444 
overview 436 
reports 

adding information 463-464 
based on input log files 470 
changing report options 464 
current activity 462-464 
report interval 464 
viewing 462 

selecting a different computer 446 
views 437, 439 

Permissions 
customizing 96-98 
description 376 
directories See Directories, permissions 
files See Files, permissions 
granting remote access permission to users 537 
granting to groups rather than to users 356 
groups See Groups, permissions 
NTFS security considerations 90-91 
online demonstration 4 
overview 90-91 
removing 96 
securing printers 195-198 
setting through shared directories 98-100 
special access permissions 90, 96-98 
standard permissions 90, 91 
vs. rights 376 

Personal groups See Program Manager, groups 
Pictures 

bitmap formats 297 
Clipboard formats 306 

PIF files 
batch programs for starting memory-resident programs 

with applications 320, 326 
creating 324-336 
custom startup files 335-336 
customizing MS-DOS environment 318 
description 318 
PIF Editor 320, 324 
setting up MS-DOS applications with Windows NT 

Setup 322 

PIF files (continued) 
specifying options 326-336 
starting applications from PIFs 325 
using multiple PIFs for an application 325 
Windows NT default PIF 318,324 

Ping utility 521 
Pointing 

customizing pointing devices with Control Panel 131 
description 18 
mouse pointers 18 

Policies See Security policies 
Pop-up programs See MS-DOS, memory-resident programs 
Ports 

configuring with Control Panel 120-121 
I/O port base addresses, troubleshooting 481 
installing printers 183 
printer ports 194, 195, 484 
serial ports, troubleshooting 480 

Postoffice Manager See Mail, Postoffice Manager 
Power failure 

configuring UPS options 145-148 
low battery power warning 146 
sending messages 147, 148 
system shutdown 145,148-149 

Print Manager 
See also Printers; Printing 
administering network print servers remotely 207-208 
auditing printer usage 198-200 
changing 

document details 206-207 
printer properties 187-195 
printing order 205 

choosing print destinations 182-183 
connecting to network printers 185-186 
defining printer priority 193 
installing printer drivers 184 
installing printers 181-184 
overview 180-183 
pausing and resuming printing 204 
pooling printers 193-194 
printing 

directly to ports 194 
documents 202-207 
files from File Manager 82 

removing printers 186 
removing waiting documents 205 
restarting printing documents 205 
securing printers 195-198 
setting 

default printer 203 
hours a printer is available 191 



Print Manager, setting (continued) 
job defaults 189 
printer details 191-195 
printing options 188-189 
time-out options 195 

setting up to print 11 
sharing printers 188 
specifying print processor 194 
taking ownership of printers 200 
viewing document status 203 

Print servers, administering remotely 207-208 
Printer drivers, installing 182, 184 
Printers 

See also Printing 
adding groups or users to printer permissions 

list 197-198 
administering remotely 207-208 
auditing usage 198-200 
browsing the network 9, 11 
connecting to 

network printers 185-186 
online demonstration 4 

data types 194 
default printer 203 
defining multiple printers for one physical 

printer 182, 193 
fonts See Fonts 
hardware interrupt levels 480-481 
Hewlett-Packard printers 183 
hours a printer is available 191 
information required during Setup 484 
installing 181-184 
installing printer drivers 184 
memory available 188 
pausing and resuming printing 204 
Print Manager See Print Manager 
printer names 183 
printer pools 193-194 
printer priority 182, 193 
printer properties 187-195 
printer resolution affecting font display 121 
printers that print to files 182, 183 
removing printers 186 
securing printers 195-198 
separator pages 192 
setting up a local printer during Setup 494 
sharing printers 188 
taking ownership 200 
time-out options 195 
using parallel ports 195 
viewing document status 203 
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Printing 
See also Printers 
changing file type information in File Manager 80 
data types 194 
destination 182-183 
documents 

changing details 206-207 
changing document printing hours 207 
changing document priority 207 
changing print notification 206 
changing printing order 205 
from File Manager 82 
margins 201-202 
paper size and format 128,201-202 
removing waiting documents 205 
restarting printing documents 205 
spooled documents, description 194 
viewing document status 203 

forms 188,189,201-202 
memory available to printers 188 
pausing and resuming 204 
Print Manager See Print Manager 
printing directly to ports 194 
separator pages 192 
setting 

job defaults 189 
printing options 188-189 

setting up to print 11 
specifying print processor 194 
taking ownership of printers 200 
to files 182 

Privileges See Permissions; Rights 
Processes 

object type in Performance Monitor 444 
running different processes in memory 314 

Profiles See User profiles 
Program Information Files (PIFs) See PIF files 
Program items 

arranging icons 42-43 
changing icons 51 
copying to another group 49-50 
creating 45-48 
deleting 48 
description 40 
properties 

changing with File Manager 48 
changing with Program Manager 47 
setting with File Manager 48 
setting with Program Manager 45 

specifying application shortcut keys 47, 333 
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Program items (COil lillI/cd) 
specifying working directories 46 
starting applications minimized 47,52 

Program Manager 
arranging icons 42-43 
assigning application shortcut keys 47,333 
built-in groups 

Accessories group 40 
Administrative Tools group 7 
Applications group 40 
Games group 40 
Main group 6-7,40 
Startup group 7,40,52 

groups 
changing group description 49 
common and personal groups 40 
creating 44 
deleting 48 
description 40 
group windows 39-41,327 
icons 39 
installed during Setup 40 

keyboard shortcut reference 34 
opening documents automatically when starting 

applications 46 
overview 38 
program items See Program items 
quitting Windows NT 39 
returning to Program Manager from applications 52 
running applications as icons 52 
running as an icon 52 
saving settings 43 
setting up applications 339 
setting up applications to run from Program Manager 498 
specifying startup directory 328 
starting applications 19,33,51,323 

Programs 
See also Applications 
batch programs See Batch files 
displaying in File Manager 69 
MS-DOS memory-resident programs 319-320,327 
pop-up programs 319-320,327 
Program Information Files (PIFs) See PIF files 
program items See Program items 
running as icons 52 
running multiple programs 142 
starting from command prompt 279-280 
TSR programs 319-320,327 

Properties 
local group properties 373 
printer properties 187-195 
server properties 163 

Properties (colltinued) 
share properties 88 
user account properties 356-364 

Protocols 

Q 

changing protocol binding order 161 
Data Link Control 156, 183, 505 
description 503 
NetBEUI 156, 504 
NWLink 156, 505-510 
overview 504 
protocol software 156-157 
provided with Windows NT 156, 503 
TCP/IP See TCP/IP 

Quick Format 105 
QuickEdit 262, 280 
Quitting Windows NT 5, 39 

R 
Random Access Memory (RAM) 142 
Recovering data See Restoring 
Registry 

See also Configuration, disk configuration information 
backing up local registry files 387-389 
recovering disk configuration information 428-429 

. restoring local registry files from backups 397 
Reminders program See Schedule+, reminders 
Remote Access Service (RAS) 

description 533-535 
dial-up PADs 

connecting with clients 545 
PAD.INF format 546 

granting remote access permission 537 
intermediary devices 

connecting through 547 
supported 546 
writing scripts 548-549 

joining a domain 159 
logging on to a domain from a remote workstation 3-4 
security hosts 546 
setting up 537 
X.25 networks 

configurations offered 538 
configuring remote access software 546 
dial-up PADs 538-543 
setting up remote access clients and servers 544-545 
support 538-544 
X.25 packet handling 538 



Remote Procedure Call service See Services, RPC service 
Renaming 

See also Names 
directories and files 77 
source OLE documents 310 
user accounts 365 

Repair program 348 
Replication See Directory replication 
Resources 

closing 169 
scheduling with Schedule+ 253-254 
shared resources 

disconnecting users 167 
viewing 166-167 

viewing resources in use 168-169 
Restarting your computer 39 
Restoring 

assigned drive letters 428--429 
disk configuration information 428--429 
mail folders 236 
mail system files 236-237 
mirror sets 428--429 
stripe sets 428--429 
system 

using last known good configuration 346,475 
with Emergency Repair disk 346-348,475 

volume sets 428--429 
windows 20 

Restoring files from tape 
building a partial catalog 396 
catalog information 394-396 
choosing what to restore 394 
corrupt files 392, 395 
from backups, overview 381-384,394-399 
from third party backup programs 396 
local registry files 397 
log options 398 
restoration policies 394 
restore options 397-398 
restore status 399 
restoring permissions 397 
verifying restorations 394, 397 

Rights 
advanced user rights 377 
description 376 
managing user rights 376-378 
programming rights 377 
rights of built-in groups 368 
User Rights policy 16, 376-378 
vs. permissions 376 
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RISC-based computers 
16-bit character-based OS/2 applications 320 
boot configuration 13, 424 
disk-partitioning schemes, examples 420 
formatting partitions for file systems 489, 490--493 
important files copied during Setup 499 
installing Windows NT 487 
restoring the system with Emergency Repair disk 347, 

475 
running MS-DOS applications under Windows 

NT 316,331 
system partitions 419,424,425,487,489 
Windows NT system requirements xix 

Running applications 
as icons 52 

s 

by double-clicking OLE packages 293 
device drivers required 315 
from command prompt 259 
from Program Manager 498 
in Windows NT 6-7,314-315 
regardless of operating system required 314 
with MS-DOS memory-resident programs 319-320 

Saving 
disk configuration information 428 
Program Manager settings 43 

Schedule+ 
advanced features 256-257 
Appointment Book 

adding appointments 244-248, 255 
adding tasks 250-251 
dates and times 243 
description 243 
notes 243 
reminders 243, 245 
scheduling recurring appointments 243, 246-248 
tentative appointments 243, 246 

archiving data 257 
exchanging data with other scheduling programs 257 
modifying tasks 250 
moving files from one computer to another 257 
overview 240 
Planner 

planning workgroup meetings 251-254 
scheduling attendees 251-253 
scheduling resources 253-254 
viewing others' schedules 251 
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Schcdule+ (col/IiI/lied) 
reminders 

general options 256 
options 243 
Reminders program 241 
setting 245 

signing in 240 
Task list 

adding tasks 248-250 
adding tasks to Appointment Book 250-251 
modifying tasks 250 
removing tasks 250 
sorting tasks 248 

time slots 243 
views 241-242 
working offline 257 

Screen 
See also Desktop; Display 
copying screen images 32 
screen savers See Screen savers 

Screen savers 119-120 
Scrolling 20, 29 
SCSI drives See Drives, SCSI drives 
Searching 

for directories with File Manager 77-78 
for disk configuration information 428 
for events in Event Viewer 410 
for files 11,69, 77-78 
for information in Windows NT Help 4 
for Mail messages 223 
for names in Mail Address Book 217 
network provider search order 162 

Sectors, checking when formatting floppy disks 105 
Security 

auditing access to files and directories 15,409 
auditing events 379 
NTFS considerations 90-91 
overview 15 
password protected screen savers 119 
permissions See Permissions 
policies See Security policies 
pressing CTRL+ALT+DEL before entering password at 

logon 2 
securing system partitions on RISC-based computers 425 

Security policies 
Account policy 16,374 
Audit policy 16,379-380 
auditing events 379 
managing 374-380 
managing security 15 
setting up 16 
User Rights policy 16, 376-378 

Selecting commands and information 18, 34 
Separator pages See Printing, separator pages 
Servers 

administering network print servers remotely 207-208 
global group memberships 367 
home directories See Directories, home directories 
logon scripts See Logon scripts 
network provider search order 162 
remote access servers See Remote Access Service (RAS) 
Server See Services, Server service 
server properties usage summary 163 
Server Unavailable message during OLE 311 
setting up Windows NT master files on a server 500-502 

Services 
Alerter 148, 173, 175 
Clipbook 175 
Computer Browser 175 
configuring 

service startup 14, 177-178 
with Control Panel Services option 14, 175 

controlling startup parameters 14, 175, 176 
correct procedure for logging off 39 
DCE Cell Directory service (CDS) 162 
default services provided with Windows NT 175 
Directory Replicator See Directory replication 
DNS See TCP/IP 
EventLog 148,175,401 
FTP Server service 527-532 
logging on to services 177 
managing services 175 
Messenger 148,173,175 
Name Service Interface (NS!) 162 
Net Logon 175 
Network DDE 175 
Network DDE DSDM 175 
pausing and continuing services 176 
Remote Access Service (RAS) See Remote Access 

Service (RAS) . 
Remote Procedure Call (RPC) 162, 175 
Server 85,175,177 
SNMP See TCP/IP 
starting 175, 176 
stopping services 176 
troubleshooting service startup 482 
UPS 145,175 
Workstation 175 

Setup 
checking disk space before adding files 344 
configuring the system, overview 12 
configuring Windows NT 493-498 



Setup (continued) 
creating program items 45 
deleting user profiles 345 
Express vs. Custom Setup 487-488 
information required 484, 493 
installing Windows NT 483 
joining a workgroup or domain 496 
making an Emergency Repair disk 484 
migrating Windows 3.1 settings 500 
Program Manager groups installed 40 
removing NTFS partitions, troubleshooting 482 
selecting directory for Windows NT files 493 
setting up 

applications to run from Program Manager 498 
local accounts 497 
local printers 494 
network adapter cards 494-495 
virtual memory 498 

Setup command switches 500-502 
starting and quitting Setup 338 
system maintenance 337 
troubleshooting Windows NT installation 473 

Shared directories 
browsing the network 9 
changing share properties 88 
limiting number of users 86, 88 
on remote computers 85 
removing groups or users 100 
securing 90-104 
setting permissions 91-94,98-100 
sharing directories 85-89 
stopping directory sharing 87 

Shared files 
closing 89 
online demonstration 4 
securing 90-104 
sharing files 85-89 
stopping file sharing 87 
viewing 89 

Sharing 
ClipBook information 300, 301 
directories See Shared directories 
files See Shared files 
information, online demonstration 4 
printers 188 
resources See Resources, shared resources 
WGPO mail directories 231-232 

Shortcut keys See Keys 
Shutdown 

turning off your computer 5, 39 
UPS command file executed prior to system 

shutdown 148-149 

SNMP service See TCP/IP 
Sorting 

archived event log files 414 
directory contents in File Manager 68 
events 407 
international characters 128 

Sounds 
assigning to events 136-137 
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embedding sound clips as OLE packages 306 
hardware required 135 
MIDI Mapper 135-137 
playing 306,312 
sound files 136 
turning off 137 

Starting applications 
automatically 52 
by dragging data file icons onto program file icons 82 
from command prompt 279-280, 323 
from File Manager 81-82, 323 
from PIFs 325 
from program groups 51 
from Program Manager 19,323 
from program or document files 81-82 
minimized 33,47,82 
MS-DOS memory-resident programs 320 
opening documents automatically 46, 82 
overview 322-323 

Starting Windows NT 
See also Booting; Logging on; Startup 
after completing Setup 499 
boot partitions 424 
configuring service startup 14 
configuring the network 8-9 
configuring the system, overview 12-14 
customizing working environment, suggestions 6-8 
defining 

boot loader 13 
operating system variables 13 
startup applications 7 

logging on 2-4 
online demonstration 4 
setting up 

security policies 16 
to print 11 
user accounts and groups 14 

troubleshooting 474-476 
Startup 

boot configuration 
defining boot operating system 13, 140,424 
RISC-based computers 13, 424 
tools for modifying 111 
x86-based computers 13, 424 
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Startup (continllcd) 
boot partitions 424 
configuring service startup 14, 177-178 
custom startup files 335-336 
defining 

boot loader 13 
operating system variables 13 
startup applications 7 

faulty device drivers 342 
setting device startup type 139 
specifying default startup system 140-141 
starting applications automatically 52 
startup directory 328 
Startup group 7,40, 52 
troubleshooting 474-476 

Storage space See Disk space 
Stripe sets 

caution when installing Windows NT 489 
creating 433-434 
deleting 434 
description 433 
drive letters assigned 434 
restoring 428-429 
restrictions 424, 433 

Subsystems 
applications supported by Windows NT subsystems 314 
MS-DOS 316 
OS/2 320 
subsystem commands supported by Windows NT 272 
supported by Windows NT 314 
troubleshooting startup 482 
Windows 3.1 315 

Swap files See Paging files 
Switching to another application 

ALT+ESC 52 
ALT+TAB 19,52,119 
application shortcut keys See Keys, application shortcut 

keys 
Control menu 23 
keyboard shortcut reference 34 
Switch To command 23 
Task List 23 

System 
accounts, specifying for service startup 178 
aUditing events 379 
configuration 

changing settings 338-339 
customizing with Control Panel 110 
device driver settings 134 
overview 12-14 
setting system devices 139 
system settings in user profiles 345 

System (COli tin lied) 
correcting faulty device driver installation 342 
default services provided 175 
environment variables See Environment variables 
mail system See Mail, system 
maintaining, overview 338 
performance See Optimizing performance; Performance; 

Performance Monitor 
restoring 

using last known good configuration 346,475 
with Emergency Repair disk 346-348,428,475 

time See Time 
Windows NT system requirements xix 

SYSTEM.lNI 316 

T 
Tape drives See Backing up; Backup tapes; Drives, tape 

drives 
Task List 

keyboard shortcut reference 34 
managing windows and icons 23 
Schedule+ Task list See Schedule+, Task list 

TCP/IP 
checksum 512 
configuring TCP/IP 516-521 
default gateway 514 
DNS connectivity 519-521 
example of packet delivery 514-515 
FIP Server service See Services, FIP Server service 
host IDs 513 
installing TCP/IP 515-516 
IP addresses 513 
network IDs 513 
ping utility 521 
port IDs 512 
sequence numbers 512 
SNMP service 

agent information 526-527 
configuring 522-524 
configuring security 524-525 
installing 521-522 

sub net masks 513 
TCP headers 512 
TCP/IP protocol, description 156,510-514 
TCP/IP utilities reference 274 
troubleshooting IP connections 521 

Threads 442 
Time 

changing document printing hours 207 
customizing display 126 



Time (continued) 
setting 

hours a printer is available 191 
system time 125-127 
time zone 125 

time formats 126 
time-out options for printers 195 

Time intervals 
default for sending power failure messages 147 
displaying list of operating systems at startup 141 
Performance Monitor alert monitoring interval 461 

Titles 
preventing icon titles from overlapping 117 
specifying window titles with Program Manager 327 

Transferring information 
between applications 31 
between command prompt windows 280-282 
between documents 280-282, 299 
with ClipBook Viewer 299 

Troubleshooting 
alternate operating system 476 
hardware configuration 472-473 
hardware interrupt levels 480-481 
I/O port base addresses 481 
IP connections when installing TCP/IP 521 
logging on 476 
memory buffer addresses 481 
network adapter cards 473,478-481 
network problems 477-481 
OLE 310-312 
performance problems 477 
removing NTFS partitions 482 
restoring your system 346 
services or subsystems not starting 482 
starting Windows NT 474-476 
Windows NT installation 473 

TrueType fonts 121-123 
TSR programs See MS-DOS, memory-resident programs 
Turning off your computer 5, 39 

u 
Uninterruptible Power Supply See UPS 
UPS 

battery low power warning 146 
command file executed prior to system 

shutdown 148-149 
configuring 145-148 
testing configuration 149 
UPS service 146, 175 

User accounts 
Account policy 16, 374 
adding 

procedure 353-356 
to local groups 372 

Administrator account 352 
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built-in user accounts, description 352-353 
creating 354-356 
deleting 364-365 
description 14 
Directory Replicator service See Directory replication 
disabling 364-365 
Guest account 352 
Initial User account 353 
Mail accounts See Mail, accounts 
managing 351-364 
modifying 356-358 
online demonstration 4 
passwords See Passwords 
permissions See Permissions 
renaming 365 
setting up 14,497 
specifying for service startup 178 
User Rights policy 376-378 

User environments 
changing variables 141-142 
user environment profiles 363 
viewing variables 140 

User Manager 
authorized users 351 
configuring user environment profiles 363 
disabling or deleting user accounts 364-365 
managing 

Account policy 374 
Audit policy 379-380 
group memberships 359-364 
groups 366-374 
profiles 361-364 
security policies 374-380 
user accounts 351-364 
User Rights policy 376-378 

overview 350 
User profiles 

copying 355 
deleting 345 
description 345 
home directories See Directories, home directories 
logon script names 361 
managing with User Manager 361-364 
user environment profiles 363 
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Username, unique identifier used at logon 3, 353 
Users 

v 

adding to auditing or permissions list 96-104 
adding to printer permissions list 197-198 
aUditing events 379 
communicating with other users, online demonstration 4 
disconnecting from servers 165 
granting permissions to groups rather than to users 356 
group memberships 

copying 355 
global groups 367 
local groups 366 
managing 359-364 

Initial User account 353 
mail accounts See Mail, accounts 
mail message files See Mail, message files 
passwords See Passwords 
permissions See Permissions 
Power Users group 369 
user accounts See User accounts 
user environments See User environments 
user names 353 
user profiles See User profiles 
user rights See Rights 
Users group 369 
viewing user sessions 164-165 

Variables, environment See Environment variables 
Version 

OLE restrictions 308 
viewing version information in File Manager 84 

Virtual memory paging files See Paging files 
Volumes 

assigning drive letters 425 
boot partitions 424 
deleting mirror sets 429 
deleting 427 
description 420 
extending 432 
formatting 423 
formatting new partitions 417 
labeling new volumes 423 
mirror sets See Mirror sets 
number possible in Windows NT 425 
stripe sets See Stripe sets 
volume sets 

caution when installing Windows NT 489 
creating 430-432 
deleting 432 

Volumes, volume sets (continued) 
description 430 
extending 432 

w 

formatting new partitions 423 
maximum number of disks 431 
operating system restrictions 430 
restoring 428-429 
volume sizes 431 

Wallpaper, desktop 117 
WOPOs See Mail, WOPOs 
Wildcards, searching for filenames 11, 69 
WIN.INI 316 
Windows 

active window, description 19 
application windows, displaying Control menu with 

ALT+SPACEBAR 23 
command prompt windows See Command prompt, 

windows 
desktop windows 118 
document windows 

description 21 
displaying Control menu with ALT+HYPHEN 23 

fast application switching 19, 24, 52, 119 
keeping pop-up programs easily available 320 
keyboard shortcut reference 34 
managing 19-21 
managing with Task List 23 
maximizing or minimizing 20 
moving 20 
printer windows 180 
Program Manager group windows 39,41-42 
restoring 20 
scrolling c'Jntents 20 
sizing 20 . 
specifying titles with Program Manager 327 

Windows 3.1 
configuring existing Windows environment when 

installing Windows NT 316 
migrating settings when installing Windows NT 500 
virtual memory 315 

Windows 3.1-based applications 
environment 315 
run by Windows NT 314 
running from command prompt 259 
setting up 322-323 
starting automatically 52 
virtual memory 315 
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adding components 343-345 
additional information xxi 
documentation xxi 
Driver Library 341 
Executive, description 314 
features xviii 
overview xviii 
removing non-essential components 343-345 
subsystems 314 
system requirements xx 
tools for configuring and monitoring the network 8 
vs. Windows for MS-DOS xix 

Windows NT Locator 162, 175 
Workgroups 

description 9, 157 
joining 

after Setup 9 
during Setup 496 
with Control Panel 157-158 

scheduling tool See Schedule+ 
workgroup postoffices (WGPOs) See Mail, WGPOs 

Workstations 

}( 

Audit policy 379-380 
group memberships 

global groups 367 
local groups 366 
managing 359-364 

home directories See Directories, home directories 
logon scripts See Logon scripts 
managing user rights 376-378 
remote workstations 

See also Remote Access Service (RAS) 
joining a domain 159 

user profiles See User profiles 
viewing events 404 

X86-based computers 
boot configuration 13, 424 
disk-partitioning schemes, examples 420 
guidelines for disk partitions 489 
important files copied during Setup 499 
installing Windows NT 485-486 
OS/2 applications 314,320 
partitions 424 
restoring the system with Emergency Repair disk 347, 

428,475 
running MS-DOS-based applications under Windows 

NT 316,331 
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X86-based computers (continued) 
running Windows NT Setup 485-486 
setting up Windows NT master files on a server 500-502 
standard IRQ assignments 480 
system partitions 419,424,426 
troubleshooting Windows NT installation 473 
Windows NT system requirements xx 
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